Contents

Preface ................................................................. xli
About This Manual ..................................................... xli
Conventions in This Manual ........................................... xlili
  Typographical Conventions ....................................... xlili
  Syntax Notation .................................................... xliv
  Information Alerts ................................................ xliv
  Edition Alerts ..................................................... xlvi
  Video Alerts ....................................................... xlv
  Video Descriptions ............................................... xlv
Available Documentation .......................................... xlv
Technical Support ................................................... xlvi

Chapter 1: Getting Started with Stylus Studio® 2006 ................. 1
Stylus Studio Editions .................................................... 3
  Stylus Studio XML Enterprise Edition ............................. 3
  Stylus Studio XML Professional Edition .......................... 3
  Stylus Studio Home Edition ........................................ 4
Edition Alerts ............................................................. 4
More Information ....................................................... 4
Starting Stylus Studio ................................................... 5
  Getting Updates ..................................................... 5
  Getting Help .......................................................... 6
Updating an XML Document—Getting Started ....................... 6
  Opening a Sample XML Document ................................. 6
  Alternatives .......................................................... 7
  For more information ............................................... 8
## Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updating the Text of a Sample Document</td>
<td>8</td>
</tr>
<tr>
<td>Displaying Line Numbers</td>
<td>8</td>
</tr>
<tr>
<td>Adding Elements in the Text View of a Sample Document</td>
<td>9</td>
</tr>
<tr>
<td>Copying and Pasting in the Text View of a Sample Document.</td>
<td>10</td>
</tr>
<tr>
<td>Undoing Operations in the Text View of a Sample Document</td>
<td>10</td>
</tr>
<tr>
<td>Inserting Indents in the Text View of a Sample Document</td>
<td>11</td>
</tr>
<tr>
<td>Querying in the Text View of a Sample Document</td>
<td>12</td>
</tr>
<tr>
<td>Deleting a Query</td>
<td>14</td>
</tr>
<tr>
<td>Updating the Schema of a Sample Document</td>
<td>14</td>
</tr>
<tr>
<td>Creating a Sample Schema</td>
<td>15</td>
</tr>
<tr>
<td>Defining a Sample Element</td>
<td>17</td>
</tr>
<tr>
<td>Adding an Element Reference to a Sample Schema</td>
<td>18</td>
</tr>
<tr>
<td>Defining an Entity in a Sample Schema</td>
<td>19</td>
</tr>
<tr>
<td>Exploring Other Features in a Sample Schema</td>
<td>19</td>
</tr>
<tr>
<td>Updating the Tree Representation of a Sample Document</td>
<td>20</td>
</tr>
<tr>
<td>Adding an Element to a Sample Document Tree</td>
<td>20</td>
</tr>
<tr>
<td>Changing an Element’s Data in a Sample Document Tree</td>
<td>21</td>
</tr>
<tr>
<td>Adding Attributes and Other Node Types to a Sample Document Tree</td>
<td>21</td>
</tr>
<tr>
<td>Adding an Entity Reference to a Sample Document Tree</td>
<td>22</td>
</tr>
<tr>
<td>Updating a Sample Document Using the Grid Tab</td>
<td>23</td>
</tr>
<tr>
<td>Modifying Values</td>
<td>25</td>
</tr>
<tr>
<td>Moving Around the Grid</td>
<td>25</td>
</tr>
<tr>
<td>Working with Stylesheets – Getting Started</td>
<td>26</td>
</tr>
<tr>
<td>Opening a Sample Stylesheet</td>
<td>26</td>
</tr>
<tr>
<td>XSLT Stylesheet Editor Quick Tour</td>
<td>27</td>
</tr>
<tr>
<td>Parts of the XSLT Editor</td>
<td>28</td>
</tr>
<tr>
<td>Exploring the XSLT Source Tab</td>
<td>28</td>
</tr>
<tr>
<td>Exploring the Params/Other Tab</td>
<td>31</td>
</tr>
<tr>
<td>Exploring the WYSIWYG Tab</td>
<td>32</td>
</tr>
<tr>
<td>XSLT Scenarios</td>
<td>33</td>
</tr>
<tr>
<td>Working with Scenarios</td>
<td>35</td>
</tr>
<tr>
<td>About Preview</td>
<td>35</td>
</tr>
<tr>
<td>Working with a Sample Result Document</td>
<td>35</td>
</tr>
<tr>
<td>Making a Static Web Page Dynamic by Editing XSLT</td>
<td>38</td>
</tr>
<tr>
<td>Importing a Sample HTML File</td>
<td>39</td>
</tr>
<tr>
<td>Creating the video Template</td>
<td>41</td>
</tr>
<tr>
<td>Instantiating the video Template</td>
<td>43</td>
</tr>
<tr>
<td>Making Titles Dynamic</td>
<td>44</td>
</tr>
<tr>
<td>Making Images Dynamic</td>
<td>45</td>
</tr>
</tbody>
</table>
Contents

Making Summaries Dynamic .................................................. 46
Stylesheets That Generate HTML – Getting Started .......................... 47
Video Demonstrations of the XSLT WYSIWYG Editor .......................... 47
Introduction to WYSIWYG in Stylus Studio .................................. 47
Working with Tables ............................................................. 48
Using Templates ................................................................. 48
Converting Static HTML ....................................................... 48
Getting Started with the XSLT WYSIWYG Editor ............................. 48
Creating Static HTML .......................................................... 49
Defining Dynamic Contents ................................................... 52
Adding a Table with Dynamic Contents .................................... 53
Using the Properties Window .................................................. 56
Making a Static Web Page Dynamic Using the WYSIWYG Editor .............. 59
Before You Begin .................................................................. 59
Making Repeating Table Rows in the WYSIWYG Editor ....................... 60
Making Contents Dynamic in the WYSIWYG Editor .......................... 61
Rendering Images as Dynamic Content in the WYSIWYG Editor .......... 61
Using Conditional If Processing in the WYSIWYG Editor ..................... 63
Using the XSLT Mapper – Getting Started .................................... 64
Opening the XSLT Mapper ....................................................... 65
Mapping Nodes in Sample Files ............................................... 67
Saving the Stylesheet and Previewing the Result .............................. 69
Deleting Links in Sample Files ................................................. 70
Defining Additional Processing in Sample Files ............................... 71
Debugging Stylesheets – Getting Started ..................................... 72
Setting Up Stylus Studio to Debug Sample Files .............................. 72
Inserting a Breakpoint in the Sample Stylesheet .............................. 73
Gathering Debug Information About the Sample Files ....................... 75
The Variables Window ......................................................... 76
The Call Stack Window .......................................................... 76
The Watch Window ............................................................... 77
Ending Processing During a Debug Session ................................... 78
Defining a DTD – Getting Started ............................................. 80
Process Overview ................................................................. 80
Creating a Sample DTD ........................................................ 80
Defining Data Elements in a Sample DTD ................................... 81
Defining the Container Element in a Sample DTD ......................... 82
Defining Structure Rules in a Sample DTD ................................... 82
Examining the Tree of a Sample DTD ........................................ 84
Contents

Defining an XML Schema Using the Diagram Tab – Getting Started ........................................... 85
  Introduction to the Diagram Tab .................................................................................................. 86
  Diagram Pane ............................................................................................................................ 87
  Text Pane .................................................................................................................................. 91
  Definition Browser ..................................................................................................................... 93
  Editing Tools of the Diagram Tab ................................................................................................. 94
  Menus and Tool Bars .................................................................................................................... 94
  In-place Editing ............................................................................................................................ 95
  Drag-and-Drop ............................................................................................................................ 95
  QuickEdit .................................................................................................................................... 96
  Refactoring .................................................................................................................................. 97

Description of Sample XML Schema .............................................................................................. 99
  Defining a complexType in a Sample XML Schema in the Diagram View ................................... 99
  Defining the Name of a Sample complexType in the Diagram View .......................................... 100
  Adding an Attribute to a Sample complexType in the Diagram View ........................................ 101
  Adding Elements to a Sample complexType in the Diagram View ........................................... 102
  Adding Optional Elements to a Sample complexType in the Diagram View .............................. 103
  Adding an Element That Contains Subelements to a complexType in the Diagram View .......... 103
  Choosing the Element to Include in a Sample complexType in the Diagram View .................... 105
  Defining Elements of the Sample complexType in the Diagram View ....................................... 106

Opening Files in Stylus Studio .......................................................................................................... 108
  Types of Files Recognized by Stylus Studio ................................................................................ 108
  Opening Unknown File Types .................................................................................................... 109
  Opening Files Stored on Third-Party File Systems ...................................................................... 109
  Modifications to Open Files .......................................................................................................... 110
  Using the File Explorer ............................................................................................................... 110
  How to Use the File Explorer to Open Files ................................................................................ 111
  Other Features of the File Explorer ........................................................................................... 111
  Working with the File Explorer Filter .......................................................................................... 112
  Dragging and Dropping Files in the Stylus Studio ....................................................................... 113
  Other Ways to Open Files in Stylus Studio ................................................................................ 114
  Adding File Types to Stylus Studio ............................................................................................... 115
  Deleting File Types .................................................................................................................... 116

Working with Projects .................................................................................................................... 116
  Displaying the Project Window .................................................................................................... 117
  Displaying Path Names ................................................................................................................ 118
  Other Documents ......................................................................................................................... 118
## Contents

- Creating Projects and Subprojects .................................................. 118
- Saving Projects ................................................................. 119
- Opening Projects ................................................................. 119
  - Recently Opened Projects .................................................. 120
- Adding Files to Projects .......................................................... 120
  - Other Ways to Add Files to Projects ...................................... 120
- Copying Projects ................................................................. 121
- Rearranging the Files in a Project ............................................. 121
- Removing Files from Projects .................................................... 121
- Closing and Deleting Projects ..................................................... 122
  - Closing .................................................................................. 122
  - Deleting ............................................................................... 122
- Setting a Project Classpath ............................................................. 122
  - Specifying Multiple Classpaths ............................................. 122
  - How to Set a Project Classpath ............................................. 123
- Using Stylus Studio with Source Control Applications ....................... 125
  - Tested Source Control Applications ...................................... 125
  - Prerequisites ......................................................................... 126
  - Recursive Selection ................................................................ 126
  - Using Stylus Studio with Microsoft Visual SourceSafe ................. 126
  - Using Stylus Studio with ClearCase ....................................... 129
  - Using Stylus Studio with Zeus CVS ....................................... 132
  - Specifying Advanced Source Control Properties ......................... 133
- Customizing Tool Bars ..................................................................... 134
  - Tool Bar Groups ...................................................................... 134
  - Showing/Hiding Tool Bar Groups ............................................ 135
  - Changing Tool Bar Appearance ............................................... 136
- Specifying Stylus Studio Options ..................................................... 136
  - Setting Module Options ......................................................... 136
    - XML Diff ........................................................................... 137
    - XML Editor ........................................................................ 137
    - XSLT Editor ....................................................................... 137
    - Java ................................................................................... 138
  - Defining Custom Tools ............................................................... 138
  - Defining Keyboard Shortcuts ...................................................... 140
    - How to Define a Keyboard Shortcut ..................................... 140
    - Deleting a Keyboard Shortcut ............................................ 141
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updating Java Server Pages as XML Documents</td>
<td>160</td>
</tr>
<tr>
<td>Using the Text Editor</td>
<td>161</td>
</tr>
<tr>
<td>Text Editing Features</td>
<td>161</td>
</tr>
<tr>
<td>Simple Text Editing</td>
<td>162</td>
</tr>
<tr>
<td>Code Folding</td>
<td>162</td>
</tr>
<tr>
<td>Sense:X</td>
<td>163</td>
</tr>
<tr>
<td>Indent</td>
<td>164</td>
</tr>
<tr>
<td>Line Wrap</td>
<td>164</td>
</tr>
<tr>
<td>Spell Checking</td>
<td>165</td>
</tr>
<tr>
<td>Font</td>
<td>165</td>
</tr>
<tr>
<td>Comments</td>
<td>165</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>165</td>
</tr>
<tr>
<td>Search</td>
<td>165</td>
</tr>
<tr>
<td>Use of Colors in the Text Tab</td>
<td>166</td>
</tr>
<tr>
<td>How to Change Text Colors</td>
<td>166</td>
</tr>
<tr>
<td>Using the Spell Checker</td>
<td>167</td>
</tr>
<tr>
<td>Default Spell Checking</td>
<td>167</td>
</tr>
<tr>
<td>Manual Spell Checking</td>
<td>167</td>
</tr>
<tr>
<td>Specifying Spell Checker Settings</td>
<td>168</td>
</tr>
<tr>
<td>How to Spell Check a Document</td>
<td>169</td>
</tr>
<tr>
<td>Using the Personal Dictionary</td>
<td>170</td>
</tr>
<tr>
<td>Moving Around in XML Documents</td>
<td>171</td>
</tr>
<tr>
<td>Line Numbers</td>
<td>171</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>171</td>
</tr>
<tr>
<td>Tags</td>
<td>172</td>
</tr>
<tr>
<td>Find</td>
<td>172</td>
</tr>
<tr>
<td>Updating DOM Tree Structures</td>
<td>173</td>
</tr>
<tr>
<td>Displaying All Nodes in the Tree View</td>
<td>174</td>
</tr>
<tr>
<td>Adding a Node in the Tree View</td>
<td>174</td>
</tr>
<tr>
<td>Deleting a Node in the Tree View</td>
<td>174</td>
</tr>
<tr>
<td>Moving a Node in the Tree View</td>
<td>175</td>
</tr>
<tr>
<td>Changing the Name or Value of a Node in the Tree View</td>
<td>175</td>
</tr>
<tr>
<td>Obtaining the XPath for a Node</td>
<td>175</td>
</tr>
<tr>
<td>Using the Grid Tab</td>
<td>177</td>
</tr>
<tr>
<td>Layout of the Grid Tab</td>
<td>178</td>
</tr>
<tr>
<td>Features of the Grid Tab</td>
<td>178</td>
</tr>
<tr>
<td>Expanding and Collapsing Nodes</td>
<td>179</td>
</tr>
<tr>
<td>Collapsing Empty Nodes</td>
<td>179</td>
</tr>
<tr>
<td>Renaming Nodes</td>
<td>181</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td>Resizing Columns .................................................. 181</td>
<td></td>
</tr>
<tr>
<td>Showing Row Tag Names ............................................. 182</td>
<td></td>
</tr>
<tr>
<td>Moving Around the Grid Tab ......................................... 182</td>
<td></td>
</tr>
<tr>
<td>Selecting Items in the Grid ......................................... 183</td>
<td></td>
</tr>
<tr>
<td>How Grid Changes Affect the XML Document ....................... 183</td>
<td></td>
</tr>
<tr>
<td>Types of Changes that Affect the Document ....................... 184</td>
<td></td>
</tr>
<tr>
<td>Working with Rows ................................................... 184</td>
<td></td>
</tr>
<tr>
<td>Reordering Rows ..................................................... 185</td>
<td></td>
</tr>
<tr>
<td>Adding and Deleting Rows ........................................... 185</td>
<td></td>
</tr>
<tr>
<td>Working with Columns ................................................ 186</td>
<td></td>
</tr>
<tr>
<td>Selecting a Column .................................................. 186</td>
<td></td>
</tr>
<tr>
<td>Adding Columns ....................................................... 186</td>
<td></td>
</tr>
<tr>
<td>Deleting Columns ..................................................... 187</td>
<td></td>
</tr>
<tr>
<td>Reordering Columns .................................................. 187</td>
<td></td>
</tr>
<tr>
<td>Renaming Columns ..................................................... 187</td>
<td></td>
</tr>
<tr>
<td>Changing a Value ..................................................... 188</td>
<td></td>
</tr>
<tr>
<td>Working with Tables .................................................. 188</td>
<td></td>
</tr>
<tr>
<td>Adding a Nested Table ............................................... 189</td>
<td></td>
</tr>
<tr>
<td>Moving a Nested Table ............................................... 190</td>
<td></td>
</tr>
<tr>
<td>Deleting a Table ..................................................... 190</td>
<td></td>
</tr>
<tr>
<td>Sorting a Table ....................................................... 190</td>
<td></td>
</tr>
<tr>
<td>Copying a Table as Tab-Delimited Text ............................ 191</td>
<td></td>
</tr>
<tr>
<td>Diffing Folders and XML Documents ................................. 191</td>
<td></td>
</tr>
<tr>
<td>Overview ............................................................. 193</td>
<td></td>
</tr>
<tr>
<td>Sources and Targets .................................................. 194</td>
<td></td>
</tr>
<tr>
<td>The Diff Configuration File .......................................... 194</td>
<td></td>
</tr>
<tr>
<td>What Branches Are Calculated? ... ................................. 194</td>
<td></td>
</tr>
<tr>
<td>Tuning the Diffing Algorithm ....................................... 195</td>
<td></td>
</tr>
<tr>
<td>When Does the Diff Run? ............................................ 196</td>
<td></td>
</tr>
<tr>
<td>Running the Diff Manually ......................................... 197</td>
<td></td>
</tr>
<tr>
<td>Symbols and Background Colors .................................... 197</td>
<td></td>
</tr>
<tr>
<td>Diffing Folders ....................................................... 198</td>
<td></td>
</tr>
<tr>
<td>Features ............................................................... 199</td>
<td></td>
</tr>
<tr>
<td>How to Diff Folders .................................................. 200</td>
<td></td>
</tr>
<tr>
<td>How to Diff Documents from the Diff Folders Dialog Box ....... 202</td>
<td></td>
</tr>
<tr>
<td>The XML Diff Viewer ................................................ 202</td>
<td></td>
</tr>
<tr>
<td>Split View - Tree ..................................................... 203</td>
<td></td>
</tr>
<tr>
<td>Split View - Text ...................................................... 204</td>
<td></td>
</tr>
<tr>
<td>Merged View ........................................................... 205</td>
<td></td>
</tr>
</tbody>
</table>
Contents

View Symbols and Colors ........................................... 206
The XML Diff Viewer Tool Bar ..................................... 206
Tools for Working with Documents ................................. 209
Removing a Target Document ....................................... 210
Diffing a Pair of XML Documents .................................. 210
How to Diff a Pair of Documents ................................. 210
Diffing Multiple Documents ......................................... 211
Document Focus ..................................................... 211
Symbols Used in the Target Document Window .................. 212
How to Diff Multiple Documents .................................... 215
Modifying Default Diff Settings ..................................... 216
Opening the Options Dialog Box .................................... 217
Engine Settings ....................................................... 218
Presentation Options ................................................ 220
Running the Diff Tool from the Command Line ................. 220
Restrictions .......................................................... 221
Usage ................................................................. 221
Using Schemas with XML Documents .............................. 223
Associating an External Schema With a Document ............. 223
Having Stylus Studio Generate a Schema ......................... 224
Validating XML Documents ....................................... 224
Updating a Document’s Schema .................................... 225
Removing the Association Between a Document and a Schema 225
Converting XML to Its Canonical Form ............................ 225
Querying XML Documents Using XPath ........................... 226
Printing XML Documents ........................................... 226
Saving XML Documents ............................................ 227
Options for Saving Documents ....................................... 227
More About Backup Files ........................................... 227
Opening a Backup File .............................................. 227

Chapter 3: Converting Non-XML Files to XML .................. 229
Overview of Convert to XML ......................................... 230
File Support ........................................................ 231
Using Convert to XML ................................................ 232
Other Ways to Convert Files to XML ............................. 232
Choosing an Input File .............................................. 233
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Convert to XML Editor</td>
<td>234</td>
</tr>
<tr>
<td>Document Pane</td>
<td>235</td>
</tr>
<tr>
<td>Example – .txt Files</td>
<td>235</td>
</tr>
<tr>
<td>Display of Delimiting and Control Characters</td>
<td>236</td>
</tr>
<tr>
<td>Field Names</td>
<td>237</td>
</tr>
<tr>
<td>Document Pane Display Features</td>
<td>238</td>
</tr>
<tr>
<td>Moving Around the Document</td>
<td>240</td>
</tr>
<tr>
<td>Properties Window</td>
<td>242</td>
</tr>
<tr>
<td>How Properties are Organized</td>
<td>243</td>
</tr>
<tr>
<td>Properties for Fixed-Width and Line-Oriented Input Files</td>
<td>243</td>
</tr>
<tr>
<td>Schema Pane</td>
<td>244</td>
</tr>
<tr>
<td>Parts of an Input File</td>
<td>245</td>
</tr>
<tr>
<td>Regions</td>
<td>245</td>
</tr>
<tr>
<td>Region Types</td>
<td>246</td>
</tr>
<tr>
<td>Managing Regions</td>
<td>246</td>
</tr>
<tr>
<td>Rows</td>
<td>246</td>
</tr>
<tr>
<td>Fields</td>
<td>247</td>
</tr>
<tr>
<td>Component and Sub-Component Fields</td>
<td>247</td>
</tr>
<tr>
<td>Working with Regions</td>
<td>247</td>
</tr>
<tr>
<td>Converting the Region Type</td>
<td>247</td>
</tr>
<tr>
<td>How to Convert a Region Type</td>
<td>249</td>
</tr>
<tr>
<td>Adjusting Fixed-Width Regions</td>
<td>250</td>
</tr>
<tr>
<td>Example</td>
<td>251</td>
</tr>
<tr>
<td>Defining and Joining Regions</td>
<td>252</td>
</tr>
<tr>
<td>Defining a Region</td>
<td>252</td>
</tr>
<tr>
<td>Joining Regions</td>
<td>253</td>
</tr>
<tr>
<td>Controlling Region Output</td>
<td>254</td>
</tr>
<tr>
<td>Working with Fields</td>
<td>254</td>
</tr>
<tr>
<td>Naming Fields</td>
<td>255</td>
</tr>
<tr>
<td>Using the Element Name Source Property</td>
<td>255</td>
</tr>
<tr>
<td>More About Using Rows for Field Names</td>
<td>257</td>
</tr>
<tr>
<td>How to Name Fields</td>
<td>257</td>
</tr>
<tr>
<td>Defining Fields</td>
<td>258</td>
</tr>
<tr>
<td>Creating Notes for Fields</td>
<td>260</td>
</tr>
<tr>
<td>Component and Sub-Component Fields</td>
<td>261</td>
</tr>
<tr>
<td>Controlling XML Output</td>
<td>262</td>
</tr>
<tr>
<td>Specifying Element Names</td>
<td>263</td>
</tr>
<tr>
<td>Specifying Format</td>
<td>264</td>
</tr>
<tr>
<td>Omitting Regions and Fields, and Rows</td>
<td>264</td>
</tr>
</tbody>
</table>
Pattern Matching .......................................................... 265
Example .......................................................................... 265
Sample Regular Expressions .............................................. 266
Specifying Multiple Match Patterns ....................................... 267
Working with Nodes ............................................................ 267
Using Lookup Lists ............................................................. 270
Defining Lookup Lists ........................................................ 271
Working with Lookup Lists .................................................. 272
Using Key=Value Characters ................................................ 272
Creating an Adapter ............................................................ 273
Specifying File Settings ....................................................... 273
How to Create an Adapter ..................................................... 274
Using Adapters in Stylus Studio .............................................. 275
Built-In Adapters .............................................................. 276
How to Open a File Using an Adapter ...................................... 278
More About Converting EDI ................................................ 280
Supported EDI Dialects ....................................................... 281
Understanding Separator Characters ..................................... 281
How Stylus Studio Sets Separator Characters .......................... 281
Invalid Separator Characters .............................................. 282
Setting Processing Instruction .............................................. 282
Syntax ............................................................................. 283
Ways to Specify Control Characters ....................................... 284
Using the Built-In EDI Adapter to Convert EDI to XML ................. 284
Where to Find It ................................................................ 284
Using Convert to XML to Convert EDI to XML ....................... 285
Validating XML from/to EDI ............................................... 285
User-Defined Adapaters Properties Reference .......................... 285
Input File Properties .......................................................... 286
XML Output URL Properties ............................................... 287
Region Type Properties ...................................................... 288
Row Element Name Properties ............................................ 291
Field Element Name Properties .......................................... 292
Type-Specific Properties ..................................................... 293
Specifying Control Characters .............................................. 298
## Chapter 4: Working with XSLT

Getting Started with XSLT ................................................................. 303

What Is XSLT? .............................................................................. 303
  What XSLT Versions Does Stylus Studio Support? .................. 304

What Is a Stylesheet? ................................................................. 305
  Example of a Stylesheet .......................................................... 305
  About Stylesheet Contents ....................................................... 308

What Is a Template? ................................................................. 308
  Contents of a Template ........................................................... 309
  Determining Which Template to Instantiate ......................... 310
  How the **select** and **match** Attributes Are Different ........ 311

How the XSLT Processor Applies a Stylesheet ......................... 311
  Instantiating the First Template ................................................ 312
  Selecting Source Nodes to Operate On ..................................... 313
  Controlling the Order of Operation ......................................... 314
  Omitting Source Data from the Result Document ................... 315
  When More Than One Template Is a Match ............................... 316
  When No Templates Match ...................................................... 316

Controlling the Contents of the Result Document ...................... 317
  Specifying Result Formatting ................................................ 317
  Creating New Nodes in the Result Document ......................... 318
  Controlling White Space in the Result ..................................... 318

Specifying XSLT Patterns and Expressions ............................. 319
  Examples of Patterns and Expressions .................................... 319

Frequently Asked Questions About XSLT ................................. 320

Sources for Additional XSLT Information .................................. 322

Benefits of Using Stylus Studio ................................................. 323
  Structural Data View ............................................................ 323
  Sophisticated Editing Environment ....................................... 324
  XSLT and Java Debugging Features ....................................... 325
  Integrated XML Parser/XSLT Processor ................................. 327

Tutorial: Understanding How Templates Work ......................... 327
  Creating a New Sample Stylesheet ......................................... 328
  Understanding How the Default Templates Work .................... 331
    Instantiating the Template That Matches the Root Node .......... 332
    Instantiating the Root/Element Default Template ................... 333
    Instantiating the Text/Attribute Default Template ................. 334
  Illustration of Template Instantiations ................................. 335
  Editing the Template That Matches the Root Node .................. 336
## Contents

- Creating a Template That Matches the `book` Element .............................................. 337
- Creating a Template That Matches the `author` Element ........................................... 338
- Working with Stylesheets ................................................................................................. 339
  - About the XSLT Editor .................................................................................................... 340
  - Creating Stylesheets ...................................................................................................... 341
- Creating a Stylesheet from HTML .................................................................................... 341
- Specifying Stylesheet Parameters and Options ............................................................... 342
- Applying Stylesheets .......................................................................................................... 345
  - About Applying Stylesheets .......................................................................................... 345
  - Results of Applying a Stylesheet ................................................................................... 346
  - Applying Stylesheets to Large Data Sets ..................................................................... 348
  - Creating a Scenario ........................................................................................................ 348
  - Cloning Scenarios .......................................................................................................... 350
  - Saving Scenario Meta-Information ................................................................................ 350
- Applying a Stylesheet to Multiple Documents ................................................................. 351
  - Applying the Same Stylesheet in Separate Operations ................................................. 351
  - Applying a Stylesheet to Multiple Documents in One Operation ............................... 351
- About Stylesheet Contents ................................................................................................ 352
  - Contents Provided by Stylus Studio .............................................................................. 352
  - Contents You Can Add .................................................................................................... 352
- Updating Stylesheets ......................................................................................................... 353
  - Dragging and Dropping from Schema Tree into XSLT Editor .................................. 353
  - Using Sense:X Automatic Tag Completion .................................................................. 354
  - Using Sense:X to Ensure Well-Formed XML ............................................................... 354
  - Using Standard Editing Tools ...................................................................................... 355
- Saving Stylesheets ............................................................................................................ 355
  - Using Updated Stylesheets ............................................................................................ 356
- Creating Stylesheets That Generate HTML .................................................................... 357
  - Descriptions of WYSIWYG Terms ............................................................................... 358
  - Inserting Contents in the HTML Editor ........................................................................ 359
  - Displaying a Repeating Element in the HTML Editor ............................................... 360
  - Adding Conditional Processing in the HTML Editor .................................................. 360
    - Specifying Choose Conditional Processing in the HTML Editor ............................ 361
    - Specifying If Conditional Processing in the HTML Editor ...................................... 362
  - Instantiating Templates in the HTML Editor ............................................................... 363
    - Calling a Named Template ......................................................................................... 363
    - Specifying Properties and Attributes in the HTML Editor ..................................... 364
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifying Extension Functions in Stylesheets</td>
<td>364</td>
</tr>
<tr>
<td>Using an Extension Function in Stylus Studio</td>
<td>365</td>
</tr>
<tr>
<td>Basic Data Types</td>
<td>366</td>
</tr>
<tr>
<td>Declaring an XSLT Extension Function</td>
<td>366</td>
</tr>
<tr>
<td>Working with XPath Data Types</td>
<td>367</td>
</tr>
<tr>
<td>Declaring an Extension Function Namespace</td>
<td>367</td>
</tr>
<tr>
<td>Invoking Extension Functions</td>
<td>367</td>
</tr>
<tr>
<td>Finding Classes and Finding Java</td>
<td>368</td>
</tr>
<tr>
<td>Debugging Stylesheets That Contain Extension Functions</td>
<td>368</td>
</tr>
<tr>
<td>Working with Templates</td>
<td>369</td>
</tr>
<tr>
<td>Viewing Templates</td>
<td>369</td>
</tr>
<tr>
<td>Viewing a List of Templates</td>
<td>370</td>
</tr>
<tr>
<td>Viewing a Specific Template</td>
<td>370</td>
</tr>
<tr>
<td>Checking if a Template Generates Output</td>
<td>370</td>
</tr>
<tr>
<td>Using Stylus Studio Default Templates</td>
<td>371</td>
</tr>
<tr>
<td>Contents of a New Stylesheet Created by Stylus Studio</td>
<td>371</td>
</tr>
<tr>
<td>About the Root/Element Built-In Template</td>
<td>372</td>
</tr>
<tr>
<td>About the Text/Attribute Built-In Template</td>
<td>372</td>
</tr>
<tr>
<td>Creating Templates</td>
<td>373</td>
</tr>
<tr>
<td>Saving a Template</td>
<td>373</td>
</tr>
<tr>
<td>Applying Templates</td>
<td>374</td>
</tr>
<tr>
<td>Updating Templates</td>
<td>374</td>
</tr>
<tr>
<td>Deleting Templates</td>
<td>374</td>
</tr>
<tr>
<td>Using Third-Party XSLT Processors</td>
<td>374</td>
</tr>
<tr>
<td>How to Use a Third-Party Processor</td>
<td>375</td>
</tr>
<tr>
<td>Passing Parameters</td>
<td>377</td>
</tr>
<tr>
<td>Setting Default Options for Processors</td>
<td>377</td>
</tr>
<tr>
<td>Validating Result Documents</td>
<td>378</td>
</tr>
<tr>
<td>Post-processing Result Documents</td>
<td>380</td>
</tr>
<tr>
<td>Generating Formatting Objects</td>
<td>381</td>
</tr>
<tr>
<td>Developing Stylesheets That Generate FO</td>
<td>381</td>
</tr>
<tr>
<td>Troubleshooting FOP Errors</td>
<td>382</td>
</tr>
<tr>
<td>Viewing the FO Sample Application</td>
<td>383</td>
</tr>
<tr>
<td>Deploying Stylesheets That Generate FO</td>
<td>385</td>
</tr>
<tr>
<td>Example</td>
<td>385</td>
</tr>
<tr>
<td>Using Apache FOP to Generate NonPDF Output</td>
<td>386</td>
</tr>
<tr>
<td>Generating Scalable Vector Graphics</td>
<td>387</td>
</tr>
<tr>
<td>About SVG Viewers</td>
<td>387</td>
</tr>
<tr>
<td>Running the SVG Example</td>
<td>387</td>
</tr>
</tbody>
</table>
Generating Java Code for XSLT ................................................................. 388
  Scenario Settings .................................................................................. 389
    Choosing Scenarios ............................................................................. 390
  Java Code Generation Settings ................................................................. 391
  How to Generate Java Code for XSLT ....................................................... 391
  Compiling Generated Code ...................................................................... 392
    How to Modify the Stylus Studio Classpath ........................................ 393
    How to Compile and Run Java Code in Stylus Studio ......................... 394
  Deploying Generated Code ..................................................................... 394
    Overview .............................................................................................. 394
    About the unlockAPI() Method .......................................................... 396
XSLT Instructions Quick Reference .............................................................. 396
  xsl:apply-imports .................................................................................... 398
  xsl:apply-templates ................................................................................ 398
    Format .................................................................................................... 398
    Description ............................................................................................ 398
    Example .................................................................................................. 399
  xsl:attribute ........................................................................................... 399
    Format .................................................................................................... 399
    Description ............................................................................................ 399
    Example .................................................................................................. 400
  xsl:attribute-set ...................................................................................... 400
    Format .................................................................................................... 400
    Description ............................................................................................ 401
    Example .................................................................................................. 402
  xsl:call-template ...................................................................................... 402
    Format .................................................................................................... 402
    Description ............................................................................................ 402
  xsl:character-map .................................................................................... 403
    Format .................................................................................................... 403
    Description ............................................................................................ 403
    Example .................................................................................................. 404
  xsl:choose ................................................................................................. 405
    Format .................................................................................................... 405
    Description ............................................................................................ 405
  xsl:comment ............................................................................................. 406
    Format .................................................................................................... 406
    Description ............................................................................................ 406
    Example .................................................................................................. 406
## Contents

<table>
<thead>
<tr>
<th>Element</th>
<th>Format</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>xsl:copy</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:copy-of</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:decimal-format</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:element</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:fallback</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:for-each</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:for-each-group</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:function</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:if</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:import</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xsl:import-schema</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Element</td>
<td>Format</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>xsl:include</td>
<td>417</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:key</td>
<td>418</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:message</td>
<td>419</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:namespace-alias</td>
<td>420</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:number</td>
<td>420</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:otherwise</td>
<td>421</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:output</td>
<td>421</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:output-character</td>
<td>422</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:param</td>
<td>424</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:preserve-space</td>
<td>426</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:processing-instruction</td>
<td>426</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xsl:sequence</td>
<td>427</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5: Creating XSLT Using the XSLT Mapper ................................. 437

Overview of the XSLT Mapper ............................................................... 438
Example .............................................................................................. 439
Graphical Support for Common XSLT Instructions and Expressions ................. 440
Setting Options for the XSLT Mapper ....................................................... 441
Simplifying the Mapper Canvas Display ..................................................... 441
Other Mapper Display Features .............................................................. 444
Exporting Mappings ............................................................................. 444
Searching Document Panes ................................................................. 445
Ensuring That Stylesheets Output Valid XML 445
Steps for Mapping XML to XML 445
Source Documents 446
Choosing Source Documents 446
Source Documents and XML Instances 447
  Types of associations 447
  Source document icons 449
  How to change a source document association 449
How to Add a Source Document 449
How to Remove a Source Document 451
How Source Documents are Displayed 451
  Document structure symbols 452
  Getting source document details 452
Target Structures 452
  Using an Existing Document 453
  Building a Target Structure 453
  Modifying the Target Structure 454
    Adding a Node 454
    Removing a Node 455
Mapping Source and Target Document Nodes 455
  Preserving Mapper Layout 455
  Left and Right Mouse Buttons Explained 456
  How to Map Nodes 457
  Removing Source-Target Maps 457
Working with XSLT Instructions in XSLT Mapper 457
  What XSLT Instructions Are Represented Graphically 458
Instruction Block Ports 458
  Specifying Values for Ports 459
Understanding Input Ports 459
  Specifying Values for Input Ports 460
  Red Input Ports 460
The Flow Port 460
Adding an Instruction Block to the XSLT Mapper 461
  Notes About Creating Instruction Blocks 461
xsl:if and xsl:choose 462
Processing Source Nodes 463
XPath Function Blocks 464
  Parts of a Function Block 464
  Types of Function Blocks 465
Contents

Determining Which Template Generated Particular Output .................................................. 485
Determining the Output Generated by a Particular Template ................................................... 485
Profiling XSLT Stylesheets ........................................................................................................ 485
   About Metrics ....................................................................................................................... 487
   Enabling the Profiler ............................................................................................................ 487
   Displaying the XSLT Profiler Report ..................................................................................... 488
Handling Parser and Processor Errors ....................................................................................... 489
Debugging Java Files .................................................................................................................. 489
   Requirements for Java Debugging .......................................................................................... 489
   Setting Options for Debugging Java ....................................................................................... 490
   Using the Java Editor ............................................................................................................ 491
   Stylus Studio and the JVM ..................................................................................................... 492
   Example of Debugging Java Files ........................................................................................... 492
      Setting Up to Debug Sample Java/XSLT Application .......................................................... 492
      Inserting a Breakpoint in the Sample Java/XSLT Application ............................................. 493
      Gathering Debug Information About the Sample Java/XSLT Application ......................... 493

Chapter 7: Defining XML Schemas .......................................................................................... 495
What Is an XML Schema? ......................................................................................................... 496
Reference Information .............................................................................................................. 496
Creating an XML Schema in Stylus Studio .............................................................................. 496
   Creating Your Own XML Schema ......................................................................................... 497
   Creating XML Schema from a DTD ....................................................................................... 497
      Using the DTD to XML Schema Document Wizard ............................................................ 497
      Using the DTD to XML (Trang) Document Wizard .............................................................. 498
   Creating XML Schema from an XML Document ................................................................. 501
      Using the XML to XML Schema Document Wizard .......................................................... 502
      Using the Create Schema from XML Content Feature ...................................................... 503
      Displaying the New XML Schema ..................................................................................... 503
   Creating XML Schema from EDIFACT Messages ................................................................. 504
      Setting Wizard Options ..................................................................................................... 504
      Running the EDIFACT to XML Schema Documentation Wizard ....................................... 504
   Creating XML Schema from X12 Transaction Sets ............................................................... 505
      Setting Wizard Options ..................................................................................................... 506
      Running the X12 to XML Schema Documentation Wizard ............................................... 506
   Creating XML Schema from IATA Message Types .............................................................. 507
      Setting Wizard Options ..................................................................................................... 507
      Running the IATA to XML Schema Documentation Wizard ............................................ 507
# Contents

Working with XML Schema in Stylus Studio .................................................. 508
Views in the XML Schema Editor .................................................................. 509
Validating XML Schema ................................................................................. 513
Updating XML Schema Associated with a Document .................................. 513
Viewing an XML Instance .............................................................................. 513
Using XML Schema in XQuery and XSLT Mapper ...................................... 514
Printing ........................................................................................................ 515
  Printing XML Schema ................................................................................ 515
  Printing XML Schema Documentation ...................................................... 515
Node Properties ............................................................................................ 516
  Working with Properties in the Diagram .................................................... 516
Getting Started with XML Schema in the Tree View .................................... 517
Description of Sample XML Schema ........................................................... 517
Tips for Adding Nodes .................................................................................. 518
Defining a complexType in a Sample XML Schema in the Tree View ........ 518
  Defining the Name of the Sample complexType in the Tree View .......... 518
  Adding an Attribute to a Sample complexType in the Tree View ......... 519
  Adding Elements to a Sample complexType in the Tree View .......... 519
  Adding Optional Elements to a Sample complexType in the Tree View .. 520
  Adding an Element That Contains Subelements to a complexType in the Tree View ............................................................ 520
  Choosing the Element to Include in the Sample complexType in the Tree View ............................................................ 521
Defining Elements of the Sample complexType in the Tree View ............... 522
Defining simpleTypes in XML Schemas ....................................................... 522
  About simpleTypes in XML Schemas ....................................................... 523
Examples of simpleTypes in an XML Schema ............................................ 524
Defining a simpleType in the Diagram View ............................................... 525
  Before You Begin ...................................................................................... 525
  Defining an Atomic simpleType .............................................................. 525
  Specifying a Restriction for a simpleType – QuickEdit ......................... 526
  Specifying a Restriction for a simpleType – Manually ......................... 527
  Defining List and Union simpleTypes ...................................................... 528
Defining a simpleType in the Tree View ....................................................... 529
About Facet Types for simpleTypes ............................................................. 531
Defining List and Union simpleTypes in the Tree View ................................ 532
Defining complexTypes in XML Schemas ................................................... 533
  Defining complexTypes That Contain Elements and Attributes – Diagram View ............................................................ 534
  Adding Nodes to a complexType ............................................................. 534
  Choosing an Element ................................................................................ 535
  Including All Elements .......................................................................... 536

xxiv
Contents

Specifying the Sequence of Elements .............................................. 536
Reordering Nodes ................................................................. 537
Combining the Sequence and Choice Modifiers ............................... 537
Defining complexTypes That Contain Elements and Attributes – Tree View 538
Defining complexTypes That Mix Data and Elements ....................... 540
  Diagram View ........................................................................... 540
  Tree View ............................................................................... 541
Defining complexTypes That Contain Only Attributes ........................ 541
  Diagram View ........................................................................... 541
  Tree View ............................................................................... 542
Defining Elements and Attributes in XML Schemas ......................... 543
  Defining Elements That Carry Attributes and Contain Data in XML Schemas 544
    Diagram View ........................................................................... 544
    Tree View ............................................................................... 545
  Defining Elements That Contain Subelements in XML Schemas .......... 547
    Diagram View ........................................................................... 547
    Tree View ............................................................................... 547
Adding an Identity Constraint to an Element .................................. 548
  Example of an Identity Constraint ............................................ 549
    Diagram View ........................................................................... 550
    Tree View ............................................................................... 550
Defining Groups of Elements and Attributes in XML Schemas .......... 551
  Defining Groups of Elements in XML Schemas – Diagram View ...... 552
    Alternative .............................................................................. 553
  Defining Groups of Elements in XML Schemas – Tree View .......... 553
  Defining attributeGroups in XML Schemas – Diagram View .......... 554
  Defining attributeGroups in XML Schemas – Tree View ............... 554
Adding Comments, Annotation, and Documentation Nodes to XML Schemas .................................................. 555
  Comments ............................................................................... 555
  Annotations ............................................................................. 555
    Diagram View ........................................................................... 556
    Tree View ............................................................................... 556
    Moving a Comment or Annotation ........................................... 557
      Example ................................................................................ 557
  Defining Notations ..................................................................... 558
    Diagram View ........................................................................... 558
    Tree View ............................................................................... 558
Contents

Referencing External XML Schemas ................................................................. 559
  Ways to Reference XML Schemas ............................................................... 560
    Including an XML Schema ................................................................. 560
    Importing an XML Schema ..................................................................... 560
    Redefining an XML Schema .................................................................... 560
  Where You Can Reference XML Schemas ....................................................... 561
    What to Do Next ....................................................................................... 561
  Referencing XML Schemas in the Diagram View ............................................ 562
  Referencing XML Schemas in the Tree View ................................................ 563
  Redefining Nodes ......................................................................................... 564
    Extensions and Restrictions ..................................................................... 564
    Specifying Restriction Facets .................................................................. 564
    How to Redefine a Node ......................................................................... 565
  Generating Documentation for XML Schema ................................................ 566
    XS3P Stylesheet Overview ....................................................................... 567
    XS3P Stylesheet Features ......................................................................... 568
    XS3P Stylesheet Settings ......................................................................... 569
    Modifying the XS3P Stylesheet ............................................................... 570
    XSDdoc Stylesheet Overview .................................................................... 571
    XSDdoc Stylesheet Settings ...................................................................... 571
    Choosing a Display Option for XML Schema Documentation .................. 572
    Saving XML Schema Documentation ....................................................... 573
    Printing XML Schema Documentation ................................................... 573
  Generating JAXB Classes ............................................................................ 573
    What Stylus Studio Generates ................................................................... 574
    How to Generate JAXB Classes .............................................................. 574
    Compiling JAXB Class Files .................................................................... 575
  About XML Schema Properties ..................................................................... 575
    About xsd:schema Properties ................................................................. 576
    Element and Element Reference Properties in XML Schemas ................. 578
    Attribute and Attribute Reference Properties in XML Schemas ............... 580
    Group Properties in XML Schemas ......................................................... 582
    Model Group Properties in XML Schemas ............................................... 582
    Complex and simpleType Properties in XML Schemas ........................... 584
    Restriction and Extension Type Properties in XML Schemas ................. 585
    Content Type Properties in XML Schemas ............................................. 585
    Aggregator Type Properties in XML Schemas ......................................... 586
    Facet Type Properties in XML Schemas .................................................. 587
    Notation Type Properties in XML Schemas ............................................. 588
# Chapter 8: Defining Document Type Definitions

- What Is a DTD? .................................................. 591
- Creating DTDs .................................................. 592
- About Editing DTDs .......................................... 593
  - Restrictions .................................................. 593
- About Modifiers in Element Definitions in DTDs .......................... 594
  - Description of Element Modifiers in DTDs ............... 594
  - Simple Example of Aggregating Modifiers in DTDs .......... 595
  - More Complex Example of Aggregating Modifiers in DTDs ...... 596
  - Aggregating Modifiers to Allow Any Order and Any Number in DTDs 596
- Defining Elements in DTDs .................................. 597
  - Defining Elements in the DTD Tree Tab ...................... 598
  - Specifying That an Element Can Have an Attribute in DTDs .. 599
  - Specifying That an Element is Required in DTDs ............ 599
  - Specifying That an Element is Optional in DTDs ............ 600
  - Specifying That Multiple Instances of An Element Are Allowed in DTDs 601
  - Specifying That An Element Can Contain One of a Group of Elements in DTDs 603
  - Specifying That an Element Can Contain One or More Elements in DTDs .... 604
  - Specifying That an Element Can Contain Data in DTDs .......... 605
  - Moving, Renaming, and Deleting Elements in DTDs ........ 605
- Defining General Entities and Parameter Entities in DTDs ............. 606
  - Steps for Defining Entities in DTDs ......................... 606
  - General Entity Example in a DTD .......................... 607
  - Parameter Entity Example in a DTD ......................... 608
- Inserting White Space in DTDs .................................. 608
- Adding Comments to DTDs ....................................... 608
- About Node Properties in DTDs .................................. 609
  - Description of Element Properties in DTDs ............... 609
  - Description of Attribute Properties in DTDs ............... 610
  - Description of Entity and Parameter Entity Properties in DTDs 612
- Associating an XML Document with an External DTD .................. 613
- Moving an Internal DTD to an External File ....................... 613
Chapter 9: Writing XPath Expressions

About the XPath Processor ........................................... 616
Where You Can Use XPath Expressions ......................... 616
About XPath .................................................................. 616
Benefits of XPath .......................................................... 617
Internationalization ...................................................... 618
Restrictions on Queries ................................................. 618

Using the XPath Query Editor ........................................ 619
Parts of the XPath Query Editor ...................................... 619
Displaying the XPath Query Editor ................................. 620
Customizing Syntax Coloring ........................................ 621
Working with XPath Queries ........................................ 621
Executing the Query ..................................................... 621
Creating a New Query .................................................. 622
Deleting a Query .......................................................... 622
Working with Query Results .......................................... 623
Opening Query Results as a New Document .................. 623
Working with Namespaces ............................................. 624

Sample Data for Examples and Practice .......................... 625
About XML Document Structure ................................... 625
A Sample XML Document ............................................ 626
Tree Representation of a Sample XML Document ............. 626
Steps for Trying the Sample Queries ............................... 628

Getting Started with Queries .......................................... 629
Obtaining All Marked-Up Text ....................................... 629
Obtaining a Portion of an XML Document ....................... 630
Obtaining All Elements of a Particular Name .................... 631
Obtaining All Elements of a Particular Name from a
Particular Branch ...................................................... 632
Different Results from Similar Queries ............................ 633
Queries That Return More Than You Want ...................... 633
Specifying Attributes in Queries .................................... 634
Restrictions ................................................................. 635
Attributes and Wildcards .............................................. 635
Filtering Results of Queries .......................................... 635
Quotation Marks in Filters .......................................... 636
More Filter Examples .................................................... 636
How the XPath Processor Evaluates a Filter .................... 637
## Contents

Multiple Filters ........................................... 637  
Filters and Attributes ................................. 638  
Wildcards in Queries .................................. 638  
Restrictions ........................................... 638  
Attributes ............................................. 639  
Calling Functions in Queries ........................... 639  
Case Sensitivity and Blank Spaces in Queries ......... 640  
Precedence of Query Operators ............................ 641  
Specifying the Nodes to Evaluate ....................... 642  
Understanding XPath Processor Terms ................. 643  
  Axis .............................................. 643  
  Context Node ...................................... 643  
  Context Node Set .................................. 643  
  Current Node ...................................... 643  
  Document Element .................................. 643  
  Filter ............................................ 644  
  Location Path Expression ......................... 644  
  Location Step ...................................... 644  
  Node Test ........................................ 644  
  Root Node ........................................ 644  
Starting at the Context Node ............................ 645  
About Root Nodes and Document Elements ............. 645  
Starting at the Root Node ................................ 645  
Descending Along Branches .............................. 646  
Explicitly Specifying the Current Context ............. 647  
Specifying Children or Descendants of Parent Nodes 648  
Examples of XPath Expression Results ................. 648  
Syntax for Specifying an Axis in a Query ............... 649  
Supported Axes ........................................ 650  
  About the child Axis ................................ 650  
  About the descendant Axis ......................... 651  
  About the parentAxis ............................... 651  
  About the ancestor Axis ............................... 651  
  About the following-sibling Axis .................. 652  
  About the preceding-sibling Axis ................. 652  
  About the following Axis ......................... 652  
  About the preceding Axis ......................... 653  
  About the attribute Axis .............................. 653  
  About the namespace Axis ............................ 654
## Contents

- About the self Axis .................................................. 654
- About the descendant-or-self Axis ................................. 654
- About the ancestor-or-self Axis .................................. 655
- Axes That Represent the Whole XML Document ................. 655

### Handling Strings and Text .................................... 656

- Searching for Strings .............................................. 656
  - Finding Identical Strings ...................................... 656
  - Case Sensitivity .................................................. 657
  - Finding Strings That Contain Strings You Specify .......... 657
  - Finding Substrings That Appear Before Strings You Specify 657
  - Finding Substrings That Appear After Strings You Specify 658
  - Finding Substrings by Position ............................... 658
- Manipulating Strings .............................................. 659
  - Concatenating Strings ........................................... 659
  - Determining the Number of Characters in a String .......... 659
  - Normalizing Strings ............................................. 660
  - Replacing Characters in Strings with Characters You Specify 660
  - Converting Objects to Strings ................................. 661
  - Finding Strings That Start with a Particular String ....... 662
- Obtaining the Text Contained in a Node ....................... 662

### Specifying Boolean Expressions and Functions ................ 663

- Using Boolean Expressions ....................................... 663
  - Case Sensitivity .................................................. 663
  - Examples .......................................................... 663
- Calling Boolean Functions ....................................... 664
  - Converting an Object to Boolean ............................. 664
  - Obtaining Boolean Values ..................................... 665
  - Determining the Context Node Language ..................... 665

### Specifying Number Operations and Functions .................. 666

- Performing Arithmetic Operations ............................... 666
- Calling Number Functions ....................................... 667
  - Converting an Object to a Number .......................... 667
  - Obtaining the Sum of the Values in a Node Set ............ 668
  - Obtaining the Largest, Smallest, or Closest Number ....... 668

### Comparing Values .................................................. 669

- About Comparison Operators ..................................... 670
- How the XPath Processor Evaluates Comparisons .............. 670
- Comparing Node Sets .............................................. 671
  - Two Node Sets ................................................... 671
## Contents

- Obtaining the Current Node for the Current XSLT Template ........................................... 688
- Finding an Element with a Particular Key ........................................................................... 689
- Generating Temporary IDs for Nodes ................................................................................. 691
  - Format .............................................................................................................................. 691
- Accessing Other Documents During Query Execution ......................................................... 691
  - Format of the document() Function ................................................................................ 692
  - When the First Argument is a Node Set ............................................................................ 692
  - Specification of Second Argument .................................................................................... 692
  - Example of Calling the document() Function .................................................................... 693
- XPath Quick Reference ...................................................................................................... 693
  - XPath Functions Quick Reference ..................................................................................... 694
  - XPath Syntax Quick Reference ......................................................................................... 698
    - Axes ............................................................................................................................... 698
    - Node Tests .................................................................................................................... 698
    - Filters ............................................................................................................................ 699
    - Location Steps ............................................................................................................... 699
    - XPath Expression ......................................................................................................... 699
- XPath Abbreviations Quick Reference ................................................................................ 699

## Chapter 10: Working with XQuery in Stylus Studio ............................................................ 703

### Getting Started with XQuery in Stylus Studio ................................................................. 704
- What is XQuery? .................................................................................................................. 704
  - Example ............................................................................................................................ 704
  - Sources for Additional XQuery Information .................................................................... 704
- What is an XQuery? ............................................................................................................. 705
- The Stylus Studio XQuery Editor ......................................................................................... 705
  - XQuery Source Tab ......................................................................................................... 705
  - Mapper Tab ....................................................................................................................... 707
  - XQuery Source and Mapper Tab Interaction .................................................................... 708
- An XQuery Primer .............................................................................................................. 708
  - What is XQuery For? ....................................................................................................... 709
- Your First XQueries ............................................................................................................ 709
- Accessing XML Documents with XQuery .......................................................................... 710
  - Handling URLs ................................................................................................................ 711
  - The videos.xml Document .............................................................................................. 711
- XQuery and XPath ............................................................................................................... 711
  - XPath Query Editor ......................................................................................................... 715
  - Introduction to FLWOR Expressions ............................................................................... 715
Contents

Generating XML Output with XQuery ........................................... 717
Accessing Databases with XQuery ............................................. 719
Understanding FLWOR Expressions ........................................... 720
Simple XQuery FLWOR Expressions ......................................... 720
The Principal Parts of an XQuery FLWOR Expression ..................... 721
  F is for For ............................................................................ 721
  L is for Let .......................................................................... 725
  W is for Where ..................................................................... 729
  O is for Order By ............................................................... 730
  R is for Return ..................................................................... 731
Other Parts of the XQuery FLWOR Expression ............................... 733
 Declaring XQuery Types ......................................................... 734
  XQuery Position Variables .................................................... 734
  Multiple Assignments .......................................................... 735
Grouping ............................................................................... 735
Building an XQuery Using the Mapper ........................................ 736
Process Overview .................................................................... 737
  Working with Existing XQueries ............................................ 737
  Saving the Mapping ............................................................. 737
Source Documents ................................................................... 738
  Choosing Source Documents ................................................ 738
  Source Documents and XML Instances ................................... 738
  Source document icons ........................................................ 740
  How to Change a Source Document Association ....................... 740
  How to Add a Source Document ............................................. 740
  How to Remove a Source Document ....................................... 743
  How Source Documents are Displayed .................................... 743
  Document structure symbols ............................................... 744
  Getting source document details ............................................ 744
Specifying a Target Structure ................................................... 744
  Using an Existing Document ................................................ 745
  Building a Target Structure .................................................. 745
Modifying the Target Structure ................................................ 747
  Adding a Node ..................................................................... 747
  Removing a Node ............................................................... 747
  Setting a Text Value ............................................................ 747
Mapping Source and Target Document Nodes ............................... 748
  Preserving Mapper Layout ................................................... 748
Left and Right Mouse Buttons Explained ................................. 749
## Contents

- How to Map Nodes ........................................ 750
- Link Lines Explained .................................. 750
- Removing Source-Target Map .......................... 753

### Simplifying the Mapper Canvas Display
- Other Mapper Display Features ...................... 755

### Exporting Mappings
- Searching Document Panes ............................. 756
- FLWOR Blocks ........................................... 756
  - Parts of a FLWOR Block ................................ 757
  - Creating a FLWOR Block ............................. 758
- Function Blocks ......................................... 759
  - Standard Function Block Types ..................... 759
  - Creating a Function Block ........................... 759
  - Parts of a Function Block ............................ 760
  - User-Defined Functions ................................ 761
  - concat Function Blocks ................................ 762
- IF Blocks .................................................. 762
- Condition Blocks ....................................... 763

### Working with the XQuery collection() Function
- Using the collection() Function in Stylus Studio 764
- How the collection() Function is Processed ....... 765
  - Database Connections .................................. 766
  - Handling Invalid Characters ........................ 766
- Creating a Database Connection ..................... 765
- Creating a collection() Statement ................... 767
- collection() Function Syntax ........................ 767
- What Happens When You Create a collection() Statement? 767
- Creating Multiple Connections ...................... 768
- How to Create a collection() Statement .......... 769

### Other Ways to Register a Database Configuration
- Choosing a Database Object .......................... 770

### Debugging XQuery Documents
- Using Breakpoints ...................................... 772
- Inserting Breakpoints ................................ 773
- Removing Breakpoints ................................ 773
- Start Debugging ........................................ 773
- Viewing Processing Information ..................... 774
- Watching Particular Variables ....................... 774
- Evaluating XPath Expressions in the Current Processor Context 774
# Contents

Obtaining Information About Local Variables .................................................. 774
Displaying a List of Process Suspension Points .................................................. 775
Displaying XQuery Expressions for Particular Output ........................................ 775
Using Bookmarks .................................................................................................. 775
Inserting ................................................................................................................ 776
Removing .............................................................................................................. 776
Moving Focus ........................................................................................................ 776
Profiling XQuery Documents .................................................................................. 777
About Performance Metrics .................................................................................. 778
Enabling the Profiler .............................................................................................. 778
Displaying the XQuery Profiler Report ................................................................. 779
Creating an XQuery Scenario .................................................................................. 780
Specifying XML Input ............................................................................................ 780
Selecting an XQuery Processor ............................................................................. 782
Setting Default Options for Processors ............................................................... 785
Setting Values for External Variables ................................................................. 786
Performance Metrics Reporting ............................................................................ 786
Validating XQuery Results .................................................................................... 787
How to Create a Scenario ...................................................................................... 788
How to Run a Scenario .......................................................................................... 789
How to Clone a Scenario ...................................................................................... 789
Generating XQuery Documentation ........................................................................ 790
Documentation Defaults ...................................................................................... 790
Syntax and Usage ................................................................................................... 791
Save the XQuery Document .................................................................................. 792
ActiveX Controls .................................................................................................... 792
Viewing Code Samples .......................................................................................... 793
How to Generate XQuery Documentation ............................................................. 793
Using XQuery to Invoke a Web Service ................................................................. 794
Requirements ........................................................................................................ 795
Using the Saxon Processor ..................................................................................... 795
Invoking a SOAP Request in an XQuery ............................................................... 796
Invoking Multiple SOAP Requests ....................................................................... 796
Rules ....................................................................................................................... 796
How to Invoke Multiple SOAP Requests in the Same XQuery ............................ 797
Generating Java Code for XQuery .......................................................................... 797
Scenario Settings ................................................................................................... 798
Choosing Scenarios ............................................................................................... 799
Java Code Generation Settings ............................................................................. 800
Contents

Creating a Web Service Call Scenario .............................................. 825
  Overview of Scenario Features ................................................. 825
  Scenario Names ................................................................. 826
  Transport Protocol and Client Settings ..................................... 826
  Other Transport Settings ..................................................... 826
  How to Create a Scenario ..................................................... 827
  How to Run a Scenario ....................................................... 828
  How to Clone a Scenario ..................................................... 829

Chapter 12: Accessing Relational Data as XML ................................. 831
  Overview of DB-to-XML Data Sources ...................................... 832
  System Requirements ........................................................... 832
  Supported Databases ........................................................... 832
  DB-to-XML Data Source Scenarios .......................................... 833
  The DB-to-XML Data Source Editor ........................................... 834
    SQL/XML Editor Pane ......................................................... 834
    Database Schema Pane ....................................................... 835
  Working with Relational Data ................................................ 836
  Creating a DB-to-XML Data Source ......................................... 836
    Before You Begin ............................................................. 837
    How to Create a DB-to-XML Data Source ............................... 837
    Saving a DB-to-XML Data Source ......................................... 838
    Opening a DB-to-XML Data Source ....................................... 838
  Specifying Connection Settings .............................................. 839
    Choosing a Database ........................................................ 839
    Using the Server URL Field ............................................... 840
    Username and Password ..................................................... 840
    Creating a Default Database Connection ................................. 840
    Creating a Database Connection from the File Explorer ............... 841
  Using an ODBC Data Source in Stylus Studio ............................... 842
    Installing DataDirect SequeLink SocketServer ........................... 843
    Creating an ODBC System Data Source .................................. 843
    Configuring DataDirect SequeLink to Reference an ODBC System Data Source .......................................... 847
    Using DataDirect SequeLink as a DB-to-XML Data Source .......... 850
  Working with Scenarios ........................................................ 852
    Opening the Scenario Properties Dialog Box ............................. 853
    Creating a Scenario ........................................................ 853
      Naming Scenarios ........................................................... 853
      How to Create a Scenario ................................................ 854
## Contents

Alternative ................................................................. 854  
How to Modify a Scenario ............................................ 854  
How to Clone a Scenario .............................................. 855  
How to Rename a Scenario ............................................ 855  
How to Delete a Scenario .............................................. 856  
Composing SQL/XML in Stylus Studio ............................... 857  
   Manually Entering SQL/XML ........................................ 857  
   Using Drag-and-Drop ............................................... 857  
      Example ............................................................ 858  
   How Relational Data is Translated to XML ......................... 858  
Working with Relational Data as XML ............................... 860  
   Understanding SELECT and UPDATE ............................... 860  
      When Statements are Executed ................................ 861  
      Example ............................................................ 861  
      The SELECT Statement ......................................... 861  
      The INSERT Statement ......................................... 862  
   Saving the File .................................................... 862  
   Opening the .rdxml as XML ....................................... 863  
   Updating the Data in the Database ................................ 864  

### Chapter 13: Integrating with Third-Party File Systems .............. 865  
Using Stylus Studio with Berkeley DB XML .......................... 866  
   Overview ............................................................ 866  
      Berkeley DB XML Support ........................................ 867  
      Usage Summary ................................................... 867  
   Prerequisites .......................................................... 868  
      Saving Files to Berkeley DB XML ................................ 869  
   Configuring the BerkeleyDBXML.xml File ......................... 869  
      The Berkeley Database Environment ........................... 869  
      The BerkeleyDBXML.xml Configuration File .................. 870  
      How to Configure BerkeleyDBXML.xml ....................... 871  
      Open the Output Window ....................................... 871  
   Naming Files .......................................................... 871  
      Example – Berkeley DB XML V 1.2.1 .......................... 872  
   Opening a File Stored on Berkeley DB XML ....................... 873  
   Saving a File Back to Berkeley DB XML ........................... 873  
      Saving and Containers .......................................... 873  
      Validating Documents .......................................... 874
## Contents

- Creating Containers with Stylus Studio ........................................ 875
  - Node and Wholedoc Containers ............................................. 875
- Usage Tips .................................................................................. 876
  - Before Starting Stylus Studio .................................................. 876
  - Database Environment Recovery ............................................... 876
- Using Stylus Studio with TigerLogic XDMS .................................... 876
  - Overview .................................................................................. 876
  - TigerLogic XDMS Version Support ............................................ 877
  - Connecting to TigerLogic XDMS ............................................... 877
    - What Happens When You Connect ........................................... 878
    - How to Connect to TigerLogic XDMS ........................................ 878
    - Reconnecting ........................................................................ 879
  - Using Documents Stored on TigerLogic XDMS ............................ 879
    - Opening Documents ................................................................ 880
    - Saving Documents .................................................................. 880
    - Using Documents in XQuery and XSLT .................................... 880
  - Creating Collections .................................................................. 880

### Chapter 14: Extending Stylus Studio ...................................... 883

- Custom XML Validation Engines .................................................. 884
  - Registering a Custom Validation Engine ..................................... 884
  - Configuring a Custom Validation Engine ..................................... 885
    - The Custom Validation Engines Page ....................................... 885
    - How to Configure a Custom Validation Engine ........................... 888
- Custom Document Wizards ......................................................... 889
  - Registering a Custom Document Wizard ...................................... 890
  - Configuring a Custom Document Wizard ...................................... 890
    - The Custom Document Wizards Page ....................................... 891
    - Defining Arguments ................................................................ 895
    - How to Configure a Custom Document Wizard ......................... 899

### Chapter 15: The Stylus Studio Java API ................................ 901

- Java API Overview ...................................................................... 901
  - Data Access ............................................................................. 902
  - Package Summary ...................................................................... 903
    - Javadoc for the Stylus Studio Java API .................................... 903
      - com.stylusstudio.converter .................................................. 903
      - com.exln.stylus.io ............................................................. 904
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.stylusstudio.version</td>
<td>905</td>
</tr>
<tr>
<td>Stylus Studio URL Schemes</td>
<td>906</td>
</tr>
<tr>
<td>Invoking an Adapter Programmatically</td>
<td>907</td>
</tr>
<tr>
<td>The adapter: URL Scheme</td>
<td>907</td>
</tr>
<tr>
<td>Adapter URL Syntax</td>
<td>908</td>
</tr>
<tr>
<td>Where Adapter URLs are Displayed in Stylus Studio</td>
<td>909</td>
</tr>
<tr>
<td>Constructing Your Own Adapter URL</td>
<td>910</td>
</tr>
<tr>
<td>Using the URL in the Select XML Converter Dialog Box</td>
<td>910</td>
</tr>
<tr>
<td>Using the URL in the Properties Window</td>
<td>910</td>
</tr>
<tr>
<td>Example – demo.java</td>
<td>912</td>
</tr>
<tr>
<td>Demonstration Files</td>
<td>912</td>
</tr>
<tr>
<td>Running demo.java</td>
<td>912</td>
</tr>
<tr>
<td>Required Classes</td>
<td>913</td>
</tr>
<tr>
<td>Setting the Installation Directory</td>
<td>913</td>
</tr>
<tr>
<td>Example 1</td>
<td>913</td>
</tr>
<tr>
<td>Example 2</td>
<td>914</td>
</tr>
<tr>
<td>Example 3</td>
<td>914</td>
</tr>
<tr>
<td>Example 4</td>
<td>915</td>
</tr>
<tr>
<td>Example 5</td>
<td>917</td>
</tr>
<tr>
<td>Deploying Applications</td>
<td>918</td>
</tr>
<tr>
<td>Stylus Studio XML Deployment Components</td>
<td>918</td>
</tr>
<tr>
<td>Unlocking the API</td>
<td>918</td>
</tr>
<tr>
<td>Setting Up the Deployment Environment</td>
<td>919</td>
</tr>
<tr>
<td>Custom File Systems</td>
<td>919</td>
</tr>
<tr>
<td>Creating a Custom File System</td>
<td>920</td>
</tr>
<tr>
<td>File System Interfaces</td>
<td>921</td>
</tr>
<tr>
<td>Examples</td>
<td>921</td>
</tr>
<tr>
<td>Registering a Custom File System</td>
<td>921</td>
</tr>
<tr>
<td>The Custom File Systems Page</td>
<td>922</td>
</tr>
<tr>
<td>How to Display</td>
<td>923</td>
</tr>
<tr>
<td>Fields</td>
<td>923</td>
</tr>
<tr>
<td>How to Register a Custom File System</td>
<td>924</td>
</tr>
<tr>
<td>Adapter Properties</td>
<td>924</td>
</tr>
<tr>
<td>Line Separator Values</td>
<td>925</td>
</tr>
<tr>
<td>Base-64 Adapter Properties</td>
<td>925</td>
</tr>
<tr>
<td>Adapter Name in URL</td>
<td>926</td>
</tr>
<tr>
<td>Comma-Separated and Tab-Separated Values Adapter Properties</td>
<td>926</td>
</tr>
<tr>
<td>Adapter Names in URL</td>
<td>926</td>
</tr>
</tbody>
</table>
Preface

This Preface contains the following sections:

- **About This Manual** describes this manual and its intended audience.
- **Conventions in This Manual** describes the text formatting, syntax notation, and flags used in this manual.
- **Available Documentation** describes the printed and online documentation that accompanies Stylus Studio® 2006.
- **Technical Support** provides information on contacting Technical Support.

### About This Manual

This manual describes how to use Stylus Studio 2006 to develop XML applications. It is assumed that you are familiar with XML and the concepts of it and its related technologies.

This manual has the following chapters:

- **Chapter 1, “Getting Started with Stylus Studio® 2006,”** provides step-by-step instructions for editing an XML document, applying a stylesheet, creating a dynamic Web page, debugging stylesheets and Java files, and mapping an XML document with one schema to an XML document with another schema.
- **Chapter 2, “Editing and Querying XML,”** describes how to update an XML document in the text, tree, schema, and grid views of the XML editor. It also provides information about how to query documents and handle query results.
- **Chapter 3, “Converting Non-XML Files to XML,”** describes how to use the Stylus Studio Convert to XML module to create converters that allow you to open any flat file (.txt, binary, or EDI, for example) as an XML document.
Preface

- Chapter 4, “Working with XSLT,” includes a tutorial for using XSLT and understanding how XSLT works. It provides information and instructions for using the XSLT editor to create, modify, and apply stylesheets. It also contains reference information for the various XSLT instructions you can specify in a stylesheet.
- Chapter 5, “Creating XSLT Using the XSLT Mapper,” describes how to use the Stylus Studio XML mapper. The XML mapper generates a stylesheet for transforming an XML document that uses one schema to an XML document that uses another schema.
- Chapter 6, “Debugging Stylesheets,” describes how to use the Stylus Studio debugging features.
- Chapter 7, “Defining XML Schemas,” provides information and instructions for creating and editing DTDs and XML Schema documents.
- Chapter 8, “Defining Document Type Definitions,” provides information about how to use the Stylus Studio Document Type Definition (DTD) editor to define a DTD.
- Chapter 9, “Writing XPath Expressions,” includes complete information about how to define a query, which must be an XPath expression. In addition to explicitly running a query on an XML document, you specify queries as the values of `select` and `match` attributes in stylesheets.
- Chapter 10, “Working with XQuery in Stylus Studio,” describes how to work with XQuery in Stylus Studio, including how to use the XQuery debugger.
- Chapter 11, “Composing Web Service Calls,” describes how to design, compose, and test a Web service call without writing any code, and how to use the Web service calls you create elsewhere in Stylus Studio.
- Chapter 12, “Accessing Relational Data as XML,” describes how to use Stylus Studio to connect to a relational database, and how to query and update relational data.
- Chapter 13, “Integrating with Third-Party File Systems,” describes how Stylus Studio is integrated with third-party file systems, including Sleepycat Software’s Berkeley DB XML and RainingData® TigerLogic® XML Data Management Server (TigerLogic XDMS).
- Chapter 14, “Extending Stylus Studio,” provides a description of advanced Stylus Studio features, including information about using the Stylus Studio custom document wizard.
- Chapter 15, “The Stylus Studio Java API,” provides an overview of the Stylus Studio Java API and describes the demonstration application that is installed with Stylus Studio. It also provides additional information on deploying applications you develop with the Java API.
Conventions in This Manual

This section describes the typographical and formatting conventions used in this manual for text, notes, warnings, and important messages.

Typographical Conventions

This manual uses the following typographical conventions:

- **Bold typeface in this font** indicates keyboard key names (such as Tab or Enter) and the names of windows, menu commands, buttons, and other user-interface elements. For example, “From the File menu, select Open.”

- **Italic text** emphasizes new terms when they are introduced.

- Code samples appear in text like this:

  ```
  -Xdebug -Xnoagent -Xrunjdwp:transport=dt_socket, server=y,suspend=n,address=8000  -Djava.compiler=NONE
  ```

- **Monospace typeface** indicates text that might appear on a computer screen such as
  - Code that the user must enter
  - System output (such as responses, error messages, and so on)
  - Filenames and pathnames
  - Software component names, such as class and method names

  Essentially, monospace typeface indicates anything that the computer is “saying,” or that must be entered into the computer in a language that the computer “understands.” **Bold monospace typeface** emphasizes text that would otherwise appear in monospace typeface.

  *Monospace typeface in italics* or **Bold monospace typeface in italics** (depending on context) indicates variables or placeholders for values you supply or that might vary from one case to another.

  ◆ **Procedures are introduced this way:**
Syntax Notation

This manual uses the following syntax notation conventions:

- Brackets ([ ]) in syntax statements indicate parameters that are optional.
- Braces ({ }) indicate that one (and only one) of the enclosed items is required. A vertical bar (|) separates the alternative selections.
- Ellipses (…) indicate that you can choose one or more of the preceding items.

Information Alerts

This manual highlights special kinds of information by shading the information area, and indicating the type of alert in the left margin.

Tip

A Tip flag identifies information that can help you use Stylus Studio more effectively – short-cuts, alternatives, and information about system behavior are all examples of tips.

Note

A Note flag indicates information that complements the main text flow. Such information is especially needed to understand the concept or procedure being discussed.

Important

An Important flag indicates information that must be acted upon within the given context in order for the procedure or task (or other) to be successfully completed.

Warning

A Warning flag indicates information that can cause loss of data or other damage if ignored.

Edition Alerts

Not all features are supported in all editions of Stylus Studio. Documentation that describes features peculiar to a given edition is identified with an alert like the following:

XQuery support is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

See Stylus Studio Editions on page 3 for more information about the features that are available in a given edition.
**Video Alerts**

Stylus Studio provides dozens of video demonstrations of editing tools and features for XSLT, XQuery, XML Schema, relational-to-XML conversion, and others. Sections in the documentation that describe a Stylus Studio feature for which a video demonstration exists include an alert like the following:

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: [watch a video on Convert to XML](http://www.StylusStudio.com/xml_videos.html).

Clicking either the television icon or the hyperlink launches the video.

**Video Descriptions**

You can find descriptions of all Stylus Studio video demonstrations here:


**Available Documentation**

Table 1 lists the documentation supplied with Stylus Studio. In addition to the documentation listed in this table, Stylus Studio comes with sample files. All documentation is included with the Stylus Studio media and downloads.

### Table 1. The Stylus Studio Documentation Set

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stylus Studio® 2006 User Guide</strong></td>
<td>Describes how to use Stylus Studio to develop XML applications using XML, SQL/XML, XQuery, Web Services, and XSLT.</td>
</tr>
<tr>
<td><strong>ReadMe</strong></td>
<td>Describes features in the current release of Stylus Studio plus late-breaking information and known issues. The release notes are located in the \doc directory where you installed Stylus Studio.</td>
</tr>
<tr>
<td><strong>Online help</strong></td>
<td>Stylus Studio’s online help system can be accessed from the application by pressing F1 or by selecting Help &gt; Documentation from the menu bar. You can also view the help independently of the application, by opening \ide.chm in the \doc directory where you installed Stylus Studio.</td>
</tr>
</tbody>
</table>
Technical Support

Submit questions and report problems using the Stylus Studio Developer Network (SSDN). Once you log in, navigate to the Stylus Studio Technical Forum, and enter your issue there.

When submitting an issue, consider providing the following information:

- The release version number and serial number of your copy of Stylus Studio. This information is listed in the About Stylus Studio dialog box (click Help > About Stylus Studio on the menu bar).
- Your name and, if applicable, your company name.
- E-mail address, telephone, and fax numbers for contacting you.
- The platform on which you are running Stylus Studio, as well as any other environment information you think might be relevant, such as the Java Virtual Machine (JVM) you are using.
Stylus Studio® 2006 (Stylus Studio) is an integrated development environment (IDE) for XML and related technologies. Stylus Studio allows you to design, develop, and test XML applications using its intuitive graphical interface, textual editors, and debuggers for XML, XML Schema, DTD, XQuery, XSLT, Web services, and Java.

Figure 1. Stylus Studio’s XML Schema Diagram Editor
Stylus Studio includes modules for:

- XML
- XQuery
- XSLT
- DTD
- XML Schema
- SQL/XML
- Web services
- Java
- Converting non-XML files to XML using built-in and user-defined adapters

Each module has one or more editors to help you author, edit, and debug XML applications.

In this chapter

This chapter provides a tour of the basic operations Stylus Studio provides with each of its modules. It also includes information about opening files in any module, using projects to organize files, and setting options that affect all modules.

This chapter is organized as follows:

- “Stylus Studio Editions” on page 3
- “Starting Stylus Studio” on page 5
- “Updating an XML Document—Getting Started” on page 6
- “Working with Stylesheets — Getting Started” on page 26
- “Stylesheets That Generate HTML — Getting Started” on page 47
- “Using the XSLT Mapper — Getting Started” on page 64
- “Debugging Stylesheets — Getting Started” on page 72
- “Defining a DTD — Getting Started” on page 80
- “Defining an XML Schema Using the Diagram Tab — Getting Started” on page 85
- “Opening Files in Stylus Studio” on page 108
- “Working with Projects” on page 116
- “Customizing Tool Bars” on page 134
- “Specifying Stylus Studio Options” on page 136
- “Defining Keyboard Shortcuts” on page 140
- “Using Stylus Studio from the Command Line” on page 141
- “Managing Stylus Studio Performance” on page 145
Stylus Studio Editions

Stylus Studio is offered in several editions to provide a tool that is appropriate for every level of user, from integration architects and application developers providing enterprise-class solutions, to students and non-professional users just starting out with XML and related technologies.

Stylus Studio XML Enterprise Edition

Stylus Studio XML Enterprise Edition is Stylus Studio’s most comprehensive XML IDE, offering a complete and robust set of tools for writing, testing, debugging, and deploying XML applications. In addition to editors for XML, XML Schema, XQuery, and XSLT, Stylus Studio XML Enterprise Edition provides the following features exclusive to this edition of Stylus Studio:

- Java code generation for deployment of XQuery and XSLT transformations
- The ability to expose XML Schema to Java binding
- XQuery and XSLT Profilers to help you gather performance metrics and troubleshoot performance bottlenecks
- Convert to XML, a module that allows you to easily convert non-XML files to XML
- Web Service Call Composer to help you build and test calls to hundreds of industry-standard Web services
- Integration with Mark Logic
- Integration with Sleepycat Software’s Berkeley DB XML
- Support for OASIS catalogs, including dozens of catalogs bundled with Stylus Studio

Stylus Studio XML Professional Edition

Stylus Studio XML Professional Edition provides a complete set of tools for the XML application developer, including

- XML Differencing for comparing multiple XML documents and folders
- DB-to-XML Data Sources, a module that allows you to access relational data and render it as XML
- A WYSIWYG HTML designer for XSLT
Custom file systems

These features are also included in Stylus Studio XML Enterprise Edition.

Stylus Studio Home Edition

Stylus Studio Home Edition is a value-priced XML IDE that provides an excellent way to learn about and work with XML and its related technologies. Stylus Studio Home Edition offers many of the features of Stylus Studio XML Professional Edition, allowing you to do real work with XML, XML Schema, XSLT, DTD, and other important XML technologies.

Edition Alerts

The Stylus Studio® 2006 User Guide describes features found in all Stylus Studio editions. Alerts, like the one shown here, are used to identify documentation describing features found only in particular Stylus Studio editions.

The XML Editor Grid tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

More Information

For a complete description of Stylus Studio XML Enterprise, XML Professional, and Home editions, see the Stylus Studio Web site:

Starting Stylus Studio

Throughout this chapter, you perform exercises that require you to first start Stylus Studio. For example, if you installed Stylus Studio XML Enterprise Edition, you would:

The path shown here assumes that you accepted the defaults when you installed Stylus Studio. If you did not, you must alter your selection path accordingly.

You can also start Stylus Studio by double-clicking the desktop icon, which is added to your desktop by default when you install Stylus Studio:

![Figure 2. Example of a Stylus Studio Desktop Icon](image)

On startup, Stylus Studio displays the Tip of the Day dialog box.

![Figure 3. Stylus Studio on Startup (XML Professional Edition Shown)](image)

Getting Updates

By default, Stylus Studio checks the Stylus Studio Web site for newer versions each time you start the application. You can review and modify this and other application settings...
Getting Started with Stylus Studio® 2006

by selecting Tools > Options from the menu bar and selecting the Application Settings page.

If you want, you can perform this check manually by selecting Help > Check for latest version from the Stylus Studio menu.

Getting Help

As you use Stylus Studio, you can press F1 at any time to obtain context-sensitive help. If you want, you can open the online help manually (and independent of the Stylus Studio application) by selecting Start > Programs > Stylus Studio XML Edition Name > Stylus Studio Documentation.

Note: The online documentation is not installed with Stylus Studio. The first time you access the online documentation, you are prompted to download it from the Stylus Studio web site. By default, the online documentation is installed in the \doc directory where you installed Stylus Studio.

Updating an XML Document—Getting Started

Each of the following topics contains instructions for editing a sample XML document. You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps depend on actions you performed in a previous topic. This introduction to updating XML documents in Stylus Studio is organized as follows:

● “Opening a Sample XML Document” on page 6
● “Updating the Text of a Sample Document” on page 8
● “Updating the Schema of a Sample Document” on page 14
● “Updating the Tree Representation of a Sample Document” on page 20
● “Updating a Sample Document Using the Grid Tab” on page 23

Opening a Sample XML Document

1. In the File Explorer window, navigate to the examples\quotes directory in your Stylus Studio installation directory.

Tip: The examples directory is a sibling of bin.
2. Double-click `your-quotes.xml`.

Stylus Studio displays the `your-quotes.xml` document in the XML editor. The initial view of the document is the Text view, as you can see by the tab at the bottom of the window.

![Figure 4. Editors Use Color-Keyed Text](image)

**Tip**  Stylus Studio uses different colors to distinguish markup, tag names, and data in all of its text editors. Orange, for example, identifies elements that are not associated with a schema. You can change the colors for editors individually. Select **Tools > Options** from the menu bar, then select **Editor Format**. You select the editor whose settings you want to modify using the **Editor** drop-down list.

**Alternatives**

The **File Explorer** window is the primary way to open and access files in Stylus Studio, but you can also open files using:

- The **Open** dialog box, which is displayed when you select **File > Open** from the menu bar or click the **Open** button on the tool bar, for example.
- The **Project** window, which is displayed on the left of the Stylus Studio desktop. The **Project** window shows only those files associated with Stylus Studio projects.
For more information

See “Opening Files in Stylus Studio” on page 108 to learn more about the File Explorer window.

See “Working with Projects” on page 116 to learn more about projects in Stylus Studio.

Updating the Text of a Sample Document

When you update an XML document in the Text view of the XML editor, you can use the usual editing tools, as well as tools tailored for handling XML.

Each of the following topics contains instructions for editing a sample XML document. You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps depend on actions you performed in a previous topic.

For more information on editing tools and features, see Using the Text Editor on page 167.

This section provides instructions for

- “Displaying Line Numbers” on page 8
- “Adding Elements in the Text View of a Sample Document” on page 9
- “Copying and Pasting in the Text View of a Sample Document” on page 10
- “Undoing Operations in the Text View of a Sample Document” on page 10
- “Inserting Indents in the Text View of a Sample Document” on page 11
- “Querying in the Text View of a Sample Document” on page 12
- “Deleting a Query” on page 14

Displaying Line Numbers

Stylus Studio lets you optionally display line numbers in most of its editors. Line numbers provide simple, unobtrusive points of reference that can make working large or complex documents easier. Line numbers are off by default; turn them on now.

1. Select Tools > Options from the Stylus Studio menu.
2. Stylus Studio displays the Options dialog box.
2. Click **Application Settings > Editor General**.

![Options dialog box with XML editor settings](image)

**Figure 5. Sense:X and Other Editor Features are in the Options Dialog Box**

3. Select **XML Editor** from the **Editor** drop-down list.

4. Click **Show line numbers**.

5. Click **OK**.

**Adding Elements in the Text View of a Sample Document**

1. In the XML editor window, click in the first line just after `<ticker>`.

2. Press Enter and type `<quote><company>data</company>`.

**Sense:X™ Auto-Completion**

As soon as you type the closing forward slash, Stylus Studio displays **company** because it is the only element that is appropriate to close. Automatic closing of open tags is part of Stylus Studio’s **Sense:X intelligent editing**. You can change this and other Sense:X options on the **Editor General** page of the **Options** dialog box – for example, you can have Stylus Studio display a list of appropriate elements, even if that list includes one only item.

This document does not have a DTD or XML Schema associated with it. But suppose for a moment that it does have an associated schema. As soon as you type `<`, Stylus Studio
would display a pop-up list of the elements you could add at that location. You need only
double-click the element you want to add.

Figure 6. Example of Stylus Studio Sense:X

Copying and Pasting in the Text View of a Sample Document

1. Use the mouse to select the text for one quote element and its contents.

2. In the menu bar, select Edit > Copy.
   Alternatives: Press Ctrl+C or click Copy.

3. Scroll down in the XML editor and click just before </ticker>.

4. In the menu bar, select Edit > Paste.
   Stylus Studio copies the quote element here, but the indentations are not quite right.
   Instructions for fixing this are in the topic Inserting Indents in the Text View of a
   Sample Document on page 11.
   Alternatives: Press Ctrl+V or click Paste.

Undoing Operations in the Text View of a Sample Document

1. In the menu bar, select Edit > Undo to remove the text you just pasted.
   Alternative: Press Ctrl+Z.

2. In the menu bar, select Edit > Redo to replace the text you just removed.
Alternative: Press Ctrl+Y.

3. In the XML editor window, click **Indent XML Tags** , which is the left most button. Stylus Studio displays a message that alerts you that there is an open tag for a quote element but no close tag. The messages indicates the line and column in which the error was found.

4. In the alert box, click **OK**. Because the document is not well-formed XML, Stylus Studio does not insert indents in the document. The next topic, **Inserting Indents in the Text View of a Sample Document** on page 11, shows how to fix the document so that it is well-formed.

5. In the menu bar, click **Edit**.
   The **Undo** and **Redo** operations are no longer active. After you click the **Indent XML Tags** button, you cannot automatically undo or redo recent changes. It does not matter whether or not Stylus Studio actually inserts the indents. After you make another change, the **Undo** operation becomes active again.

**Inserting Indents in the Text View of a Sample Document**

1. In the XML editor tool bar, click **Indent XML Tags** again.
   Stylus Studio displays the message that indicates that a close tag is missing. It specifies the element name, and the line and column numbers that identify where the error was found.
2. In the alert box, click **OK**.

   Stylus Studio moves the cursor so that it appears immediately after the `quote` tag that has no closing tag.

   **Tip**
   The current cursor location within the document is displayed as line/column coordinates in the Stylus Studio status bar at the bottom of the Stylus Studio window.

3. In line 2, click after the `</company>` tag and type `</`. By default, Stylus Studio displays `quote>` because it is the only element that is appropriate to close.

4. In the XML Editor tool bar, click **Indent XML Tags**.

   This time, Stylus Studio correctly indents the XML text.

   **Indent XML Tags** changes your XML document by inserting white space. If this is undesirable, and you want to check for well-formedness, click the **Tree** tab at the bottom of the XML Editor window. If the document is well-formed, Stylus Studio displays the tree representation. If the document is not well formed, Stylus Studio displays a message that indicates the reason the document is not well formed and the location of the error or omission.

**Querying in the Text View of a Sample Document**

Stylus Studio provides support for both XPath 1.0 and 2.0. You control the version you want Stylus Studio to use to process your XPath using the `v.1` and `v.2` buttons in the XML Editor tool bar. The default XPath used is version 1.0.

1. Click in the **<Type a new query>** field at the top of the XML Editor.
Alternative: Press F6. This moves the focus immediately to the query definition field.

2. Type `/ticker/quote` and press Enter.
Stylus Studio runs the `/ticker/quote` query on `your-quotes.xml`, and displays the results in the Query Output window.

3. In the Query Output window, expand the second `quote` element to view its contents.
4. Click the **symbol** element.  
   In the **Text** view, Stylus Studio uses its back-mapping feature to move the cursor to the source element for the **symbol** result element you clicked.

5. In the **Text** view, click the down arrow to the right of the query field.

6. Click `<type a new query>`.

7. Type `//company` and press Enter.
   Stylus Studio runs the new query and displays the results on a new tab (labelled **Query2**) in the **Query Output** window. Stylus Studio adds a new tab for each query you define.

8. Click the **Query1** tab to view the results for the first query.

9. Click **Save Result** at the top of the **Query Output** window.
   Stylus Studio displays the **Save As** dialog box.

10. In the **URL:** field, type `query1.xml` and press Enter.
    This saves the results from the `/ticker/quote` query in **query1.xml**.

11. Close the **Query Output** window by clicking the x in that window’s upper right corner.

### Deleting a Query

You cannot explicitly delete a query. In addition, queries you define are not saved with an XML document unless that document belongs to a Stylus Studio *project* – if you close the XML document and then reopen it, the queries you defined in the previous editing session are no longer there.

### Note
See “Working with Projects” on page 116 to learn more about projects and their role in Stylus Studio.

### Updating the Schema of a Sample Document

This section provides instructions for updating the internal DTD for your-quotes.xml.

When an XML document has an external DTD, you can view the external DTD in the **Schema** tab of the XML Editor, but you cannot edit it. To be able to edit an external DTD, you must open it in the DTD editor. When an XML document has an internal DTD, you can view and edit it in both the **Schema** tab and the **Text** tab of the XML editor.

You should have already performed the steps in “Updating the Text of a Sample Document” on page 8. Each of the following topics contains instructions for editing the
sample XML document. You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps depend on actions you performed in a previous topic.

This section includes the following topics:

- “Creating a Sample Schema” on page 15
- “Defining a Sample Element” on page 17
- “Adding an Element Reference to a Sample Schema” on page 18
- “Defining an Entity in a Sample Schema” on page 19
- “Exploring Other Features in a Sample Schema” on page 19

For more information, see “Defining a DTD – Getting Started” on page 80.

Creating a Sample Schema

1. If it is not already open, open your-quotes.xml. See “Opening a Sample XML Document” on page 6 if you need help with this step.

2. At the bottom of the XML editor window, click the Schema tab.

   Stylus Studio displays the Schema tab, and opens the Properties window. The Schema tab displays a DTD tree, which is currently empty.

3. To create a schema for your-quotes.xml, select XML > Create Schema from XML Content from the Stylus Studio menu.

   Stylus Studio displays the Create Schema or DTD dialog box. By default, Stylus Studio generates an internal DTD and inserts it in a DOCTYPE element at the beginning
of the document. You can also use this dialog box to generate an external XML Schema or DTD.

4. Click **Yes** to instruct Stylus Studio to create a DTD based on the XML document content.

Stylus Studio displays a tree representation of the new, internal DTD. It also displays the **Properties** window.

![Create Schema or DTD dialog box](image)

**Figure 12. Create Schema or DTD Based on XML Content**

![Properties window](image)

**Figure 13. Result of Generating a Schema Based on XML Content**
Defining a Sample Element

1. Click the company element in the Schema tab.
   This selects the company element definition and displays the properties for the company element in the Properties window.

   ![Figure 14. Properties Window Displays Element Properties](image)

   The Content Model property indicates the allowable contents for a company element. In this example, it is Mixed, which means that a company element can contain specified elements (as opposed to all elements defined in this DTD), attributes, and raw data.

   **Tip** Windows like the Properties and Query Output windows are docking windows – you can change their location within the Stylus Studio window, or separate them from the Stylus Studio entirely, by dragging them to the desired location.

2. Click the DTD node.
   In the left tool bar, Stylus Studio activates only those buttons that are applicable to the DTD – you can add elements, entities, comments, and so on. But you cannot add an attribute definition, a reference to an element, or a #PCDATA node, for example.

3. In the left tool bar, click New Element Definition. Stylus Studio displays an entry field at the bottom of the tree.

   ![Figure 15. Entry Field for a New DTD Element](image)
4. Type `location` and press Enter. Stylus Studio displays the properties for the new `location` element in the **Properties** window.

5. In the left tool bar, click **New Modifier**. Stylus Studio displays a drop-down menu of options that specify the rules for the occurrence of the children of the new element.

![Figure 16. Drop-Down List for Modifier Values](image)

6. Double-click **Zero or More** (or click once to select it and press Enter).

7. In the left tool bar, click **Add #PCDATA**. Your definition of the `location` element specifies that it can contain only raw data.

**Adding an Element Reference to a Sample Schema**

1. In the **Schema** tab, expand the `quote` element.

2. Click its **Sequence** modifier.

3. In the left tool bar, click **New Modifier**. Stylus Studio displays an entry field for the new modifier at the end of the list of modifiers that already apply to the **Sequence** modifier. The entry field consists of a drop-down list of available values for the new modifier.

4. In the drop-down list, double-click **Optional**.

5. In the left tool bar, click **New Reference to Element**. Stylus Studio displays an entry field after the new **Optional** modifier.

6. Type `location` and press Enter.

7. To move the `location` element to be earlier in the sequence, click its **Optional** modifier.

8. In the XML editor top tool bar, click **Move Up** repeatedly until the `location` element is where you want it to be.
Defining an Entity in a Sample Schema

1. Click the DTD node.
2. In the left tool bar, click New Entity Ent.
   At the end of the schema, Stylus Studio displays Ent and a entry field for the name of the new entity.
3. Type TCBCC for the name of the entity and press Enter.
   In the Properties window, Stylus Studio displays the properties for the new entity.
4. In the Properties window, double-click the Value field.
5. Type The Country's Best Computer Company and press Enter.

Exploring Other Features in a Sample Schema

1. Click Toggle Display of White Space WS to display nodes that represent white space in the DTD. Click the button again to hide the white space nodes.
Getting Started with Stylus Studio® 2006

2. Click Validate Document.

Stylus Studio displays a message in the Output window that indicates that the document is valid.

Figure 17. Output Window After Schema Validation

Updating the Tree Representation of a Sample Document

This section provides instructions for updating the DOM tree representation of the your-quotes.xml document.

You should have already performed the steps in “Updating the Schema of a Sample Document” on page 14. Each of the following topics contains instructions for editing the sample XML document. You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps depend on actions you performed in a previous topic.

This section includes the following topics:

- “Adding an Element to a Sample Document Tree” on page 20
- “Changing an Element’s Data in a Sample Document Tree” on page 21
- “Adding Attributes and Other Node Types to a Sample Document Tree” on page 21
- “Adding an Entity Reference to a Sample Document Tree” on page 22

Adding an Element to a Sample Document Tree

1. If it is not already open, open your-quotes.xml.
Updating an XML Document—Getting Started

See “Opening a Sample XML Document” on page 6 if you need help with this step.

2. At the bottom of the XML Editor window, click the Tree tab.
   Stylus Studio closes the Properties window.

Tip  You can close the Output window if it is still open from the previous exercise.

3. Click the plus sign next to the ticker element to expose the children of the ticker element.

4. Click New Element in the left tool bar to add a quote element to the document.
   Stylus Studio displays a drop-down menu that lists the elements you can add at that position in the tree.

5. Click quote and press Enter.
   Stylus Studio displays a field next to the new quote element. The DTD allows a quote element to contain data.

6. Click outside the field to close it without entering data.

Changing an Element’s Data in a Sample Document Tree

1. Expand the third quote element.

2. Click the symbol element.

3. In the XML Editor top tool bar, click Change Value.
   Stylus Studio activates the field to the right of the symbol element and selects the current value.

4. In the active field, type XSOL and press Enter.

5. To the right of the exchange element, right-click Nasdaq NMS.
   Stylus Studio displays a shortcut menu.

6. Click Change Value. Stylus Studio activates the value field for the exchange element.

7. In the active field, type NYSE and press Enter.

Adding Attributes and Other Node Types to a Sample Document Tree

1. Click the last quote element in the tree.

2. Click New Attribute.
Getting Started with Stylus Studio® 2006

Stylus Studio displays an attribute name field immediately below the selected quote element.

![Image of a document tree with a selected quote element and an attribute name field showing agent and its value]

**Figure 18. Adding a New Element to a Document Tree**

3. In the attribute name field, type agent and press Enter. Stylus Studio displays a default value for the attribute, Text, in an entry field to the right of the new attribute.

4. In the attribute value field, type Star Brokers and press Enter. Stylus Studio displays an entry field for a new attribute name, allowing you to easily add a number of attributes, one after the other.

5. Click outside the attribute name field to close it.

6. In the XML editor top tool bar, click Validate Document. Stylus Studio displays a message in the Output window that indicates that the document is not valid. The DTD does not specify the agent attribute for the quote element. Stylus Studio allows you to modify your document in invalid ways, which you might want to do during application design. The validation feature informs you that your document is invalid when you try to validate the document.

7. Click the agent attribute.

8. In the XML Editor top tool bar, click Delete Node.

9. Click Validate Document again. Stylus Studio displays a message in the Output window that indicates that the document is now valid.

**Adding an Entity Reference to a Sample Document Tree**

1. If it is not already selected, click the quote element you defined in the previous topic.

2. In the left tool bar, click New Element to add subelements to the new quote element.
Updating an XML Document—Getting Started

Stylus Studio displays a drop-down menu that lists a number of elements that you can insert at this point. Scroll the list to view them all.

3. Click company, which is first in the list, and press Enter.
   Stylus Studio displays a field next to the element name. You can enter data here, such as the name of the company. But rather than entering data, suppose you want to refer to an entity. To refer to an entity:

4. Click outside the field or press the Esc key.

5. Click New Entity Reference, which is the last button in the left tool bar.
   Stylus Studio displays a drop-down menu that lists the defined entities.
   If the New Entity Reference button is not active, click Toggle Display of Entity References in the XML editor top tool bar. This button allows you to control whether you can refer to entities.

6. Double-click TCBCC.
   Stylus Studio inserts the text The Country’s Best Computer Company as the value for the company element.

7. Click the Text tab at the bottom of the XML editor window.
   Stylus Studio displays the \&TBCC; entity reference in the new company element.

8. Click the Tree tab.

Updating a Sample Document Using the Grid Tab

The XML Editor Grid tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

This section provides instructions for updating the your-quotes.xml document using the Grid tab of the XML Editor. The Grid tab is useful for displaying structured data. It is a convenient way to view a document that contains multiple instances of the same type of element, for example.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the XML Grid Editor video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

1. If it is not already open, open your-quotes.xml.
See “Opening a Sample XML Document” on page 6 if you need help with this step.

2. At the bottom of the XML Editor window, click the Grid tab. Stylus Studio displays a table that contains the XML data.

![Figure 19. Grid Tab](image)

The left most column, with the **Tag Name** heading, contains the children of the `<ticker>` element. The remaining columns contain the grandchildren of the `<ticker>` element. The heading of each column identifies the element name – company, symbol, and so on.

**Tip**

You can resize columns by dragging the handle on the column heading’s right side. You can change the element order in the document by dragging the handle on the column heading’s left side. Stylus Studio swaps positions with the column on which you come to rest.

3. Select the last row by clicking to the left of the last `<quote>` element. The row is highlighted in blue.
4. Click the **Insert row after** button.
   A new instance of the `<quote>` element is added to the document. The cursor is placed in the `<company>` element cell.

5. Type `XML Designs` and press Enter.
   Stylus Studio creates the value for the `<company>` subelement.

6. Press Tab (or use the right arrow key) to move the cursor to the next cell in the row.

7. Repeat **Step 5** and **Step 6** to create values for the `<symbol>` and `<exchange>` subelements.

8. If you want, you can continue to add the data contained in a `quote` element.

### Modifying Values

It is easy to change and delete values in grid fields:

- To change the value of any field, double-click the field and type the new data. Press Enter to save the change.
- To delete the value of a field, double-click the field, select the text you want to delete, and press the Delete key.

### Moving Around the Grid

You can move around the grid using the mouse and the keyboard.

Using the mouse, click where you want to place the cursor.

Using the keyboard:

- Use the Tab key to advance the focus to the next cell; use Shift + Tab to move the focus to the previous cell
- Use the arrow keys to move the focus in the direction of the arrow you choose
Working with Stylesheets – Getting Started

This section helps you get started working with XSLT stylesheets. To focus on stylesheets that generate HTML, see “Stylesheets That Generate HTML – Getting Started” on page 47. To focus on stylesheets that map XML to XML, see “Using the XSLT Mapper – Getting Started” on page 64.

Except for the first topic, each of the following topics contains instructions for working with a sample XSLT stylesheet. You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps depend on actions you performed in a previous topic.

This introduction to working with stylesheets in Stylus Studio is organized as follows:

- “Opening a Sample Stylesheet” on page 26
- “XSLT Stylesheet Editor Quick Tour” on page 27
- “XSLT Scenarios” on page 33
- “Making a Static Web Page Dynamic by Editing XSLT” on page 38

Before you begin

To get started, you’ll need to start Stylus Studio if you haven’t already. See “Starting Stylus Studio” on page 5 if you need help with this step.

Opening a Sample Stylesheet

1. In the File Explorer or Open dialog box, navigate to the examples\quotes directory in your Stylus Studio installation directory.

   Alternative: If the Stylus Studio examples project is open, you can access this file from the Project window. To open the examples project, open examples.prj in the Stylus Studio examples directory.

![Stylus Studio's XSLT Editor](image)

Figure 21. Stylus Studio’s XSLT Editor

As with the XML Editor, Stylus Studio uses different colors to distinguish markup, tag names, and data in the XSLT Editor.

**XSLT Stylesheet Editor Quick Tour**

When you use the Stylus Studio XSLT stylesheet editor, you work with XSLT stylesheets, XML source documents, and result documents. This quick tour is organized to introduce you to some of the main features for working with XSLT in Stylus Studio:

- “Parts of the XSLT Editor” on page 28
- “Exploring the XSLT Source Tab” on page 28
- “Exploring the Params/Other Tab” on page 31
- “Exploring the WYSIWYG Tab” on page 32
Parts of the XSLT Editor

The XSLT Editor consists of four tabs that allow you to work with XSLT in different ways, based on your preferences and the functionality that you desire.

- **XSLT Source.** Use the XSLT Source tab when you want to directly edit or view the XSLT source code that comprises your stylesheet. The XSLT Source tab can also be a good way to learn more about XSLT – you can see how changes you make to the XSLT using graphical editors, such as the WYSIWYG tab, affect the source.

  *Tip* XSLT source is also visible from a pane within the Mapper tab.

- **Mapper.** The Mapper tab allows you to create XSLT by graphically mapping source document nodes to nodes in a target document. Stylus Studio interprets the mappings to generate XSLT that will yield a document conforming to the document described in the Set Target Document pane.

  *Note* Using the Mapper tab is discussed in detail in “Using the XSLT Mapper – Getting Started” on page 64.

- **Params/Other.** You use the Params/Other tab to specify the encoding Stylus Studio uses to store the stylesheet, the stylesheet’s output method, and the encoding Stylus Studio uses for the document that results from applying this stylesheet. You can also use this tab to view default values for parameters used by your stylesheet.

- **WYSIWYG.** The WYSIWYG tab allows you to compose HTML by dragging and dropping XML document elements and attributes. The WYSIWYG tab tool bar lets you easily format text, create tables, build lists, and Stylus Studio automatically generates the XSLT instructions that output the content you define on the tab.

Exploring the XSLT Source Tab

1. In the stylesheet text, click anywhere below the third `xsl:template` instruction (line 11).
In the status bar just below the XSLT Editor tool bar, Stylus Studio displays `match: /`. This indicates that the location you clicked is inside a template that matches the root node.

2. Click in the `xsl:stylesheet` instruction (line 5).

   Now the status bar is blank. This instruction is not part of a template.

3. In the XSLT Editor tool bar, click **Add a new template**.

   Stylus Studio inserts the following after the last template already specified in the stylesheet.

   ```xml
   <xsl:template match="NewTemplate">
   </xsl:template>
   ```

   To define a new template, replace `NewTemplate` with the match pattern you want, and add contents to the new template as needed.

   **Tip**

   You can also create a new template by double-clicking a node on the schema tree. Templates that match nodes in the XSLT document are displayed with a check in the schema tree, as shown here.

   Yellow indicates that the text cursor in the XSLT source is within that template.
4. In the XSLT Editor toolbar, click Template Mode, which is the right most button. Stylus Studio displays only the new template.

![Figure 23. Use Template Mode to Focus on a Single Template](image)

You can edit the stylesheet in either template mode or in full source mode. In template mode, Stylus Studio displays one template at a time. In full source mode, Stylus Studio displays the whole stylesheet.

**Tip** In large or complex stylesheets, use the XSLT Editor’s status bar to identify the current template.

5. In the upper right corner of the editing pane, click the down arrow. Stylus Studio displays a list of the templates in the stylesheet with their match patterns.

![Figure 24. You Can Show Individual Templates in a Stylesheet](image)

6. Click match: `*/*`. This displays the template that matches every element and the root node.

Every stylesheet that Stylus Studio creates includes two built-in templates. One built-in template matches every element and the root node. The other built-in template matches all text and attribute nodes. See “Using Stylus Studio Default Templates” on page 377.

To delete a template, click the match pattern for the template you want to delete and then click Delete template in the XSLT Editor toolbar. You must be in template mode to delete a template.
7. Click **Full Source Mode**.

Stylus Studio displays the complete stylesheet. The cursor is at the beginning of the template that was being displayed in template mode.

**Exploring the Params/Other Tab**

Drop-down menus let you specify the encoding format used to store the stylesheet in Stylus Studio, as well as method and encoding output attributes. A simple grid displays the name, source URL, and default value of any global parameters used by the active stylesheet, as well as by any imported ones.

All information that you can specify in the **Params/Other** tab can also be specified in the XSLT source. For example, you can specify the XSLT encoding in the processing instruction at the beginning of the stylesheet; you can specify the output method and encoding with the `xsl:output` instruction. Stylus Studio automatically updates the XSLT source with any changes you make in the **Params/Other** tab, and vice versa.
Exploring the WYSIWYG Tab

The XSLT Editor WYSIWYG tab is available only in Stylus Studio XML Professional Edition.

The WYSIWYG tab is a graphical XSLT editor that lets you compose XSLT by constructing the HTML document you want the XSLT to output.

1. Click the WYSIWYG tab.
   Stylus Studio displays a message that indicates that the output of the stylesheet is unspecified and asks you if you want to make it HTML. When the output is HTML (or XML), you can edit the stylesheet in the WYSIWYG HTML editor.

2. Click Yes to make the stylesheet’s output HTML.
   Stylus Studio displays the WYSIWYG tab.

See “Stylesheets That Generate HTML – Getting Started” on page 47 to learn more about using the XSLT WYSIWYG editor.
XSLT Scenarios

To apply a stylesheet to an XML document in Stylus Studio, you use a scenario. A scenario is a group of customizable settings that allows you to experiment with different source XML documents (that is, the XML document to which you will apply the XSLT), processors, parameter values, post-processors, and profiling settings. You can also use scenarios to perform validation on the XML document that results from the XSLT processing. (Validation is always performed before any post-processing you specify.)

You can define multiple scenarios using different settings to see how each affects document processing. Stylus Studio also supports scenarios for Web service calls, DB-to-XML Data Sources, and XQuery.

An XSLT scenario is defined by a single stylesheet-XML document pair. You can associate any number of scenarios with a stylesheet, though only one scenario can be in effect at the time the XSLT is processed. Similarly, you can associate any number of scenarios with an XML source document.

Tip  Stylus Studio lets you work with several XSLT processors, including Saxon, Xalan-J, MSXML and .NET.

A scenario has already been created for the your-quotes.xsl stylesheet, using the your-quotes.xml as the source XML document. Run the scenario now and look at the output created by the XSLT defined in your-quotes.xsl.
Stylus Studio processes the source XML document using the XSLT stylesheet you specify and displays the results in the **Preview** window.

![Stylus Studio XML Professional Edition - [your-quotes.xsl]](image)

**Figure 28. XSLT Processing Results are Shown in the Preview Window**

By default, results are displayed using a Web browser. If you choose, you can display results in tree or text format, by clicking **Preview in Tree** and **Preview Text** in the **Preview** window tool bar.

Use the scroll bar to review the HTML in the **Preview** window. You can see that the values come from the XML document `your-quotes.xml`.

**Tip**  If it is not already open, you can open the source XML document specified in a scenario by clicking **Open XML From Scenario** in the XSLT Editor tool bar.
Working with Scenarios

To define additional scenarios, click the down arrow next to the scenario field in the XSLT Editor tool bar, and click Create Scenario. After you have more than one scenario, click the same down arrow to select the scenario you want to use to preview a result.

To change the properties of a scenario, or to delete a scenario, select the scenario you want to change or delete, and then click Browse to the right of the scenario name field. Stylus Studio displays the Scenario Properties dialog box.

About Preview

When you preview a result, Stylus Studio automatically saves the changes you have made to the document. If you want to revert to the document’s previous state, you can use the undo function (Edit > Undo).

Working with a Sample Result Document

1. In the Preview window, click anywhere in the display.
Using its back-mapping functionality, Stylus Studio displays the template in the XSLT Editor’s status bar and flags the line that generated the line you clicked with a blue pointer.

Figure 29. Back-mapping Shows which XSLT Generated a Result
2. In the left tool bar of the **Preview** window, click **Preview Text**. Stylus Studio displays the HTML file that generates the browser display.

![Figure 30. You Can Render XSLT Results as Plain HTML](image)

3. Click anywhere in the HTML display. The gray background identifies any HTML that was generated by the same template.

   This works in reverse as well. If you click a line in a template (full source mode or template mode), Stylus Studio uses a gray background to display the HTML generated by that template.

4. In the left tool bar, click **Export Preview**. Stylus Studio displays the **Save As** dialog box. If you want, you can enter a file name and click **Save** to preserve the generated HTML file. Otherwise, click **Cancel**.

   **Note**

   Notice the tab at the bottom of the **XSLT Preview** window. It specifies `your-quotes [your-quotes.xsl]`. After you create another scenario and apply the stylesheet in that scenario, another tab with the name of that scenario will be displayed. You can click the tab for the result you want to view and easily compare result documents from different scenarios.
Making a Static Web Page Dynamic by Editing XSLT

Suppose you have an XML document with a repeating element, and you want to build a Web page that displays information for each of the elements. For example, you might have a document that contains information for hundreds of books, customer accounts, sales calls, or even chemistry experiments. It is relatively easy to create an HTML file that elegantly displays the information for one element. You can then import this file into Stylus Studio, and modify it in a few steps to display all the elements in your XML document.

This section provides step-by-step instructions for converting a static Web page that displays information about one video into a dynamic Web page that displays information about many videos. The process is described in the following major steps:

- "Importing a Sample HTML File" on page 39
- "Creating the video Template" on page 41
- "Instantiating the video Template" on page 43
- "Making Titles Dynamic" on page 44
- "Making Images Dynamic" on page 45
- "Making Summaries Dynamic" on page 46

If you follow the instructions in these topics, you create the video.xsl stylesheet. Stylus Studio includes a sample version of this stylesheet. It is sampleVideo.xsl, and it is in the examples\VideoCenter directory of your Stylus Studio installation directory. If the Stylus Studio examples project is open, you can access this file from the Project window. To open the examples project, open examples.prj in the Stylus Studio examples directory.

Stylus Studio includes an additional sample stylesheet, sample2Video.xsl. This stylesheet performs the same function as sampleVideo.xsl, but it does not use the xsl:apply-templates instruction. Instead, it directly executes the instructions. This results in a nicer looking WYSIWYG display.

An alternative to editing the XSLT source is to use the WYSIWYG tab to compose HTML graphically. This feature is described in "Making a Static Web Page Dynamic Using the WYSIWYG Editor" on page 59.
Importing a Sample HTML File

The HTML to XSLT Document Wizard is available only in Stylus Studio XML Professional Edition.

1. In the Stylus Studio menu bar, click **File > Document Wizards**.
2. Click the **XSLT Editor** tab.
3. Double-click **HTML to XSLT**. Stylus Studio displays the **Open** dialog box.
4. Open **movies.html**, which is in the `examples\VideoCenter` directory of your Stylus Studio installation directory.
   Stylus Studio displays a stylesheet in the XSLT Editor. The stylesheet contains one template, which matches the root node (`<xsl:template match="/">`). Stylus Studio copies all HTML markup that is in `movies.html` into the **CDATA** section of this template.
   If you want, you can move and enlarge the XSLT editor window. If you do, leave a few inches at the bottom of the Stylus Studio window for the **Preview** window, which Stylus Studio will display later in this procedure.

**Tip** An alternative to the previous four steps is to display `movies.html` in Internet Explorer and then select **Open with Stylus Studio**.

5. In the XSLT editor tool bar, click **Preview Result**.
   Stylus Studio displays the **Scenario Properties** dialog box. A scenario associates a stylesheet with an XML source document. When Stylus Studio imports an HTML file, it automatically creates the stylesheet that can generate that HTML file.

6. In the **Scenario Properties** dialog box, in the **Scenario Name:** field, type **Video Scenario 1**.
7. Next to the **Source XML Url:** field, click **Browse**. Stylus Studio displays the **Open** dialog box.
8. In the **Open** dialog box, double-click **videos.xml**, which is in the `examples\VideoCenter` directory of your Stylus Studio installation directory.
9. In the **Base URL for HTML Links Resolution:** field, type the name of the directory in which Stylus Studio is installed followed by `\examples\VideoCenter`:
   Stylus_Studio_install_dir\examples\VideoCenter
   You must type an absolute path.
10. Click OK.

Stylus Studio displays the Save As dialog box.

11. In the URL field, type video.xsl and click the Save button.

Stylus Studio applies the new stylesheet to the videos.xml document and displays the result in the Preview window.

![Screenshot of Stylus Studio with the Save As dialog box and the Preview window showing the XSLT preview of video.xsl]

Figure 31. XSLT Preview of video.xsl

The result provides information about one video. Also, Stylus Studio displays the tree of the XML source document in a pane to the right of the stylesheet.

**What to do next**

To modify the stylesheet in the XSLT Source tab, continue to the next topic, “Creating the video Template” on page 41.

To modify the stylesheet using the WYSIWYG tab, see “Making Repeating Table Rows in the WYSIWYG Editor” on page 60.
Creating the video Template

1. In the source tree pane of the XSLT editor, click the plus sign next to the videos element.

   **Tip** If the source tree pane is not visible, click Source Tree at the top of the XSLT window, or select XSLT > Display Source Tree Pane.

2. Double-click the video repeating element.

   Stylus Studio creates a template that matches the video element. The new template is empty, and it appears in the XSLT Editor pane near the end of the stylesheet (around line 159). In the source tree pane, a check appears next to video to indicate that there is a template that matches video.

3. In the Preview window, click somewhere in the movie title Enemy of the State.

   Stylus Studio displays the template it created that matches the root element, and flags the line that generates the title. This shows you about where the HTML markup starts.
for a single video. In the next few steps, you are going to move the markup for the video element into its own template.

4. In the XSLT Editor, highlight all markup that displays a single video.

   a. Place the text cursor on line 61 – between the </TR> tag and the comment tag in the following line:

      <!-- *** Start Video *** -->

   Tip When you backmap (by clicking in the output), Stylus Studio displays the Back-map Stack pane in the Preview window. This pane is discussed later in this topic.

   Tip The cursor position (line and column number) is displayed in the Stylus Studio status bar, shown here:
b. Drag your cursor down through the end of the following line, which is around line 110:

    <!-- *** End Video *** -->

5. Press Ctrl+X to cut the highlighted text.

6. Scroll down to the video template.

7. Place your cursor on the blank line in the video template body (line 112) and press Ctrl+V to paste the video markup into its new template.

8. Click Preview Result to apply the current stylesheet to the XML source document and refresh the Preview window.

   The display no longer includes any information about the video. This is because you moved the video markup to the video template, but you did not specify an instruction that instructs the XSLT processor to instantiate the video template.

9. Click Save.

**Instantiating the video Template**

1. In the XSLT Editor, put the text cursor in line 61 (the spot from which you cut the markup for the video element).

2. Type `<x.

   Stylus Studio displays the Sense:X tag completion menu.

   ![Figure 33. Sense:X Tag Completion in XSLT](image)

Stylus Studio inserts the \texttt{xsl:apply-templates} instruction.

4. Type a space. Stylus Studio again displays the choices for what you can enter.


6. Double-click \texttt{result}.

7. Type a forward slash (/).

8. Double-click \texttt{videos} and type a forward slash (/).

9. Double-click \texttt{video} and type "/".

   The XSLT you have just composed selects all \texttt{video} elements for processing. The complete instruction is as follows:
   \begin{verbatim}
   <xsl:apply-templates select="result/videos/video"/>
   \end{verbatim}

10. Click \texttt{Preview Result} to refresh the Preview window.

   Now you can see that the XSLT processor does instantiate the \texttt{video} template for each \texttt{video} element in the XML source document. However, because the template currently contains information for \textit{Enemy of the State} only, the information for that \texttt{video} appears for each \texttt{video} element in the XML source document. You need to modify the XSLT instructions that generate the \textit{Enemy of the State} text. Each time the XSLT processor instantiates the \texttt{video} template, you want it to pull in information for a different \texttt{video}.

11. Click \texttt{Save}. 

---

**Making Titles Dynamic**

1. In the \texttt{Preview} window, click somewhere in the movie title \textit{Enemy of the State}.

   In the Backmap Stack pane, Stylus Studio shows you the XSLT instruction that generated the output you clicked in the result document. In the XSLT Editor pane, Stylus Studio’s back-mapping feature points to the line that contains \texttt{Enemy of the State}.

2. Delete the text \texttt{Enemy of the State}.

   Do not cut the \texttt{<b> and </b>} tags.

3. In the spot in the line where you deleted \texttt{Enemy of the State}, type the following instruction, or select its parts from the Sense:X tag completion lists.

   \begin{verbatim}
   <xsl:apply-templates select="title"/>
   \end{verbatim}
This instructs the XSLT processor to instantiate a template that matches `title`. However, there is no such template because a `title` template is not needed in this stylesheet. The default templates provide the required operations. When the XSLT processor cannot find a template that matches `title`, it instantiates the default template that matches all elements — its template rule is `/|*`.

This default template operates on the children of the node for which it is instantiated. In this case, each time the default template is instantiated for a `title` element, it operates on the text node that is the lone child of the `title` element. Because the child node is a text node, this template instantiates the other default template, the one that matches all text nodes. This other default template copies the contents of the text node to the result document. This is how the actual title of each video gets displayed in the result.

The templates that match `/|*` and `text()|@*` are default templates in every stylesheet whether or not you or Stylus Studio explicitly include them. For additional information about how these templates work, see “Understanding How the Default Templates Work” on page 337.

4. Click Preview Result to refresh the Preview window.
   Now the display for each video has a different title, but the rest of the information (the summary, the image, and so on) is that for Enemy of the State.

5. Click Save.

Making Images Dynamic

1. In the Preview window, click in the Enemy of the State image.
   Again, Stylus Studio’s back-mapping feature identifies the line in the stylesheet that generates the image.
   The Backmap Stack window now displays two `xs1:template` instructions. One matches the root node and one matches `video`.

2. To edit the expression that identifies the image, in the XSLT editor pane, delete `id1244100` from the line Stylus Studio is pointing to.
3. Replace the specific ID with the following attribute value template:
   {@id}

   The result should look like the following:
   <img src="images/video/{@id}.gif" align=BOTTOM" ... 

   During XSLT processing, the XSLT processor replaces the attribute value template
   with the ID for the current video.

4. Click Preview Result to refresh the Preview window.

   Stylus Studio displays a different image for each title.

5. Click Save.

Making Summaries Dynamic

1. In the Preview window, click in the Enemy of the State summary. 

   Stylus Studio uses back-mapping to point to the line that generates the summary.

2. In the XSLT editor pane, delete the text for the summary. Do not delete any markup.

3. Insert the following instruction, or select its components from the Sense:X tag
   completion lists, where you deleted the summary text:
   <xsl:apply-templates select="summary"/>

   Again, the XSLT processor will use the default templates to copy the text to the result
document.

4. Click Preview Result to refresh the Preview window.

   Stylus Studio displays a different summary for each title.

5. You can follow the same procedure described here to make the other child elements
   of the video element (genre, rating, and so on) dynamic. But before you do that, save
   the work you have already done.

6. Click Save.
You can use the **WYSIWYG** tab of the XSLT Editor to create stylesheets that generate HTML. Stylus Studio automatically generates the XSLT instructions that output the HTML you define on the **WYSIWYG** tab.

This section helps you get started working with stylesheets that generate HTML. To get started with the features common to all stylesheets, see “Working with Stylesheets – Getting Started” on page 26. To focus on stylesheets that map XML to XML, see “Using the XSLT Mapper – Getting Started” on page 64.

This section is organized as follows:

- “Video Demonstrations of the XSLT WYSIWYG Editor” on page 47
- “Getting Started with the XSLT WYSIWYG Editor” on page 48
- “Making a Static Web Page Dynamic Using the WYSIWYG Editor” on page 59

To get started, you’ll need to start Stylus Studio if you haven’t already. See “Starting Stylus Studio” on page 5.

### Video Demonstrations of the XSLT WYSIWYG Editor

Stylus Studio provides several video demonstrations that show you how to use the XSLT WYSIWYG editor. You can watch these videos instead of (or in addition to) performing the tutorial procedures in this section. You can find an overview of the XSLT WYSIWYG video demonstrations here: [http://www.stylusstudio.com/learn_xslt.html#xslt_1](http://www.stylusstudio.com/learn_xslt.html#xslt_1). A complete list of all the videos demonstrating Stylus Studio’s features is here: [http://www.stylusstudio.com/xml_videos.html](http://www.stylusstudio.com/xml_videos.html).

### Introduction to WYSIWYG in Stylus Studio

This video demonstration shows how to access the XSLT WYSIWYG editor, how to create static and dynamic contents, and how to create tables and nested tables.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Introduction to WYSIWYG in Stylus Studio video.
Getting Started with Stylus Studio® 2006

Working with Tables

This video demonstration shows how to sort a table and how to do advanced formatting using XSLT conditional processing on atomic entities or on table rows.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Working with Tables video.

Using Templates

This video demonstration shows how to use the xsl:apply-templates instruction with the XSLT WYSIWYG editor, how to create new templates, how to edit templates, how to reuse them.

Note This video demonstration is not described in the tutorial procedures in this section.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Using Templates video.

Converting Static HTML

This video demonstration shows how to convert a static HTML page to a dynamic HTML page.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Converting Static HTML video.

Getting Started with the XSLT WYSIWYG Editor

This section provides instructions for getting started with the XSLT WYSIWYG editor. It introduces the basic WYSIWYG editor features, and provides background information needed to edit simple stylesheets.

You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps in subsequent topics depend on actions you performed in a previous topic.

This section is organized as follows:

● “Creating Static HTML” on page 49
● “Defining Dynamic Contents” on page 52
● “Adding a Table with Dynamic Contents” on page 53
Creating Static HTML

1. In the Stylus Studio menu bar, select **File > New > XSLT Stylesheet.**
   Stylus Studio displays the **Scenario Properties** dialog box.
2. In the **Scenario Properties** dialog box, to the right of the **Source XML URL** field, click **Browse**.
3. Navigate to and select `examples\query\books.xml` in the Stylus Studio installation directory, and click **Open**.
4. In the **Scenario Properties** dialog box, click **OK.**
   Stylus Studio displays the XSLT Editor open to the **WYSIWYG** tab. The HTML canvas, the center pane on the **WYSIWYG** tab, is empty. A tree that represents the XML source document, `books.xml`, appears to the right of the HTML canvas. The **Properties** window is displayed by default.

Figure 34. XSLT Editor WYSIWYG Tab
5. Click the **XSLT Source** tab. As you can see, the basic XSLT instructions that Stylus Studio inserts in every new stylesheet are there. Because you created the stylesheet by selecting the WYSIWYG editor, which is used to design HTML, Stylus Studio has set the output method to HTML (`<xsl:output method="html"/>`).

6. Click the **WYSIWYG** tab.

7. Click in the HTML canvas and type My Favorite Books.

8. In the **WYSIWYG** tool bar, in the **HTML Element** field, click the down arrow to display the element menu and click **Heading 1**.

![Figure 35. Select HTML Formatting from Drop-down Menus](image)


10. In the **WYSIWYG** tool bar, click **Text Color** and select a color, and then click **Center**. You can enter and format text in the HTML canvas as you would in any other WYSIWYG editor. What you are creating is static HTML.

11. Click **Preview Result**.

The **Save As** dialog box appears.

12. Type myBooks.xsl in the **URL** field and click the **Save** button.

13. As you can see in the **Preview** window, the contents of the HTML canvas and the contents of the result document are identical.

**Tip** Resize the **Preview** window by dragging the splitter that separates the **Preview** window from the XSLT Editor.
14. Click the XSLT Source tab. Stylus Studio has captured the formatting and translated it into XSLT instructions. The stylesheet now contains these instructions in the template that matches the root node.

```xml
<?xml version='1.0' encoding='utf-8'?>
<xsl:stylesheet version="1.0"
    xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
    <xsl:output method="html"/>

    <xsl:template match="/">
        <p align="center">
            <html><head/>
            <body>
                <font color="#008000">My Favorite Books</font>
                ...
            </body>
        </html>
    </xsl:template>
</xsl:stylesheet>
```

15. Click the WYSIWYG tab before continuing.
Defining Dynamic Contents

This topic is part of a sequence that starts with “Creating Static HTML” on page 49.

1. In the source XML document tree, click books and press the asterisk key (*) in the numeric keypad to expand all the elements.

2. In the HTML canvas, position the cursor at the end of My Favorite Books and press Enter.

3. Type This is a list of :

4. In the XML source tree, drag the name attribute to just before the colon ( : ). Stylus Studio displays a pop-up menu.

5. Click xsl:value-of. Stylus Studio adds <<@name>> to the canvas; this statement is a placeholder for the value returned by /books/@name.

6. Move the pointer over this placeholder to display a yellow marker. This is the value-of marker.

7. Move the pointer over the value-of marker.

Stylus Studio displays the instruction that generates the contents for the placeholder.

8. Select This is a list of <<@name>>:

9. In the WYSIWYG tool bar, click the down arrow in the HTML Element field.

10. Click Heading 2. As you can see, you can format a mixture of static and dynamic HTML.

11. Click Preview Result . The result document contains This is a list of My books: where the HTML canvas contains This is a list of <<@name>>:
12. Press the Enter key to move the cursor to the next line before continuing.

Adding a Table with Dynamic Contents

This topic is part of a sequence that starts with “Creating Static HTML” on page 49.

1. In the XML source tree, notice the repeat symbol; this symbol identifies repeating elements, such as book and author.

2. Drag the book element from the XML source tree and drop it onto the HTML canvas. Stylus Studio displays the pop-up menu with an additional option, Add Table.

3. Click Add Table.

   Stylus Studio inserts a two-column table with a marker to the left of the table. This marker indicates a looping element.

   ![Figure 38. Table Created Using WYSIWYG Editor](image)

   **My Favorite Books**

   This is a list of «@name»:

4. Move the pointer over the marker. Stylus Studio displays the instruction that generates the contents of the table, xsl:for-each, and the context for the instruction, books/book. Anything you enter in the table is in the context of books/book.

5. Drag the title element from the XML source tree and drop it into the first column of the table in the HTML canvas.

   Stylus Studio displays a pop-up menu.
6. Click **xs1:value-of**.
   Stylus Studio displays the «title» placeholder in the first column. When you apply the stylesheet, the title of each book will appear in a row of the first column of the table.

7. Drag the **author** element from the XML source tree and drop it into the second column of the table in the HTML canvas.
   Stylus Studio displays the pop-up menu.

8. Click **Add table**.
   Stylus Studio displays a subtable in the second column of the table.

9. Right-click in the second column of the subtable to display a new pop-up menu.

10. Click **Delete Columns** to delete the second column in the subtable.

11. Drag the **author** element from the XML source tree and drop it into the subtable again.

12. In the pop-up menu that appears, click **xs1:value-of**.
    Stylus Studio displays the «author» placeholder in the second column.
13. Click Preview XSLT. The result document now contains a table that displays the title and authors for each book in books.xml.

![My Favorite Books]

This is a list of the books:

<table>
<thead>
<tr>
<th>Books</th>
<th>Authors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Web Services</td>
<td>David A. Chappell</td>
</tr>
<tr>
<td>Java Message Service</td>
<td>Tyler Jewell</td>
</tr>
</tbody>
</table>

Figure 39. Table with Dynamic Content
Using the Properties Window

This topic is part of a sequence that starts with “Creating Static HTML” on page 49.

1. In the HTML canvas, click the «author» placeholder, which represents an xsl:value-of instruction.

2. In the Properties window, click the down arrow to display a list of elements.

3. Click the second td element to specify properties for the table data. (If you click the first td element, you specify properties for the subtable that is in the second column of the main table.)

Stylus Studio displays only the properties that can be specified for the element you clicked. For the td element, there are many such properties, or attributes, and you can click the tabs at the bottom of the Properties window to view a particular subset (Color, Layout, Position, and so on).

4. At the bottom of the Properties window, click the Color tab.

5. Double-click the background-color field.
6. Click Browse to display a drop-down color menu.

7. Click the color you want for the background of the table rows and click OK.

8. Click Preview Result.
The result document now displays the table rows with the background color you selected.

![Figure 42. Colors Applied by Editing Properties](image)

9. Click the XSLT Source tab.

Stylus Studio has inserted the XSLT instructions that display the table in the color you specified.
Making a Static Web Page Dynamic Using the WYSIWYG Editor

In “Making a Static Web Page Dynamic by Editing XSLT” on page 38, you learned how to use the XSLT Editor’s XSLT Source tab to build a Web page that displays dynamic content.

This section provides step-by-step instructions for using the Stylus Studio XSLT WYSIWYG editor to convert a static Web page that displays information about one video into a dynamic Web page that displays information about many videos.

Before You Begin

Before starting this part of the tutorial, you must import an HTML file as described in “Importing a Sample HTML File” on page 39, with the following changes:

- In Step 6, give the scenario a different name, or use the current default.
- In Step 11, give the stylesheet a different name.

When you are done, your copy of Stylus Studio should look something like this:

![Stylus Studio - [myVideos.xsl]](image)

Figure 43. Preview of myVideos.xsl

After you perform Step 11 in that topic, return here, and start with “Making Repeating Table Rows in the WYSIWYG Editor” on page 60.
Making Repeating Table Rows in the WYSIWYG Editor

This topic is part of a sequence that starts with “Importing a Sample HTML File” on page 39.

In the Preview window, you can see that the information for one video appears in a row of a table. You want to make this a repeating row and have each row contain information for a different video.

1. Click the WYSIWYG tab.
2. In the source tree pane, expand the result and videos nodes.
3. Drag the video repeating element to the Title table cell, which contains Enemy of the State.
4. In the pop-up menu that appears, click Make repeating.

Stylus Studio displays a looping marker to the left of the table row to indicate that it is a repeating row. If you move the cursor over the marker, Stylus Studio displays the information that the marker represents an xsl:for-each instruction that executes in the context of /result/videos/video.

Figure 44. Repeating Element Depicted in WYSIWYG

5. Click Preview Result. The result document now displays multiple rows. Each row contains information for the same movie: Enemy of the State.

Now that the XSLT describes a table with repeating rows, our next task is to make each of the rows’ columns dynamic, that is, to ensure that each row displays information for a different movie.
Making Contents Dynamic in the WYSIWYG Editor

This topic is part of a sequence that starts with “Importing a Sample HTML File” on page 39.

1. In the HTML canvas, select the title *Enemy of the State*.
2. In the source tree pane, expand the video node and drag and drop the title element on the selected text.
3. In the pop-up menu that appears, click `xsl:value-of`. Stylus Studio removes the text for *Enemy of the State* and replaces it with the `<<title>>` placeholder.
4. Move the cursor over the `<<title>>` placeholder and then shift it slowly over the value-of marker ([]) to the left. Stylus Studio displays the information that the marker represents an `xsl:value-of` instruction and that it executes in the context of `/result/videos/video/title`.
5. Click Preview Result. The result document now displays a different video title in each row. If you want, you can select the title placeholder, apply some formatting and preview the results. Every title in the result document will have the formatting you specified.
6. Repeat Step 1 through Step 4 for each of the following elements:
   - summary - select all the text in the summary before you drag the summary element
   - genre - select `action`
   - vhs - select 16.99 (leave the dollar sign ($))
   - dvd - select 29.99
   - director - select *Tony Scott*
   - studio - select *Buena Vista*
   - year - select 1999
   - runtime - select 113
7. Click Preview Result. Each row now contains information for a different video. However, the video image in each row is still the same.

Rendering Images as Dynamic Content in the WYSIWYG Editor

This topic is part of a sequence that starts with “Importing a Sample HTML File” on page 39.
The image for each movie is still the same. For this part of the XSLT, you will use the XSLT Source tab:

1. Click the XSLT Source tab.
2. In the Preview window, click the video image to backmap to the instruction that generates it in the XSLT Source tab.
   Stylus Studio displays the XSLT Source tab, and flags the line that contains the instruction. As you can see, the stylesheet uses an image ID.
3. In the string "images/video/id1244100.gif", select id1244100.
4. Type {@id} to replace the selected text. This specifies an attribute value template.
5. Click Preview Result.
   Each row now contains the correct image for the video described in that row.
6. Click the WYSIWYG tab.
   As you can see, there is now a placeholder where the original image was.
7. Click the image’s placeholder.
   In the Properties window, Stylus Studio displays the properties for the image. If you scroll down to the src property, you can see that the value is images/video/{@id}.gif.

8. Scroll the result document towards the bottom and examine the VHS and DVD prices.
   As you can see, some of the prices are missing the decimal places.
9. In the result document, click on the price for a VHS video.
   Stylus Studio backmaps to <xsl:value-of select="vhs"/> in the XSLT Source tab.
10. Replace "vhs" with "format-number(vhs, '#.00')". This ensures that every VHS price is formatted with two decimal places.
11. In the XSLT Source tab, scroll down about eight lines, and repeat the previous step for the DVD price. That is replace `select= "dvd"` with `select="format-number(dvd, '#.00')"`.

12. Click **Preview Result**. Each price now includes two decimal places. However, small circles appear when no VHS tapes or DVDs are available for sale. The next topic describes how to use conditional processing to remove these circles.

13. Click the **WYSIWYG** tab. Stylus Studio displays `<<format-number()>>` as the placeholder for the VHS and DVD prices.

### Using Conditional If Processing in the WYSIWYG Editor

This topic is part of a sequence that starts with “Importing a Sample HTML File” on page 39.

In the current videos result document, there are small circles when no VHS tapes or DVDs are available.

![Figure 46. Circles Show Processing of Empty Strings](image)

These circles appear when the XSLT processor tries to process an empty string with `select=format-number`.

1. In the **WYSIWYG** tab, select the `<<format-number()>>` that is the placeholder for the VHS price.
2. Right-click the selected placeholder.
3. In the pop-up menu, select **Conditional Processing > Add If**. Stylus Studio displays the **Input** dialog box.
4. In the **Input** dialog box, type `vhs` in the **Test Condition field**. This tests whether there are any `vhs` elements.
5. Repeat Step 1 through Step 4, but this time select the DVD price placeholder, and specify `dvd` as the test condition.
6. Click **Preview Result**. The small circles no longer appear. Instead, nothing appears when there are no VHS tapes or DVDs for a particular video.
Using the XSLT Mapper – Getting Started

This section helps you get started using the XSLT Mapper to create stylesheets that aggregate data and transform XML. The sample files used in this section are in the Stylus Studio examples\simpleMappings directory. If you follow the procedures in this section, you create the BooksToCatalog.xsl stylesheet. A sample version of this stylesheet, sampleBooksToCatalog.xsl, is also in the examples\simpleMappings directory of your Stylus Studio installation directory.

Each of the topics in this section contains instructions for working with sample XML documents that you can use to familiarize yourself with the XSLT Mapper. You should perform the steps in each topic before you move on to the next topic – after the first topic, some steps depend on actions you performed in a previous topic.

This section covers the following topics:

- “Opening the XSLT Mapper” on page 65
- “Mapping Nodes in Sample Files” on page 67
- “Saving the Stylesheet and Previewing the Result” on page 69
- “Deleting Links in Sample Files” on page 70
- “Defining Additional Processing in Sample Files” on page 71

In addition to the topics described in this section, the Stylus Studio® 2006 User Guide contains other sources of information on XSLT:

- To learn more about XSLT, see “Working with XSLT” on page 309.
- To get started XSLT Editor features for stylesheets, see “Working with Stylesheets – Getting Started” on page 26.
- To focus on features for stylesheets that generate HTML, see “Stylesheets That Generate HTML – Getting Started” on page 47.
- To learn about the XSLT mapper in greater detail, see “Creating XSLT Using the XSLT Mapper” on page 443.

Before you begin

To get started, you will need to start Stylus Studio if you haven’t already. See “Starting Stylus Studio” on page 5 if you need help with this step.
Opening the XSLT Mapper

This procedure describes how to open the XSLT Mapper and select the files you want to use for the drag-and-drop operations that will define your XSLT stylesheet.

1. From the Stylus Studio menu bar, select File > New > XSLT Stylesheet.
   Stylus Studio displays the Scenario Properties dialog box.

2. Click the Cancel button to dismiss the dialog box.

3. Click the Mapper tab.
   Stylus Studio displays XSLT editor with the Mapper tab selected. The source pane beneath the mapper panes appears by default, allowing you to see how the mappings of XML document elements are rendered as XSLT. The source pane is fully editable and synchronized with the XSLT Mapper. Of course, you can always click the XSLT Source tab for a full-screen view of your XSLT code.

4. Click the Add Source Document button at the top of the mapper’s left pane.

Tip
The Project window also appears if it was open the last time Stylus Studio was closed. You can close it.
Stylus Studio displays the Open dialog box.

5. For this example, navigate to the examples\simpleMappings directory in the Stylus Studio installation directory.


7. Click the Set Target Document button at the top of the Mapper’s right pane. Stylus Studio displays the Open dialog box.

8. For this example, navigate to the examples\simpleMappings directory in the Stylus Studio installation directory.


Stylus Studio displays tree diagrams of these XML documents. The default XSLT source code has not been altered at this point.

Figure 48. XSLT Mapper Tab with Source and Target Documents
Mapping Nodes in Sample Files

1. In the Mapper tab, expand the tree for both books.xml and catalog.xml.

   **Tip** You can display an entire tree using the asterisk key (*) on your keyboard’s number pad.

2. In books.xml, place the pointer over the book repeating element.

3. Press and hold the left mouse button, and drag from book to the Book repeating element in catalog.xml.
   Stylus Studio draws a line as you drag.

4. Release the mouse button to create the link between book and Book.

   Stylus Studio creates an xsl:for-each block that links the book and Book repeating elements. (If you mouse over the block, xsl:for-each appears in a pop-up to indicate the XSLT operation represented by the link.)

   **Tip** If you prefer, you can render xsl:for-each as a simple line. You might want to do this to simplify the appearance of the mapper canvas. Select **Tools > Options** from the menu, and then navigate to **Module Settings > XSLT Editor > Mapper**.

Figure 49. xsl:for-each Block Displayed by the XSLT Mapper

Also notice that the complete xsl:for-each instruction has been added to the XSLT source, which appears in the XSLT source pane under the XSLT Mapper canvas. The back-mapping pointer identifies the line of XSLT that was just added to stylesheet.
The template contains an `<xsl:for-each>` instruction that selects the `book` element, which is the node you selected in Step 2. The output from this template is an empty `Book` element, which is the node that was the target of the link. Stylus Studio created the `Catalog` element automatically, to provide the document structure necessary to support the `Book` element.

**Tip**

By default, Stylus Studio creates an `<xsl:value-of>` instruction when you link one element to another; Stylus Studio creates an `<xsl:for-each>` instruction if you link two repeating elements. You can also create other types of instructions graphically, including `<xsl:if>`, `<xsl:choose>`, and `<xsl:apply-template>`.

5. Click the **Params/Other** tab.

In the **Output method** field, display the drop-down list and click **html**. Note, however, that the output of a stylesheet generated by the XSLT Mapper is always XML – even if the setting for **Output method** is **unspecified**, Stylus Studio still generates XML.

6. Click the **Mapper** tab.

The `<xsl:output>` instruction is added to the XSLT source:

```xml
<xsl:output method="html"/>
```

7. Create another link from the **title** element to the **Title** element.

**Note**

When you map, you always map from the source document to the destination document.
8. Click the **XSLT Source** tab to see the new instructions in the template. (If you prefer, you can simply adjust the splitter between the XSLT source pane and the XSLT Mapper canvas.

![XSLT Source](image)

**Figure 50. Stylus Studio Builds XSLT Based on the Mapper Links**

For each link you define, Stylus Studio adds instructions to the template that matches the root node. In the XSLT you have composed so far, the XSLT inserts a `Book` element for each `book` element it finds in the source document. In the `Book` element, the stylesheet selects the `title` elements. For each `title` element, it inserts a `Title` element. Finally, in each `Title` element, the stylesheet extracts the value of the current context node, which is the `title` node.

Why does the stylesheet extract the value of the `title` nodes but not the `book` nodes? The `title` node has only a text node as its child. In this situation, the default is that the XSLT Mapper inserts an `xsl:value-of` instruction.

### Saving the Stylesheet and Previewing the Result

1. Click **Save**. Stylus Studio displays the **Save As** dialog box.

2. In the **URL:** field, type `BooksToCatalog.xsl`.

3. Click the **Save** button.

   This saves the stylesheet that Stylus Studio has generated. It does not matter that you have not finished mapping all nodes.
4. In the upper left corner of the XSLT Mapper, click **Preview Result**.

**Tip**

When you create a stylesheet using the XSLT Mapper, Stylus Studio automatically creates a scenario for you, using the source document you specify as the source document for the scenario. Scenarios and their value in the application development process are described earlier in this chapter. See “XSLT Scenarios” on page 33.

Stylus Studio displays the result of processing books.xml with the stylesheet you created in the XSLT Mapper in the **Preview** window.

![Example of Preview Result](image)

**Figure 51. Result of Applying XSLT to books.xml**

The result document uses the same schema as the target document, catalog.xml in this example. Because not all nodes have been mapped yet, the result document does not contain all nodes found in books.xml (author and subject nodes, for example).

5. You can confirm that the result document is incomplete by viewing books.xml. Click **Open XML From Scenario**., which is at the top of the **Mapper** tab.

Stylus Studio displays the books.xml document in the Stylus Studio XML Editor.

6. Review the XML document, and then click the document tab for the **BooksToCatalog.xsl** stylesheet to re-display the XSLT Editor.

**Deleting Links in Sample Files**

1. Click the **Mapper** tab if it is not already selected.
2. Click the title to Title link to select it.

![Figure 52. Click a Link to Select It](image)

3. Press the Delete key, or
   a. Right-click the selected link. This displays a shortcut menu.
   b. Click **Delete** to delete the selected link.

   **Tip** In addition to **Delete**, the shortcut menu displays the following options:
   - **Go To Source** displays the line of XSLT code represented by the link you select in the XML Editor.
   - **Carry Value** allows you to create `<xsl:value-of select="."/>` statements. This option is available for links representing `xsl:for-each` instructions only.

### Defining Additional Processing in Sample Files

The stylesheet that the XSLT Mapper creates is not limited to the instructions that Stylus Studio adds. You can edit the template as you would any template. Stylus Studio automatically incorporates any changes you make to the template and displays them in the **Mapper** tab, if it is appropriate to do so.

In addition, you can perform external processing by, for example, defining Java functions and incorporating those functions in your XSLT stylesheet. Like standard supported XSLT functions, user-defined Java functions can be created graphically in the XSLT Mapper – just right click on the mapper canvas, select **Java Functions** from the shortcut menu, and select any registered Java function you want to use.

See “Processing Source Nodes” on page 469.
Debugging Stylesheets – Getting Started

The Stylus Studio debugger allows you to follow XSLT processing and detect errors in your stylesheets. Stylus Studio includes sample files that you can experiment with to learn how to use the debugger. To get you started, this section provides step-by-step instructions for using the debugger with these sample files. You should perform the steps in each topic in the order of the topics.

For complete information about how to use the debugger, see “Debugging Stylesheets” on page 485.

In addition, Stylus Studio allows you to observe and debug the interaction between your Java code and XML data. See “Debugging Java Files” on page 495.

This section includes the following topics:

- “Setting Up Stylus Studio to Debug Sample Files” on page 72
- “Inserting a Breakpoint in the Sample Stylesheet” on page 73
- “Gathering Debug Information About the Sample Files” on page 75

Before you begin

To get started, you’ll need to start Stylus Studio if you haven’t already. See “Starting Stylus Studio” on page 5.

Setting Up Stylus Studio to Debug Sample Files

1. Open the videosDebug.xsl stylesheet, located in the examples\VideoCenter directory where Stylus Studio was installed. 
   
   Alternative: If the Stylus Studio Project window is open, you can access this stylesheet from the examples project.

   Stylus Studio displays the videosDebug.xsl stylesheet in the XSLT editor.

2. In the XSLT editor tool bar, click Preview Result to run the predefined scenario DebugVideosScenario. The source XML document is videos.xml.
Stylus Studio applies the stylesheet and displays the results (a finished HTML page that displays information about a single video) in the Preview window.

**Figure 53. Preview of videosDebug.xsl**

**Inserting a Breakpoint in the Sample Stylesheet**

As with any debugger, in the Stylus Studio XSLT debugger you insert a breakpoint where you want to suspend processing and examine what is going on. You can do this using the Debug menu or the debug set of tools in the tool bar.

**Tip** Tools in the tool bar are in grouped by function. These groups, like the one for debug tools shown here, are dockable and can be moved anywhere you please.

1. In the XSLT Editor, click in line 202. Line numbers appear in the lower right corner of the XSLT Editor window. Line 202 starts with `<xsl:template match="director">

**Tip** To display lines in Stylus Studio text editors, click Tool > Option > Editor General, and select Show line numbers.

2. In the Stylus Studio tool bar, click Toggle Breakpoint .
Alternative: If you prefer, select **Debug > Toggle Breakpoint**, or press F9.

Stylus Studio displays a red circle to the left of the line that contains the `xsl:template match="director"` instruction. The XSLT processor will stop processing when it gets to the instantiation of this template.

Do not do it, but to remove a breakpoint, you click in the line that has the breakpoint and then click **Toggle Breakpoint** (or F9). The **Toggle Breakpoint** button and F9 key operate as toggles.

3. Press F5 to start debugging.

**Alternative:** In the Stylus Studio tool bar, click **Start Debugging**.

The XSLT processor displays a yellow triangle to indicate where processing has been suspended. Instead of the finished HTML created when you first ran the scenario, the **Preview** window displays just the HTML code because complete processing of the XSLT was suspended before the finished HTML could be rendered.

Do not do it, but to stop debugging, you can click **Cancel** in the lower right corner of the XSLT editor window, or click **Stop Debugging** in the Stylus Studio tool bar.

If you click **Preview Result** instead of pressing F5, Stylus Studio applies the stylesheet without running the debugger. Pressing F5 always invokes the debugger. If there are no breakpoints, and no errors, processing completes and Stylus Studio displays the result in the **Preview** window.
Gathering Debug Information About the Sample Files

When XSLT processing is suspended at a breakpoint, Stylus Studio displays the Variables, Call Stack, and Watch windows.

![Variable, Call Stack, and Watch Windows](image)

**Figure 56. Variable, Call Stack, and Watch Windows Appear During Debugging**

You can use the information in these windows to learn about potential and actual problems encountered in your XSLT processing.

**Tip** You can also control the display of these windows using the Debug menu, shown here, or the tool bar.
The Variables Window

The Variables window displays a list of variables and their values when processing was suspended.

![Variables Window](image)

As you can see, the stylesheet defines the VideoName parameter, which had no value when processing was suspended. In addition, the Variables window shows you that when processing was suspended, the processor was operating on the first director child element of the first video child element of the first videos child element of the first result element.

The Call Stack Window

The Call Stack window displays a history of the steps the processor performed to reach the point at which processing was suspended, including the names of the templates that are currently instantiated, in most recent-to-oldest order.

![Call Stack Window](image)

In this example, the XSLT processor has instantiated the director template, which is part of the instantiation of the video template, which is part of the instantiation of the template that matches the root node.
Debugging Stylesheets – Getting Started

The processor completes the instantiation of the director template, which adds some HTML to the Preview window. The yellow triangle moves to show the new location in the XSLT source.

![Diagram](image)

Figure 59. Stepping Out Advances the Processor

As you can see in the Call Stack window, the processor is now two levels deep in the template that matches the root node, instead of three levels deep as it was previously. The value of the context node in the Variables window is /result[1]/videos[1]/video[9] (it was /result[1]/videos[1]/video[9]/director[1]).

The Watch Window

If your application contains a lot of variables, the Watch window allows you to focus on the variables in which you are particularly interested.

![Diagram](image)

Figure 60. Watch Window Lets You Track Variables

1. Double-click the Name field.

2. Type the name of the variable you want to watch and press Enter.

As processing continues, the Watch window displays the values of the variables you specify.
Ending Processing During a Debug Session

1. In the **Preview** window, click any line of text.
   In the **XSLT Source** tab, Stylus Studio displays the blue back-mapping triangle that indicates the line in the stylesheet that generated the output line you clicked.

2. In the lower right corner of the XSLT editor, click the **Cancel** button to end processing.

   ![Figure 61. Cancelling Processing During Debugging](image)

   Stylus Studio displays a notification message that indicates that processing has been stopped and, optionally, allows you to jump to the location where processing ended.

   ![Figure 62. You Can Jump to Where XSLT Processing Ended](image)

3. Click **Yes** to jump to the location where processing ended.
   The cursor appears on line 146 of the **XSLT Source** tab, which contains `<xsl:apply-templates select="director"/>`. 
4. In the XSLT editor tool bar, click **Open XML from Scenario**.

Stylus Studio displays the XML source document that the stylesheet operates on. As you can see, the first `result` element is the document element.

![Figure 63. Viewing the XML Source for an XSLT Transformation](image)

For more information

This section demonstrated some of the major features of Stylus Studio’s debug tools, including specialized windows for presenting call stack and variable information. For complete information on using the XSLT debugger, see “Debugging Stylesheets” on page 485.
Defining a DTD – Getting Started

This section provides a quick tour of the main features of the DTD Editor. It provides instructions that you can follow to actually define a simple DTD. For complete documentation about how to use the Stylus Studio DTD Editor, see “Defining Document Type Definitions” on page 599.

Process Overview

When you use Stylus Studio to define a DTD, the main steps you perform are:

1. Create a new DTD schema file.
2. Define the elements that contain the raw data.
3. Define the elements that contain other elements.
4. In the container elements, specify the rules for the contained elements. That is, specify whether a contained element is optional or required, whether there can be more than one, and what order contained elements must be in.

This section provides step-by-step instructions for defining the bookstore.dtd schema file. You should perform the steps in each topic in the order of the topics. This section includes the following topics:

- “Creating a Sample DTD” on page 80
- “Defining Data Elements in a Sample DTD” on page 81
- “Defining the Container Element in a Sample DTD” on page 82
- “Defining Structure Rules in a Sample DTD” on page 82
- “Examining the Tree of a Sample DTD” on page 84

Before you begin

To get started, you’ll need to start Stylus Studio if you haven’t already. See “Starting Stylus Studio” on page 5.

Creating a Sample DTD

1. From the Stylus Studio menu bar, select File > New > DTD Schema.
2. Click Save.
   Stylus Studio displays the Save As dialog box.
3. Navigate to the Stylus Studio examples directory.
4. In the URL: field, type bookstore.dtd.
5. Click the **Save** button.

**Defining Data Elements in a Sample DTD**

In your DTD, suppose you want a book element to be optional. Further, if a book element is present, it must always have exactly one **title** element and it can have any number of **author** elements. The **title** and **author** elements contain only raw data.

1. At the bottom of the DTD editor, click the **Tree** tab.
2. Click the **DTD** node at the top of the tree if it is not already selected.
3. Click **New Element Definition**, which is the top button in the tool bar on the left side of the DTD editor window.
   Stylus Studio displays an entry field for the element name.
4. Type **title** and press Enter.
   Stylus Studio displays the new element, **title**, and the element's properties in the **Properties** window.
5. Click **New Modifier**.
   Stylus Studio displays an entry field for the element's modifier.
6. Double-click **Zero or More**.
   The new modifier is added to the element.
7. Click **Add #PCDATA**.
8. To define the author element, repeat Step 2 through Step 7. In Step 4, type **author** instead of **title**.

---

**Figure 64. New Element in the DTD Editor**

**Stylus Studio® 2006 User Guide**
When you are done, the Stylus Studio desktop should resemble the following:

![Figure 65. Creating a DTD with Two Elements](image)

### Defining the Container Element in a Sample DTD

1. Click the DTD node at the top of the tree.
2. Click **New Element Definition**.
3. Type `book` and press Enter.

### Defining Structure Rules in a Sample DTD

1. Click the `book` node in the DTD tree if it is not already selected.
2. Click **New Modifier**.
3. In the drop-down list that appears, scroll down and double-click **Sequence**. This indicates that the `book` element can include one or more elements.
4. Click **New Reference to Element**.
5. Type `title` in the entry field and press Enter.
   
   Because the reference to the `title` element appears immediately after the **Sequence** modifier, the DTD editor assumes that the default behavior is what is wanted. That is, the `book` element must contain exactly one instance of the `title` element.

6. Click the **Sequence** modifier.
7. Click **New Modifier**.
8. Double-click **One or More**. (There can be one or more `author` elements in each `book` element.)
9. Click **New Reference to Element**.
10. Type author in the entry field and press Enter.

At this point, the definition of the book element is complete, and the tree diagram of bookstore.dtd should look like this:

![Figure 66. Early Steps of bookstore.dtd](image)

However, you have not yet specified that you want the book element itself to be optional. You need to do this in the element that references the book element. For example, suppose the bookstore element is the root element in XML documents that use this DTD. Further suppose that you want the book element to be a child of the bookstore element.

1. Click the DTD node at the top of the tree.
2. Click New Element Definition.
3. Type bookstore in the entry field and press Enter.
4. Click New Modifier.
5. In the drop-down list that Stylus Studio displays, double-click Optional.
6. Click New Reference to Element.
7. Type book in the entry field and press Enter.
8. Click Save.
Examining the Tree of a Sample DTD

Your DTD should now look like Figure 67.

To complete this DTD, you could define magazine and newsletter elements. In the bookstore element definition, you could add references to the magazine and newsletter elements. You could also expand the definition of the book element to include information about the publisher, price, publication date, and number of pages.
Defining an XML Schema Using the Diagram Tab – Getting Started

This section provides a quick tour of the main features of the Diagram tab of the XML Schema Editor and shows you how to define a simple XML Schema. For complete documentation about how to use the XML Schema Editor, see “Creating an XML Schema in Stylus Studio” on page 504.

The topics in this section provide step-by-step instructions for defining the bookstoreDiagram.xsd XML Schema document. You should perform the steps in each topic in the order of the topics.

This section includes the following topics:

- “Introduction to the Diagram Tab” on page 86
- “Editing Tools of the Diagram Tab” on page 94
- “Description of Sample XML Schema” on page 99
- “Defining a complexType in a Sample XML Schema in the Diagram View” on page 99
- “Defining Elements of the Sample complexType in the Diagram View” on page 106

Before you begin

To get started, you will need to start Stylus Studio if you have not already. See “Starting Stylus Studio” on page 5.
Introduction to the Diagram Tab

The recommended way to define an XML Schema in Stylus Studio is to start with the **Diagram** tab of the XML Schema Editor, which is shown in Figure 68.

When you use the **Diagram** tab to define an XML Schema, you can create XML Schema nodes directly on the **XML Schema diagram pane** using tools on the tool bar or from the **XML Schema > Diagram** and shortcut menus. You can also type in the **text pane**, which appears under the **Diagram** tab. The text pane displays the XML Schema syntax Stylus Studio creates for you as you work in the diagram pane.

Stylus Studio ensures that the XML Schema you create is valid. For example, any nodes you define are created in the required order in the XML document that contains the XML Schema definition, regardless of the order in which you create them.
Defining an XML Schema Using the Diagram Tab – Getting Started

The **Diagram** tab, shown in Figure 68, consists of three main areas:

- “Diagram Pane” on page 87
- “Text Pane” on page 91
- “Definition Browser” on page 93

This section describes these areas and how to work with them.

**Diagram Pane**

The diagram pane contains graphical representations of the elements, attributes, and other nodes that make up your XML Schema.

**Nodes**

Each node displayed in the diagram pane is represented by its own symbol; tool tips, which are displayed when you hover over a node in the diagram, identify the node’s type.
(element, attribute, sequence, and so on). The symbols used in the diagram are summarized in Table 1.

**Table 1. Symbols Used in the XML Schema Diagram**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![schema symbol]</td>
<td>schema (xsd:schema)</td>
</tr>
<tr>
<td>![annotation symbol]</td>
<td>annotation (xsd:annotation)</td>
</tr>
<tr>
<td>![documentation symbol]</td>
<td>documentation (xsd:documentation)</td>
</tr>
<tr>
<td>![element symbol]</td>
<td>element (xsd:element)</td>
</tr>
<tr>
<td>![attribute symbol]</td>
<td>attribute (xsd:attribute)</td>
</tr>
<tr>
<td>![attributeGroup symbol]</td>
<td>attributeGroup (xsd:attributeGroup)</td>
</tr>
<tr>
<td>![simpleType symbol]</td>
<td>simpleType (xsd:simpleType)</td>
</tr>
<tr>
<td>![complexType symbol]</td>
<td>complexType (xsd:complexType)</td>
</tr>
<tr>
<td>![choice symbol]</td>
<td>choice (xsd:choice)</td>
</tr>
<tr>
<td>![sequence symbol]</td>
<td>sequence (xsd:sequence)</td>
</tr>
<tr>
<td>![key symbol]</td>
<td>key (xsd:key)</td>
</tr>
<tr>
<td>![key reference symbol]</td>
<td>key reference (xsd:keyref)</td>
</tr>
<tr>
<td>![unique symbol]</td>
<td>unique (xsd:unique)</td>
</tr>
<tr>
<td>![group symbol]</td>
<td>group (xsd:group)</td>
</tr>
<tr>
<td>![simpleContent symbol]</td>
<td>simpleContent (xsd:simpleContent)</td>
</tr>
<tr>
<td>![complexType symbol]</td>
<td>complexContent (xsd:complexType)</td>
</tr>
<tr>
<td>![restriction symbol]</td>
<td>restriction (xsd:restriction)</td>
</tr>
<tr>
<td>![extension symbol]</td>
<td>extension (xsd:extension)</td>
</tr>
<tr>
<td>![union symbol]</td>
<td>union (xsd:union)</td>
</tr>
<tr>
<td>![list symbol]</td>
<td>list (xsd:list)</td>
</tr>
</tbody>
</table>
Defining an XML Schema Using the Diagram Tab – Getting Started

Nodes can be expanded and collapsed using the plus and minus symbols, respectively, that appear on the right side of the node. In Figure 72 for example, the PurchaseOrderType complexType has been expanded. The shipTo element has not.

Displaying Properties

To streamline the diagram, most nodes are displayed with their properties hidden by default. Exceptions include element, extension, and restriction nodes, for which the type is displayed, as shown in the productName element in Figure 70.

Figure 70. Most Nodes Appear with Properties Hidden

You can change the display for classes of nodes (all elements, for example) using the Schema Diagram Properties dialog box, shown in . (In addition, the Properties window displays all the properties for any node you select.)

Figure 71. Schema Diagram Properties Dialog Box

For each node property, you can choose to

- Show the property
- Show the property only if it is not empty
- Hide the node
If all of a node’s properties have the same show/hide setting, that value is displayed in the **Inline Visibility in Diagram** field. If no value is displayed in the **Inline Visibility in Diagram** field, it means that two or more properties have different show/hide settings.

- Select **Diagram > Properties** from the Stylus Studio menu
- Select **Properties** from the diagram shortcut menu

**Tip** You can also change schema diagram properties on the **Diagram** page of the **Options** dialog box – **Tools > Options > Module Settings > XML Schema Editor > Diagram**.

1. Display the **Schema Diagram Properties** dialog box, or the **Diagram** page of the **Options** dialog box.

2. Select the node whose properties display you want to change.

**Tip** To hide all properties, click the **Hide All** button. To restore defaults, click the **Restore Defaults** button.

3. Click **OK**.

**Background color**

Background color is used as another visual cue for information about the XML Schema:

- A tan, or light brown, color identifies global nodes – these are elements, types, and so on, that are defined as children of the schema (`xsd:schema`). In Figure 72, the `purchaseOrder` element is an example of a globally defined node.

- A light yellow background identifies local instances of globally defined types. In Figure 72, the `PurchaseOrderType` complexType is a local instance of that type.

![Figure 72. Background Colors Show Global and Local Types](image)

Figure 72. Background Colors Show Global and Local Types
Displaying documentation

By default, text associated with documentation elements (xsd:documentation) is hidden. You can expand documentation elements in the diagram by clicking the Show Documentation ( ) button, or by selecting Diagram > Show Documentation from the Stylus Studio menu. When you do, the text associated with all documentation elements defined in the XML Schema appears, as shown in Figure 73.

![Figure 73. Show Documentation with the Click of a Button](image)

Moving around the diagram

There are several ways to move around the diagram pane:

- To move from node to node in the diagram, press the arrow keys.
- You can use the scroll bars to explore the diagram; the zoom slider lets you change the magnification.
- Click Go to Definition ( ) on the shortcut menu to display a new page that shows just the type definition.
- Click Display Definition ( ) on the shortcut menu to jump to the place in the XML Schema where the type is defined.

Text Pane

The text pane appears directly beneath the XML Schema diagram pane. It displays the XML Schema code represented by the nodes you create in the diagram. The default font is Courier New, but you can change it to whatever font you want by clicking the Change Font button ( ).

Stylus Studio synchronizes the diagram and text views of the XML Schema – any changes you make in the diagram are reflected in the text pane, and vice versa. Synchronization information is displayed in the bar that separates the diagram and text panes. Current
status is displayed on the right. When the two views are synchronized, Stylus Studio
displays this graphic: . When Stylus Studio detects a change, such as a change to
the text, it displays a message and changes the status graphic, as shown in Figure 74.

![Synchronization Status](image)

**Figure 74. Synchronization Status is Monitored and Displayed**

Stylus Studio also flags any XML Schema errors in the text pane – lines that contain errors
are identified with a red dot, and the type and location of the error is displayed in the status
area at the top of the text pane, as shown here:

```xml
<xs:element name="street" type="xsd:string"/>
```

![XML Schema Errors](image)

**Figure 75. Text Pane Highlights XML Schema Errors**

When you click the error message, Stylus Studio jumps to that part of the XML Schema
containing the error. When you correct one error, information about the next error
detected by Stylus Studio (if any) is displayed in the status area.
You can use the splitter to resize the text pane to view more or less text, or you can hide it entirely using the controls on the splitter’s right side.

Figure 76. Splitter Controls Change Size of Text and Diagram Panes

Stylus Studio supports back-mapping between the text pane and the XML Schema diagram pane – if you click a node in the diagram, Stylus Studio scrolls the text pane to display the line of XML Schema that defines the node you clicked. A blue triangle is displayed to the left of the exact line of code.

**Definition Browser**

The definition browser is a drop-down list that displays all the child nodes of the schema node. It is located at the top of the **Diagram** tab.

Figure 77. Definition Browser
When you select a node from the definition browser, Stylus Studio displays a new page in the XML Schema diagram pane that shows the definition of the node you select. In addition, the definition browser displays information about that node.

![Figure 78. Information About the Selected Node](image)

To return to the page you were viewing previously, press the back ( ) button.

**Note** When you display a node using the definition browser, the focus of the text pane does not change. Clicking the node jumps you to that part of the XML Schema where the node is defined.

### Editing Tools of the Diagram Tab

Many of the operations you perform in the **Diagram** tab can be performed in a number of ways. This section briefly describes menu and tool bar use, and introduces additional features for defining XML Schema.

This section covers the following topics:

- “Menus and Tool Bars” on page 94
- “In-place Editing” on page 95
- “Drag-and-Drop” on page 95
- “QuickEdit” on page 96
- “Refactoring” on page 97

### Menus and Tool Bars

The complete set of available operations is defined by the menu system. The tool bar provides a subset of frequently performed operations. The top-level menu (**XMLSchema** > **Diagram**), the shortcut menus, and the tool bar are context sensitive – only operations that are permitted given the current context are available. For example, if you want to add an element to a sequence, you can

- Select **XML Schema** > **Diagram** > **Add** > **Element** from the main menu
- Select **Add** > **Element** from the sequence shortcut menu
Defining an XML Schema Using the Diagram Tab – Getting Started

- Click the Add button on the tool bar and select **Element** from the drop-down list it displays.

  Each of these actions lets you add a new node, in this case, an element, to your XML Schema definition.

**In-place Editing**

*In-place editing* allows you to change node names and properties directly in the diagram. For example, say you want to change the value of the **Mixed** property of the PurchaseOrderType complexType. Just double-click the property. Stylus Studio opens the property for editing, as shown in Figure 79.

![Figure 79. In-Place Editing](image)

Similarly, if you double-click a node name, Stylus Studio places the property in edit mode, allowing you to type a new name.

**Tip** To display all of a node’s properties in the diagram, see “Displaying Properties” on page 89.

**Drag-and-Drop**

An alternative to using the menu and the tool bar is to use *drag-and-drop*, which lets you add an existing node to another node’s definition. For example, say you wanted to add an existing element to a sequence. You can do this by dragging the element icon to the sequence icon, as shown in Figure 80.

![Figure 80. Using Drag-and-Drop to Define a Node](image)
Use drag-and-drop any time you want to define a node using a node already defined in your XML Schema.

**Tip** When you drag and drop, you remove the element from its current context. If you want to make a *copy* an element, press and hold the CTRL key when you perform the drag operation.

Typical targets of drag-and-drop operations include the following nodes
- schema
- sequence
- choice
- all
- list
- annotation
- restriction
- union

Typical sources for drag-and-drop operations include the following nodes
- simpleType
- element
- annotation

**Tip** Any node you drag to the schema node is created as a child of the schema node.

**QuickEdit**

*QuickEdit* is a feature of the **Diagram** tab that streamlines common editing operations. For example, you can use QuickEdit to
- Change a sequence to a choice or to an all
- Specify a restriction for a simpleType
- Create sequence, choice, any, and all element definitions

For example, the following structure was created by selecting QuickEdit > Add Elements Choice from the complexType’s shortcut menu.

![QuickEdit Example](image)

**Figure 81. QuickEdit Creates Complex Definitions With a Click**

QuickEdit appears on the top-level and shortcut menus in those contexts in which it is available, and it is also available on the tool bar by pressing the QuickEdit button "f."
Refactoring

Refactoring is a process that allows you to copy globally defined nodes from one XML Schema and paste them in a new XML Schema. The difference between refactoring and a simple copy is that refactoring includes both the node you select and all its dependencies. Consider the following example: here is how the purchaseOrder node appears when it is copied from purchaseOrder.xsd and pasted into a new XML Schema document:

![Figure 82. Simple Copy/Paste of a Node](image)

Figure 82. Simple Copy/Paste of a Node
As you can see, the copy action copies only the selected node to the clipboard. When the same node is copied using refactoring and pasted into another XML Schema document, the node, and all its dependencies copied as well.

Figure 83. Refactoring Copy/Paste of a Node

Not all of the diagram or text are displayed in this illustration, but it is clear that more than just the purchaseOrder node was copied to the clipboard. For example, the purchaseOrder’s type, PurchaseOrderType complexType has been copied, as well as PurchaseOrderType’s element and sequence nodes, such as shipTo, billTo, and items.

If you were to scroll up either the text pane or the diagram pane, you would also see, for example, the complete definitions for other global complexTypes such as SKU and USAddress.

1. Right-click the node you want to refactor.

2. Select Refactoring > Copy from the node’s shortcut menu.

**Note**  If the node is not globally defined, refactoring is not available.

The node and all its dependencies are copied to the clipboard.
3. To paste the node in the target XML Schema document, select **Refactoring > Paste** from the shortcut menu.

**Description of Sample XML Schema**

Suppose you want to define an XML Schema that defines book, magazine, and newsletter elements. The type of each of these elements is `PublicationType`. The XML Schema defines the `PublicationType` complexType. An element that is a `PublicationType` has the following description:

- The `genre` attribute specifies the style of the publication. That is, whether it is a book, magazine, or newsletter.
- There is always exactly one `title` element.
- The `subtitle` element is optional.
- There must be at least one `author` element and there can be more. Each `author` element contains one `first-name` element and one `last-name` element.
- Of the following three elements, exactly one must always be present:
  - `ISBNnumber`
  - `PUBnumber`
  - `LOCnumber`
- The elements must be in the order specified in this list.

The following topics in this section describe how to define this XML Schema using the **Diagram** tab of the XML Schema Editor.

**Defining a complexType in a Sample XML Schema in the Diagram View**

The steps for defining the `PublicationType` complexType described in “Description of Sample XML Schema” on page 99 are presented in the following topics:

- “Defining the Name of a Sample complexType in the Diagram View” on page 100
- “Adding an Attribute to a Sample complexType in the Diagram View” on page 101
- “Adding Elements to a Sample complexType in the Diagram View” on page 102
- “Adding Optional Elements to a Sample complexType in the Diagram View” on page 103
- “Adding an Element That Contains Subelements to a complexType in the Diagram View” on page 103
Defining the Name of a Sample complexType in the Diagram View

1. From the Stylus Studio menu bar, select **File > New > XML Schema**. Stylus Studio displays the XML Schema Editor. Maximize the XML Schema Editor window. If the **Project** window is visible, you can close it.

2. At the bottom of the XML Schema editor, click the **Diagram** tab. Stylus Studio displays the **Diagram** view for the new schema.

3. Right-click the schema node in the XML Schema diagram pane and select **Add > ComplexType** from the shortcut menu.

   *Alternatives:* This action is also available from the **XMLSchema > Grid Editing** menu.
Defining an XML Schema Using the Diagram Tab – Getting Started

Stylus Studio displays a representation for the new node in the diagram. The complexType properties appear in the Properties window. The new complexType has a default name of ComplexType-0.

4. Type PublicationType in the Name property in the Properties window and press Enter.
   Stylus Studio updates the diagram and the XML Schema in the text pane.

5. Click Save.

6. In the Save As dialog box, in the URL field, type bookstoreDiagram.xsd, and click Save. You can save it in the examples directory of the Stylus Studio installation directory or in a directory of your choice.

Adding an Attribute to a Sample complexType in the Diagram View

1. Right-click the PublicationType node.

2. In the shortcut menu that appears, select Add > Attribute.
   Stylus Studio displays a node for the new attribute (untitled).

3. In the Properties window, type genre as the name of the new attribute and press Enter.

4. In the Properties window, click the Type field.
   Stylus Studio displays a drop-down list of built-in types.
5. Scroll down to **xsd:string** and click it, or type **xsd:string** and press Enter. The diagram should now look like the one shown in Figure 87.

![PublicationType](image.png)

**Figure 87. The Finished genre Attribute**

*Tip* You can toggle the display of attributes by clicking the small triangle at the bottom of the complexType node.

6. Click **Save**.

**Adding Elements to a Sample complexType in the Diagram View**

The elements belonging to this complexType must occur in a specific order. Before defining the first element, you need to create a sequence node to define this requirement in the XML Schema.

1. Right-click the **PublicationType** node.

2. In the shortcut menu that appears, select **Add > Sequence**.

   The sequence node is added to **bookstoreDiagram.xsd**. The sequence modifier indicates that if an instance document contains the sequence node’s child elements (the elements you will add next), they must be in the order in which they are defined.

3. Type **title** and press Enter.

4. Right-click the sequence node.

5. In the shortcut menu that appears, select **Add > Element**.

   A child element is added to the **PublicationType** node.

6. In the **Properties** window, click the **Name** field and enter **title**.

7. In the **Properties** window, click the **Type** field.

   Stylus Studio displays a drop-down list of built-in types.

8. Scroll down to **xsd:string** and click it, or type **xsd:string** and press Enter.

   According to the XML Schema requirements described earlier, the **title** element can occur only once. By default, the default value for the Min Occur. (minimum occurrences) and Max Occur. (maximum occurrences) properties is 1. You want exactly one instance of the **title** element in **PublicationType**, so you can accept these defaults.
Adding Optional Elements to a Sample complexType in the Diagram View

1. Right-click the sequence node.
2. In the shortcut menu that appears, select Add > Element. Below the title element, Stylus Studio displays a rectangle for the new element definition.
3. Rename the new element subtitle.
4. Give the new element a data type of xsd:string.
5. Give the new element a minimum occurrences value of 0. You can accept the default of 1 for the Max Occur. property.
6. Click Save.

At this point, the XML Schema diagram should look like Figure 88:

![Figure 88. PublicationType complexType](image)

Adding an Element That Contains Subelements to a complexType in the Diagram View

The sample schema requirements (see “Description of Sample XML Schema” on page 99) state that the PublicationType complexType must include at least one author element. Further, an author element must include a first-name element and a last-name element.

Each element that can contain one or more subelements is a complexType. Consequently, to add the author element to the PublicationType complexType, you must first define the AuthorType complexType. You can then add an element that is of AuthorType to the PublicationType complexType.

1. Right-click the schema node in the XML Schema diagram pane and select Add > Complex Type from the shortcut menu.

   **Alternatives:** This action is also available from the **XMLSchema > Grid Editing** menu. Stylus Studio displays a representation for the new node in the diagram. The complexType properties appear in the **Properties** window.
2. Type `AuthorType` in the `Name` property in the `Properties` window and press Enter. Stylus Studio updates the diagram and the XML Schema in the text pane.

3. Right-click the `AuthorType` node in the diagram.

4. In the shortcut menu that appears, select `Add > Sequence`. Stylus Studio displays the sequence node.

5. Right-click the sequence node.

6. In the shortcut menu that appears, select `Add > Element`.

7. Type `first-name` in the `Name` property in the `Properties` window and press Enter.

8. Change the `Type` property to `xsd:string` and press Enter.

9. Repeat Step 5 through Step 8 to add a new element to the sequence, using `last-name` as the name of the new element.

1. Right-click the sequence node belonging to the `PublicationType` node.

2. In the shortcut menu that appears, select `Add > Element`. Stylus Studio displays a representation for the new node in the diagram. The complexType properties appear in the `Properties` window.

3. Type `author` in the `Name` property in the `Properties` window and press Enter. Stylus Studio updates the diagram and the XML Schema in the text pane.

4. Click the `Type` field in the `Properties` window. Stylus Studio displays a drop-down list of built-in types plus any types you have defined, such as the `AuthorType` you defined in the previous procedure.

5. Select `AuthorType` from the drop-down list.

   **Tip** A plus sign appears on the right side of the `author` element. You can click the plus sign to display the definition of the `AuthorType` complexType, which was just added to the `author` element.

6. Click the `Max Occur.` field.

7. In the drop-down list that appears, click `unbounded`.

   **Tip** When you give an element an unbounded maximum number of occurrences, Stylus Studio renders the node using two outlines, to indicate that multiple occurrences of this element are allowed.

8. Click `Save`.

---

**Getting Started with Stylus Studio® 2006**

104  Stylus Studio® 2006 User Guide
Defining an XML Schema Using the Diagram Tab – Getting Started

At this point, the XML Schema diagram should look like Figure 89:

![Diagram of XML Schema](image)

Figure 89. author Element with AuthorType complexType

Choosing the Element to Include in a Sample complexType in the Diagram View

In the sample XML Schema, you want PublicationType elements to contain an ISBNnumber, PUBnumber, or LOCnumber element.

1. Right-click the sequence node belonging to the PublicationType node.
2. In the shortcut menu that appears, select Add > Sequence.
   Stylus Studio displays a representation for the new sequence node in the diagram. Sequence properties appear in the Properties window.
   We added the sequence node in error – the specification requires that this node be a choice node. The QuickEdit feature makes it easy to correct errors such as this.
3. Right-click the new sequence node. In the shortcut menu that appears, select QuickEdit > Switch to Choice.
   Stylus Studio changes the sequence node to the choice node ( ).
4. Right-click the new choice node.
5. In the shortcut menu that appears, select Add > Element.
6. In the Properties window, change the Name to ISBNnumber and press Enter.
7. In the Properties window, change the Type xsd:int and press Enter.
8. Repeat Step 4 through Step 7 twice: once to add the PUBnumber element, and once to add the LOCnumber element.
9. Click Save .
The definition of the PublicationType complexType is now complete and should look like Figure 90:

![Figure 90. PublicationType complexType Fully Defined](image)

**Defining Elements of the Sample complexType in the Diagram View**

In the final step of defining bookstoreDiagram.xsd, you define elements that are of the PublicationType complexTypes you defined earlier – book, magazine, and newsletter elements.

1. Right-click the schema node in the diagram.
2. In the shortcut menu that appears, select **Add > Element**.
   Stylus Studio displays a node for the new element in the XML Schema diagram pane. The properties for the new element appear in the **Properties** window.
3. Type book as the name of the new element and press Enter.
4. In the **Properties** window, click the **Data Type** field. Stylus Studio displays a drop-down list of built-in types plus any types you have defined.

5. Click **PublicationType**.

6. Repeat Step 1 through Step 5 twice: once to add the magazine element, and once to add the newsletter element.

7. Click **Save**.

   The bookstoreDiagram.xsd document is now complete.

8. Select **XMLSchema > Validate Document** from the menu to validate the XML Schema document you created.

   The validation message appears in the **Output** window, as shown in

   ![Stylus Studio XML Professional Edition - [bookstoreDiagram.xsd *]](image)

   **Figure 91. Validation of bookstoreDiagram.xsd**
Opening Files in Stylus Studio

This section describes the types of files Stylus Studio recognizes, how to add new file types to Stylus Studio, and how to open files using the Stylus Studio File Explorer and other methods. This section covers the following topics:

- “Types of Files Recognized by Stylus Studio” on page 108
- “Using the File Explorer” on page 110
- “Dragging and Dropping Files in the Stylus Studio” on page 113
- “Other Ways to Open Files in Stylus Studio” on page 114
- “Adding File Types to Stylus Studio” on page 115

**Tip** You can set an option so that when you open Stylus Studio, Stylus Studio automatically opens any files that were open the last time you closed Stylus Studio. See “Options - Application Settings”.

Types of Files Recognized by Stylus Studio

Stylus Studio recognizes over ten types of files by default. Each file is associated with a Stylus Studio module, or editor, appropriate for its type, as shown in the following table.

Table 2. File Extensions and Associated Modules

<table>
<thead>
<tr>
<th>File Name Extension</th>
<th>Stylus Studio Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>.conv</td>
<td>Convert to XML Editor</td>
</tr>
<tr>
<td>.dff</td>
<td>XML Diff Viewer</td>
</tr>
<tr>
<td>.dtd</td>
<td>DTD Schema Editor</td>
</tr>
<tr>
<td>.java</td>
<td>Java Debugger</td>
</tr>
<tr>
<td>.prj</td>
<td>Project framework</td>
</tr>
<tr>
<td>.rdbxml</td>
<td>DB-to-XML Data Source Editor</td>
</tr>
<tr>
<td>.wsc, .wsc</td>
<td>Web Service Call Composer</td>
</tr>
<tr>
<td>.xml</td>
<td>XML Editor</td>
</tr>
<tr>
<td>.xquery</td>
<td>XQuery Editor</td>
</tr>
</tbody>
</table>
Opening Files in Stylus Studio

Table 2. File Extensions and Associated Modules

<table>
<thead>
<tr>
<th>File Name Extension</th>
<th>Stylus Studio Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>.xsd</td>
<td>XML Schema Editor</td>
</tr>
<tr>
<td>.xsl, .xslt</td>
<td>XSLT Stylesheet Editor</td>
</tr>
</tbody>
</table>

You can add your own file types to this list, specify the module you want them opened in, and, optionally, specify Stylus Studio as the default application for viewing and editing files of that type. See “Adding File Types to Stylus Studio” on page 115.

Opening Unknown File Types

When you try to open a file of a type that is not recognized by Stylus Studio, Stylus Studio displays the **Choose Module for** dialog box, which allows you to specify the module or editor you want to use to open the file.

![Choose Module Dialog Box](image)

Figure 92. Choose Module Dialog Box

When you respond to this dialog box, you can optionally indicate whether you want all files of that type to be associated with the Stylus Studio module you select in the future. File types you associate with a Stylus Studio module are added to the **File Types** page of the **Options** dialog box. You can remove or change the module association at any time. See “Adding File Types to Stylus Studio” on page 115 for more information.

Opening Files Stored on Third-Party File Systems

Stylus Studio provides access XML documents stored on third-party file systems like Sleepycat Software’s Berkeley DB XML and Raining Data® TigerLogic® XML Data Management Server (TigerLogic XDMS).

See **Integrating with Third-Party File Systems** on page 875 for more information.
Modifications to Open Files

If a file that is open in Stylus Studio is modified (changed, and saved) outside Stylus Studio, Stylus Studio alerts you that the file has been changed and gives you the chance to reload it.

Using the File Explorer

The Stylus Studio File Explorer is a dockable window that provides easy access to any file system accessible from the computer on which you are running Stylus Studio. You can use the File Explorer to quickly add files to Stylus Studio and open files in Stylus Studio, as well as to perform typical file management tasks (like renaming and deleting files, for example).

Figure 93. Stylus Studio File Explorer

By default, the File Explorer window appears on the right side of the Stylus Studio window, but you can drag it anywhere on your desktop. You can close/open the File Explorer window from the View menu.
How to Use the File Explorer to Open Files

There are several ways to open files using the File Explorer:

- Double-click the file
- Right-click the file and select **Open** or **Open With** from the shortcut menu

**Tip**  
**Open With** allows you to select the module you want to use to open the file.

- Drag and drop the file. See Dragging and Dropping Files in the Stylus Studio on page 113.

When you open a file by double-clicking or using the **Open** shortcut menu, Stylus Studio opens the file in the module associated with the file type (the XML Editor for .xml files, for example). If the file type is not currently registered with Stylus Studio, you can register the file at this time using the **Choose Module for** dialog box. See “Types of Files Recognized by Stylus Studio” on page 108 for more information about file type/module associations in Stylus Studio.

Other Features of the File Explorer

The tool bar in the **File Explorer** window has several features that can help you navigate the file systems associated with your computer and work with individual documents.

![File Explorer Tool Bar](image)

**Figure 94. File Explorer Tool Bar**
These features are summarized in the following table.

### Table 3. File Explorer Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New Folder" /></td>
<td>Creates a new folder as a child of the folder with current focus. The default folder name is New Folder.</td>
</tr>
<tr>
<td><img src="image" alt="Read Document Structure" /></td>
<td>Displays the structure of XML documents in tree form. You can drag exposed nodes onto the document tab area to open the document associated with that node. If you drag a node into an existing XQuery or XSLT document, Stylus Studio creates the document function with the XPath expression for that node. For example, if you drag the title element from books.xml into an XQuery document, Stylus Studio builds the following function: doc(&quot;file:///c:/Program Files/Stylus Studio XML Enterprise Edition 6/examples/simpleMappings/books.xml&quot;)/books/book/title</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refreshes the File Explorer window.</td>
</tr>
<tr>
<td><img src="image" alt="Reset Filters" /></td>
<td>Resets the File Explorer filter from its current content to the wildcard (<em>.</em>) .</td>
</tr>
<tr>
<td><img src="image" alt="Stylus File Types" /></td>
<td>Changes the File Explorer filter to display only file types associated with Stylus Studio: .xml, .xsd, .dtd, .java, .conv, and others.</td>
</tr>
</tbody>
</table>

### Working with the File Explorer Filter

By default, the File Explorer window uses a wildcard filter to display all file types (*.*)

![Figure 95. File Explorer Filter](image)

You can

- Type your own filter (*.txt, for example). If you want to use multiple filters, separate them with a semicolon (*.txt; *.html, for example).
- Use the Stylus File Types ![Stylus File Types](image) button to change the filter to display only file types associated with Stylus Studio (.xml, .xsd, .dtd, .java, .conv, and others)

Stylus Studio remembers the filters you create and adds them to the drop-down list.
Drag and Dropping Files in the Stylus Studio

You can open a file in Stylus Studio by dragging the file from the File Explorer (or other file system browsers, like Windows Explorer) and dropping it inside Stylus Studio. How Stylus Studio behaves depends on where you drop the file, as summarized in Table 4.

Table 4. How Stylus Studio Handles Dragged-and-Dropped Files

<table>
<thead>
<tr>
<th>If You Drop the File Here</th>
<th>Stylus Studio Does This</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the document editor area (when no documents are open)</td>
<td>Opens the document editor associated with the type of file you selected. See Types of Files Recognized by Stylus Studio on page 108. If the file type is not currently registered with Stylus Studio, you can register the file at this time using the Choose Module for dialog box. See Opening Unknown File Types on page 109.</td>
</tr>
<tr>
<td>On the document editor tab area</td>
<td>Opens the document editor associated with the type of file you selected. See Types of Files Recognized by Stylus Studio on page 108. If the file type is not currently registered with Stylus Studio, you can register the file at this time using the Choose Module for dialog box. See Opening Unknown File Types on page 109.</td>
</tr>
<tr>
<td>In an active document</td>
<td>Adds the file’s URL to the end of the document.</td>
</tr>
<tr>
<td>On another file in the File Explorer</td>
<td>Performs the operation associated with the target file and opens the resulting document in its own editor. For example, you might use this operation to convert a text file to XML by dropping the .txt file on a converter file (.conv).</td>
</tr>
<tr>
<td>In a project in the Project window</td>
<td>Adds the file to the project. If the file type is not currently registered with Stylus Studio, you can register the file at this time using the Choose Module for dialog box. See Opening Unknown File Types on page 109.</td>
</tr>
</tbody>
</table>
Other Ways to Open Files in Stylus Studio

In addition to the File Explorer and drag-and-drop, you can also open files in Stylus Studio from the following places:

- The Open dialog box (displayed when you select File > Open from the menu, for example). By default, Stylus Studio opens the file in the editor associated with files of the type you select (see Types of Files Recognized by Stylus Studio on page 108). If you want, you can choose a different editor – you might want to open an XSLT stylesheet in the XML Editor, for example – when opening files from the Open dialog box.

  To specify a different module, click the down arrow to the right of the Open button and select the module you want to use from the drop-down list as shown in Figure 96.

- Project window – either double-click the file, or select Open or Open With from the file’s shortcut menu.

- Other file system browsers (like Windows Explorer, for example) – for files recognized by Stylus Studio, just double-click the file. See “Opening Unknown File Types” on page 109.

![Figure 96. Choose the Module to Use When Opening a File](image)
Adding File Types to Stylus Studio

You use the procedure described in this section to associate a file type (.txt, for example) with a specific Stylus Studio module or editor. Once you do this, any time you open a file of that type from within Stylus Studio (using the File Explorer, for example), that file is opened in the editor you specify.

You can optionally specify that you want to use Stylus Studio as the default editor for files of this type, regardless of where the file is opened (from a file browser like Total Commander, for example).

**Note**  You do not need to specify the usual extensions, such as xml, xsl, and java. Use the procedure described in this section for file name extensions peculiar to your application or environment.

1. From the Stylus Studio menu bar, select **Tools > Options**. Stylus Studio displays the **Options** dialog box.
2. Under **General**, click **File Types**. The **File Types** page appears.

![Figure 97. Associating File Types with Stylus Studio Editors](image)
3. To add a new file type/module association, click the Add button.  
   Alternative: Double-click the Type field.
4. Type the new extension, including the period, and press Enter. 
   Stylus Studio adds the file type and selects a default module in the Module field.
5. Optionally, select a different module using the drop-down list in the Module field.
6. If you want to always use Stylus Studio to open files of this type, change the value in the Open with Stylus Studio field to True.
7. To add another file type, repeat Step 3 through Step 6.
8. When you are done, click OK.

Deleting File Types

1. Click the file type you want to delete.
2. Click the Delete button.
3. Click OK.

Working with Projects

A project in Stylus Studio is a group of files related to a given XML application. A project might include XML, XML Schema, and XQuery files, as well as OASIS catalogs, for example. A project can contain subprojects, and subprojects can contain subprojects. The Stylus Studio project framework allows you to name projects (project files are saved with a .prj extension), and it provides several tools for managing the projects you create.

Projects are simply a convenience for organizing files – a file does not have to belong to a project in order for you to edit it in Stylus Studio. For example, Stylus Studio includes all sample application files in the examples project. You can find the examples.prj file in the examples directory of your Stylus Studio installation directory.

This section discusses the following topics:
- “Displaying the Project Window” on page 117
- “Creating Projects and Subprojects” on page 118
- “Saving Projects” on page 119
- “Opening Projects” on page 119
- “Adding Files to Projects” on page 120
Working with Projects

- “Copying Projects” on page 121
- “Rearranging the Files in a Project” on page 121
- “Removing Files from Projects” on page 121
- “Closing and Deleting Projects” on page 122
- “Setting a Project Classpath” on page 122
- “Using Stylus Studio with Source Control Applications” on page 125

Displaying the Project Window

When you open Stylus Studio for the first time, Stylus Studio displays the Project window with the examples project. (The File Explorer window is displayed on the right.)

![Project Window with Default Project Displayed](image)

Figure 98. Project Window with Default Project Displayed

There are several ways to toggle the display of the Project window. You might want to close the Project window in order to gain more space in the editor you are working with, for example.

- From the Stylus Studio menu, select View > Project Window.
- In the Stylus Studio tool bar, click Toggle Project Window.

**Tip** The Project window is dockable – you can move it anywhere on your desktop.
Click the X in the upper right corner of the Project window.

**Tip** When you hide the Project window, any open files remain open.

### Displaying Path Names

You can control whether the Project window displays absolute or relative path names for files in projects. The default display is relative names.

1. Display the Project window.
2. In the Project window, right-click to display the pop-up menu.
3. Click Show Full URL Info.

### Other Documents

Stylus Studio displays documents that are not associated with a project in the Other Documents folder, which appears after the last folder or document in the currently displayed project. In addition, when you remove a file from a project, it is placed in the Other Documents folder.

![Figure 99. Other Documents Folder](image)

You can add these documents to a project at any time. See “Adding Files to Projects” on page 120.

### Creating Projects and Subprojects

You can create projects and organize any project into multiple levels of subprojects. You can add files to projects and save the project under a name you specify.

Stylus Studio displays the new project in the Project window. The Project window displays information for only one project at a time.

1. Right-click the project name, and click New Project Folder in the pop-up menu.
Stylus Studio displays a default subproject folder name (NewFolder1, for example).

2. Type a new subproject name.
3. Press Enter.

There are several ways to add files to your projects and subprojects. See “Adding Files to Projects” on page 120.

**Saving Projects**

The first time you save a project, Stylus Studio prompts you to specify a name for your project. Stylus Studio appends .prj to the name you specify. It does not matter whether or not you specify the .prj extension. Stylus Studio does not allow a project to have any other file name extension.

When you save a project, references to the files part of the project are saved relative to the path of the project file. This allows you to move or share projects easily.

**Opening Projects**

You can have only one project open at one time. If you have a project open and you open a second project, Stylus Studio closes the first project and then opens the second project.

If the Project window is not visible when you open a project, Stylus Studio automatically displays the Project window.

1. From the Stylus Studio menu bar, select Project > Open Project.
2. Navigate to and select your project file. For example, you can open examples.prj in the examples directory of your Stylus Studio installation directory. The examples project contains the files for all Stylus Studio sample applications.
3. Click the Open button.
Recently Opened Projects

Projects that were recently opened are displayed at the bottom of the Project drop-down menu. Click the project you want to open.

![Figure 100. Recently Opened Projects Are Listed on the Project Menu](image)

Adding Files to Projects

The easiest way to add a file to a Stylus Studio project is to drag the file from the File Explorer or another file browser (like Total Commander, for example) into the desired project folder. You can drag-and-drop multiple files at a time.

If the file type is unknown to Stylus Studio, the Choose Module for dialog box appears, which allows you to associate the file with a Stylus Studio module or editor. See Opening Unknown File Types on page 109 for more information.

Other Ways to Add Files to Projects

The following procedures describe other ways to add files to a project. Note that these procedures vary based on whether or not the file is already open in Stylus Studio.

When Files are Open in Stylus Studio

1. Open the project to which you want to add the file.
2. Click the window (the Web Service Call Composer, for example) that contains the file you want to add.
3. In the Stylus Studio tool bar, click Add Document to Project.
When Files are Closed

1. Open the project to which you want to add the file.
2. In the Stylus Studio tool bar, click Add File to Project. 
   Alternative: Select Project > Add File from the Stylus Studio menu bar.
   The Open dialog box appears.
3. Navigate to the file you want to add and click the Open button.

Copying Projects

1. Open the project you want to copy.
2. From the Stylus Studio menu bar, select Project > Save Project As.
   The Save As dialog box appears.
3. Navigate to the location for the project copy.
4. In the URL: field, type the name of the new project.
5. Click the Save button.

Rearranging the Files in a Project

The order in which files are displayed in the Project window has no effect on the project. You might want to place related files near each other, or place more frequently used project files toward the top of the project tree.

1. If the Project window is not visible, click Toggle Project Window in the Stylus Studio tool bar.
2. In the Project window, click the file you want to move.
3. Drag it to its new location.

Removing Files from Projects

When you remove a file from a project, it is added to the Other Documents folder in the Project window.
1. If the **Project** window is not visible, click **Toggle Project Window** in the Stylus Studio tool bar.

2. In the **Project** window, click the path for the file you want to remove.

3. From the Stylus Studio menu bar, select **Project > Remove File from Project**. 
   *Alternative: Press the Delete key.*

### Closing and Deleting Projects

#### Closing

**Tip** Toggling or closing the **Project** window does not close the project.

#### Deleting

### Setting a Project Classpath

You can set a classpath at the project level. When Stylus Studio compiles or runs Java code, it always checks the project for a locally defined classpath first. If a project classpath has not been defined, Stylus Studio uses the classpath defined **Java Virtual Machine** page of the Options. dialog box.

### Specifying Multiple Classpaths

You use the **Project Classpath** dialog box to specify one or more classpaths for a project. If multiple classpaths have been defined, Stylus Studio searches them in the order in which they are listed in the **Project Classpath** dialog box. You can use the up and down arrows at the top of this dialog box to change the classpath order.

![Project Classpath](image)

**Figure 101. Use Arrow Buttons to Change the Order of Classpaths**
How to Set a Project Classpath

1. Open the Project Window if it is not already displayed.
2. Right-click the project node.
   The project shortcut menu appears.
   Alternative: Select Project > Set Classpath from the Stylus Studio menu.
3. Select Set Project Classpath.
   The Project Classpath dialog box appears.

![Project Classpath Dialog Box](image)

4. Click the browse folders ( ) button.
   A new entry field appears in the Locations list box. Two buttons appear to the right of the entry field.
5. To add a JAR file to the classpath, click the browse jar files button ( ).
Stylus Studio displays the **Browse for Jar Files** dialog box.

![Browse for Jar Files Dialog Box](image)

**Figure 103. Browse for Jar Files Dialog Box**

To add a folder to the classpath, click the browse folders button ( ). Stylus Studio displays the **Browse for Folder** dialog box.

![Browse for Folder Dialog Box](image)

**Figure 104. Browse for Folder Dialog Box**

6. When you have located the JAR file or folder you want to add to the classpath, click **OK**.

7. Optionally, add other JAR files or folders to the classpath by repeating **Step 5** and **Step 6**.
Using Stylus Studio with Source Control Applications

Stylus Studio supports the Microsoft Source Code Control Interface, allowing you to use Stylus Studio with any source code control system that supports the same interface used by Microsoft Visual Studio or Microsoft Visual Studio .NET.

Stylus Studio’s source control support allows you to

- Add a file to source control
- Remove a file from source control
- Get the latest version of a source-controlled file
- Check out a file
- Check in a file
- Uncheck out a file
- Show the source control history of a file
- Show differences between versions of a file

In this section

This section covers the following topics:

- “Tested Source Control Applications” on page 125
- “Prerequisites” on page 126
- “Using Stylus Studio with Microsoft Visual SourceSafe” on page 126
- “Using Stylus Studio with ClearCase” on page 129
- “Using Stylus Studio with Zeus CVS” on page 132
- “Specifying Advanced Source Control Properties” on page 133

Tested Source Control Applications

Integration with the following source control applications has been tested:

- Microsoft Visual SourceSafe
- Clearcase/Attache
- CVS
Prerequisites

To use Stylus Studio’s source control features, you must have already installed the client software for your source control application, as shown in Table 5.

Table 5. Working with Source Control Clients

<table>
<thead>
<tr>
<th>When Data Is In</th>
<th>You Need to Install</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceSafe repository</td>
<td>SourceSafe client or SourceOffSite</td>
</tr>
<tr>
<td>ClearCase</td>
<td>Attache client</td>
</tr>
<tr>
<td>CVS</td>
<td>Zeus-CVS product</td>
</tr>
</tbody>
</table>

In addition, files must belong to a Stylus Studio project before you can use them with a source control application.

Recursive Selection

When you build a project using files from a source control application, Stylus Studio gives you the option of recursively importing all projects that are subordinate to the project folder you select. This option, Recursively import all subprojects, appears on the Build Project from SCC dialog box, which appears when you start the New Project Wizard.

Selecting the Recursively import all subprojects option has the effect of selecting all the siblings of the selected file or directory, as well as any descendants of the selected item and its siblings. Stylus Studio creates a project that contains all files that Stylus Studio can open (for example, .xml, xs1t, and .xsd files) and that are in the directory hierarchy of the file or directory you select.

For example, suppose you check Recursively import all subprojects, and you select c:\work\myproject\documentation.xml. Stylus Studio creates a project that contains all Stylus Studio-editable files in c:\work\myproject and its subdirectories.

If you do not check Recursively import all subprojects, only the file you select is added to the new Stylus Studio project you create. You cannot select a directory if you do not select this option.

Using Stylus Studio with Microsoft Visual SourceSafe

1. From the Stylus Studio menu bar, select Project > New Project Wizard.
The **Project Wizards** dialog box appears.

![Project Wizards Dialog Box](image)

**Figure 105. Project Wizards Dialog Box**
2. Click Project from SCC, and click the OK button.
The Build Project From SCC dialog box appears.

3. Select Microsoft Visual SourceSafe from the Provider to use drop-down list.

4. If you want to use Stylus Studio to access more than one file in a directory hierarchy, click the check box for Recursively import all subprojects. See “Recursive Selection” on page 126 if you need help with this step.
   Depending on your installation, you might need to specify other properties. See “Specifying Advanced Source Control Properties” on page 133.

5. Click the OK button.
The Visual SourceSafe Login dialog box appears:

6. Specify the username and password; optionally, use the Browse... button to access a database other than the default database displayed in the Database field.

7. Click OK.
Working with Projects

The **Create Local Project from SourceSafe** dialog box appears.

![Create Local Project from SourceSafe Dialog Box](image)

**Figure 108. Create Local Project from SourceSafe Dialog Box**

1. Select the folder in which you want to create the new project.

2. Click **OK**.

   The project is created in Stylus Studio. A message displays the names of any files that were not added to the project because their extensions are not associated with a Stylus Studio editor.

**Using Stylus Studio with ClearCase**

1. Use Attache to copy the files you want to work on from a ClearCase view to the local file system.

   **Note**

   If you move these files from this directory after you create the project, you must specify the new directory that contains the files in the **Local Project Path** field of the **Source Control Properties** dialog box. To access this dialog box, select **SourceControl > Source Control Properties** from the Stylus Studio menu bar.

2. From the Stylus Studio menu bar, select **Project > New Project Wizard**.
The **Project Wizards** dialog box appears.

![Project Wizards Dialog Box](image)

**Figure 109. Project Wizards Dialog Box**

3. Click **Project from SCC**, and click the **OK** button.

The **Build Project From SCC** dialog box appears.

![Build Project From SCC Dialog Box](image)

**Figure 110. Build Project From SCC Dialog Box**

4. Select **Clearcase** from the **Provider to use** drop-down list.

5. If you want to use Stylus Studio to access more than one file in a directory hierarchy, click the check box for **Recursively import all subprojects**. See “Recursive Selection” on page 126 if you need help with this step.

   Depending on your installation, you might need to specify other properties. See “Specifying Advanced Source Control Properties” on page 133.

6. Click the **OK** button.
The **Browse for Folder** dialog box appears.

![Browse for Folder Dialog Box](image)

**Figure 111. Browse for Folder Dialog Box**

7. Navigate to and select the file or directory you want to operate on, or one of the files or directories in the topmost level of the directory hierarchy that you want to access, and click the **OK** button.

   Stylus Studio creates a new project that contains the file you selected, or all files that are editable by Stylus Studio and that were in the directory hierarchy of the file you selected. The default name of the project is `Projectn`. To rename the project, select **Project > Save Project As** from the Stylus Studio menu bar.

**Adding Files After the Project is Created**

After you create the project, you can add additional ClearCase files to it. If the file is already in ClearCase, it must be a sibling of the original file you selected, or it must be a descendant of one of its siblings. If the file you want to add is not in the directory hierarchy of the original file, you must create a new Stylus Studio project and specify a directory in the source control hierarchy that contains all the files you want to be in your Stylus Studio project.

If you want to add a file that is not already in ClearCase, open the file in Stylus Studio and then click **Add To Source Control** in the Stylus Studio tool bar.
Using Stylus Studio with Zeus CVS

Stylus Studio supports the latest version of the Zeus CVS Provider, and with some additional configuration needed in the SourceControl > Properties dialog box.

1. From the Stylus Studio menu bar, select Project > New Project Wizard. The Project Wizards dialog box appears.

2. Click Project from SCC, and click the OK button. The Build Project From SCC dialog box appears.

3. Select Zeus SCC-CVS from the Provider to use drop-down list.

4. Click the check box for Recursively import all subprojects.

5. Click Advanced. Several new fields appear.

6. In the User Name field, type the user name you want to use to log in to the CVS server.

7. In the Project Name field, type the name of a module in the source control hierarchy. This should be the name of a directory that contains all files that you want to open in Stylus Studio.

8. In the Auxiliary Path field, type the contents of the $CVSROOT environment variable that you use to access the CVS server. For example, suppose you are required to enter the following commands in a DOS console or UNIX shell:

   `cvs.exe -d:pserver:user@server.company.com:/cvsroot/projectname login`
   
   `Password: *****`
   
   `cvs.exe -d:pserver:user@server.company.com:/cvsroot/projectname co module`

   The value you should enter in the Auxiliary Path field would be:
   
   `:pserver:user@server.company.com:/cvsroot/projectname`

9. In the Working Dir field, type the name of a local directory.
10. Click the **OK** button.

Stylus Studio downloads the selected files and places them in the directory you specified in the **Working Dir** field. If you move these files from this directory, you must specify the new directory that contains the files in the **Local Project Path** field of the **Source Control Properties** dialog box. To open this dialog box, select **SourceControl > Source Control Properties** from the Stylus Studio menu bar.

All files that can be opened in Stylus Studio are now in the new Stylus Studio project. The default name of the project is Project
n. To rename the project, select **File > Project > Save Project As** from the Stylus Studio menu bar.

**Note**  
The **cvs.exe** file must be in your **PATH** environment variable.

### Specifying Advanced Source Control Properties

The **Advanced** button in the **Build Project From SCC** dialog box displays several additional fields.

![Advanced Source Control Settings](image)

- **User Name** is the name of the source control user. Stylus Studio uses this name to establish a connection with the source control server.

- **Project Name** is the name of the source control repository you want to access. The syntax of the project name depends on the source control provider you want to connect with. For example, SourceSafe uses $/Name/Name, ClearCase uses the name of the view, and CVS uses the name of the module. Some source control providers change this description to something more suitable to their model. For example, ClearCase changes it to **ClearCase Attache**.
● **Auxiliary Path** contains source control provider-specific information. This field allows you to enter any other information required to find your source control server. For example, if you are using SourceSafe, you would specify the directory of the SourceSafe client here. If you are using CVS, you would specify the contents of the CVSRoot environment variable.

● **Working Dir** is the local directory into which you copied the files under source control that you want to access. It is the local counterpart for the source control repository. For example, suppose you copied the contents of the SourceSafe repository $/Company/OneProject to the local directory c:\work\myproject. Your local files would map to the source control hierarchy as shown in Table 6:

<table>
<thead>
<tr>
<th>Local File</th>
<th>Repository File</th>
</tr>
</thead>
<tbody>
<tr>
<td>c:\work\myproject\documentation.xml</td>
<td>$/Company/OneProject/documentation.xml</td>
</tr>
<tr>
<td>c:\work\myproject\subdir\root.java</td>
<td>$/Company/OneProject/subdir/root.java</td>
</tr>
<tr>
<td>c:\work\anotherproject\root.java</td>
<td>$/Company/anotherproject/root.java</td>
</tr>
</tbody>
</table>

### Customizing Tool Bars

Stylus Studio allows you to customize the appearance, location, and content of tool bars, and even to create tool bars of your own. This section covers the following topics:

- “Tool Bar Groups” on page 134
- “Showing/Hiding Tool Bar Groups” on page 135
- “Changing Tool Bar Appearance” on page 136

### Tool Bar Groups

Tool bars are organized by functional group within Stylus Studio (Default, Edit, Source Control, and so on). Customizations available for these groups include

- Show/hide
- Look, feel, and size
- Group position

**Tip** Tool bars are docking windows – you can drag them anywhere on your desktop.
Customizing Tool Bars

You control all these customizations from the Toolbars tab of the Customize dialog box.

![Customize dialog box](image)

**Figure 113. Toolbars Tab of Customize Dialog Box**

**Showing/Hiding Tool Bar Groups**

Tool bar groups are displayed by default. Use this procedure to hide/re-display them.

**Tip** Consider maximizing Stylus Studio on your desktop in order to view as much of the tool bar as possible when making changes.

1. Display the Customize dialog box (Tools > Customize).
2. In the Toolbars group box, deselect the check box of the group you want to hide.
   The tool bar is removed from the Stylus Studio window.
3. To re-display a hidden tool bar group, follow Step 1 and Step 2 and reselect the check box,
Changing Tool Bar Appearance

Changes you can make to the tool bar’s appearance include

- Whether or not to show tooltips when the mouse pointer is placed over a tool bar button
- Whether tool bar buttons are rendered as a flat panel (the Cool Look) or individual buttons
- Whether tool bar buttons are rendered in a size larger than the default

Note Appearance settings affect all tool bars. You cannot control the appearance of individual tool bar groups.

1. Display the Customize dialog box (Tools > Customize).
2. Click Show Tooltips to toggle the display of tooltips when the pointer is placed over a tool bar button.
3. Click Cool Look to toggle the display of the tool bar between one that is rendered as a flat panel and one that is rendered as individual buttons.
4. Click Large Buttons to toggle the size of the tool bar buttons.
5. Optionally, click the Reset button to restore default settings.
6. Click the OK button.

Specifying Stylus Studio Options

Stylus Studio allows you to set a variety of options for Stylus Studio modules, and it provides the ability to define custom tools to run different editors and processors. This section covers the following topics:

- “Setting Module Options” on page 136
- “Defining Custom Tools” on page 138

Setting Module Options

Stylus Studio allows you to set a variety of options for the Stylus Studio modules.

1. From the Stylus Studio menu bar, select Tools > Options.
2. In the Options dialog box that appears, expand Module Settings to display a list of choices.
Specifying Stylus Studio Options

XML Diff

You use the Engine and Presentation pages to define settings used by the XML Diff tool. See “Diffing Folders and XML Documents” on page 197 for more information.

XML Editor

Click XML Settings to specify the following:

- Refresh interval for Sense:X
- Number of errors after which you want Stylus Studio to stop validation, and whether or not you want Stylus Studio to display a message when validation is complete

Click Custom Validation Engines to specify an alternate validation engine. See “Custom XML Validation Engines” on page 894 for more information.

XSLT Editor

Module settings for the XSLT Editor let you specify external XSLT processors, settings used by the Mapper and WYSIWYG tabs, and general editor behavior.

Click External XSLT to specify default values for external XSLT processors. Note that Stylus Studio’s back-mapping and debugging features are not supported for all XSLT processors. The XSLT processors that support back-mapping and debugging are identified on the Processor tab of the Scenario Properties dialog box.

In a scenario, you can specify that you want to use an external XSLT processor. If you use a particular XSLT processor frequently, specify default values here. Then, in the scenario properties, you just need to specify which external XSLT processor you want to use. If you specify default values and you then specify different values in a scenario’s properties, the scenario properties override the defaults. You can specify the following external XSLT options:

- Default additional path for Xalan-J processor
- Default additional classpath for Xalan-J processor
- Additional JVM options for Xalan-J processor
- Default custom processor command line
- Default additional path for custom processor
- Default additional classpath for custom processor
Click **Mapper** to specify how `xsl:for-each` instructions should be rendered on the Mapper canvas, and to specify element creation for unlinked nodes. See “Mapping Source and Target Document Nodes” on page 461 for more information on using the XSLT Mapper.

Click **WYSIWYG** to specify settings Stylus Studio uses to define tab stops and new lines in the HTML it generates. See “Creating Stylesheets That Generate HTML” on page 363 for more information on using the XSLT WYSIWYG editor.

Click **XSLT Settings** to specify the following:

- Whether Stylus Studio displays the **Scenario Properties** dialog box when you create a new stylesheet
- Whether Stylus Studio saves scenario meta information in stylesheets
- Whether Stylus Studio detects infinite loops
- Maximum recursion level
- Allocated stack size

**Java**

To modify Java settings, see “Configuring Java Components” on page 149.

**Defining Custom Tools**

Stylus Studio allows you to define custom tools to run alternative editors, processors, preprocessors, or postprocessors. For example, you can specify a custom tool that configures Internet Explorer to display the document you are working on.

After you define a custom tool, Stylus Studio adds an entry to its **Tools** menu – select **Tools** and then your tool. The order in which the tool names appear in the **Custom Tools** options page is the order in which the tool names appear in the Stylus Studio **Tools** menu.

1. From the Stylus Studio menu bar, select **Tools > Options**.
   Stylus Studio displays the **Options** dialog box.

2. Click **Custom Tools** to display the **Custom Tools** page.

3. In the **Custom Tools** page, click **Define New Tool**.
Stylus Studio displays an entry field for the tool name.

4. Enter the name as you want it to appear in the Stylus Studio **Tools** menu.

5. In the **Command** field, specify or select the absolute path for the command that runs your tool. This must be a .exe, .bat, or .cmd file.

6. In the **Arguments** field, specify any arguments your tool requires. You can click to display a drop-down list that includes **File Path**, **File Dir**, **File Name**, **File Extension**, and **Classpath**.

7. In the **Initial Directory** field, type the absolute path for the directory that contains any files or directories needed by your custom tool.

8. In the **Path** field, type any paths that need to be defined and that are not already defined in your PATH environment variable.

9. If you want Stylus Studio to prompt for arguments before it runs your tool, click **Prompt for Arguments**.

10. If you want Stylus Studio to display output from your custom tool in its **Output Window**, select **Use Output Window**.

11. Click the **OK** button.
Defining Keyboard Shortcuts

You can define a keyboard shortcut for many of the tasks you perform with Stylus Studio. If you find that you repeatedly perform the same action, define a shortcut to speed your work. You can use a keyboard shortcut right after you define it.

How to Define a Keyboard Shortcut

1. From the Stylus Studio menu bar, select **Tools > Keyboard**. The **Shortcut Keys** dialog box appears.

2. In the **Select a macro**: field, select the macro for which you want to define a shortcut. **Tip** When you select a macro, Stylus Studio displays a description of what that macro does.

3. Click **Create Shortcut**. The **Assign Shortcut** dialog box appears.
4. Press the key or keys that you want to be the shortcut. For example, Ctrl+E, F7, Alt+P. The Assign Shortcut dialog box displays a message indicating whether or not that key combination is currently in use.

5. If the shortcut key is not already in use, click the OK button. Otherwise, try another shortcut key.
   Stylus Studio closes the Assign Shortcut dialog box.

6. Click OK in the Shortcut Keys dialog box.

Deleting a Keyboard Shortcut

1. From the Stylus Studio menu bar, select Tools > Keyboard. The Shortcut Keys dialog box appears.

2. In the Select a macro: field, select the macro you want to delete a shortcut for.

3. In the Assigned shortcuts field, click the shortcut you want to remove.

4. Click Remove.

5. Click OK in the Shortcut Keys dialog box.

Using Stylus Studio from the Command Line

Stylus Studio provides utilities that allow you to perform several Stylus Studio operations from the command line. These utilities, and where to find more information on them, are described in the following table.

Table 7. Stylus Studio Command Line Utilities

<table>
<thead>
<tr>
<th>Utility Name</th>
<th>Description</th>
<th>Where to Find More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>struzzo</td>
<td>Invokes Stylus Studio</td>
<td>“Invoking Stylus Studio from the Command Line” on page 142</td>
</tr>
<tr>
<td>StylusDiff</td>
<td>Diffs two XML documents</td>
<td>“Running the Diff Tool from the Command Line” on page 226</td>
</tr>
<tr>
<td>StylusValidator</td>
<td>Validate XML</td>
<td>“Validating XML from the Command Line” on page 144</td>
</tr>
</tbody>
</table>
The executables for these command line utilities are located in the \bin directory where you installed Stylus Studio.

### Invoking Stylus Studio from the Command Line

You use the Struzzo utility to invoke Stylus Studio from the command line and open a particular file. Stylus Studio recognizes the file extension and opens the file in the editor associated with that file type. If Stylus Studio is already running, the same instance is used to open the file specified in the file parameter.

You can optionally use the stylesheet or XQuery parameter to create a scenario with the stylesheet or XQuery you specify.

The Struzzo utility takes the following format:

```
Struzzo file [stylesheet or XQuery]
```

Table 8 describes the parameters for the Struzzo command.

#### Table 8. Struzzo Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>file</td>
<td>The path of the document you want to open in Stylus Studio. This document is used as the source document in a scenario when you provide the stylesheet or XQuery parameter.</td>
</tr>
<tr>
<td>[stylesheet or XQuery]</td>
<td>The path of the stylesheet or XQuery you want to use to create a scenario.</td>
</tr>
</tbody>
</table>

### Applying a Stylesheet from the Command Line

You use the StylusXslt utility to apply a stylesheet from the command line. The StylusXslt utility uses the XSLT and XPath processors specified in Stylus Studio.
Using Stylus Studio from the Command Line

One way you might want to use the StylusXslt command-line utility is to chain stylesheets. That is, you can create a batch file in which Stylus Studio consecutively applies multiple stylesheets to the same XML source document. Stylus Studio creates temporary files to specify the result of one transformation as the source for the next transformation.

The StylusXslt utility takes the following format:

```
StylusXslt [-out <output file>] [-param name=value] [-fop] [-print] -in <input XML file> <XSLT stylesheet>
```

Table 9 describes the parameters for the StylusXslt command.

Table 9. StylusXslt Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-out &lt;output file&gt;]</td>
<td>File to which the XSLT result will be written. The default is stdout.</td>
</tr>
<tr>
<td>[-param name=value]</td>
<td>The name-value pair of a parameter in the stylesheet specified in the</td>
</tr>
<tr>
<td></td>
<td>stylesheet parameter.</td>
</tr>
<tr>
<td>[-fop]</td>
<td>Invokes the Apache Formatting Objects Processor (FOP) to post-process the</td>
</tr>
<tr>
<td></td>
<td>XSLT result.</td>
</tr>
<tr>
<td>[-print]</td>
<td>Sends the result of the transformation to the default printer.</td>
</tr>
<tr>
<td>[-in &lt;input file&gt;]</td>
<td>The path of the XML document to which you want to apply the stylesheet</td>
</tr>
<tr>
<td></td>
<td>specified in the XSLT stylesheet parameter.</td>
</tr>
<tr>
<td>&lt;XSLT stylesheet&gt;</td>
<td>The path of the XSLT you want to apply to the document specified in the</td>
</tr>
<tr>
<td></td>
<td>-in parameter.</td>
</tr>
</tbody>
</table>

Executing an XQuery from the Command Line

XQuery support is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

You use the StylusXql utility to execute an XQuery from the command line. The format for invoking the utility is as follows:

```
StylusXql [-in <source>] [-out <output file>] [-param name=value] [-i] [-debug host[:port]] <XQuery file>
```
Table 10 describes the parameters for the StylusXql command. All parameters are required.

### Table 10. StylusXql Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-in &lt;source&gt;</td>
<td>The path of the XML document to be used to set the current context for the</td>
</tr>
<tr>
<td></td>
<td>XQuery.</td>
</tr>
<tr>
<td>-out &lt;output</td>
<td>File to which you want the XQuery result to be written. The default is</td>
</tr>
<tr>
<td>file&gt;</td>
<td>stdout.</td>
</tr>
<tr>
<td>-param</td>
<td>The name-expression pair of a variable in the XQuery specified in the</td>
</tr>
<tr>
<td>name=value</td>
<td>XQuery file parameter.</td>
</tr>
<tr>
<td>-i</td>
<td>Indents the XQuery result.</td>
</tr>
<tr>
<td>-debug</td>
<td>Debugs the query using the debug server specified by the host and,</td>
</tr>
<tr>
<td>host[:port]</td>
<td>optionally, port parameters.</td>
</tr>
<tr>
<td>XQuery file</td>
<td>The path of the XQuery you want to execute against the file specified in the</td>
</tr>
<tr>
<td></td>
<td>-in &lt;source&gt; parameter.</td>
</tr>
</tbody>
</table>

**Validating XML from the Command Line**

You use the StylusValidator utility to validate XML from the command line. StylusValidator uses the built-in Stylus Studio XML validator. All output from this utility goes to stdout.

The StylusValidator utility takes the following format:

StylusValidator [-q] [-noval] [-schema] filename

Table 11 describes the parameters for the StylusXql command.

### Table 11. StylusValidator Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-q]</td>
<td>Quiet mode – errors are not printed to stdout.</td>
</tr>
<tr>
<td>[-noval]</td>
<td>Checks only for well-formedness. Does not check for errors.</td>
</tr>
</tbody>
</table>
Managing Stylus Studio Performance

Stylus Studio uses the TEMP directory to store temporary files such as the translation in UNICODE of the current XML or XSLT document. File systems are usually quite fast when handling files that are in the range of a few hundred megabytes. Stylus Studio performance should be smooth and quick when the TEMP windows environment variable points to a location where

- There is a minimum of 1 gigabyte of free space.
- The host disk is reasonably fast.

Stylus Studio is regularly tested against files that are up to 120 MB. How well your installation of Stylus Studio can create, open, and manipulate such large files, or even larger files, depends on

- Available physical memory
- Dimension of the page file
- Current load of the machine

Troubleshooting Performance

Table 12, Performance Symptoms, summarizes performance symptoms you might experience and where to find information on addressing them.

Table 12. Performance Symptoms

<table>
<thead>
<tr>
<th>Symptom</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML editing is slow</td>
<td>Changing the Schema Refresh Interval on page 146</td>
</tr>
<tr>
<td></td>
<td>Checking for Modified Files on page 147</td>
</tr>
</tbody>
</table>
Changing the Schema Refresh Interval

As you edit an XML document, Stylus Studio displays a pop-up menu that lists the elements and element attributes you can create. Stylus Studio retrieves this information from the document’s schema. The frequency with which Stylus Studio retrieves this information can affect XML editing performance. The default refresh interval is 10 seconds.

If XML editing performance is slow, increase the refresh interval that Stylus Studio uses to refresh the schema information.

1. From the Stylus Studio menu bar, select **Tools > Options**. The **Options** dialog box appears.
2. Click **Module Settings > XML Editor > XML Settings**. The **XML Settings** page of the **Options** dialog box appears.
3. In the **Refresh interval** field, type a larger number. For information about how Stylus Studio uses this interval, see “Options - Module Settings - XML Editor - XML Settings”.

   **Tip** If the schema used by your document is almost never modified, you can safely increase the interval to as much as 10,000 seconds.
4. Click **OK**.
Managing Stylus Studio Performance

Checking for Modified Files
When you are working with files that Stylus Studio must open through network connections that might be slow, you might not want Stylus Studio to automatically check for modified files. Turning off this option can improve XML editing performance.

1. From the Stylus Studio menu bar, select **Tools > Options**.
   The Options dialog box appears.
2. Click **Application Settings** if it is not already selected.
   The Application Settings page of the Options dialog box appears.
3. If the **Automatically check for externally modified files** is selected, deselect it. For information about how Stylus Studio uses this setting see “Options - Application Settings”.
   Alternatively, you can select **Disable check on hidden files**, which allows Stylus Studio to skip these files. Hidden files are files that are in the Stylus Studio project or the Other Documents folder but are not currently open in Stylus Studio.
4. Click **OK**.

Changing the Recursion Level or Allocated Stack Size
If you are getting errors or crashes when you use the internal Stylus Studio XSLT processor, there are two options you can change to fix this.

- The **Maximum recursion level** is the number of levels Stylus Studio allows you to recurse on a template invocation.
- The **Allocated stack size** is the amount of memory allocated to the XSLT processing thread stack.

1. From the Stylus Studio menu bar, select **Tools > Options**.
   The Options dialog box appears.
2. Click **Module Settings > XSLT Editor > XSLT Settings**.
   The XSLT Settings page of the Options dialog box appears.
3. Adjust the **Maximum recursion level** and the **Allocated stack size** as needed. For information about how Stylus Studio uses these settings see “Options - Module Settings - XSLT Editor - XSLT Settings”.
4. Click **OK**.
Automatically Opening the Last Open Files

When you start Stylus Studio, it automatically opens any files that were open the last time you closed it. This feature can affect performance if many files were open when you last closed Stylus Studio.

If Stylus Studio is taking a long time to start, you can do one of the following:

- Close most or all files before you shut down Stylus Studio.
- Turn off the option that automatically opens the files that were open the last time you closed Stylus Studio.

1. From the Stylus Studio menu bar, select Tools > Options.
   The Options dialog box appears.

2. Click Application Settings if it is not already selected.
   The Application Settings page of the Options dialog box appears.

3. If Open last documents automatically when Stylus Studio starts is selected, deselect it. For information about how Stylus Studio uses this settings see “Options - Application Settings”.

4. Click OK.
Configuring Java Components

Several modules in Stylus Studio are written using Java, and therefore require either Java runtime or Java compiler components to be installed on your computer. These Java components, the Java Runtime Environment (JRE) and the Java Development Kit (JDK), are available from Sun Microsystems and are installed separately from Stylus Studio.

You can install these components either before or after you install Stylus Studio. When you start Stylus Studio, it attempts to identify the location of the Java runtime libraries and compiler automatically.

This section identifies the Stylus Studio modules that require Java runtime and Java compiler components, where you can download these Java components, and how to force Stylus Studio to detect new or changed Java components.

This section covers the following topics:
- “Stylus Studio Modules That Require Java” on page 149
- “Verifying the Current Java Virtual Machine” on page 150
- “Downloading Java Components” on page 150
- “Modifying Java Component Settings” on page 151
- “Modifying the Classpath” on page 153

Stylus Studio Modules That Require Java

The following modules in Stylus Studio require that Java runtime and/or Java compiler components are installed on the machine on which you have installed Stylus Studio:
- Saxon XSLT and XQuery engines
- Mark Logic XQuery engine
- Xalan-J XSLT engine
- Xerces-J Validator
- SQL/XML
- FOP
- Custom File Systems
- Web Service Call Composer Axis client
- Adapters accessed via URL
- Sense:X in the Java editor
- CSV to XML document wizard
Getting Started with Stylus Studio® 2006

- Fixed to XML document wizard

Rather than trying to determine in advance which Stylus Studio modules you might use in your XML application development, consider installing the JDK or JRE on your machine.

Settings for Java Debugging

See “Debugging Java Files” on page 495 for more information on this topic.

Verifying the Current Java Virtual Machine

The Java Virtual Machine (JVM) interprets runtime commands and compiler instructions; it is part of the Java installation. You can check to see the current version of the JVM installation by selecting Help > About from the Stylus Studio menu:

![Figure 117. Verifying the Current JVM Installation](image)

The Java Virtual Machine field displays information about the JVM installed on your machine.

Downloading Java Components

Java runtime and compiler components are available for download from Sun Microsystems; they are packaged in the Java 2 Platform Standard Edition (J2SE).

Either of the following versions is compatible with Stylus Studio 2006:
Configuring Java Components

- J2SE 1.4.2 (download it here: http://www.java.sun.com/j2se/1.4.2/download.html)
- J2SE 5.0 (download it here: http://www.java.sun.com/j2se/1.5.0/download.jsp)

Modifying Java Component Settings

Properties for JVM and JDK components are displayed on the Java Virtual Machine page of the Options dialog box, shown in Figure 118. When you start Stylus Studio, it automatically detects the Java Virtual Machine (JVM) and compiler components installed on your machine and sets the properties for these components accordingly.

![Options Dialog Box](image)

Figure 118. Reset Java Properties in the Options Dialog Box

Once these properties have values, Stylus Studio uses them until you either
- Use the auto detect feature to change them. You might want use auto detect if you have been using Stylus Studio with the J2SE 1.4.2 and later install the J2SE 5.0, for example.
- Change them manually. You can manually specify that Stylus Studio use a different jvm.dll or javac.exe, for example.

How Auto Detect Works

The auto detect feature prompts Stylus Studio to fetch the settings from the registry setting Current Version under the key HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Java Runtime
Environment to find the version, and then adds the version number to that same location to get the settings.

Note that if you manually change your settings to use another local version of the JDK, it may fail to load properly unless you also point the Current Version setting to match. This is because the JVM itself might try to load DLLs from the location of the current version instead of the location you specify.

About JVM Parameters

As a rule, you should never change the default values in the Parameter fields for the JVM or the External JVM. This option exists to accommodate unusual configurations. In such situations, Stylus Studio Technical Support might instruct you to change this value.

About JDK Parameters

The -g parameter instructs the compiler to add debugging information to the generated .class file; it is set by default.

How to Modify Java Component Properties

1. Start Stylus Studio if it is not already running, and select Tools > Options from the menu.
   The Options dialog box appears.


3. If you want Stylus Studio to update Java component properties to the latest installed version on your machine, click the Auto detect button.
   Otherwise, make the changes manually.

4. Click OK.

5. If you made changes to any JVM properties, you need to restart Stylus Studio for those changes to take effect.
Modifying the Classpath

The only field not set by Stylus Studio’s auto detect feature is the **Classpath** field. For Stylus Studio to be able to find a Java class, its location must be specified in this classpath.

To add a directory or `.jar` file to this classpath, click **Browse**. For classpath changes to take effect, you must restart Stylus Studio whenever you modify the **Classpath** field.

**Note**  The value of the **Classpath** field does not affect the `CLASSPATH` environment variable. The default value of the **Classpath** field, `${classpath}`, specifies that you want to use the contents of the `CLASSPATH` environment variable. There is no requirement for the classpath specified here and the classpath specified in the environment variable to be identical. However, it is good practice for them to be the same.
Stylus Studio makes it easy to create, edit, and query XML documents. Depending on the structure of the data in your XML document, you can choose to work with raw XML text, a DOM tree diagram, or a grid representation. Any changes you make in one view are immediately visible in every other view. You can easily create an XML Schema or DTD based on the content of your XML document if it is not already associated with a schema.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the XML Editor video.

You can see other Stylus Studio video demonstrations here: http://www.stylusstudio.com/xml_videos.html.

This section covers the following topics:

- “Creating XML Documents” on page 162
- “Using Document Wizards to Create XML” on page 162
- “Updating XML Documents” on page 165
- “Using the Text Editor” on page 167
- “Updating DOM Tree Structures” on page 179
- “Using the Grid Tab” on page 183
- “Diffing Folders and XML Documents” on page 197
- “Using Schemas with XML Documents” on page 229
- “Converting XML to Its Canonical Form” on page 231
- “Querying XML Documents Using XPath” on page 232
- “Printing XML Documents” on page 232
- “Saving XML Documents” on page 233
Creating XML Documents

You can create XML documents in Stylus Studio manually, using the XML Editor, or automatically, using a number of document wizards, adapters, and other features.

Using the XML Editor

To create an XML document using the XML Editor, select **File > New > XML Document** from the Stylus Studio menu.

Stylus Studio displays a new, untitled document in the XML Editor. The document contains only the XML declaration:

```xml
<?xml version="1.0"?>
```

The XML Editor provides several views of an XML document, each on its own tab – **Text**, **Tree**, **Grid**, and **Schema**. See “Updating an XML Document—Getting Started” for an overview of these XML editing tools. See “Updating XML Documents” on page 165 for more detailed information.

Other Ways to Create XML

You can also create XML using

- Document wizards that convert HTML, ADO, DTD, and XML Schema to XML. See “Using Document Wizards to Create XML” on page 162, later in this section.
- Built-in adapters that convert CSV, fixed-width, EDI, and other flat file formats to XML. See “Using Adapters in Stylus Studio” on page 281.
- User-defined adapters that you build using Stylus Studio’s Convert to XML module. See “Converting Non-XML Files to XML” on page 235.

Using Document Wizards to Create XML

Stylus Studio provides several document wizards that automatically create XML documents from XML Schema, DTD, HTML, and ADO. This section describes how to work with these document wizards; it covers the following topics:

- “How to Use a Document Wizard” on page 163
- “Creating XML from XML Schema” on page 163
- “Creating XML from DTD” on page 163
How to Use a Document Wizard

Most document wizards operate in the same general fashion:

1. Select the document wizard you want to use.
2. Specify the file from which you want to create an XML document (an HTML file or an XML Schema, for example).
3. Specify additional settings that will affect the resulting XML document (the root node, for example).
4. Run the wizard.

Converted files are opened as new, untitled XML documents in the XML Editor.

All document wizards are listed in the Document Wizards dialog box. Select File > Document Wizards to display this dialog box.

Creating XML from XML Schema

When you use the XML Schema to XML document wizard, you specify the XML Schema from which you want to create an XML document, as well as its root node, and whether or not you want to generate comments in the XML.

Note
If the XML Schema contains an element defined using a built-in type, the instance of that element in the XML document is created using the minimum value of the range specified for that type. For example, if the XML Schema contains a `<part>` element defined as `type="xs:integer"`, the `<part>` element in the resulting XML document appears as `<part>-9223372036854775808</part>`.

Creating XML from DTD

In addition to XML Schema, you can use a DTD to create an XML file. When you use the DTD to XML document wizard, you specify the DTD from which you want to create an XML document in the DTD File field. Next, specify the element that you want to be the root element in the new XML document, and whether or not you want expand each element only once (this results in a smaller XML document file).
Creating XML from HTML

You can create an XML document from an HTML file using the HTML to XML document wizard. Simply specify the HTML file you want converted to XML and run the document wizard.

**Tip** Stylus Studio also has a document wizard that converts HTML to XSLT. See Creating a Stylesheet from HTML on page 347.

Creating XML from ADO

You can use the XML from ADO document wizard to create XML from relational database objects like tables and views. This document wizard allows you to access any relational database that supports OLE DB, such as SQL Server.

After you specify the OLE DB provider and database server connection information on the Microsoft Data Link Properties dialog box, Stylus Studio displays the Import from External Source dialog box, shown here:

![Import from External Source Dialog Box](image)

**Figure 119. Import from External Source Dialog Box**

You use this dialog box to specify either:

- The database object you want to convert to XML
- A SQL statement you want to execute against the database

When you click **OK**, Stylus Studio selects the database object (or executes the SQL statement) and returns it as an XML document in the XML Editor.
Updating XML Documents

Stylus Studio® 2006 User Guide

165

Updating XML Documents

The XML editor Grid tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

Stylus Studio provides Text, Tree, and Grid views for updating any XML document you open. The view you choose for editing depends on how structured your data is and your personal preferences. This section describes how to choose an XML document view to work with and other features related to editing XML.

This section discusses the following topics:

- “Choosing a View” on page 165
- “Saving Your Work” on page 166
- “Ensuring Well-Formedness” on page 166
- “Reverting to Saved Version” on page 166
- “Updating Java Server Pages as XML Documents” on page 166

Choosing a View

You can add and modify the data and structure of an XML document in any view. When you switch to a different view, any changes you made appear in the new view. To move from view to view, click the Text, Tree, or Grid tab at the bottom of the document you are working with.

To add contents to an empty XML document, consider the structure of the data you plan to add. The Grid view is most useful for creating very structured data that includes multiple instances of the same elements. The Tree view makes it easy to add many different elements. In order to use it, however, the XML must be well-formed.

Each view of the document allows you to query the contents of the document. See “Querying XML Documents Using XPath” on page 232.

Watch it! You can view a video demonstration of the Grid tab by clicking the television icon or by clicking this link: watch the XML Grid Editor video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.
For More Information

To learn more about a specific XML view, see one of the following sections:

- “Using the Text Editor” on page 167
- “Updating DOM Tree Structures” on page 179
- “Using the Grid Tab” on page 183

Saving Your Work

The procedure for saving your work is the same regardless of which view you use to edit XML – make sure your work is in the active window, and then select **File > Save** from the Stylus Studio menu bar, or click **Save** in the Stylus Studio tool bar.

Ensuring Well-Formedness

If the document is well formed, Stylus Studio displays the tree representation. If the document is not well formed, Stylus Studio displays a message that indicates the reason the document is not well formed and the location of the error or omission. Correct the document, and click the **Tree** tab.

If you are already viewing the **Tree** representation of your document, the document is well formed. When you edit the **Tree** view, the XML that Stylus Studio generates is always well formed.

Reverting to Saved Version

You might make some changes to an XML document and then decide that you do not want to save them. In the Stylus Studio tool bar, click **Reload**. Stylus Studio displays a message that warns you that you will lose any changes, and prompts you to confirm that you want to reload the version of the document that is in the file system. After you confirm, Stylus Studio displays the last saved version of the document.

Updating Java Server Pages as XML Documents

1. In the File Explorer, navigate to the JSP file you want to open.
2. Right click the file name, and select **Open With** from the shortcut menu.
3. Click **XML Editor**.
Using the Text Editor

You use the Text tab of the XML editor to edit XML text. The Text tab provides the usual tools you expect to find in a text editor. These tools are described in this section.

This section covers the following topics:

- Text Editing Features on page 167
- Use of Colors in the Text Tab on page 172
- Using the Spell Checker on page 173
- Moving Around in XML Documents on page 177

Text Editing Features

This section describes some of the more common text editing tools and features in Stylus Studio.
Simple Text Editing

Select the text you want to edit and then do any of the following:
- Click the right mouse button to display a pop-up menu of edit commands.
- Click the appropriate button in the Stylus Studio tool bar.
- Press the standard control keys to copy, cut, paste, undo, or redo.

You can select a portion of text and move it to a new location by dragging it. You can drag text from one document to another. You can drag text from documents outside Stylus Studio to a document in Stylus Studio.

Code Folding

*Code folding* is the ability to collapse three or more lines of code in XML-based editors. For example, this code segment:

```xml
<author>
  <first-name>Joe</first-name>
  <last-name>Bob</last-name>
  <award>Trenton Literary Review Honorable Mention</award>
</author>
```

when collapsed, appears as this:

```xml
<author>
  <award>Trenton Literary Review Honorable Mention</award>
</author>
```

Code folding allows you to simplify the visual presentation of XML-based code; folding does not affect the underlying code.

In editors in which code folding is supported, Stylus Studio displays a tree control in the gutter to the left of editing canvas; this is the same area of the editor used to display line numbers, debugging symbols, and back mapping symbols. By default, all code is displayed.

What You Can Fold

In XML-based editors, you can fold
- Internal DTD
- Comments
- CDATA
- XML elements
In the XQuery Source editor, you can fold
  - Comments
  - Expressions delimited by curly braces ( { and } )
  - XML elements

**How to Fold Code**

*To fold a segment of code, click the [+] symbol associated with that code.*

*To unfold a segment of code, click the [-] symbol associated with that code.*

When you fold code, Stylus Studio displays a boxed ellipsis symbol at the end of the line of code you have folded, as shown here:

![Figure 121. Example of Folded Code](image)

**Tip** You can unfold a folded segment by double-clicking the tool tip.

**Sense:X**

As you type, Sense:X prompts you with the possible tags that you can insert at a given location based on the XML Schema associated with the document you are editing. As soon as you type a tag’s open bracket, Stylus Studio displays a scrollable list of the elements that are allowed at that location of the document. Double-click the tag you want. For example, suppose you have an XML Schema where the book element can contain author or title elements. If you add a book element, the Sense:X list displays only the author and title tags.
Editing and Querying XML

Indent

Indent XML tags to show the hierarchy relationships. Click **Indent XML Tags**. Stylus Studio indents all text in the active XML document window.

**Note**

After you click the **Indent XML Tags** button, you cannot automatically undo or redo any changes you have been making. After you make more changes, you can press Ctrl+Z and Ctrl+Y to automatically undo and redo those changes until you click **Indent XML Tags** again.

Line Wrap

Stylus Studio automatically wraps lines whose length exceeds 16k characters. You can also turn on line wrap manually, by selecting **Edit > Wrap Lines** from the Stylus Studio menu or by clicking the wrap lines button on the tool bar.

When line wrapping is on, Stylus Studio wraps lines to fit in the available window; the place at which the line wraps moves as the width of the window changes. Green arrows, as shown in **Figure 122**, indentify lines that have wrapped.

![Figure 122. Green Arrows Identify Lines That Have Wrapped](image)

In what many are calling the UNIX masterpiece of the decade, Evans, Matthew, and Stones have come up with a book that is as lyrical as it is technically astute and thorough.
Spell Checking

By default, Stylus Studio spell checks text as you type using an internal spell checker. Words the spell checker believes are misspelled (or repeated) are underlined with a squiggly line, as shown in Figure 123.

For more information, see Using the Spell Checker on page 173.

Font

You can change the font of the text display in Stylus Studio. This change affects only the Stylus Studio display. Beyond personal preference, you might choose to change the font for localization purposes – the available fonts are the fonts that can display the characters in your XML file. For example, in a Japanese file, only two or three font names appear. Click Font Change to display a list of fonts.

Comments

Select the text that you want to be a comment. In the Stylus Studio tool bar, click Comment/Uncomment Selection. To remove comment tags, select the commented text, and click Comment/Uncomment Selection.

Tip  To select an entire line, click the gray area to the left of the line you want to select.

Bookmarks

You can set bookmarks in the XML display. Bookmarks allow you to jump to important lines in your file. See “Using Bookmarks” on page 490.

Search

Search for and replace text you specify. Click Find or Replace in the tool bar. You can also enable Find by pressing Ctrl + F.
When you enable Find, Stylus Studio displays the word in which the cursor is located – whether the cursor is within the word or immediately adjacent to it – in the Find what field of the Find dialog box. Similarly, any text you have selected – whole, partial, or multiple words – is displayed in the Find what field.

**Tip** You can scroll through a list of the other words you have searched for by pressing the down arrow when the Find what field is active.

### Use of Colors in the Text Tab

Stylus Studio text editors use colors to distinguish the types of data in XML documents. The default colors for the XML Editor are described in the Table 13.

**Table 13. Text Colors in Stylus Studio**

<table>
<thead>
<tr>
<th>Color</th>
<th>Type of Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Royal blue</td>
<td>Markup</td>
</tr>
<tr>
<td>Black</td>
<td>XML declaration and text node contents</td>
</tr>
<tr>
<td>Pale blue</td>
<td>Schema definition</td>
</tr>
<tr>
<td>Purple</td>
<td>Element names defined in the DTD</td>
</tr>
<tr>
<td>Red</td>
<td>Attribute names</td>
</tr>
<tr>
<td>Dark blue</td>
<td>Attribute values</td>
</tr>
<tr>
<td>Orange</td>
<td>Element names not defined in the DTD</td>
</tr>
</tbody>
</table>

### How to Change Text Colors

You can set colors differently for the text editors associated with different document types (XML, XQuery, XSLT, and so on).

1. Select **Tools > Options** to display the Options dialog box.
2. Click **Editor Format**.
3. Select the editor type from the Editor drop-down list.
4. Set the font, size, and color for different document elements as appropriate.
5. Click **OK** to close the Options dialog box.
Using the Spell Checker

You can use the Stylus Studio Spell Checker with all of Stylus Studio’s text-based editors (like editors for XQuery and XSLT, for example) to both actively and passively check your documents for typographical errors such as misspellings and repeated words.

![Figure 124. Stylus Studio’s Spell Checker](image)

**Default Spell Checking**

The Spell Checker is on by default for most editors. This means that when you open a document in a Stylus Studio text editor, and as you type in that document, Stylus Studio checks the document for typographical errors. Words that the Spell Checker identifies as possibly containing a typographical error are underlined with a red “squiggle”, like the word Worx shown in Figure 123.

**Tip** You can right-click a word with a squiggle and select Spell Checker Suggestions for to display a list of suggestions for the word identified by the Spell Checker.

**Manual Spell Checking**

At any time, you can manually spell check a document by selecting Tools > Check Spelling from the Stylus Studio menu. When you do this, Stylus Studio starts the Spell Checker, which reads through the current document. When it finds a possible typographical error, Stylus Studio displays the Spelling dialog box, as shown in Figure 124.

Using the Spelling dialog box, you can...
Editing and Querying XML

- Ignore the current occurrence of the word the Spell Checker has selected
- Ignore all occurrences of the word
- Replace the current occurrence of the word
- Replace all occurrences of the word
- Add new words to the dictionary
- Edit existing dictionary content

Specifying Spell Checker Settings

You specify Spell Checker settings using the Spell Checking page of the Options dialog box.

Figure 125. Options for the Spell Checker

Spell Checker settings include

- Words to skip based on certain characteristics – you might decide to skip e-mail addresses and URLs, for example. Skipped words are not considered by the Spell Checker.

- Characteristics in words that you wish to ignore – you might not care about case or accents marks for spelling purposes. In this case, two words that share the same spelling, except for the characteristic you specify, are considered to be equivalent (mème and meme (accent), or BMW and bmw (case), for example).
● The type of dictionary you want the Spell Checker to use when providing alternatives to the typographical errors it locates. Settings range from **Abridged** to **Unabridged** and show the fewest to the most alternatives, respectively. The **Abridged** setting results in fewer alternative suggestions for misspelled words than **Standard** (the default) or **Unabridged**, for example, but it requires less time to spell check a given document.

● The layout of the keyboard you are using. The Spell Checker uses this information to offer meaningful suggestions to words you might have mistyped.

### How to Spell Check a Document

1. Select **Tools > Check Spelling** from the menu.

   Stylus Studio starts checking the document for typographical errors. If it finds a typographical error, it displays the **Spelling** dialog box.

2. Once you select an action, the Spell Checker continues checking the document. When you have addressed all identified errors in the document (either by replacing, correcting, or ignoring them), the Spell Checker stops.

<table>
<thead>
<tr>
<th><strong>If You Want To</strong></th>
<th><strong>Then</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace the misspelled word with the word suggested by the Spell Checker</td>
<td>Click <strong>Replace</strong>. Click <strong>Replace All</strong> to replace all occurrences of that word. You can also replace the misspelled word with another word selected from the <strong>Alternatives</strong> list box, or with a word you type in the <strong>Replace with</strong> field.</td>
</tr>
<tr>
<td>Ignore the misspelled word</td>
<td>Click <strong>Ignore</strong>. Click <strong>Ignore All</strong> to ignore all occurrences of that word.</td>
</tr>
<tr>
<td>Add the misspelled word to the personal dictionary</td>
<td>Click <strong>Add</strong>.</td>
</tr>
<tr>
<td>Edit the personal dictionary</td>
<td>Click <strong>Edit</strong>. See <strong>Using the Personal Dictionary</strong> on page 176 for more information.</td>
</tr>
</tbody>
</table>
Using the Personal Dictionary

The Stylus Studio Spell Checker comes with its own dictionary. You can create a personal dictionary and fill it with your own entries. Personal dictionaries are used in conjunction with the Spell Checker dictionary across all Stylus Studio editors.

To add entries to the personal dictionary, you can
● Type entries individually
● Import lists formatted as .txt files
● Automatically add entries while you check the document

The personal dictionary is stored in the c:\Documents and Settings\username\Application Data\Stylus Studio directory.

Warning: Do not modify the files in this directory by hand. Use the Personal Dictionary Editor dialog box to make any changes to the personal dictionary.

1. Start the Spell Checker and display the Personal Dictionary Editor dialog box (click Edit on the Spelling dialog box).

2. Enter a word in the New Word field.

3. Click the Add button.
   The word appears in the Words in Personal Dictionary list box.

4. Click the Close button.

Tip: You can also add any word identified as a misspelling to the personal dictionary by pressing the Add button on the Spelling dialog box.

Note: Lists you import into the personal dictionary must be unformatted .txt files, with each entry on its own line. Do not use tab- or comma-separated files.

1. Start the Spell Checker and display the Personal Dictionary Editor dialog box (click Edit on the Spelling dialog box).

2. Click the Import button.
   The Open dialog box appears.

3. Select the .txt file you want to import into the personal dictionary and click Open.
   The words in the list you import appear in the Words in Personal Dictionary list box.

4. Click the Close button.
Using the Text Editor

1. Start the Spell Checker and display the Personal Dictionary Editor dialog box (click Edit on the Spelling dialog box).

2. Click the Export button.
   The Save As dialog box appears.

3. Navigate to the directory in which you want to save the copy of the personal dictionary.

4. Enter a name in the File name field.

5. Click Save.
   The contents of the personal dictionary is saved to the text file.

6. Click the Close button.

Moving Around in XML Documents

Stylus Studio provides several tools for easily moving around in an XML document.

Line Numbers

To go to a particular line, click Go to a specified location in the Stylus Studio tool bar. Stylus Studio displays the Go To dialog box. Type the number of the line you want to go to and click OK. The cursor moves to the line you specified.

Stylus Studio displays line numbers and column numbers in the lower right corner of the Stylus Studio window. If you want, you can set a Stylus Studio option that displays line numbers to the left of each line in the editor you are using.

To do this, from the Stylus Studio menu bar, select Tools > Options. In the Options page that appears, click Editor General. In the Editor field, select the editor in which you want to display line numbers. Select the Show Line Numbers check box.

Bookmarks

To quickly focus on a particular line, insert a bookmark for that line. You can insert any number of bookmarks. You can insert bookmarks in any document that you can open in Stylus Studio.

To insert a bookmark, click in the line that you want to have a bookmark. Then click Toggle Bookmark in the Stylus Studio tool bar. Stylus Studio inserts a turquoise box with rounded corners to the left of the line that has the bookmark. To move from
Editing and Querying XML

bookmark to bookmark, click Next Bookmark or Previous Bookmark. See “Using Bookmarks” on page 490.

Tags

To move to the closing tag for an element, click in the tag name for the element. In the Stylus Studio tool bar, click Go to Matching Tag. Stylus Studio moves the cursor to the closing tag for the element you clicked.

Find

In any view of an XML document, and in the XSLT Source view of a stylesheet, you can click Find in the Stylus Studio tool bar. In the Find dialog box that appears, specify the string you want to search for and click Find Next. Stylus Studio highlights the first occurrence of the string you entered. In the Text view, you can specify that you want Stylus Studio to highlight all instances.

Depending on which view you are examining, Stylus Studio allows you to specify constraints on the search. The constraints you can specify include the following:

- Match whole word only
- Match case
- Find a regular expression
- Search inside only element tags, only element values, only attribute names, and/or only attribute values

To learn more about regular expression syntax, visit http://www.boost.org/libs/regex/doc/syntax.html.
Updating DOM Tree Structures

To update the DOM tree for an XML document, click the Tree tab at the bottom of the window that contains the document.

Figure 126. Tree Tab in XML Editor

While you are editing, if the display does not appear to correctly represent the current tree, click Reload Document in the main tool bar. If you want to perform a certain action and Stylus Studio has grayed out the button for that action, try clicking Refresh first.

To save your file, select File > Save from the Stylus Studio menu bar or click Save in the Stylus Studio tool bar.

This section discusses the following topics:

- “Displaying All Nodes in the Tree View” on page 180
- “Adding a Node in the Tree View” on page 180
- “Deleting a Node in the Tree View” on page 180
- “Moving a Node in the Tree View” on page 181
- “Changing the Name or Value of a Node in the Tree View” on page 181
Displaying All Nodes in the Tree View

To expand a tree so that you can see all the nodes in the tree, click the root node and then press the asterisk (*) key in the numeric key pad. To expand any particular node, click that node and press * in the numeric key pad.

The default tree view of your document does not include nodes that contain only blank spaces, line feeds, or tabs. To toggle between the default view and a view that does display all nodes, click White Space in the Stylus Studio tool bar. This view is most helpful when you are operating on the DOM and need to know the exact structure of the tree.

Adding a Node in the Tree View

Along the left side of the window that contains your DOM tree, there are buttons that represent the types of nodes you can add to your document. The procedure for adding a node is similar for all types of nodes.

1. Click the element that you want to be the parent of the new element, or click an element that you want to be a sibling of the new element.

2. To add a child element, click New Element. To add a sibling element, hold down the Shift key and click New Element.
   
   Alternative: To add a child element, press Ctrl+E. To add a sibling element, press Ctrl+Shift+E.

   If your XML document specifies a DTD, Stylus Studio displays a list of the elements that you can add at that location. If your document is associated with an XML Schema or does not specify a DTD, Stylus Studio prompts you to specify the name of the new element.

3. Double-click the element you want to add, or type the name of the new element and press Enter. If you added a child node, Stylus Studio adds it as the last child.

4. If the new element contains data, type a value for the new element and press Enter.

Deleting a Node in the Tree View

Along the left side of the window that contains your DOM tree, there are buttons that represent the types of nodes you can add to your document. The procedure for deleting a node is similar for all types of nodes.
Updating DOM Tree Structures

1. Click the node you want to delete.
2. Click **Delete Node**.

Moving a Node in the Tree View

Along the left side of the window that contains your DOM tree, there are buttons that represent the types of nodes you can add to your document. The procedure for moving a node is similar for all types of nodes.

1. Click the node you want to move.
2. Click the up and down arrows at the top of the document window to move the node up or down the tree.

*Alternative:* Drag the node to its new location.

Changing the Name or Value of a Node in the Tree View

Along the left side of the window that contains your DOM tree, there are buttons that represent the types of nodes you can add to your document. The procedure for renaming a node is similar for all types of nodes.

1. Click the node you want to rename.
2. Click **Change Name**. If your document specifies a DTD, Stylus Studio displays a list of the possible names. If your document does not specify a DTD, Stylus Studio opens an edit field.
3. Double-click the new name, or type the new name and press Enter.

To change the value of a node:

1. Click the node whose value you want to change.
2. Click **Change Value**. Stylus Studio displays an update field.
3. Type the new value and press Enter.

Obtaining the XPath for a Node

1. In the XML editor, click the **Tree** tab.
2. Right-click the node for which you want the XPath expression.
3. In the shortcut menu that appears, click **Copy XPath Query to Clipboard**.
4. Press Ctrl+V to paste the XPath expression where you want it.
Using the Grid Tab

The XML Editor **Grid** tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

The **Grid** view of an XML document is useful for structured data – it is a convenient way to view and work with documents that contain multiple instances of the same type of element.

![Figure 127. Grid View of books.xml](image)

This section describes the features of the **Grid** tab and how to use it to edit XML documents. This section covers the following topics:

- “Layout of the Grid Tab” on page 184
- “Features of the Grid Tab” on page 184
- “Moving Around the Grid Tab” on page 188
- “Working with Rows” on page 190
- “Working with Columns” on page 192
Editing and Querying XML

- “Working with Tables” on page 194

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the XML Grid Editor video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

Layout of the Grid Tab

The Grid tab consists of a tool bar and a display area. The tool bar has buttons to perform actions and operations on both the grid itself and on the underlying XML document represented in the grid. An example of the former is the ability to show the child elements of the document’s root element; they are hidden by default. An example of the latter is the ability to add a new instance of an element or to change a value. These operations are also accessible from the XML > Grid Editing menu, as well as from the grid shortcut menu (right-click on the grid).

The tool bar also includes a query field, which allows you to enter an XPath expression to query the XML document. Results are displayed in the Query Output window, which appears when you run the query if it is not already displayed. See “Querying XML Documents Using XPath” on page 232 for more information on this feature.

The display area shows the XML document, both its structure and content, rendered in a tabular, or grid format.

Features of the Grid Tab

This section describes the features of the Grid tab. It covers the following topics:

- “Expanding and Collapsing Nodes” on page 185
- “Collapsing Empty Nodes” on page 185
- “Renaming Nodes” on page 187
- “Resizing Columns” on page 187
- “Showing Row Tag Names” on page 188
Expanding and Collapsing Nodes

When you first display a document in the Grid tab, the document is collapsed so that it shows just the root element (here it is `<books>`) and its name attribute (`My books`), as shown in Figure 128.

A plus sign displayed to the left of the node name indicates that this node has child nodes. You can click the plus sign to display a subgrid that displays the child nodes, as shown in Figure 129.

Collapsing Empty Nodes

Some nodes in a document are simply containers – they have no content of their own. An example of a container node is the `<authors>` element in `books.xml`. The `<authors>`
element is simply a container for one or more <author> elements, as shown in this excerpt of books.xml:

```xml
<authors>
    <author>David A. Chappel</author>
    <author>Tyler Jewell</author>
</authors>
```

To streamline the display, Stylus Studio hides the tables that represent container nodes. Information about container nodes is displayed in the child node’s header. Figure 130 shows the default display for the author element. Notice that the header, book/authors/author, contains information about the container node, authors.

![Figure 130. Table Headers Show Full Path](image)

If you want, however, you can display the tables associated with container nodes, as shown in Figure 131.

![Figure 131. Container Nodes Are Hidden by Default](image)
Using the Grid Tab

The table associated with the authors node now appears in the grid; it is empty (it has no rows) because it is a container. The elements it contains are displayed in their own table, authors/author.

This action is also available from the XML > Grid Editing menu and from the grid shortcut menu.

Renaming Nodes

You can rename container nodes directly in the grid.

1. Double-click the header that represents the node you want to rename.
   The node name is selected.
2. Type the name you want to use for the node.
3. Press Enter (or click elsewhere in the grid or grid background).

Resizing Columns

When you expand a node, Stylus Studio displays it in uniform columns. You can resize columns to any width you prefer by dragging the handle on the right side of the column header, as shown in Figure 132.

Figure 132. Resize Columns by Dragging the Right Handle
Showing Row Tag Names

In the grid view of a structured XML document, each child element of a node corresponds to a row in a table. For example, the <books> node of books.xml contains nine child elements; each row is an instance of the <book> element. To preserve space in the grid, the tag names of child elements are not displayed as a separate column in the table. Rather, as shown in Figure 129, this information is displayed in the table header itself.

If you want, you can display the tag name for child elements in their own columns, as shown in Figure 133.

![Figure 133. Displaying the Root’s Child Element](image)

This action is also available from the XML > Grid Editing menu.

Moving Around the Grid Tab

You can move around the grid using the mouse (click where you want to go) and the keyboard. Keyboard navigation is presented in the following table.

Table 14. Keyboard Navigation in the Grid

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up/Down arrow keys</td>
<td>Moves the row highlight in the direction of the arrow key you press.</td>
</tr>
<tr>
<td>Left/Right arrow keys</td>
<td>Moves the focus from one cell to the next, in the direction of the arrow key you press.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Moves the row highlight to the root node’s attribute.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Moves the row highlight to the last row in the document.</td>
</tr>
</tbody>
</table>
Using the Grid Tab

Selecting Items in the Grid

When you select a cell in a table:

- The row is selected; you can perform row-oriented actions like changing the row’s order in the table. You can also select a row by clicking the plus sign to the left side of the row.
- The column is selected; you can perform column-oriented actions like adding a new column or renaming an existing one.
- The cell gets focus.

**Tip** Pressing Enter places a selected cell in Edit mode.

How Grid Changes Affect the XML Document

When you make a change to the document structure or content on the **Grid** tab, those changes are reflected immediately in the underlying XML document. You can see your changes affect the document on the **Text** tab.

Consider the following excerpt from `books.xml`.

```xml
<authors>
  <author>David A. Chappel</author>
  <author>Tyler Jewell</author>
</authors>
```

If you move the rows in the authors table, for example, as shown in **Figure 134**,
the underlying XML changes accordingly:

```xml
<authors>
  <author>Tyler Jewell</author>
  <author>David A. Chappel</author>
</authors>
```

### Types of Changes that Affect the Document

The following changes, all of which can be made using the Grid tab, affect the underlying XML document:

- Adding, deleting, reordering rows
- Adding, deleting, reordering, and renaming columns
- Adding, deleting, reordering, and sorting tables
- Changing element and attribute values
- Renaming container elements

Changes you make affect the current instance only. For example, in the example shown in Figure 134, only that instance of the nested table is affected. If you add a column to books/book, however, every instance of books/book gets that new column.

### Working with Rows

Stylus Studio provides several features to help you work with table rows in the Grid tab. Changes you make to tables in the Grid tab, such as adding a new row or modifying a value, are reflected in the underlying XML document.

This section covers the following topics:

- “Reordering Rows” on page 191
- “Adding and Deleting Rows” on page 191
Using the Grid Tab

Reordering Rows

You can move rows up and down within the same table. Changes you make to row order affect the element order in the underlying XML document.

1. Select the row you want to move.

2. Click the Move Up (↑) or Move Down (↓) button to move the row to the desired location in the table. These actions are also available from the XML > Grid Editing menu and from the grid shortcut menu.

Adding and Deleting Rows

You can add and delete rows in a table. Changes you make to the table in this way affect the number of instances of the element in the table. When you add a row, you can insert it in the table above or below the currently selected row.

Tip You can move rows up and down within a table.

1. Select the row next to which you want to insert a new row.

2. Click the Insert Row Before (↑) or Insert Row After (↓) button to add the new row to the table. These actions are also available from the XML > Grid Editing menu and from the grid shortcut menu.
   The row is added to the table.

1. Select the row you want to delete.

2. Click Delete (X). This action is also available from the XML > Grid Editing menu and from the grid shortcut menu.
   The row is deleted from the table.
Editing and Querying XML

Working with Columns

Stylus Studio provides several features to help you work with table columns in the Grid tab. Changes you make to tables in the Grid tab, such as adding a new column or reordering existing columns, are reflected in the underlying XML document.

This section covers the following topics:
- “Selecting a Column” on page 192
- “Adding Columns” on page 192
- “Deleting Columns” on page 193
- “Reordering Columns” on page 193
- “Renaming Columns” on page 193
- “Changing a Value” on page 194

Selecting a Column

Column operations can be performed when you select any cell in a column. When a cell (and, therefore, its column) is selected, it is highlighted with a yellow outline. As shown in Figure 135, the <title> column is selected – the cell containing Java Message Service is the one that is highlighted.

Adding Columns

You can add two types of columns to tables in the Grid tab – attribute columns and element columns. The procedure for adding both types of columns is the same. When you add a column, it is inserted immediately after the last column of its type. You can move columns after you create them.

1. Select the row in which you want to add a column.
2. Click Add Attribute Column or Add Element Column. These actions are also available from the XML > Grid Editing menu and from the grid shortcut menu. The column is added to the table.
3. If you want, move the column to a new location in the row. See “Reordering Columns” on page 193.

Deleting Columns

1. Select a cell in the column you want to delete.  
A yellow border appears around the cell you select.

2. Click Delete Column ( ). This action is also available from the XML > Grid Editing menu and from the grid shortcut menu.  
The column is deleted from the table.

Reordering Columns

You can reorder columns in the grid by dragging them to the position you desire.

1. Place the pointer on the left handle in the column header.

2. Press and hold mouse button one.
   The cursor changes shape, as shown here.

   ![Figure 136. Moving a Column](image)

   3. Drag the column to the location in the row you want.

   4. Release the mouse button.
      The column is placed in the new location within the row.

Renaming Columns

You can rename columns in the grid. This has the effect of renaming the corresponding attribute or element name in the underlying XML document.

**Note** You cannot rename the root element from the Grid tab.

1. Select a cell in the column you want to rename.  
A yellow border appears around the cell you select.
Editing and Querying XML

2. Click Rename Column ( ). This action is also available from the XML > Grid Editing menu and from the column shortcut menu.
   The column is renamed.

Changing a Value

You can change element and attribute values.

1. Double-click the cell whose value you want to change.
   The cell field becomes editable, as shown here.

![Figure 137. Changing a Value]  

2. Edit the value as required.

3. Press Enter.

Working with Tables

Stylus Studio provides several features to help you work with tables in the Grid tab. Changes you make to tables in the Grid tab, such as adding a nested table, are reflected in the underlying XML document.

This section covers the following topics:
- “Adding a Nested Table” on page 195
- “Moving a Nested Table” on page 196
- “Deleting a Table” on page 196
- “Sorting a Table” on page 196
- “Copying a Table as Tab-Delimited Text” on page 197
Adding a Nested Table

You add nested tables to a document in the Grid tab using the Add Nested Table dialog box, shown in Figure 138. This dialog box allows you to specify the path to the root for the new table, a row element name, and the number of rows.

![Add Nested Table Dialog Box](image)

Figure 138. Add Table Dialog Box

A nested table is created as a child of the current element. The nested table shown in Figure 139, myTable, was created as a child of the <book> element.

![Nested Table](image)

Figure 139. Default Nested Table

Nested tables are created with two default rows, which use the element name you provide in the Row Element Name field of the Add Nested Table dialog box. Rows get a default text value of Row n text, where n is an incrementing value starting with 1. You specify the number of rows using the Number of rows field.

1. Select the element to which you want to add a nested table.
2. Click **Add Nested Table** ( ). This action is also available from the **XML > Grid Editing** menu and from the grid shortcut menu.
   The **Add Nested Table** dialog box appears.

3. Optionally, specify the path to the root. If you leave this field blank, the nested table is created as a child of the current element.

4. Enter a row element name.

5. Optionally, change the number of default rows.

6. Click OK.
   The nested table is added to the document and appears in the grid.

**Moving a Nested Table**

You can change the order of nested tables within a row.

1. Select the heading of the nested table you want to move.

2. Click the **Move Up** ( ) or **Move Down** ( ) button to move the table to the desired location. These actions are also available from the **XML > Grid Editing** menu and from the grid shortcut menu.

**Deleting a Table**

1. Select the heading of the table you want to delete.

2. Click **Delete** ( ). This action is also available from the **XML > Grid Editing** menu and from the grid shortcut menu.
   The table is deleted from the document.

**Sorting a Table**

You can sort tables on any column in ascending or descending order.

1. Select a cell in the column on which you want to sort the table.

2. Click the **Sort Ascending** ( ) or **Sort Descending** ( ) button to sort the table rows in ascending or descending order, respectively. These actions are also available from the **XML > Grid Editing** menu and from the grid shortcut menu.

**Tip**

You can also display sort options by right-clicking the column heading.

The table rows are sorted based on the order you select.
Copying a Table as Tab-Delimited Text

You can copy a tab-delimited text version of a table to the clipboard. This makes it possible to paste document contents from the grid into spreadsheets and other editors that can manage tab-delimited files. Figure 140 shows books/book in books.xml pasted into Microsoft Excel, for example.

Note that when you use this feature, the entire table is copied – column headings (element and attribute names) are not distinguished from cell contents (element and attribute values) in the spreadsheet.

1. Select the heading of the table you want to copy.
2. Select XML > Grid Editing > Copy as Tab-Delimited from the menu. This action is also available from the grid shortcut menu.

Diffing Folders and XML Documents

XML differencing is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

During application development, it can be useful to be able to compare two or more XML documents, or to compare the contents of two folders, in order to identify the type and number of differences between them. The process of comparing one document (or folder)
Editing and Querying XML

with another is referred to as *diffing*. Stylus Studio provides utilities for diffing folders and documents.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the XML Diff video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

This section covers the following topics:

- “Overview” on page 199
- “Diffing Folders” on page 204
- “The XML Diff Viewer” on page 208
- “Differing a Pair of XML Documents” on page 216
- “Differing Multiple Documents” on page 217
- “Modifying Default Diff Settings” on page 222
- “Running the Diff Tool from the Command Line” on page 226
Overview

Stylus Studio’s Diff tool lets you easily compare two or more versions of the same document in the XML Diff Viewer (as shown in Figure 141), or the contents of two folders (as shown in Figure 145).

Customizable color-coding lets you quickly determine how one document differs from another – green, for example, identifies objects (such as elements and attributes) that are present in the target document, but which do not exist in the source document. When you hover the pointer over symbols displayed in the side bars of the source and target document windows, Stylus Studio displays a tool tip that indicates the specific nature of the change.

This section covers the following topics:

- “Sources and Targets” on page 200
- “The Diff Configuration File” on page 200
- “What Diffs Are Calculated?” on page 200
- “Tuning the Diffing Algorithm” on page 201
- “When Does the Diff Run?” on page 202
Sources and Targets

When you use Stylus Studio to diff documents (or folders), you select a source and a target. Stylus Studio considers the source document or folder to be the baseline, or current standard; the target document or folder is assumed to be some other version (it might be older or newer, for example) of the source. The Stylus Studio Diff tool illustrates how this other version, the target, differs from the source (or sources) you have selected.

Tip

You can open source and target documents in the XML Editor from the XML Diff Viewer – right click on the XML Diff Viewer background and select the document you want to edit from the short-cut menu of source and target documents displayed by Stylus Studio. This feature is context-sensitive – if you right-click on a node that has been removed, the target document will not be listed, for example.

The Diff Configuration File

You can save the information associated with a given XML diff session in a diff configuration file. Diff configuration files make it easy to perform a diff on the same set of XML documents over time. Examples of the information saved with the diff configuration file include the URLs of the source and target documents, and any settings made on the XML Diff menu or tool bar. Diff configuration files are created with a .dff extension.

Changes made to the source and target documents are detected by Stylus Studio the next time you open the diff configuration file, allowing you to diff the files at that time. (Whether or not the diff is run automatically when you open the diff configuration file depends on Autorun Diff settings on the Engine page of the Options dialog box. See “When Does the Diff Run?” on page 202 for more information.)

What Diffs Are Calculated?

This section describes how Stylus Studio diffs XML documents and folders.

Documents – The Stylus Studio Diff engine compares source and target documents in their entirety. If you want, you can use the Engine page of the Options dialog box to exclude certain items from the diff calculation. These items include:

- Comments
- Text

- “Running the Diff Manually” on page 203
- “Symbols and Background Colors” on page 203
Diffing Folders and XML Documents

- Entities
- Attributes
- Processing instructions

You can also specify whether or not you want Stylus Studio to:
- Use URIs to compare namespaces
- Expand entity references
- Ignore text formatting characters (new lines, carriage returns, and tabs)

See “Modifying Default Diff Settings” on page 222 to learn how to set these and other diff options.

Folders – Options for diffing XML documents do not affect how Stylus Studio diffs folders. When diffing folders, Stylus Studio compares one folder’s contents with another. See “Diffing Folders” on page 204 for more information on this topic.

Tuning the Diffing Algorithm

The purpose of any diffing tool is to identify the list of logical operations required to change the source document into the target document. Examples of logical operations include additions, revisions, and deletions. Even diffs between simple XML documents can yield a long list, sometimes with redundant operations. Ideally, the list of operations should be reduced to make it as economical as possible; that is, the list should be able to answer the question, *What are the fewest number of changes required to turn the source into the target?*

Calculating such a list can be time-consuming and resource intensive, and these costs might not be worth the benefits to a given user. For this reason, Stylus Studio provides settings that let you tune the diffing algorithm used by the XML Diff engine. Tuning settings are displayed in the Performance group box on the Engine page of the Options dialog box.

![Figure 142. Performance Settings Let You Tune the Diffing Algorithm](image)

Stylus Studio® 2006 User Guide
You can

- Select a tuning that optimizes the algorithm to provide the most economical set of changes possible (**Optimize change description**). As described earlier, this calculation, though it yields the best results, can be costly in terms of time and processing resources.
- Select a tuning that optimizes the algorithm to provide the set of changes in the shortest time possible (**Optimize calculation time**).
- Let Stylus Studio decide (**Autodetect**). By default, Stylus Studio tries to provide the most economical set of changes possible, but if it determines that processing resources are limited or that the calculation will take too much time, it reverts to the algorithm tuning that is optimized for speed.

### Handling Large Documents

The **Optimize for large documents with few changes** setting helps speed the differencing of large (greater than 1MB) documents. This setting can be used in conjunction with any of the algorithm tuning settings and is on by default.

### When Does the Diff Run?

Stylus Studio runs the differencing automatically, as soon as you specify the target document or folder. Whether or not subsequent changes cause Stylus Studio to automatically recalculate the diff is determined by the **Autorun Diff** settings on the **Engine** page of the **Options** dialog box. Changes that can make a diff recalculation necessary include adding new source and target documents, changing the underlying source and target documents themselves, or to changes to certain **Engine** settings.

### Options That Affect When the Diff Runs

These settings, on the **Engine** page of the **Options** dialog box, determine when and whether Stylus Studio automatically recalculates the diff.

- **On changes** – Certain types of changes to the diff configuration file require Stylus Studio to recalculate the diff. These changes include:
  - Adding a new source document
  - Changing the target document
  - Changing the **Use URI to compare namespaces** setting
  - Changing the **Expand entity references** setting
If the **On changes** setting is on, Stylus Studio automatically runs the diff when any of these changes occurs.

- **If files modified** – If you make and save changes to a source or target document, Stylus Studio automatically runs the diff if this setting is on.

**Note** These settings do not affect the differencing of folders.

See “Modifying Default Diff Settings” on page 222 to learn more about setting these and other Diff options.

**Running the Diff Manually**

You can run the diff manually by clicking the Calculate diff button ( ). Stylus Studio activates this button when it detects the need to recalculate the diff, and the **On changes** or **If files modified** settings are off. These settings, as described in “When Does the Diff Run?” on page 202, cause Stylus Studio to run the diff automatically.

You can also run the diff from the command line. See “Running the Diff Tool from the Command Line” on page 226.

**Symbols and Background Colors**

Stylus Studio uses symbols and background colors to alert you to differences in diffed documents and folders. The following table summarizes the symbols and default background colors, and the types of changes they represent.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Background Color</th>
<th>Identifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢</td>
<td>Light green</td>
<td>Added items; appears in the target document and identifies an item that is present in the target but absent from the source.</td>
</tr>
<tr>
<td>🔴</td>
<td>Light red</td>
<td>Removed items; appears in the source document and identifies an item that is present in the source but absent from the target.</td>
</tr>
<tr>
<td>🟧</td>
<td>Light yellow</td>
<td>Changed items; can appear in both source and target documents.</td>
</tr>
<tr>
<td>🟫</td>
<td>Light gray</td>
<td>Collapsed item containing changes (such as an added, changed, or removed node).</td>
</tr>
</tbody>
</table>
You can change the background colors on the Presentation page of the Options dialog box.

Combined Symbols
As described in Table 15, Default Colors Used for Diffing Files and Folders., Stylus Studio displays a turquoise block ( ) when a node that you have collapsed contains changes. Sometimes, the node itself has changes. In this case, Stylus Studio combines two symbols – one indicating the change of a child within the collapsed node, and one to the node itself. Consider the following illustration:

![Figure 143. Sample of a Collapsed Node with Changes](image)

Here, the city node displays a combined symbol – the turquoise box indicates that a change exists within the collapsed node; the minus sign indicates that the city node is not present in the source document. Expanding the city node makes the scope and nature of the changes explicit:

![Figure 144. Expanded Node with Changes](image)

Tip Hover the mouse point over these symbols to display tool tips that describe the nature of the change.

Additional Symbols for Diffing Multiple Sources
Stylus Studio uses other symbols in the target document window when you diff multiple source documents. See “Symbols Used in the Target Document Window” on page 218.

Diffing Folders
Stylus Studio allows you to diff two folders. As shown in Figure 145, the Diff Folders dialog box displays the contents of each folder; symbols and colors, described in
“Symbols and Background Colors” on page 203, identify the types of changes in the respective folders.

This section covers the following topics:

- “Features” on page 205
- “How to Diff Folders” on page 206
- “How to Diff Documents from the Diff Folders Dialog Box” on page 208

**Features**

The **Diff Folders** dialog box has several features that make it easy to diff folders and the XML documents they contain:

- **Splitter** lets you change the width of the source and target folder windows. This can be especially useful if you are working with a folder that has nested directories.
- **File type filter** limits the display to files with a .xml extension; if you choose, you can display (and diff) all file types, as shown in Figure 145.
- **Abort** button, shown here, appears at the bottom of the **Diff Folders** dialog box if the operation you are performing (loading or diffing a directory with a large number
of files, for example) is taking more time than usual. Clicking the **Abort** button cancels the operation.

![Abort Button](image)

**Figure 146. Abort Button Lets You Cancel Long Load Operations**

**Tip**

This feature is also part of the XML Diff Viewer.

- The **Diff Files** button allows you to perform a diff of XML documents in the source and target folders. See “How to Diff Documents from the Diff Folders Dialog Box” on page 208 for more information on this topic.

### How to Diff Folders

1. Select **Tools > Show Differences In > Folders** from the Stylus Studio menu. The **Diff Folders** dialog box appears.
2. Click the **Choose Source Folder** button ( ).
   The **Select Source Folder** dialog box appears.

3. Expand the **Desktop** tree and navigate to the folder you want to use as the source folder for the diff.

4. Click **Open**.
   The folder is displayed in the **Source folder** window of the **Diff Folders** dialog box.

5. Repeat **Step 2** through **Step 4** for the target folder.
   Stylus Studio performs the diff as soon as you select the target folder for comparison.

6. Optionally, use the **Show files of type** drop-down list to filter the display to show only those files of the type you specify. (By default, Stylus Studio shows XML files – files with a `.xml` extension.)
How to Diff Documents from the Diff Folders Dialog Box

You can diff XML documents in the source and target folders directly from the Diff Folders dialog box.

1. Click the file you want to diff.
   The document is shown as selected in both the Source folder and Target folder windows. In this illustration, the document authors_new.xml was selected.

2. Click the Diff Files button.
   Stylus Studio displays the XML Diff Viewer window.

   Tip Notice that, even though the file names are different, Stylus Studio is able to infer that authors_new.xml and authors_mods.xml are actually the same document.

   If you select a document that cannot be diffed, you will not see the selection in the opposite window.

For more information on diffing documents, see “Diffing a Pair of XML Documents” on page 216.

The XML Diff Viewer

This section describes the XML Diff Viewer and its features, including the different views available for comparing documents, the XML Diff Viewer tool bar, and tools for loading documents.

This section covers the following topics:
● “Split View - Tree” on page 209
● “Split View - Text” on page 210
● “Merged View” on page 211
● “View Symbols and Colors” on page 212
● “The XML Diff Viewer Tool Bar” on page 212
Split View - Tree

You use the XML Diff Viewer to compare two or more XML documents. By default, the XML Diff Viewer displays the diffed documents on the **Split View - Tree** tab. This view, shown in Figure 147, shows the documents side-by-side using a tree/node representation.

![Figure 147. XML Diff Viewer – Split View - Tree](image)

In split views (there is also a split view that shows documents in XML), source documents are displayed on the left, the target document on the right. A *splitter* between the two panes allows you to change the width of the source and target document panes by dragging the splitter to the left and right.
Split View - Text

The Split View - Text tab also shows source and target documents side-by-side in plain XML.

![Figure 148. XML Diff Viewer – Split View - Text](image)
Merged View

If you prefer, you can select the **Merged View** tab, which folds the nodes from the source and target documents into a single window, as shown in Figure 149.

![Figure 149. XML Diff Viewer – Merged View](image)

The merged view displays changed items in pairs – the item from the target document appears first, the item from the source document is shown second, as shown in Figure 150.

![Figure 150. Close-up of Merged View](image)

In this example, the line through the `<au_lname>` element in the source document, *Hennings*, indicates that it has changed to *White* in the target document.
View Symbols and Colors

All views use the same symbols and color schemes to identify the types of changes detected by the Stylus Studio diff calculation – by default, green for added items, yellow for changed items, and red for removed items. In addition, the text font and size are controlled by the settings for the XML Editor on the Editor Format page of the Options dialog box.

See “Symbols and Background Colors” on page 203 for more information on this topic, and to learn how you can assign custom colors to the results of standard differencing operations.

The XML Diff Viewer Tool Bar

The XML Diff Viewer tool bar, shown in Figure 151, provides tools to help you

- Manually start the diff calculation
- Navigate source and target documents
- Change default display and diff settings
- Show or ignore differences in document items such as text nodes and attributes

![Figure 151. The XML Diff Tool Bar](image)

The following table identifies the individual tools and tells you where to find more information.

Table 16. XML Diff Tool Bar Buttons

<table>
<thead>
<tr>
<th>Tool Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Calculates the differences in the documents you have selected. This button is active only when Stylus Studio detects the need to calculate differences. This button is disabled if you have selected On changes and If files modified settings. See “Engine Settings” on page 224.</td>
</tr>
<tr>
<td><img src="image" alt="Skip Next" /> <img src="image" alt="Skip Previous" /></td>
<td>Skips to the next (previous) diff in the currently selected document. You must select a line in the document to enable these buttons.</td>
</tr>
</tbody>
</table>
By default, Stylus Studio displays collapsed documents when the diff is run. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224.

By default, Stylus Studio collapses any unchanged blocks to simplify the display. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that changing this setting requires documents to be diffed again.

By default, Stylus Studio uses URIs to compare namespaces when diffing documents. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224.

By default, Stylus Studio expands entity references when diffing documents. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that changing this setting requires documents to be diffed again.

By default, Stylus Studio considers text formatting characters (new lines, carriage returns, tabs) when diffing documents. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224.

By default Stylus Studio shows differences in comments. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of comment differences.

By default Stylus Studio shows differences in text blocks. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of text block differences.

### Table 16. XML Diff Tool Bar Buttons

<table>
<thead>
<tr>
<th>Tool Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default, Stylus Studio displays collapsed documents when the diff is run. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224.</td>
</tr>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default, Stylus Studio collapses any unchanged blocks to simplify the display. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that changing this setting requires documents to be diffed again.</td>
</tr>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default, Stylus Studio uses URIs to compare namespaces when diffing documents. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that changing this setting requires documents to be diffed again.</td>
</tr>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default, Stylus Studio expands entity references when diffing documents. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that changing this setting requires documents to be diffed again.</td>
</tr>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default, Stylus Studio considers text formatting characters (new lines, carriage returns, tabs) when diffing documents. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224.</td>
</tr>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default Stylus Studio shows differences in comments. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of comment differences.</td>
</tr>
<tr>
<td><img src="image" alt="Tool Button" /></td>
<td>By default Stylus Studio shows differences in text blocks. You can override this setting using the tool bar button, or you can change it permanently on the Options page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of text block differences.</td>
</tr>
</tbody>
</table>
By default Stylus Studio shows differences in attributes. You can override this setting using the tool bar button, or you can change it permanently on the **Options** page. See “Engine Settings” on page 224.

Note that this feature affects only the display, and not the calculation, of attribute differences.

By default Stylus Studio shows differences in processing instructions. You can override this setting using the tool bar button, or you can change it permanently on the **Options** page. See “Engine Settings” on page 224.

Note that this feature affects only the display, and not the calculation, of processing instruction differences.

By default Stylus Studio shows differences in entities. You can override this setting using the tool bar button, or you can change it permanently on the **Options** page. See “Engine Settings” on page 224.

Note that this feature affects only the display, and not the calculation, of entity differences.

By default Stylus Studio shows differences in entity references. You can override this setting using the tool bar button, or you can change it permanently on the **Options** page. See “Engine Settings” on page 224.

Note that this feature affects only the display, and not the calculation, of entity differences.

Allows you to change the font of documents displayed in the XML Diff Viewer.

### Table 16. XML Diff Tool Bar Buttons

<table>
<thead>
<tr>
<th>Tool Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Attribute Difference" /></td>
<td>By default Stylus Studio shows differences in attributes. You can override this setting using the tool bar button, or you can change it permanently on the <strong>Options</strong> page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of attribute differences.</td>
</tr>
<tr>
<td><img src="image" alt="Processing Instruction Difference" /></td>
<td>By default Stylus Studio shows differences in processing instructions. You can override this setting using the tool bar button, or you can change it permanently on the <strong>Options</strong> page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of processing instruction differences.</td>
</tr>
<tr>
<td><img src="image" alt="Entity Difference" /></td>
<td>By default Stylus Studio shows differences in entities. You can override this setting using the tool bar button, or you can change it permanently on the <strong>Options</strong> page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of entity differences.</td>
</tr>
<tr>
<td><img src="image" alt="Entity Reference Difference" /></td>
<td>By default Stylus Studio shows differences in entity references. You can override this setting using the tool bar button, or you can change it permanently on the <strong>Options</strong> page. See “Engine Settings” on page 224. Note that this feature affects only the display, and not the calculation, of entity differences.</td>
</tr>
<tr>
<td><img src="image" alt="Font Change" /></td>
<td>Allows you to change the font of documents displayed in the XML Diff Viewer.</td>
</tr>
</tbody>
</table>
Tools for Working with Documents

The XML Diff Viewer provides several tools for working with source and target documents:

- Add/Remove document buttons:
  - Add document (source)
  - Set document (target)
  - Remove document (source)
  - Drop-down list

![Figure 152. Buttons for Adding and Removing Documents](image)

When you click the add or set document button, Stylus Studio displays the **Open** dialog box. The add button for source documents displays a green plus sign on it ( ) to alert you to the fact that you can add multiple source documents when diffing XML documents. You can specify only a single target document, however.

You use the remove button, the folder with the red minus sign on it ( ), to remove the current source document from the XML diff calculation.

**Tip** If Stylus Studio determines that the load or diff operation for a given XML document will take more than a moment, it displays a message and an **Abort** button at the bottom of the XML Diff Viewer window. You can click the **Abort** button to terminate the operation at any time. The message and the button are removed from the XML Diff Viewer window once the operation is complete or cancelled.

- Drop-down list. You use the drop-down list to change the current document in the XML Diff Viewer. When you change the current doc in a multi-document diff, the target document display – specifically, the symbols and colors used to identify documents – typically changes, as well. See “Symbols Used in the Target Document Window” on page 218 for more information.
Removing a Target Document

You cannot remove a target document. You can specify a different target document by clicking the set target button ( ) again. This replaces the current target document with the document you select.

Diffing a Pair of XML Documents

This section describes how to use Stylus Studio to diff a pair of XML documents.

Before continuing with this section, you should read “Overview” on page 199, which describes basic information about the Stylus Studio Diff tool, and “The XML Diff Viewer” on page 208, which describes features of the XML Diff Viewer and how to use them.

How to Diff a Pair of Documents

1. Select Tools > Options > Show Differences > Files from the Stylus Studio menu.

   Stylus Studio displays the XML Diff Viewer.

2. In the source document window, click the add button ( ) to add the source document.

   Stylus Studio displays the Open dialog box.

   Tip  You can drag and drop a file into the entry field to load the document in the XML Diff Viewer.

3. Navigate to the document you want to load in the XML Diff Viewer.

4. Click Open.

5. Repeat Step 2 through Step 4 for the target document, using the set button for the target document window ( )

   By default, Stylus Studio runs the diff calculation automatically when you select the target document. If the default On changes setting has changed, you need to run the diff calculation manually by clicking the Calculate diff button ( ).
Differing Folders and XML Documents

Differing Multiple Documents

This section describes how to use Stylus Studio to differ multiple XML documents.

Before continuing with this section, you should read “Overview” on page 199, which describes basic information about the Stylus Studio Diff tool, and “The XML Diff Viewer” on page 208, which describes features of the XML Diff Viewer and how to use them.

This section covers the following topics:

- “Document Focus” on page 217
- “Symbols Used in the Target Document Window” on page 218

Document Focus

Differing multiple XML documents is much the same as differ ing a pair of documents – you specify the source documents (one at a time), a target document, and Stylus Studio calculates the diff.

Note

When you differ multiple source documents against the target, Stylus Studio considers the target document to be the baseline, and the XML Diff Viewer shows how the source documents vary from the target.
When you diff multiple documents, however, only one source document can have focus at a time. Consider the following illustration, which shows three source documents (source1.xml, source2.xml, and source3.xml) and a target document (target.xml).

![Figure 153. Example of Document Focus](image)

In this example, the source1.xml document currently has focus. You set the focus on a given source document by selecting that document from the drop-down list at the top of the source document window.

When a source document has focus:

- Diffs are displayed for that document only, even if you have selected the Merged View tab for display.
- Clicking the remove document button ( ) removes that document from the XML diff calculation.

**Symbols Used in the Target Document Window**

When diffing multiple documents, Stylus Studio uses an additional set of symbols in the target document window. These symbols, which are displayed in the side bar of the XML Diff Viewer window alongside the standard set of symbols described in “Symbols and Background Colors” on page 203, indicate the ways in which the change identified in the
current source document differs from changes to the same node in other source documents.

![Figure 154. Example of Symbols Used When Diffing Multiple Documents](image)

As shown in Figure 154, symbols in the column closest to the document tree identify the changes relative to the currently selected source. Here, the edit symbol ( ) indicates that the value in the target document, White, differs from that in the currently selected source (which happens to be Black in this example).

The first column of symbols characterize changes in the currently selected source relative to other source documents. Here, for example, the red exclamation point ( ) indicates that there are conflicting modifications in other source documents – that is, other source documents contain a value other than Black. As shown in Figure 155, when you click on a symbol in the first column, Stylus Studio displays

- A message describing the precise nature of the change
- A menu that identifies the documents in which the change occurs.

![Figure 155. Easily Navigate to Changed Nodes in Other Source Documents](image)

Clicking on a document in this menu changes the current focus to that source document, allowing you to easily navigate to the same node in a different document.
The additional symbols used by Stylus Studio when diffing multiple documents are described in Table 17.

### Table 17. Symbols Used to Specify Changes in Source Documents

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Yellow circle" /></td>
<td>Yellow circle</td>
<td>Modified in other documents – The object in the target and the current source document are the same, but another source document is different.</td>
</tr>
<tr>
<td><img src="image" alt="Red exclamation point" /></td>
<td>Red exclamation point</td>
<td>Conflicting modification in other documents – The object in the current source differs from that in the target document. Other source documents differ from both the current source and target.</td>
</tr>
<tr>
<td><img src="image" alt="Yellow diamond" /></td>
<td>Yellow diamond</td>
<td>Same modification in other documents – The source documents all differ from the target document in the same way.</td>
</tr>
<tr>
<td><img src="image" alt="Yellow equal sign" /></td>
<td>Yellow equal sign</td>
<td>Unchanged in other documents – The current source document differs from the target, but other source documents are the same as the target.</td>
</tr>
</tbody>
</table>

Consider the example in Figure 156, which illustrates diffing three documents. In this example, the node in question is circled in red.

![Figure 156. Diffing Three Documents](image)
Diffing Folders and XML Documents

Notice that:
\- source1.xml currently has focus.
\- source1.xml and the target document node have the same value (<abc>)
\- The node in question varies in both of the remaining source documents (it is <abc> in one and <abc> in the other).

Table 18 shows the symbols that might appear based on changing values to the node in question. The example illustrated in Figure 156 is shown in the first row. As values in the source documents change, Stylus Studio changes the diff symbol accordingly.

**Table 18. Symbols Used to Specify Changes in Source Documents**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>target.xml</th>
<th>source1.xml</th>
<th>source2.xml</th>
<th>source3.xml</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>&lt;abc&gt;</td>
<td>&lt;abc&gt;</td>
<td>&lt;xyz&gt;</td>
<td>&lt;123&gt;</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>&lt;abc&gt;</td>
<td>&lt;xyz&gt;</td>
<td>&lt;jkl&gt;</td>
<td>&lt;mno&gt;</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>&lt;abc&gt;</td>
<td>&lt;xyz&gt;</td>
<td>&lt;xyz&gt;</td>
<td>&lt;xyz&gt;</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>&lt;abc&gt;</td>
<td>&lt;xyz&gt;</td>
<td>&lt;abc&gt;</td>
<td>&lt;abc&gt;</td>
</tr>
</tbody>
</table>

**Note** Changing the target-source pairing, that is, changing the current source document, affects the symbols that are displayed.

**How to Diff Multiple Documents**

1. Select **Tools > Options > Show Differences > Files** from the Stylus Studio menu. Stylus Studio displays the XML Diff Viewer.
2. In the source document window, click the add button ( ![Add Document] ) to add the first source document. Stylus Studio displays the **Open** dialog box.

**Tip** You can drag and drop a file into the entry field to load the document in the XML Diff Viewer.
3. Navigate to the document you want to load in the XML Diff Viewer.
4. Click **Open**.
5. Repeat Step 2 through Step 4 for additional source documents.
6. Repeat Step 2 through Step 4 for the target document, using the set button for the target document window ( ).

By default, Stylus Studio runs the diff calculation automatically when you select the target document. If the default On changes setting has changed, you need to run the diff calculation manually by clicking the Calculate diff button ( ).

Modifying Default Diff Settings

Default settings for the behavior of the Diff engine and the appearance of diffed documents and folders are on the Engine and Presentation pages, respectively, of the Options dialog box. The Engine page, shown here, has settings that determine the conditions under which Stylus Studio runs the diff automatically, which items in a document (comments and text, for example) you want the diff engine to ignore, and settings that allow you to choose differencing algorithm tunings optimized for change description or time, for example.

Figure 157. Engine Options Page for XML Diff
Settings on the **Engine** page are reflected in the Diff editor tool bar, and in the **XML Diff** menu, shown here.

![XML Diff Menu](image)

**Figure 158. XML Diff Menu**

**Tip** You can override **Engine** page settings using the Diff editor tool bar or the **XML Diff** menu. Overrides do not change the settings on the **Engine** page.

This section covers the following topics:
- “Opening the Options Dialog Box” on page 223
- “Engine Settings” on page 224
- “Presentation Options” on page 226

**Opening the Options Dialog Box**

1. Click **Tools > Options** on the Stylus Studio menu.
   The **Options** dialog box appears.
2. If necessary, expand the tree for **Module Settings > XML Diff**.
3. Click the page that contains the settings you want to modify.
4. To save a changed setting, click **OK**. Click **Cancel** to revert to close the dialog box and revert to the previous settings.

**Engine Settings**

This section describes the settings that affect the behavior and performance of the Diff engine.

**General**

The fields in the **General** group box affect the initial display of diffed documents and the conditions, if any, under which Stylus Studio runs the diff automatically.

- **Automatically expand all diffs** – By default, Stylus Studio collapses the display of the diffed documents. If you select this option, all nodes containing diffs are expanded when the diff is run.

- **Collapse unchanged blocks** – By default, Stylus Studio collapses any block that does not contain any changes to save space in the XML Diff Viewer window. These blocks are displayed as `<unchanged>` in the document tree. You might prefer to have the entire document structure visible, to provide context for changed nodes, for example.

- **Autorun diff** – By default, Stylus Studio runs the diff operation if you make a change to one of the settings on the **Engine** page of the **Options** dialog box. You can also specify that Stylus Studio run the diff operation when the source or target documents change. If you select **If files modified**, Stylus Studio runs the diff operation when you save a source or target file. If neither of these options is selected, you must run the diff manually. See “When Does the Diff Run?” on page 202 for more information on this topic.

**Engine Options**

The fields in the **Engine Options** group box affect how Stylus Studio diffs source and target documents.

- **Use URI to compare namespaces** – Controls whether or not URIs are used to compare namespaces in source and target documents.

- **Expand entity references** – Controls whether or not entity references, which in some cases can include files external to the source or target document, are expanded by the Stylus Studio diff engine for purposes of comparing one block with another.

- **Ignore text formatting characters** – Controls whether or not text formatting characters (new line, carriage return, and tab) are ignored when comparing source and target documents. This option is off by default.
Diffing Folders and XML Documents

- **Show differences in** – Provides granular control of what items in XML documents are diffed. There are separate settings for comments, text, entities, attributes, and processing instructions.

**Performance**

Diffing large, numerous, or complex documents can be time-consuming. Stylus Studio provides controls that let you choose algorithm tunings that have been optimized for change description or calculation time.

- **Autodetect** – Stylus Studio determines which algorithm tuning to use based on the number, content, complexity, and size of the source and target documents. Stylus Studio first tries to use the tuning that is optimized for change description; if it determines that processing resources are limited, it reverts to the algorithm tuning optimized for speed. This setting is on by default.

- **Optimize change description** – Provides the most economical set of changes possible. This calculation, though it yields the best results, can be costly in terms of time and processing resources.

- **Optimize calculation time** – Provides the set of changes in the shortest time possible.

- **Optimize for large documents with few changes** – Helps speed the diffing of large (greater than 1MB) documents by folding similar blocks before comparing nodes. This setting can be used in conjunction with any of the algorithm tuning settings and is on by default.

**Tip** The default setting, **Autodetect** and **Optimize for large documents with few changes**, yields the best results when time and processing resources are not considerations.
Presentation Options

Presentation options allow you to modify the settings for the background colors Stylus Studio uses to identify the types of changes detected in diffed documents and folders.

You can change the background colors for the following:

- Added items
- Removed items (that is, items that are present in the target, but are not present in the source, for example)
- Changed items (the same element or attribute, but a different name, for example)
- Collapsed items with changes

Running the Diff Tool from the Command Line

In addition to using the Diff tool from the Stylus Studio user interface, Stylus Studio also provides a command line utility, StylusDiff.exe. This command line utility allows you to perform many of the same functions, and to use many of the same options, as the graphical Diff tool.
Restrictions

The following restrictions exist for using StylusDiff.exe:

- You cannot use StylusDiff.exe to diff folders
- StylusDiff.exe can diff only one pair of documents at a time

Usage

The StylusDiff.exe utility has the following usage:

StylusDiff -source <sourceURI> -target <targetURI>
[-expandPrefixes/collapsePrefixes] [-expandERs/collapseERs]
[-comments/nocomments] [-attributes/noattributes] [-text/notext] [-pi/nopi]
[-auto/best/fast]

Table 19 describes the usage for the StylusDiff command. For a complete description of these and other options that affect the XML Diff engine, see “Engine Settings” on page 224.

Table 19. StylusXql Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-source &lt;sourceURI&gt;</td>
<td>The path of the XML document you want to use as the source document in the diff. Required.</td>
</tr>
<tr>
<td>-target &lt;targetURI&gt;</td>
<td>The path of the XML document you want to use as the target document in the diff. Required.</td>
</tr>
<tr>
<td>-output &lt;outputURI&gt;</td>
<td>Saves the differences between the source and target files, if any, to the file you specify. Output files are saved with a .dff extension. Optional.</td>
</tr>
<tr>
<td>-expandPrefixes -collapsePrefixes</td>
<td>Whether you want the XML Diff engine to use the URI (-expandPrefixes) or ignore the URI (-collapsePrefixes) when comparing namespaces. The default is -collapsePrefixes.</td>
</tr>
<tr>
<td>-expandERs -collapseERs</td>
<td>Whether you want the XML Diff engine to compare entity references (-collapseERs) or values referenced by entity references (-expandERs). The default is -expandERs.</td>
</tr>
</tbody>
</table>
## Table 19. StylusXql Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-comments</td>
<td>Whether you want the XML Diff engine to compare comments (-comments) or to</td>
</tr>
<tr>
<td>-noComments</td>
<td>ignore comments (-noComments). The default is -comments.</td>
</tr>
<tr>
<td>-attributes</td>
<td>Whether you want the XML Diff engine to compare attributes (-attributes) or</td>
</tr>
<tr>
<td>-noAttributes</td>
<td>to ignore attributes (-noAttributes). The default is -attributes.</td>
</tr>
<tr>
<td>-text</td>
<td>Whether you want the XML Diff engine to compare text (-text) or to ignore</td>
</tr>
<tr>
<td>-noText</td>
<td>text (-noText). The default is -text.</td>
</tr>
<tr>
<td>-pi</td>
<td>Whether you want the XML Diff engine to compare processing instructions (-pi)</td>
</tr>
<tr>
<td>-noPI</td>
<td>or to ignore processing instructions (-noPI). The default is -pi.</td>
</tr>
<tr>
<td>-er</td>
<td>Whether you want the XML Diff engine to compare entity references (-er) or</td>
</tr>
<tr>
<td>-noER</td>
<td>to ignore entity references (-noER). The default is -er.</td>
</tr>
<tr>
<td>-entities</td>
<td>Whether you want the XML Diff engine to compare entities (-entities) or to</td>
</tr>
<tr>
<td>-noEntities</td>
<td>ignore entities (-noEntities). The default is -entities.</td>
</tr>
<tr>
<td>-formatting</td>
<td>Whether you want the XML Diff engine to compare formatting characters</td>
</tr>
<tr>
<td>-noFormatting</td>
<td>(-formatting) or to ignore formatting characters (-noFormatting) when</td>
</tr>
<tr>
<td></td>
<td>comparing text nodes. The default is -formatting.</td>
</tr>
<tr>
<td>-fold</td>
<td>Whether you want the XML Diff engine to fold similar blocks before diffing</td>
</tr>
<tr>
<td>-noFold</td>
<td>(-foldUnchangedBlocks) or to expand and diff nodes (-diffUnchangedBlocks).</td>
</tr>
<tr>
<td></td>
<td>The default is -foldUnchangedBlocks.</td>
</tr>
<tr>
<td>-auto</td>
<td>Controls that let you choose between diffing algorithm tunings that have</td>
</tr>
<tr>
<td>-best</td>
<td>been optimized for time (-fast) and thoroughness (-best). A third choice,</td>
</tr>
<tr>
<td>-fast</td>
<td>-auto, lets Stylus Studio determine which tuning to use. The default is -auto.</td>
</tr>
</tbody>
</table>

**Stylus Studio® 2006 User Guide**
Using Schemas with XML Documents

Stylus Studio allows you to associate one or more schemas with each XML document. A schema can be a DTD or an XML Schema.

There are several ways to associate a schema with an XML document:

● To associate an external schema with a document, ensure that an XML document is active. Then, from the Stylus Studio menu bar, select XML > Associate XML with Schema.

● To define an internal DTD, specify it in the XML editor Text tab or Schema tab.

● To have Stylus Studio generate a schema, in the XML editor, click the Schema tab. If the XML document has some contents, Stylus Studio prompts you to indicate whether you want Stylus Studio to generate a schema from the contents. See “Having Stylus Studio Generate a Schema” on page 230.

This section discusses the following topics:

● “Associating an External Schema With a Document” on page 229

● “Having Stylus Studio Generate a Schema” on page 230

● “Validating XML Documents” on page 230

● “Updating a Document’s Schema” on page 231

● “Removing the Association Between a Document and a Schema” on page 231

Associating an External Schema With a Document

1. Open the XML document you want to associate with a schema. See “Opening Files in Stylus Studio”.

2. From the Stylus Studio menu bar, select XML > Associate XML with Schema.

3. In the Open dialog box that appears, navigate to and select the schema you want to associate.

4. Click Open. The selected schema is now associated with the document.

To associate an XML document with an XML Schema, the XML document must contain a root element.

After you associate a schema with a document, you can view a tree representation of the schema in the XML editor window. Click the Schema tab. See “Updating a Document’s Schema” on page 231.
Having Stylus Studio Generate a Schema

In the XML editor, you can click the **Schema** tab to view the schema for your document. If your document does not specify a schema, Stylus Studio displays the **Schema Not Found** dialog box. This dialog box prompts you to indicate whether you want Stylus Studio to create a schema for your document based on its contents.

You can select **Generate XML Schema** or **Generate DTD**. If you select **Generate XML Schema**, you must specify an absolute path for the file that contains the new schema.

If you select **Generate DTD**, you must indicate whether you want the DTD to be internal or external. If it is internal, Stylus Studio inserts it immediately after the XML declaration. If it is external, you must specify or select an absolute path for the file that contains the new DTD.

After you click **OK**, Stylus Studio displays the new schema in the **Schema** tab.

Validating XML Documents

At any time, you can validate your XML document against its schema. Click **Validate Document** in the window of the document you want to validate.

Stylus Studio displays a message that indicates whether or not your document is valid. If your document does not conform to its schema, Stylus Studio displays a list of error messages that describe the inconsistencies. This list includes line and column numbers that indicate the location of the error. When you click in an XML document, Stylus Studio shows the line and column number in the bottom right corner of the Stylus Studio window.

When Stylus Studio validates a document, it also checks for well-formedness.

Stylus Studio uses font color to indicate valid and invalid element names. Purple fonts indicate valid elements. Orange fonts indicate elements that are not in the schema.

**Note**  
Stylus Studio uses Apache's Xerces XML Parser to validate XML documents. Error messages about invalid documents are generated by the Xerces XML Parser. Stylus Studio has no control over the contents of these messages. If you have trouble understanding such a message, try searching the W3C XML Schema Recommendation for the main phrase in the error message.
**Converting XML to Its Canonical Form**

**Updating a Document’s Schema**

How you update your document’s schema depends on whether the schema is internal or external. If the schema is an internal DTD, you can update it in the Schema tab of the XML editor.

If the schema is not an internal DTD, you can update it only in the DTD editor or the XML Schema editor. You can, however, view the schema in the Schema tab of the XML editor.

When Stylus Studio displays the schema for your document, you can also view the properties for each node in the schema. If the Properties window is not already in view, select View > Properties. Click on any node in the schema view to see the properties for that node.

To view the text of an external schema or to edit an external schema, you must display it in the DTD editor or the XML Schema editor. To do this, select XML > Open Associated Schema from the Stylus Studio menu bar, or click Open Schema in the Stylus Studio tool bar.

Instructions for updating a DTD are in “Defining Document Type Definitions” on page 599. Instructions for updating an XML Schema are in “Creating an XML Schema in Stylus Studio” on page 504. If you update a schema in Stylus Studio and that schema is associated with an XML document that is open in Stylus Studio, Stylus Studio refreshes the schema information for the open XML document.

**Removing the Association Between a Document and a Schema**

To remove the association between a document and an external schema, you must edit the XML document in the Text or Tree tab. Remove the text or nodes that specify the external schema.

To remove an internal DTD from a document, delete the text or nodes that specify the internal DTD.

**Converting XML to Its Canonical Form**

By default, Stylus Studio creates XML that conforms to the W3C XML 1.0 recommendation. You can also convert any XML document to its canonical form. When
you convert XML to its canonical form, the resulting document conforms to the W3C Canonical XML 1.0 recommendation.

Tip  Although you can undo conversion to canonical form, consider using Save As to create a copy of the XML document prior to conversion.

1. Open the XML document you want to convert to canonical XML.
2. Select Edit > Make Canonical XML from the Stylus Studio menu.
   
   Alternative: Click the Make Canonical XML button on the tool bar.
   
   The XML document is converted to its canonical form.

You can undo this operation (Edit > Undo) if necessary.

Querying XML Documents Using XPath

You can use the XML Path Language (XPath) to query XML documents to obtain a subset of the information in that document. You can also query XML Schema and XSLT, provided you open the XSLT using the XML Editor. (You cannot query DTD schema because it is not XML.)

In Stylus Studio, you query XML documents using the XPath Query Editor. To learn more about XPath and how to use the XPath Query Editor, see “Writing XPath Expressions” on page 623.

Printing XML Documents

You can print the raw XML text view of your document. You cannot print the other views of your document.

1. In your XML document, click the Text tab.
2. In the Stylus Studio tool bar, click Print or press Ctrl+P.
Saving XML Documents

When you save a document, Stylus Studio saves it in the encoding that is specified in the initial XML processing instruction.

1. Ensure that the window that contains your XML document is the active window.
2. From the Stylus Studio menu bar, select File > Save.

Alternatives: Press Ctrl+S or click Save in the Stylus Studio tool bar.

Options for Saving Documents

The Application Settings page of the Options dialog box contains two options that affect when and how documents are saved in Stylus Studio. You can choose to have Stylus Studio

- Save modified documents every few minutes. This option is off by default, and has a default setting of 10 minutes.
- Create a backup copy of a document when it is saved.

More About Backup Files

Backup copies are created with a *.ak extension appended to the original document name when saved to the Stylus Studio file system. For example, the backup copy of books.xml would be books.xml.bak. If you are saving to an external file system (such as Sleepycat Software’s Berkeley DB XML), the file system manages the backup file name.

Backup files are written to the same file system as the original document. They are not displayed in the Project window, and they appear in the File Explorer window only if you change the filter to display *.ak files.

Opening a Backup File

You can open a backup file

- From the File Explorer window, by double-clicking the file name or selecting Open or Open With from the file’s shortcut menu, for example
- From the Project window, by selecting the file and then selecting either
  - Open Latest Backup from the file’s shortcut menu (right-click to display), or
  - Project > Open Document’s Latest Backup from the Stylus Studio menu
Chapter 3  Converting Non-XML Files to XML

The Convert to XML module is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio uses adapters to convert an incoming stream of data from a native format to an outgoing stream of XML, or vice-versa. You can create your own adapters, using the Convert to XML module, or you can use one of the many built-in adapters bundled with Stylus Studio.

This chapter describes how to use Convert to XML to create an adapter, how to use files you convert on-the-fly elsewhere in Stylus Studio – as a source for XQuery and XSLT design, for example – and how to use Stylus Studio’s built-in adapters.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Introduction to Convert to XML video.

You can read about other video demonstrations for the Stylus Studio Convert to XML module here: http://www.stylusstudio.com/learn_convert_to_xml.html#converttoxml. A complete list of all the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

Contents
This chapter covers the following topics:

● “Overview of Convert to XML” on page 236
● “Choosing an Input File” on page 239
● “The Convert to XML Editor” on page 240
● “Parts of an Input File” on page 251
● “Working with Regions” on page 253
Converting Non-XML Files to XML

- “Working with Fields” on page 260
- “Controlling XML Output” on page 268
- “Creating an Adapter” on page 279
- “Using Adapters in Stylus Studio” on page 281
- “More About Converting EDI” on page 286
- “User-Defined Adpaters Properties Reference” on page 291

Overview of Convert to XML

The Convert to XML module consists of

- An *adapter engine* that processes non-XML source files using the adapter configuration file (.conv) you specify. The adapter engine is called silently any time you open a file using a Convert to XML adapter. You can also run the adapter engine manually to test the results of the adapters you create, but it has no user-visible or configurable components.

- An *editor* that lets you configure the instructions in the .conv file used by the adapter engine to convert non-XML files to XML. The Convert to XML Editor, shown in Figure 160, displays information read from the input file you are using as a model to build your adapter, as well as values you want the adapter engine to use when
converting other files of this type to XML. The Convert to XML Editor is displayed automatically when you create a new adapter or open an existing one.

![Figure 160. Convert to XML Editor](image)

**File Support**

Stylus Studio’s Convert to XML module makes it easy to build adapters for many non-XML file types, including text, binary, and EDI. You can let Stylus Studio use a set of rules to determine the type, encoding, layout of the input file, or you can specify these settings manually, as shown in Figure 161.

Stylus Studio’s heuristics are also used to determine the field separator character being used (if any), the delimiting character being used (if any), and so on.
Converting Non-XML Files to XML

Using Convert to XML

Generally speaking, you use Convert to XML to create an adapter (also known as a converter), and then you use that adapter to convert one or more non-XML files to XML. The process of using Convert to XML involves the following steps:

1. Create the adapter:
   a. Select **File > New > Convert to XML** from the Stylus Studio menu to display the **New Converter** dialog box.
   b. Select the file you want to convert to XML and open it in the Convert to XML Editor.
   c. Review the default adapter configuration settings displayed in the Convert to XML Editor, and modify as required.
   d. Run the adapter and review the conversion results displayed in the **Preview** window.
   e. Save the adapter (and, optionally, the XML output for the input file selected in step b).

2. Use the adapter to open a new non-XML file of the same type as the file you used to define the adapter.
   The Convert to XML adapter engine converts the new file to an XML document, displaying it in the Stylus Studio editor you specify when opening the file.

The steps in this process are described in greater detail in the following sections.

Other Ways to Convert Files to XML

In addition to creating your own adapter, you can convert files to XML:

- Using Stylus Studio’s built-in adapters – Stylus Studio comes bundled with built-in adapters for numerous file formats, including EDI, CSV, dBase, and Windows .ini files. See “Built-In Adapters” on page 282 for more information.
Choosing an Input File

The first step of creating an adapter is to select an input file.

![New Converter dialog box](image)

**Figure 161. Specify Input File Type Manually or Let Stylus Studio Decide**

The input file can be any type. If you are planning to use the adapter to convert other non-XML files of this type, the input file should be representative of that broader class of files – files with the same extension (.txt or .edi, for example), encoding, numbers and types of regions, and so on. You can always fine-tune the adapter to accommodate characteristics that are not embodied in the input file, but as a general rule, use a file that is as close to others of its type as possible.

**Note**  File systems that return only XML files, such as Sleepycat Software’s Berkeley DB XML, do not appear when you browse for input files using the **Open** dialog box.  

[284x389].txt or .edi, for example)
The Convert to XML Editor

You use the Convert to XML Editor, shown here, to build an adapter. The Convert to XML Editor appears when you create a new adapter, or open an existing one (.conv file).

Figure 162. Convert to XML Editor

The input file is displayed in a document pane; properties that both describe the existing file (encoding and size, for example) and define the XML output that will be generated when converting this file (root and field element names, and whether or not you want the XML to be indented, for example) are displayed in the Properties window. The schema pane shows a representation of the XML Schema that will be output for the converted file. Finally, in addition to current row and column position, note that the status bar also shows the Unicode value of the current character.

This section describes the main features of the Convert to XML Editor, including how it interacts with the adapter engine. This section covers the following topics:

- “Document Pane” on page 241
- “Properties Window” on page 248
- “Schema Pane” on page 250
Document Pane

The document pane displays the input file’s layout, including spaces, field separators, and control characters. The input file’s appearance in the document pane is determined, in part, by its format.

This section covers the following topics:

- “Example – .txt Files” on page 241
- “Display of Delimiting and Control Characters” on page 242
- “Field Names” on page 243
- “Document Pane Display Features” on page 244
- “Moving Around the Document” on page 246

Example – .txt Files

Stylus Studio uses slightly different displays for character-separated and fixed-width .txt files. Consider this file, which uses commas as the field separator:

<table>
<thead>
<tr>
<th>Make</th>
<th>Model</th>
<th>Year</th>
<th>Mileage</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW</td>
<td>R1150S</td>
<td>2004</td>
<td>14274</td>
</tr>
<tr>
<td>Kawasaki</td>
<td>GPz1100</td>
<td>1996</td>
<td>60234</td>
</tr>
<tr>
<td>Ducati</td>
<td>ST2</td>
<td>1997</td>
<td>24000</td>
</tr>
<tr>
<td>Moto Guzzi</td>
<td>LeMans</td>
<td>2001</td>
<td>12393</td>
</tr>
<tr>
<td>BMW</td>
<td>R1150R</td>
<td>2002</td>
<td>17439</td>
</tr>
<tr>
<td>Ducati</td>
<td>Monster</td>
<td>2000</td>
<td>15682</td>
</tr>
<tr>
<td>Aprilia</td>
<td>Futura</td>
<td>2001</td>
<td>17320</td>
</tr>
</tbody>
</table>

Figure 163 shows how this character-separated input file appears in the Convert to XML Editor’s document pane. By default, Stylus Studio aligns columns and fills the empty cells of the shorter rows with a light blue to aid readability:

![Figure 163. Character-Separated File in the Convert to XML Document Pane](image)
You can remove these spaces from the display and view the file in its native format by clicking the **Align Fields** button ( ) on the tool bar, or by selecting **Convert to XML > Align Fields** on the menu. This results in the layout shown in Figure 164.

**Figure 164. Character-Separated File without Aligned Fields**

Fixed-width files are displayed in a slightly different fashion. Consider this fixed-width input file:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deep-sea octopus</td>
<td>Bathypolypus arcticus</td>
<td><a href="http://www.dal.ca/~ceph/TCP/barctic.html">http://www.dal.ca/~ceph/TCP/barctic.html</a></td>
</tr>
<tr>
<td>Blue-ringed octopus</td>
<td>Hapalochlaena lunulata</td>
<td><a href="http://www.dal.ca/~ceph/TCP/lunulata.html">http://www.dal.ca/~ceph/TCP/lunulata.html</a></td>
</tr>
<tr>
<td>Caribbean reef octopus</td>
<td>Octopus briareus</td>
<td><a href="http://www.dal.ca/~ceph/TCP/briar.html">http://www.dal.ca/~ceph/TCP/briar.html</a></td>
</tr>
<tr>
<td>Giant octopus</td>
<td>Octopus dofleini</td>
<td><a href="http://www.dal.ca/~ceph/TCP/giant.html">http://www.dal.ca/~ceph/TCP/giant.html</a></td>
</tr>
<tr>
<td>Common octopus</td>
<td>Octopus vulgaris</td>
<td><a href="http://www.dal.ca/~ceph/TCP/Octopusvulgaris.html">http://www.dal.ca/~ceph/TCP/Octopusvulgaris.html</a></td>
</tr>
<tr>
<td>Red octopus</td>
<td>Octopus rubescens</td>
<td><a href="http://www.dal.ca/~ceph/TCP/redocto.html">http://www.dal.ca/~ceph/TCP/redocto.html</a></td>
</tr>
<tr>
<td>Octopus Salutii</td>
<td>Octopus salutii</td>
<td><a href="http://www.dal.ca/~ceph/TCP/Osalutii.html">http://www.dal.ca/~ceph/TCP/Osalutii.html</a></td>
</tr>
<tr>
<td>Octopus Macropus</td>
<td>Octopus macropus</td>
<td><a href="http://www.dal.ca/~ceph/TCP/Omacropus.html">http://www.dal.ca/~ceph/TCP/Omacropus.html</a></td>
</tr>
</tbody>
</table>

In a fixed-width file, the empty cells represent actual values (spaces) in the input file. In the second row of this input file, for example, there are three spaces between the first and second columns:

**Figure 165. Fixed-Width File in the Convert to XML Document Pane**

**Display of Delimiting and Control Characters**

Stylus Studio displays delimiting and control characters in a way that distinguishes them from plain text values.
Delimiting characters, like the comma used in the example in Figure 163, are displayed with a dark blue background. For files that include sub-fields or arrays (like EDI, for example), the sub-field separator character is shown in a different shade of blue. Sub-sub-fields delimiting characters are shown in a shade of purple.

Control characters (line feeds and carriage returns, for example) are shown using their abbreviated ASCII value. A carriage return (0x0D) line feed (0x0A) is shown as \0x0D\0x0A, for example. ASCII abbreviations are aligned vertically, to preserve space, as shown in this representation of the ASCII value for tab (0x09): \0x09.

Stylus Studio understands all Unicode characters. When editing Line-Oriented Region and Field Name values in the Properties window, you can enter mnemonic values for the C1 and C0 control characters in the following ranges:

- C0 control characters with a value from >= 0x00 to <= 0x1F
- C1 control characters with a value from >=0x80 to <= 0x9F

For example, you could enter TAB or HT in the Field Separator field in the Properties window, and Stylus Studio would correctly interpret that value. For a list of commonly used control characters, see “Specifying Control Characters” on page 304.

Characters that are discarded from output (like line terminators such as CR and LF and comment lines) are displayed against a gray background.

You can hide control characters by clicking the Toggle Control Characters button on the tool bar, or by selecting ConvertToXML > Toggle Control Characters from the menu.

Field Names

User-defined field names – values that Stylus Studio uses to create the element names in converted XML – are displayed in green, as shown here:
Converting Non-XML Files to XML

You can edit these names

- In-place, by double-clicking the field name
- In the Field Element Name field of the Properties window

If the field names are taken from a row within the file itself, Stylus Studio displays a blue arrow in the document pane margin to indicate this.

![Figure 167. Blue Arrow Indicates Field Names Taken from the File](image)

See “Naming Fields” on page 261 to learn more about naming fields for XML output by Convert to XML converters.

Document Pane Display Features

In addition to aligning fields in character-delimited files, the Convert to XML Editor’s document pane has several other features that aid readability.

Ruler

You can display a ruler that identifies each column:

![Figure 168. Ruler Helps Identify Columns](image)
Displaying Pattern Matches

You can define match patterns using regular expressions to control which rows are converted to XML and, optionally, the name to use for these rows. You can highlight rows that match the patterns that you have defined, as shown here:

To display the ruler, click the **Toggle Ruler** button ( ) on the tool bar, or select **ConvertToXML > Toggle Ruler** from the menu.

**Figure 169. Matching Rows Are Displayed in Yellow**

To highlight matching rows, click the **Highlight Matching Rows** button ( ) on the tool bar, or select **ConvertToXML > Highlight Matching Rows** from the menu.

Matching rows are displayed in light yellow, with a green check in the pane’s margin. A red X identifies rows that do not match the current pattern. Gray squares identify rows that match a pattern other than the pattern defined for the row that currently has focus. See “Specifying Multiple Match Patterns” on page 273 for more information on this feature.

**Tip** Only rows that match the same pattern that the current row matches are highlighted. Also, tooltips appear when you hover the pointer over the match symbols. These tooltips display the pattern that the row matches.

See “Pattern Matching” on page 271 to learn more about using regular expressions to define match patterns.
Grid Lines

The document pane displays both vertical and horizontal lines by default; you can hide/show them independently. In the example shown in Figure 170, horizontal lines are hidden from the display:

Figure 170. You Can Hide Horizontal and Vertical Grid Lines

To hide horizontal and vertical grid lines, click the **Toggle Horizontal Grid Lines** and/or **Toggle Vertical Grid Lines** buttons on the tool bar, or select **ConvertToXML > Toggle Horizontal Grid Lines** and/or **Toggle Vertical Grid Lines** from the menu.

Tip: Hiding horizontal lines while displaying the ruler is an effective way to quickly scan columns.

Fonts

By default, the input document is displayed using the Courier New font in 12pt. You can change the display font to suit your personal preference using the **Edit > Change Font** and **Edit > Font Size** menus.

Moving Around the Document

You can move the cursor around the document using

- The Space bar on your keyboard
- The directional arrows and Page Up, Page Down, Home, and End keys on your keyboard
- Your mouse (click on the character on which you want to place the cursor)
The Go To dialog box

Using Go To

You use the Go To dialog box to jump to a specific location in the file you are using to create your converter. You can use it to move the cursor to a specific

- Position in the file
- Region
- Position or row within a region
- Column within the current row

When you first display the Go To dialog box, values in the Go To fields reflect the cursor’s current location within the file. The values in the Maximum fields display the maximum values for each category (file size, number of regions, and so on) for the portion of the file read into the Convert to XML Editor by Stylus Studio.
Properties Window

The **Properties** window, like the one shown in Figure 172, displays information about the input file, as well as settings that Stylus Studio will use convert files to XML.

**Figure 172. Properties Window for a .txt File**

Information in the **Properties** window includes:

- Information read or inferred from the input file when it is first opened in the Convert to XML Editor. Examples include the file name, file size, and number of characters that were read. Some values, such as the type of encoding, can be edited. Informational fields that cannot be edited are identified with a blue circle: 🔄.

- Values you want the Convert to XML converter to use when converting this input file and other files of this type to XML. Output properties include the root element name, the namespace and namespace prefix, and the field element name. These fields are identified with a green arrow over a document icon: 🔄.
How Properties are Organized

Properties displayed in the Properties window are organized in the following categories:

- **Input File** – read-only information read or inferred from the input file, and editable properties that affect XML output. These properties affect the file as a whole when it is converted to XML. Input file properties are identified by this icon: 

- **XML Output URL** – properties that affect the XML document created by the Convert to XML converter, including the name you want to use for the root element, and whether or not you want to indent the XML. Output URL properties are identified by this icon: 

- **Region Type** – read only information inferred from the input file, and editable properties that affect XML output. Examples include line terminating and escape characters. These properties affect a contiguous portion of the file (that is, a given line-oriented or fixed-width region) when it is converted to XML. Region properties are identified by this icon: 

- **Row Element Name** – properties that affect which rows of the input file are output to XML and how they are output, including the name you want to use for the row. Row properties are identified with this icon: 

- **Field Element Name** – read-only information read or inferred from the input file, and editable properties that affect XML output. These properties affect only fields in a given region of the file when it is converted to XML. Field properties are identified by this icon: 

**Note** Informational properties, that is, properties that do not affect XML output, are displayed with the following icon: . These properties are displayed when you click the Toggle Informational Properties button.

Properties for Fixed-Width and Line-Oriented Input Files

Fixed-width and line-oriented input files have different properties – line-oriented properties include the line terminator and field separator characters, and fixed-width files have a row length, for example. See “User-Defined Adapters Properties Reference” on page 291 to learn more about individual properties.
Converting Non-XML Files to XML

Schema Pane

The schema pane displays a representation of the XML Schema for the XML document that will be output when the input file is converted to XML.

![Figure 173. Schema Pane Shows Output Schema Representation](image)

You can double-click on a row element to display the Set Node and Match Pattern dialog box, shown in Figure 174. This functionality provides an alternative to editing the row name and specifying a match pattern in the Properties window.

![Figure 174. Set Node and Match Pattern Dialog Box](image)

You can also edit schema node names directly in the schema pane – just click twice to place the node name in edit mode.

See “Rows” on page 252 to learn more about specifying conversion properties for rows.
Parts of an Input File

Input files displayed in the Convert to XML Editor's document pane consist of regions, rows, and fields. Each section has its own set of properties. Some, like Region Type, are read or inferred from the file; others, like Region Element Name, are values you provide that affect the XML output.

This section covers the following topics:
- “Regions” on page 251
- “Rows” on page 252
- “Fields” on page 253

Regions

A region is the largest organizational component in an input file. Regions are interpreted by Stylus Studio when the input file is first read into the Convert to XML Editor, and you can define your own using the Convert to XML Editor.

An input file can contain one or more regions; every input file has at least one region that starts at offset 0. Multiple regions are common in binary files, which often contain a fixed-size header and then one or more records containing the actual data.

In the Convert to XML Editor, regions are numbered, starting with 1, followed by the row number. For example, in an input file with two regions, you might see rows labeled as follows: 1:1, 2:1, 2:2, 2:3, and so on, as shown here:

![Figure 175. Rows in Regions Are Numbered Independently](image)

Figure 175. Rows in Regions Are Numbered Independently
Converting Non-XML Files to XML

Region Types
Regions can be fixed-width or line-oriented. You can also set the Region Type property to No-output. Regions that are marked as No-output are grayed out in the Convert to XML editor, and they are not converted to XML.

Managing Regions
Stylus Studio provides tools that let you create new regions, and join one region with another. You can also change a region’s type, define different line terminators across regions, and mark a region so that it is excluded from output. For information on these and other topics, see “Working with Regions” on page 253.

Rows
A row is equivalent to a record, line, or tuple in the input file; a row is made up of fields. An example of a row is an employee record; examples of fields in an employee record include employee_id, last_name, first_name, and so on.

Every region can have one or more rows. (A region cannot be empty.) In addition, a region can have multiple row types. Rows are selected for conversion to XML based on the match patterns expressed in the Match Pattern field of the Properties window. See “Omitting Regions and Fields, and Rows” on page 270 for more information.

Rows in a fixed-width region have the same width as the region itself; fields within each row are defined by a fixed number of columns. Stylus Studio uses a default value of 80 characters for row length in fixed-width regions, but you can adjust this as required from within the Convert to XML Editor. See “Adjusting Fixed-Width Regions” on page 256 for more information.

In a fixed-width region, you can
● Explicitly specify the fields within a row
● Adjust the size of the fields you specify

In a line-oriented region, fields are separated by a separator character or string. These characters are inferred by Stylus Studio when it first reads the file, but you can change these and other characters if needed.

See “Working with Fields” on page 260 for more information.
Fields

A field is one or more columns in a row that contains data. Each different row type has its own independent set of fields. An example of a field in an employee record is employee_id.

Stylus Studio supports many data types (string, Boolean, number, date, time, and so on) and recognizes many different input formats (like different date formats, for example). Properties vary based on data type – the Base property, for example, is applicable only to Number data types.

You can define your own fields in fixed-width input files. See “Defining Fields” on page 264 for more information.

Component and Sub-Component Fields

Some file formats, including many EDI variants, allow fields to be subdivided into arrays, sub-fields, or composite fields. Collectively, these fields are referred to as component fields in Convert to XML, and they are fully supported, both in terms of recognition and output. You can name the container element using the Component Element Name and Sub-Component Element Name properties.

Working with Regions

This section describes some of the features you can use to work with input file regions. It covers the following topics:

- “Converting the Region Type” on page 253
- “Adjusting Fixed-Width Regions” on page 256
- “Defining and Joining Regions” on page 258
- “Controlling Region Output” on page 260

Converting the Region Type

The Region Type field in the Properties window displays information about the type of region Stylus Studio inferred when the file was first read. Its value is either Fixed-width, Line-oriented, or No-output.

Tip Information about No-output regions is not displayed in the Properties window.
Converting Non-XML Files to XML

Stylus Studio’s Convert to XML interprets regions with CR/LF control characters as line-oriented regions. There might be occasions, however, when you want to change the region type from line-oriented to fixed-width, or vice versa. This section describes the tools you can use to change a region from one type to another.

Consider the following file fixed-width file:

<table>
<thead>
<tr>
<th>Make</th>
<th>Model</th>
<th>Year</th>
<th>Mileage</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW</td>
<td>R1150RS</td>
<td>2004</td>
<td>14274</td>
</tr>
<tr>
<td>Kawasaki</td>
<td>GPz1100</td>
<td>1996</td>
<td>60234</td>
</tr>
<tr>
<td>Ducati</td>
<td>ST2</td>
<td>1997</td>
<td>24000</td>
</tr>
<tr>
<td>MotoGuzzi</td>
<td>LeMans</td>
<td>2001</td>
<td>12393</td>
</tr>
<tr>
<td>BMW</td>
<td>R1150R</td>
<td>2002</td>
<td>17439</td>
</tr>
<tr>
<td>Ducati</td>
<td>Monster</td>
<td>2000</td>
<td>15682</td>
</tr>
<tr>
<td>Aprilia</td>
<td>Futura</td>
<td>2001</td>
<td>17320</td>
</tr>
</tbody>
</table>

It is a simple .txt file with fields (Make, Model, and so on) that have been created using spaces. Each new row was created using the Enter key in the text editor, resulting in CR/LF control characters at the end of each line that cause Convert to XML to interpret the file as a single line-oriented region, like this:

For display purposes, we can remove the spaces Stylus Studio has inserted for readability (the cells with the light blue shading) by clicking the Align Fields ( ) button. This...
results in a display that resembles the source (Figure 177), but Stylus Studio still considers the region to be line-oriented.

![Figure 177. Turning Off Align Fields Can Aid Readability](image)

When you convert a line-oriented region to a fixed-width region, Convert to XML removes spaces it added for readability and depicts only the spaces in the original input file used to create the fields and the field values themselves, as show in Figure 178.

![Figure 178. Line-Oriented Regions Converted to Fixed-Width](image)

By default, Stylus Studio displays fixed-width files using an 80-character row. This accounts for the input files appearance when it is first displayed as a fixed-width file – if you scan the document, you can see that all of the file’s original information, including the CR/LF control characters has been retained, but that the formatting differs – the original input file had eight rows; now it has four rows of 80 characters.

**Tip** You can adjust the width of fixed-width regions. See “Adjusting Fixed-Width Regions” on page 256.

**How to Convert a Region Type**

1. Place the cursor anywhere in the region you want to change.

2. Click the **Convert to Fixed-Width Region** ([ ]) or **Convert to Line-Oriented Region** ([ ]) button. These actions are also accessible from the **ConvertToXML** menu and the shortcut menu in the Convert to XML Editor.

3. If you have converted a line-oriented region to a fixed-width region, adjust the row length as needed. See “Adjusting Fixed-Width Regions” on page 256.
Adjusting Fixed-Width Regions

If you specify the layout of the file you are converting as fixed-width, Stylus Studio uses a default row length of 80 characters. (If you let Stylus Studio determine the file layout, Stylus Studio will attempt to determine record length based on the line terminating character, if any.) You might need to adjust the row length of a region if your input file uses a different row length, or when converting a line-oriented region, like the one shown in Figure 179, to fixed-width.

There are several ways to specify the row length for a fixed-width region:

- Using the **Row Length** property – simply change the default value, 80, to the value that is appropriate for the current region and press Enter.
- Dragging the document pane to the left or right – move the pointer to the right border of the document pane. When it changes shape, press and hold mouse button 1 and drag the right border of the grid until the input file’s fields are aligned.
- Holding the Shift key and pressing the right arrow (to add width) or the left arrow (to decrease width).

![Figure 179. Line-Oriented Region](image)
Each of these methods lets you explicitly set the row length. Alternatively, you can specify a Line Terminator character manually, as shown in Figure 180.

![Figure 180. Manually Setting the Line Terminator Character](image)

Specifying a Line Terminator character means that the rows in the region can be of variable length, based on where the specified Line Terminator character occurs in the record.

**Tip** When you specify a Line Terminator character for a fixed-width region, the value shown in the **Row Length** property represents the value of the longest row in the region.

**Example**

After converting the line-oriented region shown in Figure 179 to fixed-width, it looks like this:

![Figure 181. Line-Oriented Region Converted to Fixed-Width](image)
Figure 179 shows the same fixed-width file after it has been resized by dragging the document pane.

Defining and Joining Regions

An input file can contain any number of regions; fixed-width and line-oriented regions can exist in the same file. The Convert to XML Editor provides tools that allow you to define new regions and join existing ones.

This section covers the following topics:

- “Defining a Region” on page 258
- “Joining Regions” on page 259

Defining a Region

When you define a region in an input file, Stylus Studio splits the region at the current cursor location. The new region starts with the character on which the cursor resided when the region was defined, but it can be of either type – fixed-width or line-oriented – regardless of the type of the original region.

Consider the following input file:

```
# Bike Inventory Overview 2004-10-01 09:00:07EDT
Make,Model,Year,Mileage
BMW,R1150RS,2004,14274
Kawasaki,GPz1100,1996,60234
Ducati,ST2,1997,24000
Moto Guzzi,LeMans,2001,12393
BMW,R1150R,2002,17439
Ducati,Monster,2000,15682
Aprilia,Futura,2001,17320
```
By default, Stylus Studio reads this as a file with a single region. You might decide you want your XML to distinguish headers from actual records and treat the two accordingly (not generating headers as XML, for example).

When you define a new region, the Convert to XML Editor renumbers all the rows, using a region:row number format. In addition, each region is displayed with its own field name row, which is displayed in light green with the default field element name, `field`, as shown in Figure 183.

Field and row values are independent across regions. For example, the `<row>` element might be `<reg1>`, `<reg2>`, and so on for each of the regions in an input file.

1. Place the cursor in the document pane on the character with which you want to start the new region.

2. Click the **Start New Line-Oriented Region Here** or **Start New Fixed-Width Region Here** button. These actions are also accessible from the ConvertToXML menu and the shortcut menu in the Convert to XML Editor.

Stylus Studio defines the new region and renumbers existing regions accordingly.

### Joining Regions

You can join regions that you define as well as regions that Stylus Studio interpreted when it first read the input file. You can join the current region to either adjacent region – the previous region, or the next region.
Converting Non-XML Files to XML

The region type after the join operation depends on whether you are joining with the previous region or the next region. The region you are joining assumes the type of the region to which it is being joined.

Table 20. Region Type After Joining Regions

<table>
<thead>
<tr>
<th>Region Joined With</th>
<th>Resulting Region Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>The region you are using to perform the join</td>
</tr>
<tr>
<td>Previous</td>
<td>The region to which you are joining</td>
</tr>
</tbody>
</table>

1. Place the cursor anywhere in the region you want to join with another region.
2. Click the Join with Previous Region ( ) or Join with Next Region ( ) button. These actions are also accessible from the ConvertToXML menu and the shortcut menu in the Convert to XML Editor.
   Stylus Studio joins the region you specified in step 1 with the adjacent region.

Controlling Region Output

By default, Stylus Studio generates output for all fixed-width and line-oriented regions. No-output regions are never converted to XML. In addition to pattern matching, which controls whether or not individual rows in a region are output based on a pattern you define, you can omit entire regions from output by selecting Yes from the Omit from Output drop-down list in the Region Type section of the Properties window.

Working with Fields

This section describes some of the features you can use to work with input file fields. It covers the following topics:

- “Naming Fields” on page 261
- “Defining Fields” on page 264
- “Component and Sub-Component Fields” on page 267
Naming Fields

Every field in an input file – including fields in the same region and row – can have its own field element name. All field element names (<field> is the default) include the namespace prefix in the XML output if one was specified.

Field names are determined by two properties – **Element Name Source** in the Region Type properties, and **Field Element Name**, as shown in **Figure 184**.

![Figure 184. Sources for Field Names in XML Output](image)

The **Element Name Source** indicates the origin of the field name used in the XML output when converting the input file. The **Field Element Name** property specifies the actual value used to name the <field> element.

Using the Element Name Source Property

There are three values for the **Element Name Source** property:

- **User-Supplied** – Specifies that you will supply names for the <field> element. You can do this by editing the **Field Element Name** property, or by double-clicking the field element name in the Convert to XML document pane to edit the field name directly in the document pane.

  The default value of the **Field Element Name** property is **field**. If you use other values for the **Element Name Source** property, Stylus Studio provides the values for the **Field Element Name** property.

  **User-Supplied** is the default setting for the **Element Name Source** property.
Converting Non-XML Files to XML

- **From First Row** – You can use this setting to take `<field>` element names from the first row in the region. If you have used the **Rows to Skip** property to skip rows in a region, the first available region is used to supply the `<field>` element names.

  Consider the following input file:

<table>
<thead>
<tr>
<th>Make:Model:Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW:R1150RS:2004</td>
</tr>
<tr>
<td>MZ:Scorpion:1995</td>
</tr>
<tr>
<td>Ducati:ST2:1997</td>
</tr>
</tbody>
</table>

  If you set **Element Name Source** to **From First Row**, the XML output uses Make, Model, and Year for the `<field>` element names, as shown here:

  ```xml
  <?xml version="1.0" encoding="utf-8"?>
  <root>
    <row>
      <Make>BMW</Make>
      <Model>R1150RS</Model>
      <Year>2004</Year>
    </row>
    <row>
      <Make>MZ</Make>
      <Model>Scorpion</Model>
      <Year>1995</Year>
    </row>
    <row>
      <Make>Ducati</Make>
      <Model>ST2</Model>
      <Year>1997</Year>
    </row>
  </root>
  ```

  You can specify any row as the source for field names using the **Get Field Names from This Row** from the row’s shortcut menu.

- **WS-EDI Standard** – This setting allows rows and fields to be named based on the WS-EDI Standard level 0. See [http://www.ws-edi.org](http://www.ws-edi.org) for more information on this standard.
More About Using Rows for Field Names

When you use an existing row as the source for field names in the XML output, Stylus Studio changes the display of that row in the document pane to a darker blue to indicate this, as shown here:

In addition, preceding rows in that region, if any, are grayed out, and the value of the **Rows to Skip** field in the **Region Type** properties changes to reflect this.

In the event that the first row has fewer names than there are fields in one or more subsequent lines in the file, Stylus Studio names the extra fields `<field n>`, where `n` is the field number relative to other fields in the row. Also, if the values in the row are not valid XML identifiers, they are converted using the following rules:

- Whitespace and nulls are trimmed from both ends
- SQL/XML rules are used, except that underscores ("_") are not converted to `_x005F_` symbols

How to Name Fields

1. Display the **Properties** window if it is not already displayed (click **View > Properties** on the Stylus Studio menu).

2. Place the cursor anywhere in the field you want to name.

   The **Field Element Name** property displays the current value for the field.

3. Type the new name in the **Field Element Name** property and press Enter.
Converting Non-XML Files to XML

Alternative:

1. Double-click the **field** name in the document pane.
   The field name field becomes editable.

2. Type a new value for **field** and press Enter.

Defining Fields

You can define fields in any region in a fixed-width input file, as shown in Figure 187. Once you have defined a field, you can change its size by simply dragging it to any column in the grid.

Each field you define is treated as a separate element in the XML output by the adapter. The input file shown in Figure 187, for example, would result in XML with two `<field>` elements, one consisting of the make of motorcycle, and one consisting of the model, year,
and mileage. You can use the field feature to exercise control over the XML – defining separate fields for make, model, year, and mileage, for example.

Consider the following input file:

<table>
<thead>
<tr>
<th>Make</th>
<th>Model</th>
<th>Year</th>
<th>Mileage</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW</td>
<td>R1150RS</td>
<td>2004</td>
<td>14274</td>
</tr>
<tr>
<td>Kawasaki</td>
<td>GPz1100</td>
<td>1996</td>
<td>60234</td>
</tr>
<tr>
<td>Ducati</td>
<td>ST2</td>
<td>1997</td>
<td>24000</td>
</tr>
<tr>
<td>MotoGuzzi</td>
<td>LeMans</td>
<td>2001</td>
<td>12393</td>
</tr>
<tr>
<td>BMW</td>
<td>R1150R</td>
<td>2002</td>
<td>17439</td>
</tr>
<tr>
<td>Ducati</td>
<td>Monster</td>
<td>2000</td>
<td>15682</td>
</tr>
<tr>
<td>Aprilia</td>
<td>Futura</td>
<td>2001</td>
<td>17320</td>
</tr>
</tbody>
</table>

By default, each row is considered to have a single field, containing Make, Model, Year, and Mileage, resulting in XML output like this:

```xml
<?xml version="1.0" encoding="utf-8"?>
<root>
  <row>
    <field>Make</field>
    <field>Model</field>
    <field>Year</field>
    <field>Mileage</field>
  </row>
  <row>
    <field>BMW</field>
    <field>R1150RS</field>
    <field>2004</field>
    <field>14274</field>
  </row>
  ...
</root>
```
If you specify fields for Model, Year, and Mileage, the XML output by the adapter looks like this:

```xml
<?xml version="1.0" encoding="utf-8"?>
<root>
  <row>
    <field>Make</field>
    <field>Model</field>
    <field>Year</field>
    <field>Mileage</field>
  </row>
  <row>
    <field>BMW</field>
    <field>R1150RS</field>
    <field>2004</field>
    <field>14274</field>
  </row>
  ...
</root>
```

Neither approach is always correct, but this feature gives you the ability to define the type of XML output that is appropriate for your use.

**Tip** Of course, in this example, the next logical step might be to use the first row (Make, Model, Year, and Mileage) as the field names as described in “Naming Fields” on page 261.

1. Place the cursor in the document pane on the character with which you want to start the new field.

2. Click the Begin Field in This Column button. This action is also accessible from the ConvertToXML menu and the shortcut menu in the Convert to XML Editor.
Stylus Studio displays a thin orange line that identifies the start of the newly defined field.

The procedure for removing a field is the same as the procedure for defining one – place the cursor on any character adjacent to the field line you want to remove and click the Begin Field in This Column button.

**Creating Notes for Fields**

Stylus Studio allows you to create notes on individual fields. These notes are for reference purposes only; they are not output in the XML.
1. Click the entry field for the Notes property.

   **Tip** The Notes property is in the Field Element Name > Source Data Type tree in the Properties window. These properties appear only for rows for which a match pattern exists. See “Pattern Matching” on page 271 for more information on this topic.

   The Notes dialog box appears.

   ![Notes dialog box](image)

   **Figure 188. Notes Dialog Box**

2. Type the notes you want to associate with the field and click the OK button.

   **Tip** If a field has a note defined for it, it is displayed in a tooltip which appears when you hover the mouse pointer over the field in the Convert to XML Editor.

### Component and Sub-Component Fields

Some file formats – many EDI variants, for example – allow fields to be subdivided into arrays, sub-fields, or composite fields. Collectively, these fields are referred to as component fields in Convert to XML. Typically, the headers of these files contain information about the character used to specify component fields. Convert to XML uses this information to set the default value for the Field Component Separator property and render XML output accordingly.

Consider the following input file, which uses a semi-colon (;) to specify component fields:

```
Make;Model;Year;Color;Seat
BMW;R1150RS;2004;grey,metallic;black,vinyl
MZ;Scorpion;1995;green,clearcoat;black,vinyl
Ducati;ST2;1997;red,clearcoat;black,leather
```
Converting Non-XML Files to XML

Using the first row to supply the field names and default Component Element Name (component), the Convert to XML creates the following XML output (first two elements shown for brevity):

```xml
<?xml version="1.0" encoding="utf-8"?>
<root>
  <row>
    <Make>BMW</Make>
    <Model>R1150RS</Model>
    <Year>2004</Year>
    <Color>
      <component>grey</component>
      <component>metallic</component>
    </Color>
    <Seat>
      <component>black</component>
      <component>vinyl</component>
    </Seat>
  </row>
  <row>
    <Make>MZ</Make>
    <Model>Scorpion</Model>
    <Year>1995</Year>
    <Color>
      <component>green</component>
      <component>clearcoat</component>
    </Color>
    <Seat>
      <component>black</component>
      <component>vinyl</component>
    </Seat>
  </row>
  ...
</root>
```

The <component> elements are created as subelements of the <Color> and <Seat> elements.

For line-oriented regions in files containing component fields, you can change the default Field Component Separator property, and the Component Element Name and Component Element Name properties, that is, the name you want to use for the component fields’ container elements.

Controlling XML Output

Convert to XML provides several ways for you to control the XML output created by the Convert to XML adapter. Most XML output is specified using properties displayed in the Properties window. Some XML output, such as the number of regions or the number of fields in a row, are specified using the Convert to XML Editor.
Controlling XML Output

This section describes the properties used to control some of the most common output operations. See “User-Defined Adpaters Properties Reference” on page 291 for detailed information on all properties.

This section covers the following topics:

- “Specifying Element Names” on page 269
- “Specifying Format” on page 270
- “Omitting Regions and Fields, and Rows” on page 270
- “Pattern Matching” on page 271
- “Using Lookup Lists” on page 276
- “Using Key=Value Characters” on page 278

Specifying Element Names

You can specify names for the following in an XML document output by the adapter:

- Root element – The default for the <root> element is root. You can change the default using the Root Element Name property.
- Region element – The default for the <region> element is region. You can change the default using the Region Element Name property. Different regions can have different names.
- Namespace – You can specify names for both the namespace prefix and the namespace using the Namespace and Namespace Prefix properties, respectively. The namespace prefix you specify is added to every element name.
- Row element – The default for the <row> element is row. You can change the default using the Row Element Name property. Rows in different regions can have different names.
- Field element – The default for the <field> element is field. You can change the default using the Field Name property. Each field can have its own name. If your input file defines subelements, you can use the Component Element Name and Sub-Component Element Name properties to provide a name for the containing element.
Specifying Format

There are several ways to exercise control over the format of the XML document output by the adapter.

- Indenting – By default, Stylus Studio indents the XML generated by the adapter. You can remove indenting by changing the value of the **Indent XML?** property to False.
- Whitespace – The **Normalize Whitespace** property converts tabs, carriage returns, and line-feeds to spaces. Leading and trailing whitespaces are then removed, and any two or more consecutive whitespaces are collapsed to a single space.
- XML Schema – The **XML Schema Document** property allows you to specify the XML Schema you want to associate with the XML output. There are also fields that allow you to specify System and Public DTDs.

Omitting Regions and Fields, and Rows

Stylus Studio allows you to omit specific regions and fields from an input file when it is converted to XML.

- Omitting regions – The **Omit from Output** property lets you omit an entire region from XML output. (Regions with a **Region Type** of No-output are always omitted from XML output.)
- Omitting fields – The **Omit from Output** property lets you omit a field from XML output. You can omit a field
  - Only when it is empty. This is the default.
  - When it is empty or evaluates to a zero value.
  - Always, regardless of its value
  - Never, regardless of its value
- Comments – You can filter rows using the **Comment String** property – if the beginning of a row matches the string you enter for this property, Stylus Studio ignores the row when converting the input file to XML. You can also specify patterns that rows must match in order for them to be converted to XML. See “Pattern Matching” on page 271 for more information.
Pattern Matching

You can use regular expressions to specify match patterns for the rows in the input file. Only those rows in the input file that match the pattern you specify are output to XML when the file is converted. The simplest way to define a match pattern is to use the **Match Pattern** property in the **Row Element Name** section of the **Properties** window.

Example

Consider the following input file:

<table>
<thead>
<tr>
<th>Make,Model,Year,Mileage</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW,R1150RS,2004,14274</td>
</tr>
<tr>
<td>Kawasaki,GPz1100,1996,60234</td>
</tr>
<tr>
<td>Ducati,ST2,1997,24000</td>
</tr>
<tr>
<td>Moto Guzzi,LeMans,2001,12393</td>
</tr>
<tr>
<td>BMW,R1150R,2002,17439</td>
</tr>
<tr>
<td>Ducati,Monster,2000,15682</td>
</tr>
<tr>
<td>Aprilia,Futura,2001,17320</td>
</tr>
</tbody>
</table>

If you specify a simple regular expression, say, `^B`, for the **Match Pattern** property, Stylus Studio displays the input file in the Convert to XML Editor as shown in Figure 189 – green check marks identify the rows that match the pattern, and red X’s identify the rows that do not. (You can also display matching rows in a contrasting color by clicking the **Highlight Matching Rows** button. See “Document Pane Display Features” on page 244 for more information about this feature.)

Note that the match pattern also appears as a new node in the schema pane. This new node, the only one defined for this adapter at this point, uses the default row element name (`row`) and the value of the expression.
Converting Non-XML Files to XML

Since the match pattern selects only those rows that begin with the letter B, the adapter creates the following XML document when it is run against the input file:

```xml
<?xml version="1.0" encoding="utf-8"?>
<root>
  <row>
    <Make>BMW</Make>
    <Model>R1150RS</Model>
    <Year>2004</Year>
    <Mileage>14274</Mileage>
  </row>
  <row>
    <Make>BMW</Make>
    <Model>R1150R</Model>
    <Year>2002</Year>
    <Mileage>17439</Mileage>
  </row>
</root>
```

See “Working with Nodes” on page 273 to learn about adding the row element name/match pattern pairs that define them.

Sample Regular Expressions

The following table presents some commonly used regular expressions.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Matches</th>
</tr>
</thead>
<tbody>
<tr>
<td>^ABC</td>
<td>Match all lines starting with “ABC”</td>
</tr>
<tr>
<td>^[Aa][Bb][Cc]</td>
<td>Match all lines starting “ABC”, “abc” or any mix of upper and lowercase (“Abc”, for example)</td>
</tr>
<tr>
<td>AAA</td>
<td>Match all lines containing “AAA”</td>
</tr>
<tr>
<td>^(DEF</td>
<td>GHI)</td>
</tr>
<tr>
<td>XYZ$</td>
<td>Match all lines ending with “XYZ”</td>
</tr>
<tr>
<td>XYZ$</td>
<td>Match all lines containing “XYZ”</td>
</tr>
</tbody>
</table>

Go to [http://java.sun.com/j2se/1.5.0/docs/api/java/util/regex/Pattern.html](http://java.sun.com/j2se/1.5.0/docs/api/java/util/regex/Pattern.html) to learn about the specific regular expression implementation supported in Stylus Studio. Go to [http://www.boost.org/libs/regex/doc/syntax.html](http://www.boost.org/libs/regex/doc/syntax.html) for additional examples of regular expression usage.
Specifying Multiple Match Patterns

You can specify multiple match patterns for a single file. If we define a new match pattern, ^K, this results in a new node (<row> "^K") in the schema pane, which now displays both nodes (see Figure 190). When an input file is converted, Stylus Studio matches the patterns in the order in which the nodes that represent them are defined in the schema. Blank patterns are always matched last.

When you define multiple match patterns, the document pane displays a gray square alongside rows that match a pattern other than the one, if any, associated with the currently selected row. In Figure 190, for example, row 3 is the currently selected row; it matches the pattern ^K we have defined. Because row 3 is the active row, Stylus Studio displays gray squares in rows 2 and 6 (which match the pattern B defined previously).

![Figure 190. Gray Squares Identify Rows That Match Other Patterns](image)

Working with Nodes

In addition to defining nodes using the Match Pattern field of the Properties window, you can also use the Set Node and Match Pattern dialog box, shown here:

![Figure 191. Set Node and Match Pattern Dialog Box](image)
Converting Non-XML Files to XML

This dialog box allows you to

- Define a new node – even one that does not match a row in the current input file. For example, we could define a match pattern for Triumph motorcycles (<row> "^T") even though there are no Triumph motorcycles in the input file.

- Clone an existing node – this allows you to copy an existing node and modify its match pattern to create a new node.

- Edit an existing node. (You can also do this in the Properties window, of course.)

When you open the dialog box, the Row Element Name and Match Pattern fields contain default values that reflect the currently selected row in the document pane or node in the schema pane.

Defining a New Node

1. Select a row in the document pane or a node in the schema pane.
2. Select ConvertToXML > Add Node and Pattern from the Stylus Studio menu. 
   *Alternative*: Select Add Node and Pattern from the document pane or schema pane shortcut menu.
   
The Set Node and Pattern dialog box appears.
3. Change the default values in the Row Element Name and Match Pattern fields.
4. Click OK.

Cloning a Node

1. Select the node in the schema pane that you want to clone.
   *Alternative*: Select the row in the document pane that is represented by a row element name/match pattern pair you want to clone.
2. Select ConvertToXML > Clone Node and Pattern from the Stylus Studio menu.
   *Alternative*: Select Clone Node and Pattern from the document pane or schema pane shortcut menu.
   
The Set Node and Pattern dialog box appears.
3. Change the default values in the **Row Element Name** and **Match Pattern** fields as needed.

4. Click **OK**.

**Editing a Node**

1. Select the node in the schema pane that you want to edit.
   *Alternative*: Select the row in the document pane that is represented by a row element name/match pattern pair you want to edit.

2. Select **ConvertToXML > Edit Node and Pattern** from the Stylus Studio menu.
   *Alternative*: Select **Edit Node and Pattern** from the document pane or schema pane shortcut menu.
   *Alternative*: Double-click the node.
   The **Set Node and Pattern** dialog box appears.

3. Change the default values in the **Row Element Name** and **Match Pattern** fields as needed.

4. Click **OK**.

**Removing a Node**

When you remove a node, you are deleting the row element name/match pattern pair from the adapter you are defining.

1. Select the node in the schema pane that you want to remove.
   *Alternative*: Select the row in the document pane that is represented by a row element name/match pattern pair you want to remove.

2. Select **ConvertToXML > Remove Node and Pattern** from the Stylus Studio menu.
   *Alternative*: Select **Remove Node and Pattern** from the document pane or schema pane shortcut menu.
   *Alternative*: Press the Delete key.
   A warning message appears.

3. Click **Yes** to remove the node, otherwise click **No**.
Using Lookup Lists

You can define lookup lists for individual fields. When Stylus Studio converts the input file, it replaces the string in the input file (the lookup) with the value you have defined for it in the **Lookup List** dialog box. Figure 192 shows an example of a lookup list that has been defined for a Status field:

![Lookup List Dialog Box](image)

**Figure 192. Sample Lookup List**

For any Status fields in the input document with a value of, say, 100, Stylus Studio would convert that value to **Continue** in the XML document it outputs; values of 202 would be converted to **Accepted**; and so on.

Input file values that do not match a lookup are emitted in the XML document as-is, allowing exceptional values to be decoded. For example, you might have a temperature lookup list with these values for a `<Temperature>` field:

- 32 | Freeze
- 212 | Boil

All other temperatures would be emitted as-is.
Defining Lookup Lists

Lookups are case-sensitive, so, for example, a lookup of BMW would not match any of the Make fields in the following sample file:

```
Make,Model,Year,Mileage
BMW,R1150RS,2004,14274
Kawasaki,GPz1100,1996,60234
Ducati,ST2,1997,24000
Moto Guzzi,LeMans,2001,12393
BMW,R1150R,2002,17439
Ducati,Monster,2000,15682
Aprilia,Futura,2001,17320
```

You can define lookup lists only for fields in rows for which a match pattern (even a blank match pattern, as is the default) exists. Finally, you can paste comma- and tab-delimited text directly into the lookup list. This allows you to easily reuse existing lookup tables without having to re-enter text.

1. Select a row for which a match pattern exists.
2. Click the Lookup List entry field in the Properties window.

   The Lookup List dialog box appears.

   ![Figure 193. Lookup List Dialog Box](image)

3. Enter lookup/value pairs in the corresponding entry fields.
4. When you are done, click OK.
Working with Lookup Lists

The following table summarizes the functions of the Lookup List dialog box, which allow you to work with new and existing lookup lists.

Table 21. Lookup List Dialog Box Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Commits the lookup list to the adapter.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Lookup List dialog box without committing any changes.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the lookup list.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes comma- and tab-separated text into the lookup list. Replaces existing content, regardless of which row you have selected.</td>
</tr>
<tr>
<td>Append</td>
<td>Adds comma- and tab-separated text to the end of the lookup list. Existing lookup list content is preserved.</td>
</tr>
<tr>
<td>Insert</td>
<td>Adds a new row to the lookup list.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected row from the lookup list.</td>
</tr>
</tbody>
</table>

Note: Copy, Paste, and Append use the system clipboard and insert at the current cursor location. Any blank rows are discarded when you save the lookup list.

Using Key=Value Characters

The Key=Value Character Region property allows you to set the separator for key=value pairs as seen in the input file. When Stylus Studio converts an input file to XML, it uses the value on the left side of the key=value character for the element name, and the value on the right for the element value. Consider the following input file:

```
Triumph Inventory, Year and Quantity
Yr2003=24
Yr2004=12
Yr2005=15
```
Creating an Adapter

This section describes how to create and save an adapter (.conv file) using the Convert to XML module.

Tip  Stylus Studio comes bundled with built-in adapters for numerous file formats, including EDI, CSV, dBase, and Windows .ini files. These adapters automate the conversion process, and can be quicker and easier to use than building a custom adapter using the Convert to XML module. See “Built-In Adapters” on page 282 for more information.

Specifying File Settings

When you create a new adapter, Stylus Studio prompts you to specify the file you want to convert. It also allows you to specify the file’s

- Encoding (Windows-1252 or ANSI, for example)
- Layout (line-oriented or fixed-width, for example)

Unless you are certain of the file’s encoding and layout, consider leaving the default settings as they are — Stylus Studio will determine encoding and layout properties when it reads the file.

If you set the Key=Value Character property to =, Stylus Studio creates the following XML document when you preview the adapter:

```xml
<?xml version="1.0" encoding="utf-8"?>
<root>
  <row>
    <field>Triumph Inventory</field>
    <field>Year and Quantity</field>
  </row>
  <row>
    <Yr2003>24</Yr2003>
  </row>
  <row>
    <Yr2004>12</Yr2004>
  </row>
  <row>
    <Yr2005>15</Yr2005>
  </row>
</root>
```
How to Create an Adapter

1. Select **File > New > Convert to XML** from the Stylus Studio menu. The New Converter dialog box appears.

   ![New Converter Dialog Box]

   **Figure 194. New Converter Dialog Box**

2. Click the browse button ( ) and select the file you want to use to configure the conversion settings.

   The **Open** dialog box appears. By default, the **Files of Type** field filter is set to display .txt, .edi, .csv, .tab, .log, and .bin files.

   **Tip** The file you select should be representative of other files of this type that you wish to convert to XML.
3. Click the **Open** button.
   Stylus Studio displays the file URL in the first field of the **New Converter** dialog box.

4. Optionally, change the default file encoding and layout settings.

5. Click **OK**.
   Stylus Studio displays the file you selected in the Convert to XML Editor.

6. Examine the file and its properties as it was read into the Convert to XML Editor by Stylus Studio.

7. Modify the file layout, its regions, and its fields as needed. See “Working with Regions” on page 253 and “Working with Fields” on page 260 if you need help with this step.

8. Modify the properties that govern XML output as needed. See “Controlling XML Output” on page 268 if you need help with this step.

9. Click the **Preview Results** button ( ).
   Stylus Studio displays the **Save As** dialog box.

10. Enter a name for the adapter and click **Save**.

11. If the results are not what you expect, return to step 7 and to step 8. You might also considering revisiting the input file, making fundamental changes there, and reloading it.

---

**Using Adapters in Stylus Studio**

You can use adapters to open any file as XML anywhere in Stylus Studio. For example, you might want to use a text file (.txt) as the source document for XQuery Mapper. When you open a file using an adapter, the adapter engine converts that file to XML on-the-fly, using the settings defined in the adapter you select.

You can also use the Stylus Studio Java API to invoke an adapter programmatically to convert any file using the adapter you specify. See “Invoking an Adapter Programmatically” on page 917 for more information on this topic.
Built-In Adapters

In addition to the adapters you create using the Convert to XML module (.conv files), Stylus Studio comes bundled with numerous predefined adapters to assist you in converting files to XML documents. You can use these adapters to convert many common file formats, such as EDI, CSV, dBase, RTF, and Windows .ini files. The process for using user-defined and built-in adapters is essentially the same, as described in the following section, “How to Open a File Using an Adapter” on page 284.

Stylus Studio currently provides the following adapters, all of which are bidirectional, with the exception of mBox and WinWrite, which operate only as native-to-XML.

Table 22. Adapters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base-64</td>
<td>Converts a binary file into a Base-64 one-element file. This adapter can be useful for converting binaries that are to be included within another file.</td>
<td>“Base-64 Adapter Properties” on page 935</td>
</tr>
<tr>
<td>Binary</td>
<td>Converts a binary file into a hex-encoded one-element file. This adapter can be useful for converting binaries that are to be included within another file.</td>
<td>“Binary Adapter Properties” on page 943</td>
</tr>
<tr>
<td>CSV</td>
<td>Converts a comma-separated text file to XML, and vice versa.</td>
<td>“Comma-Separated and Tab-Separated Values Adapter Properties” on page 936</td>
</tr>
<tr>
<td>dBase_II, dBase_III, dBase_III_plus, dBase_IV, dBaseV</td>
<td>Converts dBase database management system files to XML, and vice versa.</td>
<td>“dBase Adapter Properties” on page 937</td>
</tr>
<tr>
<td>DIF</td>
<td>Converts Data Interchange Format files to XML, and vice versa. Sometimes used for spreadsheet interchange.</td>
<td>“DIF, SDI, SLK Adapter Properties” on page 938</td>
</tr>
<tr>
<td>DotD</td>
<td>Converts Progress OpenEdge text dump files to XML, and vice versa.</td>
<td>“Properties for Other Adapters” on page 946</td>
</tr>
<tr>
<td>EDI</td>
<td>Recognizes and decodes EDIFACT and X12 files to XML, and vice versa.</td>
<td>“EDI Adapter Properties” on page 939</td>
</tr>
</tbody>
</table>
### Table 22. Adapters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>HtmlTidy</td>
<td>Uses Jtidy to convert HTML to XHTML, and vice versa.</td>
<td>“HtmlTidy Adapter Properties” on page 944</td>
</tr>
<tr>
<td>JavaProps</td>
<td>Converts a Java .properties file to XML, and vice versa.</td>
<td>“Properties for Other Adapters” on page 946</td>
</tr>
<tr>
<td>Line</td>
<td>When converting text to XML, wraps each line of the incoming file with an XML tag; when converting XML to text, it writes each tag of depth two’s content as a line.</td>
<td>“Whole-line Text Adapter Properties” on page 945</td>
</tr>
</tbody>
</table>
| MBox     | Parses the .mbox file and wraps the header and body of a text message with an XML tag. The MBox adapter can be used for mbox-to-XML conversion only. Supports MIME attachments – any message attachments are properly decoded and rendered as XML. Specifically:  
  - Text and plain attachments are embedded as text  
  - Binary attachments are embedded as hex-encoded data  
  - XML-encoded attachments are emitted as escaped text | “Properties for Other Adapters” on page 946                                                                       |
| RTF      | Reads an RTF file, and converts RTF tags to XML, and vice versa.                                                                                                                                          | “Properties for Other Adapters” on page 946                                                                       |
| SDI      | Super Data Interchange (SDI) is a later version of DIF.                                                                                                                                                   | “DIF, SDI, SLK Adapter Properties” on page 938                                                                    |
| SYLK     | Converts Microsoft SYmbolic LinK format files, used for spreadsheet interchange, to XML, and vice versa.                                                                                                  | “DIF, SDI, SLK Adapter Properties” on page 938                                                                    |
How to Open a File Using an Adapter

You can use the Open dialog box to open a file using an adapter in Stylus Studio.

1. Display the Open dialog box (select File > Open from the Stylus Studio menu, for example).
2. Navigate to the directory that contains the file you want to open using the adapter and select the file.
3. Check the Convert to XML using adapter check box and click the Open button.

---

Table 22. Adapters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB</td>
<td>Converts a tab-separated text file to XML, and vice versa</td>
<td>“Comma-Separated and Tab-Separated Values Adapter Properties” on page 936</td>
</tr>
<tr>
<td>WinIni</td>
<td>Converts a Windows .ini file to XML, and vice versa.</td>
<td>“Properties for Other Adapters” on page 946</td>
</tr>
<tr>
<td>WinWrite</td>
<td>Converts Windows WinWrite .wri files to XML.</td>
<td>“Properties for Other Adapters” on page 946</td>
</tr>
</tbody>
</table>

---

Figure 195. Check Box to Open Files Using Adapter
Stylus Studio displays the **Select XML Converter** dialog box.

4. If you are using a user-defined adapter, expand the **Convert to XML Definitions** tree and select the adapter you want to use to convert the file you selected in step 2 to XML and go to step 6.

If you are using a built-in adapter, select the adapter you want to use and go to step 5.
Converting Non-XML Files to XML

5. Specify the values you want to use for translation purposes. Many fields have a drop-down list that displays valid values, like the Line Separator property for the Comma-Separated Values converter shown here:

![Select XML Converter](image)

**Figure 198. Built-In Converters Display Valid Properties**

See “Adapter Properties” on page 934 for information on properties for specific adapters.

6. Click **OK**.

   The file is converted to XML and appears in the editor from which you displayed the **Open** dialog box in step 1.

**Tip** You can use the same basic procedure, from the **Save As** dialog box, to save a file using an adapter.

More About Converting EDI

You can convert EDI to XML in Stylus Studio using the

- Built-in Electronic Data Interchange (EDI) adapter to convert the files automatically
- Convert to XML module to define the adapter manually

This section describes more about the level of support for converting EDI to XML (and vice versa) in Stylus Studio.

**Watch it!** You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the EDI to XML Mapping video.

A complete list of the videos demonstrating Stylus Studio’s features is here:


This section covers the following topics:
More About Converting EDI

- “Understanding Separator Characters” on page 287
- “Using the Built-In EDI Adapter to Convert EDI to XML” on page 290
- “Using Convert to XML to Convert EDI to XML” on page 291
- “Validating XML from/to EDI” on page 291

Supported EDI Dialects

Stylus Studio supports the following EDI dialects:

- EDIFACT
- IATA
- X12

For information on specific version support, see the Stylus Studio readme.htm in the \doc directory where you installed Stylus Studio.

Understanding Separator Characters

EDI files consist of tokens separated by special characters. Separators typically include the following:

- Segment terminators
- Element separators
- Component separators
- An optional secondary component separator
- A release (or, escape) character
- A decimal symbol
- A repeat symbol

Values for some of these separators are set explicitly in the EDI data stream. For example, in X12, the component separator is the value of the ISA16 field – the "I15: Component Element Separator." In EDIFACT, separator values can be set using the contents of the UNA segment.

How Stylus Studio Sets Separator Characters

When writing XML to EDI, Stylus Studio overwrites separator values using a set of processing instructions (PIs). As long as the character has not been emitted to the output
stream, it can be changed. For example, the segment terminator can be changed using the PI only \textit{before} the first segment is written.

\textbf{Note} \hspace{1em} In X12, since the I15 element contains the component separator, it cannot be set by a PI as one value would conflict with the other.

\textbf{Invalid Separator Characters}

You cannot use any of the following characters as EDI separators:

- Spaces
- Alphabetical characters
- Numeric characters

\textbf{Setting Processing Instruction}

Stylus Studio uses the following naming convention and default values for XML processing instructions used to set values for separator characters:

\textbf{Table 23. Processing Instructions for Separator Characters}

<table>
<thead>
<tr>
<th>Name</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>edi_segment</td>
<td>'</td>
</tr>
<tr>
<td>edi_release</td>
<td>?</td>
</tr>
<tr>
<td>edi_element</td>
<td>+</td>
</tr>
<tr>
<td>edi_component</td>
<td>:</td>
</tr>
<tr>
<td>edi_repeat</td>
<td>~</td>
</tr>
<tr>
<td>edi_decimal</td>
<td>,</td>
</tr>
<tr>
<td></td>
<td>Note that the decimal character is read from the underlying platform default. If no default is set, the EDIFACT standard specifies a comma.</td>
</tr>
<tr>
<td>edi_tertiary</td>
<td>&amp;</td>
</tr>
</tbody>
</table>

If a PI is used to set the value for one separator (say, A) to a default value being used by another separator (B), a new value will be chosen for the B separator unless one has already been specified.
Syntax

The syntax of the PI is just "<?" followed by the name, followed by a space, and then the new special character before a closing "?>" tag. Consider a few examples:

```xml
<?edi_segment \n?>
<?edi_release \}\n>
<?edi_element $?>
<?edi_component \x0001?>
<?edi_decimal .?>
```

Here is another example, showing PIs used in context. In this example, an X12 document needed to be written to meet the following requirements: the segment terminator needed to be a carriage return; the element separator needed to be an asterisk; and the component separator needed to be a greater-than symbol. The two PIs and the Component Element Separator are shown in bold for clarity:

```xml
<?xml version="1.0" encoding="utf-8"?>
<?edi_segment \r?>
<?edi_element *?>
<X12>
  <ISA>
    <ISA01>!!--I01: Authorization Information Qualifier-->00</ISA01>
    <ISA02>!!--I02: Authorization Information)--></ISA02>
    <ISA03>!!--I03: Security Information Qualifier-->00</ISA03>
    <ISA04>!!--I04: Security Information--></ISA04>
    <ISA05>!!--I05: Interchange ID Qualifier-->01</ISA05>
    <ISA06>!!--I06: Interchange Sender ID--->1515151515</ISA06>
    <ISA07>!!--I07: Interchange ID Qualifier-->01</ISA07>
    <ISA08>!!--I07: Interchange Receiver ID--->5151515151</ISA08>
    <ISA09>!!--I08: Interchange Date--->041201</ISA09>
    <ISA10>!!--I09: Interchange Time--->1217</ISA10>
    <ISA11>!!--I10: Repetition Separator--->U</ISA11>
    <ISA12>!!--I11: Interchange Control Version--->00403</ISA12>
    <ISA13>!!--I12: Interchange Control Number--->000032123</ISA13>
    <ISA14>!!--I13: Acknowledgment Requested--->0</ISA14>
    <ISA15>!!--I14: Usage Indicator--->P</ISA15>
    <ISA16>!!--I15: Component Element Separator---></ISA16>
  </ISA>
</X12>
```

If the segment terminator (edi_segment) is set to \r or \n, consider disabling the default value (specified in the URI) of adding end-of-line characters to each segment. Otherwise, the EDI output will have double endings. To do this, change `eol=yes` to `eol=no` in the URI. For more information, see “Adapter Properties” on page 934.
Ways to Specify Control Characters

In addition to literal characters, you can also specify control characters using a backslash syntax, as shown here.

Table 24. Backslash Syntax for Control Characters

<table>
<thead>
<tr>
<th>Control Character</th>
<th>Backslash Syntax</th>
<th>Hex Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace</td>
<td>\b</td>
<td>0x08</td>
</tr>
<tr>
<td>Formfeed</td>
<td>\f</td>
<td>0x0C</td>
</tr>
<tr>
<td>Linefeed</td>
<td>\n</td>
<td>0x0A</td>
</tr>
<tr>
<td>Carriage return</td>
<td>\r</td>
<td>0x0D</td>
</tr>
<tr>
<td>Tab</td>
<td>\t</td>
<td>0x09</td>
</tr>
<tr>
<td>Specify character in octal</td>
<td>[0-7]</td>
<td>n/a</td>
</tr>
<tr>
<td>Specify character in decimal</td>
<td>#[0-9]</td>
<td>n/a</td>
</tr>
<tr>
<td>Specify character in hexadecimal</td>
<td>\x[0-9A-F]</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Using the Built-In EDI Adapter to Convert EDI to XML

The Electronic Data Interchange (EDI) adapter allows you to convert EDI to XML, and vice versa. It handles most versions of EDI standard vocabularies (EDI, X12, and IATA) automatically, and it optionally performs validation of content, structure, and code list values.

See “EDI Adapter Properties” on page 939 for information about adapter settings that affect how EDI is converted to XML.

Where to Find It

As with other adapters, you can access the Electronic Data Interchange (EDI) adapter in the Select XML Converter dialog box, which appears when you open a file using the Convert to XML using adapter check box on the Open dialog box. The Select XML Converter dialog box allows you to modify the default property settings.
Using Convert to XML to Convert EDI to XML

As described earlier in this chapter (see The Convert to XML Editor on page 240), Stylus Studio’s Convert to XML module has a user interface that provides you with complete control over how files, including EDI, are converted to XML. In the case of EDI files, EDIFACT, X12, and HL7 delimiter rules are handled automatically, and you can easily manage non-standard segments and extensions to other existing standards. The Convert to XML module also allows you to customize names for the fields in the output document and use regular expressions to filter the document’s content.

The Convert to XML module is a useful way to jump-start EDI-to-XML conversion. If your needs include bi-directional conversion (XML-to-EDI as well as EDI-to-XML), consider using Stylus Studio’s built-in Electronic Data Interchange (EDI) adapter.

Validating XML from/to EDI

If you plan to use the Electronic Data Interchange (EDI) adapter to convert XML to EDI, you can use the EDIFACT to XML Schema document wizard to create an XML Schema based on a specific EDIFACT message type. This allows you to ensure that the EDI created by the Electronic Data Interchange (EDI) adapter conforms to the EDIFACT message type standard.

You can also XML Schema created by the EDIFACT to XML Schema document wizard to validate data after you have converted EDI to XML, when URL-based error checking is disabled, to determine how well the incoming stream conforms to the EDIFACT standards.

See Creating XML Schema from EDIFACT Messages on page 512 for more information on using this document wizard.

User-Defined Adapters Properties Reference

This section provides reference information for properties displayed in the Properties window of the Convert to XML Editor. It covers the following topics:

- “Input File Properties” on page 292
- “XML Output URL Properties” on page 293
- “Region Type Properties” on page 294
- “Row Element Name Properties” on page 297
- “Field Element Name Properties” on page 298
## Input File Properties

### Table 25. Input File Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input File</td>
<td>The URL of the file you are using as the input file.</td>
<td>Yes. You can select a new input file from this field.</td>
<td>No</td>
</tr>
<tr>
<td>Input Encoding</td>
<td>Encoding detected by Stylus Studio.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Physical Size</td>
<td>The size of the input file in bytes.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Portion Loaded</td>
<td>The size of the input file in bytes loaded into Stylus Studio.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Characters Loaded</td>
<td>The number of characters loaded. For especially large files, Stylus Studio does not read the entire file as only a sample is required to define an adapter. The finished adapter, however, reads any file you open it with in its entirety.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Character Unicode Value</td>
<td>The Unicode value of the character under the cursor.</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
## XML Output URL Properties

**Table 26. XML Output File Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Output URL</td>
<td>The URL to which you want the XML output when the adapter is run. Optional. If no value is specified, stdout is used.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Output Encoding</td>
<td>The Encoding you want to use for the XML output by the adapter. The default is RAW.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Root Element Name</td>
<td>The name you want to assign to the root element in the XML output. Optional.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Namespace Prefix</td>
<td>The string you want to use for the namespace prefix in the XML output. Optional</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Namespace</td>
<td>The namespace you want to use for the XML document output by the adapter.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DOCTYPE System ID</td>
<td>The URL of the System DTD you want to associate with the XML document output by the adapter.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DOCTYPE Public ID</td>
<td>The Public ID of the DTD you want to associate with the XML document output by the adapter.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>XML Schema Document</td>
<td>The URL of the XML Schema document you want to associate with the XML document output by the adapter.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Converting Non-XML Files to XML

Table 26. XML Output File Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Schema Namespace</td>
<td>The namespace you want to use with the XML Schema document.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Indent XML?</td>
<td>Whether or not you want to indent the XML output.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Region Type Properties

Note Each region has its own field and row properties. In addition, some properties apply only to line-oriented regions. These properties are marked with an asterisk.

Table 27. Region Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region Type</td>
<td>The type of the region that currently has focus.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Region Element Name</td>
<td>The name you want to assign to this region in the XML output. Optional.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Element Name Source</td>
<td>Whether the source for the element names in this region is user-supplied,</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>is taken from the first row in the region, or is based on the WS-EDI</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>standard.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rows to Skip</td>
<td>The number of rows, starting at the beginning of the region, you want to</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>omit from output.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit from Output</td>
<td>Whether or not you want to omit the entire region from output.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 27. Region Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>The region’s size in characters.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Portion of File</td>
<td>The starting and ending offsets of the current region.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Row Count</td>
<td>The number of rows in the current region.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Row Length*</td>
<td>The number of characters in the current row.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Line Terminator*</td>
<td>The type of line terminator character detected by Stylus Studio.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Separator*</td>
<td>The type of field separator character detected by Stylus Studio.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Delimiter Pairs*</td>
<td>Sets of delimiting characters detected by Stylus Studio.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Comment String</td>
<td>String used by the Convert to XML adapter – if the beginning of a row</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>matches the string in this field, the adapter interprets the row as a</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>comment and does not output it in the XML.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Escape Characters*</td>
<td>Allows you to distinguish escape characters from separators – if a</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>character in the input file is preceded by an Escape Character, that</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>character is not treated as delimiting character, separator, or</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>subsequent escape character.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toss Characters*</td>
<td>Characters outside delimiting characters that should be ignored.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 27. Region Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key=Value Character</td>
<td>Allows you to set the separator for key=value pairs as seen in the input file.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Component Separator*</td>
<td>The type of character used to separate sub-fields detected by Stylus Studio. If this character appears in a string, the string is split into sub-fields when the input file is converted to XML.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sub-Component Separator*</td>
<td>The type of character used to separate sub-fields detected by Stylus Studio. If this character appears in a string, the string is split into sub-fields when the input file is converted to XML.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Region Terminator</td>
<td>The type of region terminator character detected by Stylus Studio. The region will be processed until this string is encountered; after that point, all remaining data in the region is skipped. The next region, if present, will be handled immediately.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Collapse Consecutive Field Separators*</td>
<td>Whether or not multiple consecutive field separators should be treated as one. For example, if this property is set to <strong>Yes</strong>, <code>x,,Y,,Z</code> is treated as <code>x,Y,Z</code>. This property is most useful when spaces are used as delimiting characters.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Double Delimiter to Escape</td>
<td>Whether or not to treat a pair of delimiting characters within a delimited string as escaped characters. For example, if this property is set to <strong>Yes</strong>, “abc”“xyz” is treated as <code>abc``xyz</code>.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
* This property is for line-oriented regions only.
+ This property is for fixed-width regions only.

**Row Element Name Properties**

**Table 28. Row Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Element Name</td>
<td>The name you want to assign to all rows in the region. The default value is row.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Match Pattern</td>
<td>A regular expression you can use to filter rows in a region. Only rows that match the pattern you specify are output to XML.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Current Row Length</td>
<td>The length of the current row.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Fields in Current Row</td>
<td>The number of fields in the current row.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Max Fields in Row</td>
<td>The number of fields in the row that contains the largest number of fields.</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Field Element Name Properties

**Note** Each region has its own field and row properties. In addition, some properties apply only to line-oriented regions. These properties are marked with an asterisk.

Table 29. Field Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Element Name</td>
<td>The name you want to use for field elements in the XML output. The default value is field.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Component Element Name</td>
<td>The name you want to use for sub-fields detected by Stylus Studio (based on the Component Separator character) in the XML output. The default value is component.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sub-Component Element Name</td>
<td>The name you want to use for sub-fields detected by Stylus Studio (based on the Sub-Component Separator character) in the XML output. The default value is subcomponent.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Source Data Type</td>
<td>The data type of the current field. Stylus Studio provides support for the following data types: String, Boolean, number, date, time, byte, short, integer, long, float, double. Note that some properties are type-specific. See “Type-Specific Properties” on page 299 for information on properties that are associated with specific data types.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Target Data Type</td>
<td>Not currently used.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 29. Field Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Editable</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number of the field in which the cursor is located. Starting with 1 from the left-most field.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Cursor Position</td>
<td>The offset of the cursor's current location from the start of the current field.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Offset</td>
<td>The offset of the start of the current field. Measured from the start of the row.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the current field in characters.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Max Field Length*</td>
<td>The length of the longest of all the instances of this field.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the current field. This value also appears in the status bar.</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

* This property is for line-oriented regions only.

Type-Specific Properties

This section describes the properties that are specific to a given data type.

Table 30. Type-Specific Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architecture</td>
<td>BCD</td>
<td>Specifies the architecture type for Binary Coded Decimal (BCD).</td>
<td>Yes</td>
</tr>
<tr>
<td>Base</td>
<td>Number</td>
<td>The numeric base of the number. Decimal (base 10) is assumed by default, but base 2 through base 36 are recognized.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 30. Type-Specific Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘C’ rules for octal and hex</td>
<td>Number</td>
<td>Determines how numeric values are treated. If this property is set to True and the value begins with 0x, the value is treated as hexadecimal (base 16). If the value begins with 0, it is treated as octal (base 8). Otherwise, it is treated as base 10.</td>
<td>Yes</td>
</tr>
<tr>
<td>Decimal</td>
<td>Number</td>
<td>The decimal separator character. Defaults to the standard platform symbol, which is typically a period or comma.</td>
<td>Yes</td>
</tr>
<tr>
<td>Endian</td>
<td>Double, Float, Integer, Long, Short</td>
<td>Determines whether the first byte in binary multi-byte values is the least significant (Little) or the most significant (Big). The default is Little, which is the native mode on Stylus Studio platforms.</td>
<td>Yes</td>
</tr>
<tr>
<td>● False Output As</td>
<td>Boolean</td>
<td>Strings output based on matching strings specified in the False Value Match List and True Value Match List.</td>
<td>Yes</td>
</tr>
<tr>
<td>● True Output As</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Unknown Output As</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Table 30. Type-Specific Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>False Value Match List</td>
<td>Boolean</td>
<td>Semicolon-separated lists of values. If the field value matches a string specified in the False Value Match List, the string specified in the False Output As property is output; likewise for values that match those specified in the True Value Match List. If there are no matches with either the false or true match lists, the value specified in the Unknown Output As property is output.</td>
<td>Yes</td>
</tr>
<tr>
<td>True Value Match List</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Format

<table>
<thead>
<tr>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Specifies the order of the day, month, and year in date strings. Convert to XML can determine date format if names are used for months. Dates are recognized in many formats, with and without delimiting characters, including: MMDDYY MMDDYYYY DDMYY DDMYYYY YYMMD DYYYYMMDD MM-DD-YY MM-DD-YYYY DD-MM-YY DD-MM-YYYY YY-MM-DD YYYY-MM-DD YYJJJJ YYYYJJJJ YY-JJJJ YY-JJJJ</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 30. Type-Specific Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Left Padding</td>
<td>Boolean, Date, Number, String, Time</td>
<td>Allows you to specify characters you want removed from the left and right sides, respectively, of a field. Applies to characters within delimiting characters.</td>
<td>Yes</td>
</tr>
<tr>
<td>● Right Padding</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lookup List</td>
<td>All</td>
<td>Allows you to specify a list of lookups and associated values. Values are substituted for the lookup when the input file is converted to XML.</td>
<td>Yes</td>
</tr>
<tr>
<td>Normalize White Space</td>
<td>String</td>
<td>Converts any tabs, linefeeds, or carriage returns to spaces. Also removes leading and trailing white space and collapses consecutive white space characters to a single space. The default is False.</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>All</td>
<td>Allows you to add internal comments for a field.</td>
<td>No</td>
</tr>
<tr>
<td>Omit from Output</td>
<td>All</td>
<td>Allows a field to be omitted from XML output based on its presence or value. Valid values include:</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Only When Empty. This is the default.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● When Empty or Zero.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Always</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Never</td>
<td></td>
</tr>
<tr>
<td>Packed</td>
<td>BCD</td>
<td>For Binary Coded Decimal (BCD) fields, whether or not it is packed.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Table 30. Type-Specific Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaling Factor($10^n$)</td>
<td>BCD, Byte, Comp3, Double, Float, Integer, Long, Number, Short, Zoned</td>
<td>Scales a number by moving the decimal point. Use a positive value to move the decimal point to the left; use a negative value to move the decimal point to the right. To enter a scaling factors from $10^{-16}$ to $10^{16}$, just enter the exponent value. Example: Entering an exponent of 3 will cause any numbers to be multiplied by 1000 ($10^3$) before being output to XML.</td>
<td>Yes</td>
</tr>
<tr>
<td>Separator</td>
<td>Date, Time</td>
<td>Character used to separate date and time components. Date values commonly use spaces, slashes, dashes, and periods; time values commonly use colons, periods, and spaces. The platform setting is used by default.</td>
<td>Yes</td>
</tr>
<tr>
<td>Signed</td>
<td>Byte, Integer, Long, Short</td>
<td>Whether the numeric form is signed or unsigned.</td>
<td>Yes</td>
</tr>
<tr>
<td>Thousands Separator</td>
<td>Number</td>
<td>Character used to separate thousands. Typically a comma, though periods, spaces, and other characters can be used. Defaults to the platform symbol.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Specifying Control Characters

Lists of symbols are used to designate characters for properties like Field Component Separator, Line Terminator, and Field Separator.

Individual symbols can be expressed in several forms. Numbers and letters, for example, can be entered using single quotes, such as ‘A’, ‘B’, ‘C’. Control characters or other Unicode values can be expressed using their decimal value, or their hex value by preceding it with 0x – 128 or 0x80, for example. In addition, certain control characters have alternate mnemonic representations, and Stylus Studio supports them, as well.

When entering multiple symbols for a given property, separate symbols using a comma.

### Table 30. Type-Specific Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Applies to Data Type</th>
<th>Description</th>
<th>Affects XML</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Currency Conventions</td>
<td>Number</td>
<td>Determines whether values are treated as positive or negative. If the value contains DR or DB (or dr or db), it is treated as positive. If it contains CR or cr, or is surrounded by parentheses, it is treated as a negative.</td>
<td>Yes</td>
</tr>
<tr>
<td>Window for Two-Digit Years</td>
<td>Date</td>
<td>Allows you to specify the century start-date for years that use a two-digit format. For example, if you enter 1950, years with a value from 50-99 will be output as 1950-1999; years with a value of 00-49 will be output as 2000-2049.</td>
<td>Yes</td>
</tr>
<tr>
<td>XML Output Form</td>
<td>All</td>
<td>Whether to output the current row value as a child element or attribute of the <code>&lt;row&gt;</code> element. The default is element. If this field is set to True, components and subcomponents within that value are not recognized, so the entire field is used as the attribute value, instead of being broken up.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
The following table summarizes commonly used control characters. For more information, visit http://www.unicode.org.

**Table 31. Commonly Used Control Characters**

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Hex</th>
<th>Mnemonic</th>
<th>Control Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0x00</td>
<td>NUL</td>
<td>^@, '\0'</td>
</tr>
<tr>
<td>1</td>
<td>0x01</td>
<td>SOH</td>
<td>^A</td>
</tr>
<tr>
<td>2</td>
<td>0x02</td>
<td>STX</td>
<td>^B</td>
</tr>
<tr>
<td>3</td>
<td>0x03</td>
<td>ETX</td>
<td>^C</td>
</tr>
<tr>
<td>4</td>
<td>0x04</td>
<td>EOT</td>
<td>^D</td>
</tr>
<tr>
<td>5</td>
<td>0x05</td>
<td>ENQ</td>
<td>^E</td>
</tr>
<tr>
<td>6</td>
<td>0x06</td>
<td>ACK</td>
<td>^F</td>
</tr>
<tr>
<td>7</td>
<td>0x07</td>
<td>BEL or BELL</td>
<td>^G, '\a'</td>
</tr>
<tr>
<td>8</td>
<td>0x08</td>
<td>BS</td>
<td>^H, '\b'</td>
</tr>
<tr>
<td>9</td>
<td>0x09</td>
<td>TAB or HT</td>
<td>^I, '\t'</td>
</tr>
<tr>
<td>10</td>
<td>0x0A</td>
<td>LF</td>
<td>^J, '\n'</td>
</tr>
<tr>
<td>11</td>
<td>0x0B</td>
<td>VT</td>
<td>^K, '\v'</td>
</tr>
<tr>
<td>12</td>
<td>0x0C</td>
<td>FF</td>
<td>^L, '\f'</td>
</tr>
<tr>
<td>13</td>
<td>0x0D</td>
<td>CR</td>
<td>^M, '\r'</td>
</tr>
<tr>
<td>14</td>
<td>0x0E</td>
<td>SO</td>
<td>^N</td>
</tr>
<tr>
<td>15</td>
<td>0x0F</td>
<td>SI</td>
<td>^O</td>
</tr>
<tr>
<td>16</td>
<td>0x10</td>
<td>DLE</td>
<td>^P</td>
</tr>
<tr>
<td>17</td>
<td>0x11</td>
<td>DC1 or XON</td>
<td>^Q</td>
</tr>
<tr>
<td>18</td>
<td>0x12</td>
<td>DC2</td>
<td>^R</td>
</tr>
<tr>
<td>19</td>
<td>0x13</td>
<td>DC3 or XOFF</td>
<td>^S</td>
</tr>
<tr>
<td>20</td>
<td>0x14</td>
<td>DC4</td>
<td>^T</td>
</tr>
<tr>
<td>21</td>
<td>0x15</td>
<td>NAK</td>
<td>^U</td>
</tr>
</tbody>
</table>
### Table 31. Commonly Used Control Characters

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Hex</th>
<th>Mnemonic</th>
<th>Control Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>0x16</td>
<td>SYN</td>
<td>^V</td>
</tr>
<tr>
<td>23</td>
<td>0x17</td>
<td>ETB</td>
<td>^W</td>
</tr>
<tr>
<td>24</td>
<td>0x18</td>
<td>CAN</td>
<td>^X</td>
</tr>
<tr>
<td>25</td>
<td>0x19</td>
<td>EM</td>
<td>^Y</td>
</tr>
<tr>
<td>26</td>
<td>0x1A</td>
<td>SUB</td>
<td>^Z</td>
</tr>
<tr>
<td>27</td>
<td>0x1B</td>
<td>ESC</td>
<td>^[</td>
</tr>
<tr>
<td>28</td>
<td>0x1C</td>
<td>FS</td>
<td>^\</td>
</tr>
<tr>
<td>29</td>
<td>0x1D</td>
<td>GS</td>
<td>^]</td>
</tr>
<tr>
<td>30</td>
<td>0x1E</td>
<td>RS</td>
<td>^^</td>
</tr>
<tr>
<td>31</td>
<td>0x1F</td>
<td>US</td>
<td>^_</td>
</tr>
<tr>
<td>127</td>
<td>0x7F</td>
<td>DEL</td>
<td></td>
</tr>
<tr>
<td>128</td>
<td>0x80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>129</td>
<td>0x81</td>
<td></td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>0x82</td>
<td>BPH</td>
<td></td>
</tr>
<tr>
<td>131</td>
<td>0x83</td>
<td>NBH</td>
<td></td>
</tr>
<tr>
<td>132</td>
<td>0x84</td>
<td>IND</td>
<td></td>
</tr>
<tr>
<td>133</td>
<td>0x85</td>
<td>NEL</td>
<td></td>
</tr>
<tr>
<td>134</td>
<td>0x86</td>
<td>SSA</td>
<td></td>
</tr>
<tr>
<td>135</td>
<td>0x87</td>
<td>ESA</td>
<td></td>
</tr>
<tr>
<td>136</td>
<td>0x88</td>
<td>HTS</td>
<td></td>
</tr>
<tr>
<td>137</td>
<td>0x89</td>
<td>HTJ</td>
<td></td>
</tr>
<tr>
<td>138</td>
<td>0x8A</td>
<td>VTS</td>
<td></td>
</tr>
<tr>
<td>139</td>
<td>0x8B</td>
<td>PLD</td>
<td></td>
</tr>
</tbody>
</table>
### Table 31. Commonly Used Control Characters

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Hex</th>
<th>Mnemonic</th>
<th>Control Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>140</td>
<td>0x8C</td>
<td>PLU</td>
<td></td>
</tr>
<tr>
<td>141</td>
<td>0x8D</td>
<td>RI</td>
<td></td>
</tr>
<tr>
<td>142</td>
<td>0x8E</td>
<td>SS2</td>
<td></td>
</tr>
<tr>
<td>143</td>
<td>0x8F</td>
<td>SS3</td>
<td></td>
</tr>
<tr>
<td>144</td>
<td>0x90</td>
<td>DCS</td>
<td></td>
</tr>
<tr>
<td>145</td>
<td>0x91</td>
<td>PU1</td>
<td></td>
</tr>
<tr>
<td>146</td>
<td>0x92</td>
<td>PU2</td>
<td></td>
</tr>
<tr>
<td>147</td>
<td>0x93</td>
<td>STS</td>
<td></td>
</tr>
<tr>
<td>148</td>
<td>0x94</td>
<td>CCH</td>
<td></td>
</tr>
<tr>
<td>149</td>
<td>0x95</td>
<td>MW</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>0x96</td>
<td>SPA</td>
<td></td>
</tr>
<tr>
<td>151</td>
<td>0x97</td>
<td>EPA</td>
<td></td>
</tr>
<tr>
<td>152</td>
<td>0x98</td>
<td>SOS</td>
<td></td>
</tr>
<tr>
<td>153</td>
<td>0x99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>154</td>
<td>0x9A</td>
<td>SCI</td>
<td></td>
</tr>
<tr>
<td>155</td>
<td>0x9B</td>
<td>CSI</td>
<td></td>
</tr>
<tr>
<td>156</td>
<td>0x9C</td>
<td>ST</td>
<td></td>
</tr>
<tr>
<td>157</td>
<td>0x9D</td>
<td>OSC</td>
<td></td>
</tr>
<tr>
<td>158</td>
<td>0x9E</td>
<td>PM</td>
<td></td>
</tr>
<tr>
<td>159</td>
<td>0x9F</td>
<td>APC</td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>0xA0</td>
<td>NBSP</td>
<td></td>
</tr>
<tr>
<td>173</td>
<td>0xAD</td>
<td>SHY</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 4  Working with XSLT

Stylus Studio provides many features for creating, updating, and applying stylesheets. This section of the documentation covers the following topics:

- “Getting Started with XSLT” on page 309
- “Tutorial: Understanding How Templates Work” on page 333
- “Working with Stylesheets” on page 345
- “Creating Stylesheets That Generate HTML” on page 363
- “Specifying Extension Functions in Stylesheets” on page 370
- “Working with Templates” on page 375
- “Using Third-Party XSLT Processors” on page 380
- “Validating Result Documents” on page 384
- “Post-processing Result Documents” on page 386
- “Generating Formatting Objects” on page 387
- “Generating Scalable Vector Graphics” on page 393
- “Generating Java Code for XSLT” on page 394
- “XSLT Instructions Quick Reference” on page 402

Getting Started with XSLT

This section provides an introduction to using Extensible Stylesheet Language Transformations (XSLT). It discusses the following topics:

- “What Is XSLT?” on page 310
- “What Is a Stylesheet?” on page 311
What Is XSLT?

The Extensible Stylesheet Language (XSL) is the World Wide Web Consortium's (W3C) language for manipulating XML data. XSLT is the component of XSL that allows you to write a stylesheet that you can apply to XML documents. The result of applying a stylesheet is that the XSLT processor creates a new XML, HTML, or text document based on the source document. The XSLT processor follows the instructions in the stylesheet. The instructions can copy, omit, and reorganize data in the source document, as well as add new data.

XSL is an XML-based language. It was developed by the W3C XSL working group within the W3C Stylesheets Activity. The W3C activity group has organized its specification of XSL into three parts:

- **XPath** specifies the syntax for patterns and expressions used in stylesheets. The XSLT processor uses an XPath expression to execute a query on the source document to determine which nodes to operate on. See Writing XPath Expressions on page 623.
- **XSLT** specifies the syntax for a stylesheet that you apply to one XML document to create a new XML, HTML, or text document.
- **XSL formatting object language** is an XML vocabulary for specifying formatting instructions.

What XSLT Versions Does Stylus Studio Support?

Stylus Studio 2006 supports XSLT 1.0 and XSLT 2.0. The Stylus Studio built-in XSLT processor is version aware, as is the XSLT Mapper. XSLT 2.0 was designed to work with XPath 2.0.

For more information on

- XSLT 1.0, go to [http://www.w3.org/TR/xslt](http://www.w3.org/TR/xslt)
- XSLT 2.0, go to [http://www.w3.org/TR/xslt/20](http://www.w3.org/TR/xslt/20)
To learn more about the changes from XSLT 1.0 to XSLT 2.0, go to http://www.w3.org/TR/xslt20/#changes.

What Is a Stylesheet?

A stylesheet is an XML document that contains instructions for generating a new document based on information in the source document. This can involve adding, removing, or rearranging nodes, as well as presenting the nodes in a new way.

This following topics provide more information:

- “Example of a Stylesheet” on page 311
- “About Stylesheet Contents” on page 314

Example of a Stylesheet

When you work with a stylesheet, three documents are involved:

- XML source document
- Result document, which can be HTML, XML, or text
- XSL stylesheet, which is also an XML document

For example, suppose you have the following XML document:

```xml
<?xml version="1.0"?>
<bookstore>
  <book>
    <author>W. Shakespeare</author>
    <title>Hamlet</title>
    <published>1997</published>
    <price>2.95</price>
  </book>
  <book>
    <author>W. Shakespeare</author>
    <title>Macbeth</title>
    <published>1989</published>
    <price>9.95</price>
  </book>
  <book>
    <author>D. Alighieri</author>
    <title>The Divine Comedy</title>
    <published>1321</published>
    <price>5.95</price>
  </book>
</bookstore>
```
You can use a stylesheet to transform this XML document into an HTML document that appears as follows in a Web browser:

![Example of Transformed XML](image)

**Figure 199. Example of Transformed XML**

The Web page in **Figure 199** is defined by the following HTML document:

```html
<html>  
<head>  
<title>Stylesheet Example</title> </head>  
<body>  
<table align="center" cellpadding="5">  
<tr><th>Title</th><th>Author</th><th>Price</th></tr>  
<tr><td>The Divine Comedy</td><td>D. Alighieri</td><td align="right">5.95</td></tr>  
<tr><td>Hamlet</td><td>W. Shakespeare</td><td align="right">2.95</td></tr>  
<tr><td>Macbeth</td><td>W. Shakespeare</td><td align="right">9.95</td></tr>  
</table> </body> </html>
```

The HTML document contains HTML markup that is not in the source document. In the HTML document, the data from the source document is not in the same order as it is in the XML source document. Also, this HTML document does not include some data that is in the XML source document. Specifically, the HTML document does not include information about the date of publication (the published elements).

To create this HTML file, the stylesheet contains two templates that provide instructions for

- Adding a table with a heading row
- Wrapping the contents of the title, author, and price elements in table cells
Following is a stylesheet that does this.

```xml
<?xml version = "1.0">
<xsl:stylesheet xmlns:xsl= "http://www.w3.org/1999/XSL/Transform" version="1.0">
  <xsl:output method="html"/>
  <xsl:template match="/">
    <html> <head> <title>Stylesheet Example</title></head> <body>
      <table align="center" cellpadding="5">
        <tr>
          <th>Title</th>
          <th>Author</th>
          <th>Price</th></tr>
        <xsl:apply-templates select="/bookstore/book">
          <xsl:sort select="author"/>
        </xsl:apply-templates>
      </table>
    </body> </html>
  </xsl:template>
  <xsl:template match="book">
    <tr>
      <td><xsl:value-of select="title"/></td>
      <td><xsl:value-of select="author"/></td>
      <td align="right">
        <xsl:value-of select="price"/>
      </td>
    </tr>
  </xsl:template>
</xsl:stylesheet>
```

**xsl:stylesheet** is an XSLT instruction. It must be the root element in a stylesheet in Stylus Studio.

**xsl:template** is an XSLT instruction. It contains literal data to be copied to the result document and XSLT instructions to be followed by the XSLT processor. The processor performs these steps for the source nodes identified by the match attribute value. In this template, the match attribute identifies the root node of the source document.

**xsl:output** is an XSLT instruction. In this stylesheet, it specifies that the result document will be in HTML.

**xsl:apply-templates** is an XSLT instruction. For each node identified by this instruction’s select attribute, the XSLT processor goes to another template in this stylesheet, and performs the actions defined in that template. When done, the processor returns here, and moves to the next line in this template. In this template, the select attribute identifies all book elements in the source document.

**xsl:value-of** is an XSLT instruction. The XSLT processor extracts the contents of the source node specified in the select attribute and copies it into the result document.

**xsl:sort** is an XSLT instruction. The XSLT processor processes the book nodes in alphabetical order by author.

**Namespace declaration for W3C XSLT namespace.**
About Stylesheet Contents

Stylesheets are XML documents. They contain a combination of

- XSLT elements and attributes. In the previous stylesheet, the XSLT elements are
  - “xsl:stylesheet” on page 435
  - “xsl:output” on page 427
  - “xsl:template” on page 436
  - “xsl:apply-templates” on page 404
  - “xsl:sort” on page 433
  - “xsl:value-of” on page 439

Each XSLT element is an instruction to the XSLT processor. For information about all XSLT instructions, see “XSLT Instructions Quick Reference” on page 402.

- Non-XSLT elements and attributes. In the previous stylesheet, these include the HTML elements that create the table.

The root element of a stylesheet must declare a namespace that associates a prefix with the URI for an XSLT processor. The URI in the namespace declaration in the previous example identifies the W3C standard XSLT processor. This declaration, shown again below, instructs the XSLT processor to recognize the XSLT elements and attributes by their xsl prefix:

```xml
xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
```

In this stylesheet, you must use the xsl prefix for all XSLT instructions.

Note

The Stylus Studio XSLT processor requires the namespace URI to be http://www.w3.org/1999/XSL/Transform. The prefix can be anything you want. Typically, it is xsl.

When you write a stylesheet, you specify the actions you want the XSLT processor to perform when it processes a particular source node. To do this, you define XSLT templates, which are described in the next section.

What Is a Template?

A template defines what the XSLT processor should do when it processes a particular node in the XML source document. The XSLT processor populates the result document by instantiating a sequence of templates. Instantiation of a template means that the XSLT processor

- Copies any literal data from the template to the result document
Getting Started with XSLT

- Executes the XSLT instructions in the template

The following topics further describe what a template is:
- Contents of a Template on page 315
- Determining Which Template to Instantiate on page 316
- How the select and match Attributes Are Different on page 317

Contents of a Template

The stylesheet example in “Stylesheet used” on page 312 defines the following templates using the xsl:template instruction:

```xml
<xsl:template match="/"
    <html><head><title>Stylesheet Example</title></head>
<body>
<table align="center" cellpadding="5">
<tr><th>Title</th><th>Author</th><th>Price</th></tr>
<xsl:apply-templates select="/bookstore/book">
    <xsl:sort select="author">
</xsl:apply-templates>
</table></body></html>
</xsl:template>
<xsl:template match="book">
<tr><td><xsl:value-of select="title"/></td>
<td><xsl:value-of select="author"/></td>
<td align="right"><xsl:value-of select="price"/></td>
</tr>
</xsl:template>
</table align="center" cellpadding="5">
```

In the xsl:template tag, the value of the match attribute is an XPath pattern. This pattern matches (identifies) a node or a set of nodes in the source XML document. The value of the match attribute is the template rule.

The template body defines actions you want the XSLT processor to perform each time it instantiates this template. It contains

- XSLT instructions you want the XSLT processor to follow; for example, xsl:apply-templates in the first template, and xsl:value-of in the second template.
- Elements that specify literal output you want the XSLT processor to insert in the result document. For example:

```xml
<table align="center" cellpadding="5">
```
Determining Which Template to Instantiate

When the XSLT processor applies a stylesheet to an XML document, it begins processing with the root node of the XML source document. To process the root node, the XSLT processor searches the stylesheet for a template rule that matches the root node. A template rule matches the root node when the value of the template’s `match` attribute is `"/"`.

If you explicitly defined a template rule that matches the root node, the XSLT processor finds it and instantiates its template. If the XSLT processor does not find an explicitly defined template rule that matches the root node, the processor instantiates the default template that matches the root node. Every stylesheet includes this default template.

In the sample stylesheet on “Stylesheet used” on page 312, the template rule in the first template matches the root node:

```xml
<xsl:template match="/"/>
```

The XSLT processor instantiates this template to start generating the result document. It copies the first few lines from the template to the result document. Then the XSLT processor reaches the following XSLT instruction:

```xml
<xsl:apply-templates select="/bookstore/book"/>
```

When the XSLT processor reaches the `select` attribute, it creates a list of all source nodes that match the specified pattern. In this example, the list contains book elements. The processor then processes each node in the list in turn by instantiating its matching template. First, the XSLT processor searches for a template that matches the first book element. The template rule in the second template matches the book element:

```xml
<xsl:template match="book">
```

After instantiating this template for the first book element, the XSLT processor searches for a template that matches the second book element. The XSLT processor instantiates the book template again, and then repeats the process for the third book element. That is, the XSLT processor searches for a matching template, and instantiates that template when it is found.

After three instantiations of the book template, the XSLT processor returns to the first template (the template that matches the root node) and continues with the line after the `xsl:apply-templates` instruction.
How the select and match Attributes Are Different

Consider the following instructions:

```xml
<xsl:apply-templates select="expression"/>
<xsl:template match="pattern"/>
```

The `xsl:apply-templates` instruction uses the `select` attribute to specify an XPath `expression`. The `xsl:template` instruction uses the `match` attribute to specify an XPath `pattern`.

When the XSLT processor reaches an expression that is the value of a `select` attribute, it evaluates the expression relative to the current node. The result of the evaluation is that the XSLT processor selects a set of nodes to be processed.

When the XSLT processor reaches a pattern that is the value of a `match` attribute, it evaluates the pattern alone. The result of the evaluation is that the XSLT processor determines whether or not the pattern matches the node already selected for processing.

For example, suppose you have the following instruction:

```xml
<xsl:apply-templates select="/bookstore/book"/>
```

This instruction selects the `book` elements for processing. For each `book` element, the XSLT processor searches for a template that matches the `book` element. The following template matches the `book` element because the pattern identifies all elements that contain `author` elements. Because `book` elements contain `author` elements, this template is a match:

```xml
<xsl:template match="/*[author]">
  <td><xsl:value-of select="author"/></td>
</xsl:template>
```

This example shows that the expression that the XSLT processor uses to select nodes and the pattern it uses to match nodes are independent of each other.

How the XSLT Processor Applies a Stylesheet

When the XSLT processor applies a stylesheet, it starts by automatically selecting the root node for processing and then searching for a template that matches the root node. The XSLT processor then iterates through the process of instantiating templates, selecting nodes in the source document for processing, and matching patterns, until no more templates need to be instantiated.
This section uses the sample stylesheet on “Stylesheet used” on page 312 to present this process in more detail in the following topics:

- Instantiating the First Template on page 318
- Selecting Source Nodes to Operate On on page 319
- Controlling the Order of Operation on page 320
- Omitting Source Data from the Result Document on page 321
- When More Than One Template Is a Match on page 322
- When No Templates Match on page 322

**Instantiating the First Template**

To apply a stylesheet, the XSLT processor searches for a template that matches the source document root. The XSLT processor then instantiates the matching template and begins to process it line by line.

The specific processing depends on the contents of the template that matches the root node. The parts of the template include

- XSLT instructions
- Literal result elements
- Literal result text

It is important to understand that the contents of the XML source document do not dictate the order of XSLT processing. The XSLT processor performs only those actions that you specify, and operates on only the source nodes that you select. For example:

```xml
<xsl:template match="/">
  <html><head><title>Stylesheet Example</title></head>
  <body>
    <table align="center" cellpadding="5">
      <tr><th>Title</th><th>Author</th><th>Price</th></tr>
      <xsl:apply-templates select="/bookstore/book"/>
    </table></body></html>
</xsl:template>
```

This template matches the root node. Consequently, the XSLT processor begins processing by instantiating this template. This means it processes each part of the template in the order in which it appears.

In the preceding example, the XSLT processor first copies the first four lines in the template body directly into the result document. Then it executes the `xsl:apply-templates` instruction. When execution of that instruction is complete, the XSLT
The XSLT processor continues processing this template with the last line in the template body. After that, processing of this template is complete, and processing of the stylesheet is also complete.

**Selecting Source Nodes to Operate On**

Aside from the root node, the XSLT processor operates on only those nodes in the source document that are selected as the result of executing an XSLT instruction. In a stylesheet, there are two XSLT instructions that select nodes in the source document for processing:

```xml
<xsl:apply-templates select = "expression"/>
<xsl:for-each select ="expression">
  template_body
</xsl:for-each>
```

The value of the `select` attribute is an XPath expression. To evaluate this expression, the XSLT processor uses the current source node as the initial context node. This is the node for which the instruction that contains the `select` attribute is being executed. For example, if this instruction is in the template that matches the root node, the root node is the current source node.

In an `xsl:apply-templates` or `xsl:for-each` instruction, the XSLT processor uses the `select` expression you specify plus the current source node to select a set of nodes. By default, the new list of source nodes is processed in document order. However, you can use the `xsl:sort` instruction to specify that the selected nodes are to be processed in a different order. See “xsl:sort” on page 433.

When the XSLT processor reaches an `xsl:apply-templates` instruction, the XSLT processor processes each node in the list of selected nodes by searching for its matching template and, if a matching template is found, instantiating it. In other words, the XSLT processor instantiates a template for each node if a matching template is found. The matching template might not be the same template for all selected nodes. If the XSLT processor does not find a matching template, it continues to the next selected node.

In an `xsl:for-each` instruction, the XSLT processor instantiates the embedded template body once for each node in the list of selected nodes.
Controlling the Order of Operation

Typically, the template that matches the root node includes an `xsl:apply-templates` instruction. When the XSLT processor executes the `xsl:apply-templates` instruction, it performs the following steps:

1. The processor evaluates the expression specified for the `xsl:apply-templates select` attribute to create a list of the source nodes identified by the expression.
2. For each node in the list, the XSLT processor instantiates the best matching template. (Template properties such as priority and mode allow multiple templates to match the same node.)
3. The processor returns to the template that contains the `xsl:apply-templates` instruction and continues processing that template at the next line.

It is important to note that in step 2, the matching template might itself contain one or more `xsl:apply-templates` instructions. As part of the instantiation of the matching template, the XSLT processor searches for a template that matches the nodes identified by the new `xsl:apply-templates` instruction. In this way, the XSLT processor can descend many levels to complete processing of the first selected node in the initial `xsl:apply-templates` instruction. The `xsl:apply-templates` instruction allows you to access any elements in the source document in any order.

Example

The sample template on “Instantiating the First Template” on page 318 contains the following `xsl:apply-templates` instruction:

```
<xsl:apply-templates select="/bookstore/book"/>
```

The `select` attribute specifies "/bookstore/book" as the expression. This selects the set of `book` elements in the source document as the nodes you want to process. For each selected node, the XSLT processor performs the following steps:

1. The XSLT processor searches the stylesheet for a template that matches "book".
2. When the XSLT processor finds the template that matches the book element, it instantiates it. The following template matches the book elements selected by the xsl:apply-templates instruction:

```xml
<xsl:template match="book">
  <tr><td><xsl:value-of select="title"/></td>
  <td><xsl:value-of select="author"/></td>
  <td align="right"><xsl:value-of select="price"/></td></tr>
</xsl:template>
```

3. The XSLT processor creates an HTML table row and executes the xsl:value-of instructions. These instructions insert the values for the matching book’s title, author, and price elements into the table.

The XSLT processor repeats this process for each book node. In other words, it instantiates this template three times, once for each book element in the source document.

It is important to note that the XSLT processor does not search for a matching template once and then instantiate that matching template for each selected element. Rather, the XSLT processor performs the search for a matching template for each node selected for processing. For each node selected for processing, the XSLT processor

- Searches for and chooses the best matching template
- Instantiates the chosen template

Another way to control the order of operation is to specify the xsl:if, xsl:choose, and xsl:when instructions. See “XSLT Instructions Quick Reference” on page 402.

**Omitting Source Data from the Result Document**

The XSLT processor operates on only those nodes that you specify. If a node in your XML source document is never referenced in a stylesheet, the XSLT processor never does anything with it.

For example, the sample source XML document on “Source XML document” on page 311 includes more than the title, author, and price for each book. It also includes the year of publication:

```xml
<book>
  <author>W. Shakespeare</author>
  <title>Hamlet</title>
  <published>1997</published>
  <price>2.95</price>
</book>
```
However, the template that matches the book element does not specify any processing for the published element. Consequently, the published elements do not appear in the result document.

**When More Than One Template Is a Match**

Sometimes, more than one template matches the node selected by an `xsl:apply-templates` instruction. In this situation, the XSLT processor chooses the best match. Which match is the best match depends on the template’s priority, mode, and order in the stylesheet. Priority, mode, and order are template properties that you can set.

- **Priority** – Priority is a numeric value, such as 1, 10, or 99. The higher the numeric value, the higher the template’s priority. Priority is a useful way to distinguish the relative importance of two templates.
- **Mode** – A template’s mode allows you to define the context in which a given template should be performed. To use the mode attribute, you specify it (mode="xyz", for example) in both the `xsl:template` and `xsl:apply-template` instructions. Once you have specified a mode, the processor applies a template only if the modes match.
- **Order** – If the XSLT processor cannot distinguish the best match among two or more templates, it uses the last matching template that appears in the stylesheet. Thus, you can enforce priority indirectly by the order in which you define the templates within a stylesheet.

For information on specifying these attributes, see “`xsl:template`” on page 436 and “`xsl:apply-templates`” on page 404.

**When No Templates Match**

When the XSLT processor cannot find a template that matches a selected node, it uses built-in templates. Every stylesheet includes built-in templates whether or not you explicitly define them.

The XSLT processor supports these built-in templates:

- The following template matches the root node and element nodes and selects all attributes and child nodes for further processing:

```
<xs1:template match="*|/">
  <xs1:apply-templates />
</xs1:template>
```
Getting Started with XSLT
●

The following template matches text and attribute nodes. This template copies the
value of the text or attribute node to the result document:
<xsl:template match="@*|text()">
<xsl:value-of select="." />
</xsl:template>

Although Stylus Studio does not explicitly insert these templates in stylesheets you create
with Stylus Studio, they are always present. That is, as specified by the W3C XSLT
Recommendation, these templates are always defined, whether or not they are explicitly
defined. See “Using Stylus Studio Default Templates” on page 377.

Controlling the Contents of the Result Document
This section highlights some of the XSLT instructions you can specify in a stylesheet to
control the contents of the result document. This section discusses the following topics:
●
Specifying Result Formatting on page 323
●
Creating New Nodes in the Result Document on page 324
●
Controlling White Space in the Result on page 324

Specifying Result Formatting
In a stylesheet, you can specify that the XSLT processor should format the result as XML,
HTML, or text. Table 32 describes the XSLT processor output for each alternative:
Table 32. Output Based on Result Format
Result Format

XSLT Processor Output

XML

Well-formed XML.

HTML

Recognized HTML tags and attributes that are formatted
according to the HTML 4.0 specification. Most browsers
should be able to correctly interpret the result. It is your
responsibility to ensure that the result is well-formed
HTML. For example, <BR> elements should not have child
nodes.

Text

All text nodes in the result in document order.

See “xsl:output” on page 427 for information about specifying formatting in a stylesheet.

Stylus Studio® 2006 User Guide

323


Creating New Nodes in the Result Document

The simplest way to create new nodes in a result document is to specify them as literal result elements or literal result text in a stylesheet template. For example:

```xml
<xsl:template match="/"
  xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <html><head></head><body><table>
    <tr><th>Title</th><th>Author</th><th>Price</th></tr>
    ...</table></body></html>
</xsl:template>
```

This template creates many nodes in the result document that were not in the source document.

You can also use XSLT instructions to create new nodes. Typically, you use XSLT instructions when you need to compute the name or value of the node. You can find information about using the following instructions in the “XSLT Instructions Quick Reference” on page 402:

- **“xsl:element”** on page 415
- **“xsl:attribute”** on page 405
- **“xsl:comment”** on page 412
- **“xsl:processing-instruction”** on page 432
- **“xsl:text”** on page 438

You can use the **xsl:value-of** on page 439 instruction to provide the contents for a new node. You can also create a new node by copying the current node from the source document to the result document. The current node is the node for which the XSLT processor instantiates a template. See “xsl:copy” on page 412.

Controlling White Space in the Result

For readability, XML documents (both source documents and stylesheets) often include extra white space. White space in XML documents includes spaces, tabs, and new-line characters. Because this white space is for readability, it receives special treatment.

Text nodes that contain only white space are

- Preserved as normal text nodes in a source document
- Ignored in a stylesheet, unless the parent node is **xsl:text**
Significant white space

Stylus Studio recommends that you specify `xsl:text` in a stylesheet whenever you want to create significant white space in the result. Significant white space is white space that you want to appear in the result in exactly the way that you specify.

To obtain white space for readability during output formatting, specify the `xsl:output` instruction with the `indent` attribute. Default values are `yes` for HTML, and `no` for XML. With Stylus Studio, you can select the `Indent` check box on the `Params/Other` tab to display indented output instead of one long string. Note that the value of the `indent` attribute, if specified in the stylesheet, has precedence over the `Indent` option.

Specifying XSLT Patterns and Expressions

In a stylesheet’s `xsl:template`, `xsl:apply-templates`, `xsl:for-each`, and `xsl:value-of` instructions, you specify patterns or expressions as the values for the `match` or `select` attributes. These patterns are XPath expressions. You specify patterns or expressions to

- Define which nodes a template rule matches.
- Select lists of source nodes to process.
- Extract source node contents to generate result nodes.

Depending on the context, an XSLT pattern or expression can mean one of the following:

- Does this template match the current node?
- Given the current node, select all matching source nodes.
- Given the current node, select the first matching source node.
- Given the current node, do any source nodes match?

Patterns or expressions can match or select any type of node. The XSLT processor can match a pattern to a node based on the existence of the node, the name of the node, or the value of the node. You can combine patterns and expressions with Boolean operators. For detailed information about patterns and expressions, see “Writing XPath Expressions” on page 623.

Examples of Patterns and Expressions

Following are examples of patterns and expressions you can specify in stylesheet instructions:

```
xsl:template match = "book/price"
```
**Working with XSLT**

Matches any `price` element that is a child of a `book` element.

`xsl:template match = "book//award"

Matches any `award` element that is a descendant of a `book` element.

`xsl:template match = "book [price]"

Matches any `book` element that has a child that is a `price` element.

`xsl:template match = "book [@price]"

Matches any `book` element that has a `price` attribute.

`xsl:template match = "book [price=14]"

Matches any `book` element that has a child that is a `price` element whose value is 14.

`xsl:template match = "book [@price=14]"

Matches any `book` element that has a `price` attribute whose value is 14.

`xsl:apply-templates select = "book"

Selects all `book` elements that are children of the current element.

`xsl:apply-templates select = "book/price"

Selects all `price` elements that are children of `book` elements that are children of the current element.

`xsl:apply-templates select = "//book"

Selects all `book` elements in the source document.

`xsl:apply-templates select = ".//book"

Selects all `book` elements that are descendants of the current element.

**Frequently Asked Questions About XSLT**

*How can I use quoted strings inside an attribute value?*
If you need to include a quoted string inside an attribute value (in a select expression, for example), you can use the single quotation mark character (') in the value of the attribute. For example:

```xml
select = "book[title = 'Trenton Today']".
```

**How do I choose when to use xsl:for-each and when to use xsl:apply-templates?**

The way xsl:for-each and xsl:apply-templates select nodes for processing is identical. The way these instructions find the templates to process the selected nodes is different.

With xsl:for-each, the template to use is fixed. It is the template that is contained in the body of the xsl:for-each element. With xsl:apply-templates, the XSLT processor finds the template to be used for each selected node by matching that node against the template rules in the stylesheet.

Finding a template by matching requires more time than using the contained template. However, matching allows for more flexibility. Also, matching lets you avoid repeating templates that might be used in more than one place in a stylesheet.

Named templates are another option for invoking a template from more than one place in a stylesheet, when you know which template you want. It is a common mistake to use (and bear the overhead of) matching when it is not needed. But it allows you to do powerful things. Matching can take into account the following:

- Pattern matching on the node
- Precedence of templates based on stylesheet importance
- Template priority
- Template ordering

Most complex document-formatting stylesheets use xsl:apply-templates extensively.

**Tip** Use the XSLT Profiler to help you understand where the processor is spending most of its time. See “Profiling XSLT Stylesheets” on page 491.

XSLT Profiling is available only in Stylus Studio XML Enterprise Edition.

**How can I insert JavaScript in my result document?**
If you want your result document to contain JavaScript commands, you must properly escape the JavaScript code. Use the following format in your XSLT template:

```xml
<script>
  <xsl:comment>
    <![CDATA[ <your JavaScript here> ]]>
  </xsl:comment>
</script>
```

However, this method does not work when your JavaScript section contains a block of XSLT code. In this case, enclosing the JavaScript in a `CDATA` tag causes the XSLT processor to ignore not just the JavaScript but also the markup code within that tag.

In this situation, enclose the entity reference within an `<xsl:text>` tag with `disable-output-escaping` set to "yes". For example:

```xml
if(length <xsl:text disable-output-escaping="yes">&gt;</xsl:text> 1)
```

You can use this wherever an entity reference needs to be handled specifically, as opposed to being handled as part of an entire JavaScript section.

**My browser does not understand the tag `<br/>`. How can I output just `<br>`?**

Although your XSLT stylesheet must contain valid XML (meaning all tags must be either empty or have a closing element), you can instruct the XSLT processor to generate output compliant with HTML. See “Deleting Templates” on page 380.

**Alternative:** To ensure that your stylesheet always generates correct HTML, specify the `xsl:output` instruction with the `method` attribute set to `html`. See “xsl:output” on page 427.

### Sources for Additional XSLT Information

For additional information about XSL and XSLT, visit the following Web sites:

- [http://www.w3.org/Style/XSL/](http://www.w3.org/Style/XSL/)  
  W3C Extensible Stylesheet Language specification
- [http://www.w3.org/TR/xslt](http://www.w3.org/TR/xslt)  
  W3C XSLT Recommendation
Benefits of Using Stylus Studio

Now that you have an understanding of what a stylesheet can do, you can appreciate the benefits of using Stylus Studio to create them. Stylus Studio is the first integrated environment for creating, managing, and maintaining an XSL-enabled Web presence. By combining the tools needed to create XSLT stylesheets in a visual editing environment, Stylus Studio speeds initial development and eases maintenance. Key elements of Stylus Studio’s XSLT features include

- **Structural Data View** on page 329
- **Sophisticated Editing Environment** on page 330
- **XSLT and Java Debugging Features** on page 331
- **Integrated XML Parser/XSLT Processor** on page 333

**Structural Data View**

Stylus Studio graphically displays the structure, or schema, of the XML data to which you want to apply a stylesheet.

![Figure 200. Tree View Lets You Easily Edit XSLT](image)
Working with XSLT

Using this tree view, you can apply formatting to your XML – double-clicking a node in the tree automatically adds an `xsl:template match=` instruction for that node, for example. Similarly, when you drag a node into the XSLT source, Stylus Studio displays a pop-up menu that allows you to easily insert an XSLT instruction.

Finally, you can also use the tree to move quickly among different XSLT templates – clicking a node in the tree places the cursor at the corresponding template in the XSLT source.

Sophisticated Editing Environment

The Stylus Studio editor allows you to edit both the XML source document and the XSLT stylesheet. There is no need to memorize complicated syntax. As you type, Stylus Studio
Sense:X technology automatically suggests XSLT or HTML tag and attribute names, and ensures that all XML is well formed.

![Figure 202. Sense:X Speeds Coding, Reduces Errors](image)

XSLT and Java Debugging Features

Complex stylesheets require robust debugging features. With Stylus Studio, you can do the following:

- Set breakpoints in your stylesheet.
- Monitor the value of XSLT variables.
- Trace the sequence of XSLT instructions that created HTML output. With a click anywhere in the rendered HTML page, Stylus Studio Visual Backmapping...
Working with XSLT
technology displays the XSLT instructions responsible for creating that portion of HTML output.

![Figure 203. Click to HTML Output to Backmap to XSLT Source](image)

Also, you can click in the stylesheet and the backmapping feature highlights the text generated by that template.

- Use the XSLT Profiling report to review performance metrics to help troubleshoot and tune your XSLT stylesheets.

**XSLT Profiling is available only in Stylus Studio XML Professional Edition.**
Integrated XML Parser/XSLT Processor

Stylus Studio integrates an XML parser with an XSLT processor. This allows Stylus Studio to instantly show the output of your stylesheet. Each time you apply a stylesheet to an XML document, Stylus Studio detects and flags any errors in your stylesheet or XML data.

Stylus Studio’s default XSLT processor is compliant with the W3C XSLT Recommendation. You can also use the Xalan-J processor, or custom processors of your own.

Tutorial: Understanding How Templates Work

When Stylus Studio creates a new stylesheet, it contains one template, which matches the root node. However, this template is empty. If you apply the new stylesheet as is, the result document has no contents. To generate a result document with contents, you need to add instructions to the template that matches the root node.

All stylesheets have two default templates that do not appear in the stylesheet itself. It is important for you to understand how the default templates work so that you can:

- Add instructions to the template that matches the root node.
- Define additional templates to operate on the elements in your document.
- Specify HTML markup in templates.

When you can do this, you can write a stylesheet that generates a dynamic Web page that displays your information.

This tutorial provides step-by-step instructions for defining a stylesheet that generates a dynamic Web page from an XML document. The tutorial shows how the default templates work, and it provides instructions for defining templates that instantiate the default templates. It also provides instructions for adding HTML markup to the stylesheet. The result is a dynamic Web page that displays the particular information you choose.

Each of the following topics contains instructions for defining the stylesheet. You should perform the steps in each topic before you move on to the next topic. After the first topic, some steps depend on actions you performed in a previous topic. This section organizes the process as follows:

- Creating a New Sample Stylesheet on page 334
- Understanding How the Default Templates Work on page 337
- Editing the Template That Matches the Root Node on page 342
Creating a New Sample Stylesheet

1. From the Stylus Studio menu bar, select File > New > XSLT Stylesheet.

Stylus Studio displays a new untitled stylesheet and the Scenario Properties dialog box, and selects the text in the Scenario Name field.

Figure 204. Scenarios Let You Easily Test Different XSLT/XML Pairs
2. In the **Scenario Properties** dialog box, in the **Scenario Name** field, type **DynamicBookstoreScenario**.

3. Click **Browse ...** to the right of the **Source XML URL:** field. Stylus Studio displays the **Open** dialog box.

4. Navigate to the Stylus Studio examples\query directory.

5. Double-click **bookstore.xml**. This is the XML document that the new stylesheet will operate on.

6. In the **Scenario Properties** dialog box, click **OK**.
   
   This creates a scenario with the name **DynamicBookstoreScenario**. This scenario associates the **bookstore.xml** document with the new stylesheet. If you want to apply the new stylesheet to other XML documents, you must create a new scenario or change the name of the XML document in this scenario.

   Stylus Studio displays the new stylesheet in the XSLT editor. A tree representation of the **bookstore.xml** document appears to the right.

![Stylus Studio XSLT Editor](image)

Figure 205. The XSLT Editor Shows XSLT Source on Left, Tree on Right
Working with XSLT

The default stylesheet that Stylus Studio creates contains one template, which matches the root node.

7. In the XSLT editor tool bar, click Preview Result .
   Stylus Studio displays the Save As dialog box so you can save the XSLT you are composing.

8. In the URL: field, type bookstore.xsl and click Save.
   Stylus Studio applies the new stylesheet to bookstore.xml and displays the result in the Preview window. The result, displayed in the Preview window, has no contents because the template that matches the root node is empty.

9. In the XSLT editor pane, click in the empty line that follows <xsl:template match="/">

10. Type <x, which displays the Sense:X completion list.

11. In the completion list, scroll down and double-click xsl:apply-templates.

12. Type ///</xsl:template>

13. In the XSLT editor tool bar, click Preview Result .
   Stylus Studio displays the Save As dialog box.

14. Enter a name for the file and click Save.
This time, the Preview window contains all text in bookstore.xml and none of the markup. This is because the xsl:apply-templates instruction instantiates the default templates.

To create a Web page, you need to add HTML markup that displays the information the way you want. To make it easier to do that, you need to understand how the text is already being copied to the result document.

**Understanding How the Default Templates Work**

After you complete the steps in the previous section, you can see the bookstore.xsl stylesheet in the XSLT editor pane. It has the following contents:

```xml
<?xml version='1.0' ?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:template match="/">
    <xsl:apply-templates/>
  </xsl:template>
</xsl:stylesheet>
```
Working with XSLT

The stylesheet explicitly contains one template, which matches the root node. When the XSLT processor applies a stylesheet, the first thing it does is search for a template that matches the root node. If there is no template that explicitly matches the root node, the XSLT processor uses a built-in template.

There are two built-in templates, also called default templates. Every XSLT stylesheet contains these templates whether or not they are explicitly specified. This is part of the W3C XSLT Recommendation.

This section discusses the following topics:
- Instantiating the Template That Matches the Root Node on page 338
- Instantiating the Root/Element Default Template on page 339
- Instantiating the Text/Attribute Default Template on page 340
- Illustration of Template Instantiations on page 341

Instantiating the Template That Matches the Root Node

The XSLT processor instantiates the template that matches the root node. The template that matches the root node contains only the \texttt{xsl:apply-templates} instruction. In this template, the \texttt{xsl:apply-templates} instruction does not specify a \texttt{select} attribute. Consequently, the XSLT processor operates on the children of the node for which the root template was instantiated. In the \texttt{bookstore.xml} document, the root node has three children:
- XML declaration
- Comment
Tutorial: Understanding How Templates Work

- bookstore document element

![Figure 207. Source XML Document from DynamicBookstoreScenario](image)

Unless you specify otherwise, the XSLT processor operates on the children in document order. The first child is a processing instruction (the XML declaration). The XSLT processor ignores processing instructions.

The second child is the comment node, and the XSLT processor also ignores comment nodes.

The third child is the bookstore document element. The XSLT processor searches for a template that matches `bookstore`. Because there is no template that explicitly matches the `bookstore` element, the XSLT processor instantiates a built-in template that is not explicitly in the stylesheet.

### Instantiating the Root/Element Default Template

One default template matches `*|/`. This means it matches every element in the source document, and it also matches the root node. This is the root/element default template.

The root/element default template contains only the `xsl:apply-templates` instruction. Like the template that matches the root node, the `xsl:apply-templates` instruction in the root/element default template does not specify a `select` attribute. That is, it does not identify the set of nodes for which templates should be applied. Consequently, the XSLT processor operates on the children of the node for which the root/element template was instantiated.
In this case, the root/element default template was instantiated for the bookstore element. The children of the bookstore element include four book elements, a magazine element, and a book element associated with the my namespace.

The XSLT processor operates on these children in document order. First, it searches for a template that matches book. Because there is no template that explicitly matches the book element, the XSLT processor instantiates the root/element default template for the first book element.

Again, by default, the xsl:apply-templates instruction in the root/element default template operates on the children of the current node in document order. That is, it operates on the children of the first book element.

In the first book element, the first child is the title element. The XSLT processor searches for a template that matches the title element. Because there is no template that explicitly matches the title element, the XSLT processor instantiates the root/element default template again.

At this point, the XSLT processor has initiated instantiation of the root template once, and the root/element default template several times:

- Instantiate root template for root node.
- Instantiate root/element template for bookstore element.

It is important to understand that these instantiations are not yet complete. Each subsequent instantiation of the root/element default template is inside the previous instantiations.

**Instantiating the Text/Attribute Default Template**

When the XSLT processor instantiates the root/element default template for the title element, the xsl:apply-templates instruction operates on the children of the title element. The title element has one child, which is a text node. The XSLT processor searches for a template that matches this text node. The second default template in the stylesheet matches this text node. This template matches text()|@*, meaning that it matches every text node and every attribute in the source document. This is the text/attribute template.

The XSLT processor instantiates the text/attribute default template for the title element’s text node. This template contains only the xsl:value-of instruction. Its select attribute identifies the current node, which is the node for which the template was instantiated. This template copies the text contained in the current text node to the result document.
Now the result document contains the following text:

| Seven Years in Trenton |

The XSLT processor is finished with the title element, and it next processes the author element in the first book element. There is no template that explicitly matches author, so the XSLT processor instantiates the root/element default template. The first child of the author element is the first-name element, and again, there is no template that explicitly matches the first-name element. The XSLT processor instantiates the root/element default template for the first-name element. The only child of the first-name element is a text node. The XSLT processor instantiates the text/attribute default template for this text node, and this template copies the text to the result document. Now the result document contains the following text:

| Seven Years in Trenton Joe |

The XSLT processor is finished with the first-name element, and it next processes the last-name element, which is the second child of the author element.

**Illustration of Template Instantiations**

As you can see from the description in the previous section, the XSLT processor iterates through the process of searching for a matching template, instantiating one of the default templates, and operating on the children of the node for which the template was instantiated. The following figure shows the template instantiations through the second
book element. In the figure, each bracket encloses the instantiations that together compose a complete instantiation for a particular element.

```
# Instantiate root template for root node.
  # Instantiate root/element template for bookstore element.
    # Instantiate root/element template for first book element.
      # Instantiate root/element template for title element.
      # Instantiate text/attribute template for text node.
    # Instantiate root/element template for author element.
      # Instantiate root/element template for first-name element.
      # Instantiate text/attribute template for text node.
    # Instantiate root/element template for last-name element.
    # Instantiate text/attribute template for text node.
  # Instantiate root/element template for price element.
    # Instantiate text/attribute template for text node.
  # Instantiate root/element template for second book element.
    # Instantiate root/element template for title element.
    # Instantiate text/attribute template for text node.
    # Instantiate root/element template for author element.
      # Instantiate root/element template for first-name element.
      # Instantiate text/attribute template for text node.
    # Instantiate root/element template for last-name element.
    # Instantiate text/attribute template for text node.
    # Instantiate root/element template for publication element.
      # Instantiate root/element template for first-name element.
      # Instantiate text/attribute template for text node.
      # Instantiate root/element template for last-name element.
      # Instantiate text/attribute template for text node.
      # Instantiate root/element template for price element.
      # Instantiate text/attribute template for text node.
    # Instantiate root/element template for magazine element.
```

And so on.

**Editing the Template That Matches the Root Node**

Begin writing your stylesheet by adding instructions to the template that explicitly matches the root node in your source document:

In the XSLT editor, edit the contents of the root template so that it contains only the following contents. As you type, Stylus Studio displays a pop-up menu that lists possible instructions. You can scroll the list and double-click the entry you want, or you can continue typing.
Ensure that you do one of the following:

- Remove the `xsl:apply-templates` instruction that you inserted earlier.
- Edit the `xsl:apply-templates` instruction to include the `select` attribute as shown above, and place it in the correct location.

**Creating a Template That Matches the `book` Element**

The template that matches the root node includes an `xsl:apply-templates` instruction that selects `book` nodes for processing.

1. In the XSLT editor source document tree pane, expand the `bookstore` element.
2. Double-click the `book` element.

Stylus Studio creates a template that matches the `book` element. The new template is near the end of the stylesheet and has the form `<xsl:template match="book">`. In the tree pane, the yellow check next to the `book` element indicates that there is a template that matches this element.

3. In the XSLT editor pane, add the following instructions to the new template’s body:

```xml
<tr>
  <td><xsl:apply-templates select="title"/></td>
  <td><xsl:apply-templates select="author"/></td>
  <td align="right"> <xsl:apply-templates select="price"/></td>
</tr>
```

Press F5 to see the results. The result document looks like that shown in Figure 208:

![Books in Stock](image)

**Figure 208. Result of Applying XSLT**

In the book template, the `xsl:apply-templates` instructions cause the XSLT processor to instantiate the default templates. For the `title` and `price` elements, this works correctly...
Working with XSLT

because those elements include only a text node. But for the author element, the use of
the default templates copies too much information to the result table. You need to
explicitly define a template for the author element.

Creating a Template That Matches the author Element

1. In the XSLT editor source document tree pane, expand the book element.

2. Double-click the author element.

   Stylus Studio creates a template that matches the author element, and places it near
   the end of the stylesheet.

3. In the XSLT editor pane view, edit the template body so that it contains only the
   following contents.

   ```xml
   <xsl:value-of select="first-name"/>
   &nbsp;
   <xsl:value-of select="last-name"/>
   ```

   If you do not include the nonbreaking space entity, the first name and the last name
   have no space between them. Press F5 to see the results of this change, as shown in
   Figure 209.

   ![Figure 209. Result of XSLT with an Author Template](image)

4. Save the stylesheet by clicking Save.

5. Close the stylesheet by clicking File > Close on the Stylus Studio menu bar.
Working with Stylesheets

This section provides instructions for performing the various tasks involving stylesheets. See also “Working with Templates” on page 375. This section covers the following topics:

- About the XSLT Editor on page 346
- Creating Stylesheets on page 347
- Creating a Stylesheet from HTML on page 347
- Specifying Stylesheet Parameters and Options on page 348
- Applying Stylesheets on page 351
- Applying a Stylesheet to Multiple Documents on page 357
- About Stylesheet Contents on page 358
- Updating Stylesheets on page 359
- Saving Stylesheets on page 361

Also, Stylus Studio provides a number of tools that help you debug stylesheets. See “Debugging Stylesheets” on page 485.
Working with XSLT

About the XSLT Editor

The XSLT editor, which displays a stylesheet when you open it, has four tabs at the bottom.

![XSLT Editor Screenshot](image)

Figure 210. XSLT Editor

The **XSLT Source**, **Mapper**, and **Params/Other** tabs are always available. The **WYSIWYG** tab is available only when the stylesheet generates HTML.

The **WYSIWYG** tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

Editing XSLT as XML

If you want, you can edit an XSLT file as an XML file. To do this, open the stylesheet in the XML editor instead of in the XSLT editor. In the **Open** dialog box, click the down arrow in the **Open** button. Click **XML Editor** in the drop-down menu. A document can be open in the XML editor and in the XSLT editor at the same time.
Creating Stylesheets

1. From the Stylus Studio menu bar, select File > New > XSLT Stylesheet. Stylus Studio displays the Scenario Properties dialog box.

2. In the Scenario Name: field, type a name for the association between the new stylesheet and a particular XML source document. You might want to use the convention of specifying the name you want your result document to have. The result document is the document that will contain the result of applying the stylesheet you are about to create.

3. In the Source XML URL: field, type the name of an XML document or click Browse to navigate to a document. Select a document you want to apply the new stylesheet to. You are not limited to applying the new stylesheet to only this XML document. You can create other scenarios later and specify other XML documents to which you want to apply the same stylesheet.

4. Click OK. Stylus Studio displays an untitled stylesheet window. The default text in the new stylesheet appears in the left pane. The schema for the XML source document you specified in the scenario properties appears in the right pane.

5. To give the stylesheet a name, select File > Save.

6. Navigate to where you want to save the stylesheet.

7. In the URL: field, type the new stylesheet’s name.

8. Click Save.

Creating a Stylesheet from HTML

You can create an XSLT stylesheet from an HTML file using the HTML to XSLT document wizard.

Tip Stylus Studio also has a document wizard that converts HTML to XML. See “Creating XML from HTML”.


2. Click the XSLT Editor tab.

3. Double-click HTML to XSLT (or select the HTML to XSLT icon and click OK).
Working with XSLT

The HTML to XML dialog box appears.

![HTML to XML Dialog Box](image)

**Figure 211. HTML to XML Dialog Box**

4. Enter the name of the HTML file you want to convert to XSLT in the **Choose HTML File to Convert to XSLT** field.

5. Click **OK**.

Stylus Studio opens the converted HTML file as an untitled XSLT document in the XSLT Editor.

**Specifying Stylesheet Parameters and Options**

You can specify values for stylesheet parameters in the **Parameter Values** tab of the **Scenario Properties** dialog box.

1. Open the stylesheet for which you want to specify parameter values.
2. In the XSLT editor toolbar, click **Browse** ... .
   Stylus Studio displays the **Scenario Properties** dialog box.

3. Click the **Parameter Values** tab.
   Stylus Studio displays a list of the parameters defined in your stylesheet, if any, with any default values.

4. Click the third field in the line that displays the parameter for which you want to define a value – **Parameter value to be used when processing**.

5. Type the value of the parameter.

6. If you want Stylus Studio to pass this parameter as an XPath expression instead of as a string, click the fourth field, which is a check box.
   The default is that Stylus Studio passes a parameter as a string.

7. Click **OK**.
In the **XSLT Encoding** field, you can specify the encoding you want Stylus Studio to use when you save the stylesheet.

To display a list of the encodings supported by Stylus Studio, click the down arrow in the **XSLT Encoding** field.

In the **Output method** field, you can specify the type of data you want the stylesheet to generate. Choices include

- **xml**
- **html** — Stylus Studio generates HTML that is compliant with HTML 4.0. This is equivalent to inserting `<xsl:output method="html"/>` in a stylesheet.
- **text**
- **unspecified**

If you do not specify an `xsl:output` instruction in your stylesheet, Stylus Studio uses the default output method you specify here. If you do specify an `xsl:output` instruction in your stylesheet, that instruction overrides the default you specify here.

When the result of applying a stylesheet is XHTML, specify **xml** as the **Output method**. Note, however, that Stylus Studio displays rendered HTML in the **Preview in Browser** window.

In the **Params/Other** tab, in the **Output Encoding** field, you can specify the encoding you want Stylus Studio to use in the document that is the result of applying the stylesheet. When you apply a stylesheet, Stylus Studio uses this encoding for the output document. You can change the encoding by changing the setting in the **Params/Other** tab or in the initial processing instruction in the stylesheet. When you change the setting in one of these places, Stylus Studio automatically changes it in the other. They are always the...
same. In the **Output Encoding** field, click the down arrow to display a list of the supported encodings.

If you want Stylus Studio to insert indents in the result document, select **Indent**.

### Applying Stylesheets

In order to apply a stylesheet to an XML document, the stylesheet must be associated with a scenario. See

- “Creating a Scenario” on page 354
- “Cloning Scenarios” on page 356
- “Saving Scenario Meta-Information” on page 356

If your stylesheet is associated with a scenario, there are two ways to apply it:

- Click **Preview Result** , which appears in the top tool bar of the **XSLT Source** tab of your stylesheet. This ignores any breakpoints that are set.
- Press F5. Stylus Studio suspends processing if it reaches a breakpoint.

The following topics provide more information about how to apply stylesheets:

- **About Applying Stylesheets** on page 351
- **Results of Applying a Stylesheet** on page 352
- **Applying Stylesheets to Large Data Sets** on page 354

**Tip** Stylus Studio provides a number of tools that help you debug stylesheets. See “Debugging Stylesheets” on page 485.

### About Applying Stylesheets

When you apply a stylesheet, Stylus Studio checks both the XML source document and the XSLT stylesheet for correct syntax. If it detects any errors, it displays a message that indicates what the error is. This message appears at the bottom of the XSLT editor. Stylus Studio also displays and flags the line that contains the error.

Often, a stylesheet refers to other files, such as CSS stylesheets or images. For Stylus Studio to display the complete result file in the **Preview** window, you must enter the path for resolving any links. Do this in the **Base URL for HTML links resolution** field of the **Scenario Properties** dialog box.

Ensure that the correct output type is set. To do this, click the **Params/Other** tab at the bottom of the stylesheet and check the value of the **Output Method** field.
Working with XSLT

Multiple scenarios

If your stylesheet is associated with more than one scenario, select the scenario you want to use and then apply the stylesheet. To do this, click the down arrow to the right of the scenario name field to display a list of scenarios. Click the scenario you want to use, and then click Preview Result. After you apply a stylesheet in a particular scenario, the Preview window displays a tab for that scenario. To reapply the stylesheet in that scenario, click Preview Result in the left tool bar.

You might want to apply the same stylesheet to two different XML documents and compare the results. To do this, create a scenario for each XML source document. Apply the stylesheet in the context of each scenario. Stylus Studio displays a tab for each scenario at the bottom of the Preview window. Click the tab to display the result document for that scenario.

Stylus Studio does not support scenarios that consecutively apply multiple stylesheets to one source document. However, you can use the StylusXslt command-line utility within a batch file perform this type of operation. See “Applying a Stylesheet from the Command Line”.

Results of Applying a Stylesheet

Stylus Studio applies the stylesheet to the XML source document specified in the current scenario and refreshes the Preview window with the latest result document. If the Preview window is not visible, select View > Preview from the Stylus Studio menu bar.

To toggle between viewing the text of the result and viewing what the result would look like in a browser, click Preview in Browser or Preview Text.

Tip You can select and copy text in the Preview Text view.

If you click in the result document, Stylus Studio displays the Backmap Stack window, which lists the XSLT instructions that generated the text you clicked.

![Figure 214. XSLT Backmap Window](image-url)
Stylus Studio also flags the line in the stylesheet that contains the first instruction in the Backmap Stack window.

If the result document is XML, in the Preview window, you can click Preview in Tree to display the result of XSLT processing as an XML tree.

The tree view provides

- Scalability – you can more easily view large result sets
- Backmapping – click on a result tree node and Stylus Studio displays the stylesheet line that generated that node

To save the result of applying a stylesheet, click Save Preview in the Preview window. Stylus Studio displays the Save As dialog box.
Working with XSLT

The result document reflects any changes you made to either the XML source document or the XSLT stylesheet. You do not need to explicitly save either the XML or XSLT file to have changes to those documents appear in the result document. However, when you apply a stylesheet, Stylus Studio does not also save the stylesheet. To save a stylesheet, click **Save**.

Applying Stylesheets to Large Data Sets

When you open a stylesheet or assign a source XML document to a scenario, Stylus Studio loads the entire XML source document in memory. Stylus Studio requires the source XML document in order to display

- A preview of the result of applying the stylesheet
- The source tree for the document the stylesheet will be applied to

If the source XML document is particularly large, loading it can take several minutes.

Each time you leave and return to Stylus Studio, Stylus Studio checks whether any open documents have been modified. If the documents reside on remote servers, this can take some time. If you want, you can turn off the check for modified documents.

1. In the Stylus Studio menu bar, select **Tools > Options**. Stylus Studio displays the **Options** dialog box.
2. Click **Application Settings**.
3. Click the check box for **Automatically check for externally modified files**.

Creating a Scenario

A scenario allows you to preview the results of applying a stylesheet. Each scenario is for a particular group of settings. These settings include the name of an XML source document, the values of any parameters in the stylesheet, and the values of any encoding settings. A scenario can include any setting that you can specify when you apply the stylesheet.

A scenario can be associated with only one stylesheet and only one XML source document. However, you can associate any number of scenarios with a stylesheet, and you can associate any number of scenarios with an XML source document.

**Tip** If you start to create a scenario and then change your mind, click **Delete** and then **OK**.

1. In the XSLT editor tool bar, click **Browse**. Stylus Studio displays the **Scenario Properties** dialog box.
2. In the **Scenario Name**: field, type the name of the new scenario.

3. In the **Source XML URL**: field, type the name of the XML file you want to apply the stylesheet to, or click **Browse** to navigate to an XML file and select it.

4. In the **Output URL** field, optionally type or select the name of the result document you want the stylesheet to generate. If you specify the name of a file that does not exist, Stylus Studio creates it when you apply the stylesheet.

5. In the **Base URL For HTML Links Resolution** field, optionally type the path for resolving any links. For example, your stylesheet might have links to CSS stylesheets or images.

6. If you want Stylus Studio to **Store paths relative to XSLT document path**, ensure that this option is checked.

7. If you want to **Preview result in an external application**, ensure that this option is checked. When this option is checked, Stylus Studio displays the result in the default application for the output method specified for the scenario. For example, if the output method for the scenario is HTML and if Internet Explorer is the default application for displaying HTML files, Stylus Studio displays the resulting HTML in Internet Explorer, as well as in the XSLT Preview window.

8. If you want to specify values for stylesheet parameters, click the **Parameter Values** tab. Double-click the **Value** field for the parameter you want to specify a value for.

9. If you want to use an XSLT processor other than the Stylus Studio processor, click the **Processor** tab and type the required information. See “**Using Third-Party XSLT Processors**” on page 380.

10. If you want to specify any post-processing, click the **Post-process** tab. See “**Post-processing Result Documents**” on page 386.

11. To define another scenario, click **Add** and enter the information for that scenario. You can also copy scenarios. See “**Cloning Scenarios**” on page 356.

12. Click **OK**.

For more information, see “**Scenario Properties General Tab (XSLT)**”.
Cloning Scenarios

When you clone a scenario, Stylus Studio creates a copy of the scenario except for the scenario name. This allows you to make changes to one scenario and then run both to compare the results.

Tip If you start to clone a scenario and then change your mind, click Delete and then OK.

1. Display the stylesheet in the scenario you want to clone.
2. In the XSLT editor tool bar, click Browse to display the Scenario Properties dialog box.
3. In the Scenario Properties dialog box, in the Existing preview scenarios field, click the name of the scenario you want to clone.
4. Click Clone.
5. In the Scenario name field, type the name of the new scenario.
6. Change any other scenario properties you want to change. See “Creating a Scenario” on page 354.
7. Click OK.

Saving Scenario Meta-Information

Stylus Studio can store scenario meta-information in two places:

- In the stylesheet associated with the scenario, unless you turned off the Save scenario meta-information in the stylesheet option. See “Options - Module Settings - XSLT Editor - XSLT Settings”.
- In the project that the stylesheet belongs to, if the stylesheet belongs to a project.

When you save a stylesheet, Stylus Studio saves the scenario meta-information in the stylesheet, but not in the project. When you select File > Save All or when you save the project, Stylus Studio saves the scenario meta-information in the stylesheet and in the project. To ensure that scenario meta-information in the project and in the stylesheet is consistent

- The project must be open when you save the stylesheet.
- Ensure that you save the project after you modify scenario information. (If you close a project without saving it, Stylus Studio prompts you to save it.)
Suppose you modify a scenario and save and close the associated stylesheet. If the stylesheet belongs to the open project, when you save the project, Stylus Studio saves the closed stylesheet’s scenario meta-information in the project.

**Applying a Stylesheet to Multiple Documents**

You can apply the same stylesheet to multiple documents

- In separate operations
- In a single operation

### Applying the Same Stylesheet in Separate Operations

Scenarios make it easy to view results and apply the same stylesheet to multiple XML documents. A stylesheet can have any number of scenarios. Each scenario is associated with only one stylesheet. In addition to the stylesheet, a scenario is associated with a source XML file. The same XML file can be associated with any number of scenarios.

You create an initial scenario when you create a stylesheet. You can create additional scenarios at any time. See “Creating a Scenario” on page 354.

1. Click the down arrow in the scenario field at the top of the stylesheet window.
2. Click the scenario you want to view.
3. Click **Preview Result**, which is directly to the left of the scenario field. This applies the stylesheet to the XML document specified in the selected scenario.

Each time you generate a different scenario, Stylus Studio displays a tab at the bottom of the **Preview** window for that scenario. Click the tab for the scenario you want to view. This allows you to compare results.

### Applying a Stylesheet to Multiple Documents in One Operation

To apply a stylesheet to multiple documents in one operation, call the `document()` function in the XPath expression of a template. This function allows you to access another XML document and select nodes from that document for processing as source nodes. See “Accessing Other Documents During Query Execution” on page 699.

For example, you can specify the following:

```xml
<xsl:apply-templates select="document('bookstore.xml')/bookstore"
```

This selects the `bookstore` root element of the `bookstore.xml` document.
Working with XSLT

Stylus Studio looks for the document in the directory that contains the stylesheet.

The document() function has a lot of overhead. You should call it once and assign the result to a variable with the xsl:variable instruction.

About Stylesheet Contents

Stylesheets are XML documents. They can contain XSLT instructions and non-XSLT elements and nodes. Stylus Studio automatically inserts some XSLT instructions. You can add additional XSLT instructions, HTML markup, and any other XML data you want. This section describes

Contents Provided by Stylus Studio on page 358
Contents You Can Add on page 358

Contents Provided by Stylus Studio

When Stylus Studio creates a stylesheet, it has the following contents:

```xml
<?xml version="1.0"?>
<xsl:stylesheet version='1.0'
xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
  <xsl:template match="/"/>
</xsl:template>
</xsl:stylesheet>
```

The xsl:stylesheet instruction is required in every stylesheet that you use with Stylus Studio.

Stylus Studio defines one template, which matches the root node. Of course, the two built-in templates are also defined, although they are not explicitly in the stylesheet. For information about these templates, see “Using Stylus Studio Default Templates” on page 377.

When Stylus Studio creates a stylesheet from an HTML file, the template that matches the root node contains all HTML markup that was in the imported file.

Contents You Can Add

You can add to the stylesheet any XSLT instruction that Stylus Studio supports. See “XSLT Instructions Quick Reference” on page 402. You can also add HTML markup and any other XML-formatted data you require.
Working with Stylesheets

To obtain the XPath expression that retrieves a particular node in the source document you want to apply the stylesheet to, see “Obtaining the XPath for a Node”.

Updating Stylesheets

You can edit a stylesheet in the XSLT Source tab in Full Source mode or Template mode. To display a particular template in either mode, click the down arrow in the upper right corner of the editing pane. This displays a drop-down list of template match patterns. Click the template you want to view.

The XSLT editor keeps track of your XSLT context. That is, it keeps track of template match patterns, and any xsl:for-each element that affects the context on which the stylesheet is working. The editor uses Stylus Studio’s Sense:X technology to help you create XPath expressions whenever they are needed.

After you associate the stylesheet with a scenario, you can display the source tree for the XML source document specified in the scenario. Click Source Tree in the XSLT editor tool bar. This tree provides a description of the structure of the XML source document specified in the scenario. This tree does not include elements and attributes that are not instantiated in the particular source document. However, the tree provides a structure that you can examine to help you understand stylesheet behavior in a given scenario.

Editing tools

The following sections describe the Stylus Studio editing tools:

- Dragging and Dropping from Schema Tree into XSLT Editor on page 359
- Using Sense:X Automatic Tag Completion on page 360
- Using Sense:X to Ensure Well-Formed XML on page 360
- Using Standard Editing Tools on page 361

Dragging and Dropping from Schema Tree into XSLT Editor

From the source tree of the XSLT editor, you can drag an element or attribute into the XSLT Source pane. If you drop the node in the stylesheet so that it is in a template, Stylus Studio displays the following choices:

- xsl:for-each
- xsl:value-of
- xsl:apply-templates
- node_name
Working with XSLT

Click the instruction you want to create. The XSLT context into which you drop the node determines the value of the `select` attribute in the instruction you choose. The `select` attribute always selects the node you dragged into the stylesheet. If you choose `node_name`, Stylus Studio simply inserts the name of the element or attribute you dragged in. This is convenient for pasting long element or attribute names.

If you drop the node in the stylesheet so that it is not in a template, Stylus Studio creates a new template. In the new template, the value of the `match` attribute is the name of the node you dragged into the stylesheet.

You can also create a new template by double-clicking a node in the source tree. The difference between double-clicking a node and dragging a node is that when you double-click a node to create a template, Stylus Studio always inserts the template at the end of the stylesheet. When you drag a node to create a template, you determine the location of the template.

Using Sense:X Automatic Tag Completion

The Stylus Studio Sense:X automatic tag completion system helps you edit XSLT, HTML, and FO (formatting objects) instructions. Stylus Studio has built-in knowledge of all XSLT, HTML, and FO tags, as well as their attributes.


As you type in the XSLT edit window, Stylus Studio prompts you with a list of tag or attribute names that match the first few letters you typed. To complete the tag name you are typing, scroll the list if necessary, and double-click the tag you want.

You can customize the Sense:X system. Edit `languages.xml` in the Stylus Studio `bin\Plugins\Configuration Files` directory to customize the tag list.

To set options that specify Sense:X behavior, see “Options - General - Editor General”.

Using Sense:X to Ensure Well-Formed XML

Sense:X also helps you write well-formed XML. There is an option in the Editor General page that is set by default. This is Auto-Close Open Tag When Typing `</`. This means that as soon as you type `</`, Stylus Studio immediately inserts the only tag that can possibly be closed at that point.

If you prefer, you can turn off this option. Then, when you start to type a closing tag, the Sense:X list displays the only valid closing tag. Double-click it to insert it.
Using Standard Editing Tools

Standard editing tools are available to you for updating stylesheets. From the Edit menu or tool bar you can cut, copy, paste, replace, undo, redo, select all, and find. The usual keyboard shortcuts work as well:

- Ctrl+X cuts highlighted text.
- Ctrl+C copies highlighted text.
- Ctrl+V pastes text.
- Ctrl+Z undoes the most recent action that has not already been undone.
- Ctrl+Y redoes the most recently undone action that has not already been redone.

For additional shortcuts, see “Keyboard Accelerators”.

Saving Stylesheets

When you save a stylesheet, Stylus Studio uses the encoding that is specified in the Params/Other tab of the XSLT editor. You can change the encoding by changing the setting in the Params/Other tab or in the initial processing instruction in the stylesheet. When you change one of these, Stylus Studio automatically changes the other. They are always the same.

To save an XSLT stylesheet, do one of the following:

- Click Save
- Press Ctrl+S.
- Select File > Save from the Stylus Studio menu bar.

To save your stylesheet to another file, select File > Save As.

To save multiple files, select File > Save All. This saves all files that are open in Stylus Studio.

Tip You can set an option that instructs Stylus Studio to save your modified documents every few minutes. See “Options - Application Settings”.

Using Updated Stylesheets

Within a scenario, Stylus Studio automatically uses any updated files when you apply a stylesheet. It does not matter whether you have explicitly saved a file in the scenario. If a stylesheet includes or imports other stylesheets, Stylus Studio automatically uses any updated versions of included or imported stylesheets even if you have not explicitly saved them.
However, there is one situation in which Stylus Studio does not automatically use updated stylesheets. Suppose that multiple stylesheets are open in Stylus Studio. Each stylesheet generates a Web page, and the Web pages have links to each other. The stylesheets do not include or import each other. You make changes in more than one of these stylesheets and you do not explicitly save any changes. You apply one of the stylesheets, and in the Preview window you click a link to another Web page generated by one of the other stylesheets you updated. In this situation, Stylus Studio does not apply the updated stylesheet. You must explicitly save the stylesheet to be able to use the updated version.
Creating Stylesheets That Generate HTML

The WYSIWYG HTML editor is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

The WYSIWYG HTML editor allows you to design stylesheets that generate HTML in a way that is easier than typing all required XSLT instructions.

Stylus Studio synchronizes the XSLT Source and WYSIWYG tabs in the XSLT editor. Any updates you make in one tab are automatically reflected in the other tab. This allows you to go back and forth between these two views as needed. You might find that it is easier to insert some XSLT instructions directly, and then return to the WYSIWYG tab.

In the WYSIWYG tab, Stylus Studio displays a tree that represents the XML source document that the stylesheet operates on. It is important to note that when the XML source document is associated with a schema, the tree still represents the XML source document. It does not represent the associated schema.

The stylesheet that you design in the WYSIWYG tab can generate HTML or XHTML. Consequently, the output method must be HTML or XML. The output method cannot be text or unspecified.
Working with XSLT

This section covers the following topics:

- Descriptions of WYSIWYG Terms on page 364
- Inserting Contents in the HTML Editor on page 365
- Displaying a Repeating Element in the HTML Editor on page 366
- Adding Conditional Processing in the HTML Editor on page 366
- Instantiating Templates in the HTML Editor on page 369
- Specifying Properties and Attributes in the HTML Editor on page 370

Descriptions of WYSIWYG Terms

The following terms are used to describe parts of the WYSIWYG tab:

- placeholder - an element or attribute name in double angle brackets. It represents dynamic text.
- marker - a small image to the left of a placeholder or table row. Hold the cursor over a marker to see the XSLT instruction it represents and the context in which it operates.
- glyphs - pairs of images that specify choose, if, or repeat. The corresponding XSLT instruction operates on the text represented by the enclosed placeholder or element.

To remove the glyphs, select the enclosed item, and right-click it to display a pop-up menu. Click Unwrap selected element.
Inserting Contents in the HTML Editor

The **WYSIWYG** tab provides an HTML editor that operates as you would expect. You can type text and select it to format it. The usual formatting tools appear in the **WYSIWYG** tool bar. Select the text you want to operate on and then click the tool that provides the feature you want.

<table>
<thead>
<tr>
<th>Image Position</th>
<th>Insert Table</th>
<th>Insert Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Image Position" /></td>
<td><img src="image" alt="Insert Table" /></td>
<td><img src="image" alt="Insert Image" /></td>
</tr>
</tbody>
</table>

**Figure 218. WYSIWYG Tool Bar**

**Image Position** allows you to specify whether the position of an image is fixed or dependent on the contents that come before it. Click the image for which you want to set this position attribute. Then click **Make Absolute** if you want the image to always appear in the same location regardless of where the image is in the HTML source. You can also specify whether the image is movable. When **Movable** is selected, you can move the image to a new location. The image always appears in the new location unless you explicitly move it again.
Displaying a Repeating Element in the HTML Editor

In the source tree diagram, repeating elements are identified by \( \text{\(\text{\textcopyright}\)} \).

There are several ways to define a repeating element in the HTML canvas:

- Drag a repeating element from the XML source tree and drop it onto the HTML canvas. In the pop-up menu that appears, click `xsl:for-each`.
- Click `Insert Table`, drag and drop a repeating element onto a table cell, and click `Make Repeating` in the pop-up menu.

When you define a repeating element, Stylus Studio displays a marker (\( \text{\(\text{\textcopyright}\)} \)) to the left of the element. When you click this marker, Stylus Studio displays the properties of the elements that are displayed by the `xsl:for-each` instruction.

When you select `Add Table` from the pop-up menu, Stylus Studio always creates a tables with two columns. You can, of course, delete one of the columns if you do not need it.

When you drag a repeating element onto a placeholder that is already a repeating element, Stylus Studio displays a pop-up menu that includes the `Reset repeating XPath` option. Select this option if you want to reset the context for the repeating element. The new context is the element that you dragged in.

Adding Conditional Processing in the HTML Editor

Conditional processing can be on a single item, a repeating item or a row.

- To specify conditional processing on a single or repeating item, right-click the placeholder and select `Conditional Processing` from the pop-up menu.
- To specify conditional processing for an entire row, right-click in the row, and select `Conditional Processing (Table Row)` from the pop-up menu.

You can then specify whether you want to insert an `xsl:choose` or `xsl:if` instruction.

Only one branch of a conditional instruction can be active at any one time. Consequently, the HTML canvas might haze or hide glyphs and placeholders. If you want to operate on a placeholder that is not visible, you must change the active branch.

When you specify conditional processing on a table row, a marker (\( \text{\(\text{\textcopyright}\)} \)) appears to the left of the table row. You can move the cursor over the marker to display a message that indicates the active branch. Click the marker to display the properties for the active conditional branch associated with the marker your clicked.
This section covers the following topics:

- Specifying Choose Conditional Processing in the HTML Editor on page 367
- Specifying If Conditional Processing in the HTML Editor on page 368

### Specifying Choose Conditional Processing in the HTML Editor

At any point in time only one branch of an `xsl:choose` instruction can appear in the HTML canvas. This is the active branch. When you specify formatting or properties for a branch of an `xsl:choose` instruction, it applies to only the elements in that branch. When you move the cursor over a `choose` glyph, Stylus Studio displays a message that specifies which branch is the active branch.

Use the **Choose Manager** to define the test conditions in the `xsl:choose` instruction. Use the **Properties** window to change the active branch.

#### Choose Manager

1. Right click on the placeholder for which you want to define the `xsl:choose` instruction.

2. In the shortcut menu that appears, select **Conditional Processing > Add Choose**. Stylus Studio displays the **Choose Manager** dialog box.

![Choose Manager Dialog Box](image)

3. Click **Copy** to define a test condition, which must be an XPath expression. You can define as many conditions as you need. Each condition you add corresponds to an `xsl:when` instruction.
Working with XSLT

4. If you do not need it, select the true() condition and delete it.

5. To specify an xsl:otherwise instruction, add a condition and leave it blank.

6. Click OK.
   Stylus Studio creates an xsl:choose instruction that wraps the placeholder or row that you selected.

Change active branch

1. In the HTML canvas, click a choose glyph for the active branch you want to change.
   Stylus Studio displays the properties for the xsl:choose instruction you clicked.

2. In the Properties window, click the when field.

3. Click the down arrow to display the drop-down menu.

4. Click the branch you want to be active.

For a new xsl:choose instruction, the Choose Manager displays one test expression: true(). This is the initial, required, xsl:when instruction.

Tip
Stylus Studio displays only what you can operate on based on the active conditional branch. In other words, if processing at a particular point cannot operate on certain elements, then those elements do not appear in the HTML canvas. If you make an xsl:choose branch active, and the XSLT processor cannot reach it, Stylus Studio displays a false() glyph.

Specifying If Conditional Processing in the HTML Editor

1. Select the placeholder for which you want to define the xsl:if instruction.

2. In the pop-up menu that appears, select Conditional Processing > Add If. Stylus Studio displays the Input dialog box.
3. In the Test Condition field, specify an XPath expression. Stylus Studio evaluates it in the context of the placeholder to which you are adding the xsl:if instruction.

4. Click OK.
You can specify multiple xsl:if instructions on the same placeholder.

Instantiating Templates in the HTML Editor

1. Drag an element or attribute from the source tree and drop it on the HTML canvas.
2. In the pop-up menu that appears, click xsl:apply-templates.
Stylus Studio creates a template that matches the node you dragged in. You can select the placeholder, and apply formatting. Stylus Studio adds this information to the template.

Calling a Named Template

If you have one or more named templates in your stylesheet, or if you want to define a named template, you can add an xsl:call-template instruction.

1. Do one of the following:
   ■ Right-click in the HTML canvas and select Add call-template from the pop-up menu. You can then drag contents to between the xsl:call-template glyphs.
   ■ Select a placeholder or element in the HTML canvas. Right-click to display the pop-up menu, and select Add call-template.
2. Click the name of the template you want to instantiate, or click Create new template to create a new named template.

Note If you delete xsl:apply-templates glyphs, the corresponding template is still defined in the XSLT source. You must delete this definition in the source when you want to define new contents for the corresponding template in the HTML editor.
Specifying Properties and Attributes in the HTML Editor

The Properties window displays the properties for the location you click in the HTML canvas. The immediately visible properties are for the element that directly contains the location you clicked.

In the Properties window, click the down arrow to display a list of the elements that enclose the element that directly contains the location you clicked. The elements are listed from innermost to outermost. Click an element to display its properties.

Specifying Extension Functions in Stylesheets

You can write XSLT extension functions in Java and invoke them in XPath expressions in stylesheets. This section provides instructions for implementing and invoking extension functions from your stylesheet. The syntax supported is a subset of that supported by LotusXSL/Apache Xalan.

This section covers the following topics:

- Using an Extension Function in Stylus Studio on page 371
- Basic Data Types on page 372
- Declaring an XSLT Extension Function on page 372
- Working with XPath Data Types on page 373
- Declaring an Extension Function Namespace on page 373
Using an Extension Function in Stylus Studio

The process of using an extension function in Stylus Studio involves three main steps:

1. First, you need to write a Java class that can be used from within a stylesheet. In this example, the `SystemDate()` method returns the system date and time as a string:

   ```java
   import java.util.Date;
   public class SystemUtils {
       public Object SystemDate() {
           Date d = new Date();
           String s = d.toString();
           return s;
       }
   }
   ``

2. Second, compile your class and register it on the Stylus Studio host by copying the `.class` file to a location defined in the host’s `CLASSPATH` environment variable.

3. Finally, specify information in the stylesheet so that Stylus Studio can use your class. You do this with a namespace reference in the `xsl:stylesheet` tag. For example, define a namespace as `xmlns:Ext` where `Ext` is the prefix to use when calling the class methods. (`Ext` is not a predefined keyword; it can be replaced by any other legal string.) The namespace reference then takes the class name as a value. In this example, the whole reference looks like the following:

   ```
   xmlns:Ext="SystemUtils"
   ``

   The class is now available from within the stylesheet and can be used in a template such as the following:

   ```
   <xsl:template match="NODE">
     <p><xsl:value-of select="Ext:SystemDate()"/></p>
   </xsl:template>
   ```

   ```
   import java.util.Date;
   public class SystemUtils {
       public Object SystemDate() {
           Date d = new Date();
           String s = d.toString();
           return s;
       }
   }
   ```
The XSLT stylesheet might look like the following:

```xml
<?xml version="1.0" encoding="ISO-10646-UCS-2"?>
<xsl:stylesheet xmlns:xsl="http://www.w3.org/XSL/Transform"
    xmlns:Ext="SystemUtils">
    <xsl:param name="param">test</xsl:param>
    <xsl:template match="*|/">
        <xsl:apply-templates/>
    </xsl:template>
    <xsl:template match="text()|@*">
        <xsl:value-of select="."/>
    </xsl:template>
    <xsl:template match="NODE">
        <p><xsl:value-of select="Ext:SystemDate()"/></p>
    </xsl:template>
</xsl:stylesheet>
```

### Basic Data Types

XPath and XSLT data types map to Java data types according to Table 33:

**Table 33. XPath/XSLT and Java Type Mappings**

<table>
<thead>
<tr>
<th>XPath/XSLT Type</th>
<th>Java Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Set</td>
<td>org.w3c.dom.NodeList</td>
</tr>
<tr>
<td>String</td>
<td>java.lang.String</td>
</tr>
<tr>
<td>Boolean</td>
<td>boolean or Boolean</td>
</tr>
<tr>
<td>Number</td>
<td>double or Double</td>
</tr>
<tr>
<td>Result Tree Fragment</td>
<td>org.w3c.dom.DocumentFragment</td>
</tr>
</tbody>
</table>

### Declaring an XSLT Extension Function

Extension functions must have one of the following signatures:

- `public Object FxnName()`
- `public Object FxnName(Type1 var1, Type2 var2, ...)`
- `public static Object FxnName()`
- `public static Object FxnName(Type1 var1, Type2 var2, ...)`
Specifying Extension Functions in Stylesheets

A class that contains an extension function might look like the following:

```java
import org.w3c.dom.*;
import java.lang.Double;
public class NumberUtils {
    public Object Average(NodeList nl) {
        double nSum = 0;
        for (int i = nl.getLength() - 1; i >= 0; i--)
            nSum += Double.valueOf(nl.item(i).getNodeValue()).doubleValue();
        return new Double(nSum / nl.getLength());
    }
}
```

Working with XPath Data Types

The XPath types `Boolean` and `Number` can map either to the corresponding Java primitive
types or to the corresponding Java object types. If the XPath processor is looking for a
function that accepts XPath parameters `3.2` and `true`, it looks first for a function that
accepts `(double, boolean)` and then `(Double, Boolean)`. Functions that accept some
combination of primitive types and object types are not recognized by the XPath
processor.

The XPath processor determines the actual return type of a function at run time. For
example, the XPath processor treats the return type of the function in the preceding
section as an XPath `Number` because the object it returns is an instance of the Java class
`Double`. You must declare all functions to return type `Object`, regardless of the actual type
of the return value.

Declaring an Extension Function Namespace

In conformance with the XSLT specification, extension functions are accessed through a
unique namespace. The namespace declaration can be in any of the following locations:

- `xsl:stylesheet` tag
- Element that contains the XPath expression that invokes the extension function
- Ancestor of the element that contains the XPath expression that invokes the extension
  function

The XPath processor treats the namespace URI as a fully qualified class name. If the class
name is preceded by `class:`, all calls are to static methods only. Otherwise, an instance of
the class is created on first use and released when stylesheet processing is complete. Performance is better when you use a static method because creation and deletion of an instance of the class is not required.

You can separate package names with either a dot (.) or a forward slash (/). An sample namespace declaration might look like the following:

```xml
<xsl:stylesheet xmlns:Ext="NumberUtils"/>
```

The XPath processor resolves namespace prefixes in names of extension functions relative to the namespace declarations in the stylesheet.

### Invoking Extension Functions

You use XSLT extension functions just like built-in XPath functions. For example:

```xml
<xsl:value-of select="Ext:Average(portfolio/stocks/last)"/>
```

### Finding Classes and Finding Java

The XPath processor looks for extension classes by using the CLASSPATH environment variable. Ensure that your CLASSPATH references any directories or .jar files that contain extension classes.

The XPath processor tries to load the Sun Java Runtime Environment (JRE) 1.4.x or later. If the XPath processor cannot find a suitable JRE, invoking Java extension functions causes an error during stylesheet processing.

In Stylus Studio, classes are reloaded each time you refresh the preview output, so changes in a class are reflected in subsequent preview output.

### Debugging Stylesheets That Contain Extension Functions

Support for extensions debugging is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

You can use Stylus Studio backmapping and debugging features on stylesheets that invoke extension functions. You must process the stylesheet with one of the following processors:

- Built-in Stylus Studio XSLT processor
- Xalan-J XSLT processor
- Saxon processor
The Xalan-J and Saxon processors do not allow you to step into JavaScript extensions. You can step into Java extensions, however.

**Working with Templates**

Templates define the actions that you want the XSLT processor to perform. When you apply a stylesheet to an XML source document, the XSLT processor populates the result document by instantiating a sequence of templates. This is illustrated in “Understanding How the Default Templates Work” on page 337.

A template can contain elements that specify literal result nodes. It can also contain elements that are XSLT instructions for creating result nodes. In a template, the template rule is the pattern that the XSLT processor matches against (compares with) selected nodes in the source document.

This section covers the following topics:

- Viewing Templates on page 375
- Using Stylus Studio Default Templates on page 377
- Creating Templates on page 379
- Applying Templates on page 380
- Updating Templates on page 380
- Deleting Templates on page 380

**Viewing Templates**

Stylus Studio provides different ways to display lists of templates, specific templates, as well as ways to see if a given template generates any output.
Viewing a List of Templates

1. Click the down arrow in the upper right corner of the XSLT editing pane.

```
xsl:apply-templates select="author"/>
</td>
<td align="right">
  xsl:apply-templates select="price"/>
</td>
</tr>
</table>
```

![Figure 221. Choosing Available XSLT Templates](image)

Stylus Studio displays a drop-down list of the first five match patterns in the stylesheet. To limit the displayed list, type in the combo box to the left of the down arrow. Stylus Studio displays only those patterns that match the character(s) you typed.

**Note** A particular template might or might not have a match pattern (template rule). Named templates do not necessarily specify match patterns.

2. Click the match pattern for the template you want to view. It does not matter whether the XSLT editor is in **Full Source** mode or **Template** mode.

Viewing a Specific Template

To view a particular template, double-click its matching element in the XML tree view, which is displayed to the right of the editing pane. If the element has more than one template, Stylus Studio displays a list of the templates. Click the one you want.

Checking if a Template Generates Output

1. Select a template in the XSLT templates pane.
2. Click **Refresh** to apply the stylesheet.
3. In the **XSLT Preview** window, with output text displayed, scroll as necessary to find text highlighted in gray. Text with a gray background was generated by the selected template.

### Using Stylus Studio Default Templates

Every stylesheet in Stylus Studio can use two built-in templates, even though they are not explicitly defined. This section covers the following topics to help you use these templates:

- Contents of a New Stylesheet Created by Stylus Studio on page 377
- About the Root/Element Built-In Template on page 378
- About the Text/Attribute Built-In Template on page 378

#### Contents of a New Stylesheet Created by Stylus Studio

When Stylus Studio creates a new stylesheet, the stylesheet includes the following built-in templates:

```xml
<xsl:template match="*|/">
    <xsl:apply-templates/>
</xsl:template>
<xsl:template match="text()|@*">
    <xsl:value-of select="."/>
</xsl:template>
```

Every XSLT stylesheet contains these templates whether or not they are explicitly specified. In other words, the XSLT processor behaves as if they are there even when they are not explicitly specified in the stylesheet.
About the Root/Element Built-In Template

The first built-in template matches *|/. This means it matches every element in the source document and it matches the root node. This is the root/element built-in template.

This root/element built-in template contains only the xsl:apply-templates instruction. The xsl:apply-templates instruction does not specify a select attribute, which means that the XSLT processor operates on the children of the node for which the root/element template was instantiated.

What does the XSLT processor do when it operates on these children nodes? It searches for a template that matches each node. If there is no such template and if the node is an element, the XSLT processor instantiates the root/element built-in template. If the node is a text node and there is no matching template, the XSLT processor instantiates the text/attribute built-in template.

If the node for which the root/element built-in template is instantiated has no children, the XSLT processor does no processing for this node and proceeds to the next selected node.

The XSLT processor instantiates the root/element built-in template when it cannot find a template that explicitly matches the root node or an element in the source document. As you know, the XSLT processor always begins processing by instantiating the template that matches the root node. If you do not define such a template in your stylesheet, the XSLT processor begins processing by instantiating the root/element built-in template.

About the Text/Attribute Built-In Template

The second specified built-in template matches text()|@*. This means it matches the text contents of every text node and every attribute in the source document. This is the text/attribute template.

This template contains only the xsl:value-of instruction. Its select attribute specifies an expression for selecting an XML node. The "." expression identifies the current node, which is the node the template was instantiated for.

This template copies the text contained in the current text node or attribute to the result document.
Creating Templates

To do anything beyond copying the text from your XML document to the result document, you must create templates. You can create new templates several ways:

- In the source tree of the XSLT editor, double-click the element or attribute for which you want to create a template. Stylus Studio creates an empty template that matches the node you clicked. This template appears at the end of the stylesheet.

- Click New Template. Stylus Studio creates an empty template whose match pattern is NewTemplate. Replace NewTemplate with a match pattern that has meaning for your stylesheet. The new template appears at the end of the stylesheet.

- Drag an element or node from the source tree in the XSLT editor to the Full Source pane and drop it in a location that is not in a template. Stylus Studio creates a new template that matches the node you dragged in.

1. Double-click an element in the tree view of your XML document.
2. Enter the following instruction in the new template:
   `<b><xsl:value-of select="."/></b>`
3. In another template, ensure that there is an `xsl:apply-templates` instruction that selects the new template’s element for processing.
4. Press F5 to apply the stylesheet and refresh the current scenario in the Preview window.

Notice that the text contents of the element for which you created the template are now displayed in bold – the XSL instruction is formatted with `<b>` and `</b>`. Also, the XSLT processor does not process this element’s children (if there are any) because the new template you created does not specify `<xsl:apply-templates/>`.

By creating additional templates to style portions of your XML document, you can completely control how the document appears.

Saving a Template

To save a template, save the stylesheet. Click Save in the Stylus Studio tool bar, or select File > Save from the Stylus Studio menu bar.
**Applying Templates**

The `xsl:apply-templates` instruction allows you to control the order of operations when you apply a stylesheet. For an in-depth description of how the XSLT processor applies templates, see “How the XSLT Processor Applies a Stylesheet” on page 317.

To apply a template so that you can see the output in the Preview window, you must apply the entire stylesheet. Press F5 to apply the stylesheet and refresh the output. If Stylus Studio detects any errors in the stylesheet or in the XML source document, it displays a message that indicates the cause and location of the error.

In the Preview window, in the Text view, the text with a gray background was generated by the template the cursor is in. If the editor is in Template mode, the text with the gray background was generated by the currently visible template.

**Updating Templates**

When you want to update a template, you can use all features that are available when you are updating a stylesheet. See “Updating Stylesheets” on page 359.

**Deleting Templates**

1. Select the text for the template you want to delete.
2. Right-click in the editor to display the shortcut menu.
3. Click Cut.

**Using Third-Party XSLT Processors**

In addition to a built-in XSLT processor, Stylus Studio includes several third-party XSLT processors, including Saxon (8 and 6), Xalan-J, MSXML, and .NET. Note, however, that only the following XSLT processors support Stylus Studio stylesheet debugging and back-mapping functionality:

- Stylus Studio's built-in XSLT processor
- Saxon 8 and 6
- XalanJ
- Microsoft .NET (XslTransform and XslCompiledTransform)
Back-mapping and debugging are not supported by other XSLT processors, including others bundled with Stylus Studio (MSXML 4.0, for example).

**Note**  You can use only the built-in XML parser with Stylus Studio.

This section covers the following topics:
- How to Use a Third-Party Processor on page 381
- Setting Default Options for Processors on page 383

### How to Use a Third-Party Processor

You specify XSLT processors for stylesheets individually. You can, of course, create multiple scenarios for the same stylesheet, with each one using a different processor. When you use a third-party XSLT processor, output from the processor appears in the Preview window.

1. Open the stylesheet.
2. In the XSLT Editor, in the scenario name field, click the down arrow to display the scenarios associated with the stylesheet.
3. To use a third-party processor for an existing scenario, click the scenario name, and then click ![...](Scenario Properties) to display the **Scenario Properties** dialog box.
   
   To create a new scenario, click **Create Scenario**. See “Creating a Scenario” on page 354.
4. In the **Scenario Properties** dialog box that appears, click the **Processor** tab.
5. Select the XSLT processor you want to use from the **Processor** drop-down list.
   
   **Note** Stylus Studio allow you to choose an MSXML option only if you have the MSXML or MSXML .NET Framework (version 1.1 or 2.0) installed.
6. Optionally, change the default settings for the processor you selected.
7. If you selected a standard XSLT processor, you are done. Click **OK**.
   
   If you selected **Use custom processor (%1 xml, %2 xslt, %3 output):**
   
   a. In the **Command line** field, type the command line for invoking the processor you want to run. You must specify the command line so that it is clear where to use the three arguments. Following are two examples:

   ```
   myparser %1 %2 %3
   myparser -inputxslt %2 -inputxml %1 -out %3
   ```
b. In the **Path** field, specify any path that needs to be defined for the processor to run. Typically, this is the location of the processor.

c. In the **Classpath** field, type any directories the external processor needs to access that are not already specified in your CLASSPATH environment variable.

d. Click **OK**.

**Using the Saxon Processor**

Stylus Studio lets you execute XSLT documents using either the Saxon-B (basic) or Saxon-SA (schema-aware) processor. You specify which processor you want to use with the **Execution mode** property in the **Saxon XSLT Settings** dialog box. Settings that have command line equivalents in Saxon show the command in parentheses following the property name. Some settings are available only if you are using Saxon-SA.

Stylus Studio’s Sense:X syntax coloring and auto-completion provides full support for Saxon syntax, so long as the Saxon Logic XSLT processor is either associated with the current XSLT scenario or has been set as the default XSLT processor.

If you want to use the Saxon processor:

1. On the **Processors** tab, click **Saxon**.

   The **Settings** button becomes active.

2. Click the **Settings** button.

   The **Saxon XSLT Settings** dialog box appears.

   ![Figure 222. Saxon XSLT Settings Dialog Box](image-url)
3. Complete the settings as desired. Press F1 to access the Stylus Studio online help, or refer to the Saxon documentation for more information.

4. Click OK.

**Passing Parameters**

To pass parameters to the Stylus Studio built-in XSLT processor or to the Xalan-J, Microsoft .NET, Saxon, or MSXML processor, specify them in the **Parameters** tab of the **Scenario Properties** dialog box. To pass parameters to a custom external processor, you must specify them in the command line you enter.

**Setting Default Options for Processors**

If you want, you can set default values for XSLT processor options and designate a processor other than the built-in processor as the default processor used whenever you create an XSLT scenario.

You can always override the default processor and individual processor settings at the scenario level.

1. From the Stylus Studio menu, select **Tools > Options**.
   Stylus Studio displays the **Options** dialog box.
Working with XSLT

2. Select Module Settings > XSLT Editor > Processor Settings.

3. Select the processor for which you want to specify default settings from the Processor drop-down list.

4. If required, complete processor-specific settings. (Click the Settings button.)

5. If you want this processor to be used as the default processor for all XSLT scenarios, click the Use as default processor check box.

6. Click OK.

Validating Result Documents

You can optionally validate the XML document that results from XSLT processing. You can validate using the

- Stylus Studio built-in processor (Xerces C++). If you use the Stylus Studio built-in processor, you can optionally specify one or more XML Schemas against which you want the result document to be validated.

- Any of the customizable processors supported by Stylus Studio, such as the .NET XML Parser, Xerces-J, and XSV.

All validation is done before any post-processing that you might have specified.
Validating Result Documents

1. Open the stylesheet whose results you want to validate.
2. In the XSLT Editor (XSLT Source or Mapper tabs), in the scenario name field, click the down arrow and click the name of the scenario for which you want to perform validation.
3. Click Browse to open the Scenario Properties dialog box.
4. Click the Validation tab.

![Figure 224. Validation Tab for XSLT Scenarios]

5. Click Validate stylesheet result.
6. If you are using Stylus Studio's built-in validation engine, optionally, specify the XML Schemas against which you want to validate the XML result document. Otherwise, go to Step 7
   a. Click the Open file button ( ).
      The Open dialog box appears.
   b. Select the XML Schema you want to use for validation.
   c. Click the Open button to add the XML Schema to the Validation tab.
   d. Optionally, add other XML Schemas.
   e. Go to Step 8.
7. Click the **Use custom validator** button, and select the validation engine you want to use from the drop-down list box.

8. Click **OK**.

### Post-processing Result Documents

You can use a scenario’s post-processing settings to specify that you want Stylus Studio to initiate processing on the result of applying a stylesheet. If you do, Stylus Studio performs the post-processing before it displays the result in the **Preview** window. Stylus Studio can postprocess the result of its built-in XSLT processor or an external XSLT processor.

You can choose to run the Apache Software Organization’s Formatting Objects Processor (FOP) as a postprocessor. You can run this on the result of stylesheets that generate XML documents that contain FO. The Apache FOP included with Stylus Studio converts FO XML into PDF and displays it in the Stylus Studio preview window. See “Generating Formatting Objects” on page 387.

1. Open the stylesheet whose result you want to process.

2. In the XSLT Editor (**XSLT Source** or **Mapper** tabs), in the scenario name field, click the down arrow and click the name of the scenario in which you want to specify post-processing.

3. Click **Browse** to open the **Scenario Properties** dialog box.

4. Click the **Post-process** tab.

5. Click one of the following:
   - **Post Process With Apache FOP** if you want Stylus Studio to initiate the Apache FOP. You are done. Click **OK**.
   - **Custom Post-Process** if you want Stylus Studio to initiate a postprocess you define. With this selection, you must also do the following:
     a. In the **Command line** field, type the command line for starting your postprocessor. For example, `mypostprocessor %1 %2`. You can specify any application or script that takes as input the result document generated by an XSLT processor and generates a new file.
     b. In the **Generated File Extension** field, type the extension on the file name of the postprocessor output. For example, `.pdf`.
Generating Formatting Objects

You can use Stylus Studio to develop a stylesheet that generates XSL Formatting Objects (FO). In the scenario in which you apply such a stylesheet, you can specify that Stylus Studio should run a Formatting Objects Processor (FOP) on the stylesheet’s result document. When you apply the stylesheet and preview the results, Stylus Studio displays the formatted results.

Stylus Studio includes The Apache Software Organization’s FOP, and it is configured to always generate PDF. If you want to run a FOP to generate some other type of output, you must specify some other FOP in the Custom post-process fields of the Post-process tab of the Scenario Properties dialog box.

Stylus Studio includes two sample stylesheets that generate formatting objects. These files are in the examples\XSLFormattingObjects directory of your Stylus Studio installation directory.

This section covers the following topics:

- Developing Stylesheets That Generate FO on page 387
- Troubleshooting FOP Errors on page 388
- Viewing the FO Sample Application on page 389
- Deploying Stylesheets That Generate FO on page 391
- Using Apache FOP to Generate NonPDF Output on page 392

Note  FO is a W3C recommendation for an XML vocabulary that describes how to format text. FO is one part of XSL. This section assumes that you are familiar with FO. For additional information about FO, see http://www.w3.org/TR/2001/REC-xsl-20011015/.

Developing Stylesheets That Generate FO

Tip  Initially, develop the stylesheet with Stylus Studio’s internal XSLT processor. It gives better error messages than the Xalan-J processor. When the transformation and display appear to work with the built-in XSLT processor, try using the Xalan-J processor in Stylus Studio. The Xalan-J processor is the one that the FOP uses when you apply this stylesheet from a command line.
Working with XSLT

1. Define the scenario in which you want to apply the stylesheet that generates FO. See “Creating a Scenario” on page 354.

2. In the Scenario Properties dialog box, in the Post-process tab, do one of the following:
   ○ Select Postprocess with Apache FOP.
     The Apache FOP included with Stylus Studio is configured to convert FO XML into PDF. Stylus Studio then uses Acrobat Reader to display the PDF in the Stylus Studio preview window.
   ○ Specify some other FOP in the Custom post-process fields. You must do this when you want to generate output other than PDF. If you want to use the Apache FOP included with Stylus Studio to generate a format other than PDF, you can do that here.
     See “Post-processing Result Documents” on page 386.

3. In the XSLT editor, define a stylesheet that generates FO. As soon as you type <fo:, Stylus Studio displays a completion menu of FO that you can select from.

4. Apply the stylesheet to an XML document.
   After Stylus Studio transforms the XML document to generate a result XML document that contains formatting objects, Stylus Studio automatically runs the FOP you specified on the result document. Stylus Studio then displays the postprocess result in the XSLT Preview window.

Troubleshooting FOP Errors

If the transformation works well, but the FOP generates an error, obtain a copy of RenderX’s Unofficial DTD for XSL Formatting Objects. You can find this at http://www.renderx.com. Although this DTD is not official (it is more limited than what the W3C XSL recommendation defines), it is a helpful debugging tool.

1. Copy the DTD to a location such as C:\fo.dtd.

2. Include a document type declaration, such as the following, in your generated document:
   <!DOCTYPE fo:root SYSTEM "fo.dtd">

3. Turn off post-processing.

4. Apply the stylesheet.

5. Save the resulting XML document.
Generating Formatting Objects

6. Open the saved XML document in Stylus Studio.
7. Click Validate Document.

Viewing the FO Sample Application

1. In Stylus Studio, open the `examples\XSLFormattingObjects\minimal-catalog.xsl` file in your Stylus Studio installation directory.

Alternative: If the Stylus Studio examples project is open, you can access this file from the Project window. To open the examples project, open `examples.prj` in the Stylus Studio examples directory.

The video scenario has already been defined. In the Post-process tab of the Scenario Properties dialog box, Postprocess with Apache FOP is selected.

In this scenario, Stylus Studio selects elements to operate on from three different documents. These documents are in the examples directory of the Stylus Studio installation directory. They are also in the examples project. The documents are:

- VideoCenter\videos.xml
- simpleMappings\books.xml
- simpleMappings\catalog.xml
2. Click Preview Result 🎞️. As you can see, the Output Window shows some post-processing information messages.

![Screenshot of Stylus Studio with Preview Result window open]

Figure 225. Example of XSLT FO Processing

After a few seconds, the Preview window displays the PDF result in Acrobat Reader. The result contains a few lines of text for each video and book found in the XML source documents. The title, author or director, and the description is included for each item. It is hard to see where information for one item ends and another begins.

3. Examine the stylesheet. It contains the minimum FO instructions required to generate FO. There is no formatting to make the result document easier to read. You can use this stylesheet as a skeleton for creating your own stylesheets that generate FO.

4. Now open the examples\XSLFormattingObjects\catalog.xsl stylesheet.
5. Click Preview Result.

This time the PDF result in the Preview window is nicely formatted. The catalog.xsl stylesheet adds some basic formatting, as well as images, to the minimal-catalog.xsl stylesheet. Now it is easy to distinguish the title, author or director, and description for each video or book.

Deploying Stylesheets That Generate FO

When your stylesheet is complete, the process for creating a final document, such as a PDF document, from an XML document is as follows:

1. Apply a stylesheet to an XML document. This results in an XML document that contains XSL FO.
2. Run a FOP, such as Apache’s FOP, and use the generated XML as input.

Example

You can accomplish both steps with a single invocation of FOP on the command line. For example:

```
java -cp "C:\Program Files\StylusStudio\bin\Plugins\Fop\fop.jar;C:\Program Files\StylusStudio\bin\xalan.jar" org.apache.fop.apps.Fop -xml ..\VideoCenter\videos.xml -xsl catalog.xsl -pdf multimediacatalog.pdf
```

Replace C:\Program Files\StylusStudio with the name of the directory in which Stylus Studio is installed.
Using Apache FOP to Generate NonPDF Output

The Apache FOP included with Stylus Studio is configured to output PDF.

1. Open the stylesheet whose results you want to postprocess with the Apache FOP.

2. Create or open a scenario in which to do the post-processing. See “Creating a Scenario” on page 354. Stylus Studio displays the Scenario Properties dialog box.

3. In the Scenario Properties dialog box, click the Post-process tab.

4. Select Custom post-process.

5. In the Command line field, enter something like the following:
   
   ```
   java -cp "C:\Program Files\StylusStudio\bin\Plugins\Fop\fop.jar"
   org.apache.fop.apps.Fop -fo %1 -svg %2
   ```

   Modify this sample command line according to where Stylus Studio is installed and what kind of output you want the FOP to generate. The last option, -svg in the example, can be any of the following:

   **Table 34. FOP Output Options**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>-mif</td>
<td>MIF file</td>
</tr>
<tr>
<td>-pcl</td>
<td>PCL file</td>
</tr>
<tr>
<td>-txt</td>
<td>Text file</td>
</tr>
<tr>
<td>-svg</td>
<td>SVG slides file</td>
</tr>
<tr>
<td>-at</td>
<td>XML (representation of an area tree)</td>
</tr>
<tr>
<td>-pdf</td>
<td>PDF file</td>
</tr>
</tbody>
</table>

6. In the Generated file extension field, specify the extension that indicates the type of output you want. For example, specify .txt if you want the FOP to generate a text file.

7. If there is additional path information that the FOP will require to execute successfully, type it in the Additional path field.

8. Click OK.
Generating Scalable Vector Graphics

The procedure for defining a stylesheet that generates an XML document that contains Scalable Vector Graphics (SVG) is the same as for any other stylesheet. Simply create a stylesheet that specifically creates SVG elements. You can then use Stylus Studio to display the rendered SVG.

**Note** SVG is a W3C recommendation for an XML vocabulary that describes two-dimensional graphics. It is assumed that you are familiar with SVG. For additional information about SVG, see [http://www.w3.org/Graphics/SVG](http://www.w3.org/Graphics/SVG).

About SVG Viewers

If you have an installed SVG viewer, Stylus Studio automatically displays the rendered SVG when you apply the stylesheet.

If you do not have an installed SVG viewer, you can still define a stylesheet that generates SVG. However, when you try to preview the result of the stylesheet, Stylus Studio displays the generated XML. You can download an SVG viewer from Adobe Systems Incorporated at [http://www.adobe.com/support/downloads/main.html](http://www.adobe.com/support/downloads/main.html). Under **Readers**, select the SVG Viewer for **Windows**. After you install an SVG viewer, you must restart Stylus Studio and Internet Explorer to be able to view the rendered graphics.

Running the SVG Example

1. In Stylus Studio, open the `examples\SVG\chart.xsl` file in your Stylus Studio installation directory.
   
   **Alternative**: If the Stylus Studio `examples` project is open, you can access this file from the **Project** window. To open the `examples` project, open `examples.prj` in the Stylus Studio `examples` directory.
   
   The `SalesFigures` scenario has already been defined. In this scenario, the stylesheet operates on elements in the `chart.xml` source document. This file is also in the `examples` project, and in the `examples\SVG` directory.

2. Click **Preview XSLT Result**. Stylus Studio automatically uses your installed SVG viewer to render the resulting XML and display the SVG.
   
   If you do not have an SVG viewer installed, Stylus Studio displays the resulting XML.
Generating Java Code for XSLT

Java code generation is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio includes a Java Code Generation wizard that creates Java code based on the scenarios defined for an XSLT document. This section describes scenario settings that affect the generated code, as well as procedures for generating, compiling, and running generated code.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Java Code Generation video.

A complete list of all the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

This section covers the following topics:

- “Scenario Settings” on page 394
- “Java Code Generation Settings” on page 397
- “How to Generate Java Code for XSLT” on page 397
- “Compiling Generated Code” on page 398
- “Deploying Generated Code” on page 400

Tip You can also generate Java code for XQuery. See “Generating Java Code for XQuery” on page 805.
**Scenario Settings**

Stylus Studio generates Java code based on the scenarios you have defined for an XSLT document. The following tables summarizes the scenario settings that have an effect on Java code generation.

**Table 35. Scenario Settings that Affect Java Code Generation**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The Java Code Generation wizard uses only the Source XML URL, and the Output URL field, if specified. All other properties on this page are ignored.</td>
</tr>
<tr>
<td>Parameter Values</td>
<td>Default parameter values and parameters in the form of XPath expressions are ignored.</td>
</tr>
<tr>
<td>Processor</td>
<td>You must use a Saxon or XalanJ processor. The Stylus Studio URI Resolver is also used to resolve non-standard URIs if you select the check box on the Processor page.</td>
</tr>
<tr>
<td>Profiling Options</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Validation</td>
<td>Validation is optional. If you choose to validate XSLT output, the Java Code Generation wizard always uses the Xerces-J processor, regardless of the validator you specify on the Validation tab. If you want to specify external schemas for validation purposes, click Use built-in validator. Note that the Xerces-J processor is used for validation even in this case.</td>
</tr>
<tr>
<td>Post-process</td>
<td>Only post-processing using Apache FOP is specified in the generated code. Resulting PDF is written to the output URL.</td>
</tr>
</tbody>
</table>
Choosing Scenarios

You can generate Java code for one or more of the scenarios defined for a single XSLT document. By default, the Java Code Generation wizard selects only the current scenario for generation, as shown in Figure 227.

![Figure 227. The Current Scenario Is Selected for Code Generation](image)

The generated code includes a `setScenario` method for every scenario you select for code generation, as shown in the following example.

```java
// Uncomment the setScenario call for the scenario you want the code to run. // All other scenarios must be commented out.
app.setScenario_myScenario();
// app.setScenario_Scenario1();
// app.setScenario_Video_0032_Scenario_0032_1()
```

Only one `setScenario` method can be called at a time. Uncomment the `setScenario` method for the scenario you want the code to process, and make sure that all other `setScenario` methods are commented.
Generating Java Code for XSLT

Java Code Generation Settings

When you generate Java code for an XSLT document, you need to specify

- The target directory in which you want the Java code created. c:\temp\myJavaCode, for example. If the directory you name does not exist, Stylus Studio creates it when you run the Java Code Generation wizard. The default is a \sources directory, which is created where you installed Stylus Studio when you generate the code, c:\Program Files\Stylus Studio\sources, for example.

- Optionally, a package name. If you specify a package name, this name is used for a subfolder created in the target directory you specify. If you specify myPackage as the package name, for example, the generated code is written to c:\temp\myJavaCode\myPackage. (Though optional, it is considered good practice to create a package name.)

- The class name. Stylus Studio also uses the class name for the .java file created by the Java Code Generation wizard. For example, if you provide the name myClass, Stylus Studio creates c:\temp\myJavaCode\myPackage\myClass.java.

In addition, you can specify whether or not you want to

- Create the class as a public class
- Include the main(String[] args) method
- Add the generated code to the current project

All of these options are selected by default.

Tip: If you choose to add the generated code to the project, it creates a folder using the package name you specify and places the .java file in that folder. If you do not specify a package name, the .java file is added directly below the project root in the Project window.

How to Generate Java Code for XSLT

1. Define at least one scenario for the XSLT for which you want to generate Java code. The scenario must use the Saxon processor. See “Scenario Settings” on page 394 for more information.

2. Select XSLT > Generate Java Code from the Stylus Studio menu.
Working with XSLT

The **Generate Java Code** dialog box appears.

![Java Code Generation Dialog Box](image)

**Figure 228. Java Code Generation Dialog Box**

3. Specify the settings you want for the target directory, package and class names, and so on. See “Java Code Generation Settings” on page 397 if you need help with this step.

4. Select the scenarios for which you want to generate Java code.

5. Click **OK**.

Stylus Studio generates Java code for the XSLT. When the code generation is complete, the resulting file (classname.java) is opened in the Stylus Studio Java Editor.

### Compiling Generated Code

In order to compile the Java code generated for XSLT, you need to make sure that the following JAR files are in the Stylus Studio classpath:

- CustomFileSystem.jar
- Saxon8.jar

These files are in the \bin directory where you installed Stylus Studio.
How to Modify the Stylus Studio Classpath

1. Select **Tool > Options** from the Stylus Studio menu.
2. Click **Java Virtual Machine** under **General**.
3. Click the browse button alongside the **Classpath** field. The **Add Directory or JAR File to Classpath** dialog box appears.
4. Click the browse folders button.
   A new entry field appears in the **Locations** list box. Two buttons appear to the right of the entry field.

![Figure 229. Entry Field for JAR File Classpath](image)

5. Click the browse jar files button.
   Stylus Studio displays the **Browse for JAR Files** dialog box.

![Figure 230. Browse for JAR Files Dialog Box](image)

6. Navigate to the Stylus Studio `\bin` directory, select the **CustomFileSystem.jar** file, then click **Open**.
7. Repeat Step 6, this time selecting the **Saxon8.jar** file.
8. Click **OK** to close the **Add Directory or JAR File to Classpath** dialog box.
How to Compile and Run Java Code in Stylus Studio

1. Make sure the Java Editor is the active window.

2. Click the **Compile** button ( ).
   
   *Alternatives:* Press Ctrl + F7, or select **Java > Compile** from the Stylus Studio menu.  
   Stylus Studio compiles the Java code. Results are displayed in the **Output** window.

1. Make sure the Java Editor is the active window.

2. Click the **Run** button ( ).
   
   *Alternatives:* Press Ctrl + F5, or select **Java > Run** from the Stylus Studio menu.  
   If the code has not been compiled, Stylus Studio displays a prompt asking if you want to compile the code now. Otherwise, Stylus Studio runs the Java code. Results are displayed in the **Output** window.

Deploying Generated Code

If your XSLT application uses Stylus Studio’s adapter file system technology – to convert CSV or EDI to XML, or to render relational data as XML, for example – you need to use the optional Stylus Studio 2006 XML Deployment Adapters if you wish to deploy your code to a test or application server. The Stylus Studio 2006 XML Deployment Adapters are purchased and installed separately from Stylus Studio 2006 XML Enterprise Edition. Write Stylus Studio at stylusstudio@stylusstudio.com, or call 781.280.4488 for more information.

Overview

The process for deploying generated XSLT code that uses Stylus Studio’s adapter file system technology includes the following steps:

In Stylus Studio

1. Build and test the application in Stylus Studio. When testing, be sure to use the XSLT processor you will be using in your production environment. You specify the XSLT processor on the **Processors** tab of the **Scenario Properties** dialog box.

2. Generate and compile Java code for the XSLT in Stylus Studio (myApplication.java, for example).

3. Copy the XSLT (.xsl), source (.edi, for example), and Java file for the generated application (.java) to the target production server.
On the Production Server

1. If you have not done so already, install the Stylus Studio 2006 XML Deployment Adapters module.

2. Modify the classpath to include the location of the Jar files associated with the Stylus Studio 2006 XML Deployment Adapters module.

3. Open the .java file (myApplication.java, for example) and edit the following:
   - StylusFileFactory.unlockAPI() – this method’s argument requires the installation ID of the Stylus Studio 2006 XML Deployment Adapters module.
   - setProp() – these methods identify the location of Stylus Studio 2006 XML Deployment Adapters module directories.
   - m_scriptSource.setFile – this data member is the XSLT file (.xsl).
   - m_xmlSource.setFile – this data member is the source file referenced in the XSLT.

The section of code in which you will find these files is shown here:

```java
// This section performs initialization required by the Stylus Studio URISolver. Further details can be found in the Stylus Studio Javadoc for package com.exln.stylus.io. setProp will not change any System properties that were set before this method was run.
StylusFileFactory.unlockAPI("310279283224998-1175126951");
setProp("appdata", "C:/Documents and Settings/All Users/Application Data/Stylus Studio");

m_useResolver = true;

m_scriptSource = new ResolverSource();
m_xmlSource = new ResolverSource();
m_finalResult = new ResolverResult();
m_scriptSource.setFile("c:/Program Files/Stylus Studio 2006 XML Enterprise Edition/test/myApplication.xsl");
m_xmlSource.setFile("c:/Program Files/Stylus Studio 2006 XML Enterprise Edition/test/books.xml");
m_finalResult.setNone();
```

4. Compile the .java file.

You can now run the application code independently, or incorporate it in another application on the same server.
About the unlockAPI() Method

The unlockAPI() method is part of the Stylus Studio Custom File System API. This method takes as its argument a Stylus Studio installation ID, one from either Stylus Studio 2006 XML Enterprise Edition, or from the Stylus Studio 2006 XML Deployment Adapter.

The Enterprise Edition installation ID is adequate for testing purposes on your local workstation, but if you want to deploy an XSLT application that uses Stylus Studio adapters on one or more test or application servers, you need to use the Deployment Adapter installation ID for the unlockAPI() method's argument.

XSLT Instructions Quick Reference

This section provides a quick reference for the XSLT instructions supported by the Stylus Studio XSLT processor.

For more information on
- XSLT 1.0, go to http://www.w3.org/TR/xslt
- XSLT 2.0, go to http://www.w3.org/TR/xslt/20

This section covers the following instructions:
- xsl:apply-imports on page 404
- xsl:apply-templates on page 404
- xsl:attribute on page 405
- xsl:attribute-set on page 406
- xsl:call-template on page 408
- xsl:character-map on page 409
- xsl:choose on page 411
- xsl:comment on page 412
- xsl:copy on page 412
- xsl:copy-of on page 413
- xsl:decimal-format on page 414
- xsl:element on page 415
- xsl:fallback on page 416
- xsl:for-each on page 416
- xsl:for-each-group on page 418
● xsl:function on page 419
● xsl:if on page 420
● xsl:import on page 421
● xsl:import-schema on page 421
● xsl:include on page 423
● xsl:key on page 424
● xsl:message on page 425
● xsl:namespace-alias on page 426
● xsl:number on page 426
● xsl:otherwise on page 427
● xsl:output on page 427
● xsl:output-character on page 429
● xsl:param on page 430
● xsl:preserve-space on page 432
● xsl:processing-instruction on page 432
● xsl:sequence on page 433
● xsl:sort on page 433
● xsl:strip-space on page 435
● xsl:stylesheet on page 435
● xsl:template on page 436
● xsl:text on page 438
● xsl:transform on page 439
● xsl:value-of on page 439
● xsl:variable on page 440
● xsl:when on page 441
● xsl:with-param on page 441
Working with XSLT

**xsl:apply-imports**

Invokes overridden template rules.

Stylus Studio does not support the *xsl:apply-imports* instruction.

**xsl:apply-templates**

Selects source nodes for processing.

**Format**

```xml
<xsl:apply-templates [select="pattern"] [mode="qname"]>
  [<xsl:sort/>]
  [<xsl:with-param/>]
</xsl:apply-templates>
```

**Description**

If you specify the `select` attribute, specify a pattern that resolves to a set of source nodes. For each source node in this set, the XSLT processor searches for a template that matches the node. When it finds a matching template, it instantiates it and uses the node as the context node. For example:

```xml
<xsl:apply-templates select="/bookstore/book">
  [<xsl:sort/>
  [<xsl:with-param/>]
</xsl:apply-templates>
```

When the XSLT processor executes this instruction, it constructs a list of all nodes that match the pattern in the `select` attribute. For each node in the list, the XSLT processor searches for the template whose `match` pattern best matches that node.

If you do not specify the `select` attribute, the XSLT processor uses the default pattern, "node()", which selects all child nodes of the current node.

If you specify the `mode` attribute, the selected nodes are matched only by templates with a matching `mode` attribute. The value of `mode` must be a qualified name or an asterisk (*). If you specify an asterisk, it means continue the current mode, if any, of the current template.

If you do not specify a `mode` attribute, the selected nodes are matched only by templates that do not specify a `mode` attribute.

By default, the new list of source nodes is processed in document order. However, you can use the `xsl:sort` instruction to specify that the selected nodes are to be processed in a different order. See “*xsl:sort*” on page 433.

**Tip** You can create an `xsl:apply-templates` element automatically using the XSLT mapper.
Example

In the previous example, the XSLT processor searches for a template that matches /bookstore/book. The following template is a match:

```xml
<xsl:template match="book">
  <tr>
    <td><xsl:value-of select="title"/></td>
    <td><xsl:value-of select="author"/></td>
    <td><xsl:value-of select="price"/></td>
  </tr>
</xsl:template>
```

The XSLT processor instantiates this template for each book element.

**xsl:attribute**

Creates an attribute.

**Format**

```xml
<xsl:attribute name="qualified_name">
  attribute_value
</xsl:attribute>
```

**Description**

You can specify the `xsl:attribute` instruction in the

- Contents of a stylesheet element that creates a result element
- Contents of an `xsl:attribute-set` instantiation

In a stylesheet element that creates a result element, the `xsl:attribute` instruction causes an attribute to be added to the created result element.

The prefix part of the `name` attribute value becomes the prefix for the attribute you are creating. The local part of the `name` attribute value becomes the local name of the attribute you are creating.

The XSLT processor interprets the `name` attribute as an attribute value template. The string that results from instantiating the attribute value template must be a qualified name. If it is not, the XSLT processor reports an error.

The result of instantiating the content of the `xsl:attribute` instruction is used as the value of the created attribute. It is an error if instantiating this content generates anything other than characters.
If you add an attribute to an element and that element already has an attribute with the same expanded name, the attribute you are creating replaces the existing attribute.

Example

```xml
<xsl:attribute name="library:ISBN"
    namespace="http://www.library.org/namespaces/library">
  1-2222-333-4
</xsl:attribute>
```

If this instruction is inside a `book` element, the resulting `book` element would include the following attribute:

```
library:ISBN="1-2222-333-4"
```

The XSLT processor reports an error if you try to do any of the following:

- Add an attribute to a node that is not an element.
- Add an attribute to an element that already has child nodes.
- Create anything other than characters during instantiation of the contents of the `xsl:attribute` element.

### xsl:attribute-set

Defines a named set of attributes.

#### Format

```xml
<xsl:attribute-set name="set_name">
  <xsl:attribute name="attr_name">attr_value</xsl:attribute>
  <xsl:attribute name="attr_name">attr_value</xsl:attribute>
  ...
</xsl:attribute-set>
```

#### Description

The `name` attribute specifies the name of the attribute set. This must be a qualified name. The contents of the `xsl:attribute-set` element consists of zero or more `xsl:attribute` elements. Each `xsl:attribute` element specifies an attribute in the set.

To use an attribute set, specify the `use-attribute-sets` attribute in one of the following elements:

- `xsl:element`
- `xsl:copy`
● **xsl:attribute-set**

The value of the use-attribute-sets attribute is a white-space-separated list of names of attribute sets. When you specify the use of an attribute set, it is equivalent to adding an `xsl:attribute` element for each attribute in each named attribute set to the beginning of the contents of the element in which you specify the use-attribute-sets attribute.

An attribute set cannot include itself. In other words, if attribute set A specifies the use-attribute-sets attribute, the list of attribute sets to use cannot include attribute set A.

You can also specify an attribute set in an `xsl:use-attribute-sets` attribute on a literal result element. The value of the `xsl:use-attribute-sets` attribute is a white-space-separated list of names of attribute sets. The `xsl:use-attribute-sets` attribute has the same effect as the `use-attribute-sets` attribute on `xsl:element` with one additional rule. The additional rule is that attributes specified on the literal result element itself are treated as if they were specified by `xsl:attribute` elements before any actual `xsl:attribute` elements but after any `xsl:attribute` elements implied by the `xsl:use-attribute-sets` attribute.

Thus, for a literal result element, attributes from attribute sets named in an `xsl:use-attribute-sets` attribute are added first, in the order listed in the attribute. Next, attributes specified on the literal result element are added. Finally, any attributes specified by `xsl:attribute` elements are added. Since adding an attribute to an element replaces any existing attribute of that element with the same name, this means that attributes specified in attribute sets can be overridden by attributes specified on the literal result element itself.

The template within each `xsl:attribute` element in an `xsl:attribute-set` element is instantiated each time the attribute set is used. It is instantiated using the same current node and current node list as is used for instantiating the element bearing the use-attribute-sets or `xsl:use-attribute-sets` attribute. However, it is the position in the stylesheet of the `xsl:attribute` element rather than of the element bearing the use-attribute-sets or `xsl:use-attribute-sets` attribute that determines which variable bindings are visible. Consequently, only variables and parameters declared by top-level `xsl:variable` and `xsl:param` elements are visible.

The XSLT processor merges multiple definitions of an attribute set with the same expanded name. If there are two attribute sets with the same expanded name that both contain the same attribute, the XSLT processor chooses the attribute definition that was specified last in the stylesheet.
Example

The following example creates a named attribute set, title-style, and uses it in a template rule:

```
<xsl:template match="chapter/heading">
  <fo:block quadding="start" xsl:use-attribute-sets="title-style">
    <xsl:apply-templates/>
  </fo:block>
</xsl:template>
<xsl:attribute-set name="title-style">
  <xsl:attribute name="font-size">12pt</xsl:attribute>
  <xsl:attribute name="font-weight">bold</xsl:attribute>
</xsl:attribute-set>
<xsl:call-template name="template_name">
  <!-- Contents -->
</xsl:call-template>
```

### xsl:call-template

Instantiates a named template.

#### Format

```
<xsl:call-template name="template_name">
  <!-- Contents -->
</xsl:call-template>
```

#### Description

The `name` attribute is required and the value must be a qualified name. It specifies the name of the template you want to instantiate. The template you want to instantiate must specify the `name` attribute with a value identical to `template_name`.

Unlike the `xsl:apply-templates` instruction, the `xsl:call-template` instruction does not change the current node.

**Tip** You can create an `xsl:call-template` element automatically using the XSLT mapper.

### xsl:character-map

Declares a character map defined by a unique name. A stylesheet cannot contain two or more character maps with the same name. Character maps are supported by XSLT 2.0 only.

**Tip** Character maps are an alternative to defining character entities using a DTD, which was required by XSLT 1.0.
Format

```xml
<xsl:character-map
    name = qname
    [use-character-maps = qnames]>
    [<xsl:output-character> ...]
</xsl:character-map>
```

Description

A **character map** allows a specific character appearing in a text or attribute node in the final result tree to be substituted by a specified string of characters during serialization. The character map that is supplied as a parameter to the serializer is determined from the `xsl:character-map` elements referenced from the `xsl:output` declaration for the selected output definition.

Character/string mappings can be defined in the body of the `xsl:character-map` element using one or more `xsl:output-character` elements, or they can be defined in an external character map referenced using the optional `use-character-maps` attribute. If the character map references multiple external character maps, separate each character map’s Qname with a space.

An output definition, after recursive expansion of character maps referenced via its `use-character-maps` attribute, may contain several mappings for the same character. In this situation, the last character mapping takes precedence.

If a character is mapped, it is not subjected to XML or HTML escaping.
Example

This example shows a composite character map – one constructed using both internally defined character mappings (xsl:output-character), and references to externally defined character maps (the use-character-maps attribute):

```xml
<xsl:output name="htmlDoc" use-character-maps="htmlDoc" />
<xsl:character-map name="htmlDoc"
  use-character-maps="html-chars doc-entities windows-format" />
<xsl:character-map name="html-chars"
  use-character-maps="latin1 ...">
  <xsl:output-character character="&#160;" string="&amp;nbsp;" />
  <xsl:output-character character="&#161;" string="&amp;iexcl;" />
  ...
</xsl:character-map>
<xsl:character-map name="latin1">
  <xsl:output-character character="&#xE400;" string="&amp;t-and-c;" />
  <xsl:output-character character="&#xE401;" string="&amp;chap1;" />
  <xsl:output-character character="&#xE402;" string="&amp;chap2;" />
</xsl:character-map>
<xsl:character-map name="doc-entities">
  <xsl:output-character character="&#xE400;" string="&amp;t-and-c;" />
  <xsl:output-character character="&#xE401;" string="&amp;chap1;" />
  <xsl:output-character character="&#xE402;" string="&amp;chap2;" />
</xsl:character-map>
<xsl:character-map name="windows-format">
  <!-- newlines as CRLF -->
  <xsl:output-character character="&#xA;" string="&amp;#xD;&amp;#xA;" />
  <!-- tabs as three spaces -->
  <xsl:output-character character="&#x9;" string="   " />
  <!-- images for special characters -->
  <xsl:output-character character="&#xF001;"
    string="&lt;img src='special1.gif' /&gt;" />
  <xsl:output-character character="&#xF002;"
    string="&lt;img src='special2.gif' /&gt;" />
</xsl:character-map>
```
**xsl:choose**

Selects one template to instantiate from a group of templates.

**Format**

```xml
<xsl:choose>
  <xsl:when test="expression1">
    template_body
  </xsl:when>
  [<xsl:when test="expression2">
    template_body
  </xsl:when> ...]
  [<xsl:otherwise>
    template_body
  </xsl:otherwise>]
</xsl:choose>
```

**Description**

An `xsl:choose` element contains one or more `xsl:when` elements followed by zero or one `xsl:otherwise` element. Each `xsl:when` element contains a required `test` attribute, whose value is an expression. Each `xsl:when` and `xsl:otherwise` element contains a template.

When the XSLT processor processes an `xsl:choose` element, it starts by evaluating the expression in the first `xsl:when` element. The XSLT processor converts the result to a Boolean value. If the result is `true`, the XSLT processor instantiates the template contained by that `xsl:when` element. If the result is `false`, the XSLT processor evaluates the expression in the next `xsl:when` element.

The XSLT processor instantiates the template of only the first `xsl:when` element whose `test` expression evaluates to `true`. If no expressions evaluate to `true` and there is an `xsl:otherwise` element, the XSLT processor instantiates the template in the `xsl:otherwise` element.

If no expressions in `xsl:when` elements are `true` and there is no `xsl:otherwise` element, the `xsl:choose` element has no effect.

**Tip** You can create an `xsl:choose` element automatically using the XSLT mapper.
Working with XSLT

**xsl:comment**

Adds a comment node to the result tree.

**Format**

```
<xsl:comment>
  comment_text
</xsl:comment>
```

**Description**

The XSLT processor instantiates the contents of the instruction to generate the text of the new comment.

The XSLT processor reports an error if instantiating the contents of the `xsl:comment` instruction creates anything other than characters, or if the resulting string contains the substring `"--"` or ends with `-`.

**Example**

The following instruction creates a comment in the result document:

```
<xsl:comment>Unique Irish band</xsl:comment>
```

The comment is

```
<!--Unique Irish band-->
```

**xsl:copy**

Adds a copy of the current node to the result tree.

**Format**

```
<xsl:copy>copy_contents</xsl:copy>
```

**Description**

The copy includes the current node’s namespace information but does not include the current node’s attributes or children. The contents of the `xsl:copy` element is a template for the attributes and children of the node being created. If the current node cannot have
XSLT Instructions Quick Reference

attributes or children (that is, if it is an attribute, text, comment, or processing instruction
node), the content of the instruction is ignored.
If the current node is the root node, the XSLT processor does not create a root node.
Instead, it uses copy_contents as a template.

Example
Following is an example from the W3C XSLT Recommendation. It generates a copy of
the source document.
<xsl:template match="@* | node() ">
<xsl:copy>
<xsl:apply-templates select="@* | node() " />
</xsl:copy>
</xsl:template>

xsl:copy-of
Inserts the value of an expression into the result tree, without first converting it to a string.

Format
<xsl:copy-of select = "expression" />

Description
The required select attribute contains an expression. When the result of evaluating the
expression is a result tree fragment, the XSLT processor copies the complete fragment
into the result tree. When the result is a node set, the XSLT processor copies all nodes in
the set, together with their contents, in document order into the result tree. When the result
is of any other type, the XSLT processor converts the result to a string and then inserts the
string into the result tree in the same way that xsl:value-of does.
Tip You can also use xsl:sequence to add atomic values to a sequence. See xsl:sequence on

page 433 for more information.

Stylus Studio® 2006 User Guide

413


Working with XSLT

**xsl:decimal-format**

Declares a decimal format.

**Format**

```xml
<xsl:decimal-format
    name = qname
    decimal-separator = char
    grouping-separator = char
    infinity = string
    minus-sign = char
    NaN = string
    percent = char
    per-mille = char
    zero-digit = char
    digit = char
    pattern-separator = char />
```

**Description**

The `xsl:decimal-format` instruction declares a decimal format, which controls the interpretation of a format pattern that is used by the `format-number()` function.

If there is a `name` attribute, the element declares a named decimal format. Otherwise, it declares the default decimal format. The value of the `name` attribute is a qualified name.

The other attributes on `xsl:decimal-format` correspond to the methods on the JDK `DecimalFormatSymbols` class. For each get/set method pair, there is an attribute defined for the `xsl:decimal-format` instruction.

The following attributes control the interpretation of characters in the format pattern and specify characters that can appear in the result of formatting the number:

- **decimal-separator** specifies the character used for the decimal sign; the default value is the dot character (.).
- **grouping-separator** specifies the character used as a grouping (for example, thousands) separator; the default value is the comma character (,).
- **percent** specifies the character used as a percent sign; the default value is the percent character (%).
- **per-mille** specifies the character used as a per mille sign; the default value is the Unicode per mille character (\#x2030).
- **zero-digit** specifies the character used as the digit zero; the default value is the digit zero (0).

The following attributes control the interpretation of characters in the format pattern:
● **digit** specifies the character used for a digit in the format pattern; the default value is the number sign character (#).

● **pattern-separator** specifies the character used to separate positive and negative subpatterns in a pattern; the default value is the semicolon character (;).

The following attributes specify characters or strings that can appear in the result of formatting the number:

● **infinity** specifies the string used to represent infinity; the default value is the string "Infinity".

● **minus-sign** specifies the character used as the default minus sign; the default value is the hyphen (minus) character (-, #x2D).

● **NaN** specifies the string used to represent the NaN value; the default value is the string "NaN".

---

**xsl:element**

Adds an element to the result tree.

**Format**

```
<xsl:element name="qualified_name">
  element_contents
</xsl:element>
```

**Description**

The XSLT processor uses the contents of the **xsl:element** instruction as a template for the attributes and contents of the new element.

The prefix part of the **name** attribute becomes the prefix for the element you are creating. The local part of the **name** attribute becomes the local name of the element you are creating.

The XSLT processor interprets the **name** attribute as an attribute value template. The string that results from instantiating the attribute value template must be a qualified name. If it is not, the XSLT processor reports an error.
Example

```xml
<xsl:element name="audio:CD">
  <xsl:element name="audio:title">Celtic Airs</xsl:element>
  <xsl:element name="audio:artist">Chieftains</xsl:element>
</xsl:element>
```

The result of this instruction looks like the following:

```xml
<audio:CD>
  <audio:title>Celtic Airs</audio:title>
  <audio:artist>Chieftains</audio:artist>
</audio:CD>
```

**xsl:fallback**

Normally, instantiating an `xsl:fallback` element does nothing. However, when an XSLT processor performs fallback for an instruction element, if the instruction element has one or more `xsl:fallback` children, then the content of each of the `xsl:fallback` children must be instantiated in sequence; otherwise, an error is signaled. The content of an `xsl:fallback` element is a template.

**xsl:for-each**

Selects a set of nodes in the source document and instantiates the contained template once for each node in the set.

**Format**

```xml
<xsl:for-each select="pattern">
  [<xsl:sort[select="expression"]][optional_attribute]/>]
  template_body
</xsl:for-each>
```

**Description**

The `select` attribute is required and the pattern must evaluate to a node set. The XSLT processor instantiates the embedded template with the selected node as the current node and with a list of all selected nodes as the current node list.

By default, the new list of source nodes is processed in document order. However, you can use the `xsl:sort` instruction to specify that the selected nodes are to be processed in a different order. See “`xsl:sort`” on page 433.
The `xsl:for-each` instruction is useful when the result document has a regular, known structure. When you know that you want to instantiate the same template for each node in the current node list, the `xsl:for-each` instruction eliminates the need to find a template that matches each node.

**Tip** You can create an `xsl:for-each` element automatically using the XSLT mapper.

**Example**

For example, suppose your source document includes the following XML:

```xml
<books>
  <author>
    <name>Sara Peretsky</name>
    <booktitle>Bitter Medicine</booktitle>
    <booktitle>Killing Orders</booktitle>
  </author>
  <author>
    <name>Dick Francis</name>
    <booktitle>Reflex</booktitle>
    <booktitle>Proof</booktitle>
    <booktitle>Nerve</booktitle>
  </author>
</books>
```

The following stylesheet creates an HTML document that contains a list of authors. Each author is followed by the titles of the books the author wrote. It does not matter how many authors there are nor how many titles are associated with each author. The stylesheet uses the `xsl:for-each` instruction to process each author and to process each title associated with each author.

```xml
<xsl:stylesheet
  xmlns:xsl="http://www.w3.org/1999/XSL/Transform" version="1.0">
  <xsl:template match="/">
    <html>
      <head><title>Authors and Their Books</title></head>
      <body>
        <xsl:for-each select="books/author">
          <p>
            <xsl:value-of select="name"/>
            <br/>
            <xsl:for-each select="booktitle">
              <xsl:value-of select="."/>
              <br/>
            </xsl:for-each>
          </p>
        </xsl:for-each>
      </body>
    </html>
  </xsl:template>
</xsl:stylesheet>
```
The result document looks like this:

```xml
<html>
<head>
<title>Authors and Their Books</title>
</head>
<body>
<p>
Sara Peretsky<br>
Bitter Medicine<br>
Killing Orders<br>
</p>
<p>
Dick Francis<br>
Reflex<br>
Proof<br>
Nerve<br>
</p>
</body>
</html>
```

### xsl:for-each-group

Allocates the items in an input sequence into groups of items (that is, it establishes a collection of sequences) based either on common values of a grouping key, or on a pattern that the initial or final node in a group must match.

**Format**

```xml
<xsl:for-each-group
   select = expression
   [group-by = expression]
   [group-adjacent = expression]
   [group-starting-with = pattern]
   [group-ending-with = pattern]
   [collation = { uri }]
   <!-- Content: (xsl:sort*, sequence-constructor) -->
</xsl:for-each-group>
```

**Description**

The `xsl:for-each-group` element is an instruction that can be used anywhere within a sequence constructor. The sequence of items to be grouped is referred to as a `population`. A group cannot be empty. If the population is zero (that is, empty), the number of groups is zero. How items are assigned to groups is determined by the `group-by`, `group-adjacent`, `group-starting-with`, and `group-ending-with` attributes.
**xsl:function**

Allows the creation of user-defined stylesheet function that can be called from any XPath expression within the stylesheet in which the function is defined. This instruction is supported in XSLT 2.0 only.

**Format**

```
<xsl:function name="Qname" as="sequence type" [override="yes" | "no"]>
  function_body
</xsl:function>
```

**Description**

The value of the name attribute, Qname, is a qualified name and takes the form `prefix:name`. The prefix is required in order to avoid possible conflicts with any functions in the default function namespace. The prefix cannot refer to a reserved namespace.

The `function_body` contains zero or more “`xsl:param`” on page 430 elements that specify the formal arguments of the function. These `xsl:param` elements are followed by a sequence constructor that defines the value to be returned by the function. The `xsl:param` elements within an `xsl:function` element must be empty; they cannot have a `select` attribute because they must be specified.

An `xsl:function` declaration can only appear as a top-level element in a stylesheet.
Example

Here is an example from the W3C XSLT Working Draft of a simple function that reverses the order of the words in a sentence.

```xml
<xsl:transform
  xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
  xmlns:xs="http://www.w3.org/2001/XMLSchema"
  xmlns:str="http://example.com/namespace"
  version="2.0"
  exclude-result-prefixes="str">
  <xsl:function name="str:reverse" as="xs:string">
    <xsl:param name="sentence" as="xs:string"/>
    <xsl:sequence
      select="if (contains($sentence, ' '))
        then concat(str:reverse(substring-after($sentence, ' ')),
            ' ',
            substring-before($sentence, ' '))
        else $sentence"/>
  </xsl:function>
  <xsl:template match="/">
    <output>
      <xsl:value-of select="str:reverse('DOG BITES MAN')"/>
    </output>
  </xsl:template>
</xsl:transform>
```

**xsl:if**

Conditionally instantiates the contained template body.

**Format**

```
<xsl:if test = "expression">
  template_body
</xsl:if>
```

**Description**

The XSLT processor evaluates the expression and converts the result to a Boolean value. If the result is `true`, the XSLT processor instantiates `template_body`. If the result is `false`, the `xsl:if` element has no effect.
Example

This following example formats a group of names as a comma-separated list:

```xml
<xsl:template match="namelist/name">
  <xsl:value-of select="." />
  <xsl:if test="not(position()=last())">, </xsl:if>
</xsl:template>
```

If you want the XSLT processor to choose which template to instantiate from several possibilities, specify the `<xsl:choose>` instruction. See “`xsl:choose`” on page 411.

**xsl:import**

Imports a stylesheet into the stylesheet containing this instruction.

**Format**

```xml
<xsl:import href="stylesheet_path"/>
```

*stylesheet_path* specifies the stylesheet you want to import. Specify a URL, a relative path, or a DOS-style path.

**Description**

An XSLT stylesheet can import another XSLT stylesheet by using an `<xsl:import>` instruction. Importing a stylesheet is the same as including it, except that definitions and template rules in the importing stylesheet take precedence over template rules and definitions in the imported stylesheet.

The `<xsl:import>` element is only allowed as a top-level element. The `<xsl:import>` element children must precede all other element children of an `<xsl:stylesheet>` element, including any `<xsl:include>` element children. When `<xsl:include>` is used to include a stylesheet, any `<xsl:import>` elements in the included document are moved up in the including document to after any existing `<xsl:import>` elements in the including document.

When you use the `<xsl:import>` instruction, templates have an importance property.

**xsl:import-schema**

Identifies schema components (top-level type definitions and top-level element and attribute declarations) that need to be available statically, that is, before any source
Working with XSLT

document is available. Allows you to extend XSLT built-in types with the types defined in the imported XML Schema.

Format

```
<xsl:import-schema
  namespace = uri-reference
  schema-location = uri-reference>
  <!-- Content: xs:.schema -->
</xsl:import-schema>
```

Description

The `xsl:import-schema` declaration identifies a namespace containing the names of the components to be imported (or indicates that components whose names are in no namespace are to be imported). The effect is that the names of top-level element and attribute declarations and type definitions from this namespace (or non-namespace) become available for use within XPath expressions in the stylesheet, and within other stylesheet constructs such as the type and as attributes of various XSLT elements.

The same schema components are available in all stylesheet modules; importing components in one stylesheet module makes them available throughout the stylesheet.

The namespace and schema-location elements are optional. The namespace attribute indicates that a schema for the given namespace is required by the stylesheet. This information may be enough on its own to enable an implementation to locate the required schema components. The namespace attribute may be omitted to indicate that a schema for names in no namespace is being imported. The zero-length string is not a valid namespace URI, and is therefore not a valid value for the namespace attribute.

The schema-location attribute is a URI Reference that describes where a schema document or other resource containing the required definitions may be found. It is likely that a schema-aware XSLT processor will be able to process a schema document found at this location.

The use of a namespace in an `xsl:import-schema` declaration does not by itself associate any namespace prefix with the namespace. If names from the namespace are used within the stylesheet module then a namespace declaration must be included in the stylesheet module, in the usual way.

You can also define an inline schema document using the `xs:schema` element as a child of `xsl:import-schema`. An inline schema document has the same status as an external schema document, in the sense that it acts as a hint for a source of schema components in the...
relevant namespace. To ensure that the inline schema document is always used, it is advisable to use a target namespace that is unique to this schema document.

Example

The following example shows an inline schema document defined using the `xs:schema` subelement. This schema declares a simple type `local:yes-no`, which the stylesheet then uses in the declaration of a variable. The example assumes the namespace declaration `xmlns:local="http://localhost/ns/yes-no"`.

```xml
<xsl:import-schema>
  <xs:schema targetNamespace="http://localhost/ns/yes-no">
    <xs:restriction base="xs:string">
      <xs:enumeration value="yes"/>
      <xs:enumeration value="no"/>
    </xs:restriction>
  </xs:schema>
</xsl:import-schema>

<xsl:variable name="condition" select="'yes'" as="local:yes-no"/>
```

**xsl:include**

Specifies an XSLT stylesheet that is included in and combined with the stylesheet that specifies `xsl:include`.

**Format**

```xml
<xsl:include href="stylesheet_path"/>
```

*stylesheet_path* specifies the stylesheet you want to import. Specify a URL, a relative path, or a DOS-style path.

**Description**

The `xsl:include` instruction must be a child of an `xsl:stylesheet` element. The XSLT processor effectively replaces the `xsl:include` instruction with the children of the root `xsl:stylesheet` element of the included stylesheet. If the root element of the included stylesheet is a literal result element, the XSLT processor effectively replaces the `xsl:include` instruction with the following new element whose only child is that literal result element:

```xml
<xsl:template match="/"
```
A stylesheet cannot include itself directly or indirectly.

**xsl:key**

Declares a key for a document.

**Format**

```xml
<xsl:key name="qname" match = "pattern" use = "use" />
```

**Description**

Keys provide a way to work with documents that contain an implicit cross-reference structure. A stylesheet declares a key for a document with the `xsl:key` instruction.

The `xsl:key` instruction must be a top-level element. It has no contents, but it specifies three attributes.

Replace `qname` with the name of the key. You must specify a qualified name.

Replace `pattern` with a pattern that identifies one or more nodes that have this key. In other words, the nodes in the document that match the pattern are included in the key. The default is `node()`.

Replace `use` with an expression that you want to use for the key values. The XSLT processor evaluates the expression once for each node in the set identified by `pattern`.

Each key name represents a separate, independent set of identifiers. Each node included in a key is associated with a set of string key values. These values result from evaluating the `use` expression with that node as the current node.

A document can contain multiple keys with the same node and the same key name, but with different key values. A document can contain multiple keys with the same key name and value, but with different nodes. In other words:

- A node can be included in more than one key.
- For a given key, a key value can be associated with more than one node.
- The same key value can be associated with different nodes in different keys.

The value of a key can be an arbitrary string. It need not be a name.

Use the XSLT `key()` function to retrieve the list of nodes included in a given key that have given key values. See “Finding an Element with a Particular Key” on page 697.
XSLT Instructions Quick Reference

Restriction

You cannot specify multiple declarations for the same key in a stylesheet. Stylus Studio expects to remove this restriction in a future release.

**xsl:message**

Sends a message in a way that is dependent on the XSLT processor.

**Format**

```
<xsl:message terminate="yes" | "no">
  <!-- Content: template -->
</xsl:message>
```

**Description**

The content of the `xsl:message` instruction is a template. If the value of the `terminate` attribute is `yes`, the XSLT processor instantiates the template to create text. The processor aborts stylesheet processing and sends the text as part of the error message that indicates that stylesheet processing has terminated.

The default value of the `terminate` attribute is `no`. If you specify `terminate="no"` or if you do not specify the `terminate` attribute, the XSLT processor displays the message in the Stylus Studio **Output Window** but does not terminate the process.
Working with XSLT

**xsl:namespace-alias**

Causes the namespace URI to be changed in the output.

**Format**

```xml
<xsl:namespace-alias
    stylesheet-prefix = prefix | "#default"
    result-prefix = prefix | "#default" />
```

**Description**

Declares that one namespace URI is an alias for another namespace URI. When a literal namespace URI has been declared to be an alias for another namespace URI, then the namespace URI in the result tree is the namespace URI that the literal namespace URI is an alias for, instead of the literal namespace URI itself.

**xsl:number**

Inserts a formatted number into the result tree.

**Format**

```xml
<xsl:number
    [level = "single" | "multiple" | "any"]
    [count = pattern]
    [from = pattern]
    [value = number-expression]
    [format = {string}]
    [lang = {nmtoken}]
    [letter-value = {"alphabetic" | "traditional"}]
    [grouping-separator = {char}]
    [grouping-size = {number}]/>
```

**Description**

You can use the `value` attribute to specify an expression for the number to be inserted. The XSLT processor evaluates the expression. The resulting object is converted to a number as if by a call to the `number()` function. The processor rounds the number to an integer and then uses the specified attributes to convert it to a string. The value of each attribute is interpreted as an attribute value template. After conversion, the resulting string is inserted in the result tree.

The following attributes control how the current node is to be numbered:
XSLT Instructions Quick Reference

- The `level` attribute specifies what levels of the source tree should be considered. The default is `single`.
- The `count` attribute is a pattern that specifies what nodes should be counted at those levels.
- The `from` attribute is a pattern that specifies where counting starts.
- The `value` attribute can specify an expression that represents the number you want to insert. If no value attribute is specified, the XSLT processor inserts a number based on the position of the current node in the source tree.
- The `format` attribute specifies the format for each number in the list. The default is 1.
- The `lang` attribute specifies which language’s alphabet is to be used.
- The `letter-value` attribute distinguishes between the numbering sequences that use letters.
- The `grouping-separator` attribute specifies the separator used as a grouping (for example, thousands) separator in decimal numbering sequences.
- The `grouping-size` attribute specifies the size of the grouping. Normally, this is 3.

**Example**

The following example numbers a sorted list:

```xml
<xsl:template match="items">
  <xsl:for-each select="item">
    <xsl:sort select="."/>
    <p>
      <xsl:number value="position()" format="1. "/>
      <xsl:value-of select="."/>
    </p>
  </xsl:for-each>
</xsl:template>
```

**xsl:otherwise**

See “`xsl:choose`” on page 411.

**xsl:output**

Specifies the output for the result tree.

**Format**

```xml
<xsl:output attribute_list />)
```
Working with XSLT

Description

The `xsl:output` instruction specifies how you want the result tree to be output. However, if you use the XSLT processor to format the result as a string, or to generate DOM nodes, the `xsl:output` instruction has no effect.

If you specify the `xsl:output` instruction, the XSLT processor outputs the result tree according to your specification. If you specify it, the `xsl:output` instruction must be a top-level element.

The attribute list can include the `method` attribute. The `method` attribute identifies the overall method you want the XSLT processor to use to output the result tree. The value must be `xml`, `html`, or `text`.

- **xml** formats the result tree as XML.
- **html** formats the result tree as HTML. The stylesheet applies special formatting rules for empty tags, binary attributes, and character escaping, among other things. The values of the attributes named `href` and `src` are URL encoded.
- **text** concatenates the text nodes in the result tree. The concatenated string does not include any tags.

Note that the XSLT processor formats the results of applying the stylesheet. If your stylesheet generates XML or HTML that does not follow all syntax rules, the XSLT processor does not do anything to fix this. For example, if a stylesheet generates multiple root elements, the XSLT processor neither fixes this nor generates an error. You receive a string, and it is only upon examination or use of the string that you would learn that it is not well-formed XML.

If you do not specify an `xsl:output` instruction that includes the `method` attribute, the XSLT processor chooses a default as follows:

- **html** is the default output method if the name of the first element child of the root node is `html`.
- **text** is the default output method if the root node has no element child nodes.
- **xml** is the default output method in all other cases.

The other attributes that you can specify in `attribute_list` provide parameters for the output method. You can specify the following attributes:

- **doctype-public** specifies the public identifier to be used in the document type declaration.
- **doctype-system** specifies the system identifier to be used in the document type declaration.
XSLT Instructions Quick Reference

- **encoding** specifies the preferred character encoding that the XSLT processor should use to encode sequences of characters as sequences of bytes.
- **indent** specifies whether the XSLT processor can add additional white space when outputting the result tree. The value must be yes or no.
- **media-type** specifies the media type (MIME content type) of the data that results from outputting the result tree. Do not explicitly specify the charset parameter. Instead, when the top-level media type is text, add a charset parameter according to the character encoding actually used by the output method.
- **omit-xml-declaration** specifies whether the XSLT processor should omit or output an XML declaration. The value must be yes or no. If you do not specify this attribute, whether or not the output contains an XML declaration depends on the output method.
  - If the output method is html, the XSLT processor does not insert an XML declaration.
  - If the output method is xml, the XSLT processor inserts an XML declaration. The XSLT processor ignores this attribute when the output method is text.
- **standalone** specifies whether the XSLT processor should output a stand-alone document declaration. The value must be yes or no.
- **use-character-map** specifies the name, if any, of the character map you want to use for the output. A character map substitutes characters based on character/string mappings declared in the **xsl:character-map** element.

A stylesheet can include multiple **xsl:output** elements. The XSLT processor effectively merges multiple **xsl:output** elements into one **xsl:output** element. If there are multiple values for the same attribute, the XSLT processor uses the last specified value.

In this release, the XSLT processor ignores the following attributes:
- **cdata-section-elements** specifies a list of the names of elements whose text node children should be output using CDATA sections.
- **version** specifies the version of the output method.

**xsl:output-character**

Declares character/string mappings used by the **xsl:character-map** declaration. **xsl:output-character** is supported in XSLT 2.0 only.
Working with XSLT

Format

```xml
<xsl:output-character
    character = char
    string = string />
```

Description

The character map that is passed as a parameter to the serializer contains a mapping for the character specified in the `character` attribute to the string specified in the `string` attribute.

Example

See `xsl:character-map` on page 409.

**xsl:param**

Declares a parameter for a stylesheet or template, and specifies a default value for the parameter.

Format

```xml
<xsl:param name="parameter_name"
    [select = "expression1"]
    [expr = "expression2"]>
    [template_body]
</xsl:param>
```

Description

The `xsl:param` instruction declares a parameter and specifies its default value. Another value can be passed to this parameter when the template or stylesheet that contains this `xsl:param` instruction is invoked.

The `xsl:param` element must be a child of either an `xsl:stylesheet` or `xsl:template` element.

The `name` attribute is required, and it must be a string. The value of the `name` attribute is a qualified name.

The value that you bind to a parameter can be an object of any of the types that are returned by expressions. You can specify the value of the parameter in several ways:
Stylus Studio® 2006 User Guide

XSLT Instructions Quick Reference

● Specify the select attribute. The value of the select attribute must be an expression. The XSLT processor evaluates the expression, and the result is the default value of the parameter. If you specify the select attribute, the XSLT processor ignores any value you might specify for the expr attribute, and also ignores any contents of xsl:param.

● Specify the expr attribute. The expr attribute allows computation of an expression. For example:

```xml
<xsl:param name="query" expr="//VEHICLE[MAKE='{$make}']"/>
```

The XSLT processor interprets the value of the expr attribute as an attribute value template and uses the resulting string as if it were the value of the select attribute. If you specify the expr attribute, the XSLT processor ignores any contents of xsl:param.

The use of the expr attribute is an extension to the XSLT specification.

● Specify template_body. The XSLT processor instantiates this template to obtain the default value of the parameter.

● If you do not specify the select attribute, the expr attribute, or template_body, the default value of the parameter is an empty string.

For any use of the xsl:param element, there is a region of the stylesheet tree within which the binding is visible. This region includes the siblings that follow the xsl:param instruction together with their descendants. Within this region, any binding of the parameter that was visible on the xsl:param element itself is hidden. Thus, only the innermost binding of a parameter is visible. The set of parameter bindings in scope for an expression consists of those bindings that are visible at the point in the stylesheet where the expression occurs.

The xsl:param instruction can be a top-level element. If it is, it declares a global parameter that is visible to the entire stylesheet. When the XSLT processor evaluates the select or expr attribute in a top-level xsl:param instruction, the current node is the root node of the document.

**Passing parameters to templates**

Use the xsl:with-param instruction to pass a value for a parameter to a template. See “xsl:with-param” on page 441.

**xsl:preserve-space**

The xsl:preserve-space instruction is not supported by Stylus Studio. If this instruction is in a stylesheet, it is ignored.
xsl:processing-instruction

Adds a processing instruction node to the result tree.

Format

```xml
<xsl:processing-instruction name = "pi_name">
  processing_instruction
</xsl:processing-instruction>
```

Description

The XSLT processor interprets the name attribute as an attribute value template, and uses the resulting string as the target of the created processing instruction. The XSLT processor then instantiates the contents of xsl:processing-instruction to generate the remaining contents of the processing instruction.

Errors are reported under the following conditions:

- If the string that results from evaluating the name attribute is not both an NCName and a PITarget (see the XSLT Recommendation). Also, the value of the name attribute cannot be xml.
- If instantiation of the contents of the xsl:processing-instruction element creates anything other than characters or if the resulting string contains the substring "?>".

Example

```xml
<xsl:processing-instruction name = "xml-stylesheet">
  href="book.css" type="text/css"
</xsl:processing-instruction>
```

This instruction creates the following processing instruction in the result document:

```xml
<?xml-stylesheet href="book.css" type="text/css"?>
```

xsl:sequence

Used within a sequence constructor to construct a sequence of nodes or atomic values. The sequence is returned as a result of the instruction.
XSLT Instructions Quick Reference

Format

```
<xsl:sequence
    select = expression>
    [xsl:fallback]
</xsl:sequence>
```

Description

Unlike most other instructions, `xsl:sequence` can return a sequence containing existing nodes, rather than constructing new nodes. The items comprising the result sequence are selected using the `select` attribute. When `xsl:sequence` is used to add atomic values to a sequence, the effect is very similar to the `xsl:copy-of` instruction.

Any optional `xsl:fallback` instructions are ignored by XSLT 2.0 processors, but they can be included to define fallback behavior for XSLT 1.0 processors.

Example

This code produces the output, 37.

```
<xsl:variable name="values" as="xs:integer*">
    <xsl:sequence select="(1,2,3,4)"/>
    <xsl:sequence select="(8,9,10)"/>
</xsl:variable>
<xsl:value-of select="sum($values)"/>
```

xsl:sort

Sorts the set of nodes selected by an `xsl:apply-templates` or `xsl:for-each` instruction.

Format

```
<xsl:sort
    [select="expression" | expr="expression"]
    [optional_attribute]]>
```

Description

The `xsl:sort` instruction must be the child of an `xsl:apply-templates` or `xsl:for-each` instruction. Each `xsl:apply-templates` and `xsl:for-each` instruction can contain more than one `xsl:sort` instruction. The first `xsl:sort` child specifies the primary sort key. The second `xsl:sort` child, if any, specifies the secondary sort key, and so on.
When an `xsl:apply-templates` or `xsl:for-each` element contains an `xsl:sort` instruction, the selected nodes are processed in the order specified by the `xsl:sort` instructions. When `xsl:sort` elements are in an `xsl:for-each` element, they must appear first before all other child elements.

You can specify the sort key by using the `select` attribute, whose value is an expression. For each node selected by the `xsl:apply-templates` or `xsl:for-each` instruction, the XSLT processor evaluates the expression using the node as the context node. The resulting string is the sort key for that node. If you do not specify the `select` attribute, the XSLT processor uses the string value of the node as the sort key.

When all sort keys for two nodes are equal, nodes remain in document order.

The following optional attributes on `xsl:sort` determine how the XSLT processor sorts the list of sort keys. The XSLT processor interprets each of these attribute values as an attribute value template.

- **data-type** specifies the data type of the strings. The following values are allowed:
  - `text` specifies that the sort keys should be sorted lexicographically. All text sorting is based on Unicode text values.
  - `number` specifies that the sort keys should be converted to numbers and then sorted according to the numeric value. Sort keys that are strings that do not match the syntax for numbers are sorted as zeros.

  The default value is `text`.

- **order** specifies whether the strings should be sorted in ascending or descending order. The default is ascending. If the value of the `data-type` attribute is `text`, `ascending` means that keys are sorted in alphabetical order, and `descending` means that keys are sorted in reverse alphabetical order. If the value of `data-type` is `number`, `ascending` means that keys are sorted in increasing order, and `descending` means that keys are ordered in descending order.

  The XSLT processor can evaluate `xsl:sort order` at run time by using an attribute value template. For example:

  ```xsl
  <xsl:sort order="{$order}"/>
  ```

  `$order` is a run-time specified attribute value template.

  The XSLT processor ignores the `lang` and `case-order` attributes.
Example

The following example is from the W3C XSLT Recommendation. Suppose an employee database has the following form:

```xml
<employees>
  <employee>
    <name>
      <first>James</first>
      <last>Clark</last>
    </name>
    ...
  </employee>
</employees>
```

The following stylesheet fragment sorts the list of employees by name:

```xml
<xsl:stylesheet
    xmlns:xsl="http://www.w3.org/1999/XSL/Transform" version="1.0" >
  stylesheet_body
</xsl:stylesheet>
```

\textit{xsl:strip-space}

The \textit{xsl:strip-space} instruction is not supported by Stylus Studio. If this instruction is in a stylesheet, it is ignored.

\textit{xsl:stylesheet}

Specifies the start of a stylesheet.

\textbf{Format}

```xml
<xsl:stylesheet
    xmlns:xsl="http://www.w3.org/1999/XSL/Transform" version="1.0" >
      stylesheet_body
</xsl:stylesheet>
```
Description

A stylesheet must specify the `xsl:stylesheet` element unless it contains only a literal result element as the root element. The `xsl:transform` instruction is a synonym for `xsl:stylesheet`.

All XSLT elements must appear between the `<xsl:stylesheet>` and `</xsl:stylesheet>` tags. An element that is a child of an `xsl:stylesheet` element is a top-level element.

### xsl:template

Specifies a template rule.

**Format**

```
<xsl:template
  [match = "pattern"]
  [name = "qname"]
  [mode = "mode"]
  [priority = "priority"]>
  template_body
</xsl:template>
```

**Description**

The `match` attribute is required except when you specify the `name` attribute. The pattern you specify for the `match` attribute identifies the source node or set of source nodes to which the template rule applies.

The optional `name` attribute specifies a name for the template. You can use the name of a template to invoke it with the `xsl:call-template` instruction. The value you specify for `name` must be a qualified name. If you specify a `name` attribute, a `match` attribute is not required.

The optional `mode` attribute prevents the template from matching nodes selected by an `xsl:apply-templates` instruction that specifies a different mode. The value of `mode` must be a qualified name or an asterisk (*). If you specify an asterisk, it means match any node.

If an `xsl:apply-templates` instruction contains a `mode` attribute, the `xsl:apply-templates` instruction can apply to only those `xsl:template` instructions that specify a `mode` attribute with the same value. If an `xsl:apply-templates` instruction does not contain a `mode` attribute, the `xsl:apply-templates` instruction can apply to only those `xsl:template` instructions that do not specify a `mode` attribute.
If you specify the `match` and `mode` attributes, they have no effect if the template is instantiated by the `xsl:call-template` instruction. If you specify the `name` attribute, you can still instantiate the template as a result of an `xsl:apply-templates` instruction.

If two or more templates have the same name, Stylus Studio uses the template that appears last in the stylesheet.

The template body contains literal results and XSLT instructions. The XSLT processor instantiates the template body for each node identified by `pattern`. This means the XSLT processor copies literal results to the result document and executes the XSLT instructions.

If there is more than one matching template rule, the XSLT processor chooses the matching template rule with the higher priority. If both have the same priority, the XSLT processor chooses the one that occurs last in the stylesheet.

For examples and additional information about templates, see “Working with Templates” on page 375.

**Tip** You can create an `xsl:template` element automatically using the XSLT mapper.
**Working with XSLT**

**xsl:text**

Adds a text node to the result tree.

**Format**

```
<xsl:text [disable-output-escaping="yes|no"]>
  text_node_contents
</xsl:text>
```

**Description**

The XSLT processor reports an error if instantiating `text_node_contents` results in anything other than characters.

You can also add text nodes to result documents by embedding the text in elements that you define.

You can specify the `disable-output-escaping` attribute of the `xsl:text` instruction. The allowed values are `yes` or `no`. The default is `no`. If the value is `yes`, the text node generated by instantiating the `xsl:text` element is output without any escaping. For example:

```
<xsl:text disable-output-escaping="yes">&lt;</xsl:text>
```

This instruction generates the single character `<`.

**Examples**

The following fragment adds two text nodes by embedding text.

```
<xsl:template match="/"

  <html>
    <head>
      <title>Authors and Their Books</title>
    </head>
    <body>
      <intro>
        Books in stock are listed here.
      </intro>
      ...
    </body>
  </html>
</xsl:template>
```

The next example specifies the `xsl:text` instruction:

```
<xsl:text>Following is a list of authors.</xsl:text>
```
xsl:transform

The xsl:transform instruction is a synonym for xsl:stylesheet. See “xsl:stylesheet” on page 435.

xsl:value-of

Creates a new text node that contains the string value of an expression.

Format

```xml
<xsl:value-of select="expression"
[disable-output-escaping="yes|no"]/>
```

Description

The XSLT processor evaluates expression and converts the result to a string. If the string is not empty, a text node is created and added to the result. If the string is empty, the xsl:value-of instruction has no effect.

You can specify the disable-output-escaping attribute of the xsl:value-of instruction. The allowed values are yes and no. The default is no. If the value is yes, the text node generated by instantiating the xsl:value-of element is output without any escaping.

Tip  You can create an xsl:value-of element automatically using the XSLT mapper.

Example

```xml
<xsl:template match = "author">
  <p>
    <xsl:value-of select = "first-name"/>
    <xsl:text> </xsl:text>
    <xsl:value-of select = "last-name"/>
  </p>
</xsl:template>
```

This example creates an HTML paragraph from an author element. The author element has first-name and last-name children. The resulting paragraph contains the value of the first first-name child element of the current node, followed by a space, followed by the value of the first last-name child element of the current node.
Working with XSLT

**xsl:variable**

Declares a variable and binds a value to that variable.

**Format**

```xml
<xsl:variable name="variable_name"
    [select = "expression2"]
    [expr = "expression3"]>
    template_body
</xsl:variable>
```

**Description**

The `name` attribute is required, and it must be a string. The value of the `name` attribute is a qualified name.

The value that you bind to a variable can be an object of any of the types that are returned by expressions. You can specify the value of the variable in several ways:

- Specify the `select` attribute. The value of the `select` attribute must be an expression. The XSLT processor evaluates the expression, and the result is the value of the variable. If you specify the `select` attribute, you must not specify any contents for the `xsl:variable` instruction. In other words, do not specify `template_body`.

- Specify the `expr` attribute. It is interpreted as an attribute value template. It allows computation of the value expression.

The `expr` attribute of the `xsl:variable` instruction is an extension of the XSLT standard. If you want to use an XSLT processor other than the Stylus Studio processor, you cannot specify the `expr` attribute in your stylesheet.

- Specify `template_body`. The XSLT processor instantiates this template to obtain the value of the variable. If you specify `template_body`, you must not specify the `select` attribute.

- Specify none of the above. In this case, the value of the variable is an empty string.

The difference between the `xsl:param` and `xsl:variable` instructions is that `xsl:param` defines a default value while `xsl:variable` defines a fixed value.

**Scope**

For any use of the `xsl:variable` element, there is a region of the stylesheet tree within which the binding is visible. This region includes the siblings that follow the `xsl:variable` instruction together with their descendants. Within this region, any binding of the variable that is visible on the `xsl:variable` element itself is hidden. Thus, only the innermost binding of a variable is visible. The set of variable bindings in scope for an
expression consists of those bindings that are visible at the point in the stylesheet where
the expression occurs.

The `xs1:variable` instruction can be a top-level element. If it is, it declares a global
variable that is visible to the entire stylesheet. When the XSLT processor evaluates the
select or expr attribute in a top-level xs1:variable instruction, the current node is the root
node of the document. The `xs1:variable` instruction is also allowed anywhere in a
template that an XSLT instruction is allowed.

**xsl:when**

See “*xsl:choose*” on page 411.

**xsl:with-param**

Passes a parameter value to a template.

**Format**

```xml
<xsl:with-param name = "parameter_name"
    [select = "expression1"]
</xsl:with-param>
```

**Description**

The `xsl:with-param` instruction passes a parameter value to a template. If the template has
no matching `xsl:param` declaration, the XSLT processor ignores the parameter. The value
of `parameter_name` is a qualified name.

The `name` attribute is required, and it must be a string. The value of the `name` attribute is a
qualified name.

The value that you pass to a template can be an object of any of the types that are returned
by expressions. You can specify the value of the parameter in several ways:

- Specify the `select` attribute. The value of the `select` attribute must be an expression.
The XSLT processor evaluates the expression, and the result is the value of the
parameter. If you specify the `select` attribute, you must not specify any contents for
the `xsl:with-param` instruction. In other words, do not specify `parameter_value`.
- Specify the `expr` attribute. It is interpreted as an attribute value template. It allows
computation of the value expression.
Working with XSLT

- Specify `parameter_value`. If you specify `parameter_value`, you must not specify the `select` or `expr` attribute.
- Specify none of the above. In this case, the value of the parameter is an empty string.

The `xsl:with-param` element must be a child of `xsl:apply-templates` or `xsl:call-template`.

You can specify the `xsl:with-param` instruction in `xsl:call-template` and `xsl:apply-template` instructions.

Example

Suppose you specify the following parameter for a template:

```xml
<xsl:template name="Appendix">
  <xsl:param name = "heading"> 1. </xsl-param>
</xsl:template>
```

You can pass another value for this variable as follows:

```xml
<xsl:call-template name = "Appendix">
  <xsl:with-param name = "heading"> A. </xsl:with-param>
</xsl:call-template>
```
Chapter 5  Creating XSLT Using the XSLT Mapper

The XSLT Mapper is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

In addition to writing XSLT manually in the XSLT text editor, Stylus Studio provides a graphical tool, the XSLT mapper, that allows you quickly compose XSLT without writing any code. This chapter describes the XSLT mapper, how to use it, and its relationship to the XSLT displayed on the XSLT Source tab.

For a brief introduction to the mechanics of using the XSLT mapper and some of its features, see “Using the XSLT Mapper – Getting Started”.

This chapter covers the following topics:
- “Overview of the XSLT Mapper” on page 444
- “Source Documents” on page 452
- “Target Structures” on page 458
- “Mapping Source and Target Document Nodes” on page 461
- “Working with XSLT Instructions in XSLT Mapper” on page 463
- “Processing Source Nodes” on page 469
- “Creating and Working with Templates” on page 475
- “Creating an XSLT Scenario” on page 477
Overview of the XSLT Mapper

The XSLT mapper helps you compose XSLT that aggregates data from one or more source documents, regardless of their origin or XML. For example, an inventory application might use information from multiple vendors, each of whom organizes invoices in a different way. You can use the XSLT mapper to identify source documents, map the relevant nodes from each to a target document, and in doing that define any required XSLT instructions, XPath or Java functions, and logical operators graphically.

To use the XSLT mapper to create an XSLT stylesheet, you start by specifying one or more source documents and one target document.

The Mapper tab consists of these areas:

- Source document pane, in which you add one or more source documents.
- Target structure pane, in which you specify the structure of the result you want the XSLT to return.
- Mapper canvas, on which you can define conditions, functions, and operations for source document nodes to filter return values that are then mapped to the target node.

Figure 231. Example of XSLT Mapper

The Mapper tab consists of these areas:

- Source document pane, in which you add one or more source documents.
- Target structure pane, in which you specify the structure of the result you want the XSLT to return.
- Mapper canvas, on which you can define conditions, functions, and operations for source document nodes to filter return values that are then mapped to the target node.
Overview of the XSLT Mapper

- Source code pane (not shown in Figure 231). The source code pane allows you to view the source code while using the mapper. This is a great way to see how changes to the mapper affect the source, without the need to switch to the XSLT Source tab. Of course, the XSLT Source tab is available if you prefer working with the source using a full-page view. All views – Mapper tab, XSLT Source tab, and the source pane – are synchronized. When displayed, the source pane spans the width of the XSLT editor.

As you link elements and define XSLT instruction and function blocks in the mapper, Stylus Studio composes XSLT for you, which is visible (and editable) any time you click the XSLT editor’s XSLT Source tab. When you have finished mapping, you can apply the stylesheet to XML documents that have the same schema as the source document. The result document also has the same schema as the destination document.

As with the XSLT Source tab, you can preview XSLT results from the Mapper tab by clicking the Preview Result button ( ). Debugging, however, can be performed from the XSLT Source tab only.

This section covers the following topics:

- Example on page 445
- Graphical Support for Common XSLT Instructions and Expressions on page 446
- Setting Options for the XSLT Mapper on page 447
- Simplifying the Mapper Canvas Display on page 447
- Exporting Mappings on page 450
- Searching Document Panes on page 451
- Ensuring That Stylesheets Output Valid XML on page 451

**Example**

Suppose you open the XML mapper and select books.xml as the source document and catalog.xml as the target document. You then map elements in the books.xml document or structure to elements in the catalog.xml document or structure. The result is a stylesheet that you can apply to books.xml and to other files that have a structure similar to that of books.xml. When you apply this stylesheet, the result is an XML document whose structure is consistent with that of catalog.xml.

Now suppose you want to apply a stylesheet to catalog.xml and output an XML file that has a structure similar to books.xml. To do this, you must use the XSLT mapper to create a second stylesheet. This time, catalog.xml is the source document and books.xml is the
Creating XSLT Using the XSLT Mapper

destination document. The result of this mapping is a stylesheet that you can apply to documents that have a structure similar to that of catalog.xml.

Graphical Support for Common XSLT Instructions and Expressions

The XSLT mapper has graphical support for

- XSLT instructions
- XPath functions
- Logical operators
- Java Functions

Using special symbols, called *blocks*, you can quickly and easily create complex XSLT without writing any code, as shown in Figure 232:

![Figure 232. XSLT Operation, Function, and Logical Operator Blocks](image)

Blocks can be created

- Automatically, when you link one node to another. For example, if you link repeating elements in the source and target documents, Stylus Studio automatically creates an `xs1:for-each` instruction block in the mapper.
- Manually, by selecting the instruction or expression you want to create from the shortcut menu on the mapper canvas (right click on the mapper canvas to display this menu).
- By reverse-engineering the XSLT that you write on the XSLT Source tab – when you click the Mapper tab, XSLT that can be represented graphically is displayed on the mapper canvas.
Overview of the XSLT Mapper

See “Working with XSLT Instructions in XSLT Mapper” on page 463 and “Processing Source Nodes” on page 469 to learn more about working with blocks in the XSLT mapper.

Setting Options for the XSLT Mapper

There are a few options you can set that affect the XSLT stylesheets generated by the XSLT mapper. To display the Options dialog box, in the Stylus Studio tool bar, select Tools > Options.

Under Module Settings > XSLT Editor, click Mapper. The mapper has an option that determines whether Stylus Studio creates empty elements for unlinked nodes when the associated schema specifies that the elements are required. You might want to select this option to help ensure that your XSLT generates valid XML by ensuring that all required elements are accounted for.

**Tip** A red check appears on the symbol for required nodes in the target document tree displayed in the structure pane.

Among other options under the XSLT Editor heading, consider clicking XSLT Settings and specifying whether or not you want Stylus Studio to save scenario metainformation in the stylesheet. Scenario metainformation includes anything specified in the Scenario Properties dialog box – source and output URLs, parameter values, post-processing options, and so on.

**Note** If you select this option, Stylus Studio also saves mapper metainformation in the stylesheet; mapper metainformation includes the names of source files, node mapping information, and so on.

If you choose not to save scenario metainformation in the stylesheet, and if the stylesheet belongs to a project, Stylus Studio saves mapper metainformation in the project. If the stylesheet does not belong to a project, and you choose not to save metainformation in the stylesheet, mapping metainformation is not saved.

Simplifying the Mapper Canvas Display

By default, the XSLT Mapper displays all links between source and target document nodes, regardless of whether or not the node associated with a link is currently visible in the Source Document or Target Document pane. Further, as your XSLT code becomes more complex, the mapper canvas can become dense with graphical representations of the functions defined in the code and the links that represent them. Consider this example of
Creating XSLT Using the XSLT Mapper

sample2Video.xsl, one of the sample XSLT stylesheets in the Examples project installed with Stylus Studio.

Figure 233. Mapper Shows Links to All Nodes, Visible or Not
You can hide links for nodes that are not currently visible in the **Source Document** or **Target Document** pane by clicking the **Hide Links for Nodes that are not Visible** button, as shown in Figure 234:

![Figure 234. Simply the Mapper by Hiding Links](image)

When you use this feature, Stylus Studio displays

- Links in the Mapper canvas only if both nodes are currently visible in the document panes
- Green arrows (like the ones shown in Figure 235) in the document panes if only one of two linked nodes is currently visible.

![Figure 235. Arrows Identify Partially Available Links](image)
Other Mapper Display Features

In addition to displaying links for only those nodes that are visible in both document panes, you can use the document node shortcut menu (right-click on a node in a document pane) to

- Show links to a specific node
- Hide links to a specific node
- Show/hide all links

Exporting Mappings

You can export a mapping – source and target document trees and Mapper canvas contents – as an image file. The default image format is JPEG (.jpg), but you can choose from other popular image file formats such as .bmp and .tiff.

The exported image reflects the document trees at the time you export the image – if you have collapsed a node in Stylus Studio, for example, that node is also collapsed in the exported image. However, the exported image includes the entire document tree and Mapper canvas, not just what is currently visible on the Mapper tab.

By default, all source-target document links are displayed. However, if you have chosen to hide or show links for only certain nodes, the exported image reflects that choice and displays only the links for the nodes as you have specified. See “Simplifying the Mapper Canvas Display” on page 447 for more information on hiding and showing links.

1. Optionally, hide links for any nodes in the source or target documents that you do not want to appear in the exported image.

2. Select XSLT > Export Mapping as Image from the Stylus Studio menu. Stylus Studio displays the Save As dialog box.


4. Optionally, change the image type. (The default is JPEG; .bmp and .tiff are also available.)

5. Click Save.
Searching Document Panes

You can search document panes using the Find dialog box.

![Find dialog box]

Figure 236. You Can Search Document Panes

You can restrict your search to elements and/or attributes, and you can even search using regular expressions to define your match pattern.

1. Right-click in the document pane.
2. Select Find from the shortcut menu.

Ensuring That Stylesheets Output Valid XML

Stylus Studio cannot automatically generate a stylesheet that will always generate a valid XML document. As defined by the W3C, an XML document is considered to be valid if it conforms to the DTD with which it is associated.

For example, consider a stylesheet that has required attributes. In order to specify meaningful values for them, you need to have insight as to the semantics of the operation the stylesheet is performing, and it is difficult for any application to infer this type of information. Always check to see that the stylesheets you create using the XSLT mapper generate valid input.

Steps for Mapping XML to XML

1. From the Stylus Studio menu bar, select File > New > XSLT: Mapper.
   Stylus Studio displays the XSLT editor with the Mapper tab selected.
2. Select one or more source documents and a target document.
3. In both the source and the target panes, click the root element and then press the asterisk key (*) in the numeric key pad to expand the schema tree.
Creating XSLT Using the XSLT Mapper

4. Map nodes in the source documents to nodes in the target document, define XSLT instructions and functions, and create named and matched templates using the mapper’s graphical tools.

   **Tip**  Consider working through the source document in document order as you map source and target elements.

5. Check the XSLT Source view from time to time. This allows you to confirm that the stylesheet is doing what you expect it to do (and it is also a good way to teach yourself XSLT). Changes you make directly to the source are reflected on the Mapper tab, and vice versa.

Each of these steps is described in greater detail in the following sections.

Source Documents

In Stylus Studio, a source document in the XSLT mapper can be an XML document, an XML Schema (XSD), or a document type definition (DTD). The role of a source document is to provide Stylus Studio with a structure that it can use to compose the XSLT stylesheet, based on how you map individual source document elements and attributes to nodes in the target structure. Stylus Studio infers the target structure from the document (XML, XSD, or DTD) you specify and displays this structure on the Mapper tab.

This section covers the following topics:
- “Choosing Source Documents” on page 452
- “Source Documents and XML Instances” on page 453
- “How to Add a Source Document” on page 455
- “How to Remove a Source Document” on page 457
- “How Source Documents are Displayed” on page 457

Choosing Source Documents

You can use one or more source documents to build a stylesheet in the Stylus Studio XSLT mapper. You might want to select more than one document if you need their elements or attributes to fully describe the target structure or the desired XSLT result content, or if you want to aggregate multiple sources in a single document, for example.

If you choose an XSD or DTD document, you must also choose an XML instance document to associate with it. Stylus Studio uses the instance document associated with
an XSD or DTD source document to generate the XPath document() function in the finished XSLT. As a result, it is this document that is used to preview XSLT results.

**Tip** If you want to examine the contents of the XML document specified as the source file in the scenario, click [Open XML From Scenario](#), which is at the top of the XML mapper window. Stylus Studio displays the source document in the XML editor. See “Source Documents and XML Instances” on page 453 to learn more about how Stylus Studio treats source documents. See “Creating an XSLT Scenario” on page 477 to learn more about XSLT scenarios.

### Source Documents and XML Instances

As described previously, Stylus Studio uses the source documents you specify to display a structure you can use to create mappings to the target structure. In addition to the document structure, Stylus Studio needs document content information in order to compose a correct XSLT stylesheet. You provide this information by associating a XML instance to each source document you specify.

#### Types of associations

Source documents can have one of three associations, each of which has implications for the XPath expressions written by Stylus Studio, which uses these documents when it composes the XSLT stylesheet. A source document can be associated with

- **Itself.** That is, the document represented by structure displayed on the [Mapper](#) tab and the XML instance are one in the same. In this situation, Stylus Studio generates the document() function in the XSLT stylesheet. For example:

  ```xml
  document("file://c:\Program Files\Stylus Studio\examples\simpleMappings\catalog.xml")/books/book
  ```

- **The XML document specified in the XSLT scenario.** Only one source document can be associated with the XSLT scenario. In this situation, Stylus Studio does not generate the document() function in the XSLT stylesheet. In this situation, the document() function is not necessary because Stylus Studio uses the XSLT input document specified in the [Scenario Properties](#) dialog box.

**Note** The previous example shows the XSLT that results when an XML document is used to specify the source structure. This is not possible with XSD or DTD source documents.
By default, Stylus Studio uses the first XML document you add to the XSLT mapper as the source XML for the XSLT scenario, as shown here:

![Scenario Properties dialog box](image)

Figure 237. XSLT Scenario

The document specified in the **Source XML URL** field on the **Scenario Properties** dialog box is the document to which the XSLT is applied when you preview the XSLT. You can select this association for another XML document if you choose, but only one source document may have this association.

**Note**

If you specify an XML document as the first source document, Stylus Studio creates a scenario for you automatically, using that document as the scenario’s source XML. If you specify some other type of document (XSD or DTD), Stylus Studio prompts you to create a scenario – and to specify an XML document as the source – when you preview the XSLT. See “Creating an XSLT Scenario” on page 477.

- Some other XML instance. A XSD or DTD document used as a mapper source document must always be associated with an XML instance. In this situation, Stylus Studio generates the `document()` function in the XSLT stylesheet when accessing nodes of the document structure.
Source Documents

Source document icons

Stylus Studio uses different document icons to indicate how a source document structure is related to corresponding XML document content.

Table 36. Source Document Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="folder_icon.png" alt="Folder icon" /></td>
<td>The source document is associated with itself. This is the default for most XML documents (and XML documents only).</td>
</tr>
<tr>
<td><img src="folder_icon.png" alt="Folder icon" /></td>
<td>The source document is associated with default XML document specified in the Source XML URL field in the XSLT scenario. This is the case with the first XML document you add to XSLT mapper, but you can change this association manually if you choose. See “How to change a source document association” on page 455.</td>
</tr>
<tr>
<td><img src="folder_icon.png" alt="Folder icon" /></td>
<td>The source document is associated with a separate XML document instance. XSD and DTD source documents are always associated with an XML instance.</td>
</tr>
</tbody>
</table>

How to change a source document association

1. Click the Mapper tab if necessary.
2. Right click the source document whose association you want to change. The source document shortcut menu appears.
3. Click Associate With, and then select the document you want to associate with the source document.

How to Add a Source Document

1. Click the Mapper tab if necessary.
2. Click the Add Source Document button at the top left of the Mapper tab. The Open dialog box appears.
3. Select the document you want to use as the source document to map to the target document.
4. Click Open.
Creating XSLT Using the XSLT Mapper

If you selected an XML document in Step 3, the document appears in the source document pane of the Mapper tab. Go to Step 5.

If you selected an XSD or DTD document, Stylus Studio displays the Choose Root Element dialog box.

![Choose Root Element Dialog Box](image)

You use the Associate With field to associate the XSD or DTD with an XML instance.

**Note** The Associate With field appears only when you add a second document to the XSLT mapper source and that document is an XSD or DTD. You use it to specify the XML instance that you want to associate with the XSD or DTD. This field does not appear if the XSD or DTD is the first source document you add to the XSLT mapper – Stylus Studio uses the XML Source document specified in the Scenario Properties dialog box as the XML instance in this case.

a. Select the element from the XSD or DTD document that you want to use as the root element. The Choose root element drop-down list displays elements defined in the document you selected in Step 3.

b. Use the Browse ( ) button to specify the XML instance to which you want to associate the document you have chosen as your structure. The root element of the XML document you select should be the same as the element you selected as the root element from the XSD or DTD document.

c. Click OK.

The document appears in the source document pane of the Mapper tab. Go to Step 5.

5. To add another source document, return to Step 2.

**How to Remove a Source Document**

**Note** A source document cannot be removed from XSLT mapper if it is mapped to the target structure. See “Removing Source-Target Maps” on page 463.

1. Click the Mapper tab if necessary.
2. Remove any maps from the source document to the target schema. (See “Removing Source-Target Maps” on page 463 if you need help with this step.)

3. Right click on the source document.
   The source document shortcut menu appears.


How Source Documents are Displayed

A source document is represented in the mapper using a document icon; its name is displayed using a different color to help distinguish the document from elements and attributes. The document icon is modified based on the source document’s association with other documents. See “Source Documents and XML Instances” on page 453 for more information on this topic.

By default, only the file name itself is displayed; if you want, you can display the document’s full path by selecting Show Full Path on the document’s shortcut menu. (Right-click on the document name to display the shortcut menu.)

Source documents are displayed using the tree view; you can use your standard keyboard’s *+, and - number pad keys to expand and collapse selected documents.
Document structure symbols

Stylus Studio uses the following symbols to represent nodes in both source and target document structures

Table 37. Document Structure Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Repeating element</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Element</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Attribute</td>
</tr>
</tbody>
</table>

See “Source document icons” on page 455 to learn about the different ways source document icons are depicted.

Getting source document details

If you want details about the source document that are not available in tree view, you can open the document by selecting Open from the document’s shortcut menu. When you open a document this way, Stylus Studio displays it in the XML editor. XSD and DTD documents are displayed on the XML editor’s Schema tab.

Target Structures

There are two ways to specify an XSLT target structure:

- You can select an existing document from which Stylus Studio infers a structure and, optionally, modify the structure. Existing nodes in a target structure are displayed in blue. Nodes that you add are displayed in red.
- You can build a structure from scratch, starting with the root element and defining other elements and attributes as needed. Nodes for target structures you define are displayed in red.

This section covers the following topics:

- “Using an Existing Document” on page 459
- “Building a Target Structure” on page 459
- “Modifying the Target Structure” on page 460
Using an Existing Document

1. Click the Mapper tab if necessary.
2. Click the Set Target Document button at the top left of the Mapper tab. The Open dialog box appears.
3. Select the document you want to use to provide the target structure for defining the mapping (XML, XSD, or DTD).
4. Click Open. The structure of the document you select appears in the target document pane of the Mapper tab.

Building a Target Structure

To build a target structure from scratch, you first create a root element, and then define child elements and attributes as needed.

How to create a root element

1. Click the Mapper tab if necessary.
2. Right click the area underneath the Set Target Document button. The target document shortcut menu appears.
3. Select Create Root Element. The Name dialog box appears.
4. Type a name for the root element and click OK. The root element you specified appears in the target document pane of the Mapper tab.

How to create elements and attributes

You can create elements and attributes in a new or existing target structure.

1. Click the Mapper tab if necessary.
Creating XSLT Using the XSLT Mapper

2. Select the attribute or element to which you want to add a child element or attribute. If you have just created a root element, select the root element.

3. Right click the area underneath the Set Target Document button. The target document shortcut menu appears.

4. Choose one of the following:
   ❍ Add Attribute
   ❍ Add Child Element
   ❍ Insert Element After (This choice is not applicable to the root element; it creates the element as a sibling of the selected element.)

   The Name dialog box appears.

5. Type a name for the node and click OK. The node you specified is added to the target structure in the Mapper tab.

Modifying the Target Structure

This section describes the techniques you can use to modify the structure and content of an XSLT mapper target structure. It covers the following topics:

● “Adding a Node” on page 460
● “Removing a Node” on page 461

Adding a Node

See “How to create elements and attributes” on page 459.

Removing a Node

Note: Before you can remove a node, you must delete any links to that node. See “Removing Source-Target Maps” on page 463.

1. Remove any links to the node you want to remove from the target structure. See “Removing Source-Target Maps” on page 463 if you need help with this step.
2. Select the node and press the Delete key.
   Alternative: Right-click the node and select Remove Node from the shortcut menu.

Mapping Source and Target Document Nodes

You map a source document node to a target structure node using drag and drop to create a link between the two nodes. Stylus Studio composes XSLT based on these maps.

This section covers the following topics:
- “Preserving Mapper Layout” on page 461
- “Left and Right Mouse Buttons Explained” on page 462
- “How to Map Nodes” on page 463
- “Removing Source-Target Maps” on page 463

Tip You can also map source document nodes to XSLT instruction blocks, XPath and Java function blocks, and logical operators. See “Working with XSLT Instructions in XSLT Mapper” on page 463 and “Processing Source Nodes” on page 469.

Preserving Mapper Layout

As you add function blocks to the XSLT mapper, Stylus Studio places them in the center of the mapper canvas. You can change the default placement of function blocks by dragging and drop them where you like. Stylus Studio preserves the placement you select within and across sessions (as you toggle between the mapper and the XSLT Source tab, for example).

As you use the splitter in the XSLT mapper to widen the source and target document panes, the size of the mapper canvas is reduced. The Fit in Mapper Canvas button ( ), located at the top of the XSLT mapper, redraws the diagram in whatever space is currently available to the mapper canvas. This feature is also available from the mapper short-cut menu (right-click anywhere on the mapper canvas to display the short-cut menu).

Left and Right Mouse Buttons Explained

You can use either the left or the right mouse button to perform the drag and drop operation used to create source-target mappings in the XSLT mapper.

If you use the left mouse button to perform the drag operation, the link always maps the source node to the target node without making any changes to the target structure. If you
Creating XSLT Using the XSLT Mapper

use the right mouse button, Stylus Studio displays a shortcut menu that provides you with alternatives for modifying the target structure.

![Shortcut Menu for Target Document Operations](image)

**Figure 242. Shortcut Menu for Target Document Operations**

Using this menu, you can

- Map a source document node to an existing target structure node – this menu choice, **Map to This Node**, is the same as creating the link using the left mouse button.
- Add a source document node (element or attribute) as an attribute of the target structure node you select and map the two nodes.
- Add a source document node as a child element of the target structure node you select and map the two nodes.
- Add a source document node as a sibling of the target structure node you select and map the two nodes.
- Copy the entire source document node – its structure and its content – to the target structure and map it.

**How to Map Nodes**

1. Using either the left or right mouse button, drag the source document element or attribute to the appropriate node on the target structure.

   **Tip** If you need help with this step, see “Left and Right Mouse Buttons Explained” on page 462.

2. When the pointer is on the appropriate target element, release the mouse button to complete the link.

   Stylus Studio draws a link between the source and target nodes you chose is **Step 1**.

   If you linked two repeating elements, Stylus Studio displays a symbol representing
Working with XSLT Instructions in XSLT Mapper

the xsl:for-each instruction. See Working with XSLT Instructions in XSLT Mapper on page 463.

Removing Source-Target Maps

1. Select the line that represents the map you want to delete.

Tip Select the portion of the line that is drawn on the XSLT mapper canvas.

2. Press the Delete key.
   
   Alternative: Select Delete from the line shortcut menu (right click on the line to display the shortcut menu).

Working with XSLT Instructions in XSLT Mapper

As described in Graphical Support for Common XSLT Instructions and Expressions on page 446, you can create and work with XSLT instructions in the XSLT mapper using symbols called blocks. Each supported instruction is represented by a different block (symbols distinguish one block from another), and you complete the instruction’s definition graphically, using drag and drop.

This section identifies the XSLT instructions supported by the mapper, their features, and how to use them. It covers the following topics:

- What XSLT Instructions Are Represented Graphically on page 464
- Instruction Block Ports on page 464
- Understanding Input Ports on page 465
- The Flow Port on page 466
- Adding an Instruction Block to the XSLT Mapper on page 467
- xsl:if and xsl:choose on page 468
What XSLT Instructions Are Represented Graphically

The XSLT mapper represents the following XSLT instructions:

Table 38. XSLT Instruction Blocks in XSLT Mapper

<table>
<thead>
<tr>
<th>XSLT Instruction</th>
<th>Representation in the XSLT Mapper</th>
</tr>
</thead>
<tbody>
<tr>
<td>xsl:value-of</td>
<td>![Image]</td>
</tr>
<tr>
<td>xsl:for-each</td>
<td>![Image]</td>
</tr>
<tr>
<td>xsl:if</td>
<td>![Image]</td>
</tr>
<tr>
<td>xsl:choose</td>
<td>![Image]</td>
</tr>
<tr>
<td>xsl:apply-templates</td>
<td>![Image]</td>
</tr>
<tr>
<td>xsl:call-template</td>
<td>![Image]</td>
</tr>
</tbody>
</table>

Note: You can create any XSLT instruction in the XSLT source, but only the instructions in Table 38 are represented graphically in the XSLT mapper. XSLT instructions that are not supported by the mapper have no graphical representation.

Instruction Block Ports

All XSLT instruction blocks have at least three connectors, called ports. Look at the xsl:value-of instruction block shown in Figure 243.

Figure 243. Example of an XSLT xsl:value-of Instruction Block

You use these ports to link source and target nodes, to perform processing on source document nodes, and to provide flow control as the result of a xsl:choose or xsl:if.

Ports are also part of XPath and Java function blocks, logical operator blocks, and text blocks. (See Processing Source Nodes on page 469 for information on working with these types of blocks.)
Specifying Values for Ports

After you have added an instruction block to the XSLT mapper, you need to complete its definition. You do this by linking the instruction block’s input, output, and, optionally, flow ports to nodes and other blocks in the mapper.

The way you specify values for ports varies slightly between input ports and flow and output ports, but, generally speaking, you can either

- Dragging a link from the port to a target document node or to the flow port on another instruction block.
- Double-click the port and typing a value (a string or an XPath expression, for example) in the Value dialog box.

Tip To see the XSLT that is being generated based on the XSLT instruction you are creating, right click the instruction and select Go To Source from the shortcut menu.

Understanding Input Ports

Stylus Studio interprets input ports differently for different XSLT instructions, as shown in Table 39:

Table 39. XSLT Instruction Blocks in XSLT Mapper

<table>
<thead>
<tr>
<th>XSLT Instruction</th>
<th>Meaning of Input Port</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>xsl:value-of</code></td>
<td>Used to define the value of the select attribute. For example: <code>&lt;xsl:value-of select=&quot;Owen&quot;/&gt;</code></td>
</tr>
<tr>
<td><code>xsl:for-each</code></td>
<td>Used to define the XPath expression for the select attribute. For example: <code>&lt;xsl:for-each select=&quot;books/book&quot;/&gt;</code></td>
</tr>
<tr>
<td><code>xsl:if</code></td>
<td>Used to define the value of the test attribute. For example: <code>&lt;xsl:if test=&quot;authors/author = 'Henry'&quot;/&gt;</code> See <code>xsl:if</code> and <code>xsl:choose</code> on page 468 to learn more about when to use this instruction.</td>
</tr>
<tr>
<td><code>xsl:choose</code></td>
<td>Used to define the value of the test attribute of the nested <code>xsl:when</code> element. For example: <code>&lt;xsl:when test=&quot;contains(authors/author,'Marchese')&quot;/&gt;</code> See <code>xsl:if</code> and <code>xsl:choose</code> on page 468 to learn more about when to use this instruction.</td>
</tr>
</tbody>
</table>
Specifying Values for Input Ports

You can specify values for input ports by:
- Dragging a link from a source document node or from the output port of another block (like that of an XPath function or If block, for example).
- Double-clicking the port and typing a value (a string or an XPath expression, for example) in the Value dialog box.

Tip
When you mouse over an input port, Stylus Studio displays the value associated with that port.

Red Input Ports

If an xsl: instruction’s attribute takes a literal or string value (such as xsl:value-of select="Recommended"/ for example) and a value has been provided for the attribute, Stylus Studio fills the input port associated with that attribute with a deep red to indicate that a value has been specified.

The Flow Port

Output ports for any of the following xsl: instructions can be linked to the flow port of an instruction block:
- xsl:if
- The xsl: when element of xsl: choose
- xsl: for-each

You might decide you want a particular xsl: for-each instruction executed only after performing a certain function, for example.

### Table 39. XSLT Instruction Blocks in XSLT Mapper

<table>
<thead>
<tr>
<th>XSLT Instruction</th>
<th>Meaning of Input Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>xsl:apply-templates</td>
<td>Used to define the value of the select attribute. For example: <code>&lt;xsl:apply-templates select=&quot;subject&quot;/&gt;</code></td>
</tr>
<tr>
<td>xsl:call-template</td>
<td>Used to define the value of the name attribute. For example: <code>&lt;xsl:call-template name=&quot;newAuthorsTemplate&quot;/&gt;</code></td>
</tr>
</tbody>
</table>
Adding an Instruction Block to the XSLT Mapper

**Tip** If you enter an XSLT instruction in the XSLT source and that instruction can be graphically represented in the mapper, the instruction, including appropriate links to source and target nodes, appears the next time you display the Mapper tab.

1. Right click on the mapper canvas.
   The shortcut menu appears.
2. Select **XSLT Instructions** from the shortcut menu.
   The XSLT Instructions submenu appears.
3. Select the instruction you want to add to your XSLT.
   The block for the instruction you selected appears in the mapper canvas.
4. Provide a value for the input port(s). See **Specifying Values for Ports** on page 465 if you need help with this step.
5. Link the output port(s).
6. Optionally, link the flow port.

**Notes About Creating Instruction Blocks**

Be aware of the following when working with XSLT instruction blocks in the XSLT mapper:

- To simplify the mapper’s appearance, Stylus Studio sometimes removes blocks from the mapper canvas and replaces them with a simple link. For example, imagine creating an `xsl:value-of` instruction block and linking source and target document nodes. Stylus Studio displays the instruction block, but if you leave the Mapper and later return to it, the block symbol for the `xsl:value-of` instruction is replaced by a link with a small circle at its center, link the one shown in Figure 244.

![Figure 244. xsl:value-of in XSLT Mapper](image)

If you mouse over the circle, Stylus Studio displays the XSLT represented by the link (`xsl:value-of select="/books/book/@pubdate"`, for example).

This behavior also exists for text blocks created in the mapper that are not also linked to other blocks in the mapper. See **Setting a Text Value** on page 473.
Creating XSLT Using the XSLT Mapper

- If you type an XSLT instruction in the XSLT source that is not represented by the XSLT mapper, no representation of that XSLT instruction is displayed on the Mapper tab. The code remains as part of the XSLT source, however.
- If you start creating an XSLT instruction in the mapper but do not completely define it (say you specify only the input port for an \texttt{xsl:for-each} instruction, for example), it is not represented in the XSLT source, and it is removed from the XSLT mapper if you leave the Mapper tab and then return to it.

**xsl:if and xsl:choose**

The \texttt{xsl:if} instruction cannot express an else condition. It has a single input port, and a single output port, as shown in Figure 245.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{fig245}
\caption{\texttt{xsl:if} Instruction Block}
\end{figure}

Once fully defined, the \texttt{xsl:if} block generates code like the following:

\begin{verbatim}
<Review>
  <xsl:if test="authors/author = 'Minollo'">
    <xsl:value-of select="'Recommended'"/>
  </xsl:if>
  <xsl:if test="contains(authors/author, 'Pedruzzi!')">
    <xsl:value-of select="'A best buy'"/>
  </xsl:if>
</Review>
\end{verbatim}

If you need to express an else condition, use the \texttt{xsl:choose} instruction block. This instruction block has two output ports by default, one for the \texttt{xsl:when test= attribute, and one for the one \texttt{xsl:otherwise} element.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{fig246}
\caption{\texttt{xsl:choose} Instruction Block}
\end{figure}
The \texttt{xsl:choose} instruction block generates code like the following:

\begin{verbatim}
<Review>
  <xsl:choose>
    <xsl:when test="authors/author = 'Minollo'">
      <xsl:value-of select="'Recommended'"/>
    </xsl:when>
    <xsl:when test="contains(authors/author, 'Pedruzzi')">
      <xsl:value-of select="'authors best buy'"/>
    </xsl:when>
    <xsl:otherwise>
      <xsl:value-of select="'bah...'"/>
    </xsl:otherwise>
  </xsl:choose>
</Review>
\end{verbatim}

If you need to define more than one \texttt{xsl:when} \texttt{test=} attribute, use the \texttt{xsl:choose} shortcut menu (right click) and select \textit{Add When Port}.

\textbf{Note} Stylus Studio generates the \texttt{xsl:otherwise} element by default for all \texttt{xsl:choose} instructions.

\section*{Processing Source Nodes}

You can use any of the following to combine nodes or process nodes in the source document and map the result to a node in the target document:

- XPath Function Blocks on page 470
- Logical Operators on page 472
- Setting a Text Value on page 473
- Defining Java Functions in the XSLT Mapper on page 474

\section*{XPath Function Blocks}

Stylus Studio supports standard XPath functions defined by the W3C. This section describes how to work with function blocks in XSLT mapper and covers the following topics:

- “Parts of a Function Block” on page 470
- “Types of Function Blocks” on page 471
- “Creating a Function Block” on page 472
- “Deleting a Function Block” on page 472
Creating XSLT Using the XSLT Mapper

Parts of a Function Block

Function blocks are drawn as a purple block with an italic “f” at its center, and connectors, called ports, placed along the block’s border. Input ports (one or more depending on the function) on the left, the flow port at the top, and the output port on the right:

![Function Block Diagram](image)

**Figure 247. Function Block**

**Input ports**

Input ports are on the left side of the function block. The number and definition of input ports varies from function to function. To specify a value for an input port, you can

- Drag a source document element or attribute to the port and release it
- Double-click the port and enter the function in the Value dialog box

**Flow port**

Flow ports on the top of function blocks are generally used only when a function is used in a direct link between a source and target node.

**Output port**

The output port is on the right side of the function block. You use the output port to map the function result directly to a target structure element or attribute, or to an IF, condition, or another function block.

**Types of Function Blocks**

The XPath functions available in XSLT mapper include the following:

- boolean
- ceiling
- concat
- contains
- count
- floor
**Processing Source Nodes**

- format
- last
- local-name
- mod
- name
- normalize-space
- number
- position
- round
- starts-with
- string
- string-length
- substring
- substring-after
- substring-before
- sum
- translate

**XPath Mathematical Functions**

In order to simplify the graphical presentation in the XSLT mapper, the following XPath mathematical functions are not graphically represented:

- add
- div
- multiply
- subtract

You can easily express these functions by typing them in the **Value** dialog box displayed when you double-click an input port.

**Creating a Function Block**

1. In the XSLT editor, in the **Mapper** tab, right-click mapper canvas.
2. In the shortcut menu that appears, click **XPath Functions** and slide to the submenu.
Creating XSLT Using the XSLT Mapper

3. Click the function you want to use. Stylus Studio displays a function block for the function you selected.

Deleting a Function Block

Select it and press the Delete key.

If the function block is part of a link, deleting the function block also deletes the link.

Logical Operators

The Stylus Studio XSLT mapper allows you to graphically define the following types of conditions:
- Equal (=)
- Less than (<)
- Greater than (>)
- Less than or equal to (<=)
- Greater than or equal to (>=)
- and (\&)
- or (||)

All condition blocks have two input ports and a single output port, as shown in this example of a greater than block.

![Greater Than Block](image)

Figure 248. Greater Than Block

You can map the return port to a target structure element or attribute, or to the input port on an XSLT instruction, XPath function, or another condition block.

Setting a Text Value

You can set text values for target structure elements and attributes. You might want to do this if you are composing a mapping whose target structure contains an element or attribute that requires a fixed value, instead of using a value gathered from an input XML document.
Example

Here is the XSLT code Stylus Studio generates for the Title element when a text value is specified for it:

```xml
<Book>
  <Title>Confederacy of Dunces</Title>
</Book>
```

Stylus Studio displays a red letter T for nodes for which you define a text value:

![Figure 249. Symbols for Nodes With Text Values](image)

There are two ways to set a text value:

- On the mapper canvas
- On the target node

How to Set a Text Value on the Mapper Canvas

1. Right-click on the mapper canvas.
   The shortcut menu appears.
2. Select Text Block from the shortcut menu.
   The text block appears on the mapper.

![Figure 250. Text Block](image)

Double-click the text block to display the Value dialog box.

![Figure 251. Value Dialog Box](image)

**Tip**

You can also display the Value dialog box by selecting Properties from the text block shortcut menu (right click).
3. Type a value and click **OK**.
4. Drag a link from the text block’s output port to the target node to which you want to assign the text value.

**Note** Unless the text block is linked to another block (such as a logical operator or an XPath function), Stylus Studio removes it from the mapper canvas if you leave and then return to the Mapper tab. In this case, a red T is displayed next to the target node’s name.

### How to Set a Text Value on the Target Node

1. Right-click the node for which you want to set the text value. The shortcut menu appears.
2. Select **Set Text Value** from the shortcut menu. The **Value** dialog box appears.
3. Type the string you want to use as the text value and click **OK**.

**Figure 252. Value Dialog Box**

### Defining Java Functions in the XSLT Mapper

You can write your own Java functions and use them when you map nodes.

1. Ensure that a Java virtual machine is running locally.
2. Create the class file for your function. See “About Adding Java Class Files” on page 475 for more help with this step.
3. Display the **Mapper** tab in the XSLT editor, if necessary.
4. Right-click the mapper canvas.
5. In the pop-up menu that appears, select **Java Functions > Register Java Extension Class**.
6. In the **Java Class Browser** dialog box that appears, navigate to and select the Java class that provides your function.
7. Click **OK** in the **Java Class Browser** dialog box.

Now when you select **Java Functions** from the mapper short-cut menu, the list of functions includes the function you registered.

### About Adding Java Class Files

The class file must be in your **CLASSPATH** environment variable or in the Stylus Studio **ClassPath**. To add it to the Stylus Studio **ClassPath**, select **Tools > Options** from the Stylus Studio menu bar. In the **Options** dialog box, expand **Application Settings** and click **Java Virtual Machine**.

### Creating and Working with Templates

A stylesheet can contain more than one template. This section describes Stylus Studio’s features for creating and working with named and matched templates in XSLT mapper.

#### What Happens When You Create a Template

When you create a template, Stylus Studio switches the XSLT mapper to the new template. The attributes identifying the template you are currently viewing are displayed in the template drop-down list at the top of the mapper canvas.
Creating XSLT Using the XSLT Mapper

You can change the template view at any time, by selecting the template from the drop-down list, as shown in Figure 254.

![Figure 254. Display Different Templates Using the Drop-down List]

**Tip** At any time, the mapper shows only the links that have been defined for the current template.

**How to Create a Named or Matched Template**

1. Right-click the XSLT mapper canvas.
2. Select Create Template > Named Template or > Matched Template from the shortcut menu.

Stylus Studio displays the Named Template (or Matched Template) dialog box. (The Named Template dialog box is shown in Figure 255.)

![Figure 255. Named Template Dialog Box]

3. Enter a name and, optionally, a mode.

**Tip** You can use a mode to define the conditions under which a template will be applied by a stylesheet.

4. Optionally, create one or more parameters:
Creating an XSLT Scenario

An XSLT scenario is a group of settings that Stylus Studio uses to process the XSLT when you click the Preview Result button ( ). Examples of scenario settings include the XML document to which the XSLT will be applied, whether you want to perform any post-processing, and the values of any parameters you might have defined. You can create multiple scenarios that use the same XSLT, and choose different settings for each. This flexibility can aid the XSLT development process as it enables you to easily test different applications of the XSLT before you put it online.

Even if you do not explicitly create a scenario, Stylus Studio uses default scenario settings in order to preview the XSLT. For example, Stylus Studio uses the first source document you specify as the document to which the XSLT is applied. (If the first source document is an XSD or DTD, Stylus Studio prompts you to provide an XML document for the scenario when you preview the XSLT.)

This section covers the following topics:
- “Overview of Scenario Features” on page 478
- “How to Create a Scenario” on page 482
- “How to Run a Scenario” on page 483
- “How to Clone a Scenario” on page 484

Overview of Scenario Features

This section describes the main features of XSLT scenarios. It covers the following topics:
- “XML Source Documents” on page 478
- “Global Parameters” on page 479
- “XSLT Processors” on page 481
XML Source Documents

The main benefit of the XSLT scenario feature is that it lets you specify the XML document against which you want to run your XSLT. By default, Stylus Studio uses the first source document you add using the XSLT mapper as the XML source document for the scenario. You can specify the XML source document setting on the General tab of the Scenario Properties dialog box.

Figure 256. General Tab of XSLT Scenario Properties Dialog Box

See “Source Documents” on page 452 to learn more about the process of selecting and working with source documents in XSLT mapper.

Global Parameters

The Parameter Values tab of the Scenario Properties dialog box displays any global parameters you have defined in the XSLT source and allows you to

- Specify an alternate value to use when running the scenario
- Indicate whether the value is an XPath expression or a string
Creating an XSLT Scenario

For example, imagine the following parameter defined in the XSLT source:

```xml
<xsl:param name="my_title" select="'Confederacy of Dunces'"/>
```

This parameter is displayed on the **Parameter Values** tab as follows:

![Figure 257. Specifying Alternate Values for XSLT Parameters](image)

If you want to specify an alternate parameter value for this scenario, click the **Parameter value to be used when processing** entry field. If the alternate value you enter is an XPath expression, click the associated check box.

**Tip** All global parameters you define for a stylesheet are displayed on the **Params/Other** tab of the XSLT editor. Parameters displayed on this tab are read-only.
XSLT Processors

By default, Stylus Studio uses a built-in processor to process XSLT documents. You can change the processor on the Processor tab of the Scenario Properties dialog box.

![Scenario Properties](image)

Figure 258. Changing the Default XSLT Processor

You can choose from a number of third-party processors that are bundled with Stylus Studio, or you can specify your own custom processor.

Note Not all third-party processors, including any custom processors you might specify, support back-mapping and debugging.

See “How to Use a Third-Party Processor” for more information.

Performance Metrics Reporting

Performance metrics reporting is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio can generate an HTML report that contains information about how your XSLT is being processed. This option is off by default, but you can enable it, and choose options for the report, on the Profiling Options tab.

See “Profiling XSLT Stylesheets” on page 491 to learn more about the different ways in which Stylus Studio can provide you with XSLT performance metrics.
Creating an XSLT Scenario

Result Document Validation

You can optionally validate the XML document that results from XSLT processing using the XML validator you specify. You can use:

- The Stylus Studio built-in XML validator. If you use the Stylus Studio built-in processor, you can optionally specify one or more XML Schemas against which you want the result document to be validated.
- Any of the customizable processors supported by Stylus Studio, such as the .NET XML Parser, Xerces-J, and XSV.

All validation is done before any post-processing that you might have specified.

See “Validating Result Documents”.

Post-Processing Result Documents

You can use the Post-process tab to specify any optional processing you want performed on the XML after it has been processed by the XSLT. You might want to use FOP to render XML as PDF, for example.

How to Create a Scenario

1. In the XSLT Editor tool bar, click ...
   Alternative: Select Create Scenario from the scenario drop-down list at the top of the editor window.
   Stylus Studio displays the Scenario Properties dialog box.

2. In the Scenario name: field, type the name of the new scenario.

3. In the Source XML URL (optional): field, type the name of the XML file to which you want to apply the XSLT, or click Browse to navigate to an XML file and select it.
   Note: If the first document you added to the XSLT mapper is an XML document, Stylus Studio uses that document as the XML source for the scenario and displays it in this field.

4. In the Output URL field, optionally type or select the name of the result document you want the XSLT document to generate. If you specify the name of a file that does not exist, Stylus Studio creates it when you preview the XSLT.

5. If you want Stylus Studio to Store paths relative to XSLT document path, ensure that this option is checked.
Creating XSLT Using the XSLT Mapper

6. If you check **Preview result in an external application**, Stylus Studio displays the result in Internet Explorer. In addition, Stylus Studio always displays XSLT results in the Preview window.

7. Optionally, configure settings for global parameters, the XSLT processor you want to use, whether or not you want to run a profiling report, and whether or not you want to perform any post-processing on the XSLT result. See **Overview of Scenario Features** on page 478 for more information.

8. To define another scenario, click **Add** and enter the information for that scenario. You can also copy scenarios. See **How to Clone a Scenario** on page 484.

9. Click **OK**.

   If you start to create a scenario and then change your mind, click **Delete** and then **OK**.

---

### How to Run a Scenario

1. Select a scenario from the scenario drop-down list at the top of the editor window.

   **Alternative:**

   a. In the XSLT Editor tool bar, click ![button].

      Stylus Studio displays the **Scenario Properties** dialog box.

   b. On the **General** tab, select the scenario you want to run from the **Existing Scenarios** list.

   c. Click **OK**.

2. Click the **Preview Result** button ( ![button]).
Creating an XSLT Scenario

How to Clone a Scenario

When you clone a scenario, Stylus Studio creates a copy of the scenario except for the scenario name. This allows you to make changes to one scenario and then run both to compare the results.

1. Display the XSLT in the scenario you want to clone.
2. In the XSLT editor tool bar, click [ ] to display the Scenario Properties dialog box.
3. In the Scenario Properties dialog box, in the Existing preview scenarios field, click the name of the scenario you want to clone.
4. Click Clone.
5. In the Scenario name field, type the name of the new scenario.
6. Change any other scenario properties you want to change. See How to Create a Scenario on page 482.
7. Click OK.

If you change your mind and do not want to create the clone, click Delete and then OK.
Chapter 6  Debugging Stylesheets

Stylus Studio provides several tools that allow you to follow XSLT processing and detect errors in your stylesheets. To use these tools, you must use the processors displayed in the Debug and back-mapping enabled section of the Processors page on the Scenario Properties dialog box. These processors include Stylus Studio’s XSLT processor, Apache Xalan-J, MSXML .Net, and Saxon 6 and 8. If you use the MSXML XSLT processor or some other XSLT processor, you cannot use the Stylus Studio debugging and backmapping tools.

You can also use the Stylus Studio debugger to analyze Java files, or applications that include both stylesheets and Java files. In addition, you can use Stylus Studio to debug JavaScript and VBScript extension functions. See the Microsoft documentation for information about these extension functions.

This section discusses the following topics:

- “Steps for Debugging Stylesheets” on page 486
- “Using Breakpoints” on page 486
- “Viewing Processing Information” on page 487
- “Using Bookmarks” on page 490
- “Determining Which Template Generated Particular Output” on page 491
- “Determining the Output Generated by a Particular Template” on page 491
- “Profiling XSLT Stylesheets” on page 491
- “Handling Parser and Processor Errors” on page 495
- “Debugging Java Files” on page 495
Steps for Debugging Stylesheets

Stylus Studio provides tools for debugging transformations.

1. Open a stylesheet.
2. Set up a scenario or select the scenario you want to use. See “Applying Stylesheets”.
3. Set one or more breakpoints. See “Using Breakpoints” on page 486.
4. Apply the stylesheet by pressing F5, not clicking Preview Result. If you click Preview Result, Stylus Studio applies the stylesheet without invoking the debugger.
5. Examine the information in the debugging tools and in the Preview window.
6. Run and examine the information XSLT Profiler report.
7. Iteratively step through the stylesheet or program and examine the information in the debugging tools.

You can include msxml:script elements in XML documents in Stylus Studio. The msxml prefix must indicate the Microsoft urn:schemas-microsoft-com:xslt namespace.

The following sections provide the details for performing each of these steps.

Using Breakpoints

The Stylus Studio debugger allows you to interrupt XSLT or Java processing to gather information about variables and processor execution at particular points.

Inserting Breakpoints

1. In the XSLT stylesheet or Java file in which you want to set a breakpoint, place your cursor where you want the breakpoint to be.
2. Click Toggle Breakpoint or press F9. Stylus Studio inserts a blank stop sign to the left of the line with the breakpoint.

Removing Breakpoints

1. Click in the line that has the breakpoint.
2. Press F9 or click Toggle Breakpoint.
Alternative: In the Stylus Studio tool bar, click **Breakpoints** to display a list of breakpoints in all open files. You can selectively remove one or more, remove them all, or jump to one of them.

**Start Debugging**

When your stylesheet or Java file has one or more breakpoints set, start processing by clicking **Start Debugging** or pressing F5. When Stylus Studio reaches the first breakpoint, it suspends processing and activates the debugging tools. After you examine the information associated with that breakpoint (see “Viewing Processing Information” on page 487) you can choose to

- Step into. Click **Step into** or press F11.
- Step over. Click **Step over** or press F10.
- Step out. Click **Step out** or press Shift+F11.
- Run to cursor. Click **Run to cursor**.
- Continue processing. Press F5.
- Stop processing. Click **Stop Debugging** in the Stylus Studio tool bar, or click **Cancel** in the lower right corner of the stylesheet editor, or press Shift+F5.

**Note** You can also click **Pause** to suspend XSLT processing. Stylus Studio flags the line it was processing when you clicked **Pause**.

**Viewing Processing Information**

Stylus Studio provides several tools for viewing processing information when you suspend processing. The tools become active when processing reaches a breakpoint. This section discusses the following topics:

- **Watching Particular Variables** on page 488
- **Evaluating XPath Expressions in the Current Processor Context** on page 488
- **Obtaining Information About Local Variables** on page 488
- **Determining the Current Context in the Source Document** on page 489
- **Displaying a List of Process Suspension Points** on page 489
- **Displaying XSLT Instructions for Particular Output** on page 490
Watching Particular Variables

Use the Watch window to monitor particular variables. To display the Watch window, click Watch in the Stylus Studio tool bar. This button is active when Stylus Studio suspends processing because it reached a breakpoint. Stylus Studio displays the Watch window only when processing is suspended.

Enter the names of the variables you want to watch. You can enter as many as you like. In a Java program, you can double-click a symbol and drag it to the Watch window to enter it as a variable you want to watch. When Stylus Studio suspends processing, it displays the current values for any variables listed in the Watch window. You can expand and collapse complex structures as needed.

Another way to obtain the value for a variable is to hover over the symbol in your stylesheet or Java program. Stylus Studio displays a pop-up box that contains the current value.

During XSLT debugging, you can enter XPath expressions in the Watch window fields. Stylus Studio uses the current context to evaluate these expressions, and displays the results with the same kind of interface Stylus Studio uses for nodeList and node variables.

Evaluating XPath Expressions in the Current Processor Context

When you suspend processing, you can evaluate an XPath expression in the context of the suspended process. You do this in the Watch window. Click in the Stylus Studio tool bar to display the Watch window. Click in an empty name field and enter an XPath expression. As soon as you press Enter, Stylus Studio displays the results of the evaluation in the Value field of the Watch window.

Obtaining Information About Local Variables

Display the Variables window to obtain information about local variables. To display the Variables window, click Variables in the Stylus Studio tool bar. This button is active when Stylus Studio suspends processing because it reached a breakpoint. Stylus Studio displays the Variables window only when processing is suspended.

For stylesheets, Stylus Studio displays

- A path that shows which node in the stylesheet was being processed when processing was suspended
- Local and global XSLT parameter values
- Local and global XSLT variable values
Viewing Processing Information

Also, you can navigate the structure associated with a variable, a parameter, or the current context if it is a node list or a node.

For Java classes, Stylus Studio displays

- Local variables that are defined at that point in the processing and their values.
- Function parameters and their values.
- A special variable named this. The this variable represents the object being processed. It allows you to drill down and obtain additional information.

You can expand and collapse complex structures as needed.

Determining the Current Context in the Source Document

When you are debugging a stylesheet, the Variables window displays a path for the current context. This is the set of nodes that the XSLT processor is currently working through. This allows you to examine the nodes that lead to the context node.

Displaying a List of Process Suspension Points

Display the Call Stack window to view a list of the locations at which processing was suspended. To display the Call Stack window, click Call Stack in the Stylus Studio tool bar. This button is active when Stylus Studio suspends processing because it reached a breakpoint. Stylus Studio displays the Call Stack window only when processing is suspended.

For stylesheets, Stylus Studio displays the template name and line number. For Java classes, Stylus Studio displays the class name, function name, parameters, and line number.

When processing is complete, the call stack is empty.

When execution is suspended you can use the Call Stack window to jump directly to the XSLT or Java source. Double-click on a stack line to go to that location. A green triangle appears to indicate this location in the source file.

The Call Stack window and the Backmap Stack window provide the same kind of information. However, the Backmap Stack window never shows Java entries, and the contents of the Backmap Stack window can be different from the Call Stack window according to where you click in the output to enable backmapping.
Debugging Stylesheets

Displaying XSLT Instructions for Particular Output

After you apply a stylesheet, or during debugging of a stylesheet, Stylus Studio can display the XSLT instruction or the sequence of XSLT instructions that generate a particular part of a result document. This can be particularly helpful when the result is not quite what you want.

1. Open a stylesheet.
2. Apply the stylesheet.
3. In the Preview window, in either the text view or the browser view, click on the output for which you want to display the XSLT calls.

Stylus Studio displays the Backmap Stack window, which lists one or more XSLT instructions. Also, Stylus Studio flags the line in the stylesheet that contains the first instruction in the list. To find the location of another listed instruction, click that instruction in the Backmap Stack window.

The Call Stack window and the Backmap Stack window provide the same kind of information. However, the Backmap Stack window never shows Java entries, and the contents of the Backmap Stack window can be different from the Call Stack window according to where you click in the output to enable backmapping.

Using Bookmarks

When you are editing or debugging a long file, you might want to repeatedly check certain lines in the file. To quickly focus on a particular line, insert a bookmark for that line. You can insert any number of bookmarks. You can insert bookmarks in any document that you can open in Stylus Studio.
Determining Which Template Generated Particular Output

Inserting
1. Click in the line that you want to have a bookmark.
2. Click **Toggle Bookmark** in the Stylus Studio tool bar. Stylus Studio inserts a turquoise box with rounded corners to the left of the line that has the bookmark.

Removing
1. Click in the line that has the bookmark you want to remove.
2. Click **Toggle Bookmark** in the Stylus Studio tool bar. Stylus Studio removes the turquoise box.

Determining the Output Generated by a Particular Template

In the *XSLT Source* pane, if the cursor is in a template, the output from that template has a gray background in the *Preview Text* view of the *Preview* window. In the *Preview in tree* view of the *Preview* window, the contents generated by the template are highlighted.

In the *Preview in Browser* view of the *Preview* window, there is no gray shading to indicate the output from the currently displayed template.

Profiling XSLT Stylesheets

The XSLT Profiler is available only in Stylus Studio XML Enterprise Edition.
Debugging Stylesheets

In addition to debugging tools for XSLT, Stylus Studio provides the XSLT Profiler, a tool that helps you evaluate the efficiency of your XSLT. By default, the performance metrics gathered by the XSLT Profiler are displayed in a preformatted report, like the one shown in Figure 259:

![XSLT Profiler Report](image)

**Figure 259. XSLT Profiler Report**

The report format is controlled by the default XSLT stylesheet, `profile.xsl`, in the `Stylus Studio\bin` directory. You can customize this stylesheet as required. You can save XSLT Profiler reports as HTML.

**Note** XSLT and XQuery Profiler reports use the same XSLT stylesheet.
In addition to generating the standard XSLT Profiler report, you can save the raw data generated by the Profiler and use this data to create your own reports. See “Enabling the Profiler” on page 493 for more information about this procedure.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the XSLT Profiling video.

A complete list of all the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

About Metrics

The XSLT Profiler can record three different levels of performance metrics:

● A call tree of execution times
● Execution times by XSLT element, and
● A detailed log of step-by-step element execution

Note  Displaying the report for a step-by-step log can take significantly longer than evaluating the XSLT itself. Consider using the Profiler with the first two performance metric options. You can also use the Limit Trace To fields to further restrict the Profiler’s scope. If you find you need still more detail (while troubleshooting a performance bottleneck, for example), use the step-by-step setting.

Enabling the Profiler

The XQuery Profiler is off by default. You enable the Profiler on the Profiling Options tab of the XSLT Scenario Properties dialog box.

1. Open the Scenario Properties dialog box for the XSLT stylesheet. (Click Browse at the top of the XSLT editor window.)
Debugging Stylesheets

2. Click the **Profiling Options** tab.

![Profiling Options](image)

**Figure 260. Profiling Options**

3. Select the settings for the performance metrics you want the Profiler to capture.

4. Optionally, save the raw Profiler data to a separate file.

**Note**  
This option is available only after you select one or more performance metrics settings.

5. Click OK.

The next time you preview the XSLT results, the performance metrics you selected are available to you in the XSLT Profiler report (and as raw data if you selected that setting and specified a file).

**Displaying the XSLT Profiler Report**

1. Ensure that the Profiler is enabled. (See “Enabling the Profiler” on page 493 if you need help with this step.)

2. Click the **Preview Result** button ( ).

3. Click the **Show Profiling Report** button ( ).

The XSLT Profiler report appears in the **Preview** window.
Handling Parser and Processor Errors

When you refresh stylesheet output, Stylus Studio parses and processes your XML document and XSLT stylesheet. If the processor encounters a parser or processing error, Stylus Studio displays a message that indicates the nature and location of the error. Stylus Studio prompts you to indicate if you want to jump to the error location in your stylesheet.

Debugging Java Files


The Stylus Studio debugger allows you to follow Java processing as well as XSLT processing. With the Stylus Studio debugger, you can observe the interaction between your Java code and XML data.

When you debug a transformation, the transformation can include the processing of Java files. Such Java files might be servlets, server extensions, extension functions, or other kinds of Java programs that involve stylesheets. If you need to make a change to your Java file, you can compile it right in Stylus Studio. Click Compile in the upper left corner of the Java file window. Stylus Studio automatically saves the file before it compiles it.

This section discusses the following topics:

- Requirements for Java Debugging on page 495
- Setting Options for Debugging Java on page 496
- Using the Java Editor on page 497
- Stylus Studio and the JVM on page 498
- Example of Debugging Java Files on page 498

Requirements for Java Debugging

If you want to use Stylus Studio to debug Java code, you must have the Sun Java Runtime Environment (JRE) 1.4.x installed. If you want to use Stylus Studio to assist you in editing and compiling Java code, you must have the Sun JDK 1.4.x installed.

You can download the Sun Java products from http://www.javasoft.com/j2se/.

After you install the JRE, you must run the Stylus Studio auto-detect feature. For more information, see "Configuring Java Components".
Debugging Stylesheets

1. Select **Tools > Options** from the Stylus Studio menu bar.

2. In the **Options** dialog box, click **Java Virtual Machine**.

3. In the **Java Virtual Machine** page, click **Auto detect**.

Also, in the **Parameters** field of the Java Virtual Machine page, there should be something like the following:

```
-Xdebug -Xnoagent -Xrunjdwp:transport=dt_socket,server=y,suspend=n,address=8000 -Djava.compiler=NONE
```

To confirm that your set up is correct, select **Help > About Stylus Studio** from the Stylus Studio menu bar. The **Java Virtual Machine** field in the About Stylus Studio dialog box should indicate that the JVM is running in debug mode.

### Setting Options for Debugging Java

You can specify the following options when you use Stylus Studio to debug Java code:

- **Source Path** is the path that Stylus Studio uses to locate the source files during debugging.

- **Prompt user for source file path confirmation** indicates that if Stylus Studio cannot find the source files you are debugging, it prompts you to specify the source file path. If you do not set this option, and Stylus Studio cannot find a source file, the behavior varies according to what the debugger is trying to do. For example, if the debugger is stepping into an instruction that calls a function that is defined in a Java file that Stylus Studio cannot find, the debugger steps over the instruction.

- **Never step into classes starting with one of the following strings of characters:** contains a list of classes, one on each line, that you do not want to step into. For example, these might be classes that are part of the core language, or classes that you do not have source files for. If you specify `java.lang`, the debugger skips all classes whose names start with `java.lang`, for example, `java.lang.String` and `java.lang.Object`.

- **JVM communication time out** indicates the amount of time that Stylus Studio waits for a response from the JVM. If Stylus Studio does not receive a response in the specified amount of time, it stops trying to communicate with the JVM. The default is 5 seconds.

- **Show JDWP Events in the Output Window** indicates whether you want Stylus Studio to log all communication events in the Stylus Studio **Output Window** during a debugging session.
Debugging Java Files

Stylus Studio also allows you to set options that specify the Java virtual machine (JVM) you use. You can specify the run-time library, the home directory, and parameters for starting the JVM. Select **Tools > Options** from the Stylus Studio menu bar.

See “Specifying Stylus Studio Options” for instructions for setting these options.

Using the Java Editor

To use the Stylus Studio Java editor, open a Java file in Stylus Studio.

To specify arguments that Stylus Studio uses to run the active Java class, select **Java > Class Properties** from the Stylus Studio menu bar. Stylus Studio displays the **Class Properties** dialog box. Enter the arguments required to run your code. (You must have a Java file open in Stylus Studio for **Java** to appear in the menu bar.)

The same debugging capabilities that are available when you are debugging XSLT stylesheets are available when you are debugging stand-alone Java applications.

When you use the Java editor, the Sense:X auto-completion feature is available. The Java editor browses your import directives to gather information about the packages you are using and provides auto-completion when using methods or data members defined in imported classes. The auto-completion mechanism also provides you with tips about the signature of the class method and its required arguments. The same applies to the classes that you are editing. Also, the CLASSPATH is used to help you auto-complete import directives. Type Ctrl+Space if you want Stylus Studio to auto-complete keywords and class names that are defined in java.lang.package.

The Stylus Studio Java editor also does background error checking. As you type Java code, Stylus Studio displays red lines that indicate syntax errors. Move the cursor over the red line to display a pop-up error message.

When you use the Java editor, you can configure the character encoding that Stylus Studio uses to save and load files. To do this, ensure that a Java file is the active file. Then select **Edit > Change Encoding** from the Stylus Studio menu bar.

Context-sensitive help for your Java classes is available in the Java editor. The directory that contains the javadoc-generated documentation must be in the Stylus Studio class path (in the Stylus Studio menu bar select **Tools > Options > Java Virtual Machine**) or in your CLASSPATH environment variable. You can then press F1 when your cursor is on a class name in the Java editor. Stylus Studio opens the related javadoc-generated documentation.
Stylus Studio and the JVM

Stylus Studio allows you to debug a running application. You can attach Stylus Studio to a local or remote JVM, and run your application in debug mode. In the Stylus Studio toolbar, click **Attach** to debug a standalone Java program that is running an external JVM. (*Attach* is not for debugging Java extensions.)

To execute a class, open the Java source in Stylus Studio and press F5. Of course, the class must be in your `CLASSPATH` environment variable or in the Stylus Studio ClassPath (select **Tools > Options > Java Virtual Machine**).

1. Select **Tools > Options** from the Stylus Studio menu bar.
2. In the **Options** dialog box that appears, click **General > Java Virtual Machine**.

The **Home Directory** field indicates the version of the JVM.

When you suspend processing, display the **Output Window** to view any output from the Java virtual machine. To display the **Output Window**, click **Output Window** in the Stylus Studio toolbar.

Example of Debugging Java Files

Stylus Studio includes sample files that you can experiment with to learn how to use the debugger with an application that includes stylesheets and Java files. To get you started, this section provides step-by-step instructions for using the debugger with these sample files. You should perform the steps in each topic in the order of the topics.

For complete information about how to use the debugger, see “Debugging Stylesheets” on page 485.

This section includes the following topics:

- Setting Up to Debug Sample Java/XSLT Application on page 498
- Inserting a Breakpoint in the Sample Java/XSLT Application on page 499
- Gathering Debug Information About the Sample Java/XSLT Application on page 499

Setting Up to Debug Sample Java/XSLT Application

1. From the Stylus Studio menu bar, select **Tools > Options**.
2. In the **Options** dialog box that appears, click **Java Virtual Machine**.
3. If the `examples\javaExtension` directory is already in the `ClassPath` field, click **OK**.
Debugging Java Files

If the examples\javaExtension directory is not in the ClassPath field, click Browse next to the ClassPath field. In the Browse for Folder dialog box that appears, navigate to and select the javaExtension directory, which is in the examples directory of your Stylus Studio installation directory. Click OK. Restart Stylus Studio. For ClassPath changes to take effect, you must restart Stylus Studio whenever you modify the ClassPath field. For information about the relationship between the CLASSPATH environment variable and this field, see “Modifying the Classpath”.

4. In the File Explorer, navigate to the examples\javaExtension directory in your Stylus Studio installation directory.

5. Double-click IntDate.xsl.
   Stylus Studio opens the IntDate.xsl stylesheet in the XSLT editor. The tree for the XML source document, IntDate.xml, also appears.

6. In the XSLT editor tool bar, click Preview Result .
   The IntDate scenario has already been defined. Stylus Studio applies the stylesheet and displays the results (a list of dates) in the Preview window.

Inserting a Breakpoint in the Sample Java/XSLT Application

1. In the XSLT editor, examine the template that matches the date element.
   As you can see, the select attribute in the xsl:value-of instruction invokes the IntDate Java extension function.

2. In the body of the template, click just before the xsl:value-of instruction.

3. In the Stylus Studio tool bar, click Toggle Breakpoint .

4. Press F5 to apply the stylesheet.
   Alternative: In the Stylus Studio tool bar, click Start Debugging .
   The XSLT processor suspends processing at the breakpoint, displays a yellow triangle to indicate where processing has been suspended, and displays a message in the Preview window.

Gathering Debug Information About the Sample Java/XSLT Application

1. In the Stylus Studio tool bar, click Step into or press F11.
   Stylus Studio opens and displays the Java source file that contains the IntDate extension function. Now the Variables window displays a list of the variables in the extension function. There is still no output in the Preview window.
Stylus Studio might display the **Browse For Folder** dialog box. It is prompting you to specify where it can find the Java source file that contains the extension function invoked in the line that has the breakpoint. Stylus Studio does not display the **Browse for Folder** dialog box when the `.java` file is in the same directory as the `.class` file. Click the **javaExtension** directory and click **OK**.

2. In the Stylus Studio tool bar, click **Output Window**.
   Stylus Studio displays the **Output Window**, which displays output from the Java virtual machine.

3. In the Stylus Studio tool bar, click **Step Over** or F10 to move to the next line of Java code.
   The yellow triangle moves to show the new location. If the values of the variables change, the **Variables** window reflects this.

4. Press **Step Out** to return to the stylesheet.
   The **Variables** window now displays only the context node. Processing was suspended when the second `date` child element of the `doc` document element was the context node.
   The **Preview** window now displays a few lines of HTML.

5. In the **Preview** window, click in the first line of text.
   Stylus Studio displays the **Backmap Stack** window, which contains a list of the XSLT instructions that have been executed. Also, in the **XSLT Source** tab, Stylus Studio displays a blue triangle that indicates the line in the stylesheet that generated the output line you clicked in.
This section provides information about how to use Stylus Studio to define an XML Schema. Although some information about XML Schema tags is provided, familiarity with the W3C XML Schema Recommendation is assumed.

Many of the examples in this chapter are based on the purchaseOrder.xsd document, which is installed with other sample files in the examples\simpleMappings directory of your Stylus Studio installation directory. Consider having this file open as you read through the examples in this chapter.

This section covers the following topics:

- “What Is an XML Schema?” on page 504
- “Creating an XML Schema in Stylus Studio” on page 504
- “Working with XML Schema in Stylus Studio” on page 516
- “Getting Started with XML Schema in the Tree View” on page 525
- “Defining simpleTypes in XML Schemas” on page 530
- “Defining complexTypes in XML Schemas” on page 541
- “Defining Elements and Attributes in XML Schemas” on page 551
- “Defining Groups of Elements and Attributes in XML Schemas” on page 559
- “Adding Comments, Annotation, and Documentation Nodes to XML Schemas” on page 563
- “Defining Notations” on page 566
- “Referencing External XML Schemas” on page 567
- “Generating Documentation for XML Schema” on page 574
- “Generating JAXB Classes” on page 581
- “About XML Schema Properties” on page 583
Defining XML Schemas

What Is an XML Schema?

An XML Schema conforms with the W3C XML Schema Recommendation. The XML Schema Recommendation defines an XML markup vocabulary for specifying the structure of an XML document. An XML Schema serves the same purpose as a DTD. The most visible difference is that an XML Schema is in XML, while a DTD is not.

Like a DTD, an XML Schema describes the structure of a document. However, an XML Schema contains more specialized types of nodes than a DTD schema. For example, in an XML Schema, you can define nodes of type group and attributeGroup. These nodes contain groups of elements and attributes, respectively.

In an XML Schema, elements that contain subelements or attributes are called complexTypes. Elements that contain data but do not contain subelements or attributes are simpleTypes. Attributes are always simpleTypes. In your XML Schema, along with elements and attributes, you define complexTypes and some simpleTypes. In addition, many simpleTypes are part of the XML Schema grammar.

Reference Information

The World Wide Web Consortium (W3C) provides information about XML Schema, including the following:

- XML Schema Part 0: Primer at http://www.w3.org/TR/xmlschema-0/
- Reference information for simpleTypes and their facets at http://www.w3.org/TR/xmlschema-0/#SimpleTypeFacets
- Reference information for XML Schema elements and attributes at http://www.w3.org/TR/xmlschema-0/#index

Creating an XML Schema in Stylus Studio

There are several ways to create an XML Schema in Stylus Studio, including building your own XML Schema from scratch, and creating an XML Schema based on an existing DTD or from an XML document.

This section covers the following topics:

- “Creating Your Own XML Schema” on page 505
- “Creating XML Schema from a DTD” on page 505
Creating Your Own XML Schema

Stylus Studio displays a new XML document in the XML Schema Editor Diagram tab; the text pane displays the following contents:

```xml
<?xml version="1.0"?>
<xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema">
</xsd:schema>
```

When you create an XML Schema in Stylus Studio, the default namespace is specified as http://www.w3.org/2001/XMLSchema. If you choose to specify the XML Schema namespace, be sure to specify one of the following:

- http://www.w3.org/2001/XMLSchema
- http://www.w3.org/2001/XMLSchema-instance

Creating XML Schema from a DTD

Stylus Studio has two document wizards you can use to create an XML Schema from a DTD. One uses a built-in processor; the other uses the Trang schema converter from Thai Open Source Software Center (www.thaiopensource.com). Using the Trang converter gives you more control over both the input file and output characteristics (such as whether or not you want to indent the XML Schema).

Using the DTD to XML Schema Document Wizard


2. In the XML Editor tab, click DTD to XML Schema, and click OK.
The Convert DTD to XML Schema dialog box appears.

![Convert DTD to XML Schema Dialog Box](image)

**Figure 261. Convert DTD to XML Schema Dialog Box**

3. In the **DTD URL** field, type or select the absolute path for the DTD from which you want to create an XML Schema.

**Note** The DTD must be encoded in UTF-8.

4. If you want, select the **Use a Target Namespace** check box and type a target namespace.

5. Click **OK**.

Stylus Studio displays the new XML Schema in the XML Schema Editor.

**Using the DTD to XML (Trang) Document Wizard**

The following table describes the fields in the **DTD to XML (Trang)** dialog box, which is displayed when you run the DTD to XML (Trang) document wizard. This document wizard was created using Stylus Studio Custom Document Wizard (see “Custom Document Wizards” on page 899 for more information).

**Table 40. DTD to XML (Trang) Document Wizard Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input file (required)</td>
<td>The name and location of the DTD file you want to convert to XSD. You can type the file name or use the <strong>Browse</strong> button to browse a file system for the source DTD file.</td>
</tr>
<tr>
<td>[input] xmlns=&lt;uri&gt;</td>
<td>The default namespace; used for unqualified element names.</td>
</tr>
<tr>
<td>[input] xmlns:&lt;prefix=uri&gt;</td>
<td>The namespace for the element and autoboost names using <strong>prefix</strong>.</td>
</tr>
</tbody>
</table>
Creating an XML Schema in Stylus Studio

Table 40. DTD to XML (Trang) Document Wizard Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>colon-replacement=&lt;chars&gt;</td>
<td>The character that is used to replace colons in element names. Used when constructing the names of definitions used to represent the element and attribute list declarations in the DTD. Trang generates a definition for each element declaration and attlist declaration in the DTD. The definition name is based on the element name. In RELAX NG, the definition names cannot contain colons; colons are allowed in element names in DTDs. Trang first tries to use the element names without prefixes. If this results in a conflict, Trang replaces the colon with the chars specified. If no chars is specified, a period is used.</td>
</tr>
<tr>
<td>element-define=&lt;name-pattern&gt;</td>
<td>Specifies how to construct the name of the definition representing an element declaration from the name of the element. The name-pattern must contain exactly one percent character (%). This character is replaced by the name of the element, after colon replacement, and the result is used as the name of the definition.</td>
</tr>
<tr>
<td>inline-attlist / no-inline-attlist</td>
<td>inline-attlist specifies not to generate definitions for attribute list declarations. Instead, attributes in attribute list declarations are moved into the definitions generated for element list declarations. no-inline-attlist generates a distinct definition (with combine=&quot;interleave&quot;) for each attribute list declaration in the DTD; each element declaration definition references the definition for the corresponding attribute list declaration.</td>
</tr>
<tr>
<td>attlist-define=&lt;name-pattern&gt;</td>
<td>Specifies how to construct the name of the definition representing an attribute list declaration from the name of the element. The name-pattern must contain exactly one percent character (%). This character is replaced by the element name, after colon replacement, and the result is used as the name of the definition.</td>
</tr>
</tbody>
</table>
Defining XML Schemas

Table 40. DTD to XML (Trang) Document Wizard Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[input] any-name=&lt;name&gt;</td>
<td>Specifies the name of the definition generated for the content of elements declared in the DTD as having a content model of ANY.</td>
</tr>
<tr>
<td>[input] strict-any</td>
<td>Preserves the exact semantics of ANY content models by using an explicit choice of references to all declared elements. By default, Trang uses a wildcard that allows any element.</td>
</tr>
<tr>
<td>[input] annotation-prefix=&lt;prefix&gt;</td>
<td>Default values are represented using an annotation attribute prefix:defaultValue where prefix is bound to <a href="http://relaxng.org/ns/compatibility/annotations/1.0">http://relaxng.org/ns/compatibility/annotations/1.0</a> as defined by the RELAX NG DTD Compatibility Committee Specification. By default, Trang uses a for prefix unless that conflicts with a prefix used in the DTD.</td>
</tr>
<tr>
<td>[input] generate-start / no-generate-start</td>
<td>Specifies whether or not Trang should generate a start element. DTDs do not indicate what elements are allowed as document elements. Trang assumes that all elements that are defined but never referenced are allowed as document elements.</td>
</tr>
<tr>
<td>[output] encoding=&lt;name&gt;</td>
<td>Uses name as the encoding for output files.</td>
</tr>
<tr>
<td>[output] indent=&lt;n&gt;</td>
<td>Indents each indent level in the output file by n spaces.</td>
</tr>
<tr>
<td>[output] disable-abstract-elements</td>
<td>Disables the use of abstract elements and substitution groups in the generated XML schema.</td>
</tr>
<tr>
<td>[output] any-process-contents=strict</td>
<td>lax</td>
</tr>
<tr>
<td>[output] any-attribute-process-contents=strict</td>
<td>lax</td>
</tr>
</tbody>
</table>

1. From the Stylus Studio menu bar, select File > Document Wizards.
   The Document Wizards dialog box appears.
Creating an XML Schema in Stylus Studio

2. In the XML Editor tab, click DTD to XML Schema (Trang) and click OK.
   The DTD to XML Schema (Trang) dialog box appears.

3. Enter the absolute path of the DTD from which you want to create an XML Schema.
   The DTD must be encoded in UTF-8. You can type the file path, or use the browse button (which appears when you place the cursor in the Input file (required) field. This is the only required field.

4. Optionally, complete any of the remaining fields.

5. Click OK.
   Stylus Studio displays the new XML Schema in the XML Schema Editor.

Creating XML Schema from an XML Document

There are two ways to create XML Schema from an XML document:
- The XML to XML Schema document wizard allows you to create XML Schema from any XML document. The XML document you use to create the XML Schema is not
Defining XML Schemas

modified with attribute information about the new XML Schema when you use this method.

- The Create Schema from XML Content feature in the XML Editor. This method allows you to create an XML Schema (or DTD) based on the current XML document in the XML Editor. The XML document is always modified with namespace and schema location attributes when you use this method. If you choose to create DTD, you have the option of creating internal or external DTD.

Both methods allow you to specify the URI for the generated files (if an XML document has multiple namespaces defined for it, Stylus Studio creates a separate XML Schema associated with each namespace).

Using the XML to XML Schema Document Wizard

Use this procedure when you want to create an XML Schema based on the content of an existing XML document.


Figure 263. Convert XML to XML Schema Dialog Box

4. Specify the URI for the generated file(s) in the Generated XSD field.
5. Click the OK button. Stylus Studio creates the XML Schema file and opens it in the XML Schema Editor.
Creating an XML Schema in Stylus Studio

Using the Create Schema from XML Content Feature

Use this procedure when you want to create an XML Schema based on the content of an existing XML document.

1. Open the XML document from which you wish to create an XML Schema.
2. Select XML > Create Schema from XML Content from the Stylus Studio menu.
   The Create Schema or DTD dialog box appears.

![Create Schema or DTD Dialog Box](image)

   The Output File field becomes active.
4. Type a name for the XML Schema you want to create, or use the browse button (\(\ldots\)) to search for an existing file.
5. Click the Yes button.
   The XML Schema is created. If you do not specify a complete URL, the schema is written to the same location as the XML document from which it was created.

Displaying the New XML Schema

Use this procedure to open the new XML Schema created using the Create Schema from XML Content feature (or to open the XML Schema associated with any active XML document).

1. Click XML > Open Associated Schema.
2. Select the XML Schema from the drop-down menu.
Defining XML Schemas

The XML Schema appears in the XML Schema Editor.

Creating XML Schema from EDIFACT Messages

Stylus Studio Enterprise Edition provides a document wizard that allows you to create XML Schema based on an EDIFACT message, such as the Business Credit Report (BUSCRD) message type.

Setting Wizard Options

In addition to selecting a specific EDIFACT version and message type, Stylus Studio provides the following settings that determine how the XML Schema is generated. You can decide whether or not you want to

- Include annotations that describe each element.
- Generate enumerations for fields in the message that have lists of values.
- Substitute “unbounded” for `maxOccurs` that have a value of 99 or more. Stylus Studio bases `maxOccurs` values on the loops it detects in the EDIFACT message.

Running the EDIFACT to XML Schema Documentation Wizard

1. Select File > Documentation Wizards from the Stylus Studio menu. The Documentation Wizards dialog box appears.
2. Double-click the EDIFACT to XML Schema icon.
Creating an XML Schema in Stylus Studio

The **Create XML Schema from EDIFACT Message Definition** dialog box appears.

3. If necessary, change the UN/NAFTA version ID. Versions are listed chronologically in ascending order.

4. Change the XML Schema creation options as required. See **Setting Wizard Options** on page 512 if you need help with this step.

5. Click OK.

Stylus Studio converts the EDIFACT message you selected in Step 3 to XML Schema and opens a new, untitled document in the XML Schema Editor.

**Creating XML Schema from X12 Transaction Sets**

The **X12 to XML Schema document wizard is available only in Stylus Studio XML Enterprise Edition.**

Stylus Studio Enterprise Edition provides a document wizard that allows you to create XML Schema based on an EDI X12 version and transaction set, such as the 811 (Consolidated Service Invoice/Statement) transaction set.
Defining XML Schemas

Setting Wizard Options

In addition to selecting a specific X12 version and transaction set, Stylus Studio provides the following settings that determine how the XML Schema is generated. You can decide whether or not you want to

- Include annotations that describe each element.
- Generate enumerations for fields in the transaction set that have lists of values
- Substitute “unbounded” for maxOccurs that have a value of 99 or more. Stylus Studio bases maxOccurs values on the loops it detects in the EDIFACT message.

Running the X12 to XML Schema Documentation Wizard

1. Select File > Documentation Wizards from the Stylus Studio menu. The Documentation Wizards dialog box appears.
2. Double-click the X12 to XML Schema icon. The Create XML Schema from X12 Transaction Set dialog box appears.
3. If necessary, change the X12 version ID. Versions are listed chronologically in ascending order.
4. Change the XML Schema creation options as required. See Setting Wizard Options on page 514 if you need help with this step.
5. Click OK.
Stylus Studio converts the X12 transaction set you selected in Step 3 to XML Schema and opens a new, untitled document in the XML Schema Editor.

Creating XML Schema from IATA Message Types

Stylus Studio Enterprise Edition provides a document wizard that allows you to create XML Schema based on an IATA message type, such as the APSINQ (Application/Product Status Inquiry) message type.

Setting Wizard Options

In addition to selecting a specific IATA version and message type, Stylus Studio provides the following settings that determine how the XML Schema is generated. You can decide whether or not you want to

- Include annotations that describe each element.
- Generate enumerations for fields in the transaction set that have lists of values
- Substitute “unbounded” for max0ccurs that have a value of 99 or more. Stylus Studio bases max0ccurs values on the loops it detects in the EDIFACT message.

Running the IATA to XML Schema Documentation Wizard

1. Select File > Documentation Wizards from the Stylus Studio menu. The Documentation Wizards dialog box appears.
2. Double-click the IATA to XML Schema icon.
The **Create XML Schema from X12 Transaction Set** dialog box appears.

3. If necessary, change the IATA version ID. Versions are listed chronologically in ascending order.

4. Change the XML Schema creation options as required. See Setting Wizard Options on page 514 if you need help with this step.

5. Click OK.

Stylus Studio converts the IATA message type you selected in Step 3 to XML Schema and opens a new, untitled document in the XML Schema Editor.

**Working with XML Schema in Stylus Studio**

You use the **XML Schema Editor** to view, define, and validate XML Schema using one or more of three tabs, or views. This section describes these and other tools for working with XML Schema in Stylus Studio.

This section covers the following topics:

- Views in the XML Schema Editor on page 517
- Validating XML Schema on page 521
- Updating XML Schema Associated with a Document on page 521
- Viewing an XML Instance on page 521

---

Stylus Studio® 2006 User Guide 516
Views in the XML Schema Editor

The XML Schema Editor has **Diagram**, **Tree**, and **Documentation** tabs. The **Diagram** tab, which is the default for the XML Schema Editor, is shown in **Figure 268**.

**Figure 268. XML Schema Editor Diagram Tab**

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: [watch the XML Schema Diagram Editor video](#).
Defining XML Schemas

You can see other Stylus Studio video demonstrations here: http://www.stylusstudio.com/xml_videos.html.

Each tab displays the schema from a unique perspective, as summarized here:

- **Diagram** – Displays the XML Schema using graphical elements for the nodes (elements, attributes, simpleTypes, complexTypes, and so on) defined in the XML Schema in a *diagram pane*. Container elements can be expanded to show child elements, and values such as element and attribute names and types can be edited in place by double-clicking the node you want to modify.

  In addition to the diagram pane, the Diagram tab includes a *text pane*. The text pane displays the raw XML text used to define the XML Schema, and lets you see how the changes you make in the diagram affect the XML Schema text. You can make changes in either pane – to a node in the diagram, or directly to the text – Stylus Studio keeps both views synchronized.

  The Diagram tab has a full complement of editing tools, including checkers for well-formedness and validation, as well as a query functionality that lets you evaluate your query using either XPath 1.0 or XPath 2.0. XML Schema query is also supported in the Tree tab. See “Printing” on page 523 to learn how to print information in the Diagram tab.
- **Tree** – Displays a DOM tree representation of the XML Schema. You can edit the XML Schema graphically, in the tree itself, or by modifying the properties of the nodes you select.

![Figure 269. XML Schema Editor Tree Tab](image)
Defining XML Schemas

- **Documentation** – Displays read-only summary and detailed reference information about the XML Schema, including sections for schema document properties, global declarations, and global definitions.

In Stylus Studio, the information in all tabs synchronized automatically.

Generally speaking, if you are just getting started with XML Schema you should consider using the **Diagram** tab to work with XML Schema in Stylus Studio. Its graphical user interface makes defining XML Schema easy and error-free, and the built-in text pane, which lets you see how new nodes are rendered in XML, can be a useful learning tool.

To get started using the **Diagram** view to define an XML Schema, see “Defining an XML Schema Using the Diagram Tab – Getting Started”. Procedures for working with the **Diagram** tab are also covered throughout this chapter.
Validating XML Schema

Stylus Studio can analyze your XML Schema document to determine if it is valid. At any time, click Validate Document in the Stylus Studio tool bar to ensure that your schema is valid. If it is not, Stylus Studio displays a message that indicates the cause and location of the error. You can use any number of XML Schema validation engines to parse your XML Schema, including

- MSXML DOM Parser
- MSXML SAX Parser
- .NET XML Parser
- Xerces-J

Updating XML Schema Associated with a Document

Stylus Studio can associate an XML Schema with an XML document, and it can validate an XML document against its associated XML Schema. If you update an XML Schema in Stylus Studio and that schema is associated with an XML document that is open in Stylus Studio, Stylus Studio refreshes the XML Schema information for the XML document.

Viewing an XML Instance

You can view an instance of the XML represented by a node in the XML Schema Diagram tab. You can also optionally create an XML document based on that instance. For
Defining XML Schemas

example, here is an instance of the XML represented by the `purchaseOrder` element in `purchaseOrder.xsd`.

![View Sample XML](image)

**Figure 271. Sample of XML Based on XML Schema**

If you want, you can create a new XML document based on this instance by clicking the **Open as New Document** button.

**Note**
If the XML Schema contains an element defined using a built-in type, the instance of that element in the XML document is created using the minimum value of the range specified for that type. For example, if the XML Schema contains a `<part>` element defined as `type="xs:integer"`, the `<part>` element in the resulting XML document appears as `<part>-922372036854775808</part>`.

1. In the **Diagram** tab, select the node for which you want to see sample XML.
2. Select **Diagram > View XML Sample** from the Stylus Studio menu.
   *Alternative:* Select **View XML Sample** from the node’s shortcut menu (right-click to display).
   The **View Sample XML** dialog box appears. (See **Figure 271**.)
3. If you want to open this instance as a new XML document in Stylus Studio, click the **Open as a New Document** button. Otherwise, click **Close Preview**.

### Using XML Schema in XQuery and XSLT Mapper

You can use an XML Schema as the source document or target document for Stylus Studio’s XQuery and XSLT Mappers. See “Building an XQuery Using the Mapper” on
Working with XML Schema in Stylus Studio

page 744 and “Creating XSLT Using the XSLT Mapper” for more information on these topics.

Printing

You can print XML Schema from the Diagram tab, and you can print XML Schema documentation from the Documentation tab.

Printing XML Schema

Stylus Studio allows you to print either the graphics in the diagram pane, or the raw XML in the text pane. If one pane is collapsed, Stylus Studio prints the visible pane. If both panes are visible, Stylus Studio prints the pane that currently has focus.

Tip  Select File > Print Preview to verify the output before you print.

1.  Select the pane of the Diagram tab you want to print.
2.  Click Print.
   Alternative: Select File > Print from the Stylus Studio menu.

Printing XML Schema Documentation

To print XML Schema documentation, print from the Documentation tab. Stylus Studio prints the XML Schema documentation using the currently selected display format (XS3P or XSDdoc). See “Generating Documentation for XML Schema” on page 574 for more information.
Defining XML Schemas

Node Properties

The Properties window is available when you are using the Diagram or Tree tab of the XML Schema Editor. When the Properties window is open, it displays the properties of the node you click. If you have selected a restricted node from a redefined XML Schema, Stylus Studio displays a separate section in the lower half of the Properties window for you to specify the facets, as shown in Figure 272.

![Properties Window with Restricted Type Facets](image)

Figure 272. Properties Window with Restricted Type Facets

If the Properties window is not visible, select View > Properties from the Stylus Studio menu.

Tip The Properties window is a dockable window – you can drag it out of Stylus Studio and place it anywhere on your desktop, as shown in Figure 272.

To change the value of a property, click the property field and enter the new value. If only certain values are allowed, Stylus Studio displays a drop-down list of the valid choices. Each type of node has its own set of properties. For a description of each property, see “About XML Schema Properties” on page 583.

Working with Properties in the Diagram

You can also display and edit properties within the nodes in the diagram. See “Displaying Properties” for more information on this feature.
Getting Started with XML Schema in the Tree View

This section provides a quick tour of the main features of the Tree view in the XML Schema Editor. It provides instructions that you can follow to define a simple XML Schema.

This section provides step-by-step instructions for defining the bookstoreTree.xsd XML Schema document. You should perform the steps in each topic in the order of the topics. This section covers the following topics:

- Description of Sample XML Schema on page 525
- Defining a complexType in a Sample XML Schema in the Tree View on page 526
- Defining Elements of the Sample complexType in the Tree View on page 530

For instructions for using the Diagram view to define the same XML Schema, see “Defining an XML Schema Using the Diagram Tab – Getting Started”.

Description of Sample XML Schema

Suppose you want to define an XML Schema that defines book, magazine, and newsletter elements. The type of each of these elements is PublicationType. The XML Schema defines the PublicationType complexType. An element that is a PublicationType contains the following:

- The genre attribute specifies the style of the publication.
- There is always exactly one title element.
- The subtitle element is optional.
- There must be at least one author element and there can be more. Each author element contains one first-name element and one last-name element.
- Of the following three elements, exactly one must always be present:
  - ISBNnumber
  - PUBnumber
  - LOCnumber
- The elements must be in the order specified in this list.
Tips for Adding Nodes

To add a node to an XML Schema in the Tree view, click a node that is already in the schema. Stylus Studio activates the buttons for only those nodes that can be children of the node you selected. If you hold down the Shift key, Stylus Studio activates only those buttons that allow you to add nodes that can be siblings of the selected node.

Defining a complexType in a Sample XML Schema in the Tree View

The steps for defining the PublicationType complexType are described in the following sections:

- Defining the Name of the Sample complexType in the Tree View on page 526
- Adding an Attribute to a Sample complexType in the Tree View on page 527
- Adding Elements to a Sample complexType in the Tree View on page 527
- Adding Optional Elements to a Sample complexType in the Tree View on page 528
- Adding an Element That Contains Subelements to a complexType in the Tree View on page 528
- Choosing the Element to Include in the Sample complexType in the Tree View on page 529

Defining the Name of the Sample complexType in the Tree View

2. At the bottom of the XML Schema Editor, click the Tree tab. Stylus Studio displays the Tree view of the schema, and the Properties window, which lists the properties for the selected node in the tree.
3. Click the Schema node .
4. In the left tool bar, click New complexType . Stylus Studio displays a field for the new complexType.
5. Type PublicationType as the name for this new complexType and press Enter.
6. Click Save .
7. In the Save dialog box that appears, in the URL field, type bookstoreTree.xsd, and click Save.
Adding an Attribute to a Sample complexType in the Tree View

1. In the Tree view, click the PublicationType node.
2. In the left tool bar, click New Attribute Definition.
   In the Tree view, Stylus Studio displays a field for the new attribute.
3. Type genre as the name of the new attribute and press Enter.
   Stylus Studio displays a drop-down list of built-in simpleTypes.

Adding Elements to a Sample complexType in the Tree View

1. In the Tree view, click the PublicationType node.
2. In the left tool bar, click New Model Group.
   Stylus Studio displays a drop-down list of group modifiers.
3. Double-click the sequence modifier.
   The sequence modifier indicates that an instance document contains zero, one, or more of each child element in the order in which they are defined.
4. In the left tool bar, click New Element Definition.
   In the Tree view, Stylus Studio displays a field for the new element definition.
5. Type title as the name of the new element and press Enter.
   Stylus Studio displays a drop-down list of built-in simpleTypes.
Adding Optional Elements to a Sample complexType in the Tree View

1. In the Tree view, click the sequence node.
2. In the left tool bar, click New Element Definition.
   In the Tree view, Stylus Studio displays a field for the new element definition.
3. Type subtitle as the name of the new element and press Enter.
   Stylus Studio displays a drop-down list of built-in simpleTypes.
5. In the Properties window, double-click the Min Occur. field.
6. Type 0 and press Enter
7. In the Properties window, double-click the Max Occur. field.
8. Type 1 and press Enter.

Adding an Element That Contains Subelements to a complexType in the Tree View

The PublicationType complexType must include at least one author element. An author element must include a first-name element and a last-name element.

Each element that can contain subelements is a complexType. Consequently, to add the author element to the PublicationType complexType, you must first define the authorType complexType. You can then add an element that is of authorType to the PublicationType complexType.

1. In the XML Schema Editor, click the Schema node.
2. In the left tool bar, click New complexType.
   Stylus Studio displays a field for the new complexType.
3. Type authorType as the name for this new complexType and press Enter.
4. In the left tool bar, click New Model Group.
5. In the drop-down list that appears, double-click the sequence modifier.
6. In the left tool bar, click New Element Definition.
7. In the field that Stylus Studio displays, type first-name as the name of the new element and press Enter.
8. In the drop-down list that appears, double-click xsd:string.
Getting Started with XML Schema in the Tree View

9. In the **Tree** view, click the **sequence** modifier for **authorType**.

10. Repeat **Step 6** through **Step 8**, but type **last-name** as the name of the new element.

1. In the **Tree** view, click the **sequence** node under the **PublicationType** node.

2. In the left tool bar, click **New Element Definition**.

3. In the field that Stylus Studio displays, type **author** as the name of the new element and press Enter.

4. In the drop-down list that appears, double-click **authorType**.

5. In the **Properties** window, double-click in the **Min Occur**. field.

6. Type **1** and press Enter.

7. In the **Properties** window, double-click in the **Max Occur**. field.

8. Type **unbounded** in the **Max Occur**. field and press Enter.

**Choosing the Element to Include in the Sample complexType in the Tree View**

In the sample XML Schema, you want **PublicationType** elements to contain an **ISBNnumber**, **PUBnumber**, or **LOCnumber** element.

1. In the **Tree** view, under the **PublicationType** node, click the **sequence** node.

2. In the left tool bar, click **New Model Group**.

3. In the drop-down list that appears, double-click the **choice** modifier.

4. In the left tool bar, click **New Element Definition**.

5. In the field that Stylus Studio displays, type **ISBNnumber** as the name of the new element and press Enter.

6. In the drop-down list that appears, scroll until you can double-click **xsd:integer**, or type **xsd:integer** and press Enter.

7. In the **Tree** view, click the **choice** modifier for **PublicationType**.

8. Repeat **Step 4** through **Step 7** two more times. Once for the **PUBnumber** element and once for the **LOCnumber** element.

9. Click **Save**.
Defining XML Schemas

Stylus Studio displays a message that indicates that the schema is not valid. Click OK in the error box. In the Output Window, you can see the following message:

Validating bookstoreTree.xsd...
file://c:\yourDirectory\bookstoreTree.xsd:6,45:
Invalid child 'sequence' in the complexType
The XML document bookstoreTree.xsd is NOT valid (1 errors)

The problem is that there is a sequence element after an attribute element. The sequence element must come first.

10. Right-click the genre node.

11. In the pop-up menu that appears, click Move Down.

12. Click Validate Document and Save.

The definition of the PublicationType complexType is now complete and the schema is now valid.

Defining Elements of the Sample complexType in the Tree View

1. In the Tree tab, click the Schema node.

2. In the left tool bar, click New Element Definition.

3. In the field that Stylus Studio displays, type book as the name of the new element and press Enter.

4. In the drop-down list that appears, double-click PublicationType.

5. Repeat Step 1 through Step 4 two more times. Once for the magazine element and once for the newsletter element.

6. Click Save.

This is the end of the section that provides instructions for getting started with defining XML Schemas in the Tree view. The topics that follow this topic provide complete information for defining the elements that can be in an XML Schema and for working in the Diagram, Tree, and Text views.

Defining simpleTypes in XML Schemas

Many simpleTypes, such as string and integer, are built in to an XML Schema. You can define your own simpleType by restricting the range of values provided by a built-in
simpleType. You can also define simpleTypes that are derived from the simpleTypes you define.

This section covers the following topics:
- **About simpleTypes in XML Schemas** on page 531
- **Examples of simpleTypes in an XML Schema** on page 532
- **Defining a simpleType in the Diagram View** on page 533
- **Defining a simpleType in the Tree View** on page 537
- **About Facet Types for simpleTypes** on page 539
- **Defining List and Union simpleTypes in the Tree View** on page 540

### About simpleTypes in XML Schemas

XML Schema defines several kinds of simpleTypes:
- **Atomic** is the term for most of the simpleTypes built in to XML Schema, such as `integer`, `string`, and `decimal`. They are called “atomic” because in the context of XML Schema, no part of an element or attribute of an atomic type has meaning on its own. It is only the whole instance that has meaning.

Descriptions of the XML Schema built-in types are in the *W3C XML Schema Part 2: Datatypes* at http://www.w3.org/TR/xmlschema-2/.

- **List** simpleTypes are sequences of atomic types. All elements of a particular list simpleType are instances of the same atomic type.
- **Union** simpleTypes are sequences of atomic and list types. However, the elements of a particular union simpleType can be instances of more than one atomic or list type.
- **Anonymous** simpleTypes are simpleType definitions that are not explicitly named. An anonymous simpleType can be an atomic, list, or union simpleType. You define an anonymous simpleType in the element or attribute definition that uses it.

Anonymous simpleTypes are useful when you want to define a type that is used in only one element or attribute. By specifying an anonymous simpleType, you save the overhead of explicitly defining the type and specifying a reference to it.
Examples of simpleTypes in an XML Schema

The W3C XML Schema Part 0: Primer specifies the following simpleType in its sample purchase order schema:

```xml
<!-- Stock Keeping Unit, a code for identifying products -->
<xsd:simpleType name="SKU">
  <xsd:restriction base="xsd:string">
    <xsd:pattern value="\d{3}-[A-Z]{2}"/>
  </xsd:restriction>
</xsd:simpleType>
```

This specifies that SKU is a simpleType. It is restricted to the values of the base type, which is xsd:string. This means that for a node that is of type SKU, the possible values are a subset of the values allowed for the xsd:string type.

The xsd:pattern element specifies that the pattern facet is being applied to the set of values allowed by the xsd:string type. The value of the xsd:pattern element is an XML Schema regular expression that specifies the allowable values for nodes of type SKU. In this example, the regular expression specifies that the value must be three digits, followed by a hyphen, followed by two uppercase ASCII letters – `<xsd:pattern value="\d{3}-[A-Z]{2}"/>
`. For information about XML Schema expressions, see the W3C XML Schema Part 0: Primer at http://www.w3.org/TR/xmlschema-0/.

Elsewhere in the purchase order schema, an attribute definition specifies that SKU is the type of its value:

```xml
<xsd:attribute name="partNum" type="SKU" use="required"/>
```

An XML document that uses a schema that contains this simpleType definition can specify the partNum attribute. The parser ensures that the value of the partNum attribute is in the range specified by the xsd:pattern element. The SKU type itself is not mentioned in the instance document.

Following is another example of a simpleType definition from the W3C XML Schema Part 0: Primer. This simpleType, myInteger, is based on the xsd:integer type. It specifies two
Defining simpleTypes in XML Schemas

facets (minInclusive and maxInclusive), which specify the lower and upper inclusive bounds of the range of valid values.

```xml
<xsd:simpleType name="myInteger">
    <xsd:restriction base="xsd:integer">
        <xsd:minInclusive value="10000"/>
        <xsd:maxInclusive value="99999"/>
    </xsd:restriction>
</xsd:simpleType>
```

Defining a simpleType in the Diagram View

This section describes the procedures for defining simpleTypes in the Diagram view. It covers the following topics:

- “Before You Begin” on page 533
- “Defining an Atomic simpleType” on page 533
- “Specifying a Restriction for a simpleType – QuickEdit” on page 534
- “Specifying a Restriction for a simpleType – Manually” on page 535
- “Defining List and Union simpleTypes” on page 536

Before You Begin

Many of the editing features used in this section are described in “Defining an XML Schema Using the Diagram Tab – Getting Started”. You should familiarize yourself with that material if you have not done so already.

Defining an Atomic simpleType

This topic provides the steps for defining an atomic simpleType in the Diagram view.

1. Right-click the schema node to display the shortcut menu.
2. Select Add > simpleType.
   The new simpleType appears in the diagram; its properties are displayed in the Properties window.
3. Change the default name to the name of the new simpleType and press Enter.
Specifying a Restriction for a simpleType – QuickEdit

QuickEdit is a feature that combines commonly-performed editing operations, such as specifying a restriction for a simpleType. You can also perform this operation in a different way. See “Specifying a Restriction for a simpleType – Manually” on page 535.

1. Right-click the simpleType node to display the shortcut menu.
2. Select QuickEdit > Derive by restriction from the shortcut menu.
   The Type Derivation dialog box appears.

   Figure 273. Type Derivation Dialog Box

   The Type Derivation dialog box displays the W3C XML Schema, as well as any referenced XML Schemas.

3. Expand the schema (click the plus sign) to display the base types associated with that XML Schema.
4. Select the type on which you wish to base the simpleType you are defining and click OK.
   The simpleType is updated with an element that identifies the restricted type:

   Figure 274. Restricted Type

   In the lower half of the Properties window, Stylus Studio displays a section that allows you to specify facets – values that define the constraint on the range of values allowed by the base type.
5. Click the **Name** field and select a facet type.

   ![Facet Types](image)

   **Figure 275. Specifying Facets for a Restricted Type**

   Stylus Studio displays only those facets that are allowed for the base type you selected. For a description of each facet, see “About Facet Types for simpleTypes” on page 539.

6. Click the **Value** field for a facet you want to specify.

7. Enter a value for the new facet.

8. To specify another facet, repeat Step 5 through Step 7.

**Specifying a Restriction for a simpleType – Manually**

This procedure describes how to specify a restriction for a simpleType manually. It is an alternative to the procedure described in “Specifying a Restriction for a simpleType – QuickEdit” on page 534.

1. Right-click the **simpleType** node to display the shortcut menu.

2. Select **Add > Restriction** from the shortcut menu.

   The simpleType is updated with a restriction icon:

   ![Restriction Icon](image)

   **Figure 276. Restriction Icon**

3. Select the restriction icon if it is not already selected.
Defining XML Schemas

4. In the Properties window, select the type on which you want to base the simpleType you are defining from the Base Type field.

At the bottom of the Properties window, Stylus Studio displays a section that allows you to specify facets – values that define the constraint on the range of values provided by the base type.

5. Click the Name field and select a facet type.

![Properties window with facets](image)

Figure 277. Specifying Facets for a Restricted Type

Stylus Studio displays only those facets that are allowed for the base type you selected. For a description of each facet, see “About Facet Types for simpleTypes” on page 539.

6. Click the Value field for a facet you want to specify.

7. Enter a value for the new facet.

8. To specify another facet, repeat Step 5 through Step 7.

Defining List and Union simpleTypes

The procedure for defining list and union simple types is similar:

1. Create the simpleType as described in “Defining a simpleType in the Diagram View” on page 533.

2. Select the type (list or union) from the shortcut menu (right-click the new simpleType and select Add > List or Add > Union).
3. Specify the nodes that comprise the simpleType's list or union. These types are restricted to annotations and other simpleTypes.

How you perform this last step depends on whether you are adding new or existing annotation or simpleType nodes to the list or union.

- To add a new, undefined annotation or simpleType to the list or union, right click the list or union and select Add > Annotation or Add > SimpleType from the shortcut menu.

- To add an existing annotation or simpleType to the list or union, drag the annotation or simpleType to the list or union, and drop it there, as shown in Figure 278, which shows SimpleType-6 being added to the union SimpleType-3.

![Figure 278. Dragging Nodes to Define Other Nodes](image)

Defining a simpleType in the Tree View

This topic provides the steps for defining an atomic simpleType in the Tree view. When you are familiar with this procedure, you can adapt it to define list, union, and anonymous simpleTypes.

1. Click the node you want to define a simpleType for. This can be one of the following types of nodes:
   - schema
   - element
   - attribute
   - list
   - union

   To define a simpleType as the sibling of another node, click the node and hold down the Shift key when you click the button in Step 2. You cannot, of course, define a simpleType as a sibling of the Schema node.
2. In the left tool bar, click **New simpleType**. Stylus Studio displays an empty simpleType field as the last child of the node you selected. If you held down the Shift key, the field is the last sibling of the selected node.

3. Type a name for the new simpleType and press Enter.

4. In the left tool bar, click **New Restriction**. A restriction specifies the type that the new simpleType is derived from. This is the base type. Stylus Studio displays a scrollable list of XML Schema built-in types, and any simpleTypes you already defined in this schema. Descriptions of the XML Schema built-in types are in the *W3C XML Schema Part 0: Primer* at http://www.w3.org/TR/xmlschema-0/.

5. Double-click the simpleType that you want to base your new simpleType on.

6. In the left tool bar, click **New Facet**. A facet specifies a constraint on the range of values provided by the base type. Stylus Studio displays a scrollable list of XML Schema facet types. For a description of each facet, see “About Facet Types for simpleTypes” on page 539.

   You must ensure that you specify a facet that is valid for the specified base type. Stylus Studio does not prevent you from specifying an invalid facet. The *W3C XML Schema Part: 0 Primer* includes a table at http://www.w3.org/TR/xmlschema-0/ that provides this information.

7. Double-click the type of facet you want to specify.

8. In the **Properties** window, double-click the **Value** field.

9. Enter a value for the new facet.

10. To add another facet, click the **restriction** node for your simpleType, and repeat Step 6 through Step 9.
About Facet Types for simpleTypes

Table 41 provides a brief description of what you should specify as the value of a facet for a new simpleType. You should consult the XML Schema Recommendation for a complete definition of each facet and its allowable values.

Table 41. Facet Values for simpleTypes

<table>
<thead>
<tr>
<th>Facet</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>enumeration</td>
<td>One allowable value. Add an enumeration facet for each allowable value. For example:</td>
</tr>
<tr>
<td></td>
<td>&lt;xsd:simpleType name=&quot;USState&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;xsd:restriction base=&quot;xsd:string&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;xsd:enumeration value=&quot;AK&quot;/&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;xsd:enumeration value=&quot;AL&quot;/&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;xsd:enumeration value=&quot;AR&quot;/&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;!-- and so on ... --&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/xsd:restriction&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/xsd:simpleType&gt;</td>
</tr>
<tr>
<td>fractionDigits</td>
<td>The maximum number of digits that are allowed in the fractional portion of values of simpleTypes that are derived from xsd:decimal.</td>
</tr>
<tr>
<td>length</td>
<td>The number of units of length. Units vary according to the base type. The simpleType must be this number of units of length. For example, if xsd:string is the base type, you might specify 5 as the length if you know that each value will be a code that always has five characters.</td>
</tr>
<tr>
<td>maxExclusive</td>
<td>The exclusive upper bound of the range of values allowed for this simpleType. The value of the simpleType must be less than the value of maxExclusive.</td>
</tr>
<tr>
<td>maxInclusive</td>
<td>The inclusive upper bound of the range of values allowed for this simpleType. The value of the simpleType must be less than or equal to the value of maxInclusive.</td>
</tr>
<tr>
<td>maxLength</td>
<td>The maximum number of units of length. Units vary according to the base type. The length of the instances of this simpleType must be less than or equal to this number of lengths.</td>
</tr>
</tbody>
</table>
Defining List and Union simpleTypes in the Tree View

Sometimes you need to define a simpleType for a sequence of atomic types. In a list simpleType, all instances in the sequence must be of the same type. In a union simpleType, the instances in the sequence can be of different types. The procedure for defining list and union simpleTypes is the same.

1. Click the node you want to define the list or union type for.

2. In the left tool bar, click New simpleType. Stylus Studio displays an empty simpleType field as the last child of the node you selected.

Table 41. Facet Values for simpleTypes

<table>
<thead>
<tr>
<th>Facet</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>minExclusive</td>
<td>The exclusive lower bound of the range of values allowed for this simpleType. The value of the simpleType must be more than the value of minExclusive.</td>
</tr>
<tr>
<td>minInclusive</td>
<td>The inclusive lower bound of the range of values allowed for this simpleType. The value of the simpleType must be equal to or more than the value of minInclusive.</td>
</tr>
<tr>
<td>minLength</td>
<td>The minimum number of units of length. Units vary according to the base type. The length of the instances of this simpleType must be equal to or more than this number of lengths.</td>
</tr>
<tr>
<td>pattern</td>
<td>A regular expression. The values of the simpleType must be literals that match this regular expression.</td>
</tr>
<tr>
<td>totalDigits</td>
<td>The maximum number of digits that are allowed in values of simpleTypes that are derived from xsd:decimal.</td>
</tr>
<tr>
<td>whiteSpace</td>
<td>Specify one of the following values:</td>
</tr>
</tbody>
</table>
3. Type a name for the new simpleType and press Enter.

4. In the left tool bar, click **New Aggregator**. Stylus Studio displays a pop-up menu with two choices.

5. Double-click **list** or **union**.

6. Define the atomic simpleType of the elements or attributes that are instances of the list or union type. See “Defining simpleTypes in XML Schemas” on page 530.

7. If you are defining a list type you are done. If you are defining a union type, click the union node and define another atomic simpleType that can be in the union. Perform this step for each type in the union.

---

**Defining complexTypes in XML Schemas**

In an XML Schema, an element that contains only data is a simpleType. Elements with any other contents are complexTypes. (Attributes are always simpleTypes.) The XML Schema Recommendation does not include any built-in complexTypes. You must define each complexType you need.

In the Diagram view, when you define a complexType as a top-level definition, it is a global declaration. You can specify that any element in the schema is of this complexType. Similarly, in the Tree view, it is a global declaration when you define a complexType as a child of the Schema node.

**Tip** Define the complexType first. Then when you define an element, Stylus Studio includes your complexType’s name in the menu that lists the available types for your new element. You can select the name of the complexType from the menu.

You can also define a complexType in the definition of an element. See “Defining Elements That Contain Subelements in XML Schemas” on page 555.

Stylus Studio takes care of most of the details for you. But as you define a complexType, it is helpful to keep in mind that a complexType node can have only one child node that is a model group modifier. However, this modifier node can have any number of child nodes that are modifiers. In this way, you can specify any number of modifiers in a complexType. Each modifier controls the occurrence of its child nodes. You can specify the same modifier more than once. For example, you might want to specify the sequence modifier, with some child nodes, then the choice modifier with some child nodes, and then the sequence modifier again with other child nodes.

This section discusses the following topics:
Defining complexTypes That Contain Elements and Attributes – Diagram View

1. Right-click the schema node.
2. In the shortcut menu, select Add > ComplexType.

   Alternatives: This operation is also available from the XMLSchema > Diagram > Add > ComplexType menu and from the Add button.

The new complexType is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new complexType are displayed in the Properties window.

Adding Nodes to a complexType

Once you have created a complexType, you can further define it by adding sequences, elements, and other nodes. The basic procedure for adding nodes to a complexType is to:

1. Select the node.
2. Use the menus or tool bar to add the node.
3. Fully describe the complexType and its nodes by editing values in the Properties window.
Defining complexTypes in XML Schemas

You can use this procedure to add the following nodes to a complexType:

● all
● annotation
● anyAttribute
● attribute
● attributeGroup
● choice
● group
● sequence

Next steps vary according to the constraints on the elements in the complexType. The following instructions show how to achieve some typical constraints.

Choosing an Element

Suppose you want to define a complexType that contains exactly one element, and that element can be one of several different elements. In XML Schema, you do this by defining \texttt{xsd:choice}.

1. Right-click the icon that represents your new complexType.
2. In the shortcut menu that appears, select Add \textgreater Choice.

\textit{Alternatives}: This operation is also available from the XMLSchema \textgreater Diagram \textgreater Add \textgreater Choice menu and from the Add button. Stylus Studio displays the choice icon alongside the complexType icon.

3. Right-click the choice icon and select Add \textgreater Element, or use the Add button. A element is added to the choice icon.

\begin{figure}
\centering
\includegraphics[width=\textwidth]{untitled}
\caption{Defining Choice for a complexType}
\end{figure}

4. Make sure the new element is selected. In the Properties window, click the Type field.
5. Enter or select the type of the element.
6. Repeat Step 3 through Step 5 for each element that might be in the complexType.
Including All Elements

Suppose you want to define a complexType that contains a number of elements, the elements can be in any order, and there must be zero or one of each element. In XML Schema, you do this by defining `xsd:all`.

1. Right-click the icon that represents your new complexType.
2. In the shortcut menu that appears, select `Add > All`.
   *Alternatives:* This operation is also available from the `XMLSchema > Diagram > Add > All` menu and from the `Add` button.
   Stylus Studio displays the all icon alongside the complexType icon.
3. Right-click the choice icon and select `Add > Element`, or use the `Add` button.
   A element is added to the all icon.
4. Make sure the new element is selected. In the Properties window, click the Type field.
5. Enter or select the type of the element.
6. If the element is required, go to Step 7. If the element is optional, click the Min Occur. field in the Properties window, and type a zero (0).
7. If there must always be exactly one of this element, go to Step 8. If there can be more than one of this element, click the Max Occur. field in the Properties window, and enter the maximum number allowed or click `unbounded` in the drop-down list.
8. Repeat Step 3 through Step 7 for each element that can be in the complexType.

Specifying the Sequence of Elements

Suppose you want to define a complexType that contains a number of elements in a particular order. The default is that each element must appear exactly once. However, some elements are optional, and some elements can appear more than once. In XML Schema, you do this by defining `xsd:sequence`.

1. Right-click the icon that represents your new complexType.
2. In the shortcut menu that appears, select `Add > Sequence`.
   *Alternatives:* This operation is also available from the `XMLSchema > Diagram > Add > Sequence` menu and from the `Add` button.
   Stylus Studio displays the sequence icon alongside the complexType icon.
3. Right-click the sequence icon and select `Add > Element`, or use the `Add` button.
Defining complexTypes in XML Schemas

A element is added to the sequence icon.

4. Make sure the new element is selected. In the Properties window, click the Type field.

5. Enter or select the type of the element.

6. If the element is required, go to Step 7. If the element is optional, click the Min Occur. field in the Properties window, and type a zero (0).

7. If there must always be exactly one of this element, go to Step 8. If there can be more than one of this element, click the Max Occur. field in the Properties window, and enter the maximum number allowed or click unbounded in the drop-down list.

8. Repeat Step 3 through Step 7 for each element that can be in the complexType.

Reordering Nodes

If you make a mistake in the order in which you specify nodes in your XML Schema (when specifying elements in a sequence, for example), you can rearrange them.

1. Click the node you want to move.

2. Click the Move Up ▲ or Move Down ▼ from the Stylus Studio tool bar until the node is positioned where you want it.

   Alternative: This operation is also available from the XMLSchema menu and from the node’s shortcut menu.

Combining the Sequence and Choice Modifiers

Suppose you want to define a complexType that contains a number of elements in a particular order, but some of them are optional, and you want to ensure that only one element from a particular group of elements is present. In other words, you need to combine the use of the sequence and choice modifiers. To define this, you must define a sequence modifier first. You can then define sequence and choice modifiers that are children of the initial sequence modifier.
Defining XML Schemas

Defining complexTypes That Contain Elements and Attributes – Tree View

The purchaseOrder.xsd sample document contains the following complexType definition. This complexType defines three elements, refers to a fourth element, and defines an attribute.

```xml
<xsd:complexType name="PurchaseOrderType">
  <xsd:sequence>
    <xsd:element name="shipTo" type="USAddress"/>
    <xsd:element name="billTo" type="USAddress"/>
    <xsd:element ref="comment" minOccurs="0"/>
    <xsd:element name="items" type="Items"/>
  </xsd:sequence>
  <xsd:attribute name="orderDate" type="xsd:date"/>
</xsd:complexType>
```

1. Click the Schema node.
2. In the left tool bar, click New complexType. In the Tree view, Stylus Studio displays a field for the new complexType.
3. Type a name for this new complexType and press Enter.
4. In the left tool bar, click New Model Group. Stylus Studio displays a pop-up menu that lists the group modifiers.
5. Double-click the modifier you want. For a description of each modifier, see “Model Group Properties in XML Schemas” on page 590.
   You can specify any number of modifiers in a complexType. Each modifier controls the occurrence of its child nodes. You can specify the same modifier more than once. For example, you might want to specify the sequence modifier, with some child nodes, then the choice modifier with some child nodes, and then the sequence modifier again with other child nodes.
6. For each element that you want to define in this complexType with the selected modifier, perform the following steps:
   a. Click the modifier name in the Tree view.
   b. In the left tool bar, click New Element Definition. In the Tree view, Stylus Studio displays a field for the new element definition.
   c. Type a name for the new element and press Enter. Stylus Studio displays a pop-up menu that lists the built-in simpleTypes and simpleTypes you defined.
d. Double-click the type for the new element.

e. In the Properties window, you can double-click the field for any property to set the value for that property. For example, you can specify 0 for the Min Occur property and 1 for the Max property. The effect is that the element is optional.

7. For each element or group that you want to refer to in this complexType with the selected modifier, perform the following steps:

a. Click the modifier name in the Tree view.

b. In the left tool bar, click New Reference to Element or New Reference to Group. Stylus Studio displays a pop-up menu that lists the elements or groups defined in the schema.

c. Double-click the element or group you want to reference.

8. To define an attribute in this complexType:

a. Click the name of the complexType in the Tree view.

b. In the left tool bar, click New Attribute. In the Tree view, Stylus Studio displays a field for the new attribute.

c. Type a name for the new attribute and press Enter. Stylus Studio displays a pop-up menu that lists the built-in simpleTypes and the simpleTypes you defined in this schema.

d. Double-click the type of the new attribute.

9. To reference an attribute or attributeGroup in this complexType:

a. Click the name of the complexType in the Tree view.

b. In the left tool bar, click New Reference to Attribute or New Reference to Attribute Group. Stylus Studio displays a pop-up menu that lists the attributes or attributeGroups defined in the schema.

c. Double-click the attribute or attributeGroup you want to reference.
Suppose you want to define a complexType that mixes elements and data. For example, you have an XML document with contents such as the following:

```xml
<letter>
    <salutation>
        Dear Mr.
        <name>Robert Smith</name>
    
    Your order of
    <quantity>1</quantity> <productName>Baby Monitor</productName>
    shipped from our warehouse on
    <shipDate>2001-04-21</shipDate>
</letter>
```

The letter element and salutation element have element and data children. You must define complexTypes for both the letter and the salutation elements. Their Mixed property value must be set to true. The Mixed property is the one that allows an element to contain both elements (e.g., `<shipDate>`, for example) and raw data (e.g., `Dear Mr.`) as children.

This section describes how to achieve this using both the **Diagram** and **Tree** views.

### Diagram View

1. Create a complexType as described in “Defining complexTypes That Contain Elements and Attributes – Diagram View” on page 542.
2. In the Properties window, click the Mixed field.
3. In the drop-down menu that appears, click **true**.
Defining complexTypes in XML Schemas

Tree View

1. Click the Schema node.

2. In the left tool bar, click New complexType. In the Tree view, Stylus Studio displays a field for the new complexType.

3. Type a name for this new complexType and press Enter.

4. In the Properties window, double-click the Mixed field.

5. Double-click true.

6. In the left tool bar, click New Model Group. Stylus Studio displays a pop-up menu that lists the group modifiers.

7. Double-click the modifier you want. For a description of the modifiers, see “Model Group Properties in XML Schemas” on page 590. For the rest of this procedure, assume that you double-click the sequence modifier. By default, the elements that are children of this node each appear exactly once. If you want an element to be optional, or if you want an element to appear more than once, specify appropriate values for the properties for minimum occurrence and maximum occurrence.

8. For each element that you want this complexType to contain:
   a. In the left tool bar, click New Element Definition. In the Tree view, Stylus Studio displays a field for the new element definition.
   b. Type a name for the new element and press Enter. Stylus Studio displays a pop-up menu that lists the built-in simpleTypes and any types already defined in the schema.
   c. Double-click the type for the new element.

Defining complexTypes That Contain Only Attributes

An XML Schema allows you to create groups of attributes. This makes it easy to create a complexType that contains only attributes. The first step is to create an attributeGroup. You can then create a complexType and add a reference to the attributeGroup to the complexType.

Diagram View

1. Right-click the schema node. In the shortcut menu, select Add > AttributeGroup.
Defining XML Schemas

Alternatives: This operation is also available from the XMLSchema > Diagram > Add > AttributeGroup menu and from the Add button .

The new attributeGroup is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new attributeGroup are displayed in the Properties window.

3. Right-click the new attributeGroup.

4. In the shortcut menu that appears, select Add > Attribute.

The new attribute is added to the attributeGroup.

5. Make sure the new attribute is selected. In the Properties window, click the Data Type field.

6. Enter or select the type of the attribute.

7. Repeat Step 3 through Step 6 for each attribute that you want to be in the group.

8. Create a complexType as described in “Defining complexTypes That Contain Elements and Attributes – Diagram View” on page 542.

9. Drag the attributeGroup to the complexType.

Tree View

1. Click the Schema node.

2. In the left tool bar, click New Attribute Group . In the Tree view, Stylus Studio displays a field for new attributeGroup.

3. Enter a name for the attributeGroup.

4. In the left tool bar, click New Attribute Definition . In the Tree view, Stylus Studio displays a field for the new attribute definition.

5. Enter a name for the new attribute. Stylus Studio displays a scrollable, pop-up menu that lists the built-in simpleTypes and any previously defined simpleTypes.

6. Double-click the type of the new attribute.
7. For each additional attribute you want to add to the group, click the name of the attributeGroup in the Tree view, and repeat Step 4 through Step 6.

8. Click the Schema node.

9. In the left tool bar, click New complexType. In the Tree view, Stylus Studio displays a field for the new complexType.

10. Type a name for the new complexType and press Enter.

11. In the left tool bar, click New Reference to Attribute Group. Stylus Studio displays a pop-up menu that contains a list of attributeGroups.

12. Double-click the attributeGroup that you want this complexType to contain.

---

**Defining Elements and Attributes in XML Schemas**

You can define an element or attribute as part of a complexType. You can also define an element or an attribute as a top-level item. In other words, in the XML document that defines the XML Schema, the element or attribute is a child of the xsd:schema element. An element or attribute that is an immediate child of the xsd:schema element is a global element or attribute.

A global element or attribute cannot

- Contain a reference to another element or attribute
- Specify values for the minOccurs, maxOccurs, or use properties

This section covers the following topics:

- Defining Elements That Carry Attributes and Contain Data in XML Schemas on page 552
- Defining Elements That Contain Subelements in XML Schemas on page 555
- Adding an Identity Constraint to an Element on page 556
Defining Elements That Carry Attributes and Contain Data in XML Schemas

You might want to define an element that carries attributes and contains data, but does not contain subelements. In the purchaseOrder.xsd document, an example of this is the internationalPrice element, shown here in the Diagram tab.

This element has a currency attribute, and it contains data based on the xsd:decimal simpleType.

Diagram View

1. Right-click the schema node.
2. In the shortcut menu, select Add > Element.
   Alternatives: This operation is also available from the XMLSchema > Diagram > Add > Element menu and from the Add button.
   The new element is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new element are displayed in the Properties window.
3. Create a complexType of the element – right-click the element and select Add > ComplexType.
4. Make sure the new complexType is selected.
5. Click the QuickEdit button and select Derive by extension or Derive by restriction. These choices let you extend or restrict a base simpleType.
Defining Elements and Attributes in XML Schemas

The **Type Derivation** dialog box appears.

6. Expand the W3C XML Schema and select the simpleType on which you want to base the data allowed by the complexType.

7. Click OK.

   The XML Schema is updated with the element’s new definition. Figure 283 shows an extension of the `decimal` simpleType.

8. To add an attribute, right-click the element and select **Add > Attribute**.

**Tree View**

1. Click the **Schema** node.

2. In the left toolbar, click **New Element Definition**. In the **Tree** view, Stylus Studio displays a field for the new element definition.

3. Type the name of the element and press Enter twice. If you press Enter once, Stylus Studio displays a pop-up menu that lists the possible types for the new element. You need to define a new type, so you cannot select from this list. If the pop-up menu does appear, press Enter or click outside the menu. You should now have a named element with no type specified.
Define XML Schemas

4. In the left tool bar, click **New complexType**. In the Tree view, Stylus Studio displays a field for the new complexType.

5. In the left tool bar, click **New Content**. Stylus Studio displays a drop-down list.

6. In the drop-down list that appears, double-click **simpleContent**. This is the **Content Type** property. When the content type is **simpleContent**, the complexType you are defining can contain data and attributes. It cannot contain subelements.

7. If you want the contained data to be one of the simpleTypes already defined with no restrictions, click **New Extension** in the left tool bar. Stylus Studio displays a scrollable, drop-down list of the simpleTypes built in to XML Schema and previously defined in the current schema.

8. If you clicked **New Extension**, double-click the type of the data you want this element to contain. Go to **Step 9**.

   If you clicked **New Restriction**, follow these steps:
   a. Double-click the simpleType whose values you want to restrict.
   b. In the left tool bar, click **New Facet**. Stylus Studio displays a pop-up menu.
   c. Double-click the type of facet you want to specify.
   d. In the **Properties** window, double-click the **Value** field.
   e. Enter a value for the new facet.
   f. To add another facet, click the **restriction** node for the simpleType, and repeat **Step b**.

9. In the left tool bar, click the **complexType** node that you created in **Step 4**.

10. In the left tool bar, click **New Attribute Definition**. In the Tree view, Stylus Studio displays a field for the new attribute definition.

11. Type a name for the new attribute and press Enter. Stylus Studio displays a scrollable, drop-down list of the possible types for the new attribute.

12. Double-click the attribute type. If you want to, specify a value for the attribute’s **Default** or **Fixed Value** property in the **Properties** window.

13. To add additional attributes, repeat **Step 9** through **Step 12**.
Defining Elements That Contain Subelements in XML Schemas

An element that contains subelements is a complexType. Consequently, you can define an element that contains subelements in either of the following ways:

- Define a top-level complexType. That is, it is a child of the `xsd:schema` node. In the complexType definition, define the subelements. Elsewhere in the schema, define an element that uses the complexType you defined.
- Define an element that is a child of the `xsd:schema` node or a `Model Group` node. In the element definition, define a complexType that contains your subelements.

To define a complexType that contains elements, see “Defining complexTypes That Contain Elements and Attributes – Diagram View” on page 542 or “Defining complexTypes That Contain Elements and Attributes – Tree View” on page 546.

Diagram View

1. Right-click the `schema` node.
2. In the shortcut menu, select `Add > Element`.
   
   **Alternatives:** This operation is also available from the `XMLSchema > Diagram > Add` menu and from the `Add` button.

   The new element is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new element are displayed in the `Properties` window.

3. Right-click the new element and click `QuickEdit`. Select one of the following from the `QuickEdit` menu:
   - `Add Elements Sequence`
   - `Add Elements Choice`
   - `Add Elements All`
   - `Add Elements Any`

   Stylus Studio updates the element definition to include a complexType with the `sequence`, `choice`, `all`, or `any` element you selected in the previous step.

4. Add subelements to the element you created in Step 3.

Tree View

1. Click the `Schema` node or a `Model Group` (all, any, choice, sequence) node.
2. In the left tool bar, click `New Element Definition`.
Defining XML Schemas

3. Enter the name for your new element. Stylus Studio displays a pop-up menu that lists the built-in simpleTypes and any simple or complexTypes already defined in your schema.

4. Press Enter again. Rather than using a type that is already defined, you want to define a new complexType in the definition of your element. You do not want to assign a type to your new element.

5. In the left tool bar, click New complexType.

6. Enter a name for the new type.

At this point, the procedure for defining a complexType in the definition of an element is the same as defining a complexType as a child of the Schema node. See “Defining complexTypes That Contain Elements and Attributes – Tree View” on page 546.

Adding an Identity Constraint to an Element

XML Schemas provide a feature that is similar to the DTD ID identity constraint. In a DTD, the value of an ID attribute must be unique within an XML document. In XML Schemas, the type of an identity constraint can be unique, key, or keyref. You use XPath expressions to define the scope of the constraint.

You associate an identity constraint with an element.

- A unique identity constraint forces the result of evaluation of an XPath expression to be unique. Stylus Studio evaluates the XPath expression against the element for which you define the identity constraint. If the element is present, the result must be unique among the children of that element.

- A key identity constraint specifies that the fields that form the expression must be present in all instance documents. For example, if a key is based on date and number attributes, the date and number attributes must always be specified.

- A keyref identity constraint is equivalent to the IDREF attribute in DTDs. It specifies that the contents of a field in the instance document is the value of a key that is defined in another document. For example, a Quote document would have a reference to the RFQ that originated it.

This section covers the following topics:

- Example of an Identity Constraint on page 557
- Diagram View on page 558
- Tree View on page 558
Example of an Identity Constraint

This topic provides an example of an element with an identity constraint. Introductory information about identity constraints is in “Adding an Identity Constraint to an Element” on page 556. See also “Tree View” on page 558.

Suppose you define the following element in an XML Schema:

```xml
<element name="purchaseReport">
  <complexType>
    <sequence>
      <element name="parts">
        <complexType>
          <sequence>
            <element name="part" maxOccurs="unbounded">
              <attribute name="number" type="SKU"/>
              <attribute name="vendor" type="xs:string"/>
              <attribute name="quantity" type="integer"/>
            </element>
          </sequence>
        </complexType>
      </parts>
    </sequence>
  </complexType>
</element>
```

In an XML document that uses this schema, you could define the following elements:

```xml
<purchaseReport>
  <parts>
    <part number="00-01-02" vendor="IBM" quantity="10"/>
    <part number="01-01-02" vendor="BEAS" quantity="1"/>
    ...
  </parts>
</purchaseReport>
```
Defining XML Schemas

If you want to enforce that there is just one part element for each product that has been purchased, you add the following to the previous XML Schema example:

```xml
... [previous definition]
  </complexType>
  <unique name="pNumKey">
    <selector xpath="parts/part"/>
    <field xpath="@number"/>
    <field xpath="@vendor"/>
  </unique>
</element>
```

The schema validator starts with an initial context set that contains purchaseReport elements. It runs the XPath expression parts/part to obtain the data set to be checked. In this example, this is the two part elements. The schema validator then gathers the values from the number and vendor attributes, and builds a key from these values. It then uses the key to check that there are no part elements that have the same tuple.

Diagram View

1. Right-click the element for which you want to specify the identity constraint.
2. Select Add > and then Key, KeyRef, or Unique from the menu.
3. Right-click the new identity constraint, and select Selector.
4. In the Properties window, specify the XPath expression that identifies the set of elements to which the identity constraint applies.
5. Return to Step 3 and select Field.
6. In the Properties window, specify the XPath expression that identifies the element or attribute for each element identified by the selector element that has to be unique.

Tree View

This topic provides the procedure for specifying an element with an identity constraint. Introductory information about identity constraints is in “Adding an Identity Constraint to an Element” on page 556. See also “Example of an Identity Constraint” on page 557.

1. Click the element for which you want to specify the identity constraint.
2. In the XML Schema left-side tool bar, click id.
3. In the drop-down list that Stylus Studio displays, double-click unique, key, or keyref.
Defining Groups of Elements and Attributes in XML Schemas

4. In the Properties window, double-click the Name field and enter a name for the identity constraint.

5. If you selected keyref, then in the Properties window, double-click the Refer field and enter the name of the key definition.

6. In the tree representation, click the identity constraint you just defined.

7. In the left tool bar, click New Selector/Key.

8. In the drop-down list that Stylus Studio displays, double-click selector. You must define exactly one selector for each identity constraint.

9. In the Properties window, double-click the XPath Expression field and enter an XPath expression that returns the element for which you are specifying a constraint.

10. Click the unique, key, or keyref identity constraint you defined in Step 3.

11. In the left tool bar, click New Selector/Key.

12. In the drop-down list that Stylus Studio displays, double-click field. You must define one or more fields for each identity constraint. A field can be whatever the XPath expression (defined in the next step) retrieves.

13. In the Properties window, double-click the XPath Expression field and enter an XPath expression that returns the element or attribute that is the key or one of the keys for the constraint. XPath expressions associated with fields return the data that define the key for each element returned by the selector XPath expression.

14. Repeat Step 10 through Step 13 for each additional key field.

Defining Groups of Elements and Attributes in XML Schemas

The XML Schema Recommendation allows you to specify groups of elements and groups of attributes. Here is an example of an element group, purchaseType:

```xml
<xsd:group name="purchaseType">
  <xsd:choice>
    <xsd:element name="retail"/>
    <xsd:element name="internet"/>
    <xsd:element name="mailOrder"/>
  </xsd:choice>
</xsd:group>
```
Defining XML Schemas

Specification of a group makes it easier to update the schema. You only need to update the group definition. There is no need to change the references to the group.

Here is an example of an attributeGroup, deliveryDetail.

```xml
<xsd:attributeGroup name="deliveryDetail">
    <xsd:attribute name="method"/>
    <xsd:attribute name="vendor"/>
    <xsd:attribute name="dateShipped"/>
    <xsd:attribute name="dateArrived"/>
</xsd:attributeGroup>
```

This section discusses the following topics:

- Defining Groups of Elements in XML Schemas – Diagram View on page 560
- Defining Groups of Elements in XML Schemas – Tree View on page 561
- Defining attributeGroups in XML Schemas – Diagram View on page 562
- Defining attributeGroups in XML Schemas – Tree View on page 562

**Defining Groups of Elements in XML Schemas – Diagram View**

1. Define the elements that you want to be in the group. See “Defining Elements and Attributes in XML Schemas” on page 551.
2. Right-click the schema node.
3. In the shortcut menu, select Add > Group.
   
   *Alternatives:* This operation is also available from the XMLSchema > Diagram > Add > Group menu and from the Add button.
   
   The new group is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new group are displayed in the Properties window.
4. Specify the group name in the Name property in the Properties window.
5. Right-click the new group.
6. In the shortcut menu, select Add > and then select the modifier for the group of elements – All, Choice, or Sequence. In the Properties window, click the fields for the Min Occur. and Max Occur. properties to specify their values. These properties determine how often the group of the elements with the selected modifier can appear.
7. Drag the elements defined in Step 1 and drop them on the all, choice, or sequence modifier created in Step 6.
Alternative

If you prefer, you can create the element group first, define the modifier for the group elements, and then add new elements to the group by right-clicking on the modifier and selecting Add > Element. If you do this, you must then define each of the elements you added to the group.

Defining Groups of Elements in XML Schemas – Tree View

1. Define the elements that you want to be in the group. See “Defining Elements and Attributes in XML Schemas” on page 551.
2. Click the Schema node.
3. In the left tool bar, click New Group. In the Tree view, Stylus Studio displays a field for the new group.
4. Type a name for the group of elements and press Enter.
5. In the left tool bar, click New Model Group. Stylus Studio displays a pop-up menu that lists the model group modifiers. See “Model Group Properties in XML Schemas” on page 590.
6. Double-click a modifier that applies to at least one element that will be in the group.
7. In the Properties window, double-click the fields for the Min Occur. and Max Occur. properties to specify their values. These properties determine how often the subgroup of the elements with the selected modifier can appear.
8. For each element that you want to apply the selected modifier to, perform these steps:
   a. Click New Reference to Element. Stylus Studio displays a pop-up menu that lists the elements defined in the schema.
   b. Double-click the element you want to add to the group.
   c. Click the modifier to add another element reference.
9. To add more elements to the group and specify a different modifier for them, click the name of the group in the Tree view, and repeat Step 5 through Step 8.

In any location where you can add a model group, you can also add a reference to a model group definition.
Defining attributeGroups in XML Schemas – Diagram View

You define attributeGroups in much the same way that you define element groups – by creating the attributes you want to add to the attributeGroup, creating the attributeGroup, and then dragging-and-dropping the attributes in the attributeGroup. As with element groups, you can define the attributeGroup first and then add new attributes to it, if you prefer. The following procedure describes how to create an attributeGroup by creating the attributes at the same time you create the attributeGroup.

1. Right-click the schema node .
2. In the shortcut menu, select Add > AttributeGroup.
   Alternatives: This operation is also available from the XMLSchema > Diagram > Add > AttributeGroup menu and from the Add button .
   The new attributeGroup is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new attributeGroup are displayed in the Properties window.
3. Right-click the new attributeGroup.
4. In the shortcut menu that appears, select Add > Attribute.
   The new attribute is added to the attributeGroup.
5. Make sure the new attribute is selected. In the Properties window, click the Data Type field.
6. Enter or select the type of the attribute.
7. Repeat Step 3 through Step 6 for each attribute that you want to be in the group.

Defining attributeGroups in XML Schemas – Tree View

1. Click the Schema node.
2. In the left tool bar, click New Attribute Group . In the Tree view, Stylus Studio displays a field for the new attributeGroup.
3. Type a name for the attributeGroup and press Enter.
Adding Comments, Annotation, and Documentation Nodes to XML Schemas

4. In the left tool bar, click **New Attribute Definition**. In the **Tree** view, Stylus Studio displays a field for the new attribute definition.

5. Type a name for the new attribute and press Enter. Stylus Studio displays a scrollable, pop-up menu that lists the built-in simpleTypes and any previously defined simpleTypes.

6. Double-click the type of the new attribute.

7. For each additional attribute you want to add to the group, click the name of the attributeGroup in the **Tree** view, and repeat Step 4 through Step 6.

Adding Comments, Annotation, and Documentation Nodes to XML Schemas

The **XML Schema Recommendation** provides comment and annotation nodes for you to provide information that documents an XML Schema. You can add these nodes to any node in an XML Schema.

The difference between comments and annotations is that a human being must read a comment node for it to have meaning. An annotation element allows you to specify nodes that a stylesheet can operate on.

**Comments**

You cannot add comments in the **Diagram** tab.

1. Click any node in your schema.

2. In the left tool bar, click **New Comment**. In the **Tree** view, Stylus Studio displays a field for the comment.

3. Type your comment and press Enter.

**Annotations**

You use an annotation element to provide information about the XML Schema. You can annotate any node in your XML Schema. The annotation element always contains at least one appInfo or documentation node. Any text you want to enter must be entered in one of these nodes.
Defining XML Schemas

Diagram View

When you create an annotation in the Diagram tab, you create the element and specify its subelement (appInfo or documentation) in the Diagram tab. You can further describe the node:

- In the Diagram tab, by editing the node properties directly
- In the Properties window
- In the Text pane

1. Right-click the node you want to annotate.
2. Select Add > Annotation from the shortcut menu. The annotation icon appears in the Diagram tab.
3. Right-click the annotation icon and select the type of annotation you want to define – appInfo or documentation.
4. In the text pane, type the text for the appInfo or documentation node.

Tip: Stylus Studio’s backmapper identifies the line representing the element you created in Step 3 in the text pane on the Diagram.

Tree View

1. Click the node you want to annotate.
2. In the left tool bar, click New Annotation. Stylus Studio creates and selects an Annotation node.
3. In the left tool bar, click New Documentation or New Application Info.
4. If you added documentation, in the Properties window, double-click the Source field and type the URL or file path for the documentation you want to include in the schema, and press Enter. Double-click the Language field and enter the language of the contents of the source file.
5. In the left tool bar, click New Text. In the Tree view, Stylus Studio displays a field for the new text.
Moving a Comment or Annotation

If the parent of the new comment or annotation node has more than one child, you can move the comment or annotation with the up or down arrow. However, you cannot move the comment or annotation out of the scope of its parent.

Example

In an XML Schema, you might have a comment node such as the following:

```xml
<xs:schema ...
    <!-- The following element is .... -->
    <xs:element name="...">
```

The contents of a comment node have meaning only when a person reads them. However, the contents of annotation nodes can be operated on. For example:

```xml
<xs:schema ... >
    <xs:element name="foo">
        <xs:annotation>
            <xs:documentation language="en">
                This is a <b>foo</b> element. Use it for ...
            </xs:documentation>
            <xs:documentation language="jp">
                xksnjgfyre fhvbvhjds
            </xs:documentation>
        </xs:annotation>
    </xs:element>
    ...
```

You can apply an XSLT stylesheet to this XML Schema document. The stylesheet could generate an HTML manual by extracting the Documentation nodes in the desired language:

```xml
<xsl:stylesheet ... >
    <xsl:template match="xs:element">
        <xsl:apply-templates select="xs:annotation/xs:documentation[@language='en']"/>
    </xsl:template>
    ...
```

Defining XML Schemas

Defining Notations

A notation is an unparsed entity. It is a name for something that you cannot express in terms of XML. For example, suppose you have an XML file that represents a press release. You can define a notation named logo that points to a JPEG image. You can place the notation in the XML file in the location where you want the logo. See http://www.w3.org/TR/REC-xml#Notations for more information on the notation element.

**Note**  A notation element is always described as a child of the schema element.

Diagram View

1. Right-click the schema node.
2. In the shortcut menu, select **Add > Notation**.

   *Alternatives:* This operation is also available from the **XMLSchema > Diagram > Add > AttributeGroup** menu and from the **Add** button.

   The new notation is added to the XML Schema. It is displayed in the diagram and in the text pane (if you have it open). The properties for the new notation are displayed in the **Properties** window.

3. Specify the details of the notation node in the **Properties** window.

Tree View

1. Click the schema node.
2. In the left tool bar, click **New Notation**.
3. In the field that Stylus Studio displays, enter the name of the notation.
4. In the **Properties** window, double-click the **Public ID** field and enter the public ID. The public ID is a unique string that refers to the location of the external data, but it leaves the resolution of the location to some interpretations, for example, MyCompany//LOGO//JPEG.

5. In the **Properties** window, double-click the **System ID** field and enter the system ID. The system ID is the URL that Stylus Studio uses to physically locate the external data, for example, http://www.mycompany.com/mylogo.jpg.
Referencing External XML Schemas

If you want, you can reference definitions from other XML Schemas in your XML Schema document. You might want to do this if you want to simply reuse existing definitions as-is, or if you want to use an existing definition as the base for a type that you want to modify in your XML Schema.

This section covers the following topics:
- “Ways to Reference XML Schemas” on page 568
- “Where You Can Reference XML Schemas” on page 569
- “Referencing XML Schemas in the Tree View” on page 571
- “Referencing XML Schemas in the Tree View” on page 571
- “Redefining Nodes” on page 572
Ways to Reference XML Schemas

There are three ways to reference XML Schema:

- Including
- Importing
- Redefining

This section describes each of these techniques and how they can be used. In these descriptions, we use the term referenced XML Schema to indicate the XML Schema that is being included, imported, or redefined; and base XML Schema to indicate the XML Schema in which the referenced schema is being included, imported, or redefined.

Including an XML Schema

When you reference an XML Schema by including it, the included XML Schema augments the base XML Schema. Both documents are effectively combined, and they both define the same XML Schema. ComplexTypes defined in the included XML Schema can be used as the base for new types – you might use a periodicals complexType from the included XML Schema to define weekly and quarterly types for example. Both the included XML Schema and the base XML Schema must have the same target namespace. You can include multiple XML Schemas in a base XML Schema.

Importing an XML Schema

When you reference an XML Schema by importing it, the base XML Schema and the imported XML Schema must have different namespaces. The base XML Schema can the reference parts of the imported XML schema using a prefix whose namespace is defined in the imported XML Schema, for example. You can import multiple XML Schemas in a base XML Schema.

Redefining an XML Schema

Referencing an XML Schema by redefining it is similar to including it, with one important difference: when you redefine an XML Schema in the base XML Schema, you can redefine the definitions of the referenced XML Schema’s complexTypes, simpleTypes, groups, and attributeGroups. For example, suppose you release version 1 of an XML Schema. When you need to release version 2 of the XML Schema, you can reference version 1 by redefining it in version 2, which allows you to change the definition of a given node to include a new attribute.
Referencing External XML Schemas

The original complexTypes, simpleTypes, groups, and attributeGroups in the redefined XML Schema are completely masked. They are redefined using extensions and restrictions. An extension extends the base type – declaring a new element, for example. A restriction constrains the base type.

Where You Can Reference XML Schemas

You can reference external XML Schemas in the Tree or Diagram tabs. In the text pane of the Diagram tab and the Tree tab, Stylus Studio displays the referenced XML Schema, but they do not display its contents. For example, in the Tree view, you cannot expand the node for an included XML Schema.

In the Diagram tab, Stylus Studio displays complete information for any definitions in referenced XML Schema. You can toggle between diagram views of the base and referenced XML Schemas using the definition browser.

If you select a referenced schema from the definition browser, as shown in Figure 285, Stylus Studio changes the diagram view to display the referenced schema’s structure. If you selected a redefined XML Schema, for example, you could modify its complexType definitions there.

What to Do Next

If you redefine an XML Schema (as opposed to including or importing one), you can redefine nodes after referencing the XML Schema. See “Redefining Nodes” on page 572 for more information.
Referencing XML Schemas in the Diagram View

1. Right-click the schema node.
2. Click **Referenced Schemas** on the shortcut menu.

   The **Referenced Schemas** dialog box appears.

3. Click the **Add** button.

   The **Add References to Schema** dialog box appears.

4. Specify the type of reference you want to make. If you are redefining an XML Schema, specify the namespace in the **Namespace** field.
Referencing External XML Schemas

5. Specify the URL of the XML Schema you want to reference. For example:
   - myfile.xsd
   - http://www.mycompany.com/schemas/myfile.xsd
   - \fileserver\schemas\myfile.xsd

6. Click OK.
   You are returned to the Referenced Schemas dialog box.

7. Click OK to add the referenced XML Schema to your XML Schema.

Referencing XML Schemas in the Tree View

1. Click the Schema node.

2. In the XML Schema left-side tool bar, click one of the following:
   - New Include
   - New Import
   - New Redefine

3. In the field that Stylus Studio displays, enter the location. This is a URL that identifies
   the location of the file that contains the XML Schema. For example, it can be like any
   one of the following:
   - myfile.xsd
   - http://www.mycompany.com/schemas/myfile.xsd
   - \fileserver\schemas\myfile.xsd

4. If you defined an Import node, in the Properties window, double-click the Target
   Namespace field and enter the target namespace. The target namespace must be
   different from the target namespace of the importing file.
Redefining Nodes

Once you reference an XML Schema by redefining it, you are able to redefine that XML Schema’s complexTypes, simpleTypes, groups, and attributeGroups. This section describes how to redefine nodes using the Diagram tab.

Extensions and Restrictions

There are two ways to redefine a node: by extension and restriction. An extension extends the base type – adding an element or an attribute definition, for example. A restriction constrains the base type – limiting a type to a certain range of values, for example.

Specifying Restriction Facets

If you define a restriction using a simpleType, the Properties window displays a section that allows you to define the facets that restrict that type, as shown in Figure 288.

Figure 288. Facets for Describing Restrictions

Restriction facets include length, minLength, maxLength, and totalDigits. For each facet you specify, you provide the facet name, a value, and, for some facets, whether or not the value is fixed. Note that not all facets apply to all types.

See “About Facet Types for simpleTypes” on page 539 for more information on facets.
Referencing External XML Schemas

How to Redefine a Node

1. Right-click the schema node.

2. Select **Redefine** from the shortcut menu.
   
The **Redefine Schema Symbols** dialog box appears.

3. Select the node from the redefined XML Schema you want to redefine and click **OK**.
   
The redefined node is added to the diagram, and the text for the redefined node appears in the text pane. For example, `<xsd:complexType name="PublicationType"/>`.

4. Right-click the redefined node.

5. From the shortcut menu, select **Quick Edit** > and then either **Derive by extension** or **Derive by restriction**.
   
The **Type Derivation** dialog box appears.

6. Select the base type from which you want to derive the definition of the node you are redefining, and click **OK**.
Defining XML Schemas

The node you added in Figure 3 is modified in the diagram to display the restriction or extension you are using to redefine it, as shown in Figure 291.

![Image of modified node in diagram]

Figure 291. Redefined Node as a Restricted simpleType

The code displayed in the text pane is also modified. For example:

```xml
<xsd:complexType name="PublicationType">
  <xsd:simpleContent>
    <xsd:restriction base="SKU"/>
  </xsd:simpleContent>
</xsd:complexType>
```

7. If you specified a restriction of a simpleType, specify the restriction facets in the Properties window. See “Specifying Restriction Facets” on page 572 if you need help with this step.

Generating Documentation for XML Schema

The Documentation tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

The Documentation tab of the XML Schema Editor displays HTML documentation that describes the currently active XML Schema. You can choose one of two display formats – XS3P (the default) or XSDdoc. Each format has its own look-and-feel, and a set of options that affects the XML Schema documentation layout and content for both display and print.

This section covers the following topics:

- XS3P Stylesheet Overview on page 575
- XSDdoc Stylesheet Overview on page 579
- Choosing a Display Option for XML Schema Documentation on page 580
- Saving XML Schema Documentation on page 581
- Printing XML Schema Documentation on page 581
XS3P Stylesheet Overview

By default, Stylus Studio displays XML Schema on the Documentation tab using the XS3P stylesheet from the DSTC Project Titanium (http://titanium.dstc.edu.au/). Figure 292 shows how the purchaseOrder.xsd looks when displayed using this stylesheet.

The XS3P stylesheet contains
- A customizable title (the default title is XML Schema Documentation)
- A table of contents with hypertext links to sections in the documentation
- Information about the XML Schema’s properties, such as its target namespace and any declared namespaces
- Global declarations and global definitions, if any
Defining XML Schemas

- A legend that describes the graphical conventions used in the XML Schema documentation
- A glossary that defines terminology used in the XML Schema documentation.

**Tip**
You can hide the legend and the glossary by clicking the **Printer-friendly Version** check box at the top of the page.

This section covers the following topics:
- **XS3P Stylesheet Features** on page 576
- **XS3P Stylesheet Settings** on page 577
- **Modifying the XS3P Stylesheet** on page 578

**XS3P Stylesheet Features**

The XS3P stylesheet has several features that affect content and layout of XML Schema displayed on the **Documentation** tab. You can

- Create a printer-friendly version of the documentation by clicking the **Printer-friendly Version** check box.

**Figure 293. Features of XML Schema Documentation**

When you click this check box, Stylus Studio

- Hides the Legend and Glossary sections
- Automatically expands all XML instance and schema component representations
- Removes the expand/collapse controls from the page

- Expand and collapse XML instance and schema component representations. You can do this for every XML instance or schema component by clicking the **Expand All** and
Collapse All buttons associated with these representations. You can also set this option for individual instances by clicking the +/- button, as shown in Figure 294.

![Schema Component Representation](image)

Figure 294. Representations Can be Collapsed/Expanded Individually

- Customize and modify the XML Schema documentation. For example, you can choose to include all super-types, you can change the default name, and you can specify the sort order. Settings for these and other properties that affect the content and appearance of the XML Schema documentation are displayed in the Options dialog box. See XS3P Stylesheet Settings on page 577 for more information.

### XS3P Stylesheet Settings

The XS3P stylesheet allows you to modify the following:

- **Title** – The default title is *XML Schema Documentation*, but you can change it to whatever you want by editing the Title field.

- **Sort order** – By default, Stylus Studio sorts information in the XML Schema in alphabetical order by type name. If you want to display information in document order, set the Sort by Component field to False.

- Whether or not you want Stylus Studio to search included and imported XML Schemas.

- If you want to incorporate instructions in the HTML, the Use JavaScript option makes it easy for you to add instructions such as to display pop-up windows and hide information in the generated HTML document.

- Inclusion in the XML Schema documentation of
  - Supertypes
  - Subtypes
  - Glossary
  - Legend
  - xsd namespace prefix
  - Schema diagrams
Defining XML Schemas

You control these settings on the **Documentation** page of the **Options** dialog box.

**Tip** You can also modify the stylesheet directly. See *Modifying the XS3P Stylesheet* on page 578.

### Modifying the XS3P Stylesheet

You can customize the XS3P stylesheet that Stylus Studio uses to display XML Schema documentation. The XS3P stylesheet is in the `\schema-documentation` directory where you installed Stylus Studio: `bin\Plugins\schema-documentation`. The name of the stylesheet file is `xs3p.xsl`.

Should you choose to modify the default XS3P stylesheet, the new stylesheet must have the same name as the original. After you modify and save this file, click the refresh button on the Stylus Studio tool bar to see your changes.

**Tip** Make a copy of the `xs3p.xsl` file before you modify it.
XSDdoc Stylesheet Overview

The XSDdoc stylesheet, from xframe (http://xframe.sourceforge.net/xsddoc.html/) displays XML Schema documentation using a Javadoc look-and-feel. Here is sample of purchaseOrder.xsd displayed using the XSDdoc stylesheet.

![XML Schema Documentation Displayed Using XSDdoc Stylesheet](image)

XSDdoc Stylesheet Settings

The XS3P stylesheet allows you to modify the following:

- Title – The title displayed on the XML Schema documentation’s Overview page. The default title is XML Schema Documentation, but you can change it to whatever you want by editing the Doctitle field.
Defining XML Schemas

- **Header** – The string that appears in the navigation bar, which is displayed at the top and bottom of every page in the XML Schema documentation. Here, the header is `purchaseOrder.xsd`.

![Figure 296. XML Schema Documentation Headers](image)

- **Inclusion in the XML Schema documentation of**
  - Attributes
  - Groups
  - Local usage
  - Subtypes
  - Types

The name or network address of the proxy host server, and the server port to which Stylus Studio attaches. The proxy host, if needed in your environment, is used to access the Internet in order to resolve imported or included stylesheets.

You control these settings on the **Documentation** page of the **Options** dialog box.

### Choosing a Display Option for XML Schema Documentation

Stylus Studio uses the XS3P stylesheet to display XML Schema documentation.

1. Select **Tools > Options** from the Stylus Studio menu.

   The **Options** dialog box appears.

2. Navigate to **Module Settings > XML Schema Editor > Documentation**.

3. Select the desired display option from the **Documentation Style** group box.

4. Click OK.
This setting is used the next time you display an XML Schema on the Documentation tab of the XML Schema Editor. If you are viewing an XML Schema on the Documentation tab, click the Reload Document button ( ) for the change to take effect.

**Saving XML Schema Documentation**

To save the XML Schema documentation, click the Save Documentation button ( ) in the XML Schema window. The XML Schema documentation is saved as an HTML file that you can edit and add to as you would any other HTML file.

**Printing XML Schema Documentation**

1. If you are using the XS3P stylesheet, optionally click the Printer-friendly Version check box at the top of the XML Schema documentation.
2. Review the settings on the Documentation page of the Options dialog box (Tools > Options > Module Settings > XML Schema Editor > Documentation).
3. Optionally, preview the XML Schema documentation (File > Print Preview).
4. Click the Print button ( ), or type Ctrl + P.

**Generating JAXB Classes**

You can generate JAXB (Java Architecture for XML Binding) application class files from an XML Schema. The generated application skeleton (Main.java, for example) demonstrates how to use Marshaller and Unmarshaller classes.

For more information on using JAXB, refer to the Sun Microsystems’ Java Technology and XML documentation, located here: http://java.sun.com/xml/jaxb/docs.html.
What Stylus Studio Generates

By default, Stylus Studio creates the Java package in the directory in which the source XML Schema file (.xsd) resides. The package name is the XML Schema file name, and the default JAXB application class name is Main. Also by default, the generated files are added to the current Stylus Studio project in a folder with the same name as the package.

You can change any of these values at the time you run the JAXB code generator.

How to Generate JAXB Classes

1. Open the XML Schema file for which you want to generate JAXB classes.
2. Click the Diagram tab if it is not already selected.
3. Select XMLSchema > Generate Java from the Stylus Studio menu.
   The Generate Java Binding Class dialog box appears.

   ![Generate Java Binding Class Dialog Box](image)

   Figure 297. Generate Java Binding Class Dialog Box

4. If necessary, change the default values.
5. Click OK.
   Stylus Studio generates JAXB classes. The Output window displays code generation status.
Compiling JAXB Class Files

The following procedure assumes that you created the JAXB package as part of the current Stylus Studio project.

1. Display the Project window if it is not already open.
2. Right-click the folder that represents the JAXB package.
3. Select Compile from the shortcut menu.

Stylus Studio compiles the JAXB package. The Output window displays compile status.

About XML Schema Properties

The Documentation tab is available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

When the Diagram or Tree tab of an XML Schema is active, you can see the properties for the selected node. Click the node whose properties you want to view, and the properties appear in the Properties window. If the Properties window is not visible, select View > Properties from the menu bar.

To change the value of a property, click the property field and enter the new value. If only certain values are allowed, Stylus Studio displays a drop-down list of the valid choices. In the Diagram view, some properties are read-only. To modify these properties, switch to the Tree view and change the property there. When you switch back to the Diagram view, your change is visible.

Each type of node has its own set of properties. The following topics describe the properties for various node types:

- About xsd:schema Properties on page 584
- Element and Element Reference Properties in XML Schemas on page 586
- Attribute and Attribute Reference Properties in XML Schemas on page 588
- Group Properties in XML Schemas on page 590
- Model Group Properties in XML Schemas on page 590
- Complex and simpleType Properties in XML Schemas on page 592
- Restriction and Extension Type Properties in XML Schemas on page 593
- Content Type Properties in XML Schemas on page 593
About xsd:schema Properties

The root element of every XML Schema document is the xsd:schema element. The xsd:schema element has the properties described in Table 42. Click the Tree tab, and then click the Schema node to view the properties for the xsd:schema element.

Table 42. xsd:schema Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Schema.</td>
</tr>
<tr>
<td>Namespace</td>
<td>The namespace for the Schema node is usually xsd, but you can change it.</td>
</tr>
</tbody>
</table>
| Target Namespace  | This is the namespace that elements and attributes defined in an instance document belong to. For example, suppose you define the following:
   <xsd:schema ... targetNamespace="http://myNS">
   <xsd:element name="myelement"/>
   In an instance document, the following declarations conform with the target namespace:
   <myelement xmlns="http://myNS"/>
   <myns:myelement xmlns:myns="http://myNS"/>
   However, the following declaration does not conform:
   <myns:myelement xmlns:myns="http://anotherNS"/>
| Version           | Use this property as a convenient way to track the revisions of your XML Schema document. |
### About XML Schema Properties

**Table 42. xsd:schema Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Element Form       | An element or attribute's form is either qualified or unqualified. A form of qualified means that each time an element or attribute is referenced in the schema document, you must specify the prefix of its namespace. Every element and attribute has a form attribute. If it is not explicitly defined, the schema processor checks the default attribute form specified for the Schema node. For example:  
<xs:schema elementFormDefault="qualified"  
    targetNamespace="http://myNs"  
    xmlns:myns="http://myNS">  
    <xs:element name="topElem">  
      ...  
    </xs:element>  
    <xs:element name="anElem">  
      <xs:complexType>  
        <xs:sequence>  
          <xs:element ref="myns:topElem">  
            ...  
          </xs:element>  
        </xs:sequence>  
      </xs:complexType>  
    </xs:element>  
</xs:schema>  
If the form for the element `topElem` (or, the default form for elements) was defined to be unqualified, the reference could have used `ref="topElem"`. |
| Default Attribute Form     |                                                                                                                                              |
| Default Blocked Definitions| If an element does not have its own blocked or final definition, the schema processor uses the default blocked or final definition you specify here. |
| Default Final Definitions  |                                                                                                                                              |
Element and Element Reference Properties in XML Schemas

Both global and local elements have the properties described in Table 43. References to elements have the same properties except where noted.

Table 43. Element and Element Reference Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>For elements, the type is always Element. For references to elements, the type is always Ref. to Element.</td>
</tr>
<tr>
<td>Name</td>
<td>The tag name you use in an instance document. Specify the name you want the element to have.</td>
</tr>
<tr>
<td>Min Occur.</td>
<td>Specifies the minimum number of instances of this element that can be present. If an element is not required to be present, specify 0. You cannot specify this property for a global element. If you do, Stylus Studio ignores it.</td>
</tr>
<tr>
<td>Max Occur.</td>
<td>Specifies the maximum number of instances of this element that can be present. If there is no limit to the number of instances, specify unbounded. You cannot specify this property for a global element. If you do, Stylus Studio ignores it.</td>
</tr>
<tr>
<td>Data Type</td>
<td>The type of the data that the element contains. Select from all simpleTypes defined in an XML Schema, and all types (simple or complex) that you define in the same schema. Nodes that are references to elements do not have this property.</td>
</tr>
<tr>
<td>Default</td>
<td>Specifies the default value for this element. Specification of this property makes sense only for optional elements. If you specified 0 for the Min Occur. property, you can specify a default value. When this element is in an instance document, the element has whatever value you specify. If you do not specify this element, the schema processor behaves as though you had specified it with the default value. When you specify a default value for an element, that element must be optional in an instance document. An element can have a value for the Default property or a value for the Fixed Value property. The two properties are mutually exclusive.</td>
</tr>
</tbody>
</table>
### About XML Schema Properties

#### Table 43. Element and Element Reference Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Value</td>
<td>When you specify a value for Fixed Value, it is optional for the element to appear in an instance document. However, if the element does appear, it must have the value specified by Fixed Value. Whether or not you specify this element in an instance document, the schema processor behaves as though you had specified this element with the fixed value. An element can have a value for the Fixed Value property or a value for the Default property. The two properties are mutually exclusive.</td>
</tr>
<tr>
<td>Abstract</td>
<td>A Boolean value that indicates whether substitution for this element is required. When Abstract is true, the element cannot be used in an instance document. Instead, a member of the element’s substitution group must appear in the instance document.</td>
</tr>
<tr>
<td>Nillable</td>
<td>A Boolean value that indicates whether the contents of the element can be set to nil. A value of true indicates that the element can be empty; that is, it is permissible for the element to not contain any subelements, attributes, or data.</td>
</tr>
<tr>
<td>Form</td>
<td>An element’s form is either qualified or unqualified. A form of qualified means that each time the element is referenced in the schema document, you must specify the prefix of its namespace. Every element has a form attribute. If it is not explicitly defined, the schema processor checks the default attribute form specified for the Schema node.</td>
</tr>
<tr>
<td>Blocked Substitutions</td>
<td>Defines that this element cannot be derived in some forms. That is, it specifies that one or more extensions, restrictions or substitutions cannot be permitted. For example, an enumeration for all the states in the United States can block extensions and substitutions, thus allowing derived data types only so as to restrict the number of valid states.</td>
</tr>
</tbody>
</table>
Defining XML Schemas

### Table 43. Element and Element Reference Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final Substitutions</td>
<td>Specifies that this element is not allowed to be substituted in a substitution group if these are extensions or restrictions of the same base type. For example, suppose an Invoice contains a reference to a PO document. The PO document is derived from AccountingDocument. If PO document has the final=&quot;extensions&quot; attribute, and PartialPO is defined as an extension from AccountingDocument, the Invoice cannot substitute PO with PartialPO.</td>
</tr>
<tr>
<td>Substitution Groups</td>
<td>If an element defines an element name definition in a substitution group, it means that it can be used in all the places where there is a reference to that element. For example, suppose the PO document definition indicates that it can refer to an RFQ element. You can specify that a foo element is in the substitution group for an RFQ element. If you do, a PO document is valid if it refers to a foo element.</td>
</tr>
</tbody>
</table>

### Attribute and Attribute Reference Properties in XML Schemas

Both global and local attributes have the properties described in the Table 44. References to attributes have the same properties, except where noted.

### Table 44. Attribute and Attribute Reference Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>For attributes, the type is always Attribute. For attribute references, the type is always Ref. to Attribute.</td>
</tr>
<tr>
<td>Name</td>
<td>The attribute name you use in an instance document. Specify the name you want the attribute to have.</td>
</tr>
<tr>
<td>Data Type</td>
<td>The type of the data that is the value of the attribute. Select from all simpleTypes defined in an XML Schema, and all simpleTypes that you already defined in the same schema. References to attributes do not have this property.</td>
</tr>
</tbody>
</table>
### About XML Schema Properties

**Table 44. Attribute and Attribute Reference Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Specifies the default value for this attribute. Specification of this property makes sense only for optional attributes. If you specified <code>optional</code> for the Restrictions property, you can specify a default value. If this attribute is in an instance document, the attribute has whatever value you specify. If you do not specify this attribute, the schema processor behaves as though you had specified it with the default value. When you specify a default value for an attribute, that attribute must be optional in an instance document. An attribute can have a value for the Default property or a value for the Fixed Value property. The two properties are mutually exclusive.</td>
</tr>
<tr>
<td>Fixed Value</td>
<td>When you specify a value for Fixed Value, it is optional for the attribute to appear in an instance document. However, if the attribute does appear, it must have the value specified by Fixed Value. Whether or not you specify this attribute in an instance document, the schema processor behaves as though you had specified this attribute with the fixed value. An attribute can have a value for the Fixed Value property or a value for the Default property. The two properties are mutually exclusive.</td>
</tr>
<tr>
<td>Restrictions</td>
<td>Specify prohibited, optional, or required.</td>
</tr>
<tr>
<td>Form</td>
<td>An attribute’s form is either qualified or unqualified. A form of qualified means that each time the attribute is referenced in a schema document, you must specify the prefix of its namespace. Every attribute has a form attribute. If it is not explicitly defined, the schema processor checks the default attribute form specified for the Schema node.</td>
</tr>
</tbody>
</table>
**Group Properties in XML Schemas**

A group contains references to elements. Groups have the properties described in Table 45:

**Table 45. Group Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Group.</td>
</tr>
<tr>
<td>Name</td>
<td>The name you specified for the group.</td>
</tr>
<tr>
<td>Min Occur.</td>
<td>Specifies the minimum number of instances of this group that can appear in a complexType that references this group. If a group is not required to be present, specify 0.</td>
</tr>
<tr>
<td>Max Occur.</td>
<td>Specifies the maximum number of instances of this group that can appear in a complexType that references this group. If there is no limit to the number of instances, specify unbounded.</td>
</tr>
</tbody>
</table>

**Model Group Properties in XML Schemas**

After you create a group node or a complexType node, you can add a model group node as a child. A model group specifies rules for the occurrence of elements. These are the elements that are the children of the group or complexType in an instance document. A
model group references and defines elements. Model groups have the properties described in Table 46:

**Table 46. Model Group Properties**

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>The type is always <code>Model Group</code>.</td>
</tr>
<tr>
<td><strong>Modifier</strong></td>
<td>Specifies the occurrence rules for the elements that you add as children of the model group node. Specify one of the following values:</td>
</tr>
<tr>
<td></td>
<td>● <code>all</code> specifies that each element must appear exactly zero or one time. The elements can appear in any order. In an instance document, the children of the group or complexType can include 0 or 1 instance of each element.</td>
</tr>
<tr>
<td></td>
<td>● <code>choice</code> specifies that exactly one element can be present, and there must be only one instance of that element. In an instance document, exactly one element can be a child of the group or complexType.</td>
</tr>
<tr>
<td></td>
<td>● <code>sequence</code> specifies that the elements must appear in the order in which they are specified in the schema. For each element, you can specify whether it is optional and whether it can appear more than once. The default is that exactly one must be present in an instance document. In an instance document, each element that appears must be in the same order as in the schema. Another value you can specify is <code>any</code>. When you specify <code>any</code>, you do not add any element definitions or references to elements. As the name implies, any element can appear any number of times.</td>
</tr>
<tr>
<td><strong>Min Occur.</strong></td>
<td>Specifies the minimum number of instances of this model group that can appear in this group or complexType. If a model group is not required to be present, specify 0.</td>
</tr>
<tr>
<td><strong>Max Occur.</strong></td>
<td>Specifies the maximum number of instances of this model group that can appear in this group or complexType. If there is no limit to the number of instances, specify <code>unbounded</code>.</td>
</tr>
</tbody>
</table>
Complex and simpleType Properties in XML Schemas

complexType have the properties described in Table 47. simpleTypes have only the Type and Name properties.

Table 47. Complex and simpleType Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always complexType or simpleType.</td>
</tr>
<tr>
<td>Name</td>
<td>The type name you use elsewhere in the XML Schema. Specify the name you want the type to have.</td>
</tr>
<tr>
<td>Abstract</td>
<td>A Boolean value that indicates whether substitution for this complexType is required. When Abstract is true, the complexType cannot be used in an instance document. Instead, a member of the complexType’s substitution group must appear in the instance document. simpleTypes do not have this property.</td>
</tr>
<tr>
<td>Mixed</td>
<td>A Boolean value that indicates whether or not this complexType can contain raw data as well as elements and attributes. A value of true indicates that it can contain raw data. simpleTypes do not have this property.</td>
</tr>
<tr>
<td>Blocked Substitutions</td>
<td>Defines that this type cannot be derived in some forms. That is, it specifies that one or more extensions, restrictions or substitutions cannot be permitted. For example, an enumeration for all the states in the United States can block extensions and substitutions, thus allowing derived data types only so as to restrict the number of valid states.</td>
</tr>
<tr>
<td>Final Substitutions</td>
<td>Specifies that the type is not allowed to be substituted in a substitution group if these are extensions or restrictions of the same base type. For example, suppose an Invoice contains a reference to a P0 document. The P0 document is derived from AccountingDocument. If P0 document has the final=&quot;extensions&quot; attribute, and PartialP0 is defined as an extension from AccountingDocument, the Invoice cannot substitute P0 with PartialP0.</td>
</tr>
</tbody>
</table>
Restriction and Extension Type Properties in XML Schemas

When you define a simpleType, you always derive it from a built-in XML Schema simpleType, or a simpleType you previously defined. To specify the simpleType that your simpleType is based on, add a restriction node or an extension node to your simpleType node.

A restriction node indicates that your simpleType is a subset of some other simpleType. An extension node indicates that your simpleType extends the range of values provided by an existing simpleType.

Restriction type nodes and extension type nodes have the properties described in Table 48:

Table 48. Restriction and Extension Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Restriction or Extension.</td>
</tr>
<tr>
<td>Base Type</td>
<td>Indicates the data type that this simpleType is based on.</td>
</tr>
</tbody>
</table>

Content Type Properties in XML Schemas

Content types have the properties described in Table 49:

Table 49. Content Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Content.</td>
</tr>
<tr>
<td>Mixed</td>
<td>A Boolean value that indicates whether this node can contain text as well as elements.</td>
</tr>
<tr>
<td>Content Type</td>
<td>When the value is simpleContent, the node can contain only character data and no elements or attributes. When the value is complexContent, the node can contain character data, elements, and attributes.</td>
</tr>
</tbody>
</table>
Aggregator Type Properties in XML Schemas

After you create a simpleType node, you can add an aggregator node as its child. An aggregator node indicates that a single instance of an element of your new simpleType contains a sequence of atomic types. Aggregator types have the properties described in Table 50:

Table 50. Aggregator Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Must be list or union.</td>
</tr>
<tr>
<td></td>
<td>● list indicates that all instances in the sequence must be of the same type.</td>
</tr>
<tr>
<td></td>
<td>● union indicates that the instances in the sequence can be of different types.</td>
</tr>
<tr>
<td>Aggregator Type</td>
<td>The type of the instances included in your new simpleType. If the value of Type is union, you can specify a space-separated list.</td>
</tr>
</tbody>
</table>
Facet Type Properties in XML Schemas

Facet types have the properties described in Table 51:

Table 51. Facet Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facet Type</td>
<td>Must be one of the following: enumeration, fractionDigits, length, maxExclusive, maxInclusive, maxLength, minExclusive, minInclusive, minLength, pattern, totalDigits, or whiteSpace.</td>
</tr>
<tr>
<td>Fixed</td>
<td>A Boolean value that indicates whether you can further restrict the simpleType with this same facet and a different value. The default is false. That is, the default is that you can apply the same facet more than once. For example, suppose you specify the following definition: <code>&lt;xsd:simpleType name=&quot;zip&quot;&gt;  &lt;xsd:restriction base=&quot;xsd:string&quot;&gt;    &lt;xsd:length value=&quot;5&quot; fixed=&quot;true&quot;/&gt;  &lt;/xsd:restriction&gt; &lt;/xsd:simpleType&gt;</code> This defines a postal code whose length is 5 characters. You can further restrict this simpleType with, for example, the pattern facet so that the first three characters must always be &quot;100&quot;, but you cannot further restrict the length facet when the Fixed property is set to true. Facet types of pattern and enumeration do not have the Fixed property.</td>
</tr>
<tr>
<td>Value</td>
<td>Varies according to the facet type. See “About Facet Types for simpleTypes” on page 539.</td>
</tr>
</tbody>
</table>
Notation Type Properties in XML Schemas

Notation types have the properties described in Table 52. See “Defining Notations” on page 566 for more information.

Table 52. Notation Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Notation.</td>
</tr>
<tr>
<td>Name</td>
<td>The name you specify for the notation.</td>
</tr>
<tr>
<td>Public ID</td>
<td>Unique string that refers to the physical location of the external data,</td>
</tr>
<tr>
<td></td>
<td>for example, MyCompany//LOGO//JPEG.</td>
</tr>
<tr>
<td>System ID</td>
<td>URL used to physically locate the external data, for example, <a href="http://www.mycompany.com/mylogo.jpg">http://www.mycompany.com/mylogo.jpg</a>.</td>
</tr>
</tbody>
</table>

Include Type Properties in XML Schemas

Include types have the properties described in Table 53. See “Referencing External XML Schemas” on page 567 for more information.

Table 53. Include Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Include.</td>
</tr>
<tr>
<td>Location</td>
<td>URL that identifies the location of the file that contains the XML Schema.</td>
</tr>
</tbody>
</table>
Import Type Properties in XML Schemas

Import types have the properties described in Table 54. See “Referencing External XML Schemas” on page 567 for more information.

Table 54. Import Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Import.</td>
</tr>
<tr>
<td>Location</td>
<td>URL that identifies the location of the file that contains the XML Schema.</td>
</tr>
<tr>
<td>Target Namespace</td>
<td>This is the namespace that elements and attributes defined in an instance document belong to.</td>
</tr>
</tbody>
</table>

Redefine Type Properties in XML Schemas

Redefine types have the properties described in Table 55. See “Referencing External XML Schemas” on page 567 for more information.

Table 55. Redefine Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Redefine.</td>
</tr>
<tr>
<td>Location</td>
<td>URL that identifies the location of the file that contains the XML Schema.</td>
</tr>
</tbody>
</table>

Identity Constraint Type Properties in XML Schemas

Identity Constraint types have the properties described in Table 56. See “Adding an Identity Constraint to an Element” on page 556 for more information.

Table 56. Identity Constraint Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Identity Constraint.</td>
</tr>
<tr>
<td>Name</td>
<td>The name you specify for the identity constraint.</td>
</tr>
</tbody>
</table>
## Constraint Element Type Properties in XML Schemas

Constraint Element types have the properties described in Table 57. See “Adding an Identity Constraint to an Element” on page 556 for more information.

Table 57. Constraint Element Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Constraint Element.</td>
</tr>
<tr>
<td>XPath Expression</td>
<td>An XPath expression that returns the element for which you are defining a constraint.</td>
</tr>
</tbody>
</table>

## Documentation Type Properties in XML Schemas

Documentation types have the properties described in the following table:

Table 58. Documentation Type Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type is always Documentation.</td>
</tr>
<tr>
<td>Source</td>
<td>A path or URL for an external file that contains the documentation.</td>
</tr>
<tr>
<td>Language</td>
<td>The language of the contents of the documentation.</td>
</tr>
</tbody>
</table>
This section provides information about how to use the Stylus Studio Document Type Definition (DTD) editor to define a DTD. Familiarity with DTDs is assumed.

This section discusses the following topics:

- “What Is a DTD?” on page 600
- “Creating DTDs” on page 600
- “About Editing DTDs” on page 601
- “About Modifiers in Element Definitions in DTDs” on page 602
- “Defining Elements in DTDs” on page 605
- “Defining General Entities and Parameter Entities in DTDs” on page 614
- “Inserting White Space in DTDs” on page 616
- “Adding Comments to DTDs” on page 616
- “About Node Properties in DTDs” on page 617
- “Associating an XML Document with an External DTD” on page 621
- “Moving an Internal DTD to an External File” on page 621
Defining Document Type Definitions

What Is a DTD?

A document type definition (DTD) describes the structure of a document. It specifies which elements can contain which other elements, which elements are optional and which are required, and which elements contain data. For example, a DTD might specify that a book element

- Must contain exactly one title element
- Can contain any number of author elements
- Might contain a subtitle element

To use a DTD, you must associate it with an XML document. A DTD can be internal or external. An internal DTD is inside the XML document that uses it. It appears in the DOCTYPE element, which immediately follows the XML declaration at the beginning of the document. An external DTD is in a separate file. An XML document that uses an external DTD specifies the path for the DTD in its DOCTYPE element. For example, the following DOCTYPE element specifies that bookstore is the root element in this XML document, and that the DTD that this document uses is stored in the file system at C:\mydir\bookstore.dtd:

```xml
<!DOCTYPE bookstore SYSTEM "file://C:\mydir\bookstore.dtd">
```

A document instance is an XML document that uses a particular DTD. In other words, the contents of a document instance have been tagged according to the structure defined in the DTD it is associated with. For example, if the contents of the bookstore.xml file follow the structure defined in the bookstore.dtd file, bookstore.xml is a document instance of the bookstore DTD.

Creating DTDs

To create a DTD, select File > New > DTD Schema from the Stylus Studio menu bar. Stylus Studio displays the DTD schema editor.

The Stylus Studio DTD editor provides two views of a DTD. In the Tree view, Stylus Studio uses branches and leaves to represent the DTD. When you define a DTD in the Tree view, you do not need to know the details about DTD syntax. In the Text view, Stylus Studio displays the lines of text that make up the DTD. To define a DTD in the Text view, you must be familiar with DTD syntax.

If you are editing an XML document and you want to create a DTD for that document, click the Schema tab. Stylus Studio displays the Schema Not Found dialog box. Indicate
that you want Stylus Studio to generate a DTD and indicate whether you want the new
DTD to be internal or external. After you respond to the prompts and click Yes, Stylus
Studio automatically creates the DTD for you and displays it in the Schema tab.

If you instruct Stylus Studio to create an internal DTD, you can update the DTD in the
XML editor. If you instruct Stylus Studio to create an external DTD, you must explicitly
open it to update it. An external DTD that Stylus Studio displays in the Schema tab is
read-only.

To use Stylus Studio to validate an XML document against a DTD, see “Validating XML
Documents”. If you update a DTD in Stylus Studio and that DTD is associated with an
XML document that is open in Stylus Studio, Stylus Studio refreshes the schema
information for the XML document.

About Editing DTDs

Stylus Studio displays a DTD with two views. Click the Text tab or the Tree tab to display
the view you want. The Tree tab displays a DOM-like tree that represents the DTD.

You can specify and edit the DTD in either view. However, the recommended method is
to edit the DTD in the Tree view. The Tree view provides tools tailored for creating a
DTD. The tool bar on the left provides a button for defining each node in a DTD. After
you select a node in the tree, the DTD editor allows you to add only those nodes that are
valid at that point.

Also, in the Tree view of the DTD, you can see the properties for each node. When you
click the node whose properties you want to view, the properties appear in the Properties
window. If the Properties window is not visible, select View > Properties from the menu
bar.

After you add a node, you can make changes in the Properties window, the Tree tab, or
the Text tab. Any changes you make in one place are immediately reflected in the other
places.

See “Defining Elements in DTDs” on page 605.

Restrictions

A DTD can include other, external DTDs. In a future release, it is expected that you will
be able to click Open Schema to display an included DTD. However, in this release,
this is not supported.
Defining Document Type Definitions

DTDs are not XML documents. Consequently, as you would expect, Indent XML Tags does not work on DTDs.

About Modifiers in Element Definitions in DTDs

When you define an element, you specify one or more modifiers. A modifier specifies a rule about the structure or occurrence of the element being defined. An element can have only one top-level modifier. However, you can add one or more modifiers to the top-level modifier. A modifier can aggregate elements or other modifiers.

This section discusses the following topics:

● Description of Element Modifiers in DTDs on page 602
● Simple Example of Aggregating Modifiers in DTDs on page 603
● More Complex Example of Aggregating Modifiers in DTDs on page 604
● Aggregating Modifiers to Allow Any Order and Any Number in DTDs on page 604

Description of Element Modifiers in DTDs

Table 59 describes the available modifiers:

<table>
<thead>
<tr>
<th>Modifier</th>
<th>Description</th>
<th>Indicator in DTD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>This element can appear once or not at all. (0 or 1)</td>
<td>Question mark (?)</td>
</tr>
<tr>
<td>Zero or more</td>
<td>This element is optional and repeatable. (0, 1, or more)</td>
<td>Asterisk (*)</td>
</tr>
<tr>
<td>One or more</td>
<td>This element is required and repeatable. (1 or more)</td>
<td>Plus sign (+)</td>
</tr>
</tbody>
</table>
About Modifiers in Element Definitions in DTDs

Table 59. Element Modifiers

<table>
<thead>
<tr>
<th>Modifier</th>
<th>Description</th>
<th>Indicator in DTD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice</td>
<td>Exactly one of the specified subelements must appear.</td>
<td>Vertical bar (</td>
</tr>
<tr>
<td>Sequence</td>
<td>If no other modifiers are defined on the Sequence modifier, each subelement in this element must appear exactly once. In other words, it is required. Also, the subelements must appear in the order in which they are specified in the referencing element. You can define other modifiers on the Sequence modifier. In this way, you can specify that some subelements are optional, some appear zero or more times, and some appear one or more times.</td>
<td>Comma (,)</td>
</tr>
</tbody>
</table>

Simple Example of Aggregating Modifiers in DTDs

Suppose you want a book element to always contain exactly one title element and any number of author elements. The title and author elements contain only raw data. To accomplish this, you would perform steps that generate the following tree representation:

```xml
<book>
  <Sequence>
    <title>One or More</title>
    <author>
      <title>Zero or More</title>
      <author>Zero or More</author>
    </author>
  </Sequence>
</book>
```

In the book element definition, Sequence modifies book and One or More modifies Sequence. Because the title element immediately follows the Sequence modifier, the default occurrence rule is assumed. That is, the title element must appear exactly once. In the Text view of the DTD, the definition for the book element is as follows:

```
<!ELEMENT book (title, (author)+)>
```
More Complex Example of Aggregating Modifiers in DTDs

Following is a more complicated example. Suppose you want book elements to include

- Exactly one title
- Either an author or an editor, but it is okay if neither appear
- Zero or more paragraphs

To accomplish this, you would perform steps that generate the following tree representation:

```
book
  Sequence
    title
    Optional
      Choice
        author
        editor
      Zero or More
        paragraph
```

In the Text view of the DTD, the definition for the book element is as follows:

```
<!ELEMENT book (title, (author|editor)?, paragraph*)>
```

Aggregating Modifiers to Allow Any Order and Any Number in DTDs

The Choice modifier specifies that only one of the specified elements can appear in an instance document. However, if you specify the Zero or More modifier and then the Choice modifier, the result is that the specified elements can appear in any order and each element can appear any number of times.

The text for such an element definition is as follows:

```
<!ELEMENT A (B|C|D)*> 
```
Defining Elements in DTDs

The tree representation is as follows:

```
A
  Zero or More
    Choice
      B
      C
      D
```

This allows an A element to contain

- Zero, one, or more B elements
- Zero, one, or more C elements
- Zero, one, or more D elements

Furthermore, the contained elements can be in any order.

Defining Elements in DTDs

You can define an element in the Text or Tree tab.

In the Text tab, you enter the text that defines your element and describes its structure. For example, to define a Catalog element that can contain one or more Publisher elements, followed by zero or more Thread elements, followed by one or more Book elements, you would enter the following:

```
<!ELEMENT Catalog ((Publisher)+,((Thread)*,(Book)+))>
```

When you define elements in the Text tab, you must know the syntax and keywords for what you want to define. This information is publicly available on the World Wide Web. Stylus Studio documentation does not include instructions for defining a DTD in the Text tab. For DTD information, see, http://www.w3.org/TR/REC-xml.

In the Tree tab, you click New Element Definition, and Stylus Studio takes care of the syntax and keywords. In the Tree tab, definition of an element requires that you

1. Create the element by specifying its name. To do this, see “Defining Elements in the DTD Tree Tab” on page 606, which is the first topic in this section.

2. Define the structure of the element by specifying modifiers, defining where raw data is allowed, and adding references to other elements. To help you do this, this section discusses the following topics:
Defining Document Type Definitions

- Specifying That an Element Can Have an Attribute in DTDs on page 607
- Specifying That an Element is Required in DTDs on page 607
- Specifying That an Element is Optional in DTDs on page 608
- Specifying That Multiple Instances of An Element Are Allowed in DTDs on page 609
- Specifying That An Element Can Contain One of a Group of Elements in DTDs on page 611
- Specifying That An Element Can Contain One or More Elements in DTDs on page 612
- Specifying That an Element Can Contain Data in DTDs on page 613
- Moving, Renaming, and Deleting Elements in DTDs on page 613

Defining Elements in the DTD Tree Tab

In the DTD editor, if the Tree view is not visible, click the Tree tab at the bottom of the window.

1. Click the DTD node at the top of the tree.

2. In the tool bar on the left, click New Element Definition. Stylus Studio displays a field for the new element at the end of the current contents of the DTD.

3. Type the name of the new element and press Enter. Stylus Studio displays the properties for the new element in the Properties window. If the Properties window is not visible, select View > Properties from the Stylus Studio menu bar. For example, suppose you specified title as the name of the new element. Your new element has the following properties:

   Table 60. Element Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Element</td>
</tr>
<tr>
<td>Name</td>
<td>title</td>
</tr>
<tr>
<td>Content Model</td>
<td>Empty</td>
</tr>
</tbody>
</table>

4. To change the value of a property, double-click the current value. For information about the properties that each element can have, see “About Node Properties in DTDs” on page 617.
Defining Elements in DTDs

After you create an element, you must define the structure of the contents of the element. The rest of the topics in this section provide information on how to define structure.

**Specifying That an Element Can Have an Attribute in DTDs**

1. Click the name of the element that you want to have an attribute.
2. In the menu bar on the left, click **New Attribute**.
3. Type the name of the attribute and press Enter.

**Specifying That an Element is Required in DTDs**

You specify that an element is required when you add a reference to that element in another element.

1. Define the element that you want to be required. See “Defining Elements in the DTD Tree Tab” on page 606.
2. Create the element that contains the element that you want to be required. This is the container element.
3. Click the container element name.
4. In the tool bar on the left, click **New Modifier**. Stylus Studio displays a drop-down menu.
5. Double-click **Sequence**.
6. If the required element can appear only once, skip this step. If the required element can appear more than once, click **New Modifier** and double-click **One or More** in the pop-up menu.
7. With the modifier highlighted, click **New Reference to Element** in the tool bar on the left.
8. Enter the name of the element that you want this element to reference.

After you add a reference to an element, you might want to check the definition of the referenced element. To do this, right-click the reference. In the shortcut menu, click **Go To Definition**. Stylus Studio moves the focus to the definition of the referenced element.

**Example 1**

For example, suppose the **title** element is required, and that it is relevant only in the context of a **book** element. When you define the **book** element, you specify that it contains the **title** element. If you specify only the **Sequence** modifier, the occurrence default is
assumed. The occurrence default is that there must be exactly one of the contained element. In other words, the title element is required and there can be only one. In this case, the definition of the book element is as follows:

```xml
<!ELEMENT book (title)>
```

The tree representation looks like this:

```xml
book
  Sequence
    title
```

Example 2

It is also possible for an element to be required and for more than one to be allowed. Suppose the book element must also contain at least one author element, but it can contain more than one author element. The definition of the book element is as follows:

```xml
<!ELEMENT book (title, author+)>  
```

The tree representation looks like this:

```xml
book
  Sequence
    title
    One or More
      author
```

### Specifying That an Element is Optional in DTDs

You specify that an element is optional when you add a reference to that element in another element. When an element is optional, it means that there can be one or none. If you want to specify that there can be none, one, or more, use the **Zero or More** modifier. See “Specifying That Multiple Instances of An Element Are Allowed in DTDs” on page 609.

1. Define the element that you want to be optional. See “Defining Elements in the DTD Tree Tab” on page 606.
2. Create the element that contains the element that you want to be optional. This is the container element.
3. Click the container element name.
4. In the tool bar on the left, click **New Modifier**. Stylus Studio displays a drop-down menu.
5. If the container element can contain only the optional element, skip this step. If the container element can contain more than one element, click \texttt{Sequence}.

6. Click \texttt{New Modifier}.

7. In the pop-up menu that appears, double-click \texttt{Optional}.

8. In the tool bar on the left, click \texttt{New Reference to Element} and enter the name of the optional element. If the container element can contain additional optional elements, repeat this step for each one.

After you add a reference to an element, you might want to check the definition of the referenced element. To do this, right-click the reference. In the shortcut menu, click \texttt{Go To Definition}. Stylus Studio moves the focus to the definition of the referenced element.

\textbf{Specifying That Multiple Instances of An Element Are Allowed in DTDs}

You specify that multiple instances of an element are allowed when you add a reference to that element in another element. When multiple instances of an element are allowed, you specify that there can be either

\begin{itemize}
  \item None, one, or more
  \item One or more
\end{itemize}

1. Define the element that can appear multiple times. See “Defining Elements in the DTD Tree Tab” on page 606.

2. Define the element that contains the element that can appear multiple times. This is the container element.

3. Click the container element name.

4. In the left tool bar, click \texttt{New Modifier} \texttt{.} Stylus Studio displays a drop-down menu.

5. If the container element can contain only one type of element, skip this step. If the container element can contain more than one type of element, double-click \texttt{Sequence} \texttt{,} and then click \texttt{New Modifier}.

6. Double-click \texttt{Zero or More} \texttt{to allow the container element to contain zero, one, or more instances of an element. Or, double-click One or More to allow the container element to contain one or more instances of an element.}

7. In the left tool bar, click \texttt{New Reference to Element} \texttt{and enter the name of the element that can appear multiple times. If the container element can contain}
Defining Document Type Definitions

additional types of elements, repeat this step for each one that can appear multiple times.

After you add a reference to an element, you might want to check the definition of the referenced element. To do this, right-click the reference. In the shortcut menu, click **Go To Definition**. Stylus Studio moves the focus to the definition of the referenced element.

Example 1

Suppose there are some elements that can appear zero, one, or more times, and there are other elements that can appear one or more times. The tree representation for this might look like the following:

```
book
  Sequence
    One or More
      Author
      Format
    Zero or More
      Award
      Review
```

In this example, an instance document must contain these elements in the following order:

```
author
format
award
review
```

Example 2

Suppose you want them in the following order:

```
review
format
award
author
```

In this case, the tree representation would look like this:

```
book
  Sequence
    Zero or More
      Award
    One or More
      Format
    Zero or More
      Review
    One or More
      Author
```
Specifying That An Element Can Contain One of a Group of Elements in DTDs

You might want to define an element that contains one element out of a group of elements. For example, you might want an InventoryNumber element to contain a book, magazine, or newsletter element.

1. Define the elements that your new element can contain. See “Defining Elements in DTDs” on page 605.

2. Define the element that you want to contain another element. This is the container element.

3. Click the container element name.

4. In the left tool bar, click New Modifier. Stylus Studio displays a drop-down menu.

5. Double-click Choice.

6. For each element in the group of elements from which one element can appear:
   a. Click New Reference to Element in the left tool bar.
   b. Type the name of the element and press Enter.

After you add a reference to an element, you might want to check the definition of the referenced element. To do this, right-click the reference. In the shortcut menu, click Go To Definition. Stylus Studio moves the focus to the definition of the referenced element.

When the XSLT processor validates an instance document against this DTD, it ensures that each instance of the new element you just defined contains exactly one of the referenced elements.

Example

The tree representation for an InventoryNumber element that can contain a book, magazine, or newsletter element would look like the following:

```
InventoryNumber
  Choice
    book
    magazine
    newsletter
```
Specifying That an Element Can Contain One or More Elements in DTDs

Often, you want an element to contain a sequence of elements. Some of these elements might be required, some might be optional, and some might be able to occur more than once. There might even be a group of elements in which only one can appear.

1. Define the elements that you want your new element to contain. See “Defining Elements in DTDs” on page 605.

2. Define the element that contains the sequence of elements. This is the container element.

3. Click the container element name.

4. In the left tool bar, click **New Modifier**. Stylus Studio displays a drop-down menu.

5. Double-click **Sequence**.

6. To add required elements to the container element, click **New Reference to Element** in the left tool bar and enter the name of the required element. Do this for each required element. You can change the order later.

   At this point, you can add

   - Optional elements
   - Elements that can appear one or more times
   - Elements that can appear zero, one, or more times
   - Elements that belong to a group in which only one element in the group can be present

   The procedure is the same for these modifiers. The only difference is the modifier you select. For example, following are the instructions for adding optional elements:

   1. In the DTD editor, click the **Sequence** modifier.

   2. In the left tool bar, click **New Modifier**.

   3. Double-click **Optional**.

   4. For each optional element, click **New Reference to Element** and enter the name of the optional element. This works only if you want all optional elements to be consecutive. If you want optional elements to be interspersed with required elements or elements that can appear one or more times, you must perform steps 1 through 4 for each element.

Modifying the Order

In an instance document, the contained elements must appear in the order in which they are specified in the DTD.
Defining Elements in DTDs

1. Click the modifier for the element you want to move.
2. Click the up or down arrow repeatedly until the element is where you want it to be.

To move a required element that can appear only once, click its name and then use the up and down arrows.

Alternative: Right-click the item you want to move. Select Move Up or Move Down from the shortcut menu.

Specifying That an Element Can Contain Data in DTDs

To specify that an element can contain raw data, you must first define the element. See Defining Elements in the DTD Tree Tab on page 606.

1. Click the element you want to contain data.
2. In the left tool bar, click New Modifier. Stylus Studio displays a drop-down menu.
3. Double-click Zero or More.
4. In the left tool bar, click Add $PCDATA.

Moving, Renaming, and Deleting Elements in DTDs

To move an element definition or a reference to an element, in the Tree tab, click the name of the element or the modifier for the reference. Then click Move Up or Move Down repeatedly until the element or reference is where you want it to be.

Alternative: Right-click the item you want to move. Select Move Up or Move Down from the shortcut menu that appears.

Rename
To rename an element or attribute, right-click it and select Rename from the shortcut menu that appears. Type the new name and press Enter.

Alternative: Click Change Name.

Delete
To delete a node in the DTD, right-click the node you want to delete. In the shortcut menu that appears, click Delete.

Alternative: Click Delete Node.
Defining General Entities and Parameter Entities in DTDs

In DTDs, an entity allows you to define a symbol for a value. In the Tree view, you can define general entities and parameter entities. The value of a general entity can be just about anything. It can be

- A short string that represents a longer string
- A way to include another marked-up file
- A reference to a graphical image
- A placeholder for some non-XML data or an expression that needs special formatting

General entities are useful for things that change often, such as the name of a product in development. An entity allows you to change the value in one place and have the corrected value appear everywhere it is needed.

See also “Description of Entity and Parameter Entity Properties in DTDs” on page 620.

When you define a general entity, you specify a symbol that you can use in instance documents. When the XML parser finds a reference to a general entity, it replaces the symbol with the value you specified when you defined the general entity.

When you define a parameter entity, you specify a symbol that you can use elsewhere in the DTD. Again, when the XML parser finds a reference to a parameter entity, it replaces the reference with the value you specified when you defined the parameter entity.

In a DTD, the definition of an entity must appear before a reference to that entity. Therefore, it is good practice to put all entity declarations at the beginning of a DTD.

This section discusses the following topics:

- Steps for Defining Entities in DTDs on page 614
- General Entity Example in a DTD on page 615
- Parameter Entity Example in a DTD on page 616

Steps for Defining Entities in DTDs

The procedures for defining general entities and parameter entities are almost the same.

1. Click the DTD node.

2. In the left tool bar, click New Entity or New Parameter Entity.
Defining General Entities and Parameter Entities in DTDs

3. Type the name of the new entity and press Enter. Stylus Studio displays the properties for the new entity in the Properties window. If the Properties window is not visible, select View > Properties from the Stylus Studio menu bar to display it.

4. In the Properties window, check the value of the Location property. If you want to define the value for this entity in this DTD, the value should be Internal. Otherwise, the value should be External. If you need to change the value of the Location property, double-click its current value. In the drop-down menu that appears, double-click the new value.

5. If the value of the Location property is External, skip this step. If the value of the Location property is Internal, double-click the Value field and enter the value of the entity. Definition of your entity is complete. You do not perform the remaining steps in this procedure.

6. If the value of the Location property is External, specify a value for System ID. Double-click the field to enter a value. The value of System ID is a path to a file. It can be a URL or a file system path. Although you can also specify a value for the Public ID property, Stylus Studio ignores any value you specify. A Public ID is a string that some parsers can resolve to an address, which they then use to locate a file. Stylus Studio does not have this capability.

7. If you are defining a parameter entity, you are done. If you are defining a general entity, check the value of the Parsed property. If necessary, double-click the value of the Parsed property to change it. The value of the Parsed property indicates whether the value of the entity is parsed XML. For example, if the entity refers to an image file, you do not want Stylus Studio to try to parse it.

General Entity Example in a DTD

Suppose you define the shopname general entity as an internal entity with the value Most Excellent Book Store of Tokyo. In the Text view of the DTD, this appears as follows:

```xml
<!ENTITY shopname "Most Excellent Book Store of Tokyo”>
```

In an instance document, when the XML parser finds &shopname;, it replaces it with Most Excellent Book Store of Tokyo.
Defining Document Type Definitions

Parameter Entity Example in a DTD

Suppose you define the invoice parameter entity as an internal entity as follows:

```xml
<!ENTITY % customer "name, street, city, state, zipcode">
```

The percent sign (%) after the ENTITY keyword indicates that this is a parameter entity. Later in the DTD, you can reference this parameter entity as follows:

```xml
<!ELEMENT invoice (%customer;, item, price, date)>
```

When this DTD is processed, it is as if you had specified the following:

```xml
<!ELEMENT invoice (name, street, city, state, zipcode, item, price, date)>
```

Inserting White Space in DTDs

Suppose you define some elements in the Tree tab. If you click the Text tab, you see that your DTD is on one long line. To make your DTD more readable, you can insert white space between elements. You cannot insert white space between the nodes that define an element.

1. Click the DTD node at the top of the schema.
2. In the tool bar on the left, click New Text.
3. Type a space and press Enter.
4. Click the up arrow to move the space to the desired location.

Adding Comments to DTDs

In a DTD, comments are useful for organizing the contents and clarifying the various parts of a DTD. A comment can appear between element, entity, or white space nodes. You can insert a comment in the middle of an element definition.

1. Click the DTD node at the top of the schema.
2. In the tool bar on the left, click New Comment.
3. Type your comment and press Enter.
4. Click the up arrow to move the comment to the desired location.
About Node Properties in DTDs

Each node in a DTD is associated with one or more properties. Every node has a Type property. The properties associated with a node vary according to the value of the Type property. Stylus Studio supports the following values for the Type property of a node in a DTD:

- Element
- Attribute
- DTD Modifier
- PCDATA
- Entity
- Parameter Entity
- Text
- Comment

To determine the properties for a particular node in a DTD, click the node. Stylus Studio displays the properties in the Properties window. If the Properties window is not visible, select View > Properties from the Stylus Studio menu bar.

To change a property, double-click the property value in the Properties window. Enter the new value or, if a drop-down menu appears, double-click the value you want. Any changes you make in the Properties window are immediately reflected in the Tree and Text views. You cannot change the type property of a node.

The remainder of this section discusses the following topics:

- Description of Element Properties in DTDs on page 617
- Description of Attribute Properties in DTDs on page 618
- Description of Entity and Parameter Entity Properties in DTDs on page 620

Description of Element Properties in DTDs

An element has three properties: Type, Name, and Content Model. The Name property is a string that identifies the element. The Content Model property describes the allowed
Defining Document Type Definitions

contents for the element. Table 61 describes the possible values of the Content Model property for Element nodes:

Table 61. Element Property Descriptions

<table>
<thead>
<tr>
<th>Value of Content Model Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty</td>
<td>This element can contain only attributes.</td>
</tr>
<tr>
<td>Element Only</td>
<td>This element can contain attributes and specified elements. It cannot directly contain raw data.</td>
</tr>
<tr>
<td>Mixed</td>
<td>This element can contain attributes, specified elements, and raw data.</td>
</tr>
<tr>
<td>Any</td>
<td>This element can contain attributes, any elements defined in this DTD, and raw data.</td>
</tr>
</tbody>
</table>

Description of Attribute Properties in DTDs

Table 62 shows the properties that an attribute can have. It also provides the possible values, and a description for each property.

Table 62. Attribute Property Descriptions

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowable Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Attribute</td>
<td>All attribute nodes have this type.</td>
</tr>
<tr>
<td>Name</td>
<td>String</td>
<td>Identifier for the particular attribute.</td>
</tr>
<tr>
<td>Restrictions</td>
<td>Fixed</td>
<td>The attribute is required and it must always have the value specified by the Default property. You must always explicitly specify this attribute.</td>
</tr>
<tr>
<td></td>
<td>Implied</td>
<td>The attribute is optional. There is no default value.</td>
</tr>
<tr>
<td></td>
<td>Optional</td>
<td>The attribute is optional. If you do not specify it, the XML parser uses the value of the Default property.</td>
</tr>
<tr>
<td></td>
<td>Required</td>
<td>The element must always explicitly specify this attribute and assign a value to it.</td>
</tr>
</tbody>
</table>
### Table 62. Attribute Property Descriptions

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowable Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Type</td>
<td>CDATA</td>
<td>The attribute value can contain any valid character data. It is a text string.</td>
</tr>
<tr>
<td>Entity</td>
<td></td>
<td>The attribute value is the name of an entity defined in the DTD.</td>
</tr>
<tr>
<td>Entities</td>
<td></td>
<td>The attribute value is a space-separated list of entities that are defined in the DTD.</td>
</tr>
<tr>
<td>Enumerated</td>
<td></td>
<td>The attribute value is one of a set of specified values. When the value of the Content Type property is Enumerated, the attribute has an additional property: Allowed Values. Specify the allowed values in a space-separated list.</td>
</tr>
<tr>
<td>ID</td>
<td></td>
<td>The attribute value is a unique name within the DTD.</td>
</tr>
<tr>
<td>IDREF</td>
<td></td>
<td>The attribute value is an ID that is defined in the DTD.</td>
</tr>
<tr>
<td>IDREFs</td>
<td></td>
<td>The attribute value is a space-separated list of IDs that are defined in the DTD.</td>
</tr>
<tr>
<td>NMToken</td>
<td></td>
<td>The attribute value is a valid XML name that is composed of letters, numbers, hyphens, underscores, and colons.</td>
</tr>
<tr>
<td>NMTokens</td>
<td></td>
<td>The attribute value is a space-separated list of name tokens.</td>
</tr>
<tr>
<td>Notation</td>
<td></td>
<td>The name of a notation specified in the DTD. The notation describes a non-XML data format, such as those used for image files. When the value of the Content Type property is Notation, the attribute has an additional property: Allowed Values. Specify the allowed values in a space-separated list.</td>
</tr>
</tbody>
</table>
Description of Entity and Parameter Entity Properties in DTDs

Table 63 shows the properties that an entity or parameter entity can have. It also provides the possible values, and a description for each property.

**Table 63. Entity and Parameter Entity Property Descriptions**

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowable Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Entity, Parameter Entity</td>
<td>All entity nodes have this type.</td>
</tr>
<tr>
<td>Name</td>
<td>String</td>
<td>Identifier for this entity.</td>
</tr>
<tr>
<td>Location</td>
<td>External or Internal</td>
<td>An external location indicates that the value of the entity is in a file that is outside the DTD file. An internal location indicates that the value of the entity is defined in the Value property of this entity node.</td>
</tr>
<tr>
<td>Value</td>
<td>String</td>
<td>If the value of the Location property is Internal, this property specifies the value of the entity. If the value of the Location property is External, you cannot specify this property.</td>
</tr>
<tr>
<td>Public ID</td>
<td>String</td>
<td>String that some parsers can resolve to a file location. Stylus Studio ignores any value you specify.</td>
</tr>
<tr>
<td>System ID</td>
<td>String</td>
<td>Path or URI for a file that contains the value of the entity.</td>
</tr>
<tr>
<td>Parsed</td>
<td>True or False</td>
<td>Indicates whether the entity value is parsed XML. A parameter entity does not have this property.</td>
</tr>
</tbody>
</table>
Associating an XML Document with an External DTD

To associate an XML document with an external DTD, add a **DOCTYPE** element to the beginning of your XML document. The **DOCTYPE** element should be immediately after the XML declaration element. The format of the **DOCTYPE** element is

```xml
<!DOCTYPE root_element_name SYSTEM "path_to_dtd">
```

Replace `root_element_name` with the name of the root element in your XML document. Replace `path_to_dtd` with the path for the DTD you want your document to use.

Moving an Internal DTD to an External File

1. In the **Text** tab of the DTD editor, in the **DOCTYPE** element, select only the text inside the brackets `[]`.
2. Cut the text.
3. Select **File > New > DTD Schema** from the menu bar.
4. Paste the text in the new DTD schema file that Stylus Studio displays.
5. Save the file. You might want to save the DTD in the same directory as the XML document that uses it.
6. In your XML document in the **Text** tab of the DTD editor, remove the brackets and insert the following in their place:

```xml
SYSTEM "schema_file_path"
```

The path you specify can be the relative or absolute path of the DTD file you just saved. This path must be in quotation marks.
Chapter 9  Writing XPath Expressions

The XML Path Language (XPath) allows you to query an XML document using XPath expressions. An XPath expression returns a well-formed XML node-list or an XPath value object. Stylus Studio supports the November 2005 W3C XPath 2.0 Candidate Recommendation. XPath 2.0 is a superset of XPath 1.0.

This section discusses the following topics:

● “About the XPath Processor” on page 624
● “Using the XPath Query Editor” on page 627
● “Sample Data for Examples and Practice” on page 633
● “Getting Started with Queries” on page 637
● “Specifying the Nodes to Evaluate” on page 650
● “Handling Strings and Text” on page 664
● “Specifying Boolean Expressions and Functions” on page 671
● “Specifying Number Operations and Functions” on page 674
● “Comparing Values” on page 677
● “Finding a Particular Node” on page 682
● “Obtaining a Union” on page 689
● “Obtaining Information About a Node or a Node Set” on page 691
● “Using XPath Expressions in Stylesheets” on page 695
● “Accessing Other Documents During Query Execution” on page 699
● “XPath Quick Reference” on page 701
Writing XPath Expressions

About the XPath Processor

Stylus Studio supports the November 2005 W3C XPath 2.0 Candidate Recommendation. XPath 2.0 is a superset of XPath 1.0.

As an overview of the XPath processor, this section provides the following information:
- Where You Can Use XPath Expressions on page 624
- About XPath on page 624
- Benefits of XPath on page 625
- Internationalization on page 626
- Restrictions on Queries on page 626

For additional information about XPath see http://www.w3.org/TR/xpath20.

Where You Can Use XPath Expressions

You use XPath expressions in XQuery documents and XSLT stylesheets to select the nodes you want to transform and query. For example, you can specify queries as values of match and select attributes in stylesheets. You can use XPath 1.0 expressions in XQuery and XSLT 1.0, and XPath 2.0 expressions in XSLT 2.0.

You can also query XML documents using the XPath Query Editor. Stylus Studio displays the results in the Query Output window, Stylus Studio displays the result of the query.

About XPath

XPath is a notation for retrieving information from a document. The information could be a set of nodes or derived values.

XPath allows you to identify parts of an XML document. In addition, a subset of XPath allows you to test whether or not a node matches a particular pattern. XPath provides Boolean logic, filters, indexing into collections of nodes, and more.

XPath is declarative rather than procedural. You use a pattern modeled on directory notation to describe the types of nodes to look for. For example, book/author means find all author elements that are contained in book elements.

XPath provides a common syntax for features shared by Extensible Stylesheet Language Transformations (XSLT) and XQuery. XSLT is a language for transforming XML documents into XML, HTML, or text. XQuery builds on XPath and is a language for extracting information from XML documents.
The basic syntax for XPath mimics the Uniform Resource Identifier (URI) directory navigation syntax. However, the syntax does not specify navigation through a physical file structure. The navigation is through elements in the XML tree.

**Benefits of XPath**

XPath is designed for XML documents. It provides a single syntax that you can use for queries, addressing, and patterns. XPath is concise, simple, and powerful. XPath has many benefits, as follows:

- Queries are compact.
- Queries are easy to type and read.
- Syntax is simple for the simple and common cases.
- Query strings are easily embedded in programs, scripts, and XML or HTML attributes.
- Queries are easily parsed.
- You can specify any path that can occur in an XML document and any set of conditions for the nodes in the path.
- You can uniquely identify any node in an XML document.
- Queries return any number of results, including zero.
- Query conditions can be evaluated at any level of a document and are not expected to navigate from the top node of a document.
- Queries do not return repeated nodes.
- For programmers, queries are declarative, not procedural. They say what should be found, not how it should be found. This is important because a query optimizer must be free to use indexes or other structures to find results efficiently.
- XPath is designed to be used in many contexts. It is applicable to providing links to nodes, for searching repositories, and for many other applications.

When you define a query, keep in mind that XML data can be represented as a tree. A tree is a hierarchical representation of XML data. The root node is the top of the tree. Each element, attribute, text string, comment, and processing instruction corresponds to one node in the tree. A tree also shows the relationships among the nodes. For more information on tree structure, see “Tree Representation of a Sample XML Document” on page 634.
**Writing XPath Expressions**

**Internationalization**

Queries can contain non-Latin characters.

**Restrictions on Queries**

XPath is a language for selecting existing XML data; it does not perform manipulation (like sorting) or construction of different XML structures. To perform such operations, you need to use the language that is hosting XPath – XSLT or XQuery, for example.

You cannot query non-XML data. If you query a document that does not contain XML-formatted data, Stylus Studio displays an error message that informs you that the queried text is not XML.
Using the XPath Query Editor

The XPath Query Editor is a dockable window that you can use to query XML documents in Stylus Studio. An example, showing an XPath expression being evaluated against books.xml from the Example project installed with Stylus Studio, is shown here:

![Image of XPath Query Editor]

**Figure 298. XPath Query Editor**

**Parts of the XPath Query Editor**

The XPath Query Editor consists of

- A *query pane*, in which you enter the XPath you want to execute against the current document. The query pane allows you to enter queries with multiple lines.
Writing XPath Expressions

The query pane supports Stylus Studio’s Sense:X feature, which provides tool-tips for XPath expressions and auto-completion for XML documents associated with an XML Schema, as shown here:

![Sense:X Auto-completion in XPath Query Editor](image)

- A results pane, which shows the results from the query after you execute it. Results are shown as a number of hits and include the type of XML tag and value of each hit. When you click on a returned node, Stylus Studio moves the cursor in the XML document to the source node for the returned node.
- A namespace pane, which allows you to redefine the namespace prefix to be used in the query. The namespace pane is not displayed by default, and is not shown in Figure 298.

Displaying the XPath Query Editor

The XPath Query Editor is not displayed by default. In addition, it is closed when you exit the XML document with which it is associated.

- Click the **Show XPath Query Editor** button on the XML Editor tool bar ( ).
  The XPath Query Editor appears. Any previously created queries are displayed on individual tabs. If no queries have been created, a new tab, labeled *Query1*, is displayed.

  *Alternative:*
  - Select **View > XPath Query Editor** from the Stylus Studio menu.
Customizing Syntax Coloring

The XPath Query Editor uses Stylus Studio’s syntax coloring, and you can change the default settings for several XPath Query Editor properties on the Editor Format page of the Options dialog box. These settings affect tokens in XPath expressions, such as errors, strings, keywords, operators, and attributes.

1. Click Tools > Options > General > Editor Format to display the Editor Format page of the Options dialog box.
   The Options dialog box appears.

2. Scroll the Colors list; fields related to the XPath Query Editor are prefixed with XPath.

3. Use the palette to change the color of the tokens as desired.

4. Click OK.

Working with XPath Queries

When you display the XPath Query Editor, an empty query is created for you. The query name, Query1, is displayed on a tab in the XPath Query Editor window. You can start typing the XPath expression on the first line in the editing pane; use the Enter key to move the cursor to a new line.

Tip  Line numbers are displayed in the editing pane if you have enabled them for XML documents. Click Tools > Options > General > Editor General to change this setting.

You can create up to sixty-four queries for a single document; each is given the name Queryn, where n is a unique number incremented by one. You cannot name queries.

Queries are saved with the project. Changes you make – either to query expressions, or creating and deleting queries – are saved when you save the project, and not the document.

Executing the Query

- Click the Execute button on the XPath Query Editor tool bar ( ).

  Stylus Studio processes the query and displays the result in the results pane.
Writing XPath Expressions

Alternatives:
- Press F5.
  
or
- Right-click the query panel in the XPath Query Editor and select **Execute Query** from the short cut menu.

Creating a New Query
- Click the **New XPath Query** button on the XPath Query Editor tool bar ( ).
  
  A new tab appears in the XPath Query Editor.

**Alternative:**
- Right-click the query panel in the XPath Query Editor and select **New XPath Query** from the short cut menu.

Deleting a Query
- Click the **Delete** button on the XPath Query Editor tool bar ( ).
  
  The tab associated with the query is removed from the XPath Query Editor. The query itself is deleted when you save the project.

**Alternative:**
- Right-click the query panel in the XPath Query Editor and select **New XPath Query** from the short cut menu.
Working with Query Results

Query results are shown in the XPath Query Editor in the results pane as a number of hits and include the type of XML tag and value of each hit, as shown here.

When you click on a result node, Stylus Studio’s back-mapping feature highlights the line in the XML document that supplied the value for the result node you selected.

Opening Query Results as a New Document

After you have executed a query, you can optionally choose to display the query result in a new XML document. If the result contains only elements, Stylus Studio creates a root element (named `<xqr:xpath-query-result>`) to ensure that the document is well-formed.

Execute the query, and then

- Click the Open result in a new XML document button on the XPath Query Editor toolbar.
Alternative:

- Right-click the query pane in the XPath Query Editor and select **Open result in a new XML document** from the shortcut menu.

## Working with Namespaces

When the XML document you are querying has references to one or more namespaces, those namespaces are displayed in the namespace pane, as shown here:

![Namespaces Pane](image)

**Figure 301. Namespaces Pane**

In addition to the namespace URI, Stylus Studio displays the namespace prefix defined in the XML document. If one namespace prefix defined in the XML document clashes with another, the second prefix is redefined by adding a number to the end of the original prefix name to make it unique – for example, if two namespaces had the prefix `myPrefix`, the second would be redefined as `myPrefix1`. Namespace prefixes are redefined only in the context of the XPath Query Editor; namespace definitions in the XML document are unaffected.

You must use redefined namespace prefixes when writing your query expressions, though you can specify your own redefined name if you like.

Redefined namespaces

- Allow you to execute the query with the root node of the document as the current context node
- Simplify the process of entering XPath expressions in the query pane

Changes saved to the XML document are reflected in the namespace pane when you click on the namespace pane or query pane.
1. Click the Show Namespaces button ( ) if the namespace pane is not already displayed.

The namespace pane shows any namespaces that have been defined for the current XML document, as well as the namespace prefix defined in the document and the redefined namespace prefix suggested by Stylus Studio.

2. Optionally, change the value in the Redefined Prefix field.

Sample Data for Examples and Practice

The best way to learn how to query data is to practice using XPath. To prepare you for practicing with XPath queries, this section provides a review of the basic structure of an XML document. An understanding of this structure is crucial to defining queries that return the data you want. Following the review, this section includes the XML data on which the query examples operate. The last part of this section provides instructions for running queries on sample data.

The topics in this section include

- “About XML Document Structure” on page 633
- “A Sample XML Document” on page 634
- “Tree Representation of a Sample XML Document” on page 634
- “Steps for Trying the Sample Queries” on page 636

About XML Document Structure

The XPath processor operates on a tree representation of XML data that looks like the following figure:

![XML Document Structure Diagram]

---

Stylus Studio® 2006 User Guide 633
Writing XPath Expressions

The root node has no actual text associated with it. You can think of the file name as the root node. A document can include zero or more comments and zero or more processing instructions.

A document element is required, and there can be only one. The document element contains all elements in the document. For example:

```
<bookstore>
  <!-- This file represents a .... -->
  <bookstore>
    <book>
      <magazine>
        specialty="novel"
      </magazine>
    </book>
  </bookstore>
</bookstore>
```

In the preceding figure, `bookstore.xml` is the name of a file that contains XML data. There is a comment near the beginning of the document that starts with "This file represents a ...." The document element is `bookstore`. The immediate children of `bookstore` include an attribute, a namespace declaration (not supported by Stylus Studio), three `book` elements (one is in the `my` namespace), and a `magazine` element. The `book` and `magazine` elements contain elements and attributes, which are shown in the figure that appears in “Tree Representation of a Sample XML Document” on page 634.

A Sample XML Document

The examples in this section are based on the following XML data. This data is in the `bookstore.xml` file, which is in the `examples` directory of your installation directory.

Tree Representation of a Sample XML Document

When you query a document, it can be helpful to think of a tree representation of your data. A tree that represents the `bookstore.xml` document appears in Figure 302 (and is
Sample Data for Examples and Practice

continued in Figure 303). To use Stylus Studio to view a similar tree for any XML document, open the XML document in Stylus Studio and select the Tree tab.

Figure 302. Tree Display of an XML Document
Steps for Trying the Sample Queries

To try the queries in this section, or any other queries you want to run on the bookstore.xml document, follow these instructions:

1. In Stylus Studio, open bookstore.xml. You can find it in the examples directory of your installation directory.

2. At the top of the window that contains bookstore.xml, highlight <Type a new query>.
3. Type a query. For example: /bookstore/book/author.
4. Press Enter or click Refresh Query.

Stylus Studio displays the results in the Query Output window.

**Getting Started with Queries**

This section provides information to get you started using queries. It does not provide complete information about how to define a query. Instead, it provides instructions for defining typical queries you might want to run. There are numerous cross-references to later sections that provide complete information about a particular query construct.

The topics discussed in this section include
- “Obtaining All Marked-Up Text” on page 637
- “Obtaining a Portion of an XML Document” on page 638
- “Obtaining All Elements of a Particular Name” on page 639
- “Obtaining All Elements of a Particular Name from a Particular Branch” on page 640
- “Different Results from Similar Queries” on page 641
- “Queries That Return More Than You Want” on page 641
- “Specifying Attributes in Queries” on page 642
- “Filtering Results of Queries” on page 643
- “Wildcards in Queries” on page 646
- “Calling Functions in Queries” on page 647
- “Case Sensitivity and Blank Spaces in Queries” on page 648
- “Precedence of Query Operators” on page 649

**Obtaining All Marked-Up Text**

When you query a document, you do not usually want to obtain all marked-up text. However, an understanding of queries that return all marked-up text makes it easier to define a query that retrieves just what you want.
Writing XPath Expressions

The following figure shows a complete query (/bookstore) and the way the XPath processor interprets it:

```
/bookstore
  Start at the root node.
  Search immediate children and return the bookstore element.
```

This query returns the bookstore element. Because the bookstore element is the document element, which contains all elements and attributes in the document, this query returns all marked-up text.

In the query, the initial forward slash (/) instructs the XPath processor to start its search at the root node.

Suppose you run the following query on bookstore.xml:

```
/book
```

This query returns an empty set. It searches the immediate children of the root node for an element named book. Because there is no such element, this query does not return any marked-up text. Note that this query does not return an error. The query runs successfully, but the XPath processor does not find any elements that match the query. All book elements are grandchildren of the root node, and the XPath processor only checks the children of the root node.

Obtaining a Portion of an XML Document

Usually, you use a query to obtain a portion of an XML document. To obtain the particular elements that you want, you must understand how to obtain an element that is a child of the document element. With this information, you can obtain any elements in the document.
The following figure shows how the XPath processor interprets the `/bookstore/book` query:

When the XPath processor starts its search at the root node, there is only one element among the immediate children of the root node. This is the document element. In this example, `bookstore` is the document element.

The query in this figure returns the `book` elements that are children of `bookstore`. This query does not return the `my:book` element, which is also a child of `bookstore`.

Now you can define queries that obtain any elements you want. For example:

```
/bookstore/book/title
```

This query returns `title` elements contained in `book` elements that are contained in `bookstore`.

### Obtaining All Elements of a Particular Name

Sometimes you want all like-named elements regardless of where they are in a document. In this case, you do not need to start at the root node and navigate to the elements you want.

For example, the following query returns all `last-name` elements in any XML document:

```
//last-name
```

The double forward slash (`//`) at the beginning of a query instructs the XPath processor to start at the root node and search the entire document. In other words, the XPath processor searches all descendents of the root node.

If you perform this query on `bookstore.xml`, it returns the `last-name` elements that are children of `author` elements, and it also returns the `last-name` element that is a child of a `publication` element.
Obtaining All Elements of a Particular Name from a Particular Branch

Although sometimes you might want all like-named elements wherever they are in a document, other times you might want only those like-named elements from a particular part of the document (branch of the tree).

For example, you might want all price elements contained in book elements, but not price elements contained in magazine elements. The query is to return such a result is:

```
/bookstore/book//price
```

This query returns all price elements that are contained in book elements. Some of these price elements are immediate children of book elements. One returned price element is a great-grandchild of the second book element. The following figure shows how the XPath processor interprets this query:

![XPath Processor Diagram]

1. Start at the root node.
2. Search immediate children for the bookstore.
3. This is a step separator.
5. Search all book elements and all descendants of all book elements.
6. For each node that is searched, search its children for price elements.
7. Return any price elements.
Different Results from Similar Queries

Some queries can look very similar but return very different results. The following figure shows this.

Queries That Return More Than You Want

Suppose you want the titles of all the books. You might decide to define your query like this:

```
/title
```

This query does return all titles of books, but it also returns the title of a magazine. This query instructs the XPath processor to start at the root node, search all descendants, and return all title elements. In bookstore.xml, this means that the query returns the title of the magazine in addition to the titles of books. In some other document, if all titles are contained in book elements, this query returns exactly what you want.

To query and obtain only the titles of books, you can use either of the following queries. They obtain identical results. However, the first query runs faster.

```
/bookstore/book/title
```

```
//book/title
```

The first query runs faster because it uses the child axis, while the second query uses the descendant-or-self axis. In general, the simpler axes, such as child, self, parent, and
Writing XPath Expressions

ancestor, are faster than the more complicated axes, such as descendant, preceding, following, preceding-sibling, and following-sibling. This is especially true for large documents. Whenever possible, use a simpler axis.

Specifying Attributes in Queries

To specify an attribute name in a query, precede the attribute name with an at sign (@). The XPath processor treats elements and attributes in the same way wherever possible. For example:

```xml
//@style
```

This query returns the style attributes associated with the magazine, the three books, and the my:book element. That is, it returns all the style attributes in the document. It does not return the elements that contain the attributes.

Following is another query that includes an attribute:

```xml
/bookstore/book/@style
```

This query returns the three style attributes for the three book elements.

The following query returns the style attribute of the context node:

```xml
@style
```

If the context node does not have a style attribute, the result set is empty.

The next query returns the exchange attribute on price elements in the current context:

```xml
price/@exchange
```

Following is an example that is not valid because attributes cannot have subelements:

```xml
price/@exchange/total
```

Following is a query that finds the style attribute for all book elements in the document:

```xml
//@style
```
Restrictions

Attributes cannot contain subelements. Consequently, you cannot apply a path operator to an attribute. If you try to, you receive a syntax error.

Attributes are inherently unordered. Consequently, you cannot apply a position number to an attribute. If you try to, you receive a syntax error.

Attributes and Wildcards

You can use an at sign (@) and asterisk (*) together to retrieve a collection of attributes. For example, the following query finds all attributes in the current context:

```xml
@*
```

Filtering Results of Queries

Sometimes you want to retrieve only those elements that meet a certain condition. For example, you might want information about a particular book. In this case, you can include a filter in your query. You enclose filters in brackets ( [ ] ).

The following figure shows how the XPath processor interprets a query with a filter:

This query checks each book element to determine whether it has a `title` child element whose value is "History of Trenton". If it does, the query returns the book element. Using the sample data, this query returns the second book element.

The following topics provide details about filters:

- “Quotation Marks in Filters” on page 644
- “More Filter Examples” on page 644
- “How the XPath Processor Evaluates a Filter” on page 645
Writing XPath Expressions

- “Multiple Filters” on page 645
- “Filters and Attributes” on page 646

Quotation Marks in Filters

Suppose you define the following filter:

```
<title="History of Trenton"]
```

If you need to specify this filter as part of an attribute value, use single quotation marks instead of double quotation marks. This is because the attribute value itself is (usually) inside double quotation marks. For example:

```
<xsl:value-of select="/bookstore/book[title='History of Trenton']"/>
```

Strings within an expression may contain special characters such as [, {, &, ‘, /, and others, as long as the entire string is enclosed in double quotes ("). When the string itself contains double quotes, you may enclose it in single quotes (‘). When a string contains both single and double quotes, you must handle these segments of the string as if they were individual phrases, and concatenate them.

More Filter Examples

Following is another example of a query with a filter clause. This query returns book elements if the price of the book is greater than 25 dollars:

```
/bookstore/book[price > 25]
```

The next query returns author elements if the author has a degree:

```
//author[degree]
```

The next query returns the date attributes that match "3/1/00":

```
//@date[.='3/1/00']
```

The next query returns manufacturer elements in the current context for which the rwdrive attribute of the model is the same as the vendor attribute of the manufacturer:

```
manufacturer[model/@rwdrive = @vendor]
```
How the XPath Processor Evaluates a Filter

You can apply constraints and branching to a query by specifying a filter clause. The filter contains a query, which is called the subquery. The subquery evaluates to a Boolean value, or to a numeric value. The XPath processor tests each element in the current context to see if it satisfies the subquery. The result includes only those elements that test true for the subquery.

The XPath processor always evaluates filters with respect to a context. For example, the expression book[author] means for every book element that is found in the current context, determine whether the book element contains an author element. For example, the following query returns all books in the current context that contain at least one excerpt:

\[
\text{book[excerpt]}
\]

The next query returns all titles of books in the current context that have at least one excerpt:

\[
\text{book[excerpt]/title}
\]

Multiple Filters

You can specify any number of filters in any level of a query expression. Empty filters ( [ ] ) are not allowed.

A query that contains one or more filters returns the rightmost element that is not in a filter clause. For example:

\[
\text{book[excerpt]/author[degree]}
\]

The previous query returns author elements. It does not return degree elements. To be exact, this query returns all authors who have at least one degree if the author is of a book for which the document contains at least one excerpt. In other words, for all books in the current context that have excerpts, this query finds all authors with degrees.

The following query finds each book child of the current context that has an author with at least one degree:

\[
\text{book[author/degree]}
\]

The next query returns all books in the current context that have an excerpt and a title:

\[
\text{book[excerpt][title]}
\]
Filters and Attributes

Following is a query that finds all child elements of the current context with `specialty` attributes:

```
*[specialty]
```

The following query returns all `book` children in the current context with `style` attributes:

```
book[style]
```

The next query finds all `book` child elements in the current context in which the value of the `style` attribute of the `book` is equal to the value of the `specialty` attribute of the `bookstore` element:

```
book/[bookstore/@specialty = @style]
```

Wildcards in Queries

In a query, you can include an asterisk (*) to represent all elements. For example:

```
/bookstore/book/*
```

This query searches for all `book` elements in `bookstore`. For each `book` element, this query returns all child elements that the `book` element contains.

The * collection returns all elements that are children of the context node, regardless of their tag names.

The next query finds all `last-name` elements that are grandchildren of `book` elements in the current context:

```
book/*/last-name
```

The following query returns the grandchild elements of the current context.

```
/*/*
```

Restrictions

Usually, the asterisk (*) returns only elements. It does not return processing instructions, attributes, or comments, nor does it include attributes or comments when it maintains a
count of nodes. For example, the following query returns title elements. It does not return style attributes.

\[
\text{/bookstore/book/*[1]}
\]

Wildcards in strings are not allowed. For example, you cannot define a query such as the following:

\[
\text{/bookstore/book[author=" A* "]}
\]

**Attributes**

To use a wildcard for attributes, you can specify @*. For example:

\[
\text{/bookstore/book/@*}
\]

For each book element, this query returns all attributes. It does not return any elements.

**Calling Functions in Queries**

The XPath processor provides many functions that you can call in a query. This section provides some examples to give you a sense of how functions in queries work. Many subsequent sections provide information about invoking functions in queries. For a complete list of the functions you can call in a query, see “XPath Functions Quick Reference” on page 702.

Following is a query that returns a number that indicates how many book elements are in the document:

\[
\text{count(/book)}
\]

In format descriptions, a question mark that follows an argument indicates that the argument is optional. For example:

\[
\text{string substring(string, number, number?)}
\]

This function returns a string. The name of the function is substring. This function takes two required arguments (a string followed by a number) and one optional argument (a number).
Case Sensitivity and Blank Spaces in Queries

Queries are case sensitive. This applies to every part of the query, including operators, strings, element and attribute names, and function names.

For example, suppose you try this query:

```xml
/Bookstore
```

This query returns an empty set because the name of the document element is `bookstore` and not `Bookstore`.

Blank spaces in queries are not significant unless they appear within quotation marks.
Precedence of Query Operators

The precedence of query operators varies for XPath 1.0 and XPath 2.0, as shown in the following tables. In these tables, operators are listed in order of precedence, with highest precedence being first; operators in a given row have the same precedence.

Table 64. Query Operator Precedence – XPath 1.0

<table>
<thead>
<tr>
<th>Operation Type</th>
<th>XPath Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grouping</td>
<td>( )</td>
</tr>
<tr>
<td>Filter</td>
<td>[ ]</td>
</tr>
<tr>
<td>Unary minus</td>
<td>-</td>
</tr>
<tr>
<td>Multiplication</td>
<td>*, div, mod</td>
</tr>
<tr>
<td>Addition</td>
<td>+, -</td>
</tr>
<tr>
<td>Relational (Comparison)</td>
<td>= != &lt; &lt;= &gt; &gt;=</td>
</tr>
<tr>
<td>Union</td>
<td></td>
</tr>
<tr>
<td>Negation</td>
<td>not</td>
</tr>
<tr>
<td>Conjunction</td>
<td>and</td>
</tr>
<tr>
<td>Disjunction</td>
<td>or</td>
</tr>
</tbody>
</table>

Table 65. Query Operator Precedence – XPath 2.0

<table>
<thead>
<tr>
<th>Operation Type</th>
<th>XPath Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence separator</td>
<td>,</td>
</tr>
<tr>
<td>Conjunction</td>
<td>and</td>
</tr>
<tr>
<td>Type matching</td>
<td>instance of</td>
</tr>
<tr>
<td>Assertion</td>
<td>treat</td>
</tr>
<tr>
<td>Conversion test</td>
<td>castable</td>
</tr>
<tr>
<td>Conversion</td>
<td>cast</td>
</tr>
</tbody>
</table>
Writing XPath Expressions

Consider the bookstore tree in the sample data. If you query the entire tree for all author elements, the result contains a number of author elements. If you query only one branch of the tree, the result contains only one author element. The result of the query depends on which nodes the XPath processor evaluates in the execution of the query.

This section discusses the following topics:

- “Understanding XPath Processor Terms” on page 651
- “Starting at the Context Node” on page 653
- “About Root Nodes and Document Elements” on page 653
- “Starting at the Root Node” on page 653
- “Descending Along Branches” on page 654
- “Explicitly Specifying the Current Context” on page 655
- “Specifying Children or Descendants of Parent Nodes” on page 656
- “Examples of XPath Expression Results” on page 656
- “Syntax for Specifying an Axis in a Query” on page 657

### Table 65. Query Operator Precedence – XPath 2.0

<table>
<thead>
<tr>
<th>Operation Type</th>
<th>XPath Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relational (Comparison)</td>
<td><code>eq, ne, lt, le, gt, ge, =, !=, &lt;, &lt;=, &gt;, &gt;=, is, &lt;&lt;, &gt;&gt;</code></td>
</tr>
<tr>
<td>Range</td>
<td><code>to</code></td>
</tr>
<tr>
<td>Addition</td>
<td><code>+, -</code></td>
</tr>
<tr>
<td>Multiplication</td>
<td><code>*, div, idiv, mod</code></td>
</tr>
<tr>
<td>Unary</td>
<td><code>unary -, unary +</code></td>
</tr>
<tr>
<td>Union</td>
<td>`union,</td>
</tr>
<tr>
<td>Select set</td>
<td><code>intersect, except</code></td>
</tr>
<tr>
<td>Navigation</td>
<td><code>/</code>, <code>//</code></td>
</tr>
<tr>
<td>Filter</td>
<td><code>[ ]</code></td>
</tr>
</tbody>
</table>
Specifying the Nodes to Evaluate

- “Supported Axes” on page 658
- “Axes That Represent the Whole XML Document” on page 663

Understanding XPath Processor Terms

To use the context operators, it is important to understand the following terms:

**Axis**

An axis specifies a list of nodes in relation to the context node. For example, the ancestor axis contains the ancestor nodes of the context node. The child axis contains the immediate children of the context node. See “Syntax for Specifying an Axis in a Query” on page 657.

**Context Node**

A context node is the node the XPath processor is currently looking at. The context node changes as the XPath processor evaluates a query. If you pass a document to the XPath processor, the root node is the initial context node. If you pass a node to the XPath processor, the node that you pass is the initial context node. During evaluation of a query, the initial context node is also the current node.

**Context Node Set**

A context node set is a set of nodes that the XPath processor evaluates.

**Current Node**

Current node is the node that the XPath processor is looking at when it begins evaluation of a query. In other words, the current node is the first context node that the XPath processor uses when it starts to execute the query. During evaluation of a query, the current node does not change. If you pass a document to the XPath processor, the root node is the current node. If you pass a node to the XPath processor, that node is the current node.

**Document Element**

The document element is the element in a document that contains all other elements. The document element is an immediate child of the root node. When you obtain the document element of a document, you obtain all marked-up text in that document.
Writing XPath Expressions

**Filter**

A *filter* in a query specifies a restriction on the set of nodes to be returned. For example, the filter in the following query restricts the result set to book elements that contain at least one excerpt element:

```
book[excerpt]
```

**Location Path Expression**

A *location path expression* is an XPath expression. It has the following format:

```
[/*]LocationStep[/LocationStep]...
```

**Location Step**

An XPath expression consists of one or more *location steps*. A location step has the following format:

```
[axis::]node_test[[filter] [filter]...]
```

**Node Test**

You apply a *node test* to a list of nodes. A node test returns nodes of a particular type or nodes with a particular name. For example, a node test might return all comment nodes, or all book elements.

**Root Node**

The *root node* is the root of the tree. It does not occur anywhere else in the tree. The document element node for a document is a child of the root node. The root node also has as children processing instructions and comment nodes representing processing instructions and comments that occur in the prolog and after the end of the document element.
Specifying the Nodes to Evaluate

Starting at the Context Node

Following is a query that looks for all child author elements in the current context:

```
author
```

This query is simply the name of the element you want to search for. If the context node is any one of the book elements, this query returns one author element. If the context node is any other node, this query returns the empty set.

About Root Nodes and Document Elements

A root node is the topmost node in the tree that represents the contents of an XML document. The root node can contain comments, a declaration, and processing instructions, as well as the document element. The document element is the element that contains all other elements; that is, the document element contains elements that are in the document but that are not immediate children of the root node.

Starting at the Root Node

To specify that the XPath processor should start at the root node when it evaluates nodes for a query, insert a forward slash (/) at the beginning of the query.

In an XML document, there is no text that corresponds to the root node. Externally, a root node is really a concept. Internally, there are data structures that represent this concept, but there is no text that you can point to and call a root node.

The following query instructs the XPath processor to start at the root node, as indicated by the forward slash at the beginning of the query.

```
/bookstore
```

This query searches the children of the root node for a bookstore element. Because the name of the document element is bookstore, the query returns it. If the name of the document element is not bookstore, this query returns an empty set.

The following query returns the entire document, starting with the root node. As you can see, the entire query is just a forward slash:

```
/
```
Writing XPath Expressions

This query returns everything — comments, declarations, processing instructions, the document element, and any elements, attributes, comments, and processing instructions that the document element contains.

**Descending Along Branches**

Sometimes you want the XPath processor to evaluate all nodes that are descendants of a node and not just the immediate children of that node. This amounts to operating on a branch of the tree that forms the document.

To specify the evaluation of descendants that starts at the root node, insert two forward slashes (//) at the beginning of a query.

To specify the evaluation of descendants that starts at the context node, insert a dot and two forward slashes (.//) at the beginning of the query.

Following is a query that finds all `last-name` elements anywhere in the current document:

```
//last-name
```

Suppose the context node is the first `book` element in the document. The following query returns a single `last-name` element because it starts its search in the current context:

```
./last-name
```

At the beginning of a query, `/` or `//` instructs the XPath processor to begin to evaluate nodes at the root node. However, between tag names, `/` is a separator, and `//` is an abbreviation for the `descendant-or-self` axis.

The `//` selects from all descendants of the context node set. For example:

```
book//award
```

This query searches the current context for book child elements that contain `award` elements. If the `bookstore` element is the context node, this query returns the two `award` elements that are in the document.

For the sample `bookstore` data, the following two queries are equivalent. Both return all `last-name` elements in the document.

```
//last-name
//author//last-name
```
The first query returns all last-name elements in the sample document or in any XML document. The second query returns all last-name elements that are descendants of author elements. In the sample data, last-name elements are always descendants of author elements, so this query returns all last-name elements in the document. But in another XML document, there might be last-name elements that are not descendants of author elements. In that case, the query would not return those last-name elements.

Tip: // is useful when the exact structure is unknown. If you know the structure of your document, avoid the use of // . A query that contains // is slower than a query with an explicit path.

Explicitly Specifying the Current Context

If you want to explicitly specify the current context node, place a dot and a forward slash (./) in front of the query. This construct typically appears in queries that contain filters (see “Filtering Results of Queries” on page 643). The following two queries are equivalent:

```
./author
```

Remember, if you specify the name of an element as a complete query (for example, foo), you obtain only the foo elements that are children of the current context node. You do not necessarily obtain all foo elements in the document.

You can also specify the dot notation (.) to indicate that you want the XPath processor to manipulate the current context. For example:

```
/title [. = "History of Trenton"]
```

In this example, the XPath processor finds all title elements. The dot indicates the context node. This causes the XPath processor to check each title in turn to determine whether its string value is History of Trenton.
Specifying Children or Descendants of Parent Nodes

Sometimes you want a query to return information about a sibling of the context node. One way to obtain a sibling is to define a query that navigates up to the parent and then down to the sibling.

For example, suppose the context node is the first author element. You want to find out the title associated with this author. The following query returns the associated title element:

```xml
../title
```

The double dot (..) at the beginning of the query instructs the XPath processor to select the parent of the context node. This query returns the title elements that are children of the first book element, which is the parent of the first author element. In the bookstore.xml document, there is only one such title element.

Now suppose that the context node is still the first author element and you want to obtain the style attribute for the book that contains this author. The following query does this:

```xml
../@style
```

The double dot notation need not appear at the beginning of a query. It can appear anywhere in a query string, just like the dot notation.

Examples of XPath Expression Results

Table 66 provides examples of XPath expression results:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>/a</td>
<td>Returns the document element of the document if it is an a element</td>
</tr>
<tr>
<td>/a/b</td>
<td>Returns all b elements that are immediate children of the document element, which is the a element</td>
</tr>
<tr>
<td>//a</td>
<td>Returns all a elements in the document</td>
</tr>
<tr>
<td>//a/b</td>
<td>Returns all b elements that are immediate children of a elements that are anywhere in the document</td>
</tr>
</tbody>
</table>
Specifying the Nodes to Evaluate

Syntax for Specifying an Axis in a Query

The previous sections provide examples of XPath expression syntax that uses abbreviations. This section introduces you to the axis syntax that many of the abbreviations represent. For a list of XPath abbreviations, see “XPath Abbreviations Quick Reference” on page 707.

You can use axis syntax to specify a location path in a query. An axis specifies the tree relationship between the nodes selected by an expression and the context node. The syntax for specifying an axis in a query is as follows:

\[ axis_name::node_test \]

The axis names are defined in “Supported Axes” on page 658.

A node test is a simple expression that tests for a specified node type or node name. For example:

\* node() matches any type of node.
\* text() matches text or CDATA nodes.
\* comment() matches comment nodes.
\* processing-instruction() matches any processing instruction.
\* processing-instruction(name) matches processing instructions whose target is name.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>a or ./a</td>
<td>Returns all a elements that are immediate children of the context node</td>
</tr>
<tr>
<td>a/b</td>
<td>Returns all b elements that are immediate children of a elements that are immediate children of the context node</td>
</tr>
<tr>
<td>a//b</td>
<td>Returns all b elements that descend from a elements that are immediate children of the context node</td>
</tr>
<tr>
<td>./a</td>
<td>Returns all a elements in the document tree branch that starts with the context node</td>
</tr>
<tr>
<td>../../../a</td>
<td>Returns all a elements in the document tree branch that are children of the parent node of the context node.</td>
</tr>
</tbody>
</table>
Writing XPath Expressions

- *name* matches elements or attributes whose name is *name*.
- * matches any elements or any attributes.

XPath 2.0 adds additional tests, such as
- *element()* matches any element node
- *attribute()* matches any attribute node
- *document-node()* matches any document node

In addition, you can follow the node test with any number of filters.

Supported Axes

The XPath processor supports all XPath axes:
- *child*
- *descendant*
- *parent*
- *ancestor*
- *following-sibling*
- *preceding-sibling*
- *following*
- *preceding*
- *attribute*
- *namespace*
- *self*
- *descendant-or-self*
- *ancestor-or-self*

About the child Axis

The *child* axis contains the children of the context node. The following examples select the book children of the context node:

```
child::book
book
```

If the context node is the *bookstore* element, each of these queries return the book elements in *bookstore.xml*. When you do not specify an axis, the *child* axis is assumed.
Specifying the Nodes to Evaluate

About the descendant Axis

The descendant axis contains the descendants of the context node. A descendant is a child or a child of a child, and so on. The descendant axis never contains attribute nodes. The following example selects the first-name element descendants of the context node:

```
descendant::first-name
```

If the context node is the bookstore element, this query returns all first-name elements in the document. If the context node is the first publication element, this query returns the first-name element that is in the publication element.

About the parent Axis

The parent axis contains the parent of the context node, if there is one. The following example selects the parent of the context node if it is a title element:

```
parent::title
```

If the first title element in bookstore.xml is the context node, this query returns the first book element.

Note that dot dot (..) is equivalent to parent::node().

About the ancestor Axis

The ancestor axis contains the ancestors of the context node. The ancestors of the context node consist of the parent of the context node and the parent's parent, and so on. The ancestor axis always includes the root node, unless the context node is the root node. The following example selects the book ancestors of the context node:

```
ancestor::book
```

If the context node is the first title element in bookstore.xml, this query returns the first book element.
About the following-sibling Axis

The following-sibling axis contains all the siblings of the context node that come after the context node in document order. If the context node is an attribute node or namespace node, the following-sibling axis is empty. The following example selects the next book sibling of the context node:

\[
\text{following-sibling::book[position()=1]}
\]

If the context node is the first book element in bookstore.xml, this query returns the second book element.

About the preceding-sibling Axis

The preceding-sibling axis contains all the siblings of the context node that precede the context node in reverse document order. If the context node is an attribute node or namespace node, the preceding-sibling axis is empty. The following example selects the closest previous book sibling of the context node:

\[
\text{preceding-sibling::book[position()=1]}
\]

If the context node is the third book element in bookstore.xml, this query returns the second book element. If the context node is the first book element, this query returns the empty set.

About the following Axis

The following axis contains the nodes that follow the context node in document order. This can include

- Following siblings of the context node
- Descendants of following siblings of the context node
- Following siblings of ancestor nodes
- Descendants of following siblings of ancestor nodes

The following axis never includes

- Ancestors or descendants of the context node
- Attribute nodes
- Namespace nodes
Specifying the Nodes to Evaluate

The following example selects the book elements that are following siblings of the context node and that follow the context node in document order:

```
following::book
```

If the context node is the first book element, this query returns the last three book elements. If the context node is the second book element, this query returns only the third and fourth book elements.

**About the preceding Axis**

The preceding axis contains the nodes that precede the context node in reverse document order. This can include:

- Preceding siblings of the context node
- Descendants of preceding siblings of the context node
- Preceding siblings of ancestor nodes
- Descendants of preceding siblings of ancestor nodes

The preceding axis never includes:

- Ancestors or descendants of the context node
- Attribute nodes
- Namespace nodes

The following example selects the book elements that are preceding siblings of the context node and that precede the context node in document order:

```
preceding::book
```

If the third book element is the context node, this query returns the first two book elements. If the first book element is the context node, this query returns the empty set.

**About the attribute Axis**

The attribute axis contains the attributes of the context node. The attribute axis is empty unless the context node is an element. The following examples are equivalent. They both select the style attributes of the context node. The at sign (@) is an abbreviation for the attribute axis.

```
attribute::style
@style
```
If the context node is the second book element, this query returns a style attribute whose value is textbook.

**About the namespace Axis**

The namespace axis contains the namespace nodes that are in scope for the context node. This includes namespace declaration attributes for the

- Context node
- Ancestors of the context node

If more than one declaration defines the same prefix, the resulting node set includes only the definition that is closest to the context node.

If the context node is not an element, the namespace axis is empty.

For example, if an element is in the scope of three namespace declarations, its namespace axis contains three namespace declaration attributes.

**About the self Axis**

The self axis contains just the context node itself. The following example selects the context node if it is a title element:

```
self::title
```

Note that dot (.) is equivalent to `self::node()`.

**About the descendant-or-self Axis**

The descendant-or-self axis contains the context node and the descendants of the context node. The following example selects the first-name element descendants of the context node and the context node itself if it is a first-name element:

```
descendant-or-self::first-name
```

If the context node is the first-name element that is in the author element in the second book element, this query returns just the context node. If the context node is the second book element, this query returns the two first-name elements contained in the second book element.

Note that `//` is equivalent to `descendant-or-self::node()`, while `//name` is equivalent to `descendant-or-self::node()/child::name`.
Specifying the Nodes to Evaluate

About the ancestor-or-self Axis

The ancestor-or-self axis contains the context node and the ancestors of the context node. The ancestor-or-self axis always includes the root node. The following example selects the author element ancestors of the context node and the context node itself if it is an author element:

```
ancestor-or-self::author
```

If the context node is the award element in the first book element, this query returns the first author element.

Axes That Represent the Whole XML Document

The following group of axes represent an entire XML document:

- ancestor
- preceding
- self
- following
- descendant

There is no overlap among these axes, as shown in the following figure:
Handling Strings and Text

This section includes the following topics:

- “Searching for Strings” on page 664
- “Manipulating Strings” on page 667
- “Obtaining the Text Contained in a Node” on page 670

Searching for Strings

This section provides information about searching for strings. This section discusses the following topics:

- “Finding Identical Strings” on page 664
- “Finding Strings That Contain Strings You Specify” on page 665
- “Finding Substrings That Appear Before Strings You Specify” on page 665
- “Finding Substrings That Appear After Strings You Specify” on page 666
- “Finding Substrings by Position” on page 666

Finding Identical Strings

In a document, you can search for text that is an exact match with what you specify in your query. For example, consider the following query:

```xml
//name [ . ="Lu" ]
```

This query finds all `name` elements that contain only the text `Lu`. It would return elements like these:

```xml
<name>Lu</name>
<name>
  <firstname>Lu</firstname>
</name>
<name>Lu Chen</name>
<name>
  <firstname>Lu</firstname>
  <lastname>Chen</lastname>
</name>
```

The same query does not return elements like these:

```xml
<name>Lu  Chen</name>
<name>
  <firstname>Lu</firstname>
  <lastname>Chen</lastname>
</name>
```
The XPath processor does not return the first name element because the comparison is between "Lu" and "Lu Chen". The query does not return the second name element because the XPath processor concatenates the two strings "Lu" and "Chen" before it makes the evaluation. Consequently, the comparison is between "Lu" and "LuChen". Note that the XPath processor does not insert a space between text nodes that it concatenates.

**Case Sensitivity**

Searches are case sensitive. A search for "Lu" does not return "lu".

**Finding Strings That Contain Strings You Specify**

To obtain elements that contain a particular string, call the contains() function. The format is

\[
\text{boolean contains(string, string)}
\]

The contains() function returns true if the first argument string contains the second argument string, and otherwise returns false. For example, the following query returns all books that have a title that contains the string "Trenton":

\[
\text{/bookstore/book[contains(title, "Trenton")]}\]

When the first argument is a node list, the XPath processor tests only the string value of the node in the node list that is first in document order. Any subsequent nodes are ignored.

**Finding Substrings That Appear Before Strings You Specify**

To obtain a substring that appears before a string you specify, call the substring-before() function. The format is

\[
\text{string substring-before(string, string)}
\]

The substring-before() function returns the substring of the first argument string that precedes the first occurrence of the second argument string in the first argument string. This function returns the empty string if the first argument string does not contain the second argument string. For example, the following call returns "1999":

\[
\text{substring-before("1999/04/01","/")}\]
Finding Substrings That Appear After Strings You Specify

To obtain a substring that appears after a string you specify, call the substring-after() function. The format is

```
string substring-after(string, string)
```

The substring-after() function returns the substring of the first argument string that follows the first occurrence of the second argument string in the first argument string. This function returns the empty string if the first argument string does not contain the second argument string. For example, the following call returns "04/01":

```
substring-after("1999/04/01","/")
```

Finding Substrings by Position

To obtain a substring that is in a particular position within its string, call the substring() function. The format is

```
string substring(string, number, number?)
```

The substring() function returns the substring of the first argument, starting at the position specified in the second argument, with length specified in the third argument. For example, the following returns "234":

```
substring("12345", 2, 3)
```

If you do not specify the third argument, the substring() function returns the substring starting at the position specified in the second argument and continuing to the end of the string. For example, the following call returns "2345":

```
substring("12345", 2)
```

More precisely, each character in the string is considered to have a numeric position. The position of the first character is 1. The position of the second character is 2, and so on. The returned substring contains those characters for which the position of the character is greater than or equal to the rounded second argument and, if the third argument is specified, less than the sum of the value of the second and third arguments. The comparisons and addition used for the preceding follow the standard IEEE 754 rules. The
XPath processor rounds the second and third arguments as if by a call to the `round()` function. For example:

```
substring("12345", 1.5, 2.6) returns "234"
substring("12345", 0, 3) returns "12"
substring("12345", 0 div 0, 3) returns ""
substring("12345", 1, 0 div 0) returns "12345"
substring("12345", -42, 1 div 0) returns "12345"
substring("12345", -1 div 0, 1 div 0) returns ""
```

## Manipulating Strings

After you obtain a string, you might want to manipulate it and use the result in the query. This section describes functions that allow you to do this. It discusses the following topics:

- “Concatenating Strings” on page 667
- “Determining the Number of Characters in a String” on page 667
- “Normalizing Strings” on page 668
- “Replacing Characters in Strings with Characters You Specify” on page 668
- “Converting Objects to Strings” on page 669
- “Finding Strings That Start with a Particular String” on page 670

### Concatenating Strings

To concatenate two or more strings, call the `concat()` function. The format is

```
string concat(string, string, {string}...)
```

The `concat()` function returns the concatenation of its arguments.

### Determining the Number of Characters in a String

To obtain the number of characters in a string, call the `string-length()` function. The format is

```
number string-length(string?)
```

The `string-length()` function returns the number of characters in the string. If you omit the argument, it defaults to the string value of the context node.
Normalizing Strings

To strip leading and trailing white space from a string, call the `normalize-space()` function. The format is

```
string normalize-space(string?)
```

The `normalize-space()` function removes leading and trailing white space. White space consists of spaces, tabs, new lines, and returns.

If there are consecutive internal spaces, the `normalize-space()` function collapses the internal spaces into one space. The `normalize-space()` function returns the string with the extraneous white space removed. If you omit the argument, it defaults to the string value of the context node.

Replacing Characters in Strings with Characters You Specify

To replace characters in a string with other characters, call the `translate()` function. The format is

```
string translate(string, string, string)
```

The `translate()` function looks for characters in the first string that are also in the second string. For each such character, the `translate()` function replaces the character in the first string with a character from the third string. The replacement character is the character in the third string that is in the same position as the character in the second string that corresponds to the character being replaced. For example:

```
translate("bar", "abc", "ABC")
```

Execution of this function returns "BAr". Following is another example:

```
translate("---aaa---", "abc", "ABC")
```

Execution of this function returns "AAA". Sometimes there is a character in the second argument string with no character at a corresponding position in the third argument string. This happens when the second argument string is longer than the third argument string. In this case, the XPath processor removes occurrences of that character.

If a character occurs more than once in the second argument string, the first occurrence determines the replacement character. If the third argument string is longer than the second argument string, the XPath processor ignores the excess characters.
Handling Strings and Text

Converting Objects to Strings

In some situations, you might want to force a string comparison. The XPath processor performs a string comparison only when the operands are neither Boolean nor numeric values. If an operand is numeric or Boolean, call the `string()` function on it to convert it to a string. The format of the `string()` function is

```
string string(object?)
```

The `string()` function can convert any object to a string. If you omit the argument, it defaults to a node set with the context node as the only member. The string value of an element node is the concatenation of the string values of all text node descendants of the element node in document order.

Node Sets

When the `string()` function converts a node set to a string, it returns the string value of the node in the node set that is first in document order. If the node set is empty, the `string()` function returns an empty string.

Numbers

The `string()` function converts numbers to strings as follows:

- NaN (not a number) becomes "NaN"
- Positive zero becomes "0"
- Negative zero becomes "0"
- Positive infinity becomes "Infinity"
- Negative infinity becomes "-Infinity"
- An integer becomes a sequence of digits with no leading zeros, for example, "1234". A negative integer is preceded by a minus sign, for example, "-1234".
- A noninteger number becomes a sequence of digits with at least one digit before a decimal point and at least one digit after a decimal point, for example, "12.34". A negative noninteger number is preceded by a minus sign, for example, "-12.34". Leading zeros are not allowed unless there is only one to satisfy the requirement of a zero before the decimal point. Beyond the one required digit after the decimal point, there must be as many, but only as many, more digits as are needed to uniquely distinguish the number from all other IEEE 754 numeric values.

Boolean Values

The `string()` function converts the Boolean false value to the string "false", and the Boolean true value to the string "true".
Finding Strings That Start with a Particular String

To determine if a string starts with a particular string, specify the `starts-with()` function. The format is

```
boolean starts-with(string, string)
```

This function returns `true` if the first argument string starts with the second argument string, and otherwise returns `false`.

Obtaining the Text Contained in a Node

You can use the `string()` function to obtain the text in a node. The string value of an element node is the concatenation of the string values of all text node descendants of the element node in document order. Use one of the following formats:

```
string string(pathExpression)
pathExpression
```

Replace `pathExpression` with the path of the node or nodes that contain the text you want. This can be a rooted path or a relative path. It need not be a single node. If you do not explicitly specify the `string()` function, you must specify `pathExpression` in a context where the XPath processor must treat it as a string, for example:

```
/bookstore/book[title = "Trenton Revisited"]
```

The XPath processor obtains the text contained in each `title` element and compares it with "Trenton Revisited". The XPath processor returns books with the title *Trenton Revisited*.

For additional information about the `string()` function, see “Converting Objects to Strings” on page 669.
Specifying Boolean Expressions and Functions

This section provides information on how to specify Boolean expressions and functions in queries. It includes the following topics:

● “Using Boolean Expressions” on page 671
● “Calling Boolean Functions” on page 672

Using Boolean Expressions

You can specify Boolean expressions in the subqueries in filters. You specify the Boolean AND, OR, and NOT operators like this:

● and
● or
● not

You can use parentheses to group collection specifications and operators for clarity or where the normal precedence is inadequate to express an operation.

Case Sensitivity

Operators are case sensitive. Spaces are not significant. You can omit them or include them for clarity.

Examples

The following query returns all authors who have at least one degree and one award:

```plaintext
author[degree and award]
```

The next query finds all authors who have at least one degree or award and at least one publication:

```plaintext
author[(degree or award) and publication]
```

Following is a query that finds all authors who have at least one degree and no publications:

```plaintext
author[degree and not(publication)]
```
Calling Boolean Functions

This section describes the Boolean functions that you can call in a query. The operations you can perform are

- “Converting an Object to Boolean” on page 672
- “Obtaining Boolean Values” on page 673
- “Determining the Context Node Language” on page 673

Converting an Object to Boolean

In some situations, you might want to force a Boolean comparison. The XPath processor performs a Boolean comparison if either operand is a Boolean value. Consequently, if neither operand is a Boolean value, call the `boolean()` function on one operand to convert it to a Boolean value. The XPath processor automatically converts the other operand to a Boolean value. The format of the `boolean()` function is

```
boolean boolean(object)
```

The `boolean()` function converts its argument to Boolean as follows:

- A number is `false` if and only if it is one of the following:
  - Positive zero
  - Negative zero
  - NaN (not a number)
- A node set is `false` if and only if it is empty.
- A string is `false` if and only if its length is 0.

The `boolean()` function is useful in comparisons. For example, the following query returns `b` elements that either contain both `c` and `d` elements as children or contain neither `c` nor `d` elements as children:

```
/a/b[boolean(c) = d]
```

This query is equivalent to the following query:

```
/a/b [(c and d) or (not(c) and not(d))]
```
Obtaining Boolean Values

To obtain the opposite Boolean value, call the `not()` function. The format is

```
boolean not(boolean)
```

The `not()` function returns `true` if its argument is `false`, and returns `false` if its argument is `true`. For example, the following query finds all authors who have publications but no degrees or awards:

```
author[not(degree or award) and publication]
```

To obtain the value `true`, call the `true()` function. The format is

```
boolean true()
```

The `true()` function returns `true`.

To obtain the value `false`, call the `false()` function. The format is

```
boolean false()
```

The `false()` function returns `false`.

Determining the Context Node Language

To determine whether the language of the context node is the language you expect it to be, call the `lang()` function. The format is

```
boolean lang(string)
```

The `lang()` function returns `true` or `false` depending on whether the language of the context node as specified by the `xml:lang` attribute is the same as, or is a sublanguage of, the language specified by the argument string. The language of the context node is determined by the value of the `xml:lang` attribute on the context node or, if the context node has no `xml:lang` attribute, by the value of the `xml:lang` attribute on the nearest ancestor of the context node that has an `xml:lang` attribute.

If there is no such attribute, then `lang()` returns `false`. If there is such an attribute, `lang()` returns `true` in the following situations:

- The attribute value is equal to the argument string.
- The attribute value has a suffix starting with a dash (-) such that the attribute value is equal to the argument string if you ignore the suffix.
Writing XPath Expressions

In both situations, case is ignored. For example:
\[
\text{lang("en")}
\]
This returns true if the context node is any of these elements:
- \(<\text{para } xml:\text{lang}="\text{en}"/>\)
- \(<\text{div } xml:\text{lang}="\text{en}"><\text{para}/></div>\)
- \(<\text{para } xml:\text{lang}="\text{EN}"/>\)
- \(<\text{para } xml:\text{lang}="\text{en-us}"/>\)

Specifying Number Operations and Functions

This section includes the following topics:
- “Performing Arithmetic Operations” on page 674
- “Calling Number Functions” on page 675

Performing Arithmetic Operations

In queries, a number represents a floating-point number. A number can have any double-precision 64-bit format IEEE 754 value. This includes
- A special not-a-number (NaN) value
- Positive and negative infinity
- Positive and negative zero

The numeric operators convert their operands to numbers as if by calling the \text{number()} function. See “Converting an Object to a Number” on page 675.

You can use the following arithmetic operators in queries:
- \(+\) performs addition
- \(-\) performs subtraction

XML allows hyphens (-) in names. Consequently, the subtraction operator (-) typically needs to be preceded by white space. For example, \text{foo-bar} evaluates to a node set that contains the child elements named \text{foo-bar}. However, \text{foo} - \text{bar} evaluates to the difference between the result of converting the string value of the first \text{foo} child element to a number and the result of converting the string value of the first \text{bar} child to a number.
- \(*\) performs multiplication
- \text{mod} returns the remainder from a truncating division. For example:
Specifying Number Operations and Functions

- \(5 \mod 2\) returns 1.
- \(5 \mod -2\) returns 1.
- \(-5 \mod 2\) returns -1.
- \(-5 \mod -2\) returns -1.

The mod operator is the same as the \(\%\) operator in Java and ECMAScript. But it does not perform the same operation as the IEEE remainder operation, which returns the remainder from a rounding division.

- \(\div\) performs floating-point division according to IEEE 754.

Calling Number Functions

This section describes the number functions that you can call in a query. The operations you can perform are

- Converting an Object to a Number on page 675
- Obtaining the Sum of the Values in a Node Set on page 676
- Obtaining the Largest, Smallest, or Closest Number on page 676

Converting an Object to a Number

In some situations, you might want to force a numeric comparison. The XPath processor performs a numeric comparison if either operand is numeric and neither is Boolean. (If one operand is Boolean, the XPath processor converts the other to Boolean and performs a Boolean comparison.) However, if neither operand is a numeric or Boolean value, you can call the `number()` function on one operand to convert it to a numeric value. The XPath processor automatically converts the other operand to a numeric value.

To perform a numeric comparison, you must call the `number()` function to convert a Boolean operand, if there is one, to a numeric value.

The format of the `number()` function is

```
number number(object?)
```
If you omit the argument, the value of the argument defaults to a node set with the context node as its only member. Table 67 shows how the number() function converts its argument to a number:

**Table 67. number() Function Arguments and Converted Values**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Converted Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>String that consists of optional white space followed by an optional minus sign followed by a number followed by white space</td>
<td>IEEE 754 number that is nearest to the mathematical value represented by the string.</td>
</tr>
<tr>
<td>Any other string</td>
<td>NaN (not a number)</td>
</tr>
<tr>
<td>Boolean true</td>
<td>1</td>
</tr>
<tr>
<td>Boolean false</td>
<td>0</td>
</tr>
<tr>
<td>Node set</td>
<td>First the XPath processor converts the node set to a concatenated string as if by a call to the string() function for the first node in the node set, in document order. The XPath processor then converts this string the same way as it would a string argument.</td>
</tr>
</tbody>
</table>

**Obtaining the Sum of the Values in a Node Set**

To obtain the sum of the values of the nodes in a set, call the sum() function. The format is

\[
\text{number } \text{sum(node-set)}
\]

For each node in the argument node-set, the XPath processor converts the string value of the node to a number. The sum() function returns the sum of these numbers.

**Obtaining the Largest, Smallest, or Closest Number**

To obtain the largest integer that is not greater than a particular number, call the floor() function. The format is

\[
\text{number } \text{floor(number)}
\]

The floor() function returns the largest (closest to positive infinity) number that is not greater than the argument and that is an integer. For example:
Comparing Values

- floor(5.3) returns 5
- floor(-5.3) returns -6

To obtain the smallest integer that is not less than a particular number, call the ceiling() function. The format is:

```
number ceiling(number)
```

The ceiling() function returns the smallest (closest to negative infinity) number that is not less than the argument and that is an integer. For example:

- ceiling(5.3) returns 6
- ceiling(-5.3) returns -5

To obtain the closest integer to a particular number, call the round() function. The format is:

```
number round(number)
```

The round() function returns the number that is closest to the argument and that is an integer. If there are two such numbers, the function returns the one that is closest to positive infinity. For example:

- round(5.3) returns 5
- round(5.6) returns 6
- round(5.5) returns 6

Comparing Values

In queries, you can specify operators that compare values. Comparison operations return Boolean values. If you want to obtain the nodes for which a comparison tests true, enclose the comparison in a filter.

This section discusses the following topics:
- “About Comparison Operators” on page 678
- “How the XPath Processor Evaluates Comparisons” on page 678
- “Comparing Node Sets” on page 679
- “Comparing Single Values With = and !=” on page 680
- “Comparing Single Values With <=, <, >, and >=” on page 681
- “Priority of Object Types in Comparisons” on page 681
Writing XPath Expressions

- “Examples of Comparisons” on page 682
- “Operating on Boolean Values” on page 682

About Comparison Operators

The comparison operators you can specify are listed in Table 68:

Table 68. Comparison Operator Descriptions

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equality</td>
</tr>
<tr>
<td>!=</td>
<td>Inequality</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal</td>
</tr>
</tbody>
</table>

You can specify single or double quotation marks (’ or “) as string delimiters in expressions. This makes it easier to construct and pass queries from within scripting languages.

How the XPath Processor Evaluates Comparisons

A query can compare values of elements. For example:

```
last-name [. = "foo"]
```

The XPath processor compares the value of each `last-name` element in the current context with the value "foo". The result of each comparison is a Boolean value. The XPath processor returns the `last-name` elements for which the comparison yields `true`.

As mentioned before in “Filtering Results of Queries” on page 643, the XPath processor evaluates filters with respect to a context. For example, the expression `book[author]` means for every book element that is found, determine whether it has an author child element. Likewise, `book[author = "Bob"]` means for every book element that is found, determine whether it contains an author child element whose value is "Bob".
Comparing Values

Comparisons are case sensitive. For example, "Bob" and "bob" are not considered to be equal.

Remember that comparisons return Boolean values. For example:

```
/bookstore/book/author[last-name="Bob"]
```

You might think that this query returns authors whose last name is "Bob". But this is not the case. This query returns a single Boolean value. It tests each `last-name` element to determine if its value is "Bob". As soon as the XPath processor finds a `last-name` element that tests true, it returns `true`. If no nodes test true, this query returns `false`.

To obtain `author` elements whose last name is "Bob", enclose the comparison in a filter as follows:

```
/bookstore/book/author[last-name="Bob"]
```

Comparing Node Sets

You can compare
- Two node sets
- A node set and a number
- A node set and a string
- A node set and a Boolean value

Two Node Sets

Suppose the objects you want to compare are both node sets. The result is true only in the following case. There is a node in the first node set and a node in the second node set such that the result of performing a comparison on the values of the two nodes is true. For string values, the comparison can be `=` or `!=`. For numeric values, the comparison can also be `<`, `>`, `<=`, or `>=`.

A Node Set and a Number

Now suppose one object to be compared is a node set and the other is a number. The XPath processor searches for a node in the node set that yields a true result when its number value is compared with the number that is not in the node set. If necessary, the XPath processor uses the `number()` function to convert values to numeric values. If and only if the XPath processor finds such a node, the result is `true`. 
A Node Set and a String

Sometimes you want to compare a node set with a string. The XPath processor searches for a node in the node set that yields a true result when its string value is compared with the string that is not in the node set. If necessary, the XPath processor uses the `string()` function to convert values to string values. If and only if the XPath processor finds such a node, the result is `true`.

A Node Set and a Boolean Value

Finally, suppose you want to compare a node set with a Boolean value. This tests true if and only if the result of performing the comparison on the Boolean value and on the result of converting the node set to a Boolean value using the `boolean()` function is `true`.

Comparing Single Values With `=` and `!=`

When neither object to be compared is a node set and the operator is `=` or `!`, the XPath processor compares the objects by converting them to a common type and then comparing them. The XPath processor converts the objects to a common type as follows:

- If at least one object to be compared is Boolean, the XPath processor converts the other object to Boolean as if by applying the `boolean()` function.
- If at least one object to be compared is a number, and neither is Boolean, the XPath processor converts the nonnumber object to a number as if by applying the `number()` function.

If the objects to be compared are neither Boolean nor numeric, the XPath processor compares the string values of the objects as if by applying the `string()` function to each object.

The `=` comparison returns `true` if and only if the objects are equal. The `!=` comparison returns `true` if and only if the objects are not equal. Numbers are compared for equality according to IEEE 754. Two Boolean values are equal if either both are `true` or both are `false`. Two strings are equal if and only if they both consist of the same sequence of Universal Character Set (UCS) characters.
Comparing Single Values With <=, <, >, and >=

When neither object to be compared is a node set and the operator is <=, <, >=, or >, the XPath processor performs the comparison by converting both objects to numbers and comparing the numbers according to IEEE 754.

Table 69. Comparison Operator Descriptions

<table>
<thead>
<tr>
<th>Comparison</th>
<th>True If and Only If</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>The first number is less than the second number.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>The first number is less than or equal to the second number.</td>
</tr>
<tr>
<td>&gt;</td>
<td>The first number is greater than the second number.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>The first number is greater than or equal to the second number.</td>
</tr>
</tbody>
</table>

The XPath processor always evaluates these comparisons in terms of numbers. You cannot use the less than and greater than operators to order strings. This is especially important to remember when you compare a number with a string. For example, suppose you want to evaluate the expression

\[ a < \text{"foo"} \]

The return value is always false. This is because \( \text{number("foo")} \) returns NaN, and the resulting comparison, shown below, is always false.

\[ a < \text{NaN} \]

Priority of Object Types in Comparisons

When the XPath processor performs a comparison, if either operand is a Boolean value, the XPath processor automatically converts the other operand to a Boolean value, if necessary, and makes a Boolean comparison.

If either operand is numeric and neither operand is Boolean, the XPath processor automatically converts the other operand to a numeric value, if necessary, and performs a numeric comparison.

If neither operand is numeric or Boolean, the XPath processor performs a string comparison.
Examples of Comparisons

The following query finds all authors whose last name is Bob:

```
author[last-name = "Bob"]
```

The next query finds authors whose degrees are not from Harvard:

```
author/degree[@from != "Harvard"]
```

The following query returns prices that are greater than 20 dollars. This assumes that the current context contains one or more `price` elements.

```
price [. > 20]
```

Operating on Boolean Values

You can use the `=` or `!=` operator to compare Boolean values. If you try to use any other operator to compare Boolean values, you receive an error.

Finding a Particular Node

To find a specific node within a set of nodes, enclose an integer within brackets ( `[ ]` ). The integer indicates the position of the node relative to its parent. This section discusses the following topics:

- “About Node Positions” on page 683
- “Determining the Position Number of a Node” on page 683
- “Positions in Relation to Parent Nodes” on page 684
- “Finding Nodes Relative to the Last Node in a Set” on page 685
- “Finding Multiple Nodes” on page 685
- “Examples of Specifying Positions” on page 686
- “Finding the First Node That Meets a Condition” on page 686
- “Finding an Element with a Particular ID” on page 686
- “Obtaining Particular Types of Nodes By Using Node Tests” on page 688

See also “Obtaining the Current Node for the Current XSLT Template” on page 696.
Finding a Particular Node

About Node Positions

The node positions for a node set start with 1. Evaluation of the position number is always based on document order. For example, the following query returns the first author element in the current context:

```xml
author[1]
```

The next query finds the author elements (in the current context) that contain a first-name element. The query returns the third such author element.

```xml
(author[first-name])[position()=3]
```

When you specify an integer in brackets, it is equivalent to calling the `position()` function. For example, the following queries both return the third y child element of each x child element in the current context:

```xml
x/y[3]
x/y[position()=3]
```

*Tip:* If you do not know the position of the node you want, a call to the `position()` function might help you. See “Determining the Position Number of a Node” on page 683.

The return value of the `position()` function depends on the specified axis. For example, suppose the axis is one of the reverse axes, such as preceding, ancestor, or preceding-sibling. The `position()` function returns the \( n \)th one in reverse document order that falls in the specified axis.

Determining the Position Number of a Node

The `position()` function returns an integer that indicates the position of the node within the parent. Positions start with 1; a node with a position of 1 is always the first node in the collection.

For example, the following query returns the first three degree elements in the document:

```xml
//degree[position() < 4]
```

The next query finds the first two book children in the current context:

```xml
book[position() <= 2]
```
The XPath processor executes the `position()` function with respect to the parent node. Consider the following data:

```
<x>
  <y/>
  </x>
  <x>
  <y/>
  </x>
</x>
```

The following expression returns the first `y` element contained in each `x` element:

```
x/y[position() = 1]
```

For more information, see also “Finding an Element with a Particular ID” on page 686.

### Positions in Relation to Parent Nodes

Positions are relative to the parent. Consider the following data, which has line numbers on the left for explanation only.

```
1  <x>
2   <z>
3   <z/>
4   </x>
5  </x>
6   <y>
7   <y/>
8   </x>
9  </x>
10  <y>
11  <y/>
12  </x>
```

The following query returns the first `y` element contained in each `x` element. It returns the elements on lines 6 and 10. The XPath processor finds all `x` elements. For each `x` element, the XPath processor then returns the first `y` element it finds.

```
x/y[1]
```

The next query returns the first `y` element that is contained in an `x` element that is in the context node set. It returns the element on line 6. The XPath processor finds all `y` elements inside `x` elements. The XPath processor then returns the first element in that set.

```
(x/y)[1]
```
Finding a Particular Node

The next query returns the empty set. The XPath processor finds the first \( x \) element. It then searches that first \( x \) element for the first \( y \). Because the first \( x \) element does not contain a \( y \) element, this query returns the empty set.

\[ x[1]/y[1] \]

Finding Nodes Relative to the Last Node in a Set

To obtain nodes relative to the last node in the set, use the `position()` and `last()` functions with arithmetic. For example, the following queries both obtain the last `author` element in the current context:

\[
\begin{align*}
\text{author} & [\text{position()} = \text{last()}] \\
\text{author} & [\text{last()}]
\end{align*}
\]

The following queries both return the next-to-last `author` element:

\[
\begin{align*}
\text{author} & [\text{position()} = \text{last()} - 1] \\
\text{author} & [\text{last()} - 1]
\end{align*}
\]

For information about `position()`, see “Determining the Position Number of a Node” on page 683. For information about `last()`, see “Determining the Context Size” on page 694.

Finding Multiple Nodes

To obtain several nodes in one operation, use the `and` or the `or` operator with the `position()` and `last()` functions. For example, the following query returns the first and the last `author` nodes in the current context:

\[
\text{author} [(\text{position()} = 1) \text{ or } (\text{position()} = \text{last()})]
\]

You can also specify a range of nodes. For example, the next query returns the second, third, and fourth `author` elements:

\[
\text{author} [(\text{position()} >= 2) \text{ and } (\text{position()} <= 4)]
\]

To obtain a range of nodes, \( m \) to \( n \), relative to the last node, use the following format:

\[
(m <= \text{position()} \text{ and } (\text{position()} <= n)
\]
Writing XPath Expressions

For example, the following query obtains the last five nodes in the current context:

```
author [(last() - 4) <= position() and (position() <= last())]
```

Examples of Specifying Positions

The following query finds the first and fourth author elements:

```
author [(position() = 4) or (position() = 1)]
```

The next query finds the first, the third through the fifth, and the last author elements:

```
author [(position() = 1) or
       (position() >= 3 and position() <= 5) or
       (position() = last())]
```

The XPath processor removes duplicate values. For the previous query, if there are only five elements in the collection, the query returns only one copy of the fifth element.

The next example finds all author elements in which the first degree is a Ph.D.:

```
author[degree[1] = "Ph.D."]
```

Finding the First Node That Meets a Condition

Suppose you want to obtain from a collection the first node that meets a certain condition. For example, you want the first book whose author's last name is Bob. You can specify the following query:

```
//book[author/last-name="Bob"][position()=1]
```

When the XPath processor evaluates this expression, it creates a collection of book elements where the author’s last name is Bob. The XPath processor then returns the first node in this collection.

The following two expressions appear to also return the first book whose author’s last name is Bob, but they do not. Instead, these queries both return a book whose author’s last name is Bob only if that book is the first book in the document.

```
//book[author/first-name="Bob"][position()=1]
//book[author/first-name="Bob" and position() = 1]
```
Finding an Element with a Particular ID

To obtain the element that has a particular identifier (ID), the DTD must specify an attribute for that element. The type of this attribute must be ID. The name of the attribute is not significant, though it is typically id. If there is such an attribute, you can call the id() function to obtain the element with a particular ID. The format is:

\[
\text{node-set } \text{id}(\text{object})
\]

The id() function evaluates to a set. It ignores the context node set except to evaluate the function’s argument. The result set contains an element node that has an attribute of type ID whose value is identical to the string the object argument evaluates to. The element node can appear anywhere in the document that is being queried.

For example:

\[
\text{id(“special”)}
\]

This query searches for an element that has an attribute whose

- Type is ID
- Value is special

Details about working with IDs are in the following topics:

- “The id() Function’s Argument” on page 687
- “Unique IDs” on page 687

The id() Function’s Argument

When the id() function’s argument is of type node-set, the result is the union of the results of applying id() to the string value of each of the nodes in the argument node set.

When the argument of id() is any other type, the XPath processor converts the argument to a string as if by a call to the string() function. The XPath processor splits the string into a white-space-separated list of tokens. The result is a node set that contains the elements in the same document as the context node that have a unique ID equal to any of the tokens in the list.

Unique IDs

An element node can have a unique ID. This is the value of the attribute that is declared in the DTD as type ID. No two elements in a document can have the same unique ID. If
Writing XPath Expressions

an XML processor reports two elements in a document as having the same unique ID (which is possible only if the document is invalid), the second element is treated as not having a unique ID.

If a document does not have a DTD, the id() function always returns an empty node list.

Obtaining Particular Types of Nodes By Using Node Tests

The node tests allow you to obtain nodes according to their type. Node test is an XPath term. Although a node test looks like a function, it is not a function.

You can use node tests with filters and position specifiers. They resolve to the set of children of the context node that meets the restrictions you specify.

Node tests for XPath 2.0 add to the set of node tests supported for XPath 1.0. Node tests common to both XPath 1.0 and XPath 2.0 are shown in Table 70. Node tests unique to XPath 2.0 are shown in Table 70.

Table 70. Node Test Return Values Common to XPath 1.0 and XPath 2.0

<table>
<thead>
<tr>
<th>Node Test</th>
<th>Node Type Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>comment()</td>
<td>Comment nodes.</td>
</tr>
<tr>
<td>node()</td>
<td>All nonattribute nodes.</td>
</tr>
<tr>
<td>processing-instruction(&quot;name&quot;)</td>
<td>Processing instruction nodes. The processing-instruction() node test selects all processing instructions. When this node test specifies a literal argument, it selects any processing instruction that has a name equal to the value of the argument. If there is no argument, this node test selects all processing instructions.</td>
</tr>
<tr>
<td>text()</td>
<td>Text nodes and CDATA nodes.</td>
</tr>
</tbody>
</table>

Table 71. Node Test Return Values Unique to XPath 2.0

<table>
<thead>
<tr>
<th>Node Test</th>
<th>Node Type Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>attribute()</td>
<td>Matches any attribute node.</td>
</tr>
<tr>
<td>document-node()</td>
<td>Matches any document node.</td>
</tr>
<tr>
<td>element()</td>
<td>Matches any element node.</td>
</tr>
<tr>
<td>item()</td>
<td>Matches any single item.</td>
</tr>
</tbody>
</table>
Finding a Particular Node

For each \texttt{p} element in the current context, the following query returns its second text child node:

\texttt{p/text()[2]}

Following is a query that finds the third \texttt{comment} child in each \texttt{foo} element anywhere in the document:

\texttt{//foo/comment()[3]}

About the Document Object

In the Document Object Model (DOM), a document contains comments, processing instructions, and declarations, as well as the document element. As in XPath, the root node is the root of the DOM tree, and the root node is not the same as the document element. This allows comments, declarations, and processing instructions at the document entity level.

For example, the following query finds all comments at the document entity level. In other words, it finds all comments that are immediate children of the root node.

\texttt{/comment()}

This query returns the comment at the beginning of the \texttt{bookstore.xml} file:

"This file represents a fragment of a book store inventory database."

Getting Nodes of a Particular Type

A query like the following returns all the comments in a document:

\texttt{//comment()}

The following query returns the third comment in the document.

\texttt{//comment() [3]}
Obtaining a Union

Specify the | operator to combine collection sets. For example, the following query returns all last-name elements and all first-name elements in the current context:

```
first-name | last-name
```

The result set can contain zero or more of each element that the | operator applies to. For example, using the previous query, it is possible for the query to contain only first-name elements if no last-name elements are found. The following query finds all book elements and magazine elements in the bookstore element:

```
/bookstore/book | /bookstore/magazine
```

The next query finds all books and all authors in the current context:

```
book | book/author
```

The next query returns the first names, last names, and degrees of authors of books or magazines in the current context:

```
((book | magazine)/author/first-name) | (book | magazine)/author/last-name | (book | magazine)/author/degree)
```

A union can appear only as the first step in a location path expression. Consequently, the following is incorrect because there is a union specification that is not in the first step of a location path expression.

```
(book | magazine)/author/(first-name | last-name | degree)
```

The following query finds all books for which the author's first name is Bob and all magazines with prices less than 10 dollars:

```
/bookstore/book[author/first-name = "Bob"] | magazine[price < 10]
```
Obtaining Information About a Node or a Node Set

In a query, you can perform the following operations to obtain information about a node:

- “Obtaining the Name of a Node” on page 691
- “Obtaining Namespace Information” on page 691
- “Obtaining the URI for an Unparsed Entity” on page 694
- “Determining the Number of Nodes in a Collection” on page 694
- “Determining the Context Size” on page 694

Obtaining the Name of a Node

The `name()` function returns a string that contains the tag name of the node, including the namespace prefix, if any.

The following query returns the name of the third element in `bookstore`, which is "magazine".

```
name(/bookstore/*[3])
```

Wildcards

An asterisk ( * ) specifies a wildcard name for element names. If there are comments before the third element in the preceding example, this query does not include them in the count. See “Filtering Results of Queries” on page 643.

**Note** Remember, an asterisk that is not preceded by an at sign (@) never returns attributes. The XPath processor does not include attributes in node counts. See “Attributes and Wildcards” on page 643.

Obtaining Namespace Information

You can call functions to obtain namespace information. This topic discusses

- “Obtaining the Namespace URI” on page 692
- “Obtaining the Local Name” on page 692
- “Obtaining the Expanded Name” on page 692

In addition to a discussion of the functions you call, this section covers the following:

- “Specifying Wildcards with Namespaces” on page 693
- “Examples of Namespaces in Queries” on page 693
Writing XPath Expressions

Obtaining the Namespace URI

To obtain the URI for a namespace, call the `namespace-uri()` function. The format is

```
string namespace-uri(node-set?)
```

The `namespace-uri()` function returns the namespace URI of the expanded name of the node in the `node-set` argument that is first in document order. If the `node-set` argument is empty, the first node has no expanded name, or the namespace URI of the expanded name is `null`, the XPath processor returns an empty string. If you omit the argument, it defaults to a node set with the context node as its only member.

Call the `namespace-uri()` function on element or attribute nodes. For example, the query

```
/bookstore/my:book/namespaces-uri()
```

returns the string

```
"http://www.placeholder-name-here.com/schema/
```

For any other type of node, the XPath processor always returns an empty string.

Obtaining the Local Name

To obtain the local portion of a node name, excluding the prefix, call the `local-name()` function. The format is

```
string local-name(node-set?)
```

The `local-name()` function returns the local part of the expanded name of the node in the `node-set` argument that is first in document order. If the `node-set` argument is empty or the first node has no expanded name, the function returns an empty string. If you omit the argument, it defaults to a node set with the context node as its only member. For example, the following query returns `my:book` nodes:

```
/bookstore/my::*[local-name()="book"]
```

Obtaining the Expanded Name

To obtain the expanded name of a node, call the `name()` function. The expanded name is the namespace prefix, if any, plus the local name. The format is

```
string name(node-set?)
```
Obtaining Information About a Node or a Node Set

The `name()` function returns a string that represents the expanded name of the node in the `node-set` argument that is first in document order. The returned string represents the expanded name with respect to the namespace declarations in effect on the node whose expanded name is being represented.

Typically, this is the name in the XML source. This need not be the case if there are namespace declarations in effect on the node that associate multiple prefixes with the same namespace.

If the `node-set` argument is empty or the first node has no expanded name, the XPath processor returns an empty string. If you omit the argument, it defaults to a node set with the context node as its only member.

Except for element and attribute nodes, the string that the `name()` function returns is the same as the string the `local-name()` function returns.

Specifying Wildcards with Namespaces

Element and attribute names that include colons (:) can include wildcards; that is, asterisks (*). For example, queries can include `*:`, `*:a`, or `a:*`.

Examples of Namespaces in Queries

The following example finds all `book` elements in the current context. This query does not return any `book` elements that are not in the default namespace. For example, it does not return `my:book` elements.

```
book
```

The next query finds all `book` elements with the prefix `my`. This query does not return unqualified `book` elements; that is, `book` elements in the default namespace.

```
my:book
```

The following query finds all `book` elements with a `my` prefix that have an `author` subelement:

```
my:book[author]
```

The following query finds all `book` elements with a `my` prefix that have an `author` subelement with a `my` prefix:

```
my:book[my:author]
```
The next example returns the style attribute with a my prefix for book elements in the current context:

```
book/@my:style
```

### Obtaining the URI for an Unparsed Entity

To obtain the URI for an unparsed entity, call the `unparsed-entity-uri()` function. The format is

```
string unparsed-entity-uri(string)
```

This function returns the URI of the unparsed entity with the specified name that is in the same document as the context node. If there is no such entity, this function returns an empty string.

### Determining the Number of Nodes in a Collection

To obtain the number of nodes in a node set, call the `count()` function. The format is

```
number count(node-set)
```

The `count()` function returns the number of nodes in the specified set. For example, the following query finds all authors who have more than ten publications:

```
//author[count(publications) > 10]
```

To obtain the number of nodes in the current context, call the `last()` function, described in the next section.

### Determining the Context Size

To obtain the number of nodes in the current context, call the `last()` function. The format is

```
number last()
```

The `last()` function returns a number equal to the context size of the expression evaluation context. Essentially, the `last()` function returns the position number of the last node in document order for the current context. For example, the following query returns
all books if there are three or more of them. There are three book elements in the current context. Consequently, this query returns three book elements.

/bookstore/book[last() >= 3]

Using XPath Expressions in Stylesheets

This section provides information about using XPath expressions in stylesheets. It includes the following topics:

- “Using Variables” on page 695
- “Obtaining System Properties” on page 695
- “Determining If Functions Are Available” on page 696
- “Obtaining the Current Node for the Current XSLT Template” on page 696
- “Finding an Element with a Particular Key” on page 697
- “Generating Temporary IDs for Nodes” on page 699

Using Variables

In a query that you specify in a stylesheet, you can refer to variables that you defined elsewhere in the stylesheet. Use the following format to refer to a variable:

$variable_name

In a stylesheet, you can define variables with either of the following instructions:

- “xsl:param”
- “xsl:variable”

Obtaining System Properties

In a query in a stylesheet, there are three system properties for which you can obtain information:

- xsl:version returns 1.0 as the version of XSLT that the Stylus Studio XSLT processor implements.
- xsl:vendor returns DataDirect as the vendor of Stylus Studio’s XSLT processor.
- xsl:vendor-url returns http://www.stylusstudio.com as the vendor URL.
**Writing XPath Expressions**

To obtain this information, call the `system-property()` function. The format is

```
object system-property(string)
```

The string you specify must identify one of the three properties and must be a qualified name. This function returns an object that represents the value of the system property you specify.

**Determining If Functions Are Available**

In a query in a stylesheet, to determine whether the XPath processor supports a particular function, call the `function-available()` function. The format is

```
boolean function-available(string)
```

Specify a string that identifies the name of the function. The XPath processor returns `true` if it implements that function.

**Obtaining the Current Node for the Current XSLT Template**

In a stylesheet, the current node is the node for which the XSLT processor instantiates a template. When the XPath processor evaluates an expression during stylesheet processing, the initial context node for the expression is set to the current node for the stylesheet instruction that contains the expression. Because the context node can change during evaluation of subexpressions, it is useful to be able to retrieve, from within a subexpression, the original context node for which the expression is being evaluated. You can use the `current()` function for this purpose. The format is

```
node-set current()
```

The `current()` function returns a node set that contains only the current node for the current template. The `current()` function is specified in the W3C XSLT Recommendation.
For example, the following stylesheet causes the XSLT processor to pass the bookstore node to the outer `<xsl:for-each>` instruction:

```xml
<xsl:stylesheet
  xmlns:xsl="http://www.w3.org/XSL/Transform" version="1.0">
  <xsl:template match="/">
    <xsl:for-each select="bookstore">
      <xsl:for-each select="book[@style=current()/@specialty]">
        ...
      </xsl:for-each>
    </xsl:for-each>
  </xsl:template>
</xsl:stylesheet>
```

The bookstore node is the current node within the outer `<xsl:for-each>` instruction. Within the inner `<xsl:for-each>` instruction, a book node is the current node.

The `current()` function in the inner expression returns the bookstore element because the bookstore element is the current node for the inner `<xsl:for-each>` instruction. The result of the query contains book elements if the value of their `style` attribute is the same as the value of the `specialty` attribute of the bookstore element (novel).

Suppose the `select` attribute in the inner `<xsl:for-each>` instruction specified the dot (.) instead of the `current()` function:

```xml
<xsl:for-each select="book[@style=./@specialty]">
```

In a query, the dot specifies the context node. This query would return a book if the value of its `style` attribute was the same as the value of its `specialty` attribute.

You can nest `<xsl:for-each>` instructions more than one level deep. In any given nested `<xsl:for-each>` instruction, the `current()` function returns the current node for the closest enclosing `<xsl:for-each>` instruction.

### Finding an Element with a Particular Key

The `key()` function, defined in the XSLT Recommendation, obtains the node whose key value matches the specified key. The format is

```xml
node-set key(string, object)
```
Writing XPath Expressions

The first argument specifies the name of the key. The value of this argument must be a qualified name. The second argument specifies the node or nodes to examine. When the second argument is a node set, the result is the union of the results of applying the key() function to the string value of each of the nodes in the set. When the second argument is any other type, the XPath processor converts the argument to a string, as if by a call to the string() function. The key() function returns a node set that contains the nodes in the same document as the context node that have a value for the named key that is equal to this string.

Example

For example, the videos.xml document, which is in the examples directory of the Stylus Studio installation directory, contains the following elements:

```xml
<result>
  <actors>
    <actor id="00000003">Jones, Tommy Lee</actor>
    ...
  </actors>
  <videos>
    <video id="id1235AA0">
      <title>The Fugitive</title>
      ...
      <actorRef>00000003</actorRef>
      <actorRef>00000006</actorRef>
      ...
    </video>
    ...
  </videos>
</result>
```

When you display information about a video in a Web browser, you want to display the names of the actors. Because the actors are referenced only by an ID number, you create a key table in your stylesheet:

```xml
<xsl:key name="actors" match="/result/actors/actor" use="@id"/>
```

This indexes all actors by their ID. To process a video, your stylesheet specifies the following:

```xml
<xsl:for-each select="actorRef">
  <xsl:value-of select="key('actors', .)"/>
</xsl:for-each>
```
Accessing Other Documents During Query Execution

This instructs the XPath processor to look up the actor element in the actors key table by using the actorRef element as a key.

Generating Temporary IDs for Nodes

The generate-id() function, defined in the XSLT recommendation, generates temporary IDs for nodes.

**Caution**  The ID generated by the generate-id() function is not an object ID. The value generated by the generate-id() function is guaranteed to be the same only during an XSL transformation. If the source document changes, the value for this ID can change.

**Format**

The format for the generate-id() function is as follows:

```
string generate-id(node-set?)
```

The generate-id() function returns a string that uniquely identifies the node in node-set that is first in document order. This string starts with x1n and ends with eight hexadecimal digits. Syntactically, the string is an XML name.

If the node-set argument is empty, the generate-id() function returns an empty string. If you omit the node-set argument, the generate-id() function generates a temporary ID for the context node.

Accessing Other Documents During Query Execution

During execution of a query, you might want to access data in another document. To do this, call the document() function.

This section discusses the following topics:

- “Format of the document() Function” on page 700
- “When the First Argument is a Node Set” on page 700
- “Specification of Second Argument” on page 700
- “Example of Calling the document() Function” on page 701
Writing XPath Expressions

Format of the document() Function

To query multiple documents with a single query, call the `document()` function in a query. During execution of a query on a particular document, this function allows you to access another XML document.

The format for the `document()` function is

```
node-set document(object, node-set?)
```

The XPath processor examines the first argument. If it is a single value (that is, it is not a node set) the XPath processor converts it to a string, if it is not already a string. Separate directory names and the file name with a forward slash (/). See the following format:

This string must be an absolute path. The XPath processor retrieves the specified document. The new context node is the root node of this document. Suppose you invoke the `document()` function and the requested document does not exist. If the invocation is in a stylesheet, the XPath processor returns an empty node set. If the invocation is anywhere else, the XPath processor returns an error message.

When the First Argument is a Node Set

It is possible for the first argument of the `document()` function to be a node set. In this case, the result is as if you had called the `document()` function on each node in this node set. That is, the first argument of the `document()` function is each node in the node set in turn. The second argument, if there is one, is the same for each iteration of the `document()` function. This allows you to obtain the contents of multiple documents.

Specification of Second Argument

If you specify a second argument, it must be a node set. The XPath processor examines the first node (in the context of document order) in the node set to determine the document that this node belongs to. The XPath processor retrieves the name of the directory that contains this document and appends the relative path from the first argument to the name of the directory. This creates an absolute path, and the XPath processor retrieves the specified document.

If there is no second argument, the query must be an expression in an XSLT stylesheet. The XPath processor appends the relative path to the name of the directory that contains the XSLT stylesheet. This allows the query to examine the stylesheet itself.
Example of Calling the document() Function

Suppose you have the following XML document:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<books>
    <bookstore>bookstore1:bookstore1.xml</bookstore>
    <bookstore>bookstore2:bookstore2.xml</bookstore>
    <bookstore>bookstore3:bookstore3.xml</bookstore>
</books>
```

The following query returns the `bookstore` elements:

```xml
/books/bookstore
```

Now suppose you pass this query to the `document()` function as follows:

```xml
document(/books/bookstore)
```

This query returns the root nodes of `bookstore1.xml`, `bookstore2.xml`, and `bookstore3.xml`.

XPath Quick Reference

This section includes the following topics:

- “XPath Functions Quick Reference” on page 702
- “XPath Syntax Quick Reference” on page 706
- “XPath Abbreviations Quick Reference” on page 707

See also “Precedence of Query Operators” on page 649.
### XPath Functions Quick Reference

Table 72 lists the functions you can call in a query and provides short descriptions.

**Table 72. XPath Function Quick Reference**

<table>
<thead>
<tr>
<th>Function</th>
<th>Source</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean()</td>
<td>XPath</td>
<td>Boolean value that is the result of converting an object to a Boolean value. See “Converting an Object to Boolean” on page 672.</td>
</tr>
<tr>
<td>ceiling()</td>
<td>XPath</td>
<td>Number that is the smallest integer that is not less than a number you specify. See “Obtaining the Largest, Smallest, or Closest Number” on page 676.</td>
</tr>
<tr>
<td>comment()</td>
<td>XPath</td>
<td>Comment nodes. See “Obtaining Particular Types of Nodes By Using Node Tests” on page 688.</td>
</tr>
<tr>
<td>concat()</td>
<td>XPath</td>
<td>String that concatenates two or more strings you specify. See “Concatenating Strings” on page 667.</td>
</tr>
<tr>
<td>contains()</td>
<td>XPath</td>
<td>Nodes that contain the specified string. See “Searching for Strings” on page 664.</td>
</tr>
<tr>
<td>count()</td>
<td>XPath</td>
<td>Number of nodes in the <code>node-set</code> argument. See “Determining the Number of Nodes in a Collection” on page 694.</td>
</tr>
<tr>
<td>current()</td>
<td>XPath</td>
<td>Node for which the current template started its operation. See “Obtaining the Current Node for the Current XSLT Template” on page 696.</td>
</tr>
<tr>
<td>document()</td>
<td>XSLT</td>
<td>Root node of the specified document. See “Accessing Other Documents During Query Execution” on page 699.</td>
</tr>
<tr>
<td>element-available()</td>
<td>XSLT</td>
<td>Boolean value that indicates whether the specified element is supported by the XSLT processor. See “Determining If Functions Are Available” on page 696.</td>
</tr>
<tr>
<td>false()</td>
<td>XPath</td>
<td>false. See “Obtaining Boolean Values” on page 673.</td>
</tr>
<tr>
<td>Function</td>
<td>Source</td>
<td>Returns</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>floor()</td>
<td>XPath</td>
<td>Number that is the largest integer that is not greater than a number you specify. See “Obtaining the Largest, Smallest, or Closest Number” on page 676.</td>
</tr>
<tr>
<td>function-available()</td>
<td>XSLT</td>
<td>Boolean value that indicates whether the specified function is supported by the XPath processor. See “Determining If Functions Are Available” on page 696.</td>
</tr>
<tr>
<td>generate-id()</td>
<td>XSLT</td>
<td>String that uniquely, temporarily, identifies a node. See “Generating Temporary IDs for Nodes” on page 699.</td>
</tr>
<tr>
<td>id()</td>
<td>XPath</td>
<td>Element whose id attribute value matches the specified value. See “Finding an Element with a Particular ID” on page 686.</td>
</tr>
<tr>
<td>key()</td>
<td>XSLT</td>
<td>Node whose key value matches the specified key. See “Finding an Element with a Particular Key” on page 697.</td>
</tr>
<tr>
<td>lang()</td>
<td>XPath</td>
<td>Boolean value that indicates whether the language of the node is the language you expect. See “Determining the Context Node Language” on page 673.</td>
</tr>
<tr>
<td>last()</td>
<td>XPath</td>
<td>Number of nodes in the context list. See “Determining the Number of Nodes in a Collection” on page 694.</td>
</tr>
<tr>
<td>local-name()</td>
<td>XPath</td>
<td>Local portion of the node name, excluding the prefix. See “Obtaining Namespace Information” on page 691.</td>
</tr>
<tr>
<td>name()</td>
<td>XPath</td>
<td>String that contains the tag name of the node, including namespace information, if any. See “Obtaining Namespace Information” on page 691.</td>
</tr>
</tbody>
</table>
### Table 72. XPath Function Quick Reference

<table>
<thead>
<tr>
<th>Function</th>
<th>Source</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>namespace-uri()</td>
<td>XPath</td>
<td>URI for the namespace of the node. See “Obtaining Namespace Information” on page 691.</td>
</tr>
<tr>
<td>node()</td>
<td>XPath</td>
<td>All nonattribute nodes. See “Obtaining Particular Types of Nodes By Using Node Tests” on page 688.</td>
</tr>
<tr>
<td>normalize-space()</td>
<td>XPath</td>
<td>String without leading or trailing white space. See “Normalizing Strings” on page 668.</td>
</tr>
<tr>
<td>not()</td>
<td>XPath</td>
<td>Boolean value that indicates the opposite of the specified Boolean value. See “Obtaining Boolean Values” on page 673.</td>
</tr>
<tr>
<td>number()</td>
<td>XPath</td>
<td>Number that is the result of converting the specified argument to a number. See “Converting an Object to a Number” on page 675.</td>
</tr>
<tr>
<td>position()</td>
<td>XPath</td>
<td>Position number of the node relative to the context node set. See “Finding a Particular Node” on page 682.</td>
</tr>
<tr>
<td>processing-instruction()</td>
<td>XPath</td>
<td>Processing instruction nodes. If you specify a literal argument, this function returns a processing instruction if its name matches the literal you specify. See “Obtaining Particular Types of Nodes By Using Node Tests” on page 688.</td>
</tr>
<tr>
<td>round()</td>
<td>XPath</td>
<td>Number that is the closest to the argument and is an integer. See “Obtaining the Largest, Smallest, or Closest Number” on page 676.</td>
</tr>
<tr>
<td>starts-with()</td>
<td>XPath</td>
<td>Boolean value that indicates if a string starts with a particular string. See “Finding Strings That Start with a Particular String” on page 670.</td>
</tr>
<tr>
<td>string()</td>
<td>XPath</td>
<td>String that is the result of converting some object to a string. See “Converting Objects to Strings” on page 669.</td>
</tr>
<tr>
<td>Function</td>
<td>Source</td>
<td>Returns</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>string-length()</td>
<td>XPath</td>
<td>Number of characters in a string you specify. See “Determining the Number of Characters in a String” on page 667.</td>
</tr>
<tr>
<td>substring()</td>
<td>XPath</td>
<td>Substring that is in a particular position within its string. See “Finding Substrings by Position” on page 666.</td>
</tr>
<tr>
<td>substring-before()</td>
<td>XPath</td>
<td>Substring that appears before a string you specify. See “Finding Substrings That Appear Before Strings You Specify” on page 665.</td>
</tr>
<tr>
<td>substring-after()</td>
<td>XPath</td>
<td>Substring that appears after a string you specify. See “Finding Substrings That Appear After Strings You Specify” on page 666.</td>
</tr>
<tr>
<td>sum()</td>
<td>XPath</td>
<td>Number that is the sum of the values of the nodes in the specified set. See “Obtaining the Sum of the Values in a Node Set” on page 676.</td>
</tr>
<tr>
<td>system-property()</td>
<td>XSLT</td>
<td>Object that represents the specified property. See “Obtaining System Properties” on page 695.</td>
</tr>
<tr>
<td>translate()</td>
<td>XPath</td>
<td>String with some characters replaced by other characters. See “Replacing Characters in Strings with Characters You Specify” on page 668.</td>
</tr>
<tr>
<td>true()</td>
<td>XPath</td>
<td>true. See “Obtaining Boolean Values” on page 673.</td>
</tr>
<tr>
<td>unparsed-entity-uri()</td>
<td>XSLT</td>
<td>URI of an unparsed entity with the specified name. See “Obtaining the URI for an Unparsed Entity” on page 694.</td>
</tr>
</tbody>
</table>
Writing XPath Expressions

XPath Syntax Quick Reference

This topic provides a quick reference for XPath expression syntax.

Axes

XPath provides the following axes:
- ancestor
- ancestor-or-self
- attribute
- child
- descendant
- descendant-or-self
- following
- following-sibling
- namespace
- parent
- preceding
- preceding-sibling
- self

Node Tests

XPath provides the following node tests:
- * selects all nodes of the specified name. For the attribute axis, attributes are selected. For the namespace axis, namespace nodes are selected. For all other axes, element nodes are selected.
- comment() selects all comment nodes.
- element_name selects all element_name nodes.
- node() selects all nodes.
- processing-instruction(["some_literal"]) selects all processing instructions. If some_literal is specified, processing-instruction() selects all processing instructions with some_literal as their name.
- text() selects all text nodes.
Filters

A filter specifies a constraint on a node set with respect to an axis to produce a new node set.

Location Steps

A location step has the following format:

\[ AxisSpecifier::NodeTest[Filter][Filter]... \]

XPath Expression

An XPath expression has one of the following formats:

\[ LocationStep[/LocationStep]... \]
\[ FunctionCall()[Filter]/LocationStep[/LocationStep]... \]
\[ (Expression)[Filter]/LocationStep[/LocationStep]... \]

A function call or an XPath expression in parentheses can appear only at the very beginning of an XPath expression. An expression in parentheses always returns a node set. Any function that appears at the beginning of an XPath location step expression must return a node set.

XPath Abbreviations Quick Reference

Table 73 defines the abbreviations you can use in XPath expressions:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No axis is specified in a location step.</td>
<td>The child axis is assumed. For example, the following two XPath expressions both return the para children of chapter children of the context node: chapter/para child::chapter/child::para</td>
</tr>
<tr>
<td>@</td>
<td>The attribute axis. For example, the following two XPath expressions both return para children of the context node that have type attributes with a value of warning: para[@type=&quot;warning&quot;] child::para[@attribute::type=&quot;warning&quot;]</td>
</tr>
</tbody>
</table>
Writing XPath Expressions

Table 74 shows examples of abbreviations in XPath expressions

Table 74. Abbreviations in XPath Expressions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>para</td>
<td>Selects the para children of the context node</td>
</tr>
<tr>
<td>*</td>
<td>Selects all element children of the context node</td>
</tr>
<tr>
<td>node_test</td>
<td>Evaluates all children of the context node and returns those that test true for the particular node_test</td>
</tr>
<tr>
<td>*/para</td>
<td>Selects all para grandchildren of the context node</td>
</tr>
<tr>
<td>para[1]</td>
<td>Selects the first para child of the context node</td>
</tr>
</tbody>
</table>
### Table 74. Abbreviations in XPath Expressions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>para[last()]</code></td>
<td>Selects the last <code>para</code> child of the context node</td>
</tr>
<tr>
<td><code>/doc/chapter[5]/section[2]</code></td>
<td>Selects the second section of the fifth chapter of the <code>doc</code> child of the context node</td>
</tr>
<tr>
<td><code>para[@type=&quot;warning&quot;]</code></td>
<td>Selects <code>para</code> children of the context node that have <code>type</code> attributes with a value of <code>warning</code></td>
</tr>
<tr>
<td><code>para[@type=&quot;warning&quot;][5]</code></td>
<td>Selects the fifth <code>para</code> child of the context node that has a <code>type</code> attribute with a value of <code>warning</code></td>
</tr>
<tr>
<td><code>para[5][@type=&quot;warning&quot;]</code></td>
<td>Selects the fifth <code>para</code> child of the context node if that child has a <code>type</code> attribute with a value of <code>warning</code></td>
</tr>
<tr>
<td><code>chapter[title]</code></td>
<td>Selects the <code>chapter</code> children of the context node that have one or more <code>title</code> children</td>
</tr>
<tr>
<td><code>//para</code></td>
<td>Selects all <code>para</code> descendants of the document root</td>
</tr>
<tr>
<td><code>chapter//para</code></td>
<td>Selects all <code>para</code> descendants of <code>chapter</code> children of the context node</td>
</tr>
<tr>
<td><code>//olist/item</code></td>
<td>Selects all <code>item</code> elements that have <code>olist</code> parents</td>
</tr>
<tr>
<td><code>.</code></td>
<td>Selects the context node</td>
</tr>
<tr>
<td><code>./para</code></td>
<td>Selects the <code>para</code> descendants of the context node</td>
</tr>
<tr>
<td><code>../para</code></td>
<td>Selects the parent of the context node</td>
</tr>
<tr>
<td><code>@*</code></td>
<td>Selects all attributes of the context node</td>
</tr>
<tr>
<td><code>@name</code></td>
<td>Selects the <code>name</code> attribute of the context node</td>
</tr>
<tr>
<td><code>../@name</code></td>
<td>Selects the <code>name</code> attribute of the parent of the context node</td>
</tr>
</tbody>
</table>
Chapter 10  Working with XQuery in Stylus Studio

Stylus Studio provides many features for working with XML Query (XQuery), including a graphical mapper that allows you to construct a query without writing any code, and tools to help you run and debug XQueries.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Introduction to the XQuery Mapper video.

You can learn more about other video demonstrations of the XQuery Mapper here: http://www.stylusstudio.com/learn_xquery.html#xquery_1.

Contents

- “Getting Started with XQuery in Stylus Studio” on page 712
- “An XQuery Primer” on page 716
- “Understanding FLWOR Expressions” on page 728
- “Building an XQuery Using the Mapper” on page 744
- “Working with the XQuery collection() Function” on page 772
- “Debugging XQuery Documents” on page 780
- “Creating an XQuery Scenario” on page 788
- “Generating XQuery Documentation” on page 798
- “Using XQuery to Invoke a Web Service” on page 802
- “Generating Java Code for XQuery” on page 805
Getting Started with XQuery in Stylus Studio

This section describes working with XQuery in Stylus Studio. It covers the following topics:

- What is XQuery? on page 712
- What is an XQuery? on page 713
- The Stylus Studio XQuery Editor on page 713

What is XQuery?

XML Query (XQuery) is the World Wide Web Consortium (W3C) language for querying XML. XQuery is a language developed by the W3C XML Query working group.

Example

The XQuery grammar allows you to define expressions like those shown in the following sample XQuery, R-Q2.xquery:

```xml
<result>
  {   
    for $i in document("items.xml")/items/item_tuple 
      let $b := document("bids.xml")//bid_tuple[itemno = $i/itemno] 
      where contains($i/description,"Bicycle") 
      order by $i/itemno 
      return 
      <item_tuple>
        {$i/itemno}
        {$i/description}
        <high_bid>
          { max ( for $c in $b/bid return xs:decimal($c) ) } 
        </high_bid>
      </item_tuple>
  }
</result>
```

This and other XQuery examples are provided in the Stylus Studio examples\XQuery directory.

Sources for Additional XQuery Information

See An XQuery Primer on page 716 if you are just getting started with XQuery. For more detailed information, including the formal W3C XQuery specification, visit http://www.w3.org/XML/Query (the W3C page for XML Query).
Getting Started with XQuery in Stylus Studio

What is an XQuery?

In Stylus Studio, an XQuery is a document with a .xquery extension. Stylus Studio expects documents with this extension to contain a query expressed using the XML Query language.

The Stylus Studio XQuery Editor

In Stylus Studio, you use the XQuery editor’s textual editor and graphical interfaces to work with XQuery. The XQuery editor, which consists of two tabs, XQuery Source and Mapper, is displayed any time the active document within Stylus Studio is an XQuery document. You can use either or both tabs to compose an XQuery.

By default, Stylus Studio gives new XQuery files a .xquery extension. You can save XQueries using any extension you choose. If you decide to use a different extension, use the File Types page of the Options dialog box to associate that extension with the XQuery editor.

XQuery Source Tab

You can use the XQuery Source tab to view, compose, preview, and debug your XQuery. For example, you can edit query text directly, set breakpoints, and debug your XQuery on this tab. The tab is divided into two panes:

- An editing pane, which shows the XQuery code, and
- A schema pane, which displays the schema of the source documents you are using to build your XQuery. You can hide the schema pane to view more of the XQuery code by clicking the show/hide button at the base of the splitter, which allows you to vary the relative width of the two panes.

Tip

You can drag schema objects directly to the editing pane. This allows you to quickly create FLWOR and XPath expressions, for example, without writing any code or introducing typographical errors to the source.
Stylus Studio’s Sense:X automatic completion feature is supported for XQuery – Sense:X simplifies editing and helps ensure well-formed XML for queries you compose manually.

You can define other XQuery editor settings on the Editor General and Editor Format pages of the Options dialog box. (Click Tools > Options.)

You can preview the XQuery result by clicking the Preview Result button ( ). Results are displayed in the Preview window at the bottom of the XQuery editor, and, optionally, in any external application that you specify.
Mapper Tab

The Mapper tab provides an interface that allows you to compose and view your XQuery graphically.

![Figure 305. XQuery Editor Mapper Tab](image)

The Mapper tab consists of these areas:

- Source document pane, in which you add one or more source documents.
- Target structure pane, in which you specify the structure of the result you want the XQuery to return.
- Mapper canvas, on which you can define conditions, functions, and operations for source document nodes to filter return values that are then mapped to the target node.
- Text pane. The text pane allows you to view the XQuery code while using the mapper. This is a great way to see how changes to the mapper affect the XQuery code, without the need to switch to the XQuery Source tab. Of course, the XQuery Source tab is available if you prefer working with the code using a full-page view. All views – Mapper tab, XQuery Source tab, and the text pane – are synchronized.
As with the **XQuery Source** tab, you can preview XQuery results from the **Mapper** tab by clicking the **Preview Result** button ( ). Debugging, however, can be performed from the **XQuery Source** tab only.

For more information, see “Building an XQuery Using the Mapper” on page 744 to learn more about the features of the XQuery editor **Mapper** tab.

### XQuery Source and Mapper Tab Interaction

Changes made to an XQuery on the **Mapper** tab are reflected on the **XQuery Source** tab, and vice versa. For example, if you start writing your XQuery on the **XQuery Source** tab and then click the **Mapper** tab, Stylus Studio displays a graphic representation of your XQuery code. If you next edit the XQuery graphically (adding a function or a FLWOR block and mapping the return value to a node in the target structure, for example) and then return to the **XQuery Source** tab, you will see that Stylus Studio has updated the XQuery code based on your edits on the **Mapper** tab. Viewing the code on the **XQuery Source** tab that Stylus Studio creates based on actions performed on the **Mapper** tab can be a useful aid to learning XQuery syntax.

**Note** An incomplete XQuery artifact created on the **Mapper** tab is removed from the XQuery you are composing when you click the **XQuery Source** tab because it cannot be expressed in XQuery given its current definition. For example, imagine creating a FLWOR block that is not mapped to a node in the target structure. The FLWOR (pronounced “flower”) block appears on the **Mapper** tab, but Stylus Studio does not generate any code for it or display it on the **XQuery Source** tab, and when you return to the **Mapper** tab you will see that the FLWOR block has been removed.

### An XQuery Primer

This XQuery primer was adapted from a whitepaper written by Dr. Michael Kay. You can read the original document on the Stylus Studio Web site. This primer covers the following topics:

- “What is XQuery For?” on page 717
- “Your First XQueries” on page 717
- “Accessing XML Documents with XQuery” on page 718
- “XQuery and XPath” on page 719
- “Introduction to FLWOR Expressions” on page 723
- “Generating XML Output with XQuery” on page 725
What is XQuery For?

XQuery was devised primarily as a query language for data stored in XML form. So its main role is to get information out of XML databases — this includes relational databases that store XML data, or that present an XML view of the data they hold.

Some people are also using XQuery for manipulating free-standing XML documents, for example, for transforming messages passing between applications. In that role XQuery competes directly with XSLT, and which language you choose is largely a matter of personal preference.

In fact, some people like XQuery so much that they are even using it for rendering XML into HTML for presentation. That's not really the job XQuery was designed for, and there are other technologies, like XSLT, that are better suited for this purpose, but once you get to know a tool, you tend to find new ways of using it.

Your First XQueries

Try a few simple examples to get acquainted with XQuery. Start Stylus Studio, and open a new XQuery document (File > New > XQuery File). Save the file now (if you do not, Stylus Studio will prompt you to save it when you preview your first XQuery).

Type the following in the XQuery Editor:

```
"Hello, world!"
```

Now, click the Preview Result button ( ), and Stylus Studio displays the result of this XQuery in the Preview window:

```
"Hello, world!"
```

Enter a simple equation (2+2) and click the Preview Result button ( ). Predictably, the result is:

```
4
```
Finally, try the XQuery function `current-time()` and click the **Preview Result** button:

```
11:27:38Z
```

Your results will vary based on several conditions. For example, the XQuery processor you use to execute the XQuery will affect the precision of the time value (fractions of seconds), and the time zone (here, shown as Z) is determined by how your system is configured.

None of these is a very useful query on its own, but within a query language you need to be able to perform little calculations and XQuery has this covered. Further, XQuery is designed so that expressions can be fully nested – that is, any expression can be used within any other expression, provided that it delivers a value of the right type – and this means that expressions that are primarily intended for selecting data within a `where` clause can also be used as free-standing queries in their own right.

### Accessing XML Documents with XQuery

Though XQuery is capable of handling mundane tasks like those described in the previous section, it is designed to access XML data. Right now, we will look at some simple queries that require an XML document as their input. For this purpose, we will use `videos.xml`, which is installed with Stylus Studio in the `examples\VideoCenter` directory. You can also find a copy of this XML document on the Stylus Studio Web site.

XQuery allows you to access the file directly from either of these locations, using a suitable URL as an argument for its `doc()` function. If you wanted to retrieve and display the entire file from your Stylus Studio installation directory, your `doc()` might look like this:

```
doc('file:///c:/Program%20Files/Stylus%20Studio%206%20XML%20Professional%20Edition/examples/VideoCenter/videos.xml')
```

To fetch this document from the Stylus Studio Web site, you would need a `doc()` like this:

```
doc('http://www.stylusstudio.com/examples/videos.xml')
```

(The latter `doc()` function will work only if you are online; and if you are behind a corporate firewall you might have to modify your Java configuration to make it work.)
Handling URLs

URLs like those used in the previous example can be a bit unwieldy, but there are some shortcuts you can use.

- In Stylus Studio, you can specify the source document as the **Main Input** on the **General** tab of the **Scenario Properties** dialog box. Once you browse to the appropriate file and select it, you can refer to it in your XQuery code as simply “.” (dot).

- If you are working directly with a command line processor such as Saxon, you can copy the file locally (c:\xml\videos.xml, for example) and work with it from that location. Once you have done this, you can use the command line option `-s c:\xml\videos.xml` and again be able to refer to the input document in your XQuery code as “.” (dot).

The videos.xml Document

The videos.xml document contains a number of sections: video_template, actors, and videos. You might want to open this document in the XML Editor to get acquainted with it if you are not already familiar with it.

XQuery and XPath

We can access the actors section of videos.xml using this expression: `//actors`. When we execute this XQuery we get the following result:

```xml
<actors>
  <actor id="00000015">Anderson, Jeff</actor>
  <actor id="00000030">Bishop, Kevin</actor>
  <actor id="0000000f">Bonet, Lisa</actor>
  <actor id="00000024">Bowz, Eddie</actor>
  <actor id="0000002d">Curry, Tim</actor>
  <actor id="00000033">Dullea, Keir</actor>
  <actor id="00000042">Fisher, Carrie</actor>
  <actor id="00000006">Ford, Harrison</actor>
  <actor id="00000045">Foster, Jodie</actor>
  ...
</actors>
```

That was our first “real” query. If you are familiar with XPath, you might recognize that all the queries so far have been valid XPath expressions. We have used a couple of functions – `current-time()` and `doc()` – that might be unfamiliar because they are new in XPath 2.0, which is still only a draft; but the syntax of all the queries so far is plain
Working with XQuery in Stylus Studio

XPath syntax. In fact, the XQuery language is designed so that every valid XPath expression is also a valid XQuery query.

This means we can write more complex XPath expressions like this one:

```
斯坦福//actors/actor[ends-with(., 'Lisa')]
```

which gives us this output:

```
<actor id="0000000f">Bonet, Lisa</actor>
<actor id="0000001b">Spoonhauer, Lisa</actor>
```

Different systems might display this output in different ways. Technically, the result of this query is a sequence of two element nodes in a tree representation of the source XML document, and there are many ways a system might choose to display such a sequence on the screen. Stylus Studio gives you the choice of a text view, like the one shown above, and a tree view: you use the buttons next to the Preview window to switch from one to the other. Here is what the tree view looks like:

**Figure 306. XQuery Preview Window Tree View**

This example used another function – `ends-with()` – that's new in XPath 2.0. We are calling it inside a predicate (the expression between the square brackets), which defines a
An XQuery Primer

condition that nodes must satisfy in order to be selected. This XPath expression has two parts: a path `//actors/actor` that indicates which elements we are interested in, and a predicate `[ends-with(., 'Lisa')]` that indicates a test that the nodes must satisfy. The predicate is evaluated once for each selected element; within the predicate, the expression `.` (dot) refers to the node that the predicate is testing, that is, the selected actor.

The “/” in the path informally means “go down one level”, while the “//” means “go down any number of levels”. If the path starts with “./” or “../” you can leave out the initial “.”. (This assumes that the selection starts from the top of the tree, which is always the case in our examples.) You can also use constructs like “../” to go up one level, and “/@id” to select an attribute. Again, this is all familiar if you already know XPath.

XPath is capable of doing some pretty powerful selections, and before we move on to XQuery proper, let us look at a more complex example. Suppose we want to find the titles of all the videos featuring an actor whose first name is Lisa. If we look at the videos.xml file, we see that each video in the file is represented by a video element like this one:

```xml
<video id="647599251">
  <director>Francesco Rosi</director>
  <actorRef>916503211</actorRef>
  <actorRef>916503212</actorRef>
  <title>Carmen</title>
  <dvd>18</dvd>
  <laserdisk/>
  <laserdisk_stock/>
  <genre>musical</genre>
  <rating>PG</rating>
  <runtime>125</runtime>
  <user_rating>4</user_rating>
  <summary>A fine screen adaptation of Bizet's popular opera.</summary>
  <details>Placido Domingo does it again, this time in Bizet's popular opera.</details>
  <beta></beta>
</video>
```

The query required to provide the results we desire is written like this:

```
//video[actorRef=//actors/actor[ends-with(., 'Lisa')]/@id]/title
```

Again, this is pure XPath (and therefore a valid XQuery). You can read it from left-to-right as:

- Start at the implicitly-selected document (videos.xml)
- Select all the <video> elements at any level
Choose those that have an actorRef element whose value is equal to one of the values of the following:
- Select all the <actors> elements at any level
- Select all their <actor> child elements
- Select the element only if its value ends with ‘Lisa’
- Select the value of the id attribute

Select the <title> child element of these selected <video> elements

When run against our source document, the result of this XQuery is:

```
<title>Enemy of the State</title>
<title>Clerks</title>
```

Many people find that at this level of complexity, XPath syntax gets rather mind-boggling. In fact, this example just about stretches XPath to its limits. For this kind of query, and for anything more complicated, XQuery syntax comes into its own. But it is worth remembering that there are many simple things you can do with XPath alone, and that every valid XPath expression is also valid in XQuery.
XPath Query Editor

Stylus Studio provides a built-in XPath Query Editor in its XML Editor that allows you to visually edit and test complex XPath expressions, and it supports both version 1.0 and 2.0.

See “Using the XPath Query Editor” to learn more about using this tool.

Introduction to FLWOR Expressions

If you have used SQL, then you will have recognized the last example as a join between two tables – the videos table and the actors table. Join queries are not quite the same in XML, because the data is hierarchic rather than tabular, but XQuery allows you to write join queries in a similar way to the familiar SQL approach. The equivalent of the SQL SELECT expression is called the FLWOR expression, named after its five clauses: for, let,
where, order by, return. Here is the last example (all videos with an actor named ‘Lisa’, rewritten this time as a FLWOR expression.

```
let $doc := .
for $v in $doc/video,
   $a in $doc/actors/actor
where ends-with($a, 'Lisa')
   and $v/actorRef = $a/@id
return $v/title
```

When we run this XQuery, we get the same result as before.

Let’s examine the FLWOR expression:

- The `let` clause simply declares a variable. We included this here because when we deploy the query we might want to set this variable differently; for example, we might want to initialize it to `doc('videos.xml')`, or to the result of some complex query that locates the document in a database.

- The `for` clause defines two range variables: one processes all the videos in turn, the other processes all the actors in turn. Taken together, the FLWOR expression is processing all possible pairs of videos and actors.

- The `where` clause then selects those pairs that we are actually interested in. We are only interested if the actor appears in that video, and we are only interested if the actor’s name ends in ‘Lisa’.

- Finally the return clause tells the system what information we want to get back. In this case we want the title of the video.

If you have been following very closely, you might have noticed one little XPath trick that we retained in this query: most videos will feature more than one actor (though this particular database does not attempt to catalog the bit-part players). The expression `$v/actorRef` therefore selects several elements. The rules for the `=` operator in XPath (and therefore also in XQuery) are that it compares everything on the left with everything on the right and returns true if there is at least one match. In effect, it is doing an implicit join. If you want to avoid exploiting this feature, and you want to write your query in a more classically relational form, you could express it as follows:

```
let $doc := .
for $v in $doc/video,
   $va in $v/actorRef,
   $a in $doc/actors/actor
where ends-with($a, 'Lisa')
   and $va eq $a/@id
return $v/title
```
This time we used a different equality operator, \( \texttt{eq} \), which follows more conventional rules than \( \texttt{=} \) does: it strictly compares one value on the left with one value on the right. (But like comparisons in SQL, it has special rules to handle the case where one of the values is absent.)

What about the \( \text{O} \) in FLWOR? That is there so you can get the results in sorted order. Suppose you want the videos in order of their release date. Here's the revised query:

```xquery
let $doc := .
for $v in $doc//video,
  $a in $doc//actors/actor
where ends-with($a, 'Lisa')
  and $v/actorRef = $a/@id
order by $v/year
return $v/title
```

If you are wondering why FLWOR is not really a LFWOR expression: the \texttt{for} and \texttt{let} clauses can appear in any order, and you can have any number of each. To learn more about the FLWOR expression, see \textit{Understanding FLWOR Expressions} on page 728.

**Generating XML Output with XQuery**

So far all the queries we have written have selected nodes in the source document. We have shown the results as if the system copies the nodes to create some kind of result document, and if you execute the XQuery in Stylus Studio or run Saxon from the command line that is exactly what happens. But this is simply a default mode of execution. In a real application you want control over the form of the output document, which might well be the input to another application – perhaps the input to an XSLT transformation or even another query.
Working with XQuery in Stylus Studio

XQuery allows the structure of the result document to be defined using an XML-like notation. Here is an example that fleshes out our previous query with some XML markup:

```xml
declare variable $firstName as xs:string external;
<videos featuring="{$firstName}">
  
  let $doc := .
  for $v in $doc//video,
    $a in $doc//actors/actor
    where ends-with($a, $firstName)
    and $v/actorRef = $a/@id
    order by $v/year
    return
    <video year="{$v/year}">
      {$v/title}
    </video>
  
</videos>
```

We have also changed the query so that the actor's first name is now an externally defined parameter. This makes the query reusable. The way parameters are supplied varies from one XQuery processor to another. In Stylus Studio, select XQuery > Scenario Properties; click the Parameter Values tab, and Stylus Studio provides an area to specify values for any variables defined in the XQuery.

![Image of Scenario Properties window]

We can enter “Lisa”, in quotes (Stylus Studio expects an expression, so if the quotes are omitted, this value would be taken as a reference to an element named <Lisa>).
If instead you are running Saxon from the command line, you can enter:

```
java net.sf.saxon.Query sample.xquery firstName=Lisa
```

Either way, our XQuery returns the following result:

```xml
<videos featuring="Lisa">
  <video year="1999">
    <title>Enemy of the State</title>
  </video>
  <video year="1999">
    <title>Clerks</title>
  </video>
</videos>
```

As you might recall from our previous XQuery, this version of the XQuery is not especially well-designed as it returns videos featuring different actresses named Lisa. Take some time and modify the XQuery to see if you can improve it.

## Accessing Databases with XQuery

At the start of this section, we stated that the main purpose of XQuery is to extract data from XML databases, but all our examples have used a single XML document as input.

People sometimes squeeze a large data set (for example, a corporate phone directory) into a single XML document, and process it as a file without the benefit of any database system. While there are preferable alternatives, if the data volumes do not go above a few megabytes and the transaction rate is modest, then XML-document-as-database is a perfectly feasible storage mechanism. In other words, the examples in this section are not totally unrealistic.

If you have got a real database, however, the form of the queries used in this section will not need to change all that much from these examples. Instead of using the `doc()` function (or simply `"."`) to select a document, you are likely to call the `collection()` function to open a database, or a specific collection of documents within a database. The actual way collections are named is likely to vary from one database system to another. The result of the XQuery `collection()` function is a set of documents (more strictly, a sequence of documents, but the order is unlikely to matter), and you can process this using XPath expressions or FLWOR expressions in just the same way as you address a single document.

There is a lot more to databases than doing queries, of course. Each product has its own ways of setting up the database, defining schemas, loading documents, and performing maintenance operations such as backup and recovery. XQuery currently handles only one
small part of the job. In the future it is also likely to have an update capability, but in the meantime each vendor is defining his own.

One particularly nice feature of XQuery is that it has the potential to combine data from multiple databases (and freestanding XML documents). DataDirect XQuery™, which supports access to Oracle, DB2, SQL Server, and Sybase is one product that addresses this need.

Understanding FLWOR Expressions

This XQuery primer was adapted from a whitepaper written by Dr. Michael Kay. You can read the original document on the Stylus Studio Web site. This section covers the following topics:

- “Simple XQuery FLWOR Expressions” on page 728
- “The Principal Parts of an XQuery FLWOR Expression” on page 729
- “Other Parts of the XQuery FLWOR Expression” on page 741
- “Grouping” on page 743

Simple XQuery FLWOR Expressions

The simplest XQuery FLWOR expression might be something like this:

```xml
for $v in $doc//video return $v
```

This returns all of the video elements in $doc.

We can add a bit of substance by adding XQuery where and return clauses:

```xml
for $v in $doc//video
where $v/year = 1999
return $v/title
```

This returns all of the titles of videos released in 1999.

If you know SQL, that XQuery probably looks reassuringly similar to the equivalent SQL statement:

```sql
SELECT v.title
FROM video v
WHERE v.year = 1999
```
And if you know XPath, you might be wondering why our XQuery cannot be written as this:

$doc//video[year=1999]/title

Well, you can. This XPath expression is completely equivalent to the FLWOR expression above, and furthermore, it is a legal XQuery query. In fact, every legal XPath expression is also legal in XQuery. Thus the first query in this section can be written as:

$doc//video

Which style you prefer seems to depend on where you are coming from: if you have been using XML for years, especially XML with a deep hierarchy as found in “narrative” documents, then you will probably be comfortable with path expressions. But if you are more used to thinking of your data as representing a table, then the FLWOR style might suit you better.

As you will see, FLWOR expressions are a lot more powerful than path expressions when it comes to doing joins. But for simple queries, the capabilities overlap and you have a choice. Although it might be true that in SQL every query is a SELECT statement, it is not so that in XQuery every query has to be a FLWOR expression.

The Principal Parts of an XQuery FLWOR Expression

The name FLWOR comes from the five clauses that make up a FLWOR expression: for, let, where, order by, and return. Most of these clauses are optional: the only clause that is always present is the XQuery return clause (though there must be at least one XQuery for or let clause as well). To see how FLWOR expressions work, we will build up our understanding one clause at a time.

F is for For

The behavior of the for clause is fairly intuitive: it iterates over an input sequence and calculates some value for each item in that sequence, returning a sequence obtained by concatenating the results of these calculations. In simple cases there is one output item for every input item. So, this FLWOR expression:
returns the sequence (1, 4, 9, 16, 25, 36, 49, 64, 81, 100). In this example, the input items are simple numbers, and the output items are also simple numbers. Numbers are an example of what XQuery calls atomic values; other examples are strings, dates, booleans, and URIs. But the XQuery data model allows sequences to contain XML nodes as well as atomic values, and the for expression can work on either.

Here is an example that takes nodes as input, and produces numbers as output. It counts the number of actors listed for each video in a data file:

```xquery
for $v in //video
return count($v/actorRef)
```

You can run this in Stylus Studio or in Saxon, using the example videos.xml file as input. (Tips on setting up these tools are described in the previous section, “An XQuery Primer” on page 716.) Here's the output from Stylus Studio:

![Stylus Studio output](image)

**Figure 309. FOR Clause in a FLWOR Expression**

The Preview window shows the result: a rather mundane sequence of numbers (2, 4, 3, 3, 3...).

This gives us a good opportunity to point out that a FLWOR expression is just an expression, and you can use it anywhere an expression is allowed: it doesn't have to be at
the top level of the query. There is a function, \( \text{avg}() \), to compute the average of a sequence of numbers, and we can use it here to find the average number of actors listed for each of the movies in our data file:

```xml
avg(
    for $v in //video
    return count($v/actorRef)
)
```

The answer is 2.2941176 and a bit – the number of decimal places shown will depend on the XQuery processor that you use. If you are only interested in the answer to two decimal places, try:

```xml
round-half-to-even(
    avg(
        for $v in //video
        return count($v/actorRef)
    ),
    2)
```

which gives a more manageable answer of 2.29. (The strange name \text{round-half-to-even} is there to describe how this function does rounding: a value such as 2.145 is rounded to the nearest even number, in this case 2.14.) This is all designed to demonstrate that XQuery is a functional language, in which you can calculate a value by passing the result of one expression or function into another expression or function. Any expression can be nested inside any other, and the FLWOR expression is no exception.

If you are coming from SQL, your instinct was probably to try and do the averaging and rounding in the return clause. But the XQuery way is actually much more logical. The return clause calculates one value for each item in the input sequence, whereas the \( \text{avg}() \) function applies to the result of the FLWOR expression as a whole.

As with some of the examples in “An XQuery Primer” on page 716, XPath 2.0 allows you to write this example using path expressions alone if you prefer:

```xml
round-half-to-even(avg(/*//video/count(actorRef)), 2)
```

We have seen a for expression that produces a sequence of numbers from another sequence of numbers, and we have seen one that produces a sequence of numbers from a sequence of selected nodes. We can also turn numbers into nodes: the following query selects the first five videos.

```xml
for $i in 1 to 5 return //video[$i]
```
And we can get from one sequence of nodes to another sequence of nodes. This example shows all the actors that appear in any video:

```
for $actorId in //video/actorRef
return //actors/actor[@id=$actorId]
```

In fact, this last example probably represents the most common kind of for expression encountered, but we introduced it last to avoid leaving you with the impression that it is the only kind there is.

Once again, you could write this example as an XPath expression:

```
//actors/actor[@id=//video/actorRef]
```

However, this time the two expressions are not precisely equivalent. Try them both in Stylus Studio: the FLWOR expression produces a list containing 38 actors, while the list produced by the path expression contains only 36. The reason is that path expressions eliminate duplicates, and FLWOR expressions do not. Two actors are listed twice because they appear in more than one video.

The FLWOR expression and the “/” operator in fact perform quite similar roles: they apply a calculation to every item in a sequence and return the sequence containing the results of these calculations. There are three main differences between the constructs:

- The for expression defines a variable $v that is used in the return clause to refer to each successive item in the input sequence; a path expression instead uses the notion of a context item, which you can refer to as "." In this example, //video is short for ./root()//video, so the reference to the context item is implicit.
- With the “/” operator, the expression on the left must always select nodes rather than atomic values. In the earlier example //video/count(actorRef), the expression on the right returned a number – that’s a new feature in XPath 2.0 – but the left-hand expression must still return nodes.
- When a path expression selects nodes, they are always returned in document order, with duplicates removed. For example, the expression $doc//section//para will return each qualifying <para> element exactly once, even if it appears in several nested <section> elements. If you used the nearest-equivalent FLWOR expression, for $s in $doc//section return $s//para, then a <para> that appears in several nested sections would appear several times in the output, and the order of <para> elements in the output will not necessarily be the same as their order in the original document.
The for clause really comes into its own when you have more than one of them in a FLWOR expression. We will explore that a little later, when we start looking at joins. But first, let’s take a look at the other clauses: starting with let.

L is for Let

The XQuery let clause simply declares a variable and gives it a value:

```xquery
let $maxCredit := 3000
let $overdrawnCustomers := //customer[overdraft > $maxCredit]
return count($overdrawnCustomers)
```

Hopefully the meaning of that is fairly intuitive. In fact, in this example you can simply replace each variable reference by the expression that provides the expression’s value. This means that the result is the same as this:

```xquery
count(//customer[overdraft > 3000])
```

In a for clause, the variable is bound to each item in the sequence in turn. In a let clause, the variable only takes one value. This can be a single item or a sequence (there is no real distinction in XQuery – an item is just a sequence of length one). And of course the sequence can contain nodes, or atomic values, or (if you really want) a mixture of the two.

In most cases, variables are used purely for convenience, to simplify the expressions and make the code more readable. If you need to use the same expression more than once, then declaring a variable is also a good hint to the XQuery processor to only do the evaluation once.

In a FLWOR expression, you can have any number of for clauses, and any number of let clauses, and they can be in any order. For example (returning to the videos.xml data again), you can do this:

```xquery
for $genre in //genre/choice
let $genreVideos := //video[genre = $genre]
let $genreActorRefs := $genreVideos/actorRef
for $actor in //actor[@id = $genreActorRefs]
return concat($genre, " : ", $actor)
```

To understand this, just translate it into English:

For each choice of genre, let’s call the set of videos in that genre $genreVideos. Now let’s call the set of references to all the actors in all those videos $genreActorRefs. For each actor whose ID is equal to one of the references in $genreActorRefs, output
a string formed by concatenating the name of the genre and the name of the actor, separated by a colon.

Here is the result in Stylus Studio:

![Stylus Studio XQuery Editor](image)

**Figure 310. LET Clause in a FLWOR Expression**

As a quick aside, the Stylus Studio XQuery Mapper allows you to visually map from one or more XML input documents to any target output format. In a nutshell – click on the **Mapper** tab on the bottom of the XQuery Editor. Next, click **Add Source Document** and
add your source document(s). Our last XQuery would look like this in the XQuery Mapper:

![XQuery Mapper screenshot](image)

**Figure 311. Simple FLWOR Shown in XQuery Mapper**

The FLWOR block is graphically represented as a function block with three input ports going into it on the left (For, Where, Order By), a flow control port on the top, and an output port on the right. As you draw your XML mappings, Stylus Studio writes the XQuery code; similarly, you can edit the XQuery code manually and Stylus Studio which will update the graphical model – both views of the XQuery are kept synchronized. See “Building an XQuery Using the Mapper” on page 744 for more information on the Mapper module.

One important thing to note about variables in XQuery (you can skip this if you already know XSLT, because the same rule applies there): variables cannot be updated. This means you cannot write something like `let $x := $x+1`. This rule might seem very strange if you are expecting XQuery to behave in the same way as procedural languages such as JavaScript. But XQuery is not that kind of language, it is a declarative language and works at a higher level. There are no rules about the order in which different expressions are executed (which means that the little yellow triangle that shows the current execution point in the Stylus Studio XQuery debugger and XSLT debugger can sometimes behave in surprising ways), and this means that constructs whose result would
depend on order of execution (like variable assignment) are banned. This constraint is essential to give optimizers the chance to find execution strategies that can search vast databases in fractions of a second. Most XSLT users (like SQL users before them) have found that this declarative style of programming grows on you. You start to realize that it enables you to code at a higher level: you tell the system what results you want, rather than telling it how to go about constructing those results.

You might ask yourself at this point, Isn’t a variable being updated when we write something like the following?

```
for $v in //video
let $x := xs:int($v/runtime) * xdt:dayTimeDuration("PT1M")
return concat($v/title, " ",
hours-from-duration($x), " hour(s) ",
minutes-from-duration($x), " minutes")
```

(This query shows the running time of each video. It first converts the stored value from a string to an integer, then multiplies it by one minute (PT1M) to get the running time as a duration, so that it can extract the hours and minutes components of the duration. Try it.)

Here the variable $x has a different value each time around the XQuery for loop. This feels a bit like an update. Technically though, each time round the for loop you are creating a new variable with a new value, rather than assigning a new value to the old variable. What you cannot do is to accumulate a value as you go around the loop. Try doing this to see what happens:

```
let $totalDuration := 0
for $v in //video
let $totalDuration := $totalDuration + $v/runtime
return $totalDuration
```

The result is not a single number, but a sequence of numbers, one for each video. This example is actually declaring two separate variables that happen to have the same name. You are allowed to use the same variable name more than once, but this is probably not a good idea, because it will only get your readers confused. You can see more clearly what this query does if we rename one of the variables.

```
let $zero := 0
for $v in //video
let $totalDuration := $zero + $v/runtime
return $totalDuration
```
which is the same as this:

```xquery
for $v in //video
return 0 + $v/runtime
```

Hopefully it is now clear why this returns a sequence of numbers rather than a single total. The correct way to get the total duration is to use the `sum` function:

```xquery
sum(//video/runtime).
```

### W is for Where

The XQuery `where` clause in a FLWOR expression performs a very similar function to the `WHERE` clause in a SQL `select` statement: it specifies a condition to filter the items we are interested in. The `where` clause in a FLWOR expression is optional, but if it appears it must only appear once, after all the `for` and `let` clauses. Here is an example that restates one of our earlier queries, but this time using a `where` clause:

```xquery
for $genre in //genre/choice
for $video in //video
for $actorRefs in $video/actorRef
for $actor in //actor
where $video/genre = $genre
and $actor/@id = $actorRefs
return concat($genre, " ", $actor)
```

This style of coding is something that SQL users tend to be very comfortable with: first define all the tables you are interested in, then define a `WHERE` expression to define all the restriction conditions that select subsets of the rows in each table, and join conditions that show how the various tables are related.

Although many users seem to find that this style comes naturally, an alternative is to do the restriction in a predicate attached to one of the `for` clauses, like this:

```xquery
for $genre in //genre/choice
for $video in //video[genre = $genre]
for $actorRefs in $video/actorRef
for $actor in //actor[@id = $actorRefs]
return concat($genre, " ", $actor)
```

Perhaps there is a balance between the two; you will have to find the style that suits you best. With some XQuery processors one style or the other might perform better (and with Stylus Studio, you can easily create multiple XQuery scenarios that execute the same code but use different XQuery processors), but a decent optimizer is going to treat the two forms as equivalent.
Working with XQuery in Stylus Studio

Do remember that in a predicate, you select the item that you are testing relative to the context node, while in the `where` clause, you select it using a variable name. A bare name such as `genre` is actually selecting `./child::*:genre` — that is, it is selecting a child of the context node, which in this case is a `<video>` element. It is very common to use such expressions in predicates, and it is very uncommon to use them (except by mistake!) in the `where` clause. If you use a schema-aware processor like Saxon, then you might get an error message when you make this mistake; in other cases, it is likely that the condition will not select anything. The `where` condition will therefore evaluate to false, and you will have to puzzle out why your result set is empty.

O is for Order By

If there is no `order by` clause in a FLWOR expression, then the order of the results is as if the `for` clauses defined a set of nested loops. This does not mean they actually have to be evaluated as nested loops, but the result has to be the same as if they were. That is an important difference from SQL, where the result order in the absence of any explicit sorting is undefined. In fact, XQuery defines an alternative mode of execution, unordered mode, which is similar to the SQL rules. You can select this in the query prolog, and the processor might even make it the default (this is most likely to happen with products that use XQuery to search a relational database). Some products (Stylus Studio and Saxon among them) give you exactly the same result whether or not you specify unordered mode — since the XQuery specification says that in unordered mode anything goes, that is perfectly acceptable.

Often however you want the query results in sorted order, and this can be achieved using the `order by` clause. Let's sort our videos in ascending order of year, and within that in decreasing order of the user rating:

```xquery
for $x in //video
order by $x/year ascending, number($x/user-rating) descending
return $x/title
```

Note that we have not actually included the sort keys in the data that we are returning (which makes it a little difficult to verify that it is working properly; but it is something you might well want to do in practice). We have explicitly converted the user-rating to a number here to use numeric sorting: this makes sure that 10 is considered a higher rating than 2. This is not necessary if the query is schema-aware, because the XQuery processor then knows that user-rating is a numeric field.
Ordering gets a little complicated when there is more than one for clause in the FLWOR expression. Consider this example:

```
for $v in //video
for $a in //actor
  where $v/actorRef = $a/@id
  order by $a, $v/year
  return concat($a, ":", $v/title)
```

To understand this we have to stop thinking about the two for clauses as representing a nested loop. We cannot compute all the result values and then sort them, because the result does not contain all the data used for sorting (it orders the videos for each actor by year, but only shows their titles). In this case we could imagine implementing the order specification by rearranging the for clauses and doing a nested loop evaluation with a different order of nesting; but that doesn't work in the general case. For example, it wouldn't work if the order by clause changed to:

```
order by substring-after($a, ","),
  $v/year,
  substring-before($a, ",")
```

to sort first on the surname, then on the year, then on the first name (admittedly, nonsensical coding, but we show it only to illustrate that it is allowed).

The XQuery specification introduces a concept of tuples, borrowed from the relational model, and describes how the sort works in terms of creating a sequence of tuples containing one value for each of the variables, and then sorting these notional tuples.

**R is for Return**

Every XQuery FLWOR expression has a return clause, and it always comes last. It defines the items that are included in the result. What more can one say about it?

Usually the XQuery return clause generates a single item each time it is evaluated. In general, though, it can produce a sequence. For example, you can do this:

```
for $v in //video[genre="comedy"]
return //actor[@id = $v/actorRef]
```
which selects all the actors for each comedy video. However, the result is a little unsatisfactory, because we cannot tell which actors belong to which video. It is much more common here to construct an element wrapper around each result:

```xquery
for $v in //video[genre="comedy"]
return
  <actors video="{$v/title}"
    {for $a in //actor[@id = $v/actorRef] return
      <actor>
        <firstname>{substring-after($a, ",")}</firstname>
        <lastname>{substring-before($a, ",")}</lastname>
      </actor>
    }
  </actors>
```

We have not discussed XQuery element and attribute constructors until now. But in practice, a FLWOR expression without element constructors can only produce flat lists of values or nodes, and that is not usually enough. We usually want to produce an XML document as the output of the query, and XML documents are not flat.

This means that very often, instead of doing purely relational joins that generate a flat output, we want to construct hierarchic output using a number of nested FLWOR expressions. Here is an example that (like the previous query) lists the videos for each actor, but with more structure this time:

```xquery
for $v in //video[genre="comedy"]
return
  <actors video="{$v/title}"
    {for $a in //actor[@id = $v/actorRef] return
      <actor>
        <firstname>{substring-after($a, ",")}</firstname>
        <lastname>{substring-before($a, ",")}</lastname>
      </actor>
    }
  </actors>
```

Here we really do have two nested XQuery loops. The two queries below are superficially similar, and in fact they return the same result:

```xquery
for $i in 1 to 5
for $j in ("a", "b", "c")
return concat($j, $i)
```

and:

```xquery
for $i in 1 to 5
return
  for $j in ("a", "b", "c")
    return concat($j, $i)
```
But now add an `order by` clause to both queries so they become:

```xml
for $i in 1 to 5
  for $j in ("a", "b", "c")
  order by $j, $i
  return concat($j, $i)
```

and:

```xml
for $i in 1 to 5
  return
    for $j in ("a", "b", "c")
    order by $j, $i
    return concat($j, $i )
```

The difference now becomes apparent. In the first case the result sequence is a1, a2, a3, … b1, b2, b3. In the second case it remains a1, b1, c1,… a2, b2, c2. The reason is that the first query is a single FLWOR expression (one `return` clause), and the `order by` clause affects the whole expression. The second query consists of two nested loops, and the `order by` clause can only influence the inner loop.

So, the `return` clause might seem like the least significant part of the FLWOR, but a misplaced `return` can make a big difference in the result. Consider always aligning the F, L, O, W, and R clauses of a single FLWOR expression underneath each other, and indenting any nested expressions, so that you can see what is going on. You can do this easily with the Stylus Studio XQuery Editor.

**Other Parts of the XQuery FLWOR Expression**

We have explored the five clauses of the FLWOR expression that give it its name. But there are a few details we have not touched on, partly because they are not used very often. They are summarized in this section.
Declaring XQuery Types

In the for and let clauses, you can (if you wish) declare the types of each variable. Here are some examples.

```xquery
for $i as xs:integer in 1 to 5 return $i*2
```

```xquery
for $v as element(video) in //video return $v/runtime
```

```xquery
let $a as element(actor)* := //actor return string($a)
```

Declaring types can be useful as a way of asserting what you believe the results of the expressions are, and getting an error message (rather than garbage output) if you have made a mistake. It helps other people coming along later to understand what the code is doing, and to avoid introducing errors when they make changes.

Unlike types declared in other contexts such as function signatures (and unlike variables in XSLT 2.0), the types you declare must be exactly right. The system does not make any attempt to convert the actual value of the expression to the type you declare – for example it will not convert an integer to a double, or extract the string value of an attribute node. If you declare the type as string but the expression delivers an attribute node, that is a fatal error.

XQuery Position Variables

If you have used XSLT and XPath, you have probably come across the `position()` function, which enables you to number the items in a sequence, or to test whether the current item is the first or the last. FLWOR expressions do not maintain an implicit context in this way. Instead, you can declare an auxiliary variable to hold the current position, like this:

```xquery
for $v at $pos in //video
    where $pos mod 2 = 0
    return $v
```

This selects all the even-numbered videos – useful if you are arranging the data in a table. You can use `$pos` anywhere where you might use the primary variable `$v`. Its value ranges from 1 to the number of items in the `//video` sequence. If there are no `order by` clauses, then the position variables in each for clause follow a nested-loop model as you would
expect. If there is an order by clause, the position values represent the position of the items before sorting (which is different from the rule in XSLT).

There are various keywords in the order by clause that give you finer control over how the sorting takes place. The most important is the collation: unfortunately, though, the way collations work is likely to be very product-dependent. The basic idea is that if you are sorting the index at the back of a book, or the names in a phone directory, then you need to apply rather more intelligent rules than simply sorting on the numeric Unicode code value of each character. Upper-case and lower-case variants of letters may need to be treated the same way, and accents on letters have some quite subtle rules in many languages. The working group defining XQuery settled on the simple rule that every collating sequence you might want has a name (specifically, a URI rather like a namespace URI), and it is up to each vendor to decide what collations to provide and how to name them.

Other things you can say in the order specification include defining whether empty values of the sort key (XQuery's equivalent of null values in SQL) should go at the start or end of the sequence, and whether the sort should be stable, in the sense that items with equal sort key values preserve their original order.

### Multiple Assignments

One simple syntax note. Instead of writing

```xml
for $i in ("a", "b", "c")
for $j in 1 to 5
return concat($i, $j)
```

you can write:

```xml
for $i in ("a", "b", "c"),
    $j in 1 to 5
return concat($i, $j)
```

The meaning of both is the same. This same technique applies to let statements as well.

### Grouping

If you are used to SQL, then you might have been wondering what the equivalent to its distinct and group by keywords is in XQuery FLOWR expressions. Well, SQL does not have one.
You can, however, get a fair amount of mileage from the `distinct-values()` function. Here is a query that groups videos according to who directed them:

```xml
<movies>
  {for $d in distinct-values(//director) return
    <director name="{$d}">
      { for $v in //video[director = $d] return
        <title>{$v/title}</title>
      }
    </director>
  }
</movies>
```

This is not an ideal solution: apart from anything else, it depends heavily on the ability of the query processor to optimize the two nested loops to give good performance. But for the time being, this is all there is. This is an area where vendors are very likely to offer extensions to the language as defined by W3C.

Grouping was a notoriously weak point of XSLT 1.0, and the problem has been addressed with considerable success in the 2.0 version of the language. XQuery will likely follow suit.

### Building an XQuery Using the Mapper

This section describes how to build a new XQuery using Stylus Studio’s XQuery Mapper.

*Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Introduction to the XQuery Mapper video.*

You can learn more about other video demonstrations of the XQuery Mapper here: [http://www.stylusstudio.com/learn_xquery.html#xquery_1](http://www.stylusstudio.com/learn_xquery.html#xquery_1)

This section covers the following topics:

- “Process Overview” on page 745
- “Source Documents” on page 746
- “Specifying a Target Structure” on page 752
- “Modifying the Target Structure” on page 755
- “Mapping Source and Target Document Nodes” on page 756
- “Simplifying the Mapper Canvas Display” on page 762
- “Exporting Mappings” on page 763
Building an XQuery Using the Mapper

- “Searching Document Panes” on page 764
- “FLWOR Blocks” on page 764
- “Function Blocks” on page 767
- “IF Blocks” on page 770
- “Condition Blocks” on page 771

Process Overview

The process of using the XQuery mapper to build a new XQuery consists of the following steps:

2. Click the Mapper tab in the XQuery editor.
3. Add one or more source documents.
4. Specify a target structure.
5. Map source document nodes to target structure nodes. As part of this step, you can optionally define function, FLWOR (For each, Let, Where, Order by, Return), If, and condition blocks to perform actions on source document nodes and map the return value to the target structure node.

Stylus Studio uses the information expressed on the Mapper tab to compose an XQuery that returns as its result an XML document that conforms to the structure represented by the target structure you specify.

Each of these steps is described in greater detail in the following sections.

Working with Existing XQueries

You can, of course, open an existing XQuery in Stylus Studio. When you do, the XQuery Source page displays the XML used to compose the XQuery, and the Mapper tab displays the source documents, target structure, and source-target mappings that can be inferred from the source XQuery file. All of the procedures described in this section can be performed on new or existing XQuery documents.

Saving the Mapping

You can save the XQuery mapping – source and target document trees, as well as the contents of the Mapper canvas – as an image. See “Exporting Mappings” on page 763.
Source Documents

In Stylus Studio, a source document can be an XML document, an XML Schema (XSD), or a document type definition (DTD). The role of a source document is to provide Stylus Studio with a structure that it can use to compose the XQuery, based on how you map individual source document elements and attributes to nodes in the target structure. Stylus Studio infers the structure from the document you specify and displays this structure on the Mapper tab.

This section covers the following topics:
- "Choosing Source Documents" on page 746
- "Source Documents and XML Instances" on page 746
- "How to Add a Source Document" on page 748
- "How to Remove a Source Document" on page 751
- "How Source Documents are Displayed" on page 751

Choosing Source Documents

You can use one or more source documents to build an XQuery in Stylus Studio. You might want to select multiple documents if you need their elements or attributes to fully describe the target structure or the desired XQuery result content, for example.

If you choose an XSD or DTD document, you must also choose an XML instance document to associate with it. Stylus Studio uses the instance document associated with a XSD or DTD source document to generate the XPath document() function in the finished XQuery code. This document is also used to preview XQuery results.

For more information

See “Source Documents and XML Instances” on page 746 to learn more about how Stylus Studio treats source documents. See “Creating an XQuery Scenario” on page 788 to learn more about XQuery scenarios.

Source Documents and XML Instances

As described previously, Stylus Studio uses the source document you specify to infer a structure you can use to create mappings to the target structure. In addition to the document structure, Stylus Studio needs document content information in order to compose a complete XQuery. You provide this information by associating a XML instance to each source document you specify.
Source documents can have one of three associations, each of which has implications for the XPath expressions written by Stylus Studio when it composes the XQuery code. A source document can be associated with

- Itself. That is, the document represented by structure displayed on the **Mapper** tab and the XML instance are one in the same. In this situation, Stylus Studio generates the `document()` function in the XQuery code. For example:

```
for $book in document("file://c:\Program Files\Stylus Studio\examples\simpleMappings\catalog.xml")/books/book
```

- The XML document specified in the optional XQuery scenario. Only one source document can be associated with the XQuery scenario. In this situation, Stylus Studio does not generate the `document()` function in the XQuery code. For example:

```
for $book in /books/book
```

The `document()` function is not necessary because Stylus Studio uses the XQuery input document specified in the **Scenario Properties** dialog box.

By default, Stylus Studio uses the first XML document you add to the XQuery mapper as the source XML for the XQuery scenario, as shown here:

![Figure 312. Default Source Document](image)

The document specified in the **Source XML URL** field on the **Scenario Properties** dialog box is the document used to preview XQuery results. You can select this
association for another XML document if you choose, but only one source document may have this association.

**Note** Creating a scenario for an XQuery is optional. See “Creating an XQuery Scenario” on page 788.

- Some other XML instance. A XSD or DTD document used as an XQuery source document must always be associated with an XML instance. In this situation, Stylus Studio generates the `document()` function in the XQuery code.

### Source document icons

Stylus Studio uses different icons to indicate how a source document is associated with the other documents used to compose the XQuery.

**Table 75. Source Document Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="icon1" /></td>
<td>The source document is associated with itself. This is the default for most XML documents (and XML documents only).</td>
</tr>
<tr>
<td><img src="image2.png" alt="icon2" /></td>
<td>The source document is associated with the XML document specified in the XQuery scenario. This is the case with the first XML document you add to XQuery mapper, but you can change this association manually if you choose. See “How to Change a Source Document Association” on page 748.</td>
</tr>
<tr>
<td><img src="image3.png" alt="icon3" /></td>
<td>The source document is associated with a separate XML document instance. XSD and DTD source documents are always associated with an XML instance.</td>
</tr>
</tbody>
</table>

### How to Change a Source Document Association

1. Right click the source document whose association you want to change. The source document shortcut menu appears.
2. Click **Associate With**, and then select the document you want to associate with the source document.

### How to Add a Source Document

1. Click the **Mapper** tab if necessary.
2. Click the **Add Source Document** button at the top left of the **Mapper** tab. The **Open** dialog box appears.

3. Select the document you want to use as the source document for building the XQuery.
Working with XQuery in Stylus Studio

4. Click Open.

If you selected an XML document in Step 3, the document appears in the source document pane of the Mapper tab. Go to Step 5.

If you selected an XSD or DTD document, Stylus Studio displays the Choose Root Element dialog box.

![Choose Root Element dialog box](image)

Figure 313. Choose Root Element Dialog Box

You use this dialog box to associate the XSD or DTD with an XML instance.

**Note** The Associate With field appears only when you add a second document to the XQuery mapper source and that document is an XSD or DTD. You use it to specify the XML instance that you want to associate with the XSD or DTD. This field does not appear if the XSD or DTD is the first source document you add to the XQuery mapper – Stylus Studio uses the XML Source document specified in the Scenario Properties dialog box as the XML instance in this case.

- a. Select the element from the XSD or DTD document that you want to use as the root element. The Choose root element drop-down list displays elements defined in the document you selected in Step 3.

- b. Use the Browse ( ) button to specify the XML instance to which you want to map the root element you have selected. The root element of the XML document you select must be the same as the element you selected as the root element from the XSD or DTD document.

- c. Click OK.

The document appears in the source document pane of the Mapper tab. Go to Step 5.

5. To add another source document, return to Step 2.
Building an XQuery Using the Mapper

How to Remove a Source Document

**Note** A source document cannot be removed from XQuery mapper if it is mapped to the target structure. See “Removing Source-Target Map” on page 761.

1. Remove any maps from the source document to the target schema. (See “Removing Source-Target Map” on page 761 if you need help with this step.)

2. Right click on the source document.
   The source document shortcut menu appears.

3. Select **Remove Schema**.

How Source Documents are Displayed

A source document is represented using a page icon, and its name is displayed using a different color to help distinguish it from element and attribute names. The page icon is modified based on the source document’s association with other documents. See “Source Documents and XML Instances” on page 746 for more information on this topic.

By default, only the file name itself is displayed; if you want, you can display the document’s full path by selecting **Show Full Path** on the document’s shortcut menu.

(Right-click on the document name to display the shortcut menu.)

![Source Document Display](image)

**Figure 314. Source Document Display**

Source documents are displayed using the tree view; you can use your keyboard’s *, +, and - number pad keys to expand and collapse selected documents.
Document structure symbols

Stylus Studio uses the following symbols to represent nodes in both source and target document structures:

Table 76.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>⃝</td>
<td>Repeating element</td>
</tr>
<tr>
<td>�טּ</td>
<td>Element</td>
</tr>
<tr>
<td>⚖</td>
<td>Attribute</td>
</tr>
</tbody>
</table>

See “Source document icons” on page 748 to learn about the different ways source document icons are depicted.

Tip If a node is required by the XML Schema or DTD associated with the target document, a red check appears over the node symbol.

Getting source document details

If you want details about the document that are not available in tree view, you can open the document by selecting Open from the document’s shortcut menu. When you open a document this way, Stylus Studio displays it in its own editor (the XML editor if it is an XML document, for example).

Specifying a Target Structure

There are two ways to specify an XQuery target structure:

- You can select an existing document from which Stylus Studio infers a structure and, optionally, modify the structure. Existing nodes in a target structure are displayed in blue. Nodes that you add are displayed in red. If a node is required by the associated XML Schema or DTD, a red check appears over the node symbol.

- You can build a structure from scratch, starting with the root element and defining other elements and attributes as needed. Nodes for target structures you define are displayed in red.

This section covers the following topics:

- “Using an Existing Document” on page 753
- “Building a Target Structure” on page 753
Building an XQuery Using the Mapper

For more information

See “Modifying the Target Structure” on page 755 to learn about the types of changes you can make to a target structure.

Using an Existing Document

1. Click the Mapper tab if necessary.
2. Click the Set Target Document button at the top left of the Mapper tab.
   The Open dialog box appears.
3. Select the document you want to use to provide the target structure for defining the XQuery.
4. Click Open.
   The structure of the document you select appears in the target document pane of the Mapper tab.

Building a Target Structure

To build a target structure from scratch, you first create a root element, and then define child elements and attributes as needed.

How to create a root element

1. Click the Mapper tab if necessary.
2. Right click the area underneath the Set Target Document button.
   The target document shortcut menu appears.
3. Select Create Root Element.
   The Name dialog box appears.
   
   ![Name Dialog Box](image)

   Figure 315. Name Dialog Box
Working with XQuery in Stylus Studio

4. Type a name for the root element and click **OK**.
   The root element you specified appears in the target document pane of the **Mapper** tab.

**Note**
You can create elements and attributes in a new or existing target structure.

How to create elements and attributes

1. Click the **Mapper** tab if necessary.
2. Select the attribute or element to which you want to add a child element or attribute.
   If you have just created a root element, select the root element.
3. Right click the area underneath the **Set Target Document** button.
   The target document shortcut menu appears.
4. Choose one of the following:
   - **Add Attribute**
   - **Add Child Element**
   - **Insert Element After** (This choice is not applicable to the root element; it creates
     the element as a sibling of the selected element.)
   The **Name** dialog box appears.

![Figure 316. Name Dialog Box](image)

5. Type a name for the node and click **OK**.
   The node you specified is added to the target structure in the **Mapper** tab.
Modifying the Target Structure

This section describes the techniques you can use to modify the structure and content of an XQuery mapper target structure. It covers the following topics:

- “Adding a Node” on page 755
- “Removing a Node” on page 755
- “Setting a Text Value” on page 755

Adding a Node

See “How to create elements and attributes” on page 754.

Removing a Node

**Note** Before you can remove a node, you must delete any links to that node. See “Removing Source-Target Map” on page 761.

1. Remove any links to the node you want to remove from the target structure. See “Removing Source-Target Map” on page 761 if you need help with this step.
2. Select the node and press the Delete key.
   
   *Alternative:* Right-click the node and select Remove Node from the shortcut menu.

Setting a Text Value

You can set text values for target structure elements and attributes. You might want to do this if you are composing an XQuery with an element or attribute that requires a fixed value, instead of using a value gathered from an input XML document.

**Example**

Here is the XQuery code Stylus Studio generates for the Title element when a text value is specified for it:

```
<Book>
  <Title>Confederacy of Dunces</Title>
</Book>
```

Stylus Studio displays a red letter T for nodes for which you define a text value: Title T.

**How to set a text value**

1. Right-click the node for which you want to set the text value.
   
   The shortcut menu appears.
2. Select Set Text Value from the shortcut menu.
The Value dialog box appears.

![Value Dialog Box](image)

Figure 317. Value Dialog Box

3. Type the string you want to use as the text value and click OK.

**Mapping Source and Target Document Nodes**

You map a source document node to a target structure node using drag and drop to create a link between the two nodes. Stylus Studio composes XQuery code based on these maps.

This section covers the following topics:
- “Preserving Mapper Layout” on page 756
- “Left and Right Mouse Buttons Explained” on page 757
- “How to Map Nodes” on page 758
- “Link Lines Explained” on page 758
- “Removing Source-Target Map” on page 761

**Preserving Mapper Layout**

As you add function blocks to the XQuery mapper, Stylus Studio places them in the center of the mapper canvas. You can change the default placement of function blocks by dragging and drag and dropping them where you like. Stylus Studio preserves the placement you select within and across sessions (as you toggle between the mapper and the XQuery Source tab, for example).

As you use the splitter in the XQuery mapper to widen the source and target document panes, the size of the mapper canvas is reduced. The Fit in Mapper Canvas button ( ), located at the top of the XQuery mapper, redraws the diagram in whatever space is currently available to the mapper canvas. This feature is also available from the mapper short-cut menu (right-click anywhere on the mapper canvas to display the short-cut menu).

**Tip** You can also show links for visible nodes, or links for just the node you select. See “Simplifying the Mapper Canvas Display” on page 762.
Left and Right Mouse Buttons Explained

You can use either the left or the right mouse button to perform the drag and drop operation used to create source-target mappings in XQuery.

If you use the left mouse button to perform the drag operation, the link always maps the source node to the target node, one-to-one, without making any changes to the target structure.

If you use the right mouse button, Stylus Studio displays a shortcut menu that provides you with alternatives for modifying the target structure.

Using this menu, you can easily perform many operations. For example, you can

- Map a source document node to an existing target structure node – this menu choice, Map to This Node, is the same as creating the link using the left mouse button.
- Add a source document node (element or attribute) as an attribute of the target structure node you select and map the two nodes.
- Add a source document node as a child element of the target structure node you select and map the two nodes.
- Add a source document node as a sibling of the target structure node you select and map the two nodes.
- Copy the entire source document node – its structure and its content – to the target structure and map it.
How to Map Nodes

1. Using either the left or right mouse button, drag the source document element or attribute to the appropriate node on the target structure.

2. When the pointer is on the appropriate target element, release the mouse button to complete the link.

Link Lines Explained

Stylus Studio draws lines for the maps you create from source document nodes to target structure nodes. Different line styles are used to convey information about the XQuery represented by the node mapping. There are three line styles:

- Thin
- Dashed
- Thick

The sample files used to illustrate these styles are books.xml and catalog.xml, from the Stylus Studio examples\simpleMappings directory.

Thin line

A thin line indicates that the XQuery code generated by Stylus Studio copies content from the source node to the target node. Such a line is created when you map one element or attribute to another using the left mouse button, or any of the following choices on the map shortcut menu:

- Create Root Element and Map It
- Add Attribute and Map It
- Add Child Element and Map It
- Insert Element After and Map It
In addition, the structure required to navigate to the node is also generated if it does not already exist in the XQuery. For example, consider the map between the `title` element in `books.xml` and the `Title` element in `catalog.xml`:

```
<catalog>
  <book>
    <title>{/books/book/title/text()}</title>
  </book>
</catalog>
```

The content is expressed as `{/books/book/title/text()}`, and this statement is preceded by the structure needed to locate the `title` element content.
Dashed line

A dashed line indicates that only structure code is being generated. Such a line is created when you use a FLWOR or IF block. For example, consider the map between the book and Book repeating elements:

```xml
<Catalog>
  { for $book in /books/book
     return <Book>
        <Title/>
     </Book>
  }
</Catalog>
```

Notice that the FOR loop returns only structure (shown in italics), not content. To add content, we could also map the title element to the Title element, which results in the following:

```xml
<Catalog>
  { for $book in /books/book
     return <Book>
        <Title>{$book/title/text()}</Title>
     </Book>
  }
</Catalog>
```

Of course, the FLWOR block can be used to define much more complex expressions, involving maps from source document nodes to its WHERE and ORDER BY ports, for example.
Thick line

A thick line indicates that the XQuery code generated by Stylus Studio replicates the complete structure and content of the source document node in the target. Such a map is created when you use the **Copy Node** choice on the link shortcut menu. Consider the following map – the `bookid` attribute on the source was copied to the target as a child of the `Book` repeating element:

For this type of map, Stylus Studio creates the XQuery code required to duplicate the source structure and content in the target, as shown in the following sample:

```xml
<Catalog>
  <Book>
    {/books/book/@bookid}</Book>
  </Book>
</Catalog>
```

Notice that the `bookid` attribute is displayed in gray in the target structure pane. This indicates that you cannot edit it.

Removing Source-Target Map

1. Select the line that represents the map you want to delete.

   **Note** Select the portion of the line that is drawn on the XQuery mapper canvas.

2. Press the **Delete** key.
   
   **Alternative**: Select **Delete** from the line shortcut menu (right click on the line to display the shortcut menu).
Simplifying the Mapper Canvas Display

By default, the XQuery Mapper displays all links between source and target document nodes, regardless of whether or not the node associated with a link is currently visible in the Source Document or Target Document pane. Further, as your XQuery code becomes more complex, the mapper canvas can become dense with graphical representations of the functions defined in the code and the links that represent them. Consider this example of XML-Q4.xquery, one of the sample XQuery documents in the Examples project installed with Stylus Studio.

You can hide links for nodes that are not currently visible in the Source Document or Target Document pane by clicking the Hide Links for Nodes that are not Visible button, as shown in Figure 323:

When you use this feature, Stylus Studio displays

- Links in the Mapper canvas only if both nodes are currently visible in the document panes
Building an XQuery Using the Mapper

- Green arrows (like the ones shown in Figure 324) in the document panes if only one of two linked nodes is currently visible.

**Other Mapper Display Features**

In addition to displaying links for only those nodes that are visible in both document panes, you can use the document node shortcut menu (right-click on a node in a document pane) to

- Show links to a specific node
- Hide links to a specific node
- Show/hide all links

**Exporting Mappings**

You can export a mapping – source and target document trees and Mapper canvas contents – as an image file. The default image format is JPEG (.jpg), but you can choose from other popular image file formats such as .bmp and .tiff.

The exported image reflects the document trees at the time you export the image – if you have collapsed a node in Stylus Studio, for example, that node is also collapsed in the exported image. However, the exported image includes the entire document tree and Mapper canvas, not just what is currently visible on the Mapper tab.

By default, all source-target document links are displayed. However, if you have chosen to hide or show links for only certain nodes, the exported image reflects that choice and displays only the links for the nodes as you have specified. See “Simplifying the Mapper Canvas Display” on page 762 for more information on hiding and showing links.

1. Optionally, hide links for any nodes in the source or target documents that you do not want to appear in the exported image.
2. Select **XQuery > Export Mapping as Image** from the Stylus Studio menu.

   Stylus Studio displays the **Save As** dialog box.
4. Optionally, change the image type. (The default is JPEG; .bmp and .tiff are also available.)
5. Click Save.

Searching Document Panes

You can search document panes using the Find dialog box.

![Find dialog box](image)

Figure 325. You Can Search Document Panes

You can restrict your search to elements and/or attributes, and you can even search using regular expressions to define your match pattern.

1. Right-click in the document pane.
2. Select Find from the shortcut menu.

FLWOR Blocks

This section describes how to work with FLWOR blocks in the XQuery Mapper tab. It covers the following topics:

- “Parts of a FLWOR Block” on page 765
- “Creating a FLWOR Block” on page 766
Building an XQuery Using the Mapper

Parts of a FLWOR Block

FLWOR blocks are drawn as a green block with an illustration of a flower at its center, and five connectors, called ports, placed along the block’s border:

![Figure 326. FLWOR Block](image)

For, Order by, and Return ports

You define a FLWOR statement’s For and Order by clauses by mapping source document elements and attributes to them, as appropriate. For example, if you wanted your XQuery to return a list of books ordered by publication date, you would map the book repeating element in books.xml to the FLWOR block’s For port, and the Return port to the Book repeating element in catalog.xml. (As an alternative, you could map the two repeating elements directly, and Stylus Studio would create the FLWOR block and this mapping for you automatically, as described in “Creating a FLWOR Block” on page 766). Next, you would map the source document pubdate attribute to the Order by port. For a FLWOR block defined in this way, Stylus Studio generates the following XQuery:

```xml
<Catalog>
  { 
    for $book in /books/book
    order by $book/@pubdate
    return 
      <Book/>
  }
</Catalog>
```

Where port

The input for the Where port must be the output port of another block, such as a condition, IF, or function block. Imagine you have two source documents – you can create an Equal condition block, and specify that the content of an element in one source document must match the content of an element in the other source document, and map the return value of this condition to the Where port on the FLWOR block. Creating an Equal condition that
specifies that the bookid attribute must be equal to the title element results in Stylus Studio generating the following XQuery code, for example:

```xml
<Catalog>
  { for $book in /books/book
      where $book/@bookid = $book/title
      order by $book/@pubdate
      return
        <Book/>
  }
</Catalog>
```

See “IF Blocks” on page 770 and “Function Blocks” on page 767 for information on using other types of blocks in XQuery mapper.

**Flow port**

The Flow port, which is also present on IF and function blocks, allows you to link the result from other FLWOR, IF, and function blocks to define a conditional execution order for your XQuery expressions. You might decide you want a particular for each statement executed only after performing a certain function, for example. Inputs for the Flow port include the Return port of IF, function, and other FLWOR blocks.

**Creating a FLWOR Block**

You can create FLWOR blocks in the XQuery Mapper tab in one of two ways:

- Right-click on the mapper canvas and select New | FLWOR Block from the shortcut menu.
- Map one repeating element to another – Stylus Studio automatically creates a FLWOR block, mapping the source document node to the For port, and the Return port to the target structure node. Consider this code, which Stylus Studio generated after mapping the book repeating element in books.xml to the Book repeating element in catalog.xml:

```xml
<Catalog>
  { for $book in /books/book
      return
        <Book/>
  }
</Catalog>
```
Function Blocks

Stylus Studio supports standard functions defined by the W3C and any user-defined functions you might have created. This section describes how to work with function blocks in Stylus Studio and covers the following topics:
  ● “Creating a Function Block” on page 767
  ● “Parts of a Function Block” on page 768
  ● “User-Defined Functions” on page 769
  ● “concat Function Blocks” on page 770

Standard Function Block Types

Stylus Studio provides graphic support for the following types of XQuery functions:
  ● Accessor
  ● Aggregate
  ● Boolean
  ● Date time
  ● Error
  ● Node
  ● Notation
  ● Number
  ● QName
  ● Sequence
  ● Sequence generator
  ● String

If a standard function does not provide the functionality you need, create a user-defined function. See “User-Defined Functions” on page 769.

Creating a Function Block

The procedure for creating standard and user-defined function blocks varies slightly:

1. Right-click on the mapper canvas.
2. Select New > Function Block from the shortcut menu. Available functions are displayed in submenu categories.
1. Right-click on the mapper canvas.

2. Select **New > User Functions** from the shortcut menu.
   
   Any user-defined functions defined in the XQuery source are displayed in a sublist. See “User-Defined Functions” on page 769 to learn more about creating user-defined functions in Stylus Studio.

### Parts of a Function Block

Function blocks are drawn as a purple block with an italic “f” at its center, and connectors, called **ports**, placed along the block’s border. Input ports (none or more based on the function), the **Flow** port at the top, and the **Return** port on the right:

![Function Block Diagram](image)

**Figure 327. Function Block**

**Input ports**

Input ports are on the left side of the function block. The number and definition of input ports varies from function to function. To specify a value for an input port, drag a source document element or attribute to the port and release it.

**Flow port**

**Flow** ports, on the top of function blocks, are the same for FLWOR, function, and IF blocks. See “Flow port” on page 766.

**Return port**

The **Return** port is on the right side of the function block. You use the **Return** port to map the function result directly to a target structure element or attribute, or to a FLWOR, IF, condition, or another function block.
User-Defined Functions

You can define your own functions in XQuery, such as the following:

```xquery
define function total-price( $i as element) as xs:decimal
{
    let $subtotals := for $s in $i return $s/quantity * $s/USPrice
    return sum( $subtotals )
}
```

This particular user-defined function, which takes an element as its argument and returns a sum of the prices, might be used as follows (shown in italics):

```xml
<Catalog>
    {
        for $book in /books/book
        return
        <Book>
            <Price>
                {total-price($book/@bookid)}
            </Price>
        </Book>
    }
</Catalog>
```

When you create a user-defined function, Stylus Studio adds it to the **New > User Functions** shortcut menu available when you right-click the mapper canvas.

**Figure 328. User-Defined Functions**

This makes it easy to reuse a user-defined function on the **Mapper** tab once it has been defined in the XQuery source.
concat Function Blocks

There are three types of concatenation (concat) functions for strings:

- **concat() as string** allows you to specify a literal value that you might wish to concatenate to some other value in your XQuery.

  ![Figure 329. concat() as string](image)

- **concat($op1 as string?) as string** allows you to specify a variable that you might wish to concatenate to some other value.

  ![Figure 330. concat($op1 as string?)](image)

- **concat($op1 as string?, $op2 as string?, ...) as string** allows you to concatenate two or more variables.

  ![Figure 331. concat($op1 as string?, $op2 as string?, ...)](image)

Note that only the first two input ports are associated with variables ($op1 as string? and $op2 as string?). When you map a value to the third input port (...), Stylus Studio automatically adds a fourth input port to allow you concatenate a fourth value. This behavior is repeated for each additional string you define.

IF Blocks

IF blocks have a single input port, labeled **condition**; a **Flow** port; and two result ports: **if then**, and **if else**.

![Figure 332. IF Block](image)
You use IF blocks to compose if then, else XQuery expressions, such as the following:

```xml
<Book>
  
  if( $book/title ) then
    <Title/>
  else
    <ISBN/>
  
</Book>
```

This expression, for example, was composed by mapping
- The title element in the source document to the IF block’s input port.
- The if then result port to the Title element in the target structure.
- The if else result port to the ISBN element in the target structure.

IF blocks create a structure if the if then or if else branches are true. These ports can be connected to the target schema; otherwise they can be connected to Flow ports of FLWOR, function, and other IF blocks.

**Condition Blocks**

The Stylus Studio XQuery mapper allows you to graphically define the following types of conditions:
- Equal (=)
- Less than (<)
- Greater than (>)
- Less than or equal to (<=)
- Greater than or equal to (>=)
- and (&)
- or (||)

All condition blocks have two input ports and a single Return port, as shown in this example of a greater than block.

**Figure 333. Greater Than Block**

You can map the Return port to a target structure element or attribute, or to the input port on a FLWOR, function, IF, or another condition block.
Working with the XQuery collection() Function

Support for the XQuery collection() function is available only in Stylus Studio XML Enterprise Edition and Stylus Studio DataDirect XQuery Edition.

As implemented in Stylus Studio, the XQuery collection() function allows you to include relational database tables and views in your XQuery as if they were XML documents. (The collection() function is implementation-specific – different vendors have implemented it in different ways. In some implementations, for example, the collection() function takes as its argument a URL that specifies an XML document.)

This section describes how to work with the collection() function in Stylus Studio.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the XQuery Collections video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

This section covers the following topics:

● “Using the collection() Function in Stylus Studio” on page 772
● “How the collection() Function is Processed” on page 773
● “Creating a Database Connection” on page 773
● “Creating a collection() Statement” on page 775
● “Other Ways to Register a Database Configuration” on page 778

Using the collection() Function in Stylus Studio

The process of using the collection() function in Stylus Studio consists of these basic steps:

1. Create a connection to the database server whose tables and/or views you want to query. You create database connections from the File Explorer window.

2. Register the database connection with your XQuery document. This process allows the database’s tables and views to be used in your XQuery code.

3. Invoke the collection() function in your XQuery code. You can type the collection() statement by hand, or have Stylus Studio create it for you.

4. Ensure that the processor specified in the XQuery scenario is either the Stylus Studio built-in processor or the DataDirect XQuery processor.
These steps are described in greater detail later in this section.

**How the collection() Function is Processed**

The Stylus Studio built-in and DataDirect XQuery processors process `collection()` functions differently:

- The DataDirect XQuery processor converts the XQuery code to SQL statements and pushes the SQL directly to the database server. Results are returned to Stylus Studio as XML and displayed in the Preview window.
- Stylus Studio’s built-in processor retrieves the entire table or view, converts the data into XML, and evaluates the query against the XML.

Because it processes XQuery as SQL on the database server, the DataDirect XQuery processor can provide performance superior to that of other XQuery processors when querying relational data as XML.

**Database Connections**

The database connection is established when the XQuery code is executed and closed as soon as a result is returned.

**Handling Invalid Characters**

Some characters, like spaces, are valid in SQL but are invalid in XML. Invalid characters are escaped using SQL/XML escaping convention when the relational data is converted to XML. For example, Stylus Studio would create an XML tag for a column named `last name` as `last_x0020_name`.

**Creating a Database Connection**

Before you can execute a `collection()` function in an XQuery document, you need to create a database connection. This is part of the process of making the database tables and views available to the XQuery code.

1. Display the File Explorer window if it is not already open (View > File Explorer).
2. In the File Explorer window, right-click the RelationalDB icon and select New Server from the short-cut menu.
Stylus Studio displays the **Connection Settings** dialog box.

![Connection Settings Dialog Box](image)

**Figure 334. Connection Settings Dialog Box**

3. Specify the information needed to create the database connection and click OK. (See “Specifying Connection Settings” on page 847 if you need help with this step.)

   The server connection appears in the **File Explorer** window.

![File Explorer](image)

**Figure 335. New Database Server Connection**
Creating a collection() Statement

This topic describes how to create a collection() statement in your XQuery code automatically. If you prefer, you can always write the collection() statement manually. Regardless of how you input the collection() statement in your XQuery code, Stylus Studio will be able to execute it only if you have created a database connection for the database associated with the table or view referenced in the collection() function calls and have registered that connection with the XQuery document.

collection() Function Syntax

The collection() function takes as its argument a URI that identifies a specific database table or view, such as this function referencing the title column of the books table in the pubs2 database:

collection("pubs2.dbo.books")/books/title

You can always edit collection() functions created by Stylus Studio. As long as they refer to an object that is available based on the database connection associated with the XQuery document, the collection() function will execute successfully. See “Choosing a Database Object” on page 779 for more information on this topic.

What Happens When You Create a collection() Statement?

You create a collection() statement by selecting the table or view you want to query from the File Explorer window, and dropping it on the editing pane of the XQuery Source tab in the XQuery Editor. When you drop the table or view on the editing pane, Stylus Studio

- Automatically creates the collection() statement in the XQuery code based on the table or view you selected
Working with XQuery in Stylus Studio

- Registers with the XQuery document the connection information for the database associated with the selected table or view, and displays the database in the schema pane of the XQuery Editor, as shown here:

![Image of XQuery Editor with database connection]

Once the database connection information is registered with the XQuery document, you can expand the database nodes in the schema pane to display individual table and view columns.

Creating Multiple Connections

When you drop an object on the editing pane from the File Explorer window, Stylus Studio displays the connection information in the schema pane of the XQuery Editor. If you then drag and drop another object, Stylus Studio either

- Adds a new connection, if the object was from a different server or port
- Modifies the existing connection, if the object is from the same server and port

A new collection() statement is created for each object you drop on the editing pane of the XQuery editor.
Working with the XQuery collection() Function

How to Create a collection() Statement

1. Open a new XQuery document if one is not already open. The XQuery Source tab should be displayed.

2. Ensure that you have established a valid database connection as described in “Creating a Database Connection” on page 773.

3. In the File Explorer window, expand the database and tablespace to display the tables or views you want to access in your XQuery, as shown in this example:

![Figure 337. Expanded Database Connection](image)

Optionally, display table and view columns by selecting Read Structure from the table or view shortcut menu (right-click).

4. Drag the desired table or view and drop it on the editing pane of the XQuery Source tab.

Optionally, drop the table or view on the schema pane of the XQuery Source tab. If you do this, you must then drag the desired table or view from the schema pane to the editing pane to create the collection() statement.
Stylus Studio creates the `collection()` statement based on the table or view you selected in Step 4. It also displays the table’s or view’s database in the schema pane of the XQuery Editor (see Figure 336).

**Other Ways to Register a Database Configuration**

If you choose, you can explicitly register a database connection by dropping any elements from a database connection displayed in the File Explorer window (the connection representation, database, schema, table, or view) on the schema pane of the XQuery Source tab. You might want to do this when you want to view a table’s or view’s columns prior to writing your XQuery code, so you can see what data structures are available, as shown here:

![Figure 338. Schema Pane Shows Table and View Columns](image)

This also gives you the ability to close the File Explorer window after creating your database connection – providing more room to work, and simplifying the Stylus Studio desktop display.

**Tip** You can also gain access to column-level information about a database’s tables and views directly from the File Explorer window by selecting Read Structure from the table or view shortcut menu (right-click).
Choosing a Database Object

You can register a database connection by dragging any database object from the File Explorer window. The object you select affects which objects you can then query in your XQuery code:

- Server – all of the server’s databases and their child tables and views can be queried
- Database – all of the database’s tablespaces and their child tables and views can be queried
- Tablespace – any of the tablespace’s tables or views can be queried
- Table/View – only the table or view can be queried
- Column – only the column can be queried

Once you register a database connection to the XQuery document, the configuration information remains associated with the XQuery document until you explicitly delete it from the schema pane in the XQuery Editor.
Debugging XQuery Documents

Complex XQuery documents require robust debugging features.

With Stylus Studio, you can

- Set breakpoints in your XQuery documents
- Monitor the value of XQuery variables.
- Trace the sequence of XQuery expressions that created output. With a click anywhere in the result, Stylus Studio Visual Backmapping technology displays the XQuery expression responsible for creating that result.

This section covers the following topics:

- “Using Breakpoints” on page 781
- “Viewing Processing Information” on page 782
- “Using Bookmarks” on page 783
- “Profiling XQuery Documents” on page 785
Using Breakpoints

The Stylus Studio debugger allows you to interrupt XQuery processing to gather information about variables and XQuery expression execution at particular points.

Inserting Breakpoints

1. In the XQuery document in which you want to set a breakpoint, place your cursor where you want the breakpoint to be.
2. Click **Toggle Breakpoint** or press F9. Stylus Studio inserts a blank stop sign to the left of the line with the breakpoint.

Removing Breakpoints

1. Click in the line that has the breakpoint.
2. Press F9 or click **Toggle Breakpoint**.
   *Alternative:* In the Stylus Studio toolbar, click **Breakpoints** to display a list of breakpoints in all open files. You can selectively remove one or more, remove them all, or jump to one of them.

Start Debugging

When your XQuery has one or more breakpoints set, start processing by clicking **Start Debugging** or pressing F5. When Stylus Studio reaches the first breakpoint, it suspends processing and activates the debugging tools. After you examine the information associated with that breakpoint (see Viewing Processing Information on page 782) you can choose to

- Step into – click or press F11.
- Step over – click or press F10.
- Step out – click or press Shift+F11.
- Run to cursor – click
- Continue processing – press F5.
- Stop processing – click **Stop Debugging** in the Stylus Studio toolbar, or click **Cancel** in the lower right corner of the XQuery editor, or press Shift+F5.

*Note* You can also click **Pause** to suspend XQuery processing. Stylus Studio flags the line it was processing when you clicked **Pause**.
Working with XQuery in Stylus Studio

Viewing Processing Information

Stylus Studio provides several tools for viewing processing information. The tools become active when processing reaches a breakpoint. This section discusses the following topics:

- “Watching Particular Variables” on page 782
- “Evaluating XPath Expressions in the Current Processor Context” on page 782
- “Obtaining Information About Local Variables” on page 782
- “Displaying a List of Process Suspension Points” on page 783
- “Displaying XQuery Expressions for Particular Output” on page 783

Watching Particular Variables

Use the Watch window to monitor particular variables. To display the Watch window, click Watch in the Stylus Studio tool bar. This button is active when Stylus Studio suspends processing because it reached a breakpoint. Stylus Studio displays the Watch window only when processing is suspended.

Enter the names of the variables you want to watch. You can enter as many as you like. When Stylus Studio suspends processing, it displays the current values for any variables listed in the Watch window. You can expand and collapse complex structures as needed.

During XQuery debugging, you can enter XPath expressions in the Watch window fields. Stylus Studio uses the current context to evaluate these expressions, and displays the results with the same kind of interface Stylus Studio uses for nodeList and node variables.

Evaluating XPath Expressions in the Current Processor Context

When you suspend processing, you can evaluate an XPath expression in the context of the suspended process. You do this in the Watch window. Click in the Stylus Studio tool bar to display the Watch window. Click in an empty name field and enter an XPath expression. As soon as you press Enter, Stylus Studio displays the results of the evaluation in the Value field of the Watch window.

Obtaining Information About Local Variables

Display the Variables window to obtain information about local variables. To display the Variables window, click Variables in the Stylus Studio tool bar. This button is active when Stylus Studio suspends processing because it reached a breakpoint. Stylus Studio displays the Variables window only when processing is suspended.
### Debugging XQuery Documents

Information displayed in the Variables window includes:

- Information about how the return value (displayed in the Variables window as __Return_Value_3, for example) is being built
- Local and global XQuery variable values

Also, you can navigate the structure associated with a variable, a parameter, or the current context if it is a node list or a node.

#### Displaying a List of Process Suspension Points

Display the Call Stack window to view a list of the locations at which processing was suspended. For XQuery documents, Stylus Studio displays the XQuery document name and line number.

To display the Call Stack window, click Call Stack in the Stylus Studio tool bar. This button is active when Stylus Studio suspends processing because it reached a breakpoint. Stylus Studio displays the Call Stack window only when processing is suspended.

When processing is complete, the call stack is empty.

When execution is suspended you can use the Call Stack window to jump directly to the XQuery source. Double-click on a stack line to go to that location. A green triangle appears to indicate this location in the source file.

#### Displaying XQuery Expressions for Particular Output

After you create an XQuery, or during XQuery debugging, Stylus Studio can display the XQuery expression that generated a particular part of a result document. This can be particularly helpful when the result is not quite what you want.

In the Preview window, click on the output for which you want to display the XQuery expression. You can do this while either the text view or the browser view is active. Stylus Studio flags the line in the XQuery source that contains the expression that generated the output you selected.

#### Using Bookmarks

When you are editing or debugging a long file, you might want to repeatedly check certain lines in the file. To quickly focus on a particular line, insert a bookmark for that line. You can insert any number of bookmarks. You can insert bookmarks in any document that you can open in Stylus Studio.
Inserting

1. Click in the line that you want to have a bookmark.
2. Click **Toggle Bookmark** in the Stylus Studio tool bar. Stylus Studio inserts a turquoise box with rounded corners to the left of the line that has the bookmark.

Removing

1. Click in the line that has the bookmark you want to remove.
2. Click **Toggle Bookmark** in the Stylus Studio tool bar. Stylus Studio removes the turquoise box.

Moving Focus
In addition to debugging tools for XQuery, Stylus Studio provides the XQuery Profiler, a tool that helps you evaluate the efficiency of your XQuery. By default, the performance metrics gathered by the XQuery Profiler are displayed in a preformatted report, like the one shown here:

![XQuery Profiler Report](image)

**Note**
XQuery and XSLT Profiler reports use the same XSLT stylesheets.
In addition to generating the standard XQuery Profiler report, you can save the raw data generated by the Profiler and use this data to create your own reports. See “Enabling the Profiler” on page 786 for more information about this procedure.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

**About Performance Metrics**

The XQuery Profiler can record three different levels of performance metrics:

- A call tree of execution times
- Execution times by XQuery expression, and
- A detailed log of step-by-step expression execution

**Note** Displaying the report for a step-by-step log can take significantly longer than evaluating the XQuery itself. Consider using the Profiler with the first two performance metric options. You can also use the Limit Trace To fields to further restrict the Profiler’s scope. If you find you need still more detail (while troubleshooting a performance bottleneck, for example), use the step-by-step setting.

**Enabling the Profiler**

The XQuery Profiler is off by default. You enable the Profiler on the Profiling Options tab of the XQuery Scenario Properties dialog box.

1. Open the Scenario Properties dialog box for the XQuery document. (Click Browse at the top of the XQuery editor window.)
2. Click the **Profiling Options** tab.

![Figure 341. XQuery Profiler Options](image)

3. Select the settings for the performance metrics you want the Profiler to capture.

4. Optionally, save the raw Profiler data to a separate file.

   **Note**  
   This option is available only after you select one or more performance metrics settings.

5. Click OK.

   The next time you preview the XQuery results, the performance metrics you selected are available to you in the XQuery Profiler report (and as raw data if you selected that setting and specified a file).

### Displaying the XQuery Profiler Report

1. Ensure that the Profiler is enabled. (See “**Enabling the Profiler**” on page 786 if you need help with this step.)

2. Click the **Preview Result** button ( ).

3. Click the **Show Profiling Report** button ( ).

   The XQuery Profiler report appears in the **Preview** window.
Creating an XQuery Scenario

An XQuery scenario is a group of settings you associate with an XQuery. Examples of scenario settings include a main input document, XQuery processors, and whether or not you want to perform validation on the XML that results from your XQuery. Each time you preview an XQuery, Stylus Studio uses settings from the currently active scenario. For example, if the currently active scenario specifies the built-in processor, Stylus Studio executes the XQuery using that processor when you click the Preview Result button.

You can create multiple scenarios for a single XQuery, and choose different settings for each. This flexibility can aid the XQuery development process as it enables you to easily test the XQuery against different input documents and using different processors before making the XQuery available.

This section covers the following topics:

- “Specifying XML Input” on page 788
- “Selecting an XQuery Processor” on page 790
- “Setting Default Options for Processors” on page 793
- “Setting Values for External Variables” on page 794
- “Performance Metrics Reporting” on page 794
- “How to Run a Scenario” on page 797
- “Working with the XQuery collection() Function” on page 772
- “How to Create a Scenario” on page 796
- “How to Run a Scenario” on page 797
- “How to Clone a Scenario” on page 797

Specifying XML Input

When you create an XQuery scenario, you can optionally specify inputs – XML documents or other sources of XML that set the context for the XPath expressions in your XQuery code. This XML source is referred to as the main input.

The main input is a URL for a specific XML document. Specifying a main input is an alternative to using the XQuery document() function in your XQuery code. When you specify a main input document, expressions like \books\book in your XQuery code are evaluated in the context of that document.
Creating an XQuery Scenario

You specify XML input on the **General** tab of the **Scenario Properties** dialog box.

![Scenario Properties dialog box]

**Figure 342. XQuery Scenario General Properties**

**Note**  If you build your XQuery using the XQuery Mapper, Stylus Studio uses the first source document you select as the main input XML document, though you can override this default at any time. See “**Source Documents**” on page 746 to learn more about the process of selecting and working with XQuery source documents in XQuery mapper.
Selecting an XQuery Processor

You use the Processors tab of the Scenario Properties dialog box to specify the processor you want to use to process your XQuery code.

![Figure 343. XQuery Scenario Processor Properties](image)

You can use

- The DataDirect XQuery™ processor
- One of several processors that support XQuery debugging and backmapping, including Stylus Studio’s built-in XQuery processor and Saxon
- An external instance of the Stylus Studio processor
- The Mark Logic XQuery processor, which runs on the Mark Logic Content Interaction Server
- The Raining Data™ TigerLogic™ XDMS XQuery processor, which runs on the TigerLogic XDMS server
- Any custom processor you specify

**Tip** You can define default settings for XQuery processors, and you can also choose to use one of them as the default XQuery processor. See “Setting Default Options for Processors” on page 793.

Using the Saxon Processor

Stylus Studio lets you execute XQuery documents using either the Saxon-B (basic) or Saxon-SA (schema-aware) processor. You specify which processor you want to use with
the **Execution mode** property in the **Saxon XQuery Settings** dialog box. Settings that have command line equivalents in Saxon show the command in parentheses following the property name. Some settings are available only if you are using Saxon-SA.

Support for Saxon-SA is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio’s Sense:X syntax coloring and auto-completion provides full support for Saxon syntax, so long as the Saxon Logic XQuery processor is either associated with the current XQuery scenario or has been set as the default XQuery processor.

If you want to use the Saxon processor:

1. On the **Processors** tab, click **Saxon**.
   The **Settings** button becomes active.
2. Click the **Settings** button.
   The **Saxon XQuery Settings** dialog box appears.

![Saxon XQuery Settings Dialog Box](image)

3. Complete the settings as desired. Press F1 to access the Stylus Studio online help, or refer to the **Saxon documentation** for more information.
4. Click **OK**.

**Using the Mark Logic Processor**

Stylus Studio’s Sense:X syntax coloring and auto-completion provides full support for Mark Logic syntax, so long as the Mark Logic XQuery processor is either associated with the current XQuery scenario or has been set as the default XQuery processor.

If you want to use the Mark Logic processor:

1. On the **Processors** tab, click **Mark Logic**.
Working with XQuery in Stylus Studio

The **Settings** button becomes active.

2. Click the **Settings** button.
   The **Mark Logic Server Settings** dialog box appears.

![Figure 345. Mark Logic Server Settings Dialog Box](image)

3. Enter the host, port, username, and password information for the server on which the Mark Logic Content Interaction Server is running.

4. Click **OK**.

**Using the TigerLogic XDMS Processor**

Stylus Studio’s Sense:X syntax coloring and auto-completion provides full support for TigerLogic XDMS syntax, so long as the TigerLogic XDMS XQuery processor is either associated with the current XQuery scenario or has been set as the default XQuery processor.

If you want to use the TigerLogic XDMS processor:

1. Click **TigerLogic XDMS**.
   The **Settings** button becomes active.

2. Click the **Settings** button.
   The **TigerLogic XDMS Server Settings** dialog box appears.

![Figure 346. TigerLogic XDMS Server Settings Dialog Box](image)
Creating an XQuery Scenario

3. Enter the host, port, username, and password information for the server on which the Mark Logic Content Interaction Server is running.

4. Click OK.

Setting Default Options for Processors

You can set default values for all XQuery processors on the Processor Settings page of the Options dialog box. In addition, you can select a processor other than the built-in processor as the default XQuery processor.

You can always override the default processor and default processor settings at the scenario level.

1. From the Stylus Studio menu, select Tools > Options. Stylus Studio displays the Options dialog box.

2. Select Module Settings > XQuery > Processor Settings.

3. Select the processor for which you want to specify default settings from the Processor drop-down list.

4. If required, complete processor-specific settings. (Click the Settings button.)
5. If you want to use this processor as the default processor for all XQuery scenarios, click the Use as default processor check box.

6. Click OK.

Setting Values for External Variables

The Parameter Values tab of the Scenario Properties dialog box displays any external variables you have defined in the XQuery source. You can specify the parameter value you want to use for any external variables when you run the scenario. For example, imagine your XQuery code contains the following:

```
declare variable $part_num external
```

This variable is displayed on the Parameters tab as follows:

![Scenario Properties dialog box](image)

Figure 348. XQuery Scenario Parameters

When you run the scenario, you can specify the parameter value you want to use by double-clicking the Expression field and typing a value. Valid values are XPath expressions and must be entered using single or double quotes.

Performance Metrics Reporting

See “Enabling the Profiler” on page 786 to learn more about the different ways in which Stylus Studio can provide you with XQuery performance metrics.
Validating XQuery Results

You can optionally validate the XML document that results from XQuery processing. You can validate using the

- Stylus Studio built-in processor. If you use the Stylus Studio built-in processor, you can optionally specify one or more XML Schemas against which you want the result document to be validated.
- Any of the customizable processors supported by Stylus Studio, such as the .NET XML Parser, Xerces-J, and XSV.

1. Open the XQuery whose results you want to validate.
2. In the XQuery Editor, in the scenario name field, click the down arrow and click the name of the scenario for which you want to perform validation.
3. Click Browse to open the Scenario Properties dialog box.
4. Click the Validation tab.
5. Click Validate query result.
6. If you are using Stylus Studio’s built-in validation engine, optionally, specify the XML Schemas against which you want to validate the XML result document. Otherwise, go to Step 7
   a. Click the Open file button ( ).
      The Open dialog box appears.
b. Select the XML Schema you want to use for validation.

c. Click the Open button to add the XML Schema to the Validation tab.

d. Optionally, add other XML Schemas.

e. Go to Step 8.

7. Click the Use custom validator button, and select the validation engine you want to use from the drop-down list box.

8. Click OK.

**How to Create a Scenario**

1. In the XQuery editor tool bar, click .
   
   *Alternative: Select Create Scenario from the scenario drop-down list at the top of the editor window.*

   Stylus Studio displays the Scenario Properties dialog box.

2. In the Scenario name: field, type the name of the new scenario.

3. In the Main input: field, type the name of the XML file to which you want to apply the XQuery, or click Browse to navigate to an XML file and select it.

   **Note** If the first document you added to the XQuery is an XML document, Stylus Studio uses that document as the XML source for the scenario and displays it in this field.

4. If you are using DataDirect XQuery, specify one or more defined collections as input. See “Specifying XML Input” on page 788 if you need help with this step.

5. In the Output URL field, optionally type or select the name of the result document you want the XQuery document to generate. If you specify the name of a file that does not exist, Stylus Studio creates it when you preview the XQuery.

6. If you want Stylus Studio to store paths relative to XQuery document path, ensure that the Use relative paths option is checked.

7. If you check Preview result in an external application, Stylus Studio displays the result Internet Explorer. In addition, Stylus Studio always displays XQuery results in the Preview window.

8. If you want to specify values for XQuery parameters, click the Parameter Values tab. Click the Variable Name field for the parameter – Stylus Studio places the text cursor in the Expression field, allowing you to type a value for the parameter.
9. If you want Stylus Studio to capture performance metrics, enable the XQuery Profiler on the Profiling Options tab. See Profiling XQuery Documents on page 785.

10. To define another scenario, click Add and enter the information for that scenario. You can also copy scenarios. See How to Clone a Scenario on page 797.

11. Click OK.

If you start to create a scenario and then change your mind, click Delete and then OK.

How to Run a Scenario

1. Select a scenario from the scenario drop-down list at the top of the editor window. 
   Alternative:
   a. In the XQuery editor tool bar, click . Stylus Studio displays the Scenario Properties dialog box.
   b. On the General tab, select the scenario you want to run from the Existing Scenarios list.
   c. Click OK.

2. Click the Preview Result button ( ).

How to Clone a Scenario

When you clone a scenario, Stylus Studio creates a copy of the scenario except for the scenario name. This allows you to make changes to one scenario and then run both to compare the results.

1. Display the XQuery in the scenario you want to clone.

2. In the XQuery editor tool bar, click to display the Scenario Properties dialog box.

3. In the Scenario Properties dialog box, in the Existing preview scenarios field, click the name of the scenario you want to clone.

4. Click Clone.

5. In the Scenario name field, type the name of the new scenario.

6. Change any other scenario properties you want to change. See How to Create a Scenario on page 796.
7. Click **OK**.

If you change your mind and do not want to create the clone, click **Delete** and then **OK**.

### Generating XQuery Documentation

Stylus Studio allows you to generate HTML documentation for your XQuery using xqDoc, from [http://www.xqdoc.org](http://www.xqdoc.org). This section describes how to generate XQuery documentation, and how to annotate your XQuery code for reporting purposes.

### Documentation Defaults

By default, xqDoc generates Module URI, Function Summary, and Function Detail sections for each XQuery, as shown in the following illustration.

![Default xqDoc Report](image)

**Figure 350. Default xqDoc Report**
If you want, you can add your own comments using the syntax described in the following section, “Syntax and Usage” on page 799.

**Syntax and Usage**

Comments for xqDoc must start with (:~ and end with :). Comments can span multiple lines. New lines do not need to be introduced with a special character. You can use `<br/>` to force a line break, which you might want to do to aid readability. Comments that start with (: (standard XQuery syntax) are ignored by xqDoc.

The first comment in an XQuery document is interpreted by xqDoc as the Module Description. Within that comment, xqDoc recognizes certain keywords preceded by the at (@) sign. Examples include @author and @version. See the xqDoc documentation at [http://www.xqdoc.org](http://www.xqdoc.org) for more information. Here is a report for the same document shown in Figure 350 with a user-defined module and function descriptions.

![Figure 351. xqDoc Report with Additional Module and Function Descriptions](image-url)
All other comments must precede function declarations. xqDoc uses the text you enter to provide a description for each function listed in the Function Summary. The same description is used in the Function Detail. Here is an illustration of the XQuery document in the XQuery Editor; the xqDoc comments are highlighted:

![XQuery Editor with xqDoc comments]

**Figure 352. xqDoc Comments as Seen in XQuery Source**

**Save the XQuery Document**

When you annotate an XQuery document using xqDoc comments, make sure to save the XQuery document before generating documentation. Unsaved work is not detected by the report generating mechanism.

**ActiveX Controls**

xqDoc reports use ActiveX controls for navigation and code sample generation. Make sure to enable ActiveX controls for the browser displaying the xqDoc report.
Generating XQuery Documentation

Viewing Code Samples

You can view code samples from an xqDoc report by clicking the view code hyperlink, as shown in the following illustration.

![Figure 353. Viewing an XQuery Code Sample](image)

The XQuery code sample appears in a separate Web browser.

How to Generate XQuery Documentation

1. Optionally, annotate your XQuery code as described in “Syntax and Usage” on page 799.
2. Save the XQuery document.
3. Click XQuery > Generate xqDoc.
Stylus Studio displays the **Browse for Folder** dialog box, which allows you to choose where you want to save the XQuery documentation.

![Browse For Folder](image)

**Figure 354. Browse for Folder Dialog Box**

By default, Stylus Studio selects the directory to which the XQuery document is saved. After that, Stylus Studio uses the last location to which you saved the XQuery documentation.

4. Optionally, change the location to which you want to save the XQuery documentation.

5. Click **OK**.

   Stylus Studio displays processing information in the **Output** window. A new Internet browser is launched; the XQuery documentation is displayed in this browser.

6. If you have not already done so, enable ActiveX controls for the browser window displaying the xqDoc report.

### Using XQuery to Invoke a Web Service

Web Service support is available only in Stylus Studio XML Enterprise Edition.

This section describes how to use the XQuery code that Stylus Studio generates from a Web service call. To learn more about the process of generating XQuery from a Web service call, see “Generating XQuery from a Web Service Call” on page 830.
Using XQuery to Invoke a Web Service

This section covers the following topics:

- “Requirements” on page 803
- “Using the Saxon Processor” on page 803
- “Invoking a SOAP Request in an XQuery” on page 804
- “Invoking Multiple SOAP Requests” on page 804

Requirements

In order to use the XQuery generated by Stylus Studio to invoke a Web service, you need to

- Use either the built-in, Saxon, or DataDirect XQuery processor
- Ensure axis-all.jar and xercesimpl.jar are in your classpath. If you are using Java 1.4, you must also include xml-apis.jar.

Tip: You can check the version of your Java Virtual Machine on the About Stylus Studio dialog box (Help > About Stylus Studio).

Using the Saxon Processor

By default, the XQuery code generated by Stylus Studio is compliant with both the built-in and DataDirect XQuery processors. If you want to use the Saxon XQuery processor, you need to

- Comment the DataDirect namespace and function bindings:

```xml
declare namespace ws = 
"ddtekjava:com.stylusstudio.webservice.SOAPCall";
declare function ws:call($location as element(), $payload as
element()) as document-node() external;
```

- Uncomment the Saxon function binding:

```xml
declare namespace ws = "java:com.stylusstudio.webservice.SOAPCall";
```

Function bindings for both processor types are preceded with a string that identifies them, similar to this one for Saxon:

```xml
(: Saxon function binding :) 
```

Do not uncomment these strings.
Invoking a SOAP Request in an XQuery

1. Create a new Web service call and configure the SOAP request as required. See “How to Compose a Web Service Call” on page 816 if you need help with this step.

2. Generate XQuery code from the Web service call. See “How to Generate XQuery from a Web Service Call” on page 832 if you need help with this step.
   As a result of this step, XQuery code is copied to your system’s clipboard.

3. Open a new XQuery (File > New > XQuery File). Make sure you are using either the built-in, Saxon, or DataDirect XQuery processor. See “Selecting an XQuery Processor” on page 790 if you need help with this step.

4. Paste the clipboard contents into the XQuery document.

5. If necessary, modify your system’s Classpath as described in “Requirements” on page 803.

6. Preview the XQuery by clicking the Preview Result button at the top of the XQuery Editor.
   The results of the SOAP request contained in the XQuery appear in the Preview window.

7. If you are satisfied with the results, save the XQuery.

Invoking Multiple SOAP Requests

You can invoke multiple SOAP requests in the same XQuery. These SOAP requests can be from the same Web service, or from different Web services if they use the same parameters.

Rules

When invoking multiple SOAP requests in the same XQuery, bear in mind the following rules:

- The XQuery must contain only one instance of the header that declares the namespace and function bindings. In other words, copy only the Java extension function, ws:call(), to the XQuery.
- Separate each ws:call() with a comma, to create a sequence.
How to Invoke Multiple SOAP Requests in the Same XQuery

1. Make sure you understand the rules for including multiple SOAP requests in the same XQuery code as described in the previous section, “Rules” on page 804.

2. Create the first Web service and generate XQuery code for the SOAP request as described in “Generating XQuery from a Web Service Call” on page 830.

   The XQuery code generated by Stylus Studio is copied to your system’s clipboard.

3. Create a new XQuery, and paste the contents of your system clipboard into it.

4. Type a comma at the end of the `ws:call()` function.

5. Repeat Step 2 for the next Web service SOAP request you want to invoke from your XQuery.

6. Paste the new XQuery code into the XQuery you created in Step 3. Before pasting, place the text cursor after the comma you typed in Step 4.

7. From the XQuery code you just pasted, delete everything except the `ws:call()` function.

8. If you want to add another SOAP request to your XQuery, type a comma after the `ws:call()` function you just pasted, and return to Step 2.

Generating Java Code for XQuery

Java code generation is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio includes a Java Code Generation wizard that creates Java code based on the scenarios defined for an XQuery document. This section describes scenario settings that affect the generated code, as well as procedures for generating, compiling, and running generated code.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Java Code Generation video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

This section covers the following topics:

- “Scenario Settings” on page 806
- “Java Code Generation Settings” on page 808
Working with XQuery in Stylus Studio

- “How to Generate Java Code for XQuery” on page 808
- “Compiling Generated Code” on page 810
- “Deploying Generated Code” on page 812

Tip: You can also generate Java code for XSLT. See ”Generating Java Code for XSLT”.

Scenario Settings

Stylus Studio generates Java code based on the scenarios you have defined for an XQuery document. The following tables summarizes the scenario settings that have an effect on Java code generation.

Table 77. Scenario Settings that Affect Java Code Generation

<table>
<thead>
<tr>
<th>Tab</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The Java Code Generation wizard uses only the <strong>Main input</strong> and <strong>Output URL</strong> fields, if specified.</td>
</tr>
<tr>
<td>Processor</td>
<td>You must use the Saxon or processor. The Stylus Studio URI Resolver is also used to resolve non-standard URIs if you select the check box on the <strong>Processor</strong> page.</td>
</tr>
<tr>
<td>Parameter Values</td>
<td>Any parameter values you specify are processed by the Java Code Generation wizard.</td>
</tr>
<tr>
<td>Profiling Options</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Validation</td>
<td>Validation is optional. If you choose to validate XQuery output, the Java Code Generation wizard always uses the Xerces-J processor, regardless of the validator you specify on the <strong>Validation</strong> tab. If you want to specify external schemas for validation purposes, click <strong>Use built-in validator</strong>. Note that the Xerces-J processor is used for validation even in this case.</td>
</tr>
</tbody>
</table>
Choosing Scenarios

You can generate Java code for one or more of the scenarios defined for a single XQuery document. By default, the Java Code Generation wizard selects only the current scenario for generation, as shown in Figure 355.

The generated code includes a `setScenario` method for every scenario you select for code generation, as shown in the following example.

```java
// Uncomment the setScenario call for the scenario you want the code to run.
// All other scenarios must be commented out.
app.setScenario_books();
app.setScenario_books_public();
app.setScenario_books_validation();
app.setScenario_myBooks();
```

Only one `setScenario` method can be called at a time. Uncomment the `setScenario` method for the scenario you want the code to process, and make sure that all other `setScenario` methods are commented.
Java Code Generation Settings

When you generate Java code for an XQuery document, you need to specify

- The target directory in which you want the Java code created. For example, if the directory you name does not exist, Stylus Studio creates it when you run the Java Code Generation wizard. The default is a `sources` directory, which is created where you installed Stylus Studio when you generate the code, for example, `c:\Program Files\Stylus Studio\sources`.

- Optionally, a package name. If you specify a package name, this name is used for a subfolder created in the target directory you specify. For example, if you specify `myPackage` as the package name, the generated code is written to `c:\temp\myJavaCode\myPackage`. (Though optional, it is considered good practice to create a package name.)

- The class name. Stylus Studio also uses the class name for the `.java` file created by the Java Code Generation wizard. For example, if you provide the name `myClass`, Stylus Studio creates `c:\temp\myJavaCode\myPackage\myClass.java`.

In addition, you can specify whether or not you want to

- Create the class as a public class
- Include the `main(String[] args)` method
- Add the generated code to the current project

All of these options are selected by default.

Tip: If you choose to add the generated code to the project, it creates a folder using the package name you specify and places the `.java` file in that folder. If you do not specify a package name, the `.java` file is added directly below the project root in the Project window.

How to Generate Java Code for XQuery

1. Define at least one scenario for the XQuery document for which you want to generate Java code. The scenario must use the Saxon or processor. See “Scenario Settings” on page 806 for more information.

3. Specify the settings you want for the target directory, package and class names, and so on. See “Java Code Generation Settings” on page 808 if you need help with this step.

4. Select the scenarios for which you want to generate Java code.

5. Click OK.

Stylus Studio generates Java code for the XQuery. When the code generation is complete, the resulting file (classname.java) is opened in the Stylus Studio Java Editor.
Compiling Generated Code

In order to compile the Java code generated for XQuery, you need to make sure that the following JAR files are in the Stylus Studio classpath:

- CustomFileSystem.jar
- Saxon8.jar

These files are in the \bin directory where you installed Stylus Studio.

How to Modify the Stylus Studio Classpath

1. Select Tool > Options from the Stylus Studio menu.
2. Click Java Virtual Machine under General.
3. Click the browse button alongside the Classpath field.
   The Add Directory or JAR File to Classpath dialog box appears.
4. Click the browse folders button.
   A new entry field appears in the Locations list box. Two buttons appear to the right of the entry field.

Figure 357. Entry Field for JAR File Classpath
5. Click the browse jar files button ( ).
Stylus Studio displays the **Browse for JAR Files** dialog box.

![Browse for JAR Files Dialog Box](image)

6. Navigate to the Stylus Studio `bin` directory, select the `CustomFileSystem.jar` file, then click **Open**.

7. Repeat Step 6, this time selecting the `Saxon8.jar` file.

8. Click **OK** to close the **Add Directory or JAR File to Classpath** dialog box.

### How to Compile and Run Java Code in Stylus Studio

1. Make sure the Java Editor is the active window.

2. Click the **Compile** button ( ).
   
   **Alternatives:** Press Ctrl + F7, or select **Java > Compile** from the Stylus Studio menu. Stylus Studio compiles the Java code. Results are displayed in the **Output** window.

1. Make sure the Java Editor is the active window.

2. Click the **Run** button ( ).
   
   **Alternatives:** Press Ctrl + F5, or select **Java > Run** from the Stylus Studio menu. If the code has not been compiled, Stylus Studio displays a prompt asking if you want to compile the code now. Otherwise, Stylus Studio runs the Java code. Results are displayed in the **Output** window.
Deploying Generated Code

If your XQuery application uses Stylus Studio’s adapter file system technology – to convert CSV or EDI to XML, or to render relational data as XML, for example – you need to use the optional Stylus Studio 2006 XML Deployment Adapters if you wish to deploy your code to a test or application server. The Stylus Studio 2006 XML Deployment Adapters are purchased and installed separately from Stylus Studio 2006 XML Enterprise Edition. Write Stylus Studio at stylusstudio@stylusstudio.com, or call 781.280.4488 for more information.

Overview

The process for deploying generated XQuery code that uses Stylus Studio’s adapter file system technology includes the following steps:

In Stylus Studio

1. Build and test the application in Stylus Studio. When testing, be sure to use the XQuery processor you will be using in your production environment. You specify the XQuery processor on the Processors tab of the Scenario Properties dialog box.

2. Generate and compile Java code for the XQuery in Stylus Studio (myApplication.java, for example).

3. Copy the XQuery (.xquery), source (.edi, for example), and Java file for the generated application (.java) to the target production server.

On the Production Server

1. If you have not done so already, install the Stylus Studio 2006 XML Deployment Adapters module.

2. Modify the classpath to include the location of the Jar files associated with the Stylus Studio 2006 XML Deployment Adapters module.

3. Open the .java file (myApplication.java, for example) and edit the following:
   ■ StylusFileFactory.unlockAPI() – this method’s argument requires the installation ID of the Stylus Studio 2006 XML Deployment Adapters module.
   ■ setProp() – these methods identify the location of Stylus Studio 2006 XML Deployment Adapters module directories.
   ■ m_scriptSource.setFile – this data member is the XQuery file (.xquery).
m_xmlSource.setFile – this data member is the source file referenced in the XQuery.

The section of code in which you will find these files is shown here:

```
// This section performs initialization required by the
// Stylus Studio URIResolver. Further details can be found in
// the Stylus Studio Javadoc for package com.exln.stylus.io.
// setProp will not change any System properties that were
// set before this method was run.
StylusFileFactory.unlockAPI("310279283224998-1175126951");
setProp("appdata", "C:/Documents and Settings/All Users/Application Data/Stylus
Studio");

m_useResolver = true;
m_scriptSource = new ResolverSource();
m_xmlSource = new ResolverSource();
m_finalResult = new ResolverResult();
m_scriptSource.setFile("c:/Program Files/Stylus Studio 2006 XML Enterprise
Edition/test/myApplication.xquery");
m_xmlSource.setFile("c:/Program Files/Stylus Studio 2006 XML Enterprise
Edition/test/books.xml");
m_finalResult.setNone();
```

4. Compile the .java file.

You can now run the application code independently, or incorporate it in another application on the same server.

**About the unlockAPI() Method**

The unlockAPI() method is part of the Stylus Studio Custom File System API. This method takes as its argument a Stylus Studio installation ID, one from either Stylus Studio 2006 XML Enterprise Edition, or from the Stylus Studio 2006 XML Deployment Adapter.

The Enterprise Edition installation ID is adequate for testing purposes on your local workstation, but if you want to deploy an XQuery application that uses Stylus Studio adapters on one or more test or application servers, you need to use the Deployment Adapter installation ID for the unlockAPI() method’s argument.
Working with XQuery in Stylus Studio
Chapter 11  Composing Web Service Calls

The Web services features described in this chapter are available only in Stylus Studio XML Enterprise Edition.

Using Stylus Studio’s Web service call composer, you can design, compose, and test a Web service call without writing any code. Once Stylus Studio composes the Simple Object Access Protocol (SOAP) request and you have successfully tested it, you can use the SOAP response returned by the Web service as an XML source wherever you use XML documents in Stylus Studio.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Introduction to the XQuery Mapper video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

Contents

This chapter covers the following topics:

- “Overview” on page 816
- “Obtaining WSDL URLs” on page 818
- “Modifying a SOAP Request” on page 822
- “Testing a Web Service” on page 824
- “Saving a Web Service Call” on page 825
- “Generating a Java Web Service Client” on page 829
- “Generating XQuery from a Web Service Call” on page 830
- “Creating a Web Service Call Scenario” on page 833
Composing Web Service Calls

Overview

The process of composing a Web service call in Stylus Studio involves the following steps:

1. Specify the Web Services Description Language (WSDL) URL associated with the Web service you want to use. See “Obtaining WSDL URLs” on page 818.

2. Compose the Simple Object Access Protocol (SOAP) request.
   a. Select the operation described by the WSDL for which you want Stylus Studio to compose a SOAP request.
   b. Provide values for the SOAP request parameters.
      See “Modifying a SOAP Request” on page 822.

3. Test the Web service. You can test a Web service call as you composed it, or you can create a scenario to test the Web service call using parameters of your choosing. See “Testing a Web Service” on page 824.

Once you are satisfied with the Web service call, you can optionally
   ● Save the Web service call for later use. See “Saving a Web Service Call” on page 825.
   ● Generate a Java Web service client. See “Generating a Java Web Service Client” on page 829.
   ● Create a Web service scenario. See “Creating a Web Service Call Scenario” on page 833.

How to Compose a Web Service Call

1. From the Stylus Studio menu bar, select File > New > Web Service Call.
Stylus Studio opens a new document in the Web Service Call Composer.

1. Type a WSDL address in the **WSDL URL** field, or use the **UDDI** button to browse UDDI registries for published Web services. See “Obtaining WSDL URLs” on page 818 for help with this step. (Any WSDL URLs that you have used previously are displayed in the **WSDL URL** drop-down list.) Web service operations for the WSDL you select are displayed in the **Operations** field.

2. Select the Web service operation for which you want to create a SOAP request from the **Operations** field.

   Parameters for the operation you select are displayed in the **Name** field; the datatype for each parameter is displayed in the **Type** field. The SOAP request is displayed beneath the fields you use to define the operation’s parameters.

3. Set values for the parameters:
   
   a. Click the parameter name.
   
   b. Type a value in the **Value** field.

   Stylus Studio updates the SOAP request to reflect the parameter values you enter.

   **Alternative:** You can manually edit the XML in the SOAP request. If you do, the **Value** field is updated automatically.
5. When you have provided values for all of the parameters, click the **Send Request** button ( ) to test the Web service.

If it is not already open, Stylus Studio opens the **Preview** window and displays the SOAP response returned by the Web service, as shown in **Figure 360**:

[Figure 360. SOAP Response]

6. Optionally, save the Web service call. See “**Saving a Web Service Call**” on page 825 for help with this step.

**Obtaining WSDL URLs**

Every Web service is described by a Web Services Description Language (WSDL). The WSDL defines the format of the SOAP messages used to send requests to and receive responses from the Web service, the transfer protocol used, namespace declarations, and other information. Several vendors, such as IBM, Microsoft, and SAP, have established
Obtaining WSDL URLs

Universal Description, Discovery, and Integration (UDDI) registries, to make Web services publicly available.

You can locate WSDLs on your own, or you can use Stylus Studio to search UDDI registries for published Web services.

Browsing UDDI Registries

You browse UDDI registries and search for published Web services (and the WSDLs that describe them) using the UDDI Browser dialog box.

The UDDI Registry field displays a list of public UDDI registries. You use the Query field (obscured by the UDDI Registry drop-down list in the preceding illustration) to specify the keywords you want to use to search a UDDI registry from this list. For example, if you are building a weather application, you might type weather in the Query field to search for weather-related Web services. Keywords are matched against the Web service and company information available in the UDDI registry, not against the WSDL itself.
Composing Web Service Calls

Generally speaking, the same search executed against different UDDI registries will yield different results.

In addition to specifying keywords, the UDDI Browser dialog box allows you to

- Specify whether you want to search by Web service (the default) or by provider
- Limit the search results to a number or rows (the default is 100)

When you execute the search (by clicking the Search button), Stylus Studio displays search progress in a status bar. You can stop the search at any time by clicking the Stop button.

When the search is complete, the URLs for any WSDLs that meet your search criteria are displayed in the Result field. For example, if you search the XMethods UDDI registry for Web services related to weather, the Stylus Studio UDDI Browser returns the following results:

![Figure 362. UDDI Browser result](image_url)
Obtaining WSDL URLs

What to do next

When you select a WSDL URL, Stylus Studio displays the operations supported by the Web service in the Web Service Call Composer. The first operation is selected by default, and the SOAP request that defines it is displayed in the XML editing area. Web services can provide multiple operations. See “Modifying a SOAP Request” on page 822.

If you do not see a suitable WSDL URL in the UDDI registry you searched, modify your query in the UDDI Browser and try your search again, or search a different UDDI registry.

How to Browse UDDI Registries

1. In the Web Service Call Composer, click the UDDI button.
   The UDDI Browser dialog box appears.

2. In the UDDI Registry field, type the URL of a UDDI registry, or select a UDDI registry from the drop-down list.

3. In the Query field, enter the string you want to use to search the selected UDDI registry for available Web services.

4. Optionally, change the following:
   - Max Rows – the maximum number of results you want displayed in the Results field.
   - Search By – whether you want to search the UDDI registry by company or by Web service (the default).

5. Click the Search button.
   Search progress is displayed in a status bar. When the search is complete, WSDLs that match the search criteria you specified are displayed in the Results field.

6. Select the WSDL that defines the Web service operation for which you want to compose a SOAP request and click OK.
   The UDDI Browser dialog box closes and you are returned to the Web Service Call Composer.
Modifying a SOAP Request

When you select a WSDL from the Result field in the UDDI Browser and click OK, the operations exposed by the Web service are displayed in the Stylus Studio Web Service Call Composer.

When you select an operation from the Operations pane, Stylus Studio displays

- Parameters associated with that operation, including their datatype and a field in which you can enter a value for testing purposes.
- The XML that describes the SOAP request associated with that operation. You can edit the SOAP request, but for initial testing you should restrict changes to providing parameter values, and you can use the parameter’s Value field for this purpose.

Understanding Parameters

Stylus Studio displays the datatype for SOAP request parameters. It is not possible to determine all of the details for parameters, however. A zipCode parameter might take the following:

12309, 02134, 90210

Or it might take only a single value. Sometimes this type of information is provided in the WSDL itself. In some cases, however, you might have to contact the Web service provider to obtain this information.
Displaying a WSDL Document

You can easily display a WSDL document within Stylus Studio once you have specified the WSDL URL. You might want to look at a WSDL document to learn more about the structure of the SOAP request, or to see if the Web service provider commented the XML to include information for developers using their Web service.

How to display a WSDL document

Stylus Studio displays the WSDL document in its own XML editor, as shown in Figure 364:

![Figure 364. WSDL document editor](image)

How to Modify a SOAP Request

1. Select the Web service operation for which you want to compose a SOAP request from the Operations pane.
   
   The SOAP request for the Web service operation appears in the XML editing area.

2. In the Name field, select a parameter and enter a value for it in the Value field.

3. Repeat Step 2 for any remaining parameters.

What to do next

Once you have specified values for the SOAP request’s parameters, you can test the Web service. See “Testing a Web Service” on page 824.
Testing a Web Service

You can test a Web service from within Stylus Studio. Testing allows you to quickly and easily:

- Verify whether or not the Web service is available
- Understand whether or not the Web service provides the type of information you expect and require
- Learn about the SOAP response returned by the Web service
- Learn how parameters you might choose to specify in a Web service call scenario affect the Web service operation

What Happens When You Test a Web Service

When you test a Web service, Stylus Studio submits the SOAP request to the WSDL URL specified in the Web service call. The result, when it is returned, is displayed in the Preview window of the Web Service Call Composer.

By default, Stylus Studio uses the HTTP transport protocol to submit the SOAP request to the WSDL server. Stylus Studio uses the proxy server specified on the local machine if one has been configured.

Other Options for Testing a Web Service

In addition to testing a Web service as described in this section, you can also create a Web service call scenario. Web service call scenarios allow you to:

- Use transport protocols besides HTTP
- Specify overrides to the WSDL (changing the SOAP action, for example)
- Change default settings (such as the time out value for executing SOAP requests)

See “Creating a Web Service Call Scenario” on page 833 to learn more about Web service call scenarios.
How to Test a Web Service

Stylus Studio displays the SOAP response in the Preview window as shown in Figure 365:

Figure 365. Testing a Web service

Saving a Web Service Call

You can save the Web service call composed by Stylus Studio. The file created when you save a Web service call includes the WSDL URL and the last Web service operation that you configured (including parameter values) prior to saving the file. For example, if you are using a Web service that provides separate operations for temperature conversions (one for Celsius to Fahrenheit and one for Fahrenheit to Celsius, for example), only the last one you test is saved.

Saving a Web service call gives you the ability to easily recall a preconfigured SOAP request for additional testing – allowing you to modify the SOAP request and test it without having to locate the WSDL.
Using Web Service Calls as XML

In addition to opening a Web service call in the Web Service Call Composer for testing purposes, you can open a Web service call as an XML document anywhere in Stylus Studio – in the XML editor, or as a source document in the XQuery mapper for example. When you open a Web service call as an XML document, Stylus Studio automatically executes the SOAP request and displays the SOAP response.

Consider the following Web service call, stock.wsc. The Web service operation used in this example returns current stock quote and other information based on the ticker symbols provided as parameters. Here is the SOAP request composed by Stylus Studio:

```xml
<?xml version="1.0" standalone="no"?>
<SOAP-ENV:Envelope xmlns:SOAPSDK1="http://www.w3.org/2001/XMLSchema"
    xmlns:SOAPSDK2="http://www.w3.org/2001/XMLSchema-instance"
    xmlns:SOAPSDK3="http://schemas.xmlsoap.org/soap/encoding/"
    xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/&quot;>
    <SOAP-ENV:Body>
        <s0:GetStockQuotes xmlns:s0="http://swanandmokashi.com/">
            <s0:QuoteTicker>prgs</s0:QuoteTicker>
        </s0:GetStockQuotes>
    </SOAP-ENV:Body>
</SOAP-ENV:Envelope>
</soap:Body>
<GetStockQuotesResponse xmlns="http://swanandmokashi.com/">
    <GetStockQuotesResult>
        <Quote>
            <CompanyName>PROGRESS SOFT</CompanyName>
            <StockTicker>PRGS</StockTicker>
            <StockQuote>20.10</StockQuote>
            <LastUpdated>10:17am</LastUpdated>
            <Change>+0.03</Change>
            <OpenPrice>20.05</OpenPrice>
            <DayHighPrice>20.40</DayHighPrice>
            <DayLowPrice>20.00</DayLowPrice>
            <Volume>13200</Volume>
            <MarketCap>695.1M</MarketCap>
            <YearRange>11.50 - 24.06</YearRange>
        </Quote>
    </GetStockQuotesResult>
</GetStockQuotesResponse>
</soap:Body>
</soap:Envelope>
```

And here is the SOAP response returned by the Web service:

```xml
<?xml version="1.0" encoding="utf-8"?>
<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
    xmlns:xsd="http://www.w3.org/2001/XMLSchema">
    <soap:Body>
        <GetStockQuotesResponse xmlns="http://swanandmokashi.com/">
            <GetStockQuotesResult>
                <Quote>
                    <CompanyName>PROGRESS SOFT</CompanyName>
                    <StockTicker>PRGS</StockTicker>
                    <StockQuote>20.10</StockQuote>
                    <LastUpdated>10:17am</LastUpdated>
                    <Change>+0.03</Change>
                    <OpenPrice>20.05</OpenPrice>
                    <DayHighPrice>20.40</DayHighPrice>
                    <DayLowPrice>20.00</DayLowPrice>
                    <Volume>13200</Volume>
                    <MarketCap>695.1M</MarketCap>
                    <YearRange>11.50 - 24.06</YearRange>
                </Quote>
            </GetStockQuotesResult>
        </GetStockQuotesResponse>
    </soap:Body>
</soap:Envelope>
```
The saved Web service call can be used as the source document for an XQuery in the XQuery mapper, as shown in Figure 366:

**Figure 366. Using a Web Service Call to Compose an XQuery**

XQueries composed using a Web service call as a source document return real-time data from the Web service as a result.
Where Web Service Calls are Saved

Stylus Studio saves Web service calls to the Web Services file system. By default, Web service calls are saved with a .wsc extension. When you open a saved Web service call, you must look in the Web Services file system, as shown in Figure 367:

How to Save a Web Service Call

1. Select File > Save from the Stylus Studio menu bar.
   The first time you save a Web service call, the Save As dialog box appears; for subsequent save operations, Stylus Studio displays the Save dialog box.

2. Change the default name (Untitled.wsc, for example), and click Save.
Generating a Java Web Service Client

You can use Stylus Studio to generate Java classes based on the currently active Web service call. You can then use those classes to write a Java application that allows you to invoke that Web service programmatically.

About the Generated Code

This section describes details about the Java code generated from a Web service call.

The Package Name

Stylus Studio bases the package name on the target namespace of the WSDL. For example, if we use a WSDL from www.swanandmokashi.com, the resulting Java package name is com.shawandmokashi. As described in the following sections, target directory and project folder names are also based on the WSDL’s target namespace.

Target Directory

By default, when you generate a Java Web service client, Stylus Studio creates a \java folder in your system’s \temp directory (c:\temp\java, for example). Subfolders based on the package name are created beneath the \java folder, and the Java classes are written there. For example, c:\temp\java\com\swanandmokashi\*.java.

You can specify whatever target directory you like, but the subfolders based on the package name cannot be specified when you generate the Java code.

Project Folders

By default, Stylus Studio adds the Java classes based on the Web service call to the current project, using the name of the target directory you specify; subfolders are based on the package name (\java\com\swanandmokashi, for example).

Classes

Stylus Studio generates a separate Java class for each function described in the WSDL of the current Web service call. Using the StockQuotes Web service from www.swanandmokashi.com, for example, results in the generation of the following Java classes:

- GetQuotes.java
Composing Web Service Calls

- GetQuotesResponse.java
- Quote.java
- StockQuotes.java
- StockQuotesLocator.java
- StockQuotesSoap.java
- StockQuotesSoapStub.java

How to Generate a Java Web Service Client

1. Create a Web service call as described in “How to Compose a Web Service Call” on page 816.

2. Test the SOAP request by clicking the **Preview Result** button, and verify that it returns the results you require.

3. Click **WebServiceCall > Generate Java Web Service Client** from the Stylus Studio menu.
   The Generate Java Web Service Client dialog box appears.

   ![Generate Java Web Service Client Dialog Box](image)

   **Figure 368. Generate Java Web Service Client Dialog Box**

4. Optionally, change the default target directory.

5. Optionally, change the default setting to add generated classes to the current Stylus Studio project.

6. Click **OK**.
   Stylus Studio generates the Java classes for the WSDL in the current Web service call.

Generating XQuery from a Web Service Call

You can use Stylus Studio to generate XQuery from a Web service call, and then use that XQuery to invoke the Web service. The XQuery created by Stylus Studio uses a Java
extension function, `ws:call()`, that allows the built-in, Saxon, or DataDirect XQuery processor to execute the Web service call.

This section covers the following topics:

- “Example” on page 831
- “What Happens When You Generate XQuery” on page 832
- “How to Generate XQuery from a Web Service Call” on page 832

Example

Consider the following `StockQuotesSoap` SOAP request defined using the Swan and Mokashi WSDL:

```xml
<?xml version="1.0"?>
    <SOAP-ENV:Body>
        <s0:GetQuotes xmlns:s0="http://swanandmokashi.com">
            <s0:QuoteTicker>prgs</s0:QuoteTicker>
        </s0:GetQuotes>
    </SOAP-ENV:Body>
</SOAP-ENV:Envelope>
```

This SOAP request was created using the Stylus Studio Web Service Call Composer, as described in “How to Compose a Web Service Call” on page 816.

The XQuery generated by Stylus Studio for this Web service call looks like this:

```xml
declare namespace ws = "ddtekjava:com.stylusstudio.webservice.SOAPCall";
declare function ws:call($location as element(), $payload as element()) as
document-node() external;

ws:call(
    <location
        address="http://www.swanandmokashi.com/HomePage/WebServices/StockQuotes.asmx"
        soapaction="http://swanandmokashi.com/GetQuotes" />
    <s0:GetQuotes xmlns:s0="http://swanandmokashi.com">
        <s0:QuoteTicker>prgs</s0:QuoteTicker>
    </s0:GetQuotes>
)
```

In addition to the header that declares the `ws` namespace and Java extension function, `ws:call()`, the generated code includes comments that specify `.jar` files that must be present
Composing Web Service Calls

in your Classpath in order to run the resulting XQuery in Stylus Studio. Here’s an example of the complete code generated by Stylus Studio for a Swan & Mokashi Web service:

```xml
(: This function requires the following items in the classpath :) (: axis-all.jar;xercesimpl.jar :) (: xml-apis.jar only if running on Java 1.4 :) (: Saxon function binding :) declare namespace ws = "java:com.stylusstudio.webservice.SOAPCall";(: DataDirect XQuery function binding :) declare namespace ds = "ddtekjava:com.stylusstudio.webservice.SOAPCall"; declare function ws:call($location as element(), $payload as element()) as document-node() external;
ws:call(
<location
address="http://www.swanandmokashi.com/HomePage/WebServices/StockQuotes.asmx"
soapaction="http://swanandmokashi.com/GetQuotes" />,
<s0:GetQuotes xmlns:s0="http://swanandmokashi.com">
  <s0:QuoteTicker>prgs</s0:QuoteTicker>
</s0:GetQuotes>
)
```

What Happens When You Generate XQuery

When you generate XQuery from a Web service call, Stylus Studio copies the resulting XQuery to your system’s clipboard. From there, you can paste it into a new or existing XQuery.

See “Using XQuery to Invoke a Web Service” for more information on working with XQuery generated from a Web service call.

How to Generate XQuery from a Web Service Call

1. Create a Web service call as described in “How to Compose a Web Service Call” on page 816.
2. Test the SOAP request by clicking the Preview Result button, and verify that it returns the results you require.
3. Click WebServiceCall > Copy XQuery to Clipboard on the Stylus Studio menu. Stylus Studio creates an XQuery based on the SOAP request and copies the generated XQuery code to your system’s clipboard.
Creating a Web Service Call Scenario

A Web service call scenario is a group of customizable settings associated with a Web service call composition. Stylus Studio uses these settings when you test a Web service using a scenario. If you don’t define a scenario, or don’t test the Web service call using a scenario, Stylus Studio uses the settings described in the WSDL. Examples of Web service call scenario settings include the client used to perform the Web service call; a username and password for Web services requiring authentication; and the length of time Stylus Studio will try to access the Web service before timing out.

You should consider creating a Web service call scenario only after you have defined the Web service call itself. This allows Stylus Studio to inherit values for the scenario from the WSDL you select for your Web service call.

You can create multiple scenarios that use the same Web service call, and define different settings for each. This flexibility can aid the Web service call development process as it enables you to easily test different Web service parameters before making the Web service call available in your XML applications. A scenario can be associated with only one Web service call.

This section covers the following topics:

- “Overview of Scenario Features” on page 833
- “How to Create a Scenario” on page 835
- “How to Run a Scenario” on page 836
- “How to Clone a Scenario” on page 837

Overview of Scenario Features

This section describes the main features of Web service call scenarios. It covers the following topics:

- “Scenario Names” on page 834
- “Transport Protocol and Client Settings” on page 834
- “Other Transport Settings” on page 834
Scenario Names

You specify a name for a Web service call scenario on the Binding tab of the Scenario Properties dialog box.

When you create a Web service call scenario, specify a name that makes it easy to distinguish one scenario from another.

Transport Protocol and Client Settings

You specify the transport protocol you want to use when testing the Web service on the Binding tab of the Scenario Properties dialog box.

When you use HTTP as the transport protocol, the Web service call client can be any one of the following:

- Microsoft .NET
- Apache Axis

Other Transport Settings

Once you specify the client, Stylus Studio displays a list of additional settings that you can use to define properties for the scenario. Some values, such as the time out, are system...
Creating a Web Service Call Scenario

defaults. Others, such as the SOAP action, are taken directly from the WSDL specified in the Web Service Call Composer.

**Note** Values you specify on the **Binding** tab override those in the WSDL displayed in the Web Service Call Composer.

**HTTP Settings**

The following table describes the scenario settings associated with the HTTP transport protocol.

**Table 78. HTTP Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>end point</td>
<td>The server on which the Web service is executed. For example: <a href="http://glkev.webs.innerhost.com/glkev_ws/WeatherFetcher.asmx">http://glkev.webs.innerhost.com/glkev_ws/WeatherFetcher.asmx</a>. This value is taken from the current Web service call. Required.</td>
</tr>
<tr>
<td>SOAPAction</td>
<td>The SOAP action described by the WSDL you selected for the Web service call. For example: <a href="http://www.myasptools.com/GetWeather">http://www.myasptools.com/GetWeather</a>. This value is taken from the current Web service call. Required.</td>
</tr>
<tr>
<td>user</td>
<td>The username used to access the Web service if authentication is required. Optional.</td>
</tr>
<tr>
<td>password</td>
<td>The password used to access the Web service if authentication is required. Optional.</td>
</tr>
<tr>
<td>time out</td>
<td>The time in milliseconds until the connection to the Web service server is dropped due to inactivity. The default is 300000 (300 seconds). Required.</td>
</tr>
</tbody>
</table>

**How to Create a Scenario**

1. Create a Web service call if you haven’t already. See “How to Compose a Web Service Call” on page 816 if you need help with this step.

2. Display the **Scenario Properties** dialog box by clicking ![...](image) in the Web service editor tool bar.
Composing Web Service Calls

Alternative: Select **Create Scenario** from the scenario drop-down list at the top of the editor window:

3. On the **General** tab, specify a name for the Web service call scenario.
4. Click the **Binding** tab.
5. Select the appropriate transport protocol from the **Transport** drop-down list.
6. Specify the binding properties you want to associate with this Web service call scenario.
7. Click **OK**.
   The Web service call scenario is saved with the name and settings you specified.

**How to Run a Scenario**

1. Select a scenario from the scenario drop-down list at the top of the editor window:

   *Alternative:*
Creating a Web Service Call Scenario

a. In the Web Service Call Composer tool bar, click .... Stylus Studio displays the Scenario Properties dialog box.

b. On the General tab, select the scenario you want to run from the Existing preview scenarios list.

c. Click OK.

2. Click the Send Request button ( ).

How to Clone a Scenario

When you clone a scenario, Stylus Studio creates a copy of the scenario except for the scenario name. This allows you to make changes to one scenario and then run both to compare the results.

1. Display the Scenario Properties dialog box by clicking .... in the Web Service Call Composer tool bar.

2. In the Existing preview scenarios field, click the name of the scenario you want to clone.

3. Click Clone.

4. In the Scenario name field, type the name of the new scenario.

5. Change any other scenario properties you want to change. See Overview of Scenario Features on page 833.

6. Click OK.

   If you change your mind and do not want to create the clone, click Delete and then OK.
Chapter 12  Accessing Relational Data as XML

The features for working with relational data as XML described in this chapter are available only in Stylus Studio XML Enterprise Edition and Stylus Studio XML Professional Edition.

This chapter describes the different ways you can access relational data and render that data as XML in Stylus Studio:

- DB-to-XML data sources, which you can use to query and, optionally, to modify data in a relational database from within Stylus Studio

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Creating DB-to-XML Data Sources video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.

This chapter covers the following topics:

- “Overview of DB-to-XML Data Sources” on page 840
- “Creating a DB-to-XML Data Source” on page 844
- “Specifying Connection Settings” on page 847
- “Using an ODBC Data Source in Stylus Studio” on page 850
- “Working with Scenarios” on page 860
- “Composing SQL/XML in Stylus Studio” on page 865
- “Working with Relational Data as XML” on page 868
Overview of DB-to-XML Data Sources

SQL/XML is an extension of the Structured Query Language (SQL) that allows you to query relational data, render query results as XML, and write modified or new data back to a relational database. Stylus Studio supports the SQL/XML standard by allowing you to create a *DB-to-XML data source*, a file that contains:

- Connection settings used to connect to a specific relational database on a specific server. You specify connection settings in a scenario. See “DB-to-XML Data Source Scenarios” on page 841 for more information.
- SQL/XML statements (SELECT and UPDATE, for example) that you want to execute on that database. Query results returned by the DB-to-XML data source you define can be used in Stylus Studio anywhere you use XML.

DB-to-XML data sources allow you to write your own SQL/XML and update the relational database.

This section covers the following topics:

- “System Requirements” on page 840
- “Supported Databases” on page 840
- “DB-to-XML Data Source Scenarios” on page 841
- “The DB-to-XML Data Source Editor” on page 842

System Requirements

In order to use DB-to-XML data sources, the Java Runtime Environment (JRE) 1.4.2 or greater must be installed on your machine. This feature also requires that you install the JRE with the optional module, Support for Additional Languages. You can verify whether or not this module has been installed by checking your JRE for these files:

- i18n.jar
- charsets.jar

Supported Databases

Stylus Studio supports several relational databases, including:

- IBM DB2
- Informix
- Microsoft SQL Server
Overview of DB-to-XML Data Sources

- Oracle
- Sybase

In addition, you can use DataDirect SequeLink Server, bundled with Stylus Studio, to connect to any ODBC data source.

See “Choosing a Database” on page 847 to learn more about specifying a database for a DB-to-XML data source. See “Using an ODBC Data Source in Stylus Studio” on page 850 to learn more about using DataDirect SequeLink Server to create an ODBC data source.

DB-to-XML Data Source Scenarios

A DB-to-XML data source scenario is a group of customizable settings associated with a DB-to-XML data source. You use a scenario to specify connection settings, such as the
- Database type
- Database server URI
- Username and password required to log on to the database server

You define these settings on the Scenario Properties dialog box. See “Specifying Connection Settings” on page 847 to learn more about DB-to-XML data source scenarios.
The DB-to-XML Data Source Editor

You use the DB-to-XML Data Source Editor to specify database connectivity settings, and to compose the SQL/XML (queries and other actions) that you want to execute on the server.

Tip

Once you connect to a server, Stylus Studio displays the databases, tables, views, and columns on the right side of the editor. When composing your SQL statements, you can drag and drop tables, views, and columns from the database schema tree into the SQL/XML editor.

SQL/XML Editor Pane

The SQL/XML editor pane is on the left side of the DB-to-XML Data Source Editor. It consists of two tabs, SELECT and UPDATE, which you use to compose SQL/XML SELECT and, optionally, UPDATE and INSERT statements. You can type directly in the editor, or you can use drag-and-drop to automatically compose SQL/XML statements.
Overview of DB-to-XML Data Sources

See “Composing SQL/XML in Stylus Studio” on page 865 to learn more about using the SQL/XML editor.

Database Schema Pane

The database schema pane is on the right side of the DB-to-XML Data Source Editor. Once you have established a connection to the database specified in the scenario, Stylus Studio displays a tree diagram of the database schema pane.

Figure 373. Database Tree Displayed in Database Schema Pane
Accessing Relational Data as XML

The database schema tree is displayed by default. You can hide it by clicking the Show/Hide Database Schema button ( ), or by selecting DB-to-XML > Database Schema from the menu.

**Note** Once the connection with the server has been established and the database is located, Stylus Studio drops the connection to the server. You can reconnect to the database to refresh the database schema tree by selecting DB-to-XML > Load Database Schema from the menu bar.

Information in the schema tree is displayed in a hierarchical fashion, starting with the server you specified in the connection settings. Tables, views, and columns are displayed in database order; column data types are displayed in the **Type** column.

Working with Relational Data

All SQL/XML statements are defined on the **SELECT** and **UPDATE** tabs. Stylus Studio can automatically create valid SELECT, INSERT, and UPDATE SQL/XML statements based on the objects you select from the database schema tree, or you can type your own SQL/XML. The actions that can be performed by the SQL/XML you define in your DB-to-XML data source are limited only by the permissions associated with the username you use to log in to the database. See “Composing SQL/XML in Stylus Studio” on page 865 for more information on this topic.

Creating a DB-to-XML Data Source

This procedure describes how to create a DB-to-XML data source based on natively supported databases, like Oracle and Sybase, as well as one based on an ODBC system data source created using DataDirect SequeLink Server.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch the Creating DB-to-XML Data Sources video.

A complete list of the videos demonstrating Stylus Studio’s features is here: http://www.stylusstudio.com/xml_videos.html.
Before You Begin

If you want to create a data source based on an ODBC database, you must first create and configure that database as an ODBC system data source. See “Using an ODBC Data Source in Stylus Studio” on page 850 for more information.

How to Create a DB-to-XML Data Source

1. Select **File > New > DB to XML Data Source** from the menu. Stylus Studio displays the **Scenario Properties** dialog box.
2. Specify a scenario name (or accept the default).
3. Specify the information needed to connect to the database server and log in to the database. This information includes
   - The database type (Oracle or Sybase, for example)
   - The server on which the database resides
   - The username, password, and any other information required to log in to the database.

   See “Specifying Connection Settings” on page 847 if you need help with this step. If you selected DataDirect SequeLink for the database type, see “Using DataDirect SequeLink as a DB-to-XML Data Source” on page 858.

   **Alternative**: If you have already defined a default connection setting and you want to use it for this scenario, click the **Use Default Connection** field.
4. Click **OK** to save the scenario.

   Stylus Studio automatically connects to the database and logs you into the server. The database schema, table, view, and column information for the database you specified in the scenario appears in the schema pane of the DB-to-XML Data Source Editor.
5. Compose the SQL/XML SELECT statement to query the database. (UPDATE and INSERT statements, which write modified data back to the database, are optional.)

   See “Composing SQL/XML in Stylus Studio” on page 865.
6. Click the **Execute Query** button ( ) the query and review the XML it returns.
7. Optionally (if you have written SQL/XML to write new or modified data to the database), save the XML document returned by the SQL/XML query to write data back to the database. See “Working with Relational Data as XML” on page 868.

The remainder of this chapter describes these steps in greater detail.
Saving a DB-to-XML Data Source

DB-to-XML data sources are saved with a .rdbxml extension to their own file system, Relational DB.

1. Click **File > Save** or **File > Save As** from the menu.
   The **Save As** dialog box appears. The **Look in** field defaults to the Relational DB file system.

2. Specify a name for your data source.

3. Click **Save**.

Opening a DB-to-XML Data Source

You can open a DB-to-XML data source

- As a DB-to-XML data source, that is, in the DB-to-XML data source editor. This gives you the opportunity to change the data source’s definition, including its connectivity settings and SQL/XML statements, for example.

- As XML, using any Stylus Studio editor that accepts XML (such as the XML editor, for example). When you open a DB-to-XML data source as XM L, Stylus Studio displays only the XML that resulted from executing the SQL/XML defined on the **SELECT** tab of the DB-to-XML data source.

1. Select **File > Open** from the menu bar.
   Stylus Studio displays the **Open** dialog box.

2. Select the data source you want to open.

3. If you want to open the data source in the DB-to-XML Data Source Editor, click **Open**.
   If you want to open the data source as an XML document:
   a. Click the down arrow on the **Open** button.
   b. Select the editor from the drop-down list.
   Stylus Studio opens the data source as an XML document in the editor you selected.

**Note**

When you save a DB-to-XML data source that you have opened as XML, any SQL/XML statements you have defined on the **UPDATE** tab are executed.
Specifying Connection Settings

Stylus Studio uses connection settings to connect to the database from which you want to create your DB-to-XML data source. Specific properties vary from database to database, but you generally need to specify

- The type of database to which you want to connect. You can connect to one of the default relational databases supported by Stylus Studio (Oracle, Microsoft SQL Server, Informix, and so on), or you can use DataDirect SequeLink to connect to any ODBC database you specify.
- The server URL and other connection parameters. In addition to the server’s location, connection parameters can include the server name, the port through which the connection is established, and other information, such as a server ID (SID).
- The username and password required to log in to the database.

This section describes these connection setting properties in greater detail, and tells you how to create a default connection setting you can reuse with any DB-to-XML data source you create.

In this section

This section covers the following topics:

- “Choosing a Database” on page 847
- “Using the Server URL Field” on page 848
- “Username and Password” on page 848
- “Creating a Default Database Connection” on page 848

Choosing a Database

Stylus Studio allows you to connect to

- Any of a number of natively supported relational databases, such as Oracle, Microsoft SQL Server, Sybase, Informix, and IBM DB2.
- Any ODBC-compliant database configured as a DataDirect SequeLink server.

If you want to connect to one of the relational databases supported by Stylus Studio, simply select the database from the Database Type drop-down list. If you want to use an ODBC database as a data source, you must first create and configure it as described in “Using an ODBC Data Source in Stylus Studio” on page 850.
Using the Server URL Field

You use the Server URL field to identify the server hosting the database to which you want to connect, the port to use, and any other required or optional parameters. For example, the string used to connect to a Microsoft SQL Server database might look like this:

```
//invanuccio:1521;DataBaseName=pubs
```

The specific syntax of the string you enter in the Server URL field varies based on database type. Consult your database documentation for information regarding connectivity syntax and optional parameters.

**Tip** Stylus Studio populates the Server URL field with a default string appropriate for the database you specify in the Type field.

Username and Password

You use the Username and Password fields to specify the database user you want to associate with this DB-to-XML data source.

**Note** The permissions of the user you specify dictate the types of operations that can be performed by the SQL/XML on the database. For example, if you specify a user with read-only permissions, the DB-to-XML data source will not be able to perform any INSERT or UPDATE operations.

Creating a Default Database Connection

To connect to a database when defining a relational data source, you can

- Specify connection settings individually, for each data source you create
- Create a default connection setting, which you can then reuse for any data source you create

Default database connections use the same settings as other database connections you create in Stylus Studio.

1. Select Tools > Options from the Stylus Studio menu.
   The Options dialog box appears.
Specifying Connection Settings

2. Select Module Settings > DB-to-XML > Default Connection.
   The Default Database Connection page appears.

3. Select the database type, server URL, and username and password for the database to which you want to connect.

4. Click the Connect button.
   The list box on the Default Connection page displays the databases associated with the database server to which you connect.

5. Select the database to you want this connection to access.

6. Click OK.
   The default connection is now available to use when creating a new DB-to-XML data source.

Creating a Database Connection from the File Explorer

You can also create a database connection from the File Explorer window.

1. Display the File Explorer window if it is not already open (View > File Explorer).

2. In the File Explorer window, right-click the RelationalDB icon and select New Server from the short-cut menu.
   Stylus Studio displays the Connection Settings dialog box.

   ![Connection Settings Dialog Box](image)

   Figure 374. Connection Settings Dialog Box

3. Specify the information needed to create the database connection and click OK. (See “Specifying Connection Settings” on page 847 if you need help with this step.)
The server connection appears in the **File Explorer** window.

![File Explorer window](image)

**Figure 375. New Database Server Connection**

4. Expand the server connection to expose the relational objects you want to include in your DB-to-XML data source.

### Using an ODBC Data Source in Stylus Studio

You can configure DataDirect SequeLink to take advantage of new or existing ODBC data sources you have created for databases, like Microsoft Access or Progress. The steps involved in this process are:

1. Download and install DataDirect SequeLink SocketServer.
2. Using the Microsoft ODBC Database Administrator, create the ODBC system data source.
3. Using DataDirect SequeLink Server Manager, configure DataDirect SequeLink to reference your ODBC system data source.

Once you have configured DataDirect SequeLink as described in this section, you can use it to create a DB-to-XML data source in Stylus Studio as you would for any natively supported relational database.

This section covers the following topics:

- “Installing DataDirect SequeLink SocketServer” on page 851
- “Creating an ODBC System Data Source” on page 851
- “Configuring DataDirect SequeLink to Reference an ODBC System Data Source” on page 855
- “Using DataDirect SequeLink as a DB-to-XML Data Source” on page 858
Installing DataDirect SequeLink SocketServer

In order to configure DataDirect SequeLink to reference an ODBC data source, you need to install the DataDirect SequeLink SocketServer on the machine on which the ODBC driver has been installed. The installation executable and user documentation for DataDirect SequeLink SocketServer are available:

- On the downloads page of the Stylus Studio Web site:
  
  http://www.stylusstudio.com/component_downloads.html

  The link for DataDirect SequeLink Server on this page downloads a self-extracting file to your computer. When you run the file, it unpacks the installation setup.exe file and user documentation for DataDirect SequeLink Server to the location you specify.

- In the \DataDirect\SequeLinkServer5.4 directory on the Stylus Studio installation CD-ROM. This directory contains the setup.exe you use to install DataDirect SequeLink Server, and a portal page, index.htm, for the DataDirect SequeLink Server user documentation.

Stylus Studio bundles DataDirect SequeLink Client.

Creating an ODBC System Data Source

You can use the procedure described in this section to create an ODBC system data source if one does not already exist for the database you wish to use as a Stylus Studio DB-to-XML data source.

**Note**  The example procedure described in this section uses Microsoft Access as the ODBC database on which the data source is defined. Some setup information will vary based on the database type.

1. Select **Start > Settings > Control Panel** from the Windows menu.
The **Control Panel** window appears.

![Control Panel Window](image1)

**Figure 376. Windows Control Panel Window**

2. Double-click **Administrative Tools** on the **Control Panel** window. The **Administrative Tools** window appears.

![Administrative Tools Window](image2)

**Figure 377. Windows Administrative Tools Window**
3. Double-click **Data Sources (ODBC)** on the **Administrative Tools** window. The **ODBC Data Source Administrator** dialog box appears.

4. Click the **System DSN** tab and then click the **Add** button.
The Create New Data Source dialog box appears.

5. Scroll down the list until you find the driver associated with the database for which you want to create a data source, and then click Finish. The ODBC Setup dialog box appears.

Note that the information in the ODBC Setup dialog box, including the dialog box title, varies based on the database driver you selected in Step 5. There, we selected a Microsoft Access database driver, so the information displayed in the ODBC Setup dialog box is specific to that database.
6. Enter a name in the **Data Source Name** field, then click the **Select** button in the **Database** group box. The **Select Database** dialog box appears.

![Select Database Dialog Box](image)

**Figure 382. Windows Select Database Dialog Box**

7. Navigate until you locate the database you want to use as the data source and then click **OK**. You are returned to the **ODBC Setup** dialog box.

8. Click **OK** on the **ODBC Setup** dialog box. The ODBC system data source is created.

9. Configure the data source in DataDirect SequeLink Server Manager as described in the following section, “Configuring DataDirect SequeLink to Reference an ODBC System Data Source” on page 855.

**Configuring DataDirect SequeLink to Reference an ODBC System Data Source**

Use the procedure described in this section to configure DataDirect SequeLink to reference an ODBC system data source.

1. Start the DataDirect SequeLink 5.4 Manager. For example, **Start > Programs > DataDirect SequeLink 5.4 Service for ODBC Socket > SequeLink 5.4 Manager Snapin.**
The sladmin54 window appears.

2. Expand the **SequeLink 5.4 Manager (localhost)** branch. This exposes another branch, **Not connected to SLAgent54**.

3. Expand the **Not connected to SLAgent54** branch.

The **Logon to SequeLink Service** dialog box appears.

4. Enter a user ID and password and click **OK** to connect to the SequeLink Service you created when you installed the DataDirect SequeLink SocketServer. (This will be the
user ID and password for the machine on which you installed the DataDirect SequeLink SocketServer.)

After connecting to the SequeLink Service, the information in the sladmin window changes.

5. Once you are connected, expand the SLSocket54 [active] branch as follows: Configuration > Data Source Settings > Default > Advanced. When you are done, your sladmin window should look like this:

![Figure 385. DataDirect sladmin Window – After Connecting](image)

![Figure 386. DataDirect sladmin Window – Advanced Settings](image)
6. Double-click `DataSourceSOCODBConnStr`. The `DataSourceSOCODBConnStr` dialog box appears.

![Figure 387. DataDirect Connection String Dialog Box](image)

7. In the `Value` field, enter the following: `DSN=data source name`, where `data source name` is the name of the data source you created in Step 6 of the procedure described in “Creating an ODBC System Data Source” on page 851.

8. Click `OK`, and close the `sladmin` window.

Now that you have created and configured the ODBC system data source, you can use it to create a DB-to-XML data source in Stylus Studio as described in “Using DataDirect SequeLink as a DB-to-XML Data Source” on page 858.

### Using DataDirect SequeLink as a DB-to-XML Data Source

Once you have configured DataDirect SequeLink to reference an ODBC system data source, you can use DataDirect SequeLink to create a DB-to-XML data source in Stylus Studio. The basic procedure is described here. For more information about how to create a DB-to-XML data source in Stylus Studio, see “Creating a DB-to-XML Data Source” on page 844.

1. Start Stylus Studio if it is not already running.

2. Click `File > New > DB to XML Data Source`. The `Scenario Properties` dialog box appears.
Using an ODBC Data Source in Stylus Studio

3. Select **DataDirect SequeLink** from the **Database Type** drop-down list.

4. In the **Username** and **Password** fields, use the same values you used to connect to the DataDirect SequeLink service (Step 4 in the procedure described in “Configuring DataDirect SequeLink to Reference an ODBC System Data Source” on page 855.

5. Click **OK**.
Stylus Studio connects to the ODBC system data source associated with the username and password you entered in Step 4 and displays its tables and views, as shown in the following illustration.

6. Compose the SQL/XML you want to associate with this DB-to-XML data source as described in “Composing SQL/XML in Stylus Studio” on page 865.

**Working with Scenarios**

As described earlier in this chapter, you use a DB-to-XML data source scenario to specify database connectivity settings. You create and modify DB-to-XML data source scenarios using the **Scenario Properties** dialog box.

This section describes how to open the **Scenario Properties** dialog box (Stylus Studio opens it for you automatically when you create a new DB-to-XML data source), and how to create new and modify existing scenarios.

This section covers the following topics:
- “Opening the Scenario Properties Dialog Box” on page 861
- “Creating a Scenario” on page 861
- “How to Modify a Scenario” on page 862
● “How to Clone a Scenario” on page 863
● “How to Rename a Scenario” on page 863
● “How to Delete a Scenario” on page 864

Opening the Scenario Properties Dialog Box

Stylus Studio displays the Scenario Properties dialog box for DB-to-XML data sources when you create a new DB-to-XML data source. But you can create a new scenario or modify an existing one at any time.

There are two ways to open the Scenario Properties dialog box for DB-to-XML data sources. Both allow you to work on existing DB-to-XML data source scenarios or to create new ones.

● Click in the DB-to-XML data source editor tool bar.
● Select Create Scenario or an existing scenario from the scenario drop-down list at the top of the editor window.

Creating a Scenario

This section describes how to create a DB-to-XML scenario.

Naming Scenarios

Stylus Studio supplies a default name, like Scenario0, for example, for new DB-to-XML scenarios. You can accept the default name, but you should consider typing a name that
Accessing Relational Data as XML

makes it easy to distinguish one scenario from another. See “How to Rename a Scenario” on page 863.

**How to Create a Scenario**

1. Open the DB-to-XML data source editor if it is not already open.
2. Select **Create Scenario** from the scenario drop-down list at the top of the editor window.
   Stylus Studio displays the **Scenario Properties** dialog box. The name field displays a default scenario name (Scenario1, for example) in edit mode.
3. Change the default scenario name.
4. Specify the connection settings. See **Specifying Connection Settings** on page 847 if you need help with this step.
5. Click **OK** to save the scenario with the new settings.
   Stylus Studio connects to the server specified in the scenario.

**Alternative**

Use this procedure if the **Scenario Properties** dialog box is already open.

1. Click **New** on the **Scenario Properties** dialog box.
   The name field displays a default scenario name (Scenario0, for example) in edit mode.
2. Change the default scenario name.
3. Specify the connection settings. See **Specifying Connection Settings** on page 847 if you need help with this step.
4. Click **OK** to save the scenario with the new settings.
   Stylus Studio connects to the server specified in the scenario.

**How to Modify a Scenario**

You can modify a scenario at any time. Change that you make take effect as soon as you save the scenario.

1. Display the **Scenario Properties** dialog box by clicking ... in the DB-to-XML data source editor tool bar.
2. In the **Existing scenarios** field, click the name of the scenario you want to modify.

3. Change the scenario’s properties as needed. See [Specifying Connection Settings](#) on page 847 if you need help with this step.

4. Click **OK** to save the new scenario.
   Stylus Studio connects to the server specified in the scenario.

### How to Clone a Scenario

When you clone a scenario, Stylus Studio creates a copy of the scenario except for the scenario name. This allows you to make changes to one scenario and then run both to compare the results.

1. Display the **Scenario Properties** dialog box by clicking ![...](image) in the DB-to-XML data source editor tool bar.

2. In the **Existing scenarios** field, click the name of the scenario you want to clone.

3. Click **Clone**.
   The name field displays a default scenario name (Scenario0, for example) in edit mode.

4. Change the default scenario name.

5. Change the source scenario’s connection settings as needed. See [Specifying Connection Settings](#) on page 847 if you need help with this step.

6. Click **OK** to save the new scenario.
   Stylus Studio connects to the server specified in the scenario.

### How to Rename a Scenario

1. Display the **Scenario Properties** dialog box by clicking ![...](image) in the DB-to-XML data source editor tool bar.

2. In the **Existing scenarios** field, click the name of the scenario you want to rename.

3. Click **Rename**.
   The name field displays the scenario name in edit mode.

4. Change the scenario’s name.

5. Click **OK** to save the new scenario.
### How to Delete a Scenario

1. Display the **Scenario Properties** dialog box by clicking ![ Ellipsis Button ] in the DB-to-XML data source editor tool bar.

2. In the **Existing scenarios** field, click the name of the scenario you want to delete.

3. Click **Delete**.

   The scenario is deleted from Stylus Studio.
Composing SQL/XML in Stylus Studio

There are two ways to compose SQL/XML in Stylus Studio:

- Manually, typing SQL/XML on the SELECT and UPDATE tabs
- Automatically, using drag-and-drop to help you compose some or all of the SQL/XML

You can enter any valid SQL/XML statements in the SQL/XML editor’s SELECT and UPDATE tabs, though only those statements for which you have permissions will be executed.

**Manually Entering SQL/XML**

When you type a qualified name in the SELECT or UPDATE tabs of the editor, Stylus Studio’s auto-completion feature displays a list of valid names. For example, when you type the period in this statement, `SELECT * FROM dbo`, Stylus Studio displays the following:

![Example of Stylus Studio’s Auto-Completion](image)

To finish the statement, select the object name from the drop-down list and press Enter (or just double-click).

**Using Drag-and-Drop**

When you use drag-and-drop to compose SQL/XML, you start by selecting an object (a table or a column, for example) from the database schema tree and dragging it to the SQL/XML editor. When you drop the object (by releasing the mouse button) on the editor, Stylus Studio displays a shortcut menu of choices for that object. These include

- The object name, in both unqualified and qualified formats (`authors` and `dbo.authors`, for example). The format you choose depends on the database you are using – some databases require qualified names, for example. You might want to use this feature to add object names to an SQL/XML statement without typing them.
Accessing Relational Data as XML

- A complete SELECT statement (if you are on the editor’s SELECT tab); Stylus Studio uses the object name you selected to complete the statement.
- A complete INSERT, UPDATE, or SELECT statement (if you are on the editor’s UPDATE tab); Stylus Studio uses the object name you selected to complete the statement.

Example

Following is an example of the INSERT statement Stylus Studio creates using the publishers table:

```
INSERT xml_document(?)
INTO dbo.publishers (pub_id, pub_name, city, state, country)
xml_row_pattern('/root/row')
VALUES(
    xml_xpath('pub_id/text()', 'CHAR'),
    xml_xpath('pub_name/text()', 'VARCHAR'),
    xml_xpath('city/text()', 'VARCHAR'),
    xml_xpath('state/text()', 'CHAR'),
    xml_xpath('country/text()', 'VARCHAR'))
```

How Relational Data is Translated to XML

Consider the following illustration of an excerpt from the authors table in the Microsoft SQL Server pubs database. This illustration shows only the first six columns of the table (and only the first few records); the state, zip, and contract columns have been omitted for clarity:

<table>
<thead>
<tr>
<th>au_id</th>
<th>au_lname</th>
<th>au_fname</th>
<th>phone</th>
<th>address</th>
<th>city</th>
</tr>
</thead>
<tbody>
<tr>
<td>213-46-8915</td>
<td>Green</td>
<td>Marjorie</td>
<td>415 986-7020</td>
<td>309 63rd St. #411</td>
<td>Oakland</td>
</tr>
<tr>
<td>238-95-7766</td>
<td>Carson</td>
<td>Cheryl</td>
<td>415 548-7723</td>
<td>589 Darwin Ln.</td>
<td>Berkeley</td>
</tr>
<tr>
<td>267-41-2394</td>
<td>O’Leary</td>
<td>Michael</td>
<td>408 286-2428</td>
<td>22 Cleveland Av. #14</td>
<td>San Jose</td>
</tr>
</tbody>
</table>

As you can see, the authors table has columns for author ID (au_id), author’s last name (au_lname), author’s first name (au_fname), and so on.
If we write a SELECT statement (SELECT * FROM dbo.authors), Stylus Studio returns the following XML document:

```
<?xml version="1.0" encoding="UTF-8" ?>
<root>
  <row>
    <au_id>213-46-8915</au_id>
    <au_lname>Green</au_lname>
    <au_fname>Marjorie</au_fname>
    <phone>415 986-7020</phone>
    <address>309 63rd St. #411</address>
    <city>Oakland</city>
    <state>CA</state>
    <zip>94618</zip>
    <contract>true</contract>
  </row>
  <row>
    <au_id>238-95-7766</au_id>
    <au_lname>Carson</au_lname>
    <au_fname>Cheryl</au_fname>
    <phone>415 548-7723</phone>
    <address>589 Darwin Ln.</address>
    <city>Berkeley</city>
    <state>CA</state>
    <zip>94705</zip>
    <contract>true</contract>
  </row>
  <row>
    <au_id>267-41-2394</au_id>
    <au_lname>O’Leary</au_lname>
    <au_fname>Michael</au_fname>
    <phone>408 286-2428</phone>
    <address>22 Cleveland Av. #14</address>
    <city>San Jose</city>
    <state>CA</state>
    <zip>95128</zip>
    <contract>true</contract>
  </row>
</root>
```

Notice that each record in the table (that is, each author) is rendered as a separate `<row>` element. Similarly, each column is rendered as a subelement of `<row>`, taking the column name (`au_id`, `au_lname`, and so on) as its own (`<au_id>`, `<au_lname>`, and so on). The document’s root element is given the name `<root>`. 
Working with Relational Data as XML

As shown in the example in the preceding section, an SQL/XML query is returned as XML. The XML is displayed in the Preview window in the DB-to-XML data source editor, as shown in Figure 392.

![Figure 392. SQL/XML Query Returned as XML](image)

You can work with an SQL/XML query result as XML and, optionally, update the relational database using changes to the XML file and the SQL/XML statements defined on the UPDATE tab of the DB-to-XML data source editor.

Understanding SELECT and UPDATE

As described previously, you define SQL/XML SELECT statements on the SELECT tab; you define INSERT and UPDATE statements on the UPDATE tab. The DB-to-XML data source simply presents the SQL/XML to the database. The database executes the SQL/XML to the best of its ability, based on the statements you have defined and the
permissions of the user associated with the DB-to-XML data source. If the user has read-only permissions, for example, any INSERT or UPDATE statement will fail.

**Tip**  The **Output Window** can help you troubleshoot database problems. To display the **Output Window**, click the **Output Window** button ( ).

**When Statements are Executed**

Statements on the **SELECT** tab are executed when you click the **Execute Query** button ( ). Statements on the **UPDATE** tab, on the other hand, are executed only when an XML version of the DB-to-XML data source document is saved. (The **Execute Query** button is disabled when the **UPDATE** tab is active.)

**Example**

This example shows how to define a DB-to-XML data source, and how DB-to-XML data sources interact with a relational database.

Consider a DB-to-XML data source that performs a simple SELECT and INSERT.

**The SELECT Statement**

The SELECT statement is defined on the **SELECT** tab of the DB-to-XML editor:

```sql
SELECT * FROM dbo.authors
```

This SELECT statement returns every author record from the `dbo.authors` table. Thus, the XML will have one `<row>` element for each author record in the table. There are currently 25 author records in the `dbo.authors` table.
The INSERT Statement

The INSERT statement is defined on the **UPDATE** tab of the DB-to-XML data source editor:

```sql
INSERT xml_document(?)
INTO dbo.authors
(au_id, au_lname, au_fname, phone, address, city, state, zip, contract)
xml_row_pattern('/root/row')
VALUES(
    xml_xpath('au_id/text()', 'VARCHAR'),
    xml_xpath('au_lname/text()', 'VARCHAR'),
    xml_xpath('au_fname/text()', 'VARCHAR'),
    xml_xpath('phone/text()', 'CHAR'),
    xml_xpath('address/text()', 'VARCHAR'),
    xml_xpath('city/text()', 'VARCHAR'),
    xml_xpath('state/text()', 'CHAR'),
    xml_xpath('zip/text()', 'CHAR'),
    xml_xpath('contract/text()', 'BIT'))
```

This INSERT statement attempts to insert the entire XML document content into table **dbo.authors**, matching the document contents using `xml_row_pattern('/root/row')`.

Saving the File

After executing the query from the DB-to-XML data source editor, we examine the query results, which are rendered as XML in the **Preview** window. (See Figure 392 on page 868, for an example of how SQL/XML query results are displayed in Stylus Studio.) Checking the results allows us to verify that the table we are querying is providing us with the data we expect.

Once we have verified the query result, we save the `.rdbxml` file. Although this file contains both SELECT and UPDATE statements, it is important to note that the SQL/XML defined on the **UPDATE** tab has not been executed at this point.
Opening the .rdbxml as XML

Next, we open the .rdbxml file using the XML editor, as shown here:

![Opening a DB-to-XML Data Source as XML](image)

Figure 393. Opening a DB-to-XML Data Source as XML

When the DB-to-XML data source is opened in the XML editor, it looks just like any other XML document – it displays the XML returned when we executed the SQL/XML query. Other data source attributes (connection settings and the SQL/XML statements themselves) are not accessible or visible when a data source is opened as XML, but they are present as metadata.
Updating the Data in the Database

To update the data from the authors table in the database, we modify the XML in the .rdbxml file, adding the following record (a new <row> element):

```
<row>
    <au_id>781-23-4956</au_id>
    <au_lname>Black</au_lname>
    <au_fname>Frank</au_fname>
    <phone>301 282-7361</phone>
    <address>23 Bishop St.</address>
    <city>Baltimore</city>
    <state>MD</state>
    <zip>21281</zip>
    <contract>false</contract>
</row>
```

The document now contains a total of 26 <row> elements – the 25 that were read from the database, and the one which we just added. If we save this document as it is currently written, the INSERT statement we defined in the DB-to-XML data source will attempt to insert the entire document back into the database – all 26 <row> elements.

Similarly, if we deleted all existing <row> elements from the document, and saved the .rdbxml file with only the new record we created (the <row> element for author Frank Black), only that record would be added to table dbo.authors.

**Note** How the INSERT operation behaves – whether or not duplicate records are created on the database, for example – is determined by the controls for data integrity established by the database administrator.
Chapter 13  Integrating with Third-Party File Systems

Integration with Berkeley DB XML and with TigerLogic XDMS is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio is fully integrated with two popular third-party file systems:

- Sleepycat Software’s Berkeley DB XML
- Raining Data® TigerLogic® XML Data Management Server (TigerLogic XDMS)

This chapter describes how to work with these file systems in Stylus Studio, and covers the following topics.

- “Using Stylus Studio with Berkeley DB XML” on page 876
- “Using Stylus Studio with TigerLogic XDMS” on page 886
Integrating with Third-Party File Systems

Using Stylus Studio with Berkeley DB XML

Integration with the Berkeley DB XML file system is available only in Stylus Studio XML Enterprise Edition.

Stylus Studio allows you to access XML documents stored on Sleepycat Software’s Berkeley DB XML database and to write documents back to the database. This section describes prerequisites, as well as the configuration and procedural information you need to get started.

This section covers the following topics:
- “Overview” on page 876
- “Prerequisites” on page 878
- “Configuring the BerkeleyDBXML.xml File” on page 879
- “Naming Files” on page 881
- “Opening a File Stored on Berkeley DB XML” on page 883
- “Saving a File Back to Berkeley DB XML” on page 883
- “Creating Containers with Stylus Studio” on page 885
- “Usage Tips” on page 886

Overview

Stylus Studio can read and write well-formed XML documents (.xml, .xsl, and so on) from/to Berkeley DB XML container files (containers). Containers typically have a .dbxml extension. In Stylus Studio, you reference external files using a URL. The URL used to access Berkeley DB XML files is dbxml://container_pathname/filename.xml:
- dbxml is the prefix that specifies that files will be read from Berkeley DB XML
- container_pathname is the pathname of a Berkeley DB XML container
- filename.xml is the name of the file you wish to access within that container

For example, to access one of the sample files provided with Berkeley DB XML, you might enter the following in the URL field of the Stylus Studio Open dialog box: dbxml:///C:/samples/simpleExampleData.dbxml/Allspice.xml.

Note that the container name (C:/samples/simpleExampleData.dbxml in the example) appears in the URL field as if it were a directory name. This is because Stylus Studio treats Berkeley DB XML containers very much like directories, and the XML documents stored within a container are treated like files within a directory.
Using Stylus Studio with Berkeley DB XML

You can save files back to the same container from which they were read, to a new container, or to some other file system (your local machine, for example).

**Note** You can use a Berkeley DB XML URL to open an XML document anywhere you can specify URLs in Stylus Studio. For example, you can use the Berkeley DB XML URL to specify the source document for XQuery Mapper.

**Berkeley DB XML Support**

Stylus Studio supports the following versions of Berkeley DB XML:

- 1.2.1
- 2.0.7
- 2.0.9
- 2.1.8
- 2.2.5
- 2.2.8

Each version is associated with specific .dll and .jar files that Stylus Studio must be able to access. See “Prerequisites” on page 878 for more information.

**Usage Summary**

The process for using Stylus Studio with Berkeley DB XML consists of the following steps:

1. Make Berkeley DB XML .jar and .dll files accessible to Stylus Studio. See “Prerequisites” on page 878 for more information on this step.

2. Configure the BerkeleyDBXML.xml file as described in “Configuring the BerkeleyDBXML.xml File” on page 879.

3. Open Berkeley DB XML files in Stylus Studio as described in “Opening a File Stored on Berkeley DB XML” on page 883.

4. Optionally, save your work back to Berkeley DB XML as described in “Saving a File Back to Berkeley DB XML” on page 883.

Each of these steps is described in greater detail in the sections that follow.
Prerequisites

In order for Stylus Studio to access files stored on the Berkeley DB XML database, it must be able to access certain .jar and .dll files supplied by Sleepycat Software. Specific files vary based the Berkeley DB XML you are using, as described in the Table 79.

Table 79. Sleepycat Files Required for Stylus Studio Access

<table>
<thead>
<tr>
<th>Version 1.2.1</th>
<th>Version 2.0.7</th>
<th>Version 2.0.9</th>
</tr>
</thead>
<tbody>
<tr>
<td>db.jar</td>
<td>db.jar</td>
<td>db.jar</td>
</tr>
<tr>
<td>dbxml.jar</td>
<td>dbxml.jar</td>
<td>dbxml.jar</td>
</tr>
<tr>
<td>libdb42.dll</td>
<td>libdb43.dll</td>
<td>libdb43.dll</td>
</tr>
<tr>
<td>libdb_java42.dll</td>
<td>libdb_java43.dll</td>
<td>libdb_java43.dll</td>
</tr>
<tr>
<td>libdbxml12.dll</td>
<td>libdbxml20.dll</td>
<td>libdbxml20.dll</td>
</tr>
<tr>
<td>libdbxml_java12.dll</td>
<td>libdbxml_java20.dll</td>
<td>libdbxml_java20.dll</td>
</tr>
<tr>
<td>Pathan.dll</td>
<td>libxquery10.dll</td>
<td>libxquery10.dll</td>
</tr>
<tr>
<td>xerces-c_2_4_0.dll</td>
<td>Pathan_7.1.dll</td>
<td>Pathan_7.1.dll</td>
</tr>
<tr>
<td></td>
<td>xerces-c_2_6.dll</td>
<td>xerces-c_2_6.dll</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 2.1.8</th>
<th>Version 2.2.5</th>
<th>Version 2.2.8</th>
</tr>
</thead>
<tbody>
<tr>
<td>db.jar</td>
<td>db.jar</td>
<td>db.jar</td>
</tr>
<tr>
<td>dbxml.jar</td>
<td>dbxml.jar</td>
<td>dbxml.jar</td>
</tr>
<tr>
<td>libdb43.dll</td>
<td>libdb43.dll</td>
<td>libdb43.dll</td>
</tr>
<tr>
<td>libdb_java43.dll</td>
<td>libdb_java43.dll</td>
<td>libdb_java43.dll</td>
</tr>
<tr>
<td>libdbxml21.dll</td>
<td>libdbxml22.dll</td>
<td>libdbxml22.dll</td>
</tr>
<tr>
<td>libdbxml_java21.dll</td>
<td>libdbxml_java22.dll</td>
<td>libdbxml_java22.dll</td>
</tr>
<tr>
<td>Pathan_7.1.dll</td>
<td>Pathan_7.1.dll</td>
<td>Pathan.dll</td>
</tr>
<tr>
<td>xerces-c_2_6.dll</td>
<td>xerces-c_2_7.dll</td>
<td>xerces-c_2_7.dll</td>
</tr>
</tbody>
</table>

These files are supplied by Sleepycat Software – either as part of a pre-built binary distribution of Berkeley DB XML, or built by you if you received a source code distribution from Sleepycat. These files are not provided as part of your Stylus Studio installation.
Once you have acquired these files, you must make them accessible to Stylus Studio. You do this by modifying your CLASSPATH and PATH environment variables as follows:

- The Java CLASSPATH must specify the location of the .jar files
- The PATH must specify the location of the .dll files

These environment variables must be established before you start Stylus Studio. You cannot set them within Stylus Studio.

**Tip** You can use Stylus Studio with multiple versions of Berkeley DB XML, but only one version can be specified during a given Stylus Studio session. To switch Berkeley DB XML versions, change the CLASSPATH and PATH environment variables as needed before starting Stylus Studio.

**Saving Files to Berkeley DB XML**

In order to save files to Berkeley DB XML, you must first edit the settings in a configuration file. See “Configuring the BerkeleyDBXML.xml File” on page 879.

**Configuring the BerkeleyDBXML.xml File**

You need to configure the BerkeleyDBXML.xml file in order to be able to save XML documents back to a Berkeley DB XML container. Until you configure the BerkeleyDBXML.xml file as described in this section, any files you read from Berkeley DB XML are marked read-only and cannot be written back to Berkeley DB XML.

**The Berkeley Database Environment**

The Berkeley database has the concept of a database environment. The database environment is typically a directory that contains the log and lock files that provide support for transaction processing. This directory may also contain databases – files that contain user data. The containers in which Berkeley DB XML stores XML documents are examples of Berkeley databases and typically, though not always, have a .dbxml extension.

To be able to determine what database environments exist in Berkeley DB XML, and which ones are associated with which containers, you need to

- Modify the BerkeleyDBXML.xml configuration file
- Validate your changes using the BerkeleyDBXML.xsd XML Schema

These files are installed in the \bin\lib\sleepycat directory where you installed Stylus Studio (e:\Program Files\Stylus Studio XML Professional Edition\bin\lib\sleepycat, for example).
The BerkeleyDBXML.xml Configuration File

The BerkeleyDBXML.xml configuration file contains elements that allow you to specify Berkeley DB XML database environments and directories:

- `<dbenv>` – The pathname of a database environment.
- `<dbdir>` – A directory within that database environment that stores the containers you wish to access.

A finished BerkeleyDBXML.xml configuration file might look like this:

```
<dbxml>
  <dbenv path="c:\dbenv1">
    <dbdir path="d:\datadir1/">
    <dbdir path="e:\datadir2/">
    </dbdir>
  </dbenv>
  <dbenv path="c:\testenv">
    <dbdir path="c:\testdata/">
    </dbdir>
  </dbenv>
  <dbenv path="c:\testenv2"/>
</dbxml>
```

Omitting `<dbdir>` and `<dbenv>` elements

In some cases, it is not necessary to have any `<dbdir>` elements, as is illustrated by the `<dbenv path="c:\testenv2"/>` element in the example BerkeleyDBXML.xml configuration file. You can omit the `<dbdir>` element

- If it has the same path as its `<dbenv>` parent.
- If you have a DB_CONFIG file in a database environment – Stylus Studio reads the set_data_dir entries in that file. (See the Berkeley DB XML API documentation for more information on the DB_CONFIG file.)

If you use the DB_HOME environment variable to locate your database environment and all its data directories are listed in the DB_CONFIG file for that database environment, you can omit that database environment from the BerkeleyDBXML.xml configuration file. Indeed, if that is your only database environment, you do not need the BerkeleyDBXML.xml configuration file at all.

Specifying `<dbdir>` pathnames

Pathnames you specify for `<dbdir>` elements can be absolute or relative. Relative pathnames are relative to the enclosing `<dbenv>` pathname, not to your current working directory.
Using Stylus Studio with Berkeley DB XML

The validate attribute

In Berkeley DB XML Version 2.0.7 and 2.0.9, the `<dbxml>`, `<dbenv>`, and `<dbdir>` elements have a `validate` attribute that allows Sleepycat to validate XML documents before saving them to the Berkeley DB XML file system. See “Validating Documents” on page 884 for more information on this topic.

How to Configure BerkeleyDBXML.xml

1. Open the BerkeleyDBXML.xml configuration file in Stylus Studio.
2. Specify the `<dbenv>` and `<dbdir>` elements as described in “The BerkeleyDBXML.xml Configuration File” on page 880.
3. Click Validate Document.
4. If the BerkeleyDBXML.xml configuration file is valid, save your changes.
   You are ready to use Berkeley DB XML with Stylus Studio.

Open the Output Window

The first time you perform an operation on the Berkeley DB XML, Stylus Studio tries to process the BerkeleyDBXML.xml file. As the file is processed, messages are written to the Stylus Studio Output window. These messages identify which database environments and directories are being processed. This can be a useful way to verify which directories Stylus Studio is associating with which database environment and identify when you might need to make a change in the BerkeleyDBXML.xml file.

Naming Files

File-naming conventions vary between Berkeley DB XML V1.2 and V2.0.

Table 80. Sleepycat Files Required for Stylus Studio Access

<table>
<thead>
<tr>
<th>Berkeley DB XML V1.2.1</th>
<th>Berkeley DB XML V2.0.7 and 2.0.9</th>
</tr>
</thead>
<tbody>
<tr>
<td>File names are not required</td>
<td>File names are required</td>
</tr>
<tr>
<td>File names do not have to be unique; Berkeley DB XML does, however, assign a unique ID number to each file when it is first saved to the container.</td>
<td>File names must be unique</td>
</tr>
</tbody>
</table>
Stylus Studio creates a unique pseudo-name for each named file in a container. Files without a name (supported only in Berkeley DB XML Version 1.2.1) are invisible to Stylus Studio. The pseudo-name consists of the file’s name, concatenated with a pound sign (#) and the file ID assigned by Berkeley DB XML.

**Example – Berkeley DB XML V 1.2.1**

Consider the following files in a container as seen by Berkeley DB XML V 1.2.1:

- flotsam.xml
- flotsam.xml
- jetsam.xml
- [a file without a name]

When you display this container in the Stylus Studio **Open** dialog box, only these files appear:

- flotsam#1.xml
- flotsam#2.xml
- jetsam.xml

Note that only duplicate file names are assigned a numeric ID. The fourth, unnamed, file, is not visible to Stylus Studio.
Opening a File Stored on Berkeley DB XML

You can open files stored on Berkeley DB XML in one of two ways:

- Using the **Open** dialog box, as described here.
- By entering the Berkeley DB XML URL for the document you want to open (dbxml:///C:/samples/simpleExampleData.dbxml/Allspice.xml, for example) in any field in Stylus Studio that allows you to specify a resource.

**Note** You can access only those files stored in containers. You cannot open standalone XML documents in Berkeley DB XML.

1. In the File Explorer, click the **Berkeley DB XML** icon.
   Alternatively: From the Stylus Studio menu bar, select **File > Open**, and then click the **Berkeley DB XML** icon displayed in the **Open** dialog box.
2. Navigate the file system and locate the Berkeley DB XML database that contains the file you want to open.
3. Select the file you want to open.
4. Click the **Open** button.

Saving a File Back to Berkeley DB XML

You save a file to Berkeley DB XML as you would save a file to any other file system – click **File > Save**. If the document is not well-formed, Berkeley DB XML will not write it to the container.

**Tip** Use the Stylus Studio well-formedness checker to check your XML documents before saving them to Berkeley DB XML.

**Saving and Containers**

By default, **File > Save** saves the file back to the same container from which it was read. Additionally, you can

- Save the file to any container you choose, provided that you have specified it (and its database environment) in the BerkeleyDBXML.xml file.
- Create a new container on the fly by specifying it in the URL. See “Creating Containers with Stylus Studio” on page 885.
Integrating with Third-Party File Systems

In any case, in order to save any work back to Berkeley DB XML, you must have previously configured the BerkeleyDBXML.xml file. See “Configuring the BerkeleyDBXML.xml File” on page 879.

Validating Documents

If you are using Berkeley DB XML Version 2.0.7 or 2.0.9, you can optionally have Sleepycat validate XML documents before saving them to the database. You do this using the validate attribute, which you can set in the <dbxml>, <dbenv>, and <dbdir> nodes in the BerkeleyDBXML.xml file, as shown in the following example:

```
<dbxml validate="true">
  <dbenv path="c:\dbenv1" validate="false">
    <dbdir path="d:\datadir1"/
    <dbdir path="e:\datadir2" validate="true"/>
  </dbenv>
  <dbenv path="c:\testenv" validate="true">
    <dbdir path="c:\testdata"/>
  </dbenv>
</dbxml>
```

The syntax for the validate attribute is validate=["true" | "false"]. By default, this attribute is not specified and validation is not performed.

Validation occurs at the container level; each container, specified as a node in the BerkeleyDBXML.xml file, can have its own settings for the validate attribute. A child node inherits the validate attribute from its parent; similarly, you can override settings for child nodes, as shown in the following example:

```
<dbxml>
  <dbenv path="c:\dbenv1" validate="true">
    <dbdir path="d:\datadir1"/>
    <dbdir path="e:\datadir2" validate="false"/>
  </dbenv>
</dbxml>
```

Here, the validate setting of the <dbenv> node overrides the (implicit) default of “false” of its parent, <dbxml>. The first child of <dbenv> inherits the validate="true" setting, and its second child overrides it.

**Note** The set_database_dir entries read from the DB_CONFIG file do not contain any validate settings. To validate database directories established by the DB_CONFIG file, enter them in the BerkeleyDBXML.xml file.
Using Stylus Studio with Berkeley DB XML

Schema requirements
In order for Sleepycat to validate an XML document, the XML document must have its schema defined in an internal DTD. If the document does not contain a DTD, or references an external XML Schema, the document is not validated and will be saved if it is well-formed.

Changing settings
Each time Stylus Studio starts, it reads the BerkeleyDBXML.xml configuration file and uses its settings for the entire session. If you want to change the validate attribute for a container, you must exit Stylus Studio, change the BerkeleyDBXML.xml file, and then restart Stylus Studio.

Tip Remember to validate the BerkeleyDBXML.xml file in Stylus Studio any time you edit it.

Creating Containers with Stylus Studio
Typically, you use Stylus Studio to access files in existing Berkeley DB XML containers. If you want, you can use Stylus Studio to create new containers. Stylus Studio creates a new container whenever

- You type a complete Berkeley DB XML URL in the URL field in the Save or Save As dialog box when saving a file from Stylus Studio. For example:
dbxml:///C:/samples/myNewContainer.dbxml/newWork.xml
- The output file name given to the command line utility StylusXslt.exe names a container that does not exist. See “Using Stylus Studio from the Command Line” for more information on this utility.

In order to create a new container:

- The container name must end in .dbxml.
- The container home must be in a known database environment, either as specified in the BerkeleyDBXML.xml configuration file, or DB_HOME

Node and Wholedoc Containers
Berkeley DB XML Version 2.0.7 and 2.0.9 support Node and Wholedoc containers. Berkeley DB XML Version 1.2.1 supports only Wholedoc containers. Containers created by Stylus Studio are always created as Wholedoc containers.
Integrating with Third-Party File Systems

Usage Tips

Following are some tips to help you work with Berkeley DB XML in Stylus Studio.

Before Starting Stylus Studio

Before you start Stylus Studio, you must

- Set your PATH and CLASSPATH environment variables
- Configure the BerkeleyDBXML.xml file. If any errors occur while accessing Berkeley DB XML – if a database pathname in the configuration file was incorrectly specified, for example – you must correct the problem and then restart Stylus Studio.

Note: Once Stylus Studio has successfully read the BerkeleyDBXML.xml file, it will not read it again until you restart Stylus Studio.

Database Environment Recovery

Database environment recovery applications must have exclusive access to the database environment they are trying to restore. If you need to perform a database environment recovery, be sure to shut down Stylus Studio – and any other applications that might be using that database environment – prior to starting recovery procedures.

Using Stylus Studio with TigerLogic XDMS

Integration with the TigerLogic XDMS file system is available only in Stylus Studio XML Enterprise Edition.

This section describes how to use Stylus Studio with the TigerLogic XDMS file system and covers the following topics:

- “Overview” on page 886
- “Connecting to TigerLogic XDMS” on page 887
- “Using Documents Stored on TigerLogic XDMS” on page 889
- “Creating Collections” on page 890

Overview

Stylus Studio can read and write well-formed XML documents (.xml, .xsl, and so on) from/to TigerLogic XDMS collections. In Stylus Studio, you reference external files
Using Stylus Studio with TigerLogic XDMS

using a URL. The URL used to access TigerLogic XDMS files is 
tig://server:port/database_name/collection_name/file_name.xml:

- `tig` is the prefix that specifies that files will be read from TigerLogic XDMS
- `server:port` is the server name that hosts the TigerLogic XDMS file system; the port is the port used to connect to the server
- `database_name` is the name of the TigerLogic XDMS database you want to access
- `collection_name` is the name of the TigerLogic XDMS collection associated with the document you want to open
- `file_name.xml` is the name of the XML document you wish to access within that collection

For example, to access the `auction.xml` document in `mycollection`, you might enter the following in the **URL** field of the Stylus Studio **Open** dialog box:

tig://ntstylus-dev:3408/mydb/mycollection/auction.xml

Note Stylus Studio treats collections very much like directories, and the XML documents stored within a collection are treated like files within a directory.

You can save files back to the same collection from which they were read, or to some other file system (your local machine, for example). You can create new collections.

**Note** You can use a TigerLogic XDMS URL to open an XML document anywhere you can specify URLs in Stylus Studio. For example, you can use the TigerLogic XDMS URL to specify the source document for XQuery Mapper and then process the XQuery using the TigerLogic XDMS XQuery processor.

**TigerLogic XDMS Version Support**

Stylus Studio supports TigerLogic XDMS Version 2.5.

**Connecting to TigerLogic XDMS**

The TigerLogic XDMS file system is accessible from the

- **Open** dialog box
- **File Explorer** window

In addition, if you know the file system URL for a specific TigerLogic XDMS database, you can enter it in a **URL** field (in the **Open** dialog box, for example) and connect to the file system in that fashion.
What Happens When You Connect

When you connect to the server hosting TigerLogic XDMS, Stylus Studio caches the information used to establish the connection – host name and port, username, and password – for the duration of the Stylus Studio session. When you exit Stylus Studio, all connections are dropped. Only the host name and port information is retained to help simplify subsequent connections.

Note  If a document in Stylus Studio (an XQuery or XSLT, for example) uses a document stored in a TigerLogic XDMS collection, when you open that document in a subsequent session, Stylus Studio automatically prompts you for the TigerLogic XDMS connection information.

How to Connect to TigerLogic XDMS

1. In the File Explorer window, expand the TigerLogic XDMS folder.

   ![Figure 394. TigerLogic XDMS Icon in File Explorer](image)

   Alternative: On the Stylus Studio menu, Click File > Open, and then click the TigerLogic XDMS icon.

   ![Figure 395. TigerLogic XDMS Icon in Open Dialog Box](image)

   Stylus Studio displays the Choose Server dialog box.
Using Stylus Studio with TigerLogic XDMS

2. Complete the **Server Name**, (server address and port; myServer:3008, for example) **User Name**, and **Password** fields, and click OK.

Stylus Studio connects you to the host specified in the **Server name** field. Icons representing the host and the TigerLogic XDMS databases residing on that host appear in the **File Explorer** window.

3. Optionally, expand the database folders to view the TigerLogic XDMS collections stored on that database.

4. Optionally, expand the collection folders to view the XML documents stored there.

**Reconnecting**

If you lose your connection with the server hosting the TigerLogic XDMS file system, and a document from a TigerLogic XDMS collection is open, Stylus Studio displays the **Authentication Required** dialog box the next time you try to access that document.

![Authentication Required Dialog Box]

This dialog box can appear, for example, when you
- Re-start Stylus Studio
- Refresh an XSLT or XQuery that uses an XML document from a TigerLogic XDMS collection

The **Authentication Required** dialog box prompts you for the username and password you used when you first established a connection with the server.

**Using Documents Stored on TigerLogic XDMS**

XML documents stored on the TigerLogic XDMS file system are available to you in Stylus Studio once you establish a connection to the server hosting TigerLogic XDMS, as described in “Connecting to TigerLogic XDMS” on page 887.
Integrating with Third-Party File Systems

**Opening Documents**

You can open a document stored in the TigerLogic XDMS file system by dragging it from the File Explorer window into an open document editor, the document editor tab area, or some other target. See “Dragging and Dropping Files in the Stylus Studio” and “Using the File Explorer” for more information. You can also select a document using the Open dialog box (File > Open).

**Saving Documents**

When you save a document to the TigerLogic XDMS file system, TigerLogic XDMS first validates the document to ensure that it is well-formed XML. If the document is well-formed, the document is saved; otherwise, you receive an error from the TigerLogic XDMS server.

**Auto-Save and Backup Files**

Stylus Studio has an option (select Tools > Options from the Stylus Studio menu) that automatically saves modified documents at an interval you determine (every 10 minutes is the default). This option is off by default.

The creation of backup files is managed by the TigerLogic XDMS file system. Stylus Studio does not create .bak files of files saved to the TigerLogic XDMS file system.

**Using Documents in XQuery and XSLT**

You can use XML documents stored in the TigerLogic XDMS file system as source and target documents in Stylus Studio XQuery and XSLT. They are treated as any other document with one exception: when you open a document in Stylus Studio that uses a document stored in the TigerLogic XDMS file system, Stylus Studio prompts you to supply authentication information (username, password) before reestablishing connection with the server hosting the TigerLogic XDMS file system.

**Creating Collections**

You can create new TigerLogic XDMS collections in Stylus Studio.

1. Connect to a TigerLogic XDMS server, as described in “Connecting to TigerLogic XDMS” on page 887.
2. Open the **File Explorer** window if it is not already open (*View > File Explorer*).

3. Right-click the TigerLogic XDMS server instance in which you wish to create the collection.

4. Select **New Folder** from the short-cut menu.
   A new folder icon appears under the icon for the TigerLogic XDMS server instance with the default name, *New Folder*.

5. Edit the default collection name and press Enter.

*Alternative:*

You can also create a new TigerLogic XDMS collection from the Open dialog box.

1. Connect to a TigerLogic XDMS server, as described in “Connecting to TigerLogic XDMS” on page 887.

2. Click the **New Folder** button on the **Open** dialog box.
Chapter 14  Extending Stylus Studio

Stylus Studio provides several ways to extend its native functionality. This chapter describes features that allow you to specify other XML validation engines, and features that allow you to define and register custom document wizards.

This chapter covers the following topics:
● “Custom XML Validation Engines” on page 894
● “Custom Document Wizards” on page 899
Custom XML Validation Engines

Stylus Studio supports several XML validation engines, including the MSXML4.0 SAX Parser, Xerses-J 2.3.0, and .NET XML. The custom validation engine feature lets you register your own XML validation engine with Stylus Studio. Custom validation engines are added to the Validate Document drop-down list in the XML Editor once you register them with Stylus Studio, as shown in Figure 397.

Output for custom validation engines is displayed in Stylus Studio’s Output Window. Output for other custom applications, such as that created by the custom document wizard, is also displayed in Stylus Studio’s Output Window.

Registering a Custom Validation Engine

The process of registering a custom validation involves the following steps:

1. Make the necessary custom validation engine available to Stylus Studio.

2. Configure the custom validation engine on the Custom Validation Engines page of the Options dialog box. This step involves
   a. Providing a name.
b. Specifying a command line template.

c. Defining any arguments required by the command line.

d. Optionally specifying the initial directory, path, and classpath to be used by the custom validation engine.

e. Optionally setting a feature that prompts the custom validation engine user for arguments when the custom validation engine is run.

More information for each of these steps is provided in the following section, “Configuring a Custom Document Wizard” on page 900.

Configuring a Custom Validation Engine

This section provides information and procedures for configuring a custom validation engine. It covers the following topics:

● The Custom Validation Engines Page on page 895
● How to Configure a Custom Validation Engine on page 898

The Custom Validation Engines Page

You use the Custom Validation Engines page of the Options dialog box to work with custom validation engines in Stylus Studio.

Figure 399. Custom Validation Engines Page
Extending Stylus Studio

How to display

1. In the Stylus Studio menu bar, select Tools > Options.
   The Options dialog box appears.

2. If necessary, expand Application Settings and click Custom Validation Engines.
   The Custom Validation Engines page appears.

About macros

Stylus Studio provides macros for some fields to help speed creation of custom validation engines. Any macro you use to configure the custom validation engine is resolved when it is run.

Available macros vary based on the field for which they are being used. To display macros available for a given field, click . Predefined macros include

- `${FilePath}` – The complete path of the XML file to be validated.
- `${FileDir}` – The directory in which the XML file to be validated is stored.
- `${FileName}` – The name of the XML file to be validated.
- `${FileExt}` – The extension of the XML file to be validated.
- `${ClassPath}` – The Classpath environment variable.
- `${StylusDir}` – The path of the Stylus Studio installation directory.

Name

When you click the New button ( ) to create a new custom validation engine, Stylus Studio displays an entry field for the name.

Figure 400. Specifying a Custom Validation Engine Name

You should replace the default name (Validation Engine 1, for example) with the name you want to associate with the custom validation engine. The name you enter is displayed in the drop-down in the XML Editor.

Custom validation engines are displayed in the Validate Document drop-down list in the order in which they appear here.
Custom XML Validation Engines

1. Selecting the custom validation engine whose order in the list you want to change.

2. Clicking the up or down arrow to the right of the custom validation engine list box as needed.

**Command**

You use the **Command** field to specify the command line used to invoke the custom validation engine. This is typically the path to the `.exe`, `.cmd`, or `.bat` file that starts the application.

**Arguments**

You use the **Arguments** field to specify any arguments required by the custom validation engine. Click ➤ to browse predefined macros.

**Initial Directory**

You use the **Initial directory** field to specify the directory you want Stylus Studio to use as the current directory when the custom validation engine is run. Click ➤ to browse predefined macros.

**Path**

You use the **Path** field to define paths to any files (such as `.exe` and `.dll`) required by the custom validation engine. You do not have to define any paths that are already defined in your `PATH` environment variable. Separate multiple paths with a semicolon. Click ➤ to browse predefined macros.

**Classpath**

You use the **Classpath** field to define paths to any JVM files required by the custom validation engine (such as `.jar` and `.class`). You do not have to define any paths that are already defined in your `PATH` environment variable. Click ➤ to browse predefined macros.
Prompt for arguments

The **Prompt for arguments** feature displays a dialog box when the custom validation engine is run.

![Figure 401. Argument Prompt](image)

The **Arguments** field allows the user to change the command line and arguments configured with the custom validation engine when it was registered with Stylus Studio.

**How to Configure a Custom Validation Engine**

**Before you begin**

Before performing this procedure, you should be familiar with the information in “The Custom Validation Engines Page” on page 895.

1. Display the **Custom Validation Engines** page of the **Options** dialog box. See “How to display” on page 896 if you need help with this step.

2. Click the **New** button and enter a name for the custom validation engine. Remember that this value is displayed in the **Validate Document** drop-down list in the XML Editor.

3. Specify the command line any required arguments. See “**Command**” on page 897 and “**Arguments**” on page 897 if you need help with this step.

4. Optionally, specify an initial directory, path and classpath.

5. Click **Prompt for arguments** if you want Stylus Studio to display a dialog box that allows the user to change the command line or arguments when the custom validation engine is run.

6. Click **OK**.
Custom Document Wizards

Stylus Studio’s *custom document wizard* feature allows you to create and configure document wizards that invoke third-party file conversion and document generation tools, such as Thai Open Source’s Trang. When run, a custom document wizard passes argument values provided by the user (the name of the file to be converted, for example) to the command line that invokes the third-party tool. The third-party tool generates an output file as specified in the custom document wizard’s command line, and the file is then opened by Stylus Studio in the appropriate editor.

Example

An example of a custom document wizard is the DTD to XML Schema (Trang) document wizard shipped with Stylus Studio.

![Figure 402. A Custom Document Wizard](image)

This document wizard was created using the custom document wizard feature.
Registering a Custom Document Wizard

The process of registering a custom document wizard in Stylus Studio involves the following steps:

1. Make the necessary third-party software available to Stylus Studio. For example, any .jar or .exe files associated with the document conversion or generation tool must be accessible from the Stylus Studio installation.

2. Configure the custom document wizard on the Custom Document Wizards page of the Options dialog box. This step involves
   a. Providing a name and, optionally, an icon, for the custom document wizard.
   b. Setting the document type.
   c. Specifying a command line template.
   d. Defining any arguments required by the command line.
   e. Optionally setting a trace feature that displays processing provided by the third-party tool.

More information for each of these steps is provided in the following section, Configuring a Custom Document Wizard on page 900.

Configuring a Custom Document Wizard

This section provides information and procedures for configuring a custom document wizard. It covers the following topics:

- “The Custom Document Wizards Page” on page 901
- “Defining Arguments” on page 905
- “How to Configure a Custom Document Wizard” on page 909
The Custom Document Wizards Page

You use the Custom Document Wizards page of the Options dialog box to work with custom document wizards in Stylus Studio.

How to display

1. In the Stylus Studio menu bar, select Tools > Options. The Options dialog box appears.

About macros

Stylus Studio provides macros for some fields to help speed creation of custom document wizards. Available macros vary based on the field for which they are being used. To display macros available for a given field, click .
Extending Stylus Studio

Predefined macros include

- `${StylusDir}`, which indicates that the path you are specifying is relative to the Stylus Studio installation directory.
- `${PATH}`, which specifies the PATH environment variable.
- `${OutputFile}`, which is used to specify the output generated by the document wizard. This macro is available in the Command field only.

In addition, Stylus Studio creates argument variable macros for any arguments you define and displays them with other Command field macros.

Name

When you click the New button ( ) to create a new custom document wizard, Stylus Studio displays an entry field for the name.

You should replace the default name (DocumentWizard1, for example) with the name you want to associate with the custom document wizard. The name you enter is

- Displayed in the Document Wizards dialog box along with the icon you specify for the custom document wizard.
- Used in the title bar of the dialog box the user sees when running the custom document wizard.
Document type

The Document type field displays a drop-down list of available document types when you click it:

- The Document type is the type of output generated by the custom document wizard (XML Schema, XQuery, and so on). The value you select determines
  - The tab in the Document Wizards dialog box on which the custom document wizard is displayed (XML Editor, XSLT Editor, or Java, for example)
  - The editor Stylus Studio uses to display the output generated by the document wizard

Icon bitmap

You use the Icon bitmap field to specify the path for the icon you want to represent the custom document wizard. This icon, along with the name you give the custom document wizard, is displayed in the Document Wizards dialog box. Click  to browse for the file you want to specify or to insert the ${StylusDir} macro.

If you leave the Icon bitmap field blank, Stylus Studio uses the following default icon for the custom document wizard:

Command line

You use the Command line field to specify a command line template. Stylus Studio uses this template to compose the command line that invokes the custom document wizard. Variables, such as ${InputFile}, are used in place of actual arguments. Users specify argument values when they run the custom document wizard.

Consider the following example:

```java
java -cp my.jar com.exln.stylus.Import ${QuoteChar} ${InputFile} ${OutputFile}
```

This command line template allows Stylus Studio to start the specified Java class with a command line that includes the QuoteChar, InputFile, and OutputFile arguments.
Argument variables can appear anywhere in the command. They must be in the form \${name}. For example:

\${InputFile}
\${OutputFile}
\${LoggingOption}
\${SomeArgument}

You must specify the \${OutputFile} argument variable in every command line template. Stylus Studio always generates the name of the file it opens as the value for the \${OutputFile} argument variable.

As with the icon bitmap field, you can click \(\rightarrow\) to display a menu that provides shortcuts that help you specify the command line template. This menu lets you:

- Display the Custom Document Wizard Arguments dialog box, in which you can specify the command line arguments and their properties. See “Defining Arguments” on page 905 for more information.
- Browse for and select a file you want to specify.
- Insert the \${StylusDir} macro.
- Insert argument variable macros for arguments you have already defined.

Initial directory

You use the Initial directory field to specify the directory you want Stylus Studio to use as the current directory when the custom document wizard is run. Click \(\rightarrow\) to browse for the file you want to specify or to insert the \${StylusDir} macro.

Path

You use the Path field to define paths to any files required by the custom document wizard. You do not have to define any paths that are already defined in your PATH environment variable. Separate multiple paths with a semicolon.

Click \(\rightarrow\) to display a menu that provides shortcuts that help you specify the PATH field. From this menu you can:

- Browse for and select a file you want to specify.
- Insert the \${StylusDir} macro.
- Insert the \${PATH} macro.
Trace execution

If the custom document wizard you are configuring outputs processing information (error messages, stack traces, and so on), you can use the Trace execution feature to display this information in the Output Window of the Stylus Studio editor used to display the custom document wizard’s generated document.

Defining Arguments

You must define any arguments required by the custom document wizard using the Custom Document Wizard Arguments dialog box.

Stylus Studio uses the arguments you define here to
- Compose the dialog box used to run the custom document wizard. That dialog box enables users to provide values for the arguments you define.
- Create argument variable macros, which you can then use to compose the command line template. Stylus Studio displays the argument variable macro it creates in the Command field menu.

Note Every variable used in the command line template must be defined in the Custom Document Wizard Arguments dialog box.

How to display

There are two ways to display the Custom Document Wizard Arguments dialog box:
- Click the Arguments button on the Custom Document Wizard page. Use this procedure if you want to define arguments before composing the command line template.
- Select Edit Arguments from the Command field menu that is displayed when you click . You can use this procedure if you want to define arguments while composing the command line.
OutputFile argument

Stylus Studio creates an OutputFile argument for each custom document wizard. You cannot delete this argument. You can change its order, if necessary, as described in the following section.

Argument order

By default, the arguments you define in the Custom Document Wizard Arguments dialog box are displayed to users in the order in which they are created. Arguments are displayed in a simple two-column grid, with the argument description in the first column, and an entry field for the argument value in the other. (See “Example” on page 899 for an illustration of a custom document wizard dialog box.)

Also by default, the OutputFile argument appears first.

1. Selecting the argument whose order you want to change.
2. Clicking the up or down arrow to the right of the argument list box as needed.

Note Whether or not the argument order defined here has to match the argument order in the command line template will vary from one custom document wizard to the next – arguments for some applications can be order independent, for example. Generally speaking, it is good practice for the argument order in the Custom Document Wizard Arguments dialog box to match that in the command line template.

Argument attributes

You can specify the following attributes for each argument you define:

- Name. Stylus Studio uses the value you enter in the Name field to compose the argument variable macro. This name is not displayed to custom document wizard users. Required.

- Description. The value you enter in the Description field appears in the custom document wizard dialog box that is displayed to users when they run the wizard. The description should provide users with adequate information about the argument’s expected value. It can be useful to distinguish input and output arguments, for example. Required.

- Flag. The flag associated with the argument (–v, or simply - or /, for example). When Stylus Studio composes the command line for the custom document wizard, it uses the flag value as a prefix to the argument value supplied by the user.

Note The Flag field must be specified for Boolean arguments.
Custom Document Wizards

- **Type.** The argument’s data type. Table 81 summarizes valid values for the **Type** field and describes possible values for those types.

**Table 81. Type Field Values**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>The value for a Boolean argument must be <code>true</code> or <code>false</code>. If the value is <code>true</code>, Stylus Studio inserts the value of the associated <strong>Flag</strong> attribute in the command line. No value other than the <strong>Flag</strong> value appears in the command line. If the value is <code>false</code>, the associated <strong>Flag</strong> value does not appear in the command line. If you set <strong>Type</strong> to <strong>boolean</strong>, you must specify the argument’s <strong>Flag</strong> attribute.</td>
</tr>
<tr>
<td>InputFile</td>
<td>The value for an InputFile argument is a URL that the custom document wizard user enters or selects by clicking the <strong>Browse</strong> button. If the format of the URL is for a protocol other than the file protocol, Stylus Studio copies the file into a temporary local file and uses the name of the temporary local file in the command line. You can specify multiple arguments whose data type is <strong>InputFile</strong>.</td>
</tr>
<tr>
<td>OutputFile</td>
<td>The custom document wizard user does not specify a value for the <strong>OutputFile</strong> argument. Exactly one argument must be of the <strong>OutputFile</strong> type. Stylus Studio generates a value for the <strong>OutputFile</strong> argument and inserts it in the command line.</td>
</tr>
<tr>
<td>string</td>
<td>The value for a string argument can be anything specified by the custom document wizard user. Stylus Studio encloses the string values in quotation marks when composing the command line.</td>
</tr>
</tbody>
</table>

- **Default Value.** The value used by Stylus Studio for optional arguments, unless another value is specified by the user when the custom document wizard is run. Default values for required arguments are ignored – Stylus Studio requires users to enter values for required arguments.

- **Optional.** Whether or not the argument is optional. Valid values for this field are `true` or `false`. 
How to define an argument

1. Display the Custom Document Wizard Arguments dialog box. See “How to display” on page 905 if you need help with this step.

2. Click the New button ( ).
   A new argument is displayed in the Custom Document Wizard Arguments dialog box, with a default name and other default values.

3. Complete the argument attributes as described in earlier in this section. Remember that Description values appear in the custom document wizard dialog box when the user runs the wizard.

4. To define another argument, click the New button again.

5. If necessary, use the Up and Down arrows to change the argument order. Remember that the order in which arguments are displayed here is the order in which they appear in the custom document wizard dialog box when the user runs the wizard.

6. Click OK.
**Custom Document Wizards**

**How to Configure a Custom Document Wizard**

Before performing this procedure, you should be familiar with the information in “The Custom Document Wizards Page” on page 901 and “Defining Arguments” on page 905.

1. Display the **Custom Document Wizards** page of the **Options** dialog box. See “How to display” on page 901 if you need help with this step.

2. Click the **New** button and enter a name for the custom document wizard. Remember that this value is used as the title for the dialog box displayed to the user when they run the wizard, as well as for the label associated with the custom document wizard icon displayed in the **Document Wizards** dialog box.

3. Click the **Arguments** button and define the wizard’s arguments on the **Custom Document Wizard Arguments** dialog box. See “Defining Arguments” on page 905 if you need help with this step.

4. Select the custom document wizard’s document type.

5. Specify the command line template. See “Command line” on page 903 if you need help with this step.

6. Optionally, specify an initial directory and path.

7. Click **Trace execution** if you want to display processing information generated by the custom document wizard in the **Output Window** of the Stylus Studio editor window associated with the custom document wizard’s **Document type**.

8. Click **OK**.
Chapter 15  The Stylus Studio Java API

Stylus Studio XML Enterprise Edition includes a library of Java packages that provide programmatic bi-directional access to numerous data sources such as EDI, CSV, and relational as XML. These same Java packages are available separately as part of Stylus Studio XML Deployment Components, for those wishing to deploy applications developed with the Stylus Studio Java API.

This chapter provides an overview of the Stylus Studio Java API and describes the demonstration application that is installed with Stylus Studio. It also provides additional information on deploying applications you develop with the Java API.

The Stylus Studio Java API is available only in Stylus Studio XML Enterprise Edition.

This chapter covers the following topics:

- “Java API Overview” on page 911
- “Invoking an Adapter Programmatically” on page 917
- “Deploying Applications” on page 928
- “Custom File Systems” on page 929
- “Adapter Properties” on page 934

Java API Overview

The Stylus Studio Java API consists of several packages of Java libraries that you can use to build Java applications that access non-XML data, convert that data to XML, and then manipulate it (with XQuery or XSLT, for example). The Stylus Studio Java API exploits
Stylus Studio’s custom URL schemes and URI resolver to provide database connectivity and bi-directional XML-to-non-XML data conversion.

This section covers the following topics:
- “Data Access” on page 912
- “Package Summary” on page 913
- “Stylus Studio URL Schemes” on page 916

Data Access

The Stylus Studio Java API provides access to non-XML data stored as flat files (EDI, CSV, RTF, and others) and on relational databases (SQL Server, Oracle, and others), and to XML data available via Web services and stored in Sleepycat Software’s Berkeley DB XML database. Figure 408 illustrates the different ways you can use the Stylus Studio Java API to access XML and non-XML data from Java applications or from XQuery or XSLT code.

Figure 408. Accessing Data Sources with the Stylus Studio Java API

All data access relies on the Stylus Studio custom URL schemes – you use Stylus Studio’s adapter: URL scheme to access non-XML data stored as a flat file (EDI, CSV, and others). Other Stylus Studio URL schemes (db:, ws:, and others) are used to access XML and non-XML data stored on relational databases and provided by Web services. The
classes in the com.stylusstudio.converter package were designed to work with the
adapter: URL scheme. If you are using any of the other Stylus Studio URL schemes, you
simply need to register the Stylus Studio URI resolver in your Java code. Note that Stylus
Studio generates this code automatically when you generate Java code for XSLT and
XQuery using certain processors, such as the Stylus Studio built-in processor, the
DataDirect XQuery processor, and processors from Saxon and Xalan.

See “Stylus Studio URL Schemes” on page 916 to learn more about custom URL
schemes in Stylus Studio.

Package Summary

This section provides a brief description of these Stylus Studio Java API packages:

- com.stylusstudio.converter on page 913
- com.exln.stylus.io on page 914
- com.stylusstudio.version on page 915

Javadoc for the Stylus Studio Java API

Javadoc for the Stylus Studio Java API is installed with Stylus Studio. It is available in the
Stylus Studio /doc/Javadoc directory. Open index.html to get started. The Javadoc is also

com.stylusstudio.converter

You use the classes and interfaces in the com.stylusstudio.converter package to access
EDI, CSV, and other flat-file data sources from a Java application using the Stylus Studio
adapter: URL scheme.

Table 82. com.exln.stylus.io Package Classes

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Public class used to specify user-settable policies for a Configuration object. These policies govern certain aspects of the conversion process, such as memory and buffer settings.</td>
</tr>
<tr>
<td>ConverterFactory</td>
<td>Public class used to create new Converter objects. Converter objects are used to convert files to and from XML.</td>
</tr>
</tbody>
</table>
### Table 82. com.exln.stylus.io Package Classes

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputStreamResult</td>
<td>Public class used to specify that the user of Converter wants to read the result of the conversion with a InputStream.</td>
</tr>
<tr>
<td>OutputResult</td>
<td>Public class used to specify that the user of Converter wants the Converter to write its output to a Writer provided by the caller, or wants the Converter to write its output to a OutputStream provided by the caller using a specified byte encoding.</td>
</tr>
<tr>
<td>OutputStreamSource</td>
<td>Public class used to specify that the user of Converter wants to provide the source data for the conversion by writing it to a OutputStream.</td>
</tr>
<tr>
<td>ReaderResult</td>
<td>Public class used to specify that the user of Converter wants to read the result of the conversion with a Reader.</td>
</tr>
<tr>
<td>WriterSource</td>
<td>Public class used to specify that the user of Converter wants to provide the source data for the conversion by writing it to a Writer.</td>
</tr>
<tr>
<td>Conversion</td>
<td>Public interface that controls the conversion process. The application can query the status of the conversion, report errors, cancel the conversion, or finish it.</td>
</tr>
<tr>
<td>Converter</td>
<td>Public interface performs the conversion of XML to non-XML, and vice versa.</td>
</tr>
<tr>
<td>SAXConversion</td>
<td>Public interface that controls the conversion process for SAXSource objects. The application can query the status of the conversion, report errors, cancel the conversion, or finish it. SAXConversion is an extension of Conversion.</td>
</tr>
</tbody>
</table>

### com.exln.stylus.io

You use the classes and interfaces in the `com.exln.stylus.io` package to access non-XML data sources from XQuery or XSLT using one of several built-in URL schemes (ws:, db:, dbxml:, and xquery:). You can also register your own scheme to access a custom file system built with the classes in this package.
Java API Overview

Though you can also use classes in the `com.exln.stylus.io` package to access EDI, CSV, and other flat file data sources in a Java application, the classes Stylus Studio `com.stylusstudio.converter` package are preferred for this purpose.

**Table 83. com.exln.stylus.io Package Classes**

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StylusFileFactory</td>
<td>Public final class that defines a factory API that enables applications to read and write data streams using any file system that implements the StylusFile interface.</td>
</tr>
<tr>
<td>StylusFileHelpers</td>
<td>Public class of static helpers for use with StylusFile and StylusFileSystem interfaces and the StylusFile class.</td>
</tr>
<tr>
<td>StylusFile</td>
<td>Public interface that provides an abstract representation of a file in a custom file system.</td>
</tr>
<tr>
<td>StylusFileSystem</td>
<td>Public interface that represents a custom file system, enabling you to connect to and browse files on that file system.</td>
</tr>
<tr>
<td>StylusFileSystemOptions</td>
<td>Public interface that provides optional methods.</td>
</tr>
</tbody>
</table>

**com.stylusstudio.version**

`com.stylusstudio.version` is a simple package, consisting of a single class, Version, that enables you to get the current build number the installed Stylus Studio product. Version numbers of both Stylus Studio 2006 XML Enterprise Edition and the Stylus Studio Java API will be the same.

**Table 84. com.stylusstudio.version Package Classes**

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>A class containing version identification information. Includes methods that get the software build number and product name, and that write that information to System.out</td>
</tr>
</tbody>
</table>
Stylus Studio URL Schemes

In Java, files and other data resources are referenced to using URL schemes. The Java URI resolver is capable of resolving file:, http:, ftp:, and a limited set of other URL schemes – http:www.stylusstudio.com/buy, for example.

The Stylus Studio API has extended the functionality of the basic Java URI resolver so that it recognizes and understands URL schemes developed by Stylus Studio. You can use any of the following URL schemes in your Java, XQuery, and XSLT code:

- **adapter:** – Used to specify a Stylus Studio built-in adapter or user-defined converter. For example, adapter:myConverter.conv would invoke the user-defined myConverter.conv file, created with the Convert to XML module. adapter:EDI?file://m:\testing\editeur.edi would invoke Stylus Studio’s built-in EDI adapter, using the file specified as the EDI source to be converted. See “Overview of Convert to XML” for more information on built-in adapters and user-defined converters.

- **db:** – Used to specify a Stylus Studio DB-to-XML data source (.rdbxml). A DB-to-XML data source contains database connectivity information, as well as the identity of the database object you want converted to XML (expressed in SQL or SQL/XML). For example, db:m:\testing\myDataSource.rdbxml. See “Overview of DB-to-XML Data Sources” for more information about DB-to-XML data sources.

- **dbxml:** – Used to connect to Berkeley DB XML and access an XML file in the container you specify. For example, dbxml:///m:myNewContainer.dbxml/myData.xml. See “Using Stylus Studio with Berkeley DB XML” for more information.

- **ws:** – Used to specify a Web service call composition (.wscc), which invokes a Web service that returns XML. For example, ws:m:\testing\myWebServiceCall.wscc. See “Composing Web Service Calls” for more information about working with Web services in Stylus Studio.

- **xquery:** – Used to specify a relational data source defined in the Stylus Studio File Explorer window. (Relational data source defined this way use XQuery to obtain the data.) For example: xquery:///jdbc:xquery:sqlserver://myServer:1433;user=sa;xmlforest=true;urlltype=.xml. See “Creating a Database Connection from the File Explorer” for more information.
Invoking an Adapter Programmatically

The Stylus Studio Java API allows you to access and convert non-XML files to XML, and vice versa. Adapters can be invoked programmatically, in an XQuery application, for example, allowing you to treat non-XML data as XML, manipulate it as needed, and, optionally, write it back to its source in its original format.

Stylus Studio provides adapters for over one dozen common file formats (binary, comma- and tab-separated values, EDI, and others).

This section provides background information on using Stylus Studio adapters in your applications, and it describes demo.bat, a simple Java program installed with Stylus Studio.

This section covers the following topics:
- “The adapter: URL Scheme” on page 917
- “Constructing Your Own Adapter URL” on page 920
- “Example – demo.java” on page 922

The adapter: URL Scheme

Stylus Studio uses URLs extensively to reach a variety of data sources. For example, if you use the built-in CSV adapter to open the three.txt file in the \examples\Adapters directory as an XML document, Stylus Studio builds the following URL:


The instructions to the adapter engine from this instance of the adapter URL are described in Table 85.

Table 85. Parts of an Adapter URL

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Adapter URL String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Comma-Separated Values adapter</td>
<td>adapter:csv</td>
</tr>
<tr>
<td>The line separator in the source file is a carriage return/line feed</td>
<td>newline=crlf</td>
</tr>
<tr>
<td>The column separator in the source file is a comma</td>
<td>sep=,</td>
</tr>
<tr>
<td>The values in the first row of the source file should be used to supply field names</td>
<td>first=yes</td>
</tr>
</tbody>
</table>
While the basic format of the adapter URL is the same from one adapter to another, there are differences. For example:

- Built-in adapters have different properties. You should always use Stylus Studio to build your adapter URLs to be sure that it uses valid properties and values. See “Constructing Your Own Adapter URL” on page 920 for more information. For a complete description of properties for all adapters, see “Adapter Properties” on page 934.

- The adapter: URL scheme can also be used to reference a user-defined converter (a .conv file). In this case, the adapter URL specifies only the location of the .conv file; the converter itself contains information about its property settings. An adapter URL that references a user-defined converter might look like this:

  adapter:///myConverter.conv?file://inventory.txt

  This adapter uses myConverter.conv to convert the file inventory.txt to some format (specified in the converter when you built it).

- Property names in adapter URLs use an internal (generally, abbreviated) format, different from what is displayed in properties list in the Select XML Converter dialog box. Again, to avoid errors in your applications, use Stylus Studio to build your adapter URLs.

### Adapter URL Syntax

While properties differ from one adapter to the next, the syntax used to invoke them is the same:

```
adapter:name:[property_name=value: | property_name=value: | ...]?file://URL
```

Example:

```
adapter:Base64:newline=crlf:encoding=utf-8?file://w:\myfiles\base_to_xml.bin
```
Invoking an Adapter Programmatically

In this example:

- The name of the adapter is Base-64
- Properties are newline and encoding
- The file being converted is base_to_xml.bin on w:\myfiles

Where Adapter URLs are Displayed in Stylus Studio

Adapter URLs are displayed

- In the Project window (select Show Full URL from the Project window shortcut menu)

![Figure 409. Adapter URL Displayed in Project Window](image)

- In the URL field of the Select XML Converter dialog box, as shown in Figure 410.

![Figure 410. Adapter URL Displayed in the Select XML Converter Dialog Box](image)
You can use either source for the adapter URL strings in your Java applications. See “Constructing Your Own Adapter URL” on page 920 for more information.

## Constructing Your Own Adapter URL

Generally speaking, you should use Stylus Studio to construct the adapter URLs you use in Java application. Adapter URLs can be complex – properties and their values vary from one adapter to another, for example – and long, so using Stylus Studio to construct them can reduce errors in your applications.

### Tip

Adapter URLs in the Select XML Converter dialog box are already escaped and can be used as-is. Adapter URLs taken from the Project window must be escaped manually when you paste them into your application.

## Using the URL in the Select XML Converter Dialog Box

1. Use the adapter to open a file as an XML document in Stylus Studio. This can be a user-defined or built-in adapter, as appropriate. See “How to Open a File Using an Adapter” if you need help with this step.

2. Before clicking OK to complete the conversion, copy the adapter URL in the URL field of the Select XML Converter dialog box (see Figure 410).

3. Click OK to complete the conversion. (You can click Cancel if you are performing this procedure just to obtain the adapter URL.)

4. Paste the adapter URL into your Java program.

## Using the URL in the Properties Window

1. Use the adapter to open a file as an XML document in Stylus Studio. This can be a user-defined or built-in adapter, as appropriate. See “How to Open a File Using an Adapter” if you need help with this step.

### Tip

New documents are placed in the Other Documents folder in the Project window by default.

2. Open a new document in any Stylus Studio text editor (for example, File > New > Java: Text Editor).

   The purpose of this step is to provide an editor into which you can drag-and-drop the document you created in Step 1 in order to display the associated adapter URL.
3. Drag the document you created in Step 1 from the Project window and drop it into the text editor you opened in Step 2. The complete URL appears in the text editor.

4. Copy the complete adapter URL.
5. Paste the adapter URL into your Java program.
6. Escape characters as required for strings in Java programs. For example, `escape=\:quotes='"` becomes `escape=\:quotes='"` (the single quote does not need to be escaped).
The example file, demo.java, runs five sample demonstrations that show how the Stylus Studio Java API can be used to convert data to and from XML stored in a number of different formats using both built-in adapters and user-defined converters. This section describes the files associated with the demonstrations and how to run it. It also describes the code samples used for each of the sample demonstrations.

Demonstration Files

The files required to run the demonstrations are summarized in Table 86. All but one, three.conv, are installed in the \examples\Adapters directory where you installed Stylus Studio. The three.conv file is installed in your Stylus Studio \Adapter directory.

Table 86. Stylus Studio Java API Demonstration Files

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>demo.bat</td>
<td>The demonstration driver batch file.</td>
</tr>
<tr>
<td>demo.java</td>
<td>The source for the demonstration; this file contains the usage comments.</td>
</tr>
<tr>
<td>demo.sh</td>
<td>The demonstration driver file for Unix</td>
</tr>
<tr>
<td>one.csv</td>
<td>The input file for the first demonstration run by demo.bat.</td>
</tr>
<tr>
<td>two.xml</td>
<td>The input file for the second demonstration run by demo.bat.</td>
</tr>
<tr>
<td>three.conv</td>
<td>The adapter definition for the third demonstration run by demo.bat. (This file is installed in your Stylus Studio \Adapter directory.)</td>
</tr>
<tr>
<td>three.txt</td>
<td>The input file for the third demonstration run by demo.bat.</td>
</tr>
</tbody>
</table>

Running demo.java

1. Open a console window.
2. Change to the examples\Adapters directory where you installed Stylus Studio.
3. Run demo.bat (or demo.sh, if you installed the Stylus Studio XML Deployment Components on a Unix machine).
Invoking an Adapter Programmatical

Required Classes

In addition to standard Java classes like `java.io.FileOutputStream` and `javax.xml.transform.Transformer`, the demo.java application includes several classes from the Stylus Studio Java API.

```java
import com.exln.stylus.io.StylusFileFactory;
import com.stylusstudio.converter.Converter;
import com.stylusstudio.converter.Conversion;
import com.stylusstudio.converter.ConverterException;
import com.stylusstudio.converter.ConverterFactory;
```

The `com.exln.stylus.io.StylusFileFactory` class allows the application to use the `StylusFileFactory.unlockAPI()` method. This method, which provides access to the Stylus Studio Java API, takes as its parameter the Stylus Studio installation ID. If you are developing applications that you plan to deploy on one or more servers, you must use the installation ID associated with your copy of the Stylus Studio XML Deployment Components. Otherwise, you can use the Stylus Studio 2006 XML Enterprise Edition installation ID.

Setting the Installation Directory

The `STYLUS_DIR` variable is set automatically during the Stylus Studio installation. This variable is used to define `exampleDir`, which is to specify the location of the source files used by the demo.java sample demonstration.

```java
String exampleDir = System.getProperty("com.stylusstudio.exampledir");
if (exampleDir == null) {
    if (new File("./one.csv").exists())
        exampleDir = System.getProperty("user.dir");
    else exampleDir = STYLUS_DIR + File.separator + "examples" +
                    File.separator + "Adapters";
} exampleDir += File.separator;
String uriBase = "file:" + exampleDir.replace('\\', '/')
```

You can also specify the Stylus Studio installation directory manually, using the `-D` argument at the command line, like this: `-Dcom.stylusstudio.exampledir=c:\myStylus\`.

Example 1

Example 1 converts a comma-separated values (CSV) file, `one.csv`, to an XML file, `one.xml`, using Stylus Studio’s built-in CSV adapter. The conversion parameter for the new Converter object is specified as a Stylus Studio adapter: URL that indicates which
The Stylus Studio Java API

built-in adapter to use to convert the input file to the output file. Only two CSV adapter settings are shown; default values are used for all settings unless you specify them in the adapter: URL.

    ConverterFactory factory = ConverterFactory.newInstance();
    StreamSource input = new StreamSource(exampleDir + "one.csv");
    StreamResult output = new StreamResult(exampleDir + "one.xml");
    Converter toXML = factory.newConvertToXML("adapter:CSV:sep=,:first=yes");
    toXML.convert(input, output);
    System.out.println("test 1 finished: one.csv -> one.xml");

Both input and output streams are opened and closed by the Converter object.

Example 2

Example 2 is similar to Example 1, but instead of converting a non-XML file to XML, it does the opposite. It also shows how to use the Stylus Studio URI resolver to create both the input stream (`sff.resolve("two.xml", uriBase)`) and output stream (`sff.outputStreamResolver("two.csv", uriBase)`).

    StylusFileFactory sff = StylusFileFactory.getFactory();
    input = (StreamSource) sff.resolve("two.xml", uriBase);
    if (input==null)
        throw new IOException("Unable to find 'two.xml' in " + uriBase);
    output = (StreamResult) sff.outputStreamResolver("two.csv", uriBase);
    if (output==null)
        throw new IOException("Unable to create 'two.csv' in " + uriBase);
    Converter fromXML = factory.newConvertFromXML("adapter:CSV:sep=,:first=yes");
    fromXML.convert(input, output);

In this example, since we opened the input and output streams, we must also close them.

    input.getInputStream().close();
    output.getOutputStream().close();
    System.out.println("test 2 finished: two.xml -> two.csv");

Example 3

Example 3 uses a user-defined converter, `three.conv`, built using the Stylus Studio Convert to XML module, to convert a fixed-width file, `three.txt`, to XML. Here, we
Invoking an Adapter Programmatically

create our own StreamSource and StreamResult objects – because we are converting a local text file, there is no need to use the Stylus Studio URI Resolver.

```java
InputStream is = new FileInputStream(exampleDir + "three.txt");
OutputStream os = new FileOutputStream(exampleDir + "three.xml");
input = new StreamSource(is);
output = new StreamResult(os);
toXML = factory.newConvertToXML("adapter:three.conv");
toXML.convert(input, output);
is.close();
os.close();
System.out.println("test 3 finished: three.txt -> three.xml");
```

Example 4

Examples 1, 2, and 3 performed simple conversion of one file type to another – some type of converter (either a Stylus Studio built-in adapter or a user-defined converter) was given an input and converted it to another format.

Example 4 generates conversion output (in this case, a CSV file, one.csv, converted to XML using the Stylus Studio built-in adapter) as SAX events. These SAX events are then sent to the transformer’s ContentHandler. The process is illustrated in Figure 412.

![Diagram](image)

**Figure 412. Post-Conversion XSLT Processing**
Here is the code for Example 4:

```java
TransformerFactory tFactory = TransformerFactory.newInstance();
if (!(tFactory instanceof SAXTransformerFactory)) {
    System.out.println("Unable to run example 4");
    System.out.println(tFactory.getClass().getName() + " is not a SAXTransformerFactory");
} else {
    SAXTransformerFactory saxFactory = (SAXTransformerFactory)tFactory;

    is = new FileInputStream(exampleDir + "one.csv");
    input = new StreamSource(is);

    os = new FileOutputStream(exampleDir + "four.xml");
    StreamResult finalResult = new StreamResult(os);

    TransformerHandler handler = saxFactory.newTransformerHandler();
    handler.setResult(finalResult);
    SAXResult intermediateResult = new SAXResult(handler);

    toXML = factory.newConvertToXML("adapter://CSV:sep=,:first=yes");
    toXML.convert(input, intermediateResult);

    is.close();
    os.close();

    System.out.println("test 4 finished: one.csv -> four.xml");
}
```

The `finalResult` is an XML document, `four.xml`. In this example, we used a null transformer (`TransformerHandler handler = saxFactory.newTransformerHandler();`), but you could specify any XSLT transformation here (`.newTransformerHandler(new StreamSource(...))`, for example) to perform any processing on the intermediate result you required.
Example 5

In Example 5, output from an XSLT transformation is sent to a converter, which takes the XML it is given (as a saxSource) and converts it to CSV. This process is summarized in Figure 413.

Here is the code for Example 5:

```java
is = new FileInputStream(exampleDir + "two.xml");
input = new StreamSource(is);

os = new FileOutputStream(exampleDir + "five.csv");
finalResult = new StreamResult(os);

SAXSource saxSource = new SAXSource();
Conversion conversion = fromXML.convert(saxSource, finalResult);

Transformer transformer = tFactory.newTransformer();
SAXResult intermediateResult = new SAXResult((ContentHandler)conversion);
transformer.setErrorListener((ErrorListener)conversion);
transformer.transform(input, intermediateResult);

is.close();
os.close();
System.out.println("test 5 finished: two.xml -> five.csv");
```

As with Example 4, no XSLT transformation instructions were specified (newTransformer()); you can specify any XSLT transformation you require. To convert the transformation’s output to CSV, we have reused an instance of the fromXML object, which we created in Example 2. This object uses the built-in Stylus Studio CSV adapter.
Deploying Applications

You can develop applications using the Stylus Studio Java API that is installed with Stylus Studio 2006 XML Enterprise Edition. If you want to deploy those applications to other servers, you must purchase the Stylus Studio XML Deployment Components.

This section describes the process of deploying applications using Stylus Studio XML Deployment Components. For information about purchasing and licensing Stylus Studio XML Deployment Components, write Stylus Studio at stylusstudio@stylusstudio.com, or call 781.280.4488.

Watch it! You can view a video demonstration of this feature by clicking the television icon or by clicking this link: watch a video on deploying applications.

This section covers the following topics:

- “Stylus Studio XML Deployment Components” on page 928
- “Unlocking the API” on page 928
- “Setting Up the Deployment Environment” on page 929

Stylus Studio XML Deployment Components

The Stylus Studio XML Deployment Components consist of the same Java library as the Stylus Studio Java API, but it can be installed separately and is governed by a separate license. You can use this API completely independently of Stylus Studio 2006 XML Enterprise Edition, or you might choose to use Stylus Studio 2006 XML Enterprise Edition to generate Java code for your XQuery or XSLT applications automatically. The Java code generator uses the Java API to provide programmatic access to XQuery and XSLT applications.

Unlocking the API

In order to deploy an application developed using Stylus Studio XML Deployment Components, you need to unlock the Stylus Studio Java API. You do this by specifying your Stylus Studio XML Deployment Components installation ID as the parameter for the StylusFileFactory.unlockAPI() method.
Custom File Systems

Setting Up the Deployment Environment

In order to deploy an application, you need to install the Stylus Studio XML Deployment Components in your deployment environment – this might be a Linux virtual machine you have installed on your desktop, or a completely separate machine. Steps required to set up the deployment environment include:

1. Install the Stylus Studio XML Deployment Components on the deployment machine.
2. Copy or move application files to that machine. These might include
   - Source files (EDI or CSV, for example)
   - The XQuery or XSLT application developed in Stylus Studio (the my.xquery or my.xsl, for example)
   - The Java code generated by Stylus Studio for that application (my.java, for example)
3. Modify the deployment machine’s classpath to include the location of the CustomFileSystem.jar file. (By default, this is written to the /bin directory where you installed the Stylus Studio XML Deployment Components.)
4. Edit the paths specified for the bindir, rootdir, and appdata parameters in the setProp() methods in the generated Java code to point to the appropriate location on the deployment machine.
5. Edit the paths specified in the m_scriptSource.setFile() and m_xmlSource.setFile() parameters to point to the XQuery or XSLT application and source file location on the deployment machine.
6. Compile the Java code.

Custom File Systems

A file system is view that represents information as a series of files in at least one folder or directory. An individual file within that file system – such as an XML document, an XQuery program, or a DTD – can contain any text or binary information.

A custom file system is a way to extend the file/folder metaphor beyond traditional disk-based files (accessed with the file: scheme), and even beyond web-based files (WebDAV’s http: and https:, and the ftp: scheme of the file transfer protocol) for example. Stylus Studio supports several standard and custom file systems, including Windows, WebDAV, and FTP.
These file systems are referred to as “custom” because, although some are packaged with Stylus Studio, you can create your own. For example, you could create an LDAP custom file system to query an LDAP directory as if it were a file system.

There is a Java API that allows you to access the custom file interface in Stylus Studio.

**Tip**
The Stylus Studio interface to Sleepycat Software’s Berkeley DB XML was implemented using the File System Java API to create a custom file system.

### Creating a Custom File System

The process of creating a custom file system in Stylus Studio involves two main steps:

1. Use the Stylus Studio File System Java API to create the Java wrapper class for your data source. See “File System Interfaces” on page 931 for more information on this step.

2. Register the finished custom file system with Stylus Studio, to make it available through the Stylus Studio **Open**, **Save**, and **Save As** dialog boxes, as shown in Figure 414. See “Registering a Custom File System” on page 931 for more information on this step.

![Figure 414. Custom File System Registered with Stylus Studio](image)
Custom File Systems

File System Interfaces

The Stylus Studio file system interfaces are packaged in CustomFileSystem.jar, in the Stylus Studio \bin directory. To define a custom file system, you implement these interfaces:

- com.exln.stylus.io.StylusFile
- com.exln.stylus.io.StylusFileSystem

Once you have implemented the interfaces, compile them into your own .jar file (myCustomFileSystem.jar, for example), and register the custom file system with Stylus Studio.

Examples

Implementation examples of the StylusFileSystem and StylusFile interfaces, JavaFileSystem.java and JavaFile.java, are included in the \examples\CustomFileSystem directory where you installed Stylus Studio.

Registering a Custom File System

This section assumes you have already implemented the custom file system interfaces, compiled, and created a .jar file (myFileSystem.jar, for example.). You cannot complete the registration process unless the custom file system has been created.

This section covers the following topics:

- “The Custom File Systems Page” on page 932
- “How to Display” on page 933
- “Fields” on page 933
- “How to Register a Custom File System” on page 934
The Custom File Systems Page

You use the Custom File Systems page of the Options dialog box to register a custom file system.

Figure 415. Options Dialog Box for Custom File Systems
How to Display

1. In the Stylus Studio menu bar, select **Tools > Options**.
   The **Options** dialog box appears.

2. If necessary, expand **Application Settings** and click **Custom File Systems**.
   The **Custom File Systems** page appears.

Fields

The **Custom File Systems** page of the **Options** dialog box has the following fields which you need to specify values for in order to register your custom file system.

**Name**

When you click the **New** button ( ) to create a new custom file system, Stylus Studio displays an entry field for the name.

![Figure 416. Naming a New Custom File System](image)

You should replace the default name (**FileSystem1**, for example) with the name you want to associate with the custom file system. The name you enter is displayed in Stylus Studio **Open**, **Save**, and **Save As** dialog boxes.

**Classpath**

You use the **Classpath** field to specify the required classpath for the custom file system.

**Class name**

You use the **Class name** field to specify the name of the custom file system class created using the Stylus Studio custom file system Java API. If you use the **Browse** button, Stylus Studio filters the files displayed in the **Java Class Browser** dialog box to show only those classes that implement the **CustomFileSystem.jar** interfaces.
The Stylus Studio Java API

**Icon bitmap**

You use the Icon bitmap field to specify the icon to associate with the custom file system. This icon appears in the Open, Save, and Save As dialog boxes. If the Icon bitmap field is left empty, Stylus Studio uses a default icon ( ).

**How to Register a Custom File System**

1. Display the Custom File Systems page of the Options dialog box. See “How to Display” on page 933 if you need help with this step.

2. Click the New button and enter a name for the custom file system. Remember that this value appears in the Open, Save, and Save As dialog boxes along with the icon you select.

3. Specify the classpath and class name.

4. Optionally, specify the icon you want to use to represent the custom file system.

5. Click OK.

**Adapter Properties**

Adapters for different file types have different properties – the CSV adapter allows you to specify an escape character, but the binary adapter does not, for example. This section describes values for the line separator property, which is shared across most adapters, and it describes the properties for individual adapters.

- “Line Separator Values” on page 935
- “Base-64 Adapter Properties” on page 935
- “Comma-Separated and Tab-Separated Values Adapter Properties” on page 936
- “dBase Adapter Properties” on page 937
- “DIF, SDI, SLK Adapter Properties” on page 938
- “EDI Adapter Properties” on page 939
- “Binary Adapter Properties” on page 943
- “HtmlTidy Adapter Properties” on page 944
- “Whole-line Text Adapter Properties” on page 945
- “Properties for Other Adapters” on page 946
Line Separator Values

Most adapters allow you to specify some type of line separator (referred to in the adapter URL as newline). The following table summarizes commonly occurring values. All values are case-insensitive.

Table 87. Common Values for the Line Separator (newline) Property

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cr or mac</td>
<td>The Macintosh standard.</td>
</tr>
<tr>
<td>lf or unix</td>
<td>The Unix standard.</td>
</tr>
<tr>
<td>crlf or dos</td>
<td>The DOS standard.</td>
</tr>
<tr>
<td>lfcr</td>
<td>The Windows standard.</td>
</tr>
<tr>
<td>nel</td>
<td>0x85 (commonly found in mainframes).</td>
</tr>
<tr>
<td>null</td>
<td>A null byte.</td>
</tr>
<tr>
<td>platform</td>
<td>If another value has not been specified, the line separator uses the platform value as returned by the System.getProperty(&quot;line.separator&quot;) method.</td>
</tr>
</tbody>
</table>

Base-64 Adapter Properties

The following table shows adapter properties for Base-64 encoded binary files as documented in RFC 1341.
Adapter Name in URL

Base-64

Table 88. Properties for Base-64 Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>Used only when converting a Base-64 binary file to XML, and not vice versa. The default is crlf. See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
</tbody>
</table>

Comma-Separated and Tab-Separated Values Adapter Properties

With a few exceptions, noted in the following table, adapter properties are the same for both the comma-separated values and tab-separated values adapters.

Adapter Names in URL

CSV (comma-separated values)

TAB (tab-separated values)

Table 89. Properties for CSV and TSV Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML.</td>
</tr>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Separator</td>
<td>sep</td>
<td>The separator value between each value. This can be ’TAB’, any single character (a comma (, ) is the default), or the %XX-escaped value (%2c, for example).</td>
</tr>
</tbody>
</table>
Adapter Properties

**Table 89. Properties for CSV and TSV Adapters**

<table>
<thead>
<tr>
<th><strong>Property Name</strong></th>
<th><strong>Name in URL</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>First row contains field names</td>
<td>first</td>
<td>Generated field names depend on the values in the <code>first</code> and <code>number</code> fields. If <code>first=yes</code> and <code>number=no</code>, field names are read from the first row. Any field names after that are named <code>column.xxx</code>, where <code>xxx</code> is the column number, starting from one and including explicitly named columns in the count. If <code>number=yes</code>, extra columns (those after the first) are named just <code>column</code>.</td>
</tr>
<tr>
<td>Escape character</td>
<td>escape</td>
<td>This character escapes quotes and separators so that they can be embedded in values. The backslash () is the default.</td>
</tr>
<tr>
<td>Quote character</td>
<td>quote</td>
<td>A list of characters the adapter should interpret as quotation characters. Double and single quote marks (&quot; &quot;) are the default values.</td>
</tr>
<tr>
<td>Number rows and columns</td>
<td>number</td>
<td>If <code>number=yes</code> (no is the default), each row will also have an attribute, named <code>row</code>, which will contain the row number from the source document, starting from one. Also, each column, even those explicitly named, will have a <code>column</code> attribute numbering the column from one. Any empty columns are omitted from the output, but the numbering of subsequent columns will reflect that a column(s) was skipped.</td>
</tr>
</tbody>
</table>

**dBase Adapter Properties**

Adapter properties are the same for all dBase adapters – dBase II, dBase III, dBase III+, dBase IV, and dBase V.
Adapter Names in URL

- dBase_II
- dBase_III
- dBase_III_plus
- dBase_IV
- dBase_V

Table 90. Properties for dBase Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator newline</td>
<td>newline</td>
<td>Used only to convert a dBase file to XML, not vice versa. See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
<tr>
<td>Include deleted records</td>
<td>deleted</td>
<td>Whether or not records marked with a &quot;deleted&quot; attribute are included in the output to XML and preserved in the conversion from XML. Stylus Studio generates the &quot;deleted&quot; attribute on output, and looks for it on input when this property is set to Yes.</td>
</tr>
</tbody>
</table>

DIF, SDI, SLK Adapter Properties

Adapter properties are the same for both Data Interchange Format (DIF), Super Data Interchange Format (SDI), and Symbolic Link Format (SYLK) adapters.

Adapter Names in URL

- DIF (Data Interchange Format)
- SDI (Super Data Interchange Format)
SYLK (Symbolic Link Format)

Table 91. Properties for DIF, SDI, and SYLK Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>Used when converting DIF, SDI, or SYLK file to XML, and vice versa. The default is crlf. See &quot;Line Separator Values&quot; on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
</tbody>
</table>

EDI Adapter Properties

Adapter properties are the same for both Data Interchange Format (DIF), Super Data Interchange Format (SDI), and Symbolic Link Format (SLK) adapters.

Table 92. Properties for EDI Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>Used when converting EDI to XML, and XML to EDI when the Add linefeeds between segments on write property (eol) is set to yes. The default is crlf. See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
</tbody>
</table>
Enable validation val Validates the XML against the structure in the relevant EDI dictionary. An error is generated if the EDI dialect (EDIFACT, X12, for example) isn't recognized; an error is also generated if the dialect is recognized, but the message type isn't. Missing mandatory segments, or segments not specified for a particular group will also generate errors. Consider leaving this option on (Yes, the default). If this option is off (No), the adapter is unable to synchronize its position within the EDI dictionary, preventing nested loops from being generated with the output. When possible, leave this property set to Yes and ensure that the EDI input conforms to the specification.

Comment code list data decode Adds to each code that is looked up in a table a comment that explains the code’s value. For example, <!--Production Data--> in the following code:

```xml
<ISA15><!--I14: Interchange Usage Indicator-->P<!--Production Data--"></ISA15>
```

Turn off this and Comment element types (field) to disable all comment generation.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable validation</td>
<td>val</td>
<td>Validates the XML against the structure in the relevant EDI dictionary. An error is generated if the EDI dialect (EDIFACT, X12, for example) isn't recognized; an error is also generated if the dialect is recognized, but the message type isn't. Missing mandatory segments, or segments not specified for a particular group will also generate errors. Consider leaving this option on (Yes, the default). If this option is off (No), the adapter is unable to synchronize its position within the EDI dictionary, preventing nested loops from being generated with the output. When possible, leave this property set to Yes and ensure that the EDI input conforms to the specification.</td>
</tr>
</tbody>
</table>
| Comment code list data      | decode      | Adds to each code that is looked up in a table a comment that explains the code’s value. For example, <!--Production Data--> in the following code:

```xml
<ISA15><!--I14: Interchange Usage Indicator-->P<!--Production Data--"></ISA15>
```

Turn off this and Comment element types (field) to disable all comment generation. |
### Table 92. Properties for EDI Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
</table>
| Comment element types                   | field       | Creates a comment at the start of each element that includes the element’s name and number. For example, <!--I14: Interchange Usage Indicator--> in the following code: `<ISA15><I14: Interchange Usage Indicator-->P<!--Production Data--><ISA15>`
Turn off this and Comment code list (decode) to disable all comment generation. |
| Strict validation on value lengths      | len         | Checks each value against the upper and lower length limits defined in the EDI specification.                                                                                                             |
| Strict segment-ordering checking       | seg         | Relaxes the rules that require that segments come in the specified order. However, if this property is off (No), some looping constructs might break, resulting in data being grouped in correctly. |
| Force error if value not in code list  | tbl         | Generates an error if the value for an element is not in the codelist associated with that element. If this property is off (No), values are not checked for the presence of a codelist. |
| Strict datatype content checking        | typ         | Ensures that only characters that are appropriate for a given field are included in the value for that field. For example, this property ensures that dates are valid and numbers are well-formed. |
Treat all segments as optional

If set to Yes (No is the default), Stylus Studio assumes that all segments are optional. This property can be useful if your provider declines to provide segments that are considered mandatory according to the EDI specification, but you are aware of what the missing values are.

This property is not used if Enable validation (va1) is set to Yes.

Add linefeeds between segments on write

Allows you to put each segment on its own line when converting XML to EDI. (Extra linefeeds are ignored when converting EDI to XML.) If this property is set to Yes (the default), the value specified in the Line separator (newline) property is used to separate each segment. The normal segment output character is also generated.

Namespace prefix

Namespace prefix to be added, with the Namespace URI, to the root element. The prefix alone is added to all elements.
Binary Adapter Properties

You can convert binary files that have been encoded as a sequence of digits in a base from 2 to 36, and vice versa. Use the Base-64 adapter for base-64 encoded binary files. See “Base-64 Adapter Properties” on page 935 for more information.
Adapter Name in URL

Binary

Table 93. Properties for Binary Base-2 to Base-36 Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>Used when converting a binary encoded file to XML, and vice versa. The default is crlf. See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
<tr>
<td>Base</td>
<td>base</td>
<td>The numeric base of the encoded file. The default is 16 (hexadecimal). Base-2 is binary; base-8 is octal; and base-10 is decimal.</td>
</tr>
<tr>
<td>Wrap lines</td>
<td>wrap</td>
<td>Whether you want to wrap lines (wrap=yes) or output all values on a single line (wrap=no).</td>
</tr>
<tr>
<td>Byte separator</td>
<td>space</td>
<td>Whether or not byte values should be contiguous (no value) or separated with the value specified for this property. For example, if you set space=, the value 000FFF would be output as 00,0F,FF.</td>
</tr>
</tbody>
</table>

HtmlTidy Adapter Properties

You can use the HtmlTidy adapter to convert HTML to XHTML.
Adapter Name in URL

HTMLTidy

Table 94. Properties for the HtmlTidy Adapter

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator newline</td>
<td>newline</td>
<td>Used when converting HTML to XHTML. The default is crlf. See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
<tr>
<td>Abort on warnings found</td>
<td>warnings</td>
<td>Whether or not you want the adapter to fail when it encounters potential problems with the HTML-to-XHTML mapping. warnings=no is the default.</td>
</tr>
<tr>
<td>Abort on errors found</td>
<td>errors</td>
<td>Whether or not you want the adapter to fail when it encounters problems with the HTML-to-XHTML mapping. If errors=no, the adapter continues with the conversion, making a best guess. errors=yes is the default.</td>
</tr>
</tbody>
</table>

Whole-line Text Adapter Properties

The following table describes the properties for the Whole-line Text (Line) adapter.
Adapter Names in URL

Properties for Other Adapters

Each of the following adapters has the same properties. Names as they appear in adapter URLs are shown following the adapter’s proper name.

- E-mail Mbox (MBox)
- Java .properties File (JavaProps)
- Progress .d Data Dump (DotD)
- Rich Text Format (RTF)
- Windows .ini File (WinIni)

Table 95. Properties for the Whole-line Text Adapter

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>Used when converting a whole-line text file to XML, and vice versa. The default is crlf. See “Line Separator Values” on page 935 for a list of values.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
<tr>
<td>Root element name</td>
<td>root</td>
<td>Value used for the root element name. Default is root.</td>
</tr>
<tr>
<td>Line element name</td>
<td>line</td>
<td>Value used for the line element name. Default is line.</td>
</tr>
</tbody>
</table>
Adapter Properties

- Windows Write (WinWrite)

Table 96. Properties for Other Adapters

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Name in URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line separator</td>
<td>newline</td>
<td>Used when converting a file to XML, and vice versa. The default is crlf. See “Line Separator Values” on page 935 for a list of values. Note: The Smith Corona Personal Word Processor adapter uses this value when converting to XML only.</td>
</tr>
<tr>
<td>Encoding</td>
<td>encoding</td>
<td>The encoding for the input file when it is not XML; or the encoding for the output file when it is not XML. The default is utf-8.</td>
</tr>
</tbody>
</table>

Notes on the MBox Adapter

The E-mail MBox (MBox) adapter can be used for mbox-to-XML conversion only. This adapter supports MIME attachments – any message attachments are properly decoded and rendered as XML. Specifically:

- Text and plain attachments are embedded as text
- Binary attachments are embedded as hex-encoded data
- XML-encoded attachments are emitted as escaped text
Index

A
ActiveX controls
  xqDoc and 792
adapter URL scheme
  building your own adapter URL 910
description 906
displayed in Stylus Studio 909
parts of 907
syntax of 908
adapters
  converting files using adapters 229
  creating 273
  for converting EDI 280
  opening files with 278
  properties for 924
ADO
  converting to XML 158
alerts
  for video demonstrations xlv
ancestor axis 651
ancestor-or-self axis 655
AND operator 663
API
  examples of the Stylus Studio Java API 912
  Stylus Studio Java API 901
  Stylus Studio Java API packages 903
applications
  deploying applications developed using the
    Stylus Studio Java API 918
  using the Stylus Studio Java API 901
applying stylesheets
  how it is done 311
  Stylus Studio function key for 345
attribute axis 653
attributes
  matching template 334
auto detect
  feature for configuring Java components 151
automatic tag completion
  Sense:X 9
  Stylus Studio feature for 9
axis syntax in queries 649

B
back-mapping
  described 36
  using in templates 485
XPath query results and 623
XSLT processors that support 374
backup copies of documents 227
Berkeley DB XML
  configuring the BerkeleyDBXML.xml file 869
  creating containers in 875
  integration with Stylus Studio 866
  opening files stored on 873
  saving files to 873
  supported versions 867
BerkeleyDBXML.xml file
  configuring 869
<table>
<thead>
<tr>
<th>keyword</th>
<th>page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>binary files converting to XML</td>
<td>229</td>
</tr>
<tr>
<td>BLOBs querying</td>
<td>618</td>
</tr>
<tr>
<td>bookmarks setting</td>
<td>165</td>
</tr>
<tr>
<td>Bookmarks XQuery debugging and</td>
<td>775</td>
</tr>
<tr>
<td>bookstore.xml</td>
<td>626</td>
</tr>
<tr>
<td>boolean() function</td>
<td>664</td>
</tr>
<tr>
<td>Booleans converting operands to expressions functions</td>
<td>664</td>
</tr>
<tr>
<td>breakpoints in stylesheets</td>
<td>480</td>
</tr>
<tr>
<td>in XQuery documents</td>
<td>773</td>
</tr>
<tr>
<td>C</td>
<td></td>
</tr>
<tr>
<td>call stack displaying the Call Stack window in the XQuery editor</td>
<td>775</td>
</tr>
<tr>
<td>canonical XML converting XML to canonical XML</td>
<td>225</td>
</tr>
<tr>
<td>case sensitivity Boolean operators and queries and</td>
<td>663</td>
</tr>
<tr>
<td>ceiling() function</td>
<td>669</td>
</tr>
<tr>
<td>chaining stylesheets</td>
<td>143</td>
</tr>
<tr>
<td>character map in XSLT</td>
<td>403</td>
</tr>
<tr>
<td>checking spelling</td>
<td>167</td>
</tr>
<tr>
<td>child axis</td>
<td>650</td>
</tr>
<tr>
<td>classpath setting for a project</td>
<td>122</td>
</tr>
<tr>
<td>setting for Java components</td>
<td>153</td>
</tr>
<tr>
<td>ClearCase using with Stylus Studio</td>
<td>126, 129</td>
</tr>
<tr>
<td>code code folding</td>
<td>162</td>
</tr>
<tr>
<td>generating Java code for XQuery</td>
<td>797</td>
</tr>
<tr>
<td>generating Java code for XSLT</td>
<td>388</td>
</tr>
<tr>
<td>selecting lines in</td>
<td>165</td>
</tr>
<tr>
<td>collection() functions creating a collection() statement</td>
<td>767</td>
</tr>
<tr>
<td>creating database connections for</td>
<td>765</td>
</tr>
<tr>
<td>DataDirect XQuery processor and handling invalid SQL characters in</td>
<td>765</td>
</tr>
<tr>
<td>querying relational data with</td>
<td>764</td>
</tr>
<tr>
<td>Stylus Studio built-in processor and syntax</td>
<td>765</td>
</tr>
<tr>
<td>using in Stylus Studio</td>
<td>764</td>
</tr>
<tr>
<td>XQuery processors and collections connecting to TigerLogic XDMS collections</td>
<td>765</td>
</tr>
<tr>
<td>creating in TigerLogic XDMS</td>
<td>880</td>
</tr>
<tr>
<td>com.exln.stylus.io</td>
<td>904</td>
</tr>
<tr>
<td>command line custom document wizard arguments</td>
<td>895</td>
</tr>
<tr>
<td>running Stylus Studio from running XML diff</td>
<td>220</td>
</tr>
<tr>
<td>utilities</td>
<td>141</td>
</tr>
<tr>
<td>XML validation utility</td>
<td>144</td>
</tr>
<tr>
<td>XQuery utility</td>
<td>143</td>
</tr>
<tr>
<td>XSLT utility</td>
<td>142</td>
</tr>
<tr>
<td>comma-separated files see CSV files</td>
<td></td>
</tr>
<tr>
<td>comment() function</td>
<td>680</td>
</tr>
<tr>
<td>comparing node sets</td>
<td>671</td>
</tr>
<tr>
<td>comparing XML documents</td>
<td>191</td>
</tr>
<tr>
<td>merged view</td>
<td>205</td>
</tr>
<tr>
<td>text view</td>
<td>204</td>
</tr>
<tr>
<td>tree view</td>
<td>203</td>
</tr>
<tr>
<td>com.stylusstudio.converter</td>
<td>903</td>
</tr>
<tr>
<td>com.stylusstudio.version</td>
<td>905</td>
</tr>
<tr>
<td>concat function blocks in XQuery</td>
<td>762</td>
</tr>
<tr>
<td>concat() function</td>
<td>659</td>
</tr>
<tr>
<td>concatenating strings</td>
<td>659</td>
</tr>
<tr>
<td>conditions expressing in XQuery Mapper</td>
<td>763</td>
</tr>
<tr>
<td>in XSLT</td>
<td>361</td>
</tr>
<tr>
<td>expressing in XSLT Mapper</td>
<td>462</td>
</tr>
<tr>
<td>configuring DataDirect SequeLink for ODBC</td>
<td>847</td>
</tr>
<tr>
<td>Java components</td>
<td>149</td>
</tr>
<tr>
<td>ODBC data sources</td>
<td>842</td>
</tr>
<tr>
<td>containers creating Berkeley DB XML containers in Stylus Studio</td>
<td>875</td>
</tr>
</tbody>
</table>
contains() function 657
context node 643
current context
  number of nodes in 686
current node
  definition 643
current() function 688
custom document wizards
  about 889
  arguments 895
  command line arguments 895
  configuring 890
defining arguments 895
document types for 893
how to configure 899
macros for 891
naming 892
registering 890
  specifying a command line template for 893
Custom Document Wizards page in Options dialog box 891
custom file system
  Javadoc for Java API 903
custom file systems
  Custom File Systems page 922
  definition 919
  Java API for 921
  naming 923
  registering with Stylus Studio 921
custom validation engines for XML
  about 884
  configuring 885
  macros for 886
  naming 886
  registering 884
  Custom Validation Engines page in Options dialog box 885
data
  accessing data using Stylus Studio URL schemes 902
data source
  DB-to-XML data sources in Stylus Studio 832
data sources
  creating an ODBC data source 843
  using ODBC data sources in Stylus Studio 842
databases
  accessing relational data from Stylus Studio 831
  accessing with XQuery 719
  connecting
    creating a default connection 840
    from File Explorer 841
    connecting to 839
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>creating a default connection 840</td>
</tr>
<tr>
<td>DataDirect SequeLink and 832</td>
</tr>
<tr>
<td>integration with Berkeley DB XML 866</td>
</tr>
<tr>
<td>integration with Raining Data 876</td>
</tr>
<tr>
<td>integration with Sleepycat Software 866</td>
</tr>
<tr>
<td>integration with Tiger Logic XDMS 876</td>
</tr>
<tr>
<td>supported relational databases 832</td>
</tr>
<tr>
<td>using SQL/XML in Stylus Studio 857</td>
</tr>
<tr>
<td>DataDirect SequeLink</td>
</tr>
<tr>
<td>Stylus Studio and 833</td>
</tr>
<tr>
<td>using with Stylus Studio 842</td>
</tr>
<tr>
<td>DataDirect XQuery</td>
</tr>
<tr>
<td>collection() function processing 765</td>
</tr>
<tr>
<td>db URL scheme 906</td>
</tr>
<tr>
<td>DB-to-XML Data Source Editor</td>
</tr>
<tr>
<td>database schema pane 835</td>
</tr>
<tr>
<td>description 834</td>
</tr>
<tr>
<td>DB-to-XML data source editor</td>
</tr>
<tr>
<td>SELECT and UPDATE tabs 834</td>
</tr>
<tr>
<td>DB-to-XML data sources</td>
</tr>
<tr>
<td>composing SQL/XML for 857</td>
</tr>
<tr>
<td>creating 836</td>
</tr>
<tr>
<td>database connection settings 839</td>
</tr>
<tr>
<td>definition 832</td>
</tr>
<tr>
<td>example 861</td>
</tr>
<tr>
<td>how SELECT and UPDATE statements are executed 860</td>
</tr>
<tr>
<td>opening 838</td>
</tr>
<tr>
<td>saving 838</td>
</tr>
<tr>
<td>scenarios for 833</td>
</tr>
<tr>
<td>system requirements 832</td>
</tr>
<tr>
<td>video demonstration 831, 836</td>
</tr>
<tr>
<td>dbxml URL scheme 906</td>
</tr>
<tr>
<td>debugging</td>
</tr>
<tr>
<td>using bookmarks in the XQuery debugger 775</td>
</tr>
<tr>
<td>XSLT processors that support 374</td>
</tr>
<tr>
<td>debugging stylesheets</td>
</tr>
<tr>
<td>example of 72</td>
</tr>
<tr>
<td>parser errors 489</td>
</tr>
<tr>
<td>processor errors 489</td>
</tr>
<tr>
<td>using breakpoints 480</td>
</tr>
<tr>
<td>what output this template generates 485</td>
</tr>
<tr>
<td>which template generated output 485</td>
</tr>
<tr>
<td>debugging XQuery</td>
</tr>
<tr>
<td>bookmarks 775</td>
</tr>
<tr>
<td>displaying expressions associated with output 775</td>
</tr>
<tr>
<td>displaying process suspension points 775</td>
</tr>
<tr>
<td>displaying processing information 774</td>
</tr>
<tr>
<td>evaluating XPath expressions 774</td>
</tr>
<tr>
<td>local variables and 774</td>
</tr>
<tr>
<td>overview 772</td>
</tr>
<tr>
<td>using breakpoints 773</td>
</tr>
<tr>
<td>watching variables 774</td>
</tr>
<tr>
<td>debugging XSLT</td>
</tr>
<tr>
<td>bookmarks and 484</td>
</tr>
<tr>
<td>breakpoints 480</td>
</tr>
<tr>
<td>determining templates associated with output 485</td>
</tr>
<tr>
<td>displaying instructions associated with output 484</td>
</tr>
<tr>
<td>displaying process suspension points 483</td>
</tr>
<tr>
<td>displaying processing information 481</td>
</tr>
<tr>
<td>evaluating XPath expressions 482</td>
</tr>
<tr>
<td>example of 72</td>
</tr>
<tr>
<td>local variables and 482</td>
</tr>
<tr>
<td>overview 479</td>
</tr>
<tr>
<td>watching variables 482</td>
</tr>
<tr>
<td>default templates</td>
</tr>
<tr>
<td>description 371</td>
</tr>
<tr>
<td>example 30</td>
</tr>
<tr>
<td>how they work 332</td>
</tr>
<tr>
<td>deploying generated code</td>
</tr>
<tr>
<td>for XQuery 804</td>
</tr>
<tr>
<td>deploying Java applications 918</td>
</tr>
<tr>
<td>deploying XQuery code 804</td>
</tr>
<tr>
<td>deploying XSLT code 394</td>
</tr>
<tr>
<td>descendant axis 651</td>
</tr>
<tr>
<td>descendant-or-self axis 654</td>
</tr>
<tr>
<td>.dff files</td>
</tr>
<tr>
<td>default Stylus Studio module and 108</td>
</tr>
<tr>
<td>Diagram tab</td>
</tr>
<tr>
<td>XML Schema Editor 510</td>
</tr>
<tr>
<td>diffing XML</td>
</tr>
<tr>
<td>changes that are identified 194</td>
</tr>
<tr>
<td>colors and symbols used by the XML Diff Viewer 197</td>
</tr>
<tr>
<td>command line utility for 220</td>
</tr>
<tr>
<td>diffing folders 198</td>
</tr>
<tr>
<td>diffing multiple documents 211</td>
</tr>
<tr>
<td>diffing two documents 210</td>
</tr>
</tbody>
</table>

942 Stylus Studio® 2006 User Guide
merged view of diffed documents  205
options  216
overview  193
text view of diffed documents  204
tools for documents and folders  191
tree view of diffed documents  203
tuning the diffing algorithm  195
video demonstration  192
viewing documents side-by-side  203
when the diff is calculated  196
while diffing folders  202
XML Diff Viewer
  adding documents  209
  example  193
  tool bar  206
displaying line numbers  8
document pane
  display features for  238
document wizards
  ADO to XML  158
  custom document wizards  889
  DTD to XML  157
  DTD to XML Schema  497
  DTD to XML Schema (Trang)  497
  EDIFACT to XML Schema  504
  how to use  157
  HTML to XML  158
  HTML to XSLT  39
  IATA to XML Schema  507
  X12 to XML Schema  505
  XML Schema to XML  157
  XML to XML Schema  501, 502
document() function
  using  691
  XSLT Mapper and  447
documentation
  for XML Schema  566
  for XQuery  790
  Stylus Studio documentation  xlv
Documentation tab
  XML Schema Editor  512
documents
  creating backup copies  227
  custom document wizards  889
  saving  227

DTD
  code folding  162
  converting to XML  157
  spell checking documents  167
  using to create XML Schema  497
  .dtd files
    default Stylus Studio module and  108
dynamic text
  inserting in three-pane view  41
dynamic Web pages
  from static HTML  38
  from XML
    three-pane view  327

E
EDI
  creating XML Schema from EDIFACT
    message types  504
  creating XML Schema from IATA message
types  507
  creating XML Schema from X12 transaction
ssets  505
EDI files
  converting to XML  280
    Convert to XML module
EDIFACT
  creating XML Schema from EDIFACT
    message types  504
EDIFACT to XML Schema document wizard
  built-in EDI adapter and  285
  description  504
  options for  504
  running  504
  uses for XML Schema  285
editing XML
  bookmarks  165
  changing fonts  165
  colors used in text display  166
  commenting text  165
  diffing  191
  displaying line numbers  8
  displaying white space in schema
    representations  19
  features for  161
indenting text 164
inserting indents 11
line wrap 164
querying a document 12
searching text 165
Sense:X auto-completion 9
setting bookmarks 165
spell checking documents 167
tools for 161
undo 10
wrapping lines 164
editors
selecting lines in 165
evaluating text 164
example
bookstore.xml 626
creating dynamic Web pages from XML three-pane view 327
creating templates 336
making static Web pages dynamic 38
stylesheets 305
testing queries 628
tree representation of XML data 626
XML document structure 626
expand all 174
expanded node names
obtaining 684
extension functions
data types 366
declaring 366
finding 368
invoking 368
namespaces 367
XPath data types 367

F
field names
specifying in Convert to XML 255
File Explorer
adding files to Projects using
connecting to a database from 841
features of 111
filters for 112
opening files with 111
overview 110
setting filters to display files in 112
tool bar 111
file systems
integration with Berkeley DB XML 866
integration with Raining Data 876
integration with Sleepycat Software 866
integration with TigerLogic XDMS 876
files
see also CSV, EDI, and flat files
adding file types to Stylus Studio 115
adding to projects
associating file types with Stylus Studio
tools 109
converting non-XML files to XML 229
custom file systems 919
file types and Stylus Studio module associations 108
making Stylus Studio the default application 115
opening 108
spell checking files in Stylus Studio 167
filters
for XQuery 635
Find
searching XML documents 172
fixed-width files
converting to XML
Convert to XML module 229
flat files
converting to XML
Convert to XML module 229
creating XML documents from 232
floor() function 668
flow ports
in XSLT Mapper symbols 460
FLWOR blocks
creating 758
Flow port 758
For port 757
illustration 757
in XQuery Mapper 757
Order by port 757
Return port 757
Where port 757
FLWOR expressions
declaring XQuery types using 734
Index

examples 720
for 721
grouping 735
let 725
multiple assignments in 735
order by 730
overview 720
parts of 721
return 731
setting XQuery position variables using 734
where 729
folders
diffing folder contents 198
Other Documents folder in Stylus Studio projects 118
following axis 652
following-sibling axis 652
fonts
changing 165
colors used in text display 166
in Convert to XML document pane 240
formatting objects (FO)
automatic tag completion 354
generating 381
function blocks
preserving layout in XQuery Mapper 748
preserving layout in XSLT Mapper 455
function keys
applying stylesheets 345
function-available() function 688

G
generate-id() function 691
Go To dialog box
Convert to XML Editor 240
Grid tab
overview 177
renaming nodes in 181
grouping
in FLWOR expressions 735

H
handling errors in stylesheets 489
Home Edition
description 4
HTML
automatic tag completion 354
composing XSLT for 32, 357
converting to XML 158
creating XML documents from 156
creating XSLT 341

I
IATA
creating XML Schema from IATA message types 507
IATA to XML Schema document wizard
description 507
options for 507
running 507
IBM DB2
support for 832
id() function 678
IDs
finding elements with 678
public IDs for XML Schemas 558
system IDs for XML Schemas 558
temporary 691
IF blocks
in XQuery Mapper 762
images
example of dynamic images in XSLT 45
including in XML Schema documentation 569
indenting tags 11
indenting text 164
Informix
support for 832
input ports
in XQuery Mapper symbols 760
in XSLT Mapper symbols 459
INSERT statement
SQL/XML example 862
instantiating templates
process flow 334
integration
with Berkeley DBXML 866
with TigerLogic XDMS 876
Index

J
Java 149
  compiling code generated from XQuery 802
  compiling code generated from XSLT 392
  configuring the JVM 149
  defining functions in XSLT Mapper 468
  deploying code generated from XQuery 804
  deploying code generated from XSLT 394
  downloading Java components 150
  extension functions for stylesheets 368
  generating classes from a Web service 821
  generating code from XQuery 797
  generating code from XSLT 388
  generating JAXB classes from XML
    Schema 573
  modifying the classpath for Java components 153
  Stylus Studio modules that require Java components 149
Java API
  deploying applications 918
  examples of 912
  Javadoc for 903
  overview 901
  packages 903
  using to convert files 907
Java Code Generation wizard for XQuery
  about 797
  compiling code from 802
  running 800
  settings for 800
Java Code Generation wizard for XSLT
  about 388
  compiling code from 392
  running 391
  settings for 391
  .java files
  default Stylus Studio module and 108
  Javadoc
  Stylus Studio File System Java API 903
  JavaScript in stylesheet results 321
  JAXB
    generating classes from XML Schema 573

JDK
  configuring 149
  where to download 150
JRE 149
  requirements
    for DB-to-XML data sources 832
    for Java debugging 489
  where to download 150
JVM
  configuring 149

K
key() function 689
keyboard shortcuts 140

L
lang() function 665
languages.xml file 354
last() function 686
line numbers
  displaying 8
  jumping to a line in an XML document 171
  line wrap 164
local variables
  watching during XQuery processing 774
local-name() function 684
logical operators
  in XSLT Mapper 466

M
Mapper
  see XQuery Mapper and XSLT Mapper
mappings
  exporting as an image 444, 755
Mark Logic
  processing XQuery with 783
match attribute
  comparison with select attribute 311
description 309
matched templates
  creating in XSLT Mapper 470
metrics
  XQuery performance 777
  XSLT performance 485
Microsoft SQL Server
  support for 832
multidocument queries
  alternatives 692

N
name() function 683, 684
named templates
  creating in XSLT Mapper 470
namespace axis 654
namespaces
  extension functions 367
  obtaining information in queries 683
  stylesheets 308
namespace-uri() function 684
node sets
  comparing 671
node() function 680
nodes
  in-place editing in a schema diagram 95
  obtaining expanded names 684
  obtaining the local name 684
  obtaining the namespace URI 684
  renaming in the XML Grid tab 181
normalize-space() function 660
NOT operator 663
not() function 665
number() function 667
numbers
  converting operands to 667
  displaying line numbers in Stylus Studio editors 8

O
ODBC data sources
  configuring DataDirect SequeLink to reference an ODBC data source 847
  creating 843
  using in Stylus Studio 842
OLE DB
  creating XML from ADO 158
  opening files 108
  using the File Explorer 111
operands
  converting to Booleans 664
  converting to numbers 667
  converting to strings 661
Options dialog box
  Custom Document Wizards page 891
  Custom File Systems page 922
  Custom Validation Engines page 885
OR operator 663
Oracle
  support for 832

P
parameters in queries 687
parent axis 651
performance
  factors that affect Stylus Studio 145
  reporting XQuery metrics 777
  reporting XSLT metrics 485
performance metrics
  for XQuery 777
  for XSLT 475
position() function 675
POST data
  using POST.htm to test queries 628
post-processing XSLT 380
preceding axis 653
preceding-sibling axis 652
printing
  XML Schema 515
  XML Schema documentation 573
.prj files
  default Stylus Studio module and 108
processing-instruction() function 680
processors
  for XQuery 782, 785
  for XSLT 374, 475
profiling
  XQuery
    Profiler report 777
Index

stylesheet for Profiler report  777
XSLT
  Profiler report  475
  stylesheet for Profiler report  486
projects
  adding files to
    ClearCase and  126, 129
  creating  118
  definition  116
  opening  119
  placing under source control  125
  saving  119
  setting classpaths for  122
  SourceSafe and  126
  subprojects and  118
  Visual SourceSafe and  126
  Zeus CVS and  132
  public IDs for XML Schemas  558

Q

  qualified names
    wildcards  685
  queries
    axis syntax  649
    document element  626
    document structure  625
    function available?  688
    getting started  629
    IDs  678
    multiple documents  692
    non-XML data  618
    query language
      attributes  634
      Boolean expressions  663
      comparisons  669
      context flags  646
      context nodes  643
      context summary  648
      count  686
      filtering results  637
      filters  635
      getting a subscript  675
  getting all marked-up text  629
  id() function  679
  namespaces  683
  node names  683
  obtaining all like-named elements  630
  operators  670
  path operators  646
  quick reference for functions and
    methods  694
  search context  643
  searching by node type  680
  selecting nodes to evaluate  642
  subscripts  674
  wildcards  638
  wildcards in attributes  635
  restrictions  618
  root node  626
  sorting attributes  618
  subqueries  637
  temporary IDs  691
  tutorial  629
  variables  687
  where you can use  616
  query facility  615

R

  Raining Data
    see also TigerLogic
      integration with Stylus Studio  876
    .rdbxml files
      default Stylus Studio module and  108
    refactoring XML Schema nodes  97
    regular expressions
      reference  172
      using Search to find  172
      using to filter output of converted
        documents  265
    xsdpattern and  524
  relational data
    composing SQL/XML  857
    connecting to a database  839
    creating XML from ADO  158
DataDirect SequeLink and 833
defining DB-to-XML data sources 834
editing SQL/XML 834
how it is translated to XML 858
querying with the collection() function 764
working with relational data in Stylus Studio 832
removing templates 374
restrictions
queries 618
result documents
getting started with 35
root element 626
definition 643
root node
creating matching template 336
default template 372
definition 644
matching template 332
root/element default template
description 372
example 332
round() function 669

S
saving documents
automatic save 227
creating backup copies 227
options for 227
Saxon
processing XQuery with 782
using Saxon to process XSLT 376
scenarios
cloning 855
creating 853
definition 33
deleting 856
for DB-to-XML data sources 833, 852
for Web service calls 825
for XQuery 780
performance metrics reporting 777
for XSLT 33
choosing an XSLT processor 475
how to clone 478
how to create 476
how to run 477
introduction 471
performance metrics reporting 475
setting parameter values 473
specifying source documents 472
modifying 854
renaming 855
XQuery
validating results 787
XSLT
validating results 378
search context
definition 643
queries 643
searching
text 165
using Find to search XML documents 172
using XPath to search for strings 656
select attribute
comparison with match attribute 311
description 310
when there is none 332
SELECT statement
SQL/XML example 861
selecting lines of code 165
self axis 654
Sense:X automatic tag completion
description 9
example 10
Sense:X tag completion
XSLT and 354
SequeLink
DataDirect SequeLink and Stylus Studio 833
Sleepycat Software
see also Berkeley DB XML
integration with Stylus Studio 866
opening files stored on Berkeley DB XML 873
SOAP requests
modifying 814
parameters for 814
source control
Stylus Studio projects and 125
supported applications 125
Index

SourceSafe
using with Stylus Studio 126

Spell Checker
personal dictionary 170
running 169
settings for 168
using 167

SQL/XML
composing 857
editing in Stylus Studio 834
INSERT statement example 862
SELECT statement example 861

Sruzzo
command line utility for running Stylus Studio 142

string() function 661
string-length() function 659

strings
after 658
before 657
concatenating 659
converting operands to 661
number of characters 659
replacing characters 660
searching for 656
substrings 658

stylesheets
applied by XSLT processors 311
applying
  Stylus Studio 345
chaining 143
contents 308
contents description 352
creating 341
creating new nodes 318
example 305
for XML Schema documentation 567
for XQuery Profiler reports 777
for XSLT Profiler reports 486
formatting results 317
getting started with 26
introduction 305
namespaces 308
obtaining system properties 687
omitting source data 315
root element 308
selecting nodes for processing 313

Stylus Studio
debbuging 479
updating
  three-pane view 353
XSLT instructions 396

Stylus Studio
associating file types with 109
auto detect feature for Java components 151
benefits 323
command line for running 142
command line utilities for 141
DataDirect SequeLink and 833
debbuging stylesheets 479
Diff tool 191
Home Edition description 4
Java API 901
Java API examples 912
Java API packages 903
managing performance 145
modules that require Java components 149
projects 116
running from the command line 142
system requirements for DB-to-XML data sources 832
using SQL/XML 857
using with ClearCase 126, 129
using with SourceSafe 126
using with Visual SourceSafe 126
using with Zeus CVS 132
Web services and 807
XML Deployment Components 901
XML validation command line utility 144
XQuery command line utility for 143
XSLT command line utility 142

Stylus Studio Home Edition
description 4
StylusDiff 220
StylusValidator
command line XML validation utility 144
StylusXql
command line XQuery utility 143
StylusXslt
command line XSLT utility 142
substring() function 658
substring-after() function 658
substring-before() function 657
sum() function 668
support, technical xlvi
Sybase
  support for 832
symbols
  element and attribute
    in XQuery Mapper 744
    in XSLT Mapper 452
  lines linking nodes in XQuery Mapper 750
XLST function blocks
  parts of 464
XLST Mapper
  parts of 458
XQuery function blocks
  parts of 760
XQuery Mapper
document 740
XSLT Mapper
document 449
XSLT mapper
  XSLT instructions 458
syntax, notations used in this manual xliv
system IDs for XML Schemas 558
system properties in stylesheets 687
system-property() function 687

t
  technical support xlvi
templates
  applying 374
  backmapping in 485
  built-in 316
  contents description 309
  creating 373
  creating named and matched templates in XSLT Mapper 470
description of default templates 371
displaying match patterns 28
instantiation example 332
introduction 308
match attribute 311
matched templates in XSLT Mapper 470
matching root node 336
more than one match 316
named templates in XSLT Mapper 470
no match 316
removing 374
rules 310
select attribute 311
selecting for instantiation 310
updating 374
viewing 369
working with in XSLT Mapper 469
text
  colors used to display 166
text files
  converting to XML
    Convert to XML module 229
text pane
  XML Schema Editor 510
text values
  setting for elements and attributes in XQuery Mapper 747
  setting for elements and attributes in XSLT Mapper
    introduction 467
    on the target node 468
    using the Mapper canvas 467
text() function 680
text/attribute default template
description 372
example 334
three-pane view in Stylus Studio
result documents 35
TigerLogic XDMS
  connecting to collections 876
  integration with Stylus Studio 876
  processing XQuery with 784
TigerLogic XDMS
  creating collections in 880
tool bars
  changing appearance of Stylus Studio main tool bar 136
  customizing Stylus Studio main tool bar 134
  File Explorer tool bar 111
  showing and hiding Stylus Studio main tool bar 135
Index

XML Diff Viewer tool bar 206
translate() function 660
Tree tab
XML Schema Editor 511
tutorial for queries 629
typographical conventions xlv

U
UDDI registries
searching 811
Web services and 811
UN/CEFACT
creating XML Schema from EDIFACT
message types 504
unparsed-entity-uri() function 686
updating stylesheets 353
URL schemes
descriptions of 906
Stylus Studio URL schemes 902
user-defined field names
display in Convert to XML Editor 237
user-defined functions
in XQuery Mapper 761

V
validating XML
custom validation engines for 884
from the command line 144
standard validation engines for 884
video demonstration 155
variables in queries 687
Video Center example
creating video template 41
instantiating the video template 43
making images dynamic 45
making summaries dynamic 46
making titles dynamic 44
video demonstrations
alerts for xlv
Convert to XML 229, 280
DB-to-XML data sources 831, 836
diffing XML sources 192
documentation alerts for xlv
Web Service Call Composer 807
XML editing and validation 155
XML Editor Grid tab 178
XML Schema Diagram Editor 509
XQuery Mapper 703
XSLT WYSIWYG 47
viewing templates 369
Visual SourceSafe
using with Stylus Studio 126

W
Web pages
changing from static to dynamic HTML 38
creating from XML	hree-pane view 327
Web Service Call Composer
video demonstration 807
Web service calls
specifying transport protocols for 826
Web services
creating a Web service call 808
generating a Java client for 821
invoking from an XQuery 794, 822
saving Web service calls 817
scenarios for Web service calls 825
SOAP requests for 814
testing 816
using in Stylus Studio 807
using Web service calls as XML 818
WSDLs and 810
white space
handling
XPath processor 660
XSL facility 318
toggling display in schema representations 19
wildcards
in queries 638
node names 683
wizards
custom document wizards 889
wrapping lines 164
ws URL scheme 906
.wsc and .wscc files
default Stylus Studio module and 108
WSDLs
  displaying a WSDL document 815
  finding WSDL URLs 810
  searching UDDI registries for 811

WYSIWYG
  XSLT editor for composing HTML 32, 357

X

X12
  creating XML Schema from X12 transaction sets 505

X12 to XML Schema document wizard
  description 505
  options for 506
  running 506

xln: text() function 662

XML 626
  accessing XML documents with 710
  code folding 162
  command line utility for validating 144
  converting EDI to XML 280
  converting files programmatically 907
  converting XML to canonical XML 225
  creating an instance from XML Schema 513
  creating from HTML 156
  creating XML documents from flat files 232
  creating XML Schema from an XML document 501
  custom validation engines 884
  diffing in Stylus Studio 191
  displaying the XML Schema associated with a document 503
  generating XML with XQuery 717
  representing relational data as 858
  spell checking documents 167
  standard validation engines for 884
  using Web service calls as XML 818
  viewing an XML instance based on XML Schema 513

XML Diff Viewer
  adding documents 209
  example 193
  merged view 205
  options 216
  split view 203

text view 204
  tool bar 206
  tree view 203

XML documents
  comparing 191
  converting to canonical XML 225
  creating from HTML 156
  diffing 191
  jumping to a line in 171
  jumping to a matching tag 172
  querying using XPath 226
  root element 626
  root node 626
  searching 172
  setting bookmarks in 171
  specifying for XQuery scenarios 780
  structure 625
  tools for diffing 191

XML Editor
  displaying line numbers in 8
  Grid tab
    overview 177
    renaming nodes in 181
  jumping to a line 171
  jumping to a matching tag 172
  searching 172
  setting bookmarks 171
  XML Editor Grid tab
    video demonstration 178

.xml files
  default Stylus Studio module and 108

XML instances
  XQuery Mapper source documents and 738
  XSLT Mapper source documents and 447

XML Schema
  code folding 162
  converting to XML 157
  creating 496
  creating an XML instance from 513
  creating from an XML document 501
  creating from DTD 497
  creating from EDIFACT message types 504
  creating from IATA message types 507
  creating from X12 transaction sets 505
Index

definition 496
detecting errors in 92
Diagram tab
description 510
illustration 509
displaying documentation element text in the Diagram tab 91
displaying documentation using XS3P stylesheet 567
displaying documentation using XSDdoc stylesheet 571
displaying the XML Schema associated with a document 503
documentation for 566
Documentation tab
description 512
generating JAXB classes from nodes 573
refactoring 97
printing 515
refactoring nodes 97
reference information 496
spell checking documents 167
Stylus Studio tools for 510
Tree tab
description 511
validating 513
viewing an XML instance of 513
XML Schema diagram
in-place editing 95
XML Schema Diagram Editor
video demonstration 509
XML Schema documentation
printing 573
XML Schema Editor
displaying errors in text pane 92
text pane 510
XML to XML Schema document wizard 501
XML validation
video demonstration 155
XPath
background 616
benefits 617
choosing a version 12
description 616
evaluating expressions during XQuery processing 774
function blocks in XSLT Mapper
creating 466
deleting 466
introduction 464
types 465
mathematical function blocks in XSLT Mapper 465
relationship to XQuery 711
support for 12
XPath Query Editor 619
XQuery and 711
XPath expressions
where you can use 616
XPath Query Editor
description 619
xqDoc
ActiveX controls and 792
documentation for XQuery 790
viewing XQuery code samples from 793
XQuery
accessing relational data with collection() functions 764
accessing XML documents with 710
accessing databases with 719
code folding 162
collection() functions 764
command line utility for 143
concat
compiling Java code generated from 802
function blocks in XQuery Mapper 762
creating using the XQuery Mapper 736
debugging XQuery documents 772
declaring types in FLWOR expressions 734
default processor settings 785
deploying Java code generated from 804
documentation for 790
documentation for
editor for
description 705
Mapper tab 707
XQuery Source tab 705
enabling the Profiler 778
evaluating XPath expressions during XQuery processing 774
examples 709  
FLWOR expressions 720  
generating Java code from 797  
generating XML output with 717  
in Stylus Studio 705  
introduction 708  
invoking a Web service from 794, 822  
performance metrics reporting 777  
primer 708  
processing with Mark Logic 783  
processing with Saxon 782  
processing with TigerLogic XDMS 784  
processors  
  default options for 785  
profiling 777  
relationship to XPath 711  
scenarios for 780  
selecting a processor 782  
setting a default processor 785  
setting position variables in FLWOR expressions 734  
specifying XML input for the XQuery 780  
spell checking documents 167  
using collection() functions in XQuery code 764  
using existing XQueries in the XQuery editor 737  
validating result documents 787  
viewing source code in the Mapper 707  
W3C definition 704  
XPath and 711  
XQuery debugging  
  bookmarks 775  
XQuery documents  
  setting breakpoints in 773  
.xquery files  
  default Stylus Studio module and 108  
XQuery Mapper  
  adding source documents 740  
  building a target structure 745  
  choosing source documents 738  
  condition blocks 763  
  creating FLWOR blocks 758  
  creating function blocks 759  
  creating target structure elements and attributes 746  
creating target structure root elements 745  
creating XQuery 736  
document symbols 740  
element and attribute symbols in 744  
elements and attributes  
  creating in target structures 746  
exporting mapping as an image 755  
FLWOR block parts 757  
function blocks  
  about 759  
  creating 759  
  parts of 760  
  types 759  
hiding links in 754  
how documents are displayed 743  
how to map nodes 750  
IF blocks 762  
input ports in Mapper symbols 760  
lines linking nodes 750  
mapping document nodes 748  
modifying the target structure 747  
preserving Mapper layout 748  
removing a node from a target structure 747  
removing node mappings 753  
removing source documents 743  
root elements  
  creating in target structures 745  
setting text values 747  
simplifying the display 754  
source documents and XML instances 738  
source documents for 738  
target structures 744  
user-defined functions 761  
using 737  
using FLWOR blocks 756  
using the mouse 749  
video demonstration 703  
viewing source code in 707  
XQuery output  
  displaying source expressions 775  
XQuery processing  
  call stack 775  
  displaying source expressions 775  
  displaying suspension points 775  
  selecting a processor 782
Index

setting a default processor 785
using bookmarks 775
watching local variables 774
watching variables 774
XQuery processors
Mark Logic 783
Saxon 782
selecting 782
setting a default processor 785
TigerLogic XDMS 784
XQuery Profiler
description 777
displaying the report 779
enabling 778
performance metrics captured by 778
report created by 777
XQuery scenarios
performance metrics reporting 777
xquery URL scheme 906
XS3P stylesheet
display settings 569
displaying XML Schema documentation
with 567
features 568
modifying 570
XSD
displaying documentation element text 91
.xsd files
default Stylus Studio module and 108
xsd:pattern
regular expressions and 524
XSDdoc
displaying XML Schema documentation
with 571
XSDdoc stylesheet
display settings 571
XSL
additional information sources 322
and XSLT 616
definition 304
definition 305
example 305
formatting objects 381
getting started with 303
inserting JavaScript in result 321
patterns 319
XSL facility
creating new nodes 318
selecting source nodes 313
specifying XSL patterns 319
white space handling 318
.xsl files
default Stylus Studio module and 108
XSL processor
applying stylesheets 311
built-in templates 316
specifying result format 317
URI 308
xsl:apply-imports instruction 398
xsl:apply-templates instruction
comparison with xsl:for-each
instruction 321
controlling operation order 314
element 314
more than one match 316
no match 316
no select attribute 332
reference 398
selecting nodes 313
specifying patterns 319
xsl:attribute instruction 399
xsl:attribute-set instruction 400
xsl:call-template instruction 402
xsl:character-map instruction 403
xsl:choose
compared to xsl:if in XSLT Mapper 462
xsl:choose instruction 405
xsl:comment instruction 406
xsl:copy instruction 406
xsl:copy-of instruction 407
xsl:debug instruction 480
xsl:decimal-format instruction 408
xsl:element instruction 409
xsl:fallback instruction 410
xsl:for-each instruction
comparison with xsl:apply-templates
instruction 321
reference 410
selecting nodes 313
specifying patterns 319
xsl:for-each-group instruction 412
xsl:function instruction 413
<table>
<thead>
<tr>
<th>xsl:if</th>
<th>compared to xsl:choose in XSLT Mapper 462</th>
</tr>
</thead>
<tbody>
<tr>
<td>xsl:if instruction</td>
<td>414</td>
</tr>
<tr>
<td>xsl:import instruction reference</td>
<td>415</td>
</tr>
<tr>
<td>xsl:import-schema instruction</td>
<td>415</td>
</tr>
<tr>
<td>xsl:include instruction</td>
<td>417</td>
</tr>
<tr>
<td>xsl:key instruction</td>
<td>418</td>
</tr>
<tr>
<td>xsl:message instruction</td>
<td>419</td>
</tr>
<tr>
<td>xsl:name-space-alias instruction</td>
<td>420</td>
</tr>
<tr>
<td>xsl:number instruction</td>
<td>420</td>
</tr>
<tr>
<td>xsl:otherwise instruction</td>
<td>421</td>
</tr>
<tr>
<td>xsl:output instruction controlling white space</td>
<td>319</td>
</tr>
<tr>
<td>xsl:output-character instruction</td>
<td>423</td>
</tr>
<tr>
<td>xsl:param instruction</td>
<td>424</td>
</tr>
<tr>
<td>xsl:preserve-space instruction</td>
<td>426</td>
</tr>
<tr>
<td>xsl:processing-instruction instruction</td>
<td>426</td>
</tr>
<tr>
<td>xsl:sequence instruction</td>
<td>427</td>
</tr>
<tr>
<td>xsl:sort instruction</td>
<td>427</td>
</tr>
<tr>
<td>xsl:strip-space instruction</td>
<td>429</td>
</tr>
<tr>
<td>xsl:stylesheet instruction reference</td>
<td>429</td>
</tr>
<tr>
<td>xsl:template instruction creating new nodes</td>
<td>318</td>
</tr>
<tr>
<td>xsl:text instruction creating white space</td>
<td>318</td>
</tr>
<tr>
<td>xsl:transform instruction</td>
<td>433</td>
</tr>
<tr>
<td>xsl:value-of instruction reference</td>
<td>433</td>
</tr>
<tr>
<td>xsl:variable instruction</td>
<td>434</td>
</tr>
<tr>
<td>xsl:vendor property</td>
<td>687</td>
</tr>
<tr>
<td>xsl:vendor-url property</td>
<td>687</td>
</tr>
<tr>
<td>xsl:version property</td>
<td>687</td>
</tr>
<tr>
<td>xsl:when instruction</td>
<td>435</td>
</tr>
<tr>
<td>xsl:with-param instruction</td>
<td>435</td>
</tr>
<tr>
<td>XSLT automatic tag completion</td>
<td>354</td>
</tr>
<tr>
<td>background</td>
<td>304</td>
</tr>
<tr>
<td>chaining stylesheets</td>
<td>143</td>
</tr>
</tbody>
</table>

| character map | 403 |
| choosing an XSLT processor | 475 |
| code folding | 162 |
| command line utility for | 142 |
| compiling Java code generated from | 392 |
| composing for HTML | 32, 357 |
| creating from HTML | 341 |
| creating using the XSLT Mapper | 437 |
| debugging stylesheets | 479 |
| default processor settings | 377 |
| generating formatting objects | 381 |
| generating Java code from | 388 |
| instruction blocks in XSLT Mapper | 461 |
| introduction | 305 |
| performance metrics reporting | 475 |
| post-processing result documents | 380 |
| processing with Saxon | 376 |
| processors default options for | 377 |
| processors for | 374 |
| spell checking documents | 167 |
| supported versions | 304 |
| symbols used to represent instructions in XSLT Mapper | 458 |
| tags reference | 396 |
| validating result documents | 378 |
| viewing source code in the Mapper | 439 |

| XSLT Editor displaying line numbers in | 8 |
| XSLT Mapper adding instruction blocks | 461 |
| adding source documents | 449 |
| building a target structure | 453 |
| choosing source documents | 446 |
| creating target structure elements and attributes | 453 |
| creating target structure root elements | 453 |
| creating XSLT | 437 |
| defining Java functions in | 468 |
| document symbols | 449 |
| element and attribute symbols in | 452 |
| elements and attributes creating in target structures | 453 |
| example | 439 |
| exporting mapping as an image | 444 |
| flow ports in Mapper symbols | 460 |
how documents are displayed 451
how to map nodes 457
input ports in Mapper symbols 459
logical operators 466
mapping document nodes 455
modifying the target structure 454
options for 441
overview 438
overview of creating XSLT 445
preserving Mapper layout 455
processing source nodes 463
removing a node from a target structure 455
removing node mappings 457
removing source documents 451
root elements
  creating in target structures 453
setting text values
  introduction 467
  on the target node 468
using the Mapper canvas 467
source documents and document() function 447
source documents and XML instances 447
source documents for 446
support for XSLT instructions and expressions 440
symbols for XSLT instructions
  parts of 458
symbols for XSLT instructions
  list 458
  parts of 458
target structures 452
using the mouse 456
viewing source code in 439
working with templates 469
XPath function blocks
  creating 466
  deleting 466
  introduction 464
  types 465
XPath mathematical function blocks 465
XSLT processors
  backmapping and 374
  choosing 375
debugging and 374
Saxon 376
XSLT processors supported by Stylus Studio 374
XSLT Profiler
  displaying the report 488
  enabling 487
  performance metrics captured by 487
XSLT scenarios
  choosing an XSLT processor 475
  cloning 478
  creating
    how to 476
    introduction 471
  performance metrics reporting 475
  running 477
  setting parameter values 473
  specifying source documents 472
XSLT WYSIWYG
  video demonstration 47
Z
Zeus CVS
  using with Stylus Studio 132